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Lesson 1.1: Introduction to Project Management 

Some Topics to be introduced in this lesson include:

· Overview

· Definition of a Project

· Project Management

· Project Managers

· Critical Path Method (CPM)

Overview 

This section provides a brief introduction to Project Management. For a thorough discussion of Project Management and related fields, see the "Project Management Body of Knowledge" (PMBOK) at the following Web site: http://www.pmi.org/pmi/publictn/pmboktoc.htm.
Definition of a Project

The Project Management Institute defines a project as follows:

A Project is a unique undertaking with a defined starting point and duration directed at achieving defined objectives, utilizing finite or infinite resources.

The key parts of this definition:

1. A project has a unique objective.

2. A project has a definite start, duration and finish. It has a temporary rather than open-ended duration.

Some examples of projects are:

· Building a house

· Relocating a data center

· Writing a book

· Developing a software program

Project Management

Project management is the management of an organized set of activities directed toward a common goal, using specialized management structures and techniques. It includes:

Determining project objectives

What is the goal (or goals) of the project? Examples of project goals include building a bridge, relocating the MIS department to a new site or installing a new phone system. More importantly, some examples of things that are NOT projects include scheduling the usage for a training facility or scheduling engineers in a technical service department. These are not projects because they do not meet all the criteria of a project. They do not have a definitive start, finish, and duration. 

Managing budgets and resources  

Projects do not get done without resources to do them. To ensure successful completion of a project, it is important to estimate correctly the number of personnel and the amount of equipment needed. With this, it is important to realize the cost of the project. Some projects can be completed in a shorter time by increasing the manpower on the project. However, doing this also increases the cost. One of the project manager’s jobs is to maintain a balance between reducing costs and reducing the time to complete the project.

Reporting Progress

Reporting progress is a key to project management. It is essential that key players in a project know what is happening, and whether they are on track, behind, or ahead of schedule. By reviewing progress on a regular basis, you can try to avoid possible problems in advance. For example, if you notice that a certain task was scheduled to take 10 days to accomplish, but on day 5 only 25% of the work was finished, you could possibly re-allocate resources to that task in order to complete it on time.

Evaluating efficiency and effectiveness

During and after a project, it is important to review and analyze the performance on the project. This information can provide valuable insight into possible changes to make for future projects. For example, your project was to build a house, and one of the steps involved was landscaping. After the project is finished, you notice that it took less time to do the landscaping than you originally planned. This information could be valuable if you build another house, because you could reduce the time allocated for landscaping. By constantly reviewing the efficiency and effectiveness of your project, you can more accurately plan future projects.

Project Managers

Project managers are responsible for managing projects. They coordinate projects and related tasks, but do not usually have direct management responsibilities for resources assigned to their project. The resources involved in one project may not be the same resources involved in another project. Project managers focus only on work that is specific to their project, and are primarily task and time-constrained: “How do I ensure my project gets finished in the shortest amount of time?” is a question on every project manager’s mind each day.

Critical Path Method (CPM)

The definitions and calculations in this section assume a simple classical project consisting of a set of tasks, task dependencies, and task constraints. 

A task dependency (relationship) occurs if the start or finish of one task (the successor task) depends on the start or finish of another task (the predecessor task). For example, if Task B can start when Task A finishes or later, then Task A is a predecessor of Task B with a Finish-to-Start (FS) relationship. Other relationships are SS (Start-to-Start), FF (Finish-to-Finish), and SF (Start-to-Finish). Lag or Lead (negative Lag) can be specified in a relationship to allow the successor to start later or earlier than the original plain relationship. For example, an SF relationship with negative 2 days of lag means that the successor can start 2 days before the predecessor finishes, or later.

A task constraint limits when the task can occur, independent of other tasks. For example, if a task cannot start any earlier than 1/1/98, then it would have a "Start No Earlier Than" (SNET) type of constraint with a constraint date of 1/1/98.

The Critical Path Method (CPM) is a method of calculating the total duration of a project based on a specified project start date and on the individual duration of tasks and on their dependencies. CPM also provides useful information about how far a task can slip into the future before it moves other tasks or makes the project finish later. 

For a specified project start date and a set of tasks along with their dependencies and constraints, the CPM method calculates the following:

· The earliest date each task can start and finish, and the earliest date the project can finish. 

· The latest date each task can start and finish, without causing the project to finish later.

· How far into the future each task can slip without causing any other task to finish later. [those statements are identical!].

· Which tasks are critical, for example, which tasks will cause the project to finish later if they slip. 

Before looking at how the CPM works, here are a few related definitions from Microsoft Project Help:

Task Dependency

A task dependency describes how a task is related to the start or finish of another task. Microsoft Project provides four task dependencies you can use to connect a series of tasks in a schedule. By using these dependencies effectively, you can modify the critical path and shorten your project schedule slack.

Lag Time
A delay between tasks that have a dependency. For example, if you need a two-day delay between the finish of one task and the start of another, you can establish a finish-to-start relationship and specify a two-day lag time. You enter lag time as a positive value relationship.

Predecessor
A task whose start or finish determines the start or finish of another task.

Successor
A task that cannot start or finish until another task starts or finishes.

Early Start
The Early Start field contains the earliest date that a task could possibly begin, based on the early start dates of predecessor and successor tasks, and other constraints. Early Start is calculated as follows: When you first create a task, its early start date is the same as the scheduled start date. As you link the task to predecessors and successors and apply any other constraints, Microsoft Project calculates the early start date as the earliest possible date this task could be started, if all predecessor and successor tasks also start on their early start dates. If there is a leveling delay on the task, this is also figured into the early start date.

Early Finish
The Early Finish field contains the earliest date that a task could possibly finish, based on early finish dates of predecessor and successor tasks, other constraints, and any leveling delay. 

Late Start
The Late Start field contains the latest date that a task can start without delaying the finish of the project. This date is based on the task’s start date, as well as the late start and late finish dates of predecessor and successor tasks, and other constraints. 

Late Finish
The Late Finish field contains the latest date that a task can finish without delaying the finish of the project. This date is based on the task’s late start date, as well as the late start and late finish dates of predecessor and successor tasks, and other constraints. 

Critical task
A task that must be completed on schedule for the project to finish on time. If a critical task is delayed, the project completion date is also delayed. A series of critical tasks makes up a project's critical path.

Critical path
The series of tasks that must be completed on schedule for a project to finish on schedule. Each task on the critical path is a critical task. Most tasks in a typical project have some slack and can therefore be delayed a little without affecting the project finish date. Those tasks that cannot be delayed without affecting the project finish date are the critical tasks. As you modify tasks to resolve over allocations or other problems in your schedule, be aware of the critical tasks and that changes to them will affect your project finish date.

Critical Path Method (CPM)
A project management method of calculating the total duration of a project based on individual task durations and their interdependencies.

Slack (or Float)
The amount of time a task can slip before it affects another task's dates or the project finish date. Slack is sometimes referred to as float time.

Free Slack
 The amount of time a task can slip before it delays another task.

Total Slack
The amount of time a task can slip before it delays the project finish date. When the total slack is negative, the duration for a task is too long for its successor to begin on the date required by its constraint.

CPM produces results by doing a Forward Pass calculation followed by a Backward Pass calculation:

· Forward Pass: All tasks are calculated to start as early as possible for the specified task dependencies and constraints, and the specified project start date. The latest finishing task(s) determines the project finish date. The Early Start and Early Finish dates for each task are calculated during this pass.

· Backward Pass: All tasks are calculated to finish as late as possible for the specified task dependencies and constraints, and the project finish date calculated from the Forward pass. The Late Start and Late Finish dates are calculated for each task during this pass.

Example

A project starts on Jan 1, 1998 and every day is a working day. The four columns below are the specified task ID, Duration (in days), Predecessors, and Successors. All the relationships are FS, and there are no other constraints (like Start No Earlier Than). 

ID
Dur.
Pred.
Succ.

1
2d

3

2
4d

3

3
3d
1,2


4
2d

5

5
3d
4


Forward Pass:

In the table below, the cells filled with the letter "e" show how the task Early Start and Early Finish dates are calculated during the forward pass. Notice that tasks with no predecessors start at the specified project start date (Jan 1), and other tasks are scheduled as early as possible for the specified relationships. The calculated project finish date is Jan 7.

ID
Dur.
Pred.
Succ.
Jan

1
Jan

2
Jan

3
Jan

4
Jan

5
Jan

6
Jan

7
Jan

8
Jan

9
Early Start
Early Finish
Free Slack

1
2d

3
E
E







Jan 1
Jan 2
2d

2
4d

3
E
E
E
E





Jan 1
Jan 4
0d

3
3d
1,2





E
E
E


Jan 5
Jan 7
0d

4
2d

5
E
E







Jan 1
Jan 2
0d

5
3d
4



E
E
E




Jan 3
Jan 5
2d

Backward Pass:

In the table below, the cells filled with the letter "X" show how the task Late Start and Late Finish dates are calculated during the backward pass. Notice that tasks with no successors start at the project finish date that was calculated during the forward pass (Jan 7), and that other tasks are scheduled as late as possible for the specified relationships.

ID
Dur.
Pred.
Succ.
Jan

1
Jan

2
Jan

3
Jan

4
Jan

5
Jan

6
Jan

7
Late Start
Late Finish

1
2d

3


X
X



Jan 3
Jan 4

2
4d

3
X
X
X
X



Jan 1
Jan 4

3
3d
1,2





X
X
X
Jan 5
Jan 7

4
2d

5


X
X



Jan 3
Jan 4

5
3d
4





X
X
X
Jan 5
Jan 7

A comparison of the Early and Late dates for a task is used to compute its Total Slack and to determine if the task is critical (Zero Total Slack).  From the table below, you can see that the only critical tasks are task 2 and 3, and that they form a single critical path from the start to the end of the project.

ID
Dur.
Pred.
Succ.
Jan

1
Jan

2
Jan

3
Jan

4
Jan

5
Jan

6
Jan

7
Total Slack
Critical

1
2d

3
E
E





2d
No







X
X






2
4d

3
E
E
E
E



0d
Yes





X
X
X
X






3
3d
1,2





E
E
E
0d
Yes









X
X
X



4
2d

5
E
E





2d
No







X
X






5
3d
4



E
E
E


2d
No









X
X
X



More complicated projects can have more than one critical path. In non-classical projects with more advanced features, a project might have no critical path. See the Scheduling module for examples.

Lesson 1.1 - Exercises

1.
Which of the following best fits the definition of a single project?

A. The activities required to build a convention center. 

B. The cases a law firm works on year after year.

C. A law firm preparing for a specific case.

D. Daily activities during the life of a person.

E. Creating a new video game.

2. 
What is the acronym and name of the procedure in which a forward pass and a backward pass are used to calculate slack?

A. DPM - Double Pass Method

B. CPM - Critical Path Method

C. FBM - Forward Backward Method

3. 
If the Early bar (from Early Start to Early Finish) exactly matches the Late bar (from Late Start to Late Finish), and each bar is 5 working days long, then which of the following are true (identify all correct answers):

A. The Total Slack of the task is 5d

B. The Total Slack of the task is 0d

C. The task is critical.

D. No such task can exist.

4. 
Is the backward pass used to calculate the Early bar or the Late bar?

Lesson 1.1 - Lab

The picture below shows a project with three tasks with no constraints. The project is scheduled from start and the relationships are all simple Finish-to-Start. A standard five day work week is used (Mon-Fri, 8am-12pm, 1pm-5pm) and each task starts at 8am and ends at 5pm.
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A.
Based only on what you see in the picture above, complete the table below by filling in values for tasks T1 and T3 (without actually creating the project). Don't include the time of day with the dates.

Name
Early Start
Early Finish
Late Start
Late Finish
Total Slack
Critical

T1







T2
8/15
8/18
8/15
8/18
0d
Yes

T3







B.
Verify your answers by creating the above project in Microsoft Project. You'll need to set the Project Start date to 8/11/97 (by clicking Project Information from the Project menu). You'll also need to insert the appropriate columns in a task table in Microsoft Project.

Lesson 1.2: Introduction to Microsoft Project

Some Topics to be introduced in this lesson include:

· How Microsoft Project Helps

· New/ Improved Features

How Microsoft Project Helps

Microsoft Project makes it easy to get started even if you are new to project management software. The picture below, from the "Microsoft Project Map" on-line help topic, illustrates the evolution of a project and how Microsoft Project can help:
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Microsoft Project helps you manage projects in a variety of ways, including:

· Ease of Use: There are helpful learning tools such as the Office Assistant and GanttChartWizard. Microsoft Project has data entry features such as in-field spinners and dropdowns, AutoCorrect, Spell Checker, and Search and Replace. 

· Scheduling: Based on the data that you enter about the tasks, constraints, relationships, resources, assignments, calendars, and so on, Microsoft Project schedules your tasks. It can also automatically spread or split tasks to solve overallocation problems. 

· Tracking: You can track actual information and progress, and compare current scheduled information against a saved baseline.

· Reporting: There are a variety of views and reports for viewing and presenting project information.

· Workgroup: The project manager can communicate with resources about their tasks and progress using email or a web site.

· Import/Export: Microsoft Project can read and write to a variety of file formats.

· Customization: Visual Basic for Applications macros can be used to build custom solutions with Microsoft Project and other applications.

New/ Improved Features

If you used previous versions of Microsoft Project, then the following list provides a quick overview of some of the new or improved features in Microsoft Project 98:

Usage Features

· Scaling for all printers (including non-postscript).

· Find and replace tool for task, resource, or usage tables.

· In-field spinner, dropdown lists, and date picker.

· Filters: New Autofilter (similar to the one in Excel) with the ability to save as a filter. Improved custom filters support grouped conditions.

· Field improvements: Increased number of custom fields such as Text1,..., Text30. New date custom fields Date1,...,Date10. Definable custom field aliases show up in field lists.

· Copy Picture: Allows a date range to be specified. Can save as GIF.

· View Navigation: New View Bar containing icons for views. View names displayed at the border of panes.

· Formatting: Rich Edit (RTF) notes. More format choices for duration labels, like d, dy, and day. Assignment units can be formatted as % or decimal.

· Web Features: Hyperlinks in dedicated fields, text-type fields like Text1, and RTF notes. Web-based application for Workgroup messaging.

· Indicator field: Contains icons that display information about tasks, resources, or assignments, such as missed constraints or over allocations.

· Usage views: Can show assignments by task or by resource. Show timephased values by period. Timephased data can be entered for some fields such as assignment scheduled and actual work.

· Assignment Information dialog: New dialog for selecting the assignment contour and rate table, and for editing assignment fields such as Start, Finish, and actuals.

· Progress Lines: New graphical  "lightening bolt" can be displayed on the Gantt Chart for a quick overview of the progress of all the tasks in a project relative to a specified date, status date, or current date.

Scheduling and Costing Features:

· Resource Availability Dates: You can specify a date range restricting when a resource can work; this overrides the resource calendar.

· Variable Resource Rates: Each resource has 5 rate tables, each with up to 25 different rate periods. A rate table can be selected for each of the resource's assignments.

· Actual costs can be entered: Options Calculation tab has the new option, "Actual costs are always calculated by Microsoft Project." If unselected, then task and assignment total or timephased actual costs can be entered.

· Timephased fields: Many fields such as Work, Actual Work, and %Complete can be edited per period in a usage view.

· Earned Value fields: Calculated from timephased values; can be based off a specified Status Date.

· Assignment contouring: Predefined Flat (default), Back/Front Loaded, Double/Early/Late Peak, Bell, or Turtle. Contours can be customized (Contoured) by editing timephased values.

· New Duration, Work, Units calculations: Based on Task Types (Fixed Units, Fixed Duration, Fixed Work) and Effort Driven settings. Fixed Work allows units to be calculated when duration changes, keeping assignment work unchanged. Effort Driven keeps total Work constant as more resources are assigned. 

· Scheduling from Finish: Symmetric calculations compared to Schedule From Start. ASAP and ALAP retain same definition either way. Can level now using negative Leveling Delay.

· Task Splitting: Tasks can be manually split multiple times with the mouse in a Gantt view or by entering zeroes for periods in a usage view. Leveling has an option to split remaining work.

· Resource Leveling:

 Options to...

· Set the granularity (min, hr, day, week, mo).

· Specify a date range.

· Level assignments independently.

· Split remaining work for a task or assignment.

· Level projects that are scheduled from finish (using negative delays). 

· Override constraints.

· Level the rest of a resource's assignments after an unresolvable situation.

Other improvements include:

· A progress indicator on the status bar is useful during lengthy leveling calculations.

· New Preleveled date fields allow a before/after comparison in the Leveling Gantt view.

· Leveling does not destroy critical path. 

· Summary tasks: Actual Work and % Work Complete can be edited. The new Summary Progress "To" field in Bar Styles can be used to draw more meaningful progress bars.

· "Task Status Updates Resource Status": Works both ways now; edits to actuals changes the task % Complete.

· Actual Work Rolldown calculations: Edits to task actual work are rolled down to assignments in a timephased manner (period by period) until the assignment actuals total to the task actuals.

· Duration Calculation: Calculated in a timephased manner rather than maximum assignment Work/Units as in previous versions.

· Week Starts On: Can now be any day of the week rather than just Sun or Mon. Used by Date Picker dropdowns and timescale labels Week of year 1,...52 and Days count 7.

· Fiscal Year: There is now an option "Use starting year for FY numbering" rather than jumping a year ahead at the start of the fiscal year.

· Stop and Resume fields: Now editable.

· Soft constraints: New option "Tasks will always honor their constraints." If unchecked, then a successor task can obey its predecessor even if the successor violates its constraint (still causes negative slack). 

· Multiple Critical Paths: If the new "Calculate multiple critical paths" option is selected, then tasks at outline level 1 that normally have slack to the end of the project (for example, no successors or right limiting constraint) will instead have 0 slack. Slack of child tasks are relative to the summary task; ALAP child has 0 slack and can't go or push successors past the summary task finish.

· Inserted Projects: Replace the old consolidated and subproject features. Any project can be inserted into any other project at any level. 

· Cross Project Linking: Path and filename can now be specified in the predecessor field to create external links, for example, C:\Files\OtherFile.mpp\2FS+3d, or the mouse can be used to create them using inserted projects.

· Resource Pools: Improved architecture. The pool now contains all assignment information so you can see assignments across all sharers even if they are not all open. Pools can be opened as read-only so multiple users can have the project open at the same time. The new Update Resource Pool command  temporarily closes the pool, reopens it with write access, updates it, closes it, and opens it again as read-only. The new Refresh Resource Pool command reads the latest updates from the pool (closes and reopens it).

Data Import/Export Features

· Maps: Provide consistent interface for importing/exporting various file types.

· Improved ODBC support: You can do a complete save including views, etc. The MPD format is a complete save to an Access database.

· Modifying data outside of Microsoft Project: Intelligent import handles inconsistencies from external modifications.

· Save to HTML: New format works with a Map to save specified fields to an HTM extension file using a default template or a customized one created using special Microsoft Project HTML codes.

· "Microsoft Excel 5.0/7.0 Pivot Table" type: Replaces the old CreateCrossTab macro.

· Analyze_Timescaled_Data macro: Exports timescaled data to Excel sheet with an option to chart.

· Global files: Can now be opened.

Visual Basic Applications Features

· Microsoft Visual Basic (Editor: Same editor as in other Office applications. The Module Editor view is gone.

· Virus Check: A warning is given when a project that contains macros is opened.

· CommandBars collection: Allows command bars (single menu bar and various toolbars) to be controlled programmatically.

Workgroup Features

· Microsoft Outlook( Integration: Partially completed Status messages can be saved in Outlook. Unsolicited Status messages can be created in Outlook. Project file tracking events can be stored in an Outlook Journal.

· Web Based Workgroup Messaging: The Web application Mspjhttp.exe can be placed on a Web server and used by the project manager and resources to handle workgroup messaging.

Lesson 1.2 - Exercises

1.
Which of the following are new features (not just improvements) in Microsoft Project 98?

A. Scaling on postscript printers.

B. Link lines connecting predecessor and successor tasks on the Gantt Chart.

C. AutoFilter.

D. Formatting the font for selected cells in a table.

E. Rich Text formatting in the Notes tab in the task, resource, and assignment Information dialogs.

F. Task Usage view.

G. Each resource can have its own standard rate.

H.  Assignment Units field for controlling work load.

I. Resource Calendars.

J. Predefined assignment contours such as Bell and Turtle.

K. Type and Effort Driven task fields.

L. Option to schedule a project from the Start or Finish.

M. Projects scheduled from Finish can be leveled.

N. Summary tasks.

O. Option for multiple critical paths.

P. Subprojects.

Q. Inserted Projects.

R. Paste Linking between projects.

S. Cross project predecessor/successor links.

T. Projects can now share resources.

U. Projects can be saved in HTML format.

V. The Organizer can be used to copy views between projects.

W. Global files can now be opened.

X. Module Editor view for editing macros.

Y. Resources can view workgroup messages using a Web browser.

Z. You can create multiple custom menu bars.

Lesson 1.2 - Lab

Lesson 1.2 - Lab 1

Use Microsoft Project online Help to locate the Microsoft Project Map that is displayed in the beginning of this lesson.

Click on each of the circled text, circled numbers and Hint boxes along the path and briefly scan the information that is displayed.

Lesson 1.2 - Lab 2

The purpose of this subjective exercise is to encourage you to think about the potential impact of the new and improved features in Microsoft Project 98.

In the New/Improved Features section of this lesson, pick out ten of the listed items that you believe are the most important. Be prepared to support your position. 

If time permits, the instructor may hold an open forum for class participants to discuss their choices.

Module 2 - Setup
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Some Topics to be introduced in this lesson include:

· System Requirements

· Shared Office Components Folder

· Default Installation Folder

· Removing Previous Microsoft Project Versions

· STF file has a new name

· New Start-in behavior

· Microsoft( Windows( NT( 4.0 Issues

· NT 3.51 Issues

· Setting Up Microsoft Project on a Network

· Installing the Workgroup Message Handler

Microsoft Project 98 Setup

System Requirements

Operating System

Microsoft Project 98 requires one of the following operating systems:

· Microsoft Windows 95 (or later)

· Microsoft Windows NT 3.51 with Service Pack 5

· Microsoft Windows NT 4.0 with Service Pack 2

Disk Space Requirements

Microsoft Project 98 has the following disk space requirements based on the type of installation:

Typical
Complete
Workstation
Administrative

21.0
34.7
15.1
70.6

New Setup Application

Microsoft Project 98 uses the same setup application, Acme 3.0, as Microsoft Office 97.

Shared Office Components Folder

During the installation of the first Office application, Setup creates a registry key that points to the shared Office folder (for example  C:\Program Files\Microsoft Office\Office).  When an additional Office application gets installed, Setup uses this registry key to locate the shared Office folder and install the required files into this directory.  Files that have to go into this location are Office shared DLLs (for example Mso97.dll), Find Fast files, and Binder files.  Application specific files (for example  *.exe) don't have to be installed into this directory and they will not install if you install two or more Office applications under different locations.

If you choose to install two Office applications under different locations (for example, first Microsoft Project 98 under C:\WinProject and later Microsoft Access 97 under C:\Access), the application installed second uses the registry key created by the first application, to determine where the shared Office folder files have to be installed. The second application then appends the shared Office folder directory to the PATH environment variable in AUTOEXEC.BAT. The shared Office folder path has to be written to AUTOEXEC.BAT to ensure that the system finds the required DLLs and components. In the above case, Microsoft Access installs the shared Office folder files (Find Fast, Mso97.dll, etc.) under C:\WinProject and Microsoft Access specific files (for example Access.exe) under C:\Access and then appends "C:\Winproj" to the PATH in AUTOEXEC.BAT.  As a result Microsoft Access lacks boot performance because the EXE and DLLs won't live in the same location and the PATH environment variable is the last place the system looks for file locations.

This decrease in performance is true for all Office applications if you choose to install two or more Office applications under different locations.

Default Installation Folder

The default installation folder depends on whether Microsoft Project 98 is the first Office 97 application to be installed or if there is already another application installed:

· If Microsoft Project 98  is the first Office 97 application, it uses the same default as Office does (for example  C:\Program Files\Microsoft Office)

· If there is already an Office 97 application installed, the registry setting has been set and Microsoft Project 98 Setup uses its value to prompt you with the default installation folder.

The Microsoft Project executable, winproj.exe gets installed in the Office subfolder of the folder you specify during setup. For example, if you change the default folder from

c:\program files\microsoft office  to  c:\pj98, then Setup creates an Office subfolder if necessary and puts winproj.exe in  the subfolder of c:\pj98\office, as shown:

[image: image3.png]All Folders Contents of 'C:\Pj98\Office’

=0 o Name s
=423 Offce CiSetp |
@ setup CWebst
& 3 Webstv & Winproj exe





If another Office application is already installed, Microsoft Project 98 Setup would append the path to the Office folder to the PATH statement in the Autoexec.bat file as described. For example, the PATH statement might end up like the following:

PATH C:\WIN95;C:\WIN95\COMMAND;C:\PROGRA~1\MICROS~2\OFFICE

Removing Previous Microsoft Project Versions

Microsoft Project 98 Setup searches for Microsoft Project 4.x installations. If it finds any, Microsoft Project 98 offers you the option to remove the previous version. If you choose to remove the previous version, Setup will not remove any shared components, system DLLs, or any documents you created.  

STF file has a new name

The STF file in Microsoft Project 4.x was called Setup.stf.

Microsoft Project 98 uses the new convention of giving the Setup Table Files (STF) application specific names. It is now called: PRJ98.STF

See the network setup section later for instructions on modifying Prj98.stf (or look in the Setup.wri that ships with Microsoft Project 98).

New Start-in behavior

The File Open default folder in Microsoft Project 98 is determined by an Office registry setting. It does not use the Start in setting specified in a Windows shortcut. However, Microsoft Project will look in the Start in folder first for Global.mpt.
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NT 4.0 Issues

If you're installing Microsoft Project 98 on Windows NT 4.0, you need to obtain the updated files found in Service Pack 2 (or later), a cumulative build of all fixes to Windows NT Workstation, and Windows NT Server 4.0. Because of their large size, the self-extracting files for the x86, ALPHA, and Power PC versions of Service Pack 2 are only available on Microsoft's World Wide Web and FTP sites. The required files are listed below:

File name
Description
File Size

SP2_400I.EXE
Intel (x86) NT 4.00 SP2
14.8 MB

NT 3.51 Issues

If you're installing Microsoft Project 98 on Windows NT 3.51, you need to obtain the updated files found in Service Pack 5, a cumulative build of all fixes to Windows NT Workstation and Windows NT Server 3.51. Because of their large size, the self-extracting files for the x86, MIPS, ALPHA, and Power PC versions of Service Pack 5 are only available on Microsoft's World Wide Web and FTP sites. The required files are listed below:

File name
Description
File Size

SP5_351I.EXE
Intel (x86) NT 3.51 SP5
12.4 MB

Setting Up Microsoft Project on a Network

Installing Microsoft Project on a network is a two-step process:

1. The administrator creates the administrative installation point by running Setup in Administrative mode.

2. The users install Microsoft Project by running Setup from the administrative installation point.

The same Setup.exe is used for each of these steps, although in two different modes. To avoid confusion in the following discussion, these two modes will be referred to as follows:

· Administrative Setup. To create the administrative installation point, you run Setup.exe from the CD-ROM with the /A command line option.

· Client Setup. To perform a client installation, a user runs Setup.exe as usual from the administrative installation point, without the /A command line option.

Administrative Setup

You need to run Administrative Setup under Windows 95 (or later), Windows NT 3.51 Workstation (or later), or Windows NT Advanced Server 3.51 (or later). If you're running Windows NT Advanced Server, you must direct the Administrative Setup to a different server location. Do not run an Administrative Setup from a Windows NT Advanced Server machine to the same machine.

The administrative installation point must have at least 72 MB of disk space, and you (the administrator) must have read, write, delete, and create permission to this location. If users will be running Microsoft Project 98 in a shared Windows environment, you need to run Setup in that same environment. You will also need write and create permissions to the Windows folders.

Using the administrative mode of Setup, Setup will install all of the Microsoft Project files from the CD-ROM to the administrative installation point. This consists of two primary folders Setup will create:

·  \MSOffice. The main Microsoft Project program files will be installed in this folder.

·  \Msapps. Shared components, such as Microsoft Info and the spell checking files, will be installed in this folder.

Before doing the administrative installation of Microsoft Project, be sure that:

· Destination folders are empty or do not exist. Setup will automatically create the folders if they do not exist. If a previous version of Microsoft Project exists, delete all of it. (Setup will not install to a folder that already contains files.)

· Folders are locked to network user access during administrative installation.

· Virus detection software is disabled.

To install Microsoft Project on the administrative installation point, run Setup.exe from the CD-ROM with the /A command line option: setup /a
Then follow the instructions on the screen.

Note: Double-clicking Setup.exe in File Manager (Windows NT 3.51) or Explorer (Windows 95 or Windows NT 4.0) will not work. You need to use the Run command on the File menu of Program Manager or File Manager (Windows NT 3.51) or the Run command on the Start menu (Windows 95 or Windows NT 4.0) to use the command line option /A. This can also be performed from an MS-DOS( window. If you double-click Setup.exe, it will perform a client installation.

Notes:

· The organization name you enter will be used for all client installations of Microsoft Project from this network location.

· When asked for the server and path for the shared programs’ folder, enter the name in the same way that users will specify it when installing Microsoft Project. You can specify whether users with a drive letter (for example, G:\) will access the server or a UNC path (for example, \\server\share). If you select a drive letter, users installing Microsoft Project will need to have that same drive letter mapped to this folder before running Client Setup.

· When Setup asks where you want the shared program files installed, the option you select controls the choices your users will have during Client Setup:

Options
Effect on Client Setup

Server
The shared program files will remain on the server and run remotely. The user won't get a choice during Client Setup.

Local Hard Drive
The shared program files will be copied to the user's local hard drive. The user won't get a choice during Client Setup.

User's Choice
The user will be asked to choose Server or Local Hard Drive during Client Setup.

· Setup then copies all files from the CD-ROM to the administrative installation point.

· After the installation is complete, share the two folders (\MSOffice and \MSApps) on the network, either creating a single share that contains both folders or creating two separate shares, one for each folder.

Client Installation

Note: Microsoft Project will not work properly when running from a Novell network server if the computer trying to run Microsoft Project does not have a local hard drive.

To install Microsoft Project on the client computers, users will need to:

1. Connect to the main Microsoft Project folder on the administrative installation point for Setup, making sure that users have the same share rights that they will have when they run Microsoft Project.

2. Run Setup.exe.

When users run Client Setup from this administrative installation point, they will see the Run from Network Server option in addition to the other installation options. If a user selects this option, the main Microsoft Project program files are left on the server and run remotely.

When using the Run from Network Server option, the installation folder chosen during setup will only contain two files. The first file is Custom.dic, unless it already exists in another location on the hard drive. This file contains any user-specified terms that should be recognized as acceptable during a spelling check. The second file is Global.mpt, which contains the Microsoft Project default settings. The user should have read/write access to this file.

It is recommended that users have a read-only connection to the Microsoft Project folder on the server when they are running Setup and when they are running the programs after a Run from Network Server installation.

Client Installation in Batch Mode

You can create an installation script to control how Setup installs Microsoft Project, so unattended Setups can be run for workstation users. With a script, you can:

· Perform a complete installation automatically, without input from the user.

· Control which type of installation (Typical, Custom, or Workstation) you want Setup to perform.

· Specify the folder in which to install Microsoft Project.

· Ensure that all installations in a workgroup are the same.

To create a custom installation, follow these steps:

1. You must install Microsoft Project on your network file server. See the previous section, Administrative Setup (this refers to running Setup.exe with the /A command line option: "setup /a").

2. If you want to use the default setup options that Microsoft Project defines, you can use the following command lines to access the various options:

Install type
Setup command with switches

Typical
setup /Q1 /B1

Complete
setup /Q1 /B3

Workstation
setup /Q1 /B4

Uninstall
setup /Q1 /U

 By default, the Typical and Complete options will install exactly the same files. Continue with the next steps to choose what is installed and to select an installation location.

3. To change the default installation options, copy the Prj98.stf file into the folder in which you installed Microsoft Project. Rename the copy of Prj98.stf to Prj98stf.bak to preserve the original installation options. If the STF file is not backed up, and the modified STF file does not work properly, the Administrative Mode setup will need to be run again to get a working copy of this file.

4. Open Prj98.stf in any spreadsheet program, word processor, or text editor. It is easiest to work with the file in a spreadsheet program, such as Microsoft Excel.

5. The lines in the STF file that control which options are installed during setup start at line 72 of the STF file (counting down from the top). ObjID 32 designates this line, which is in the first column. The ObjID lines from 32 through 117 control each of the various components of Microsoft Project.

Type Yes or No in the Checkbox column (column 2) of the STF file for those options that you do or do not want installed. Do not change ObjID lines 33, 35–47, 67, 71–100, or 108.

Note:  To ensure that Setup works properly, do not edit any other part of the Prj98.stf file. If the initial value in a field is empty, do not edit the field. If you're using a text editor, do not delete the tab characters that separate columns.

6.
To change the folder where Microsoft Project and Microsoft Office components will be installed, replace the text "%p\MSOffice"<%p\Microsoft Office>,,,176,,yes,3 4 (where the %p represents \Program Files) that is located at line 34, designated by ObjId 1. A typical change would look like this:

Original:   "%p\MSOffice"<%p\Microsoft Office>,,,176,,yes,3 4
Modified: "%p\Office97\Proj98"<%p\Microsoft Office 97\Project 98>,,,176,,yes,3 4

Do not change any other information in these rows.

7. 
Save the file in tab-delimited, text-only format.

8. 
Run Setup with the following command line: setup.exe /q

There are other switches available that you can use along with the "/q" switch:

/n username

This is used to force the user name; for example: 

Setup.exe  /q  /n "Bill Jones"

/t tablename
This is used to substitute the name of the new script for tablename; for example: 

Setup.exe  /q  /t Batch.stf

Network Installation Issues

Install Microsoft Project in Shared Windows for the First Time

The first time Microsoft Project is installed to a user’s computer in a shared Windows environment, Setup will attempt to copy a few of the Microsoft Project files into the shared Windows folder. Although users normally have read-only access to the shared Windows folder, the first client installation of Microsoft Project requires write access to copy these files.

After the first installation is completed, the user’s access rights to the shared Windows folder can be set back to read-only. Subsequent users installing Microsoft Project only need read-only access to the Windows folder because the needed files will already be present and Setup won’t attempt to copy them again.

Install Microsoft Project when Microsoft Office is Shared

If Microsoft Project is being installed to a machine that is running Microsoft Office from a shared network location, the first user installation must have write access to the Microsoft Office folder. Microsoft Project shares some common files with Microsoft Office and Setup must be able to write any necessary files to the Microsoft Office folder.

After the first installation is completed, the user’s access rights to the Microsoft Office folder can be set back to read-only. Subsequent users installing Microsoft Project need only read-only access to the Windows folder because the needed files will already be present and Setup won’t attempt to copy them again.

Installing the Workgroup Message Handler

The Workgroup Message Handler in Microsoft Project is responsible for formatting, retrieving, and sending information to and from resources that are working on a project. If you have installed Microsoft Project on your computer, then you already have the Workgroup Message Handler. Every resource that will be receiving workgroup messages via e-mail must also have the Workgroup Message Handler installed on his/her computer.

The Workgroup Message Handler in Microsoft Project 98 supports the following mail systems:

· Microsoft Exchange running on Windows 95 and Windows NT.

· Microsoft Mail for Windows NT.

· Lotus cc:Mail 7.0 for Windows 95 and Windows NT.

· Lotus Notes 4.5a for Windows 95 and Windows NT.

Note: The message handler cannot work with Microsoft Mail running under Windows 95. Users in this situation must update their mail system to use Microsoft Exchange that ships with Windows 95 or Windows NT 4.0 for the Workgroup Message Handler to function properly. For more information about installing Microsoft Exchange for use with a Microsoft Mail post office, see your Windows 95 documentation.

If the originator (manager) who uses Microsoft Project and sends the workgroup messages is using Microsoft Project 98, then all resources must run the Setup program to be able to respond to those workgroup messages.

All resources should run the WGsetup.exe program to install the Workgroup Message Handler. This program is available from the WGsetup folder of the Microsoft Project CD-ROM. You can make the Workgroup Message Handler Setup program available to resources in two ways:

· Copy the entire WGsetup folder from your Microsoft Project 98 CD-ROM to a network location and ask your resources to run WGsetup.exe from the network.

· Copy the files from the WGsetup folder of your Microsoft Project 98 CD-ROM to two floppy disks.

Copy the following files to disk 1: Extract.exe, Prj98_1.cab, Setup.ini, WGsetup.exe, WGsetup.inf, WGsetup.lst, and WGsetup.stf.

Copy the following file to disk 2: Prj98_2.cab.

After you copy all files to the floppy disks, send your resources these two disks and ask them to run WGsetup.exe from disk 1.

New Microsoft Project 98 Limits

This section outlines the new Microsoft Project 98 limits. Microsoft Project 98 removes or greatly increases most of the Microsoft Project 4.x limits, and for the most part you are only constrained by the available memory on your machine.

Note: The maximum numbers listed in this section are only what Microsoft Project 98 supports provided the machine has enough RAM or virtual disk space.

Item
Project 4.x
Project 98
Notes

Number of tasks
9,999
1,048,575


Number of resources
9,999
1,048,575


Number of resources assigned to a single task
100
no limit per task
Limit of 1,048,575 assignments in a single project file.

Number of tasks that a single resource can be assigned to.
1,000
no limit per resource
Limit of 1,048,575 assignments in a single project file.

Maximum resource units on an assignment
100 units
10,000 units or 1,000,000%


Number of predecessors per task
100
no limit per task
Limit of 1,048,575 task links in a single project file.

Number of successors per task
100
no limit per task
Limit of 1,048,575 task links in a single project file.

Number of outline levels
10
65,535


Number of subprojects 

Number of consolidated projects
255

80
1000
In Microsoft Project 98, subprojects and consolidated projects are treated similarly. So there is a single limit of 1000 for subprojects plus inserted projects in a single container project file.

Number of open project files
80
1000


Number of sharer files connected to a resource pool
79
999
Limit of the number of open files minus 1 for the pool file itself.

Number of open windows
20
50


Number of calendar exceptions per calendar
250
1000


Maximum cost value
1012 - 1
1012 - 1
This is the maximum value a currency field can have.

Maximum task work value
1011 -1 minutes
1011 -1 minutes
This is the maximum value that a work field can have.

Max assignment work value
8,471,480 minutes
1011 -1 minutes
This is the maximum value that an assignment work field can have.

Tools Options Registry Settings

The pictures below show where the Microsoft Project 98 Tools Options settings are stored in the Registry:
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Note: These settings are also repeated in the following branch for defaults for new users:
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Lesson 2.1 - Exercises

1.
Assuming that Office 97 is already installed in its default folder on the C: drive, what folder will winproj.exe be installed in?

2. 
Suppose that during installation, you enter C:\Proj98 for the installation folder. What folder will winproj.exe be installed in?

3. 
What is the name of the Microsoft Project 98 STF file?

4. 
Describe the steps involved for setting up Microsoft Project on a network so that users can install Microsoft Project from the network and run a shared copy of winproj.exe from the network.

5. 
What is wgsetup.exe used for?

Lesson 2.1 - Labs

Lesson 2.1 - Lab 1

This lab illustrates the new behavior of the default current folder when you start Microsoft Project 98. 

1.
Create a test folder named C:\MyStartFolder

2.
Create a shortcut on the Windows Desktop to run Microsoft Project 98. Right click the shortcut and choose Properties. Click the Shortcut tab, and in the Start in box, enter C:\MyStartFolder.

3.
Double click the shortcut icon that you created in step 2. After Microsoft Project starts, use the File menu Open command to display the Open dialog. 

Is the default folder in the File Open dialog the new C:\MyStartFolder you specified for the shortcut Start in setting?

4.
Use the Find command in the Windows Registry Editor to find out what Registry setting determines the default folder in the File Open dialog in Microsoft Project.

To run the Registry Editor, click the Windows Start button, click Run, enter Regedit.exe and click OK. This opens the Registry Editor. From the Edit menu, choose Find. Enter the path of the default folder that was listed in the File Open dialog in Microsoft Project, and click Find Next. There may be many items in the Registry that contain your search string. Press F3 to continue finding more matches.

If you think you have located the correct Registry entry, test it by changing the path value to C:\MyStartFolder, close the Registry, restart Microsoft Project with your shortcut, and check to see if the File Open dialog defaults to the C:\MyStartFolder folder.

Lesson 2.1 - Lab 2

Install Microsoft Project on your computer if necessary, and then use the Registry Editor (regedit.exe) to locate the various options and settings discussed in the Tools Options Registry Settings section of this lesson.

Lesson 2.1 - Lab 3

The purpose of this subjective exercise is to encourage you to think about the potential impact of the new limits in Microsoft Project 98.

In the New ... Limits section of this lesson, pick out three of the listed items that you believe are the most important. Be prepared to support your position. 

If time permits, the instructor may hold an open forum for class participants to discuss their choices.

Lesson 2.1 - Lab 4

This lab will give you experience with administrative installs and running Microsoft Project from a network.

1.
Create a new folder with a name like PjAdmin on a network server or Windows 95 computer other than the one you are using. You cannot use the same folder name as other students, so you may want to add your email name to the folder name, for example, JoePjAdmin. The Instructor may provide you with a location to create your folder.

2.
Run setup.exe/a from the Microsoft Project setup disk, CD, or a network copy, and do an administrative install to the PjAdmin folder that you created in step 1. If you need help, read the Setup.wri file that is on the setup disks or CD.

After completing the administrative install, explore the folders and files that were placed in the administrative folder.

3.
Delete Microsoft Project from your computer if it is currently installed, then run setup.exe from the administrative folder that you created above. In the appropriate dialog, choose the option to run Microsoft Project from the network.

Does this install winproj.exe on your local hard drive? What about global.mpt?

4.
Uninstall Microsoft Project and then reinstall it locally.

Lesson 2.2: Upgrade Issues

Some Topics to be introduced in this lesson include:

· Overview of Microsoft Project 98 file system

· File Formats Supported in Microsoft Project 98

· Automatic Updating

· Global Upgrade Mode in the Organizer

· Cross-Language Upgrading

Overview of Microsoft Project 98 file system

New Microsoft Project Database (MPD) Format

To improve the file interchange support and enable cross-language file compatibility, a new Microsoft Project Database (MPD) file-type is replacing the MPX file format as the Microsoft Project standard interchange file format.

Importing Microsoft Project 4.x data and formatting

Microsoft Project 98 can read Microsoft Project 4.x MPP files and MPX files.

To ease the transition to Microsoft Project 98 from Microsoft Project 4.x, Microsoft Project 98 incorporates a new Global.mpt upgrade scheme that allows you to easily import views, tables, toolbars, menus, filters, reports, forms, and/or calendars, either selectively or automatically.

File Formats Supported in Microsoft Project 98 

Microsoft Project File Formats

In addition to the Microsoft Project 98 MPP format, Microsoft Project 98 supports the following Microsoft Project file formats:

· Reading data from Microsoft Project 4.x MPP files

· Reading Organizer information (such as views, tables, and filter) from Microsoft Project 4.x MPP files and MPT files, including Global.mpt

· Reading data from Microsoft Project 4.x MDB files

· Reading data from Microsoft Project 1.x, 3.x, or 4.x MPX files

· Saving Microsoft Project 98 data as Microsoft Project 4.x MPX files

Note: Microsoft Project cannot open MPP files older than version 4.0. Attempting to do so causes an alert.

Microsoft Project 98 cannot open MPP files prior to version 4.0
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External File Formats

Microsoft Project 98 can also read from and write to the following external file formats:

· MPD/MDB files (these are both Microsoft Access 8.0 format)

· Excel 97 XLS files (read but not write)

· Excel 5.0/95 XLS files

· Excel 5.0/95 PivotTables (write but no read)

· TXT files

· CSV files

· HTML files (write but not read)

MPD and MDB files are actually handled through ODBC, but they allow you to bypass the ODBC connection dialogs.

Dropped Formats

Microsoft Project 98 does not read or write the following formats:

· All Microsoft Project 3.0 files except for MPX

· FoxPro DBF files (will be supported through ODBC)

· Lotus WKS, WK1, and WK3 files 

· dBase III and dBase IV DBF files

· Excel 3.0 and 4.0 XLS files

Microsoft Project 3.0 Macros 

Microsoft Project 98 cannot convert Microsoft Project 3.0 macros to current Microsoft Visual Basic for Applications language and syntax. It’s possible to store a Microsoft Project 3.0 macro in a Microsoft Project 4.x file because Microsoft Project 4.x leaves the 3.0 macros intact when reading a 3.0 file. Only when you edit the 3.0 macro in Microsoft Project 4.x is it converted to the new Visual Basic for Applications format. If you open a Microsoft Project 4.x file in Microsoft Project 98 that still contains a 3.0 macro, the 3.0 macro is ignored and is not in the Tools Macros list. The workaround is to open the file in Microsoft Project 4.x, select the macro in the Tools Macros list, and click the Edit button to display it in the Microsoft Project 4.x Module Editor. That causes the Microsoft Project 3.x macro to be converted to Microsoft Project 4.x Visual Basic for Applications format. Then save the Microsoft Project 4.x file and open it in Microsoft Project 98.

Microsoft Project Exchange (MPX) Compatibility

The MPD file is replacing the MPX file as the standard interchange file format. 

Microsoft Project 98 has not updated the MPX format to cover the new features in Microsoft Project 98. You can save a project in the MPX format from Microsoft Project 98, but it may lose or change information related to the new features, and schedule differently because of the new scheduling behavior in Microsoft Project 98.

An MPX file saved from Microsoft Project 98 may be scheduled differently when opened in Microsoft Project 4.x.

For example, if a resource is assigned to a 5 day ASAP task at .5 units, the Microsoft Project 4.x MPX resource assignment record looks like this:

  75,1,0.5,20h,0h,0m,0h,$0.00,$0.00,$0.00,Fri 12/16/94 8:00 AM,Thu 12/22/94 5:00 PM,0h,1

The format of the resource assignment record is:

  Record ID, ID, Units, Work, Planned Work, Actual Work, Overtime Work, Cost, Planned
   Cost, Actual Cost, Start, Finish, Delay, Resource Unique ID

Because of the new resource-contouring feature in Microsoft Project 98, it is possible to have the same assignment span the same time, with the same units, but with a different work value. When Microsoft Project 4.x opens this MPX file, it changes the finish date of the assignment to reflect the start date and the work value. Although this example is easy to fix by having an average units calculated in Microsoft Project 98, there is a number of such potential problems in supporting backward compatibility.

Many limits in Microsoft Project 98 have increased, such as the number of tasks, maximum units, outline levels, and so on. Microsoft Project 98 does nothing unique to handle the changes.  If you have more than 10,000 tasks in Microsoft Project 98, for example, or more than 10 outline levels, and then save to an MPX file, Microsoft Project 98 writes all the tasks and all the outline information to the MPX file. If you try to open that MPX file in Microsoft Project 4.x, you get alerts as the records are read stating that they exceed the various Microsoft Project 4.x limits.

Save to MPX warning

Because of the potential lost or changed data, the following alert is displayed when you attempt to save a Microsoft Project 98 file in the MPX format (assuming you haven't chosen to turn off the alert when it was previously displayed):
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Upgrading a Microsoft Project 4.x Global.mpt

When you upgrade to Microsoft Project 98, there are a number of issues surrounding Global.mpt. 

If you install the new Microsoft Project 98 global file, you lose all of your previous customized views, tables, toolbars, menus, filters, reports, forms, and calendars. On the other hand, if you load a global file from a previous version of Microsoft Project, instead of the new Microsoft Project 98 Global.mpt, you don't get instant access to all the new features. There are also issues with items such as macros that have been eliminated, changed, or added in Microsoft Project 98, versus macros that were created or shipped with the prior version.

Microsoft Project 98 solves this problem by allowing you to import information from your old Global.mpt. 

During Setup, if you choose to install Microsoft Project 98 over an existing version of Microsoft Project in the same folder, and if an existing Global.mpt file is found, Setup renames it. The new name is Globalxx.mpt, where xx is the corresponding version of Microsoft Project (it uses an alternative name if that one is already taken). For a Microsoft Project 4.x or Microsoft Project 4.x global file, the new name is Global40.mpt. If Microsoft Project 98 setup cannot detect the version of the Global.mpt file (for example if it's corrupt or is not really a global file), then Setup renames the file to Globalxx.mpt, literally with the x’s (or an alternative name if that one is already taken).

The rest of this discussion assumes the old global file has been renamed as Global40.mpt.

When Setup detects and renames the old global file, it makes a registry entry with the new name of the old file (including the entire path):

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\8.0\MS Project\Previous Global

The key has the following registry name value and data:

Name
Data

Renamed Global File
<full-path>\Global40.MPT

Previous Global setting in the registry...
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If you have a problem with Microsoft Project 98 and need to reinstall, the Microsoft Project 98 Global.mpt file is not overwritten. So if you customized anything in Microsoft Project 98 or moved over the items from an old global, the changes are retained on reinstall. If the “Previous Global” registry key exists, Setup does not change the Data Value when reinstalling Microsoft Project 98 over Microsoft Project 98, insuring that it still knows the name of the previous global file if you have not yet upgraded (imported) it.

Microsoft Project 98 always boots with the new version of Global.mpt. When the registry flag indicates that there is an old Global.mpt file, the following wizard is displayed:

If Microsoft Project 98 detects the 'Previous Global' registry key...
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If you choose Cancel to exit without upgrading, the message is displayed again on the next boot unless you check the Don’t tell me about this again checkbox. If you check the Don’t tell me about this again checkbox and later want to move some items over from the old global file, the only way to do it is to open Global40.MPT through the File Open dialog. This automatically displays the Organizer in the new special global upgrade mode (this will be discussed in detail later).

After checking the Don’t tell me about this again checkbox, or after an automatic upgrade, a second registry No Alert entry is created under the same key, and set to Yes as shown below:
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When Microsoft Project 98 starts, if No Alert is set to Yes, Microsoft Project 98 does not display the upgrade wizard.

Automatic Updating

If you select the automatic upgrade option, Microsoft Project 98 determines which items were user-edited in the old global and moves all those items over to the Microsoft Project 98Global.mpt.

After an automatic upgrade, Microsoft Project 98 sets the No Alert registry value (described above) so that the upgrade wizard is not displayed the next time you start Microsoft Project 98.

The following list describes the upgrade that takes place for each type of item:

Views

Each customized Microsoft Project 4.x view replaces the view with the same name in Microsoft Project 98, or is added to the list of views if the name does not exist in Microsoft Project 98. The exceptions to this are the Tracking Gantt, Detail Gantt, and Delay Gantt. You need to move them over manually if they have any customizations that you want to retain.

If any of the Microsoft Project 98 Gantt views are replaced with the old version during an upgrade, Microsoft Project 98 adds in the bar styles for Split, Rolled Up Split, Ghost Task, and Project Summary to make sure all the Microsoft Project 98 features are present.

Tables

Each customized Microsoft Project 4.x table replaces the table with the same name in Microsoft Project 98, or is added to the list of tables if the name does not exist in Microsoft Project 98. If the Microsoft Project 98 Task Entry, Resource Entry, Delay, Rollup Table, or Resource Usage table is replaced with an old version, Microsoft Project 98 inserts the Indicators column into the imported table.

Microsoft Project 98 no longer exposes the fixed field, if there is such a column in a task table, the Type field replaces it.

Toolbars

Any customized toolbar items are added to the end of the same-named toolbar in Microsoft Project 98. If a custom button has been added and it has a custom button face, the button face is moved over as well, but other changes involving button faces are ignored. If a same-named toolbar does not exist in Microsoft Project 98, the entire toolbar is moved over. If the command associated with a particular button is no longer supported in Microsoft Project 98, the button is not moved over. 

The Microsoft Project 4.x  "Visual Basic" and "Microsoft Project 3.0" toolbars are not to be imported, and any customization on those toolbars is lost.

Menus

If any customized menu items in the Microsoft Project 4.x “Standard” menu bar are detected, the entire menu is brought over to Microsoft Project 98 as a custom toolbar called “Standard (Microsoft Project 4.x).” The Microsoft Project 4.x “Standard (no file)” menu bar is not imported, and any customization is lost. Any other new menu bars that do not exist in Microsoft Project 98 are moved over as new custom toolbars. If a menu command is no longer supported in Microsoft Project 98, the command is not imported.

When comparing Microsoft Project 4.x menus to the original unedited Microsoft Project 4.x menus, any change is considered a customization and the additional menu bar is created in Microsoft Project 98.

Any menu bars that have been moved over as new Microsoft Project 98 custom toolbars are hidden by default.

Filters

Each customized Microsoft Project 4.x filter replaces the filter with the same name in Microsoft Project 98, or is added to the list of filters if the name does not exist in Microsoft Project 98. 

Any filter that references the Fixed field is automatically rewritten to use the Type field instead. The Type field holds an enumerated value, while the Fixed field is Boolean (Yes/No). To account for this, the filter lines “Fixed equals Yes” and “Fixed equals No” become “Type equals Fixed Duration” and “Type not equals Fixed Duration,” respectively.

Forms

Each customized Microsoft Project 4.x form replaces the form with the same name in Microsoft Project 98, or is added to the list of forms if the name does not exist in Microsoft Project 98. 

Reports

Each customized Microsoft Project 4.x report replaces the report with the same name in Microsoft Project 98, or is added to the list of reports if the name does not exist in Microsoft Project 98. 

Calendars

Each customized Microsoft Project 4.x calendar replaces the calendar with the same name in Microsoft Project 98, or is added to the list of calendars if the name does not exist in Microsoft Project 98. 

Modules

User-defined Microsoft Project 4.x Visual Basic for Applications modules are brought over to Microsoft Project 98. Modules shipped with Microsoft Project 4.x that changed between Microsoft Project 4.x and Microsoft Project 98 are not replaced. The previously supplied “Database” and “Pivot Table” modules, which have been deleted in Microsoft Project 98, are not imported.

Microsoft Project 98 scans each of the modules that shipped with Microsoft Project 4.x, checking for any user-defined macros that have been added. If it finds any, they are moved over to Microsoft Project 98. This check works at the macro level (not the module level), based on macro name.

User-edits to macros that shipped with Microsoft Project 4.x are not imported.

If there are any password-protected modules, you are prompted for the password of each module, one at a time as shown below:

[image: image27.png]sssword Protected Module:

The VEA modue PasswardPratectedMiodue has been hidden, Please
enter the password to unhide this modke. IF you can not supply the
password, the modue wil be moved to a il where the modues il be
permanentiy protected.

password: [

Sk This Modue | Sk all Modes | o





If you click OK, Microsoft Project 98 checks the password against the one Microsoft Project 98 has for that module. If the password matches, Microsoft Project 98 unhides that module, leaves it in the current file, and continues reading the other modules. If the password does not match, then it displays the following alert:
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When you click OK, the “Password Protected Module” dialog is displayed again. This cycle continues until you supply a matching password, click “Skip All Modules,” or click “Skip this Module”.

Skip All Modules moves all the hidden modules into a new file (that Microsoft Project 98 creates) and Microsoft Project 98 won’t prompt you for any more passwords. This file is code-protected with an unknown password. You can never edit/record macros in that module again. If you click on it in the Microsoft Project Explorer it displays the alert:
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Skip this Module moves only that one hidden module into a new file (that Microsoft Project 98 creates) and continues reading other modules.

After Microsoft Project 98 has gone through all the protected modules, and either unhides or moves them, if any protected modules have been moved to a new file, it changes the name of the Visual Basic for Applications Project for this new file to “filenameMacros”, where filename is the current name of the file. For example, for Pj95ProtectedModule.mpp, the Visual Basic for Applications Project would be called Pj95ProtectedModuleMacros. If the length of “filenameMacros” exceeds the maximum allowed for Visual Basic for Applications Project names, then it truncates filename enough to append “Macros” to the end, and uses that as the Visual Basic for Applications Project name.

Then Microsoft Project 98 tries to save the file. The file name that it tries to save to is filenameMacros.mpp, where filename is the current name of the file. For example if the Microsoft Project 4.x file is Pj95ProtectedModule.mpp, the Microsoft Project 98 tries to save to Pj95ProtectedModuleMacros.mpp. Microsoft Project 98 saves this file to the location that the File Save As dialog defaults. 
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Once the Macros file has been saved, Microsoft Project 98 creates a Reference from the original Microsoft Project 4.x file to the new filenameMacros.mpp file (VBE Tools.References menu command). Microsoft Project 98 then leaves you in the original file, at the same place you would have been if this were a “normal” open.

Global Upgrade Mode in the Organizer

If you select Upgrade manually in the upgrade wizard, or if you cancel the upgrade wizard and then later open the old Global40.mpt file using the File Open command, then Microsoft Project 98 displays the Organizer in a special global upgrade mode, with the old Global40.mpt on the left and the new Global.mpt on the right:

Organizer's new global upgrade mode...
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In this special upgrade mode, you can only move items in the upgrade direction from the old global to the new. The file drop-downs on both sides are also disabled.

The Copy button is changed to read Upgrade, which, depending on the current tab, sometimes does a merge of the old data with the new and sometimes does an overwrite. The particular action is the same as that described previously in the “Automatic Updating” section for each type of item, except that the upgrade only occurs for those items that are selected on the left when you press the Upgrade button.

The Organizer does not display alerts if you pick an item to upgrade on the left that conflicts with a name on the right. If you want to avoid a conflict/overwrite, the Rename button can be used to rename an item on either side before moving items over (any renaming of items on the left are not saved back to the old global file). The Upgrade button is always disabled when you click in the Microsoft Project 98 Global.mpt listbox on the right.

When you press Close, the Organizer closes and the old global file is closed.

After a manual upgrade session, Microsoft Project 98 does not set the flag in the registry.  The upgrade wizard is displayed each time you start Microsoft Project 98 until you check the Don’t tell me about this again checkbox or choose the automatic upgrade option.

Cross-Language Upgrading

When you choose the automatic upgrade option in the upgrade wizard, Microsoft Project 98 looks in the file for evidence that the language of the global file and Microsoft Project 98 are the same. If the old Global.mpt is a different language, an alert is displayed stating that you will have to do a manual upgrade because of the difference in languages. The alert only has an OK button, and when you click it, the Organizer is displayed in global upgrade mode.

Opening Microsoft Project 98 Global Files

In Microsoft Project 4.x, if you try to use the File Open command to open a global file, you get an error message saying that you cannot open a global file.

Microsoft Project 98 is also capable of opening Microsoft Project 98 global files (in addition to upgrading from Microsoft Project 4.x global files as discussed previously). This allows you to access another user’s global data without the need to pass items back and forth in a project file.

If you want to access the contents of another global file, either from a previous version or from the current version of Microsoft Project 98, all you need to do is explicitly open it using the File Open dialog. 

· When opening an old global, you are placed in the Organizer in the upgrade mode as described above. 

· When opening a Microsoft Project 98 global, you are placed in the Organizer in the normal Organizer mode. 

If you select two Microsoft Project 98 global files in the Organizer, data can be passed back and forth in either direction as with MPP files.

The only restriction is that you cannot use File Open to open the currently active Global.mpt. Attempting to do so results in an alert. However there is no need to explicitly open the active Global.mpt since it is in the Organizer list of files anyway.

Forcing Microsoft Project 98 to Boot with an Old Global File

Microsoft Project is capable of starting up and using a Global.mpt file from Microsoft Project 4.x. All you need to do is replace the Microsoft Project 98 Global.mpt file by the Microsoft Project 4.x one.

When it starts up with a Microsoft Project 4.x Global.mpt, you are restricted to the items contained in the old global and no upgrading takes place. Other than that, it behaves like a Microsoft Project 98 global file, and upon exit, the global is rewritten in Microsoft Project 98 format (without the new items shipped with Microsoft Project 98). 

Upgrading a Microsoft Project 4.x MPP file

Upgrading Views, Tables, and Other Settings

When Microsoft Project 98 loads a Microsoft Project 4.x file, the same upgrade performed when merging global files automatically takes place for views and tables stored in the MPP. So, when opening a 4.x MPP, Microsoft Project 98 adds the Split, Rolled Up Split, Ghost Task, and Project Summary bar styles to any Gantt-style views stored in the file.

If the 4.x file contains the Task Entry, Resource Entry, Delay, Rollup Table, or Resource Usage Table, Microsoft Project 98 inserts the Indicators column into the table at the second column position.

Any tables that contain a Fixed field column are converted to the Type field and any filters referencing the Fixed field are updated as described earlier.

There are a few preference settings that require special handling in Microsoft Project 98 because the settings did not exist in Microsoft Project 4.x, or because the default has changed in Microsoft Project 98. 

Tools Options tab: setting
Action When Reading Microsoft Project 4.x Files

View tab: Show Outline Symbols
Set the option ON

Calculation tab: Default fixed costs accrual
Set the option to Start

Calendar tab: Use starting year for FY numbering
Set the option OFF

Schedule tab: New tasks are effort driven
Set the option to match the current Project 98 default (which is normally ON, but can be turned OFF and saved as the default). If this option is set to ON, each task read in is set as Effort Driven.

Calculation tab: Edits to total task % complete will be spread to the status date
Set the option to match the current Microsoft Project 98 default.

Calculation tab: Actual costs are always calculated by Microsoft Project
Set the option to match the current Microsoft Project 98 default.

Calculation tab: Edits to total actual cost will be spread to the status date
Set the option to match the current Microsoft Project 98 default.

Calculation tab: Calculate multiple critical paths
Set the option to match the current Microsoft Project 98 default.

Edit tab: For Time in '<project-name>' Show

Minutes as
Hours as
Days as
Weeks as 
Years as
Set the option to match the current Microsoft Project 98 default.

Edit tab: Add space before label
Set the option to match the current Microsoft Project 98 default.

Lesson 2.2 - Exercises

1.
Which of the following are file types that Microsoft Project 98 can read?

A. Microsoft Project 4.x MPP

B. Microsoft Project 98 MPP 

C. Microsoft Project  4.x MPX

D. Microsoft Project 98 MPX

E. Microsoft Project 4.x Global.mpt  

F. Microsoft Project 98 Global.mpt

G. Microsoft Project 4.x MDB  

H. Microsoft Project 98 MDB  

I. Microsoft Project 4.x MPD

J. Microsoft Project 98 MPD

K. Microsoft Excel 97 XLS

L. dBase IV

M. HTML

N. CSV

2. 
Is it possible for someone using Microsoft Project 4.x and someone using Microsoft Project 98 to take turns working on the same project file? If no, then why not? If yes, then how can they do it and what are some of the drawbacks?

3.
What happens if Microsoft Project 98 Setup finds a Microsoft Project 98 Global.mpt file already in the folder where Microsoft Project 98 is being installed? What about Backup.mpt?

4.
Suppose that you install Microsoft Project 98 and the first time you run it you get a PlanningWizard dialog whose first sentence is "Would you like to move your global settings from your previous installation of Microsoft Project to Microsoft Project 98?". 

A. What entries in the Registry are related to this dialog?

B. Is it possible to alter the Registry to force this message to display even if no files from a previous version of Microsoft Project are on the machine where Microsoft Project 98 is being installed?

C. What's the difference between the Upgrade automatically and Upgrade manually options in this dialog?

Lesson 2.2 - Lab

This lab requires access to the Microsoft Project 95 disks or CD.

1. Uninstall Microsoft Project 98 if it is already on your computer.

2. Install Microsoft Project 95 into the folder C:\Project. Run Microsoft Project 95 and create a copy of the Standard menu bar, and rename the copy as MyMenuBar. Exit Microsoft Project 95. 

3. Install Microsoft Project 98 into the folder C:\Project. 

4. After installation, run Microsoft Project 98 and choose the Upgrade automatically option. What happens to MyMenuBar?
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Lesson 3.1: Overview of the File System

Some topics to be introduced in this lesson include:

· Overview of Microsoft Project 98 file system.

· File Formats Supported in Microsoft Project 98.

· Code Page Support.

· The Serializer Loading Scheme.

· Loading from the Network.

· Specifics of Serializer Registration.

Overview of Microsoft Project 98 file system

In Microsoft( Project 98, all of the read/write code has been completely rewritten. The new I/O architecture is designed for extensibility, employing a new scheme for installable file serializers (converters). Adding support for a new file type only requires creating a new serializer DLL. In addition, the design encompasses the expanded ODBC support that provides a generic method of handling import/export of external database formats. This new architecture also provides a way to implement forward compatibility with future versions of Microsoft Project. For example if there is a Microsoft Project version 9.0 some time in the future, and if the appropriate serializer is available for Microsoft Project version 8.0, then a Microsoft Project 9.0 MPP file could be opened in Microsoft Project 8.0. The way that new features from the future version are handled when opening the file in a previous version depends entirely on the designer of the serializer. Note that this forward compatibility feature begins with Microsoft Project 98. Serializers cannot be written for Microsoft Project 4.x.

New MPD format

To improve the file interchange support and enable cross-language file compatibility, a new Microsoft Project Database (MPD) file-type is replacing the MPX file format as Microsoft Project’s standard interchange file format.

File Formats Supported in Microsoft Project 98 

Microsoft Project File Formats

In addition to the Microsoft Project 98 MPP format, Microsoft Project 98 supports the following Microsoft Project file formats:

· Reading data from Microsoft Project 4.x MPP files.

· Reading Organizer information (such as views, tables, and filter) from Microsoft Project 4.x MPP files and MPT files, including Global.mpt.

· Reading data from Microsoft Project 4.x MDB files.

· Reading data from Microsoft Project 1.x, 3.x, or 4.x MPX files.

· Saving Microsoft Project 98 data as Microsoft Project 4.x MPX files.

External File Formats

Microsoft Project 98 can also read from and write to the following external file formats:

· MPD/MDB files (these are both Microsoft Access 8.0 format).

· Microsoft Excel 97 XLS files (read but not write).

· Microsoft Excel 5.0/95 XLS files.

· Microsoft Excel 5.0/95 PivotTables (write but no read).

· TXT files.

· CSV files.

· HTML files (write but not read).

MPD and MDB files are actually handled through ODBC, but they allow you to bypass the ODBC connection dialogs.

File Save file types

Below is the complete list that appears in the Microsoft Project 98 File Save dialog file-type drop-down:

· Project (*.mpp)

· Template (*.mpt)

· Project Database (*.mpd)

· MPX 4.0 (*.mpx)

· Microsoft Access 97 Database (*.mdb)

· Microsoft Excel Workbook (*.xls)

· Microsoft Excel PivotTable (*.xls)

· HTML Document (*.html)

· Text (Tab delimited) (*.txt)

· CSV (Comma delimited) (*.csv)

The system list separator as specified in the Control Panel always delimits the CSV format. Thus, even though the entry in the list for CSV says, “comma delimited,” it may is delimited by something else. 

File Open file types

Below is the complete list that appears in the File Open dialog file-type drop-down:

· All Files (*.*)

· Microsoft Project Files (*.mp*)

· Projects (*.mpp)

· Project Databases (*.mpd)

· Templates (*.mpt)

· Workspaces (*.mpw)

· MPX (*.mpx)

· Microsoft Access Databases (*.mdb)

· Microsoft Excel Workbooks (*.xls)

· Text (*.txt)

· CSV (*.csv)

Microsoft Project 98 does not support the opening of Microsoft Excel files that are password protected. Instead you get an alert saying that the file cannot be opened.

Handling Unrecognized Files

When opening any file, Microsoft Project 98 does more than just look at the file extension. It first looks inside the file for the type. If Microsoft Project 98 does not recognize the file structure or if it finds no identifying signature, then Microsoft Project looks at the extension. If the extension is TXT or CSV, Microsoft Project attempts to open the file as specified by the extension. If file with the unidentified format has any other extension, then the following alert is displayed:
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If you select Yes then Microsoft Project tries to open the file as a TXT file.

Re-opening Files

When you try to re-open an MPP file that’s already open, Microsoft Project brings only the open copy to the foreground. The same is true for full projects opened from ODBC databases. For the complete projects (full save to database), only a single instance can be active on a machine, and Microsoft Project maintains a connection to the original project on disk. You can do a File Save at anytime without specifying the project or filename again.

In the case of imported data from files like MPX, TXT, XLS, CSV, and partial (selective) reads from an ODBC database, no connection is maintained to the original location on disk. Once the data is read in, if you try to do a File/Save, the File Save dialog is displayed and you must re-specify the file type and all of the file parameters again. Because there is no connection to the original file or database, Microsoft Project does not associate a file-type with this data and there is no extension shown in the Microsoft Project title bar. This has the following effects:

· All files with the same base name show the same name in the title bar (for example, MyProject.xls, MyProject.txt, and MyProject.mpx all show just MyProject in the title bar).

· If you attempt to open more than one file with the same base name, then Microsoft Project appends “-2” to the name in the title bar of the second file, appends “-3” to the name of the third file, and so on (for example, MyProject-2, MyProject-3, and so on).

· You are able to open the same file more than once (since Microsoft Project is not keeping track of where the data was imported from). You may have multiple copies of the same data in memory (for example, opening MyProject.txt over and over again just results in Microsoft Project having identical windows with MyProject, MyProject-2, MyProject-3, and so on).

· The appended number appears as part of the default filename in the File Save dialog if you try to save one of the numbered projects (for example, the default name in the File Save dialog for MyProject-2 is MyProject-2.mpp).

Additional special cases are listed below for performing a selective read from a database or from complete projects with identical names:

· On a partial read from a database, the new project has no name at all associated with it, so the title Project<x> is displayed in the title bar, where <x> is the next unused integer. Doing another selective read results in Project<y>, where <y> is the next unused integer. For example, if the first one is titled Project3, and you immediately open it again, then the next one is titled Project4.

· If you give two projects in different databases the same name, opening both of those projects at the same time causes Microsoft Project to display the DSN (Data Source Name) name in the title bar preceding the project name. For example,

<C:\MyData\MyAccessFile.mdb>\MyProjectName

The same thing occurs if you have two DSNs with different names pointing to the same data source. Opening the project the first time just shows the project name in the title bar, but if the project is opened again via the second DSN, both windows then show the DSN name in the title bar preceding the project name.

· If you have two MPP files in different directories that have the same name, opening both of those projects at the same time causes Microsoft Project to display the filename in the title bar with it’s full path.

· With Microsoft Project 4.x projects written to a database, even though the operation was considered a “full project save” at the time it was written for Microsoft Project 4.x, reading the data back into Microsoft Project 98 is handled like a selective read (with no connection maintained to the database). The project name from the database is used in the title bar, but the string “(Read-Only)”, without quotes, to convey the sense that a “real” project was opened, but it cannot be saved back to the same location.

Microsoft Project and/or File Name Display in the MRU List and Title Bar

Microsoft Project 98 has a new setting in the Tools Options General tab that control how many items are listed on theMRU list:
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The following table shows the naming syntax for the File menu MRU (Most Recently Used) list, and the title displayed in the title bar, depending on how the project is opened:

Scenario
MRU List Display
Title Bar Text

A full project opened from an MPP file
FileBasename.mpp
FileBasename.mpp*

A full project opened from an ODBC database (via a machine DSN)
<Data Source Name>\ProjectName
ProjectName*

A full project opened from an ODBC database (via a file DSN)
<ODBC Driver Name>\ProjectName
ProjectName*

A full project opened from an MPD or MDB file
<FileBasename.ext>\ProjectName
ProjectName

A full project opened from a Microsoft Project 4.x database
<Data Source Name>\ProjectName
ProjectName (Read-Only)

Opening a template (MPT) file
FileBasename.mpt
FileBasename

A selective import from a TXT, CSV, or XLS file
FileBasename.ext (MapName)
FileBasename

A selective import from an ODBC database (via a machine DSN)
<Data Source Name> (MapName)
Projectx (where x = next unused number)

A selective import from an ODBC database (via a file DSN)
< ODBC Driver Name > (MapName)
Projectx (where x = next unused number)

*
In the case where two projects with the same name in different directories are opened, the full path is displayed in the title bar with the file name, once you open the second project.
In the case where two projects with the same name in different databases are opened, or when you open the same project twice through two different DSNs, the data source name is displayed in the title bar with the project name once you open the second project.

Code Page Support

Microsoft Project 98 uses Unicode internally. Windows 95 is not a Unicode OPERATING SYSTEM, so a number of new code page issues arise. Any time data is passed into or out of Microsoft Project 98, it must undergo a conversion based on some code page. 

Microsoft Project 98 utilizes an internal code page record for native files and has a standard code page default scheme for all external data import and export. Whenever Microsoft Project 98 must convert data to or from Unicode, the code page to use is resolved by the following rules:

· If the file contains a code page record, use the specified code page.

· Whenever the code page is not specified in the file, use the code page that is currently set in the Regional Settings of the Control Panel.
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Nothing is based on the language of the operating system itself or on the language of the version of Microsoft Project in use. When you create a new project, a record is created with the value of the code page currently set in the Control Panel. On an open or import, if the source file does not have a code page record (for example, on an import from a TXT file), it is converted based on the current setting. That code page information is stored in the project. Consequently, no project can be open in Microsoft Project 98 without an associated code page. So, for any save or export, Microsoft Project knows the code page to use, and it saves that information with the project in the MPP, MPX, XLS, and database cases.

In the database case, the code page of the database is used when viewing Microsoft Project data from within the database application. However, Microsoft Project still stores the code page information out with the data on a full save to database, whether or not the database application does anything with it.

Overriding the default code page

If you need to write out to an external text-based format based on a code page other than the current one, or if you need to read from an external text-based file created with a code page other than the current one, you can change the code page in the Control Panel (assuming it's available) and then read or save the external file.

Code Page Conversion with Microsoft Project 4.x Files

When reading a Microsoft Project 4.x file, the Japanese and Traditional Chinese releases include a flag in the MPP header that specifies the version, so Microsoft Project knows what code page to use if it encounters one of the FE (Far East) files. For the other languages, Microsoft Project opens the file using the current system code page. 

Missing Code Pages

Whenever Microsoft Project 98 opens a file like an MPP with a known code page, it uses the specified code page to display the data with the correct character set. If the specified code page is not available on the user’s system, Microsoft Project 98 displays the following alert to inform you that the necessary code page is not installed. If you choose the alert OK button, there’s a good chance that much of the data may appear as unreadable. If you choose the alert Cancel button, the import process ends. The alert is also displayed during an import from a TXT or CSV file where the File Origin setting in the map (which can be specified on the Options tab of the Define Map dialog) specifies a code page (for example, Macintosh) that is not available on the current system. When a file has been opened in this way and is then edited, it may not save properly, since it has to use the wrong code page when converting back from Unicode. 

[image: image35.png]aN

There i a probler with the character set s file usss.
The e was created with a character set that i not available on this system, IF you
open o save the fle under the defult languags or character set, some data may
appear cormupt and unreadable.

To continue, cck OK.

To cancel,cick Cancel.

& el





Forward Compatibility with MPP Files

Microsoft Project 98 introduces a new scheme that allows it to be forward compatible with new Microsoft Project file formats that may be introduced in future releases. The scheme relies on the new installable file serializers. It takes advantage of the Web integration in Office 97 to obtain the necessary serializer if it is not currently on your system.

Starting with Microsoft Project 98, Microsoft Project is able detect newer file formats. There are two possible scenarios:

· If no local (or network) installed serializer is found, it connects you to the Microsoft Web and allows you to download the serializer.

· If system administrators want to make a serializer available to everyone on their network, they can configure user's registries to point to where Microsoft Project should look for the serializer on the network.

The Serializer Loading Scheme

The serializer loading process is summarized in the list below:

· Get the clipboard format from the file and create the CFMT string.

· Check the CFMT registry entry for the serializer string.

· Check the serializer registry entry for the Class ID string.

· Check the Class ID registry entry for the in-proc handler name.

· Load the in-proc handler.

This scheme is the same for MPP files and other files that Microsoft Project supports, such as XLS. The rest of this section focuses on the MPP case.

When Microsoft Project encounters an MPP file, it looks at the header information in the file to determine the MPP version number. If the version is greater than that of the version of Microsoft Project in use, Microsoft Project looks in the registry to see if an appropriate serializer has already been registered for the newer format.

If no registered serializer is available, Microsoft Project makes a call to the Office DLL (MSO97.DLL). This call succeeds if the Office DLL determines that you have the means to connect to the Web, for example, if you have a Web browser installed on your system.

If the call fails (because no browser is detected), Microsoft Project displays an alert stating that the file cannot be opened.

If the Office DLL detects a browser, it displays an Office alert explaining that you are trying to open a project created in a newer version of Microsoft Project, and it asks if you want to download the appropriate converter (serializer) from the Microsoft Web site. The alert contains Yes and No buttons. If you click No, then an alert is displayed stating that the file cannot be opened. If you click Yes, the Office DLL uses an appropriate URL from the registry or the default URL hardcoded in the Office DLL used to connect to the Office Web site. On the Web server end, a new Office redirector component (redir.dll) directs the connection to the actual Web location with the Microsoft Project serializers. The redirector is used to allow moving serializers around on the Web site or adding a new Web location just by changing or adding entries in a redirection database on the server.

The Web site has options for downloading whatever serializers happen to be available. Clicking on one downloads a self-extracting EXE file that installs the serializer. Microsoft Project then attempts to open the file again.

Although the original Office alert says that you will need to reboot after downloading the converter (serializer), Microsoft Project can install and use the serializer without rebooting. 

Loading from the Network

The path in the registry that is used to find the serializer can contain a UNC or a drive letter mapped connection. This allows the system administrator to place a single copy of the serializer in a central place and have all Microsoft Project installations point to that place. The administrator still needs to register the serializer on each system, but the serializer doesn’t need to be downloaded to each machine.

Specifics of Serializer Registration

When loading a file, Microsoft Project must determine which serializer to use. First, it determines the clipboard format string of the file if it has one. For an MPP file, it can determine the format from the data structure of the file. For other file types, it tries to determine the format of the file by reading the initial portion (header) of the file. If it cannot determine the clipboard format, then it displays an alert stating that it does not recognize the format, and offers to open the file as a text file.

Microsoft Project constructs a key from the clipboard format string to look up in the registry. The key has the form:

MSProject.CFMT.<clipboard-format-string>.8 

Microsoft Project then searches the registry under

HKEY_CLASSES_ROOT\MSProject.8.Serializers

The picture below shows a few of the CFMT keys in the left pane, with the one for CSV selected in the left pane, and its value data showing in the right pane.
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If a registry key is not found for the constructed string, then the Office dialog for downloading from the Web is displayed.

If the key is found, it contains a string value for the serializer, for example, MSProject.CSV.8 in the right pane of the above picture. The table below lists some of the registry CFMT keys that appear in the left pane, and their corresponding data value strings that appear in the right pane.

Registry Key
Value Data

MSProject.CFMT.Biff5.8
MSProject.XLS5.8

MSProject.CFMT.BiffPivot.8
MSProject.XLS5.8

MSProject.CFMT.Biff8.8
MSProject.XLS8.8

MSProject.CFMT.CSV.8
MSProject.CSV.8

MSProject.CFMT.HTML.8
MSProject.HTML.8

MSProject.CFMT.MDB8.8
MSProject.MDB8.8

MSProject.CFMT.MPM.8
MSProject.MPM.8

MSProject.CFMT.MSProject.Docfile.4.8
MSProject.Docfile.4

MSProject.CFMT.MSProject.Global8.8
MSProject.Global8.8

MSProject.CFMT.MSProject.MDB8.8
MSProject.MDB.8

MSProject.CFMT.MSProject.MPD8.8
MSProject.MPD.8

MSProject.CFMT.MSProject.MPX4.8
MSProject.MPX.8

MSProject.CFMT.MSProject.ODBC8.8
MSProject.ODBC.8

MSProject.CFMT.MSProject.Text.8
MSProject.TXT.8

Microsoft Project uses the value in the right pane as a new search key. When a key is found whose name is the value of the original CFMT key, the ClassID of this second key is used to locate the in-process serializer handler.
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If the CMFT key for the file type is missing (for example, if you rename or remove it), even for the MPP file type, then the following alert is displayed when you attempt to open a file of that type:
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MPX Compatibility

The MPD file is replacing the MPX file as the standard interchange file format. 

Microsoft Project 98 has not updated the MPX format to cover the new features in Microsoft Project 98. 
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An MPX file saved from Microsoft Project 98 may be scheduled differently when opened in Microsoft Project 4.x.

For example, if a resource is assigned to a 5 day ASAP task at .5 units, the Microsoft Project 4.x MPX resource assignment record looks like this:

  75,1,0.5,20h,0h,0m,0h,$0.00,$0.00,$0.00,Fri 12/16/94 8:00 AM,Thu 12/22/94 5:00 PM,0h,1

The format of the resource assignment record is:

  Record ID, ID, Units, Work, Planned Work, Actual Work, Overtime Work, Cost, Planned
  Cost, Actual Cost, Start, Finish, Delay, Resource Unique ID

Because of the new resource contouring feature in Microsoft Project 98 it is possible to have the same assignment span the same time, with the same units, but with a different work value. When Microsoft Project 4.x opens this MPX file, it changes the finish date of the assignment to reflect the start date and the work value. Although this example is easy to fix by having average units calculated in Microsoft Project 98, there are a number of such potential problems in supporting backward compatibility.

Many limits in Microsoft Project 98 have been increased, such as the number of tasks, maximum units, outline levels, and so on. Microsoft Project 98 does not do anything special to handle the changes. So if you have more than 10,000 tasks in Microsoft Project 98, for example, or more than 10 outline levels, and then save to an MPX file, Microsoft Project 98 writes all the tasks and all the outline information to the MPX file. If you then try to open that MPX file in Microsoft Project 4.x, you get alerts as the records are read, stating that they exceed the various Microsoft Project 4.x limits.

Save to MPX warning

Because of the potential lost or changed data, the following alert is displayed when you attempt to save a Microsoft Project 98 file in the MPX format (if you haven't selected to turn the alert off when it was previously displayed):
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Opening Microsoft Project 98 Global Files

In Microsoft Project 4.x, if you try to use the File Open command to open a global file, you get an error message saying that you cannot open a global file.

Microsoft Project 98 is capable of opening Microsoft Project 98 global files as well as being capable to upgrade from Microsoft Project 4.x global files, as discussed previously. This allows you to access another user’s global data without the need to pass items back and forth in a project file.

If you want to access the contents of another global file, either from a previous version or from the current version of Microsoft Project 98, use the File Open dialog to explicitly open it. 

· When opening an old global, you are placed in the Organizer in the upgrade mode as described above. 

· When opening a Microsoft Project 98 global, you are placed in the Organizer in the normal Organizer mode. 

If you select two Microsoft Project 98 global files in the Organizer, data can be passed back and forth in either direction as with MPP files.

The only restriction is that you cannot use File Open to open the currently active Global.mpt. Attempting to do so results in an alert. However, there is no need to explicitly open the active Global.mpt since it is in the Organizer list of files anyway.

Lesson 3.1 - Exercises

1.
What file types in the File Open dialog are not listed in the File Save dialog?

2.
What file types in the File Save dialog are not listed in the File Open dialog?

3.
Suppose the following item is listed on the Most Recently Used list at the bottom of the File menu: <C:\Dbs\MyProjs.mdb>\Mfg
What does this notation mean?

4. 
Which of the following are true regarding the ability of Microsoft Project 98 to read MPP files created in future versions of Microsoft Project?

A. It will not be possible.

B. A serializer has to be created that allows Microsoft Project 98 to read the MPP file from the newer version of Microsoft Project.

C. The newer version MPP file has to be saved from the newer version of Microsoft Project in the Microsoft Project 98 MPX format.

D. All future versions of Microsoft Project will use exactly the same file format as Microsoft Project 98, so nothing special has to be done.

Lesson 3.1 - Labs

Lesson 3.1 - Lab 1

This lab allows you to experiment with the Registry settings related to the serializers that Microsoft Project 98 uses when reading files.

1.
Create a project with one task and save it in CSV format. Select the predefined Default task information map when the Export Format dialog is displayed. After saving the file, close the active project and don't save changes. Exit Microsoft Project.

2.
Use the Find command in the Windows Registry Editor (regedit.exe) to locate the subkey MSProject.CFMT.CSV.8 under the key MSProject.8.Serializers.

Rename the subkey as xMSProject.CFMT.CSV.8 and then close the Registry Editor.

3. 
Run Microsoft Project 98 and on the File menu click Open and try to open the CSV file that you created in step1. You should get an alert indicating that it can't find the file or that it does not understand the file format. Close Microsoft Project.

4. 
Use the Registry Editor to rename the subkey from step 2 back to its original name.

Lesson 3.1 - Lab 2

This lab illustrates the scheduling differences that may occur when a user of Microsoft Project 4.x opens an MPX file saved from Microsoft Project 98.

This lab requires both Microsoft Project 95 and Microsoft Project 98. 

1.
Run Microsoft Project 98. In row one of a new project, enter T in the Task Name column and R in the Resource Names column. The task should default to 1d duration.

3.
On the View menu click Task Usage. Double-click the assignment record and select Bell from the Work contour dropdown list in the Assignment Information dialog General tab, and then click OK. Enter 10d for the task Duration. The Work should automatically change to 40h. Note the task Start and Finish dates.

4.
Save the project using the MPX 4.0 format.

5.
Run Microsoft Project 95 and open the MPX file that you saved in step 4. Does it have the same Start and Finish dates it had in Microsoft Project 98? Explain.

Lesson 3.2: Import-Export Interface

Some Topics to be introduced in this lesson include:

· The Microsoft Project 98 Import-Export Interface

· ODBC Interface

· Reading and Writing Data in Microsoft Project 98

· New Import/Export Maps

· Changes to the File Open and File Save Dialogs

· The Read and Write Process

· Performing a Non-ODBC Save of a Complete Project

· Saving a Complete Project to an Arbitrary Database Via ODBC

· Loading a Complete Project

· Concurrent Usage and Project Locking

· Database Permissions

· Database Modification or Corruption

· Importing Selective Data from an Arbitrary ODBC Database

· Import/Export with Non-Database File Formats

· Selective Import/Export to Microsoft Excel

· Selective Import/Export to Text File Formats

· Selective Export to a Microsoft Excel Pivot Table

The Microsoft Project 98 Import-Export Interface

Note: Saving in HTML format is covered in detail in a separate lesson. Much of the general map information in this lesson also applies to saving in HTML format.

ODBC Interface

ODBC provides a means by which Microsoft Project can store and retrieve project information from arbitrary data sources. 

Microsoft Project 95 had an ODBC interface written by a third-party, a macro stored in a hidden Database module. It used MPX format as an intermediate step.

Microsoft Project 98 instead has an internal, uniform solution for reading and writing data both directly and through ODBC. This new interface is being expanded to permit full or partial data import and export and support a new item called an import/export map. the maps allows you to specify how to map fields in Microsoft Project to fields in a database, spreadsheet, or text file. Import/export maps can be saved and reused, to simplify repetitive tasks like exporting specific Microsoft Project data for regular reports. A map created for export can be used to read the same fields back in.

Whether importing or exporting data to a file or to a database, a whole project or a few fields at a time, there is a consistent process and interface, all available through the File Open and File Save dialogs.

Reading and Writing Data in Microsoft Project 98
Microsoft Project data can be saved in two distinct ways: 

1. As a complete project including all formatting so that Microsoft Project can later read this information back in and fully recreate the original project (with any legal changes made outside of Microsoft Project).

2. As selective task, resource, and assignment fields that can be used in other applications, Microsoft Project cannot recognize that as a complete project. For example, a table can be written to Microsoft Excel or a text file, as in previous versions of Microsoft Project. Or you can create a new table in an ODBC database (new feature) and the Microsoft Project data written to the new table (existing tables can be overwritten, but merging/appending is not supported).

 Similarly, Microsoft Project data can also be loaded in two distinct ways: 

1. As a complete project with all data, formatting, and everything else, such that Microsoft Project understands and treats it as a native project

2. As selective data that is merged with or appended to the currently active project. This selective load might be something like the current import of a table from Microsoft Excel, the reading of data from a CSV file, or the mapping of particular fields in an arbitrary ODBC database to particular fields in Microsoft Project.

New Import/Export Maps

A new item being introduced in Microsoft Project 98 is an “import/export map” that contains information on how to map fields in Microsoft Project to the fields in an external data store. For example, an import/export map may be used to map the fields in Microsoft Project to the fields in a database table, to the columns in a Microsoft Excel worksheet, or to the columns in a text file. The maps are used to specify all kinds of import/export options. They alleviate the need of having to set up a table in Microsoft Project with the required columns in a specific order. Whenever selective data is being imported into or exported out of Microsoft Project, a map must be used to define the specific data and the scope of the operation.

Changes to the File Open and File Save Dialogs

The File Open and File Save dialogs are the starting point for all file and database I/O in Microsoft Project 98. Whether you save selective data or a complete project, and whether this is going to a file or an ODBC database, the process begins in the File Save dialog. Conversely, whether you read in selective data or load a complete project. Whether this comes from a file or an ODBC database, the process begins in the File Open dialog.

The Save to Database As and Open from Database commands that were previously found on a submenu under Multiple Projects on the Tools menu are being replaced by a new ODBC... button in the File Open and File Save dialogs:
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The file type drop-down list contains all the non-ODBC file types. In addition, the list contain the Microsoft Access MDB and the new Microsoft Project Database MPD file types (an MPD is really just an MDB with its own extension and it's only used for full project saves). The MPD file replaces the MPX file as the new standard format for data interchange and MDB files are included because they are one of the most common external data sources that is used with Microsoft Project.

Our internal scheme for accessing MPDs and MDBs is to go through ODBC, but this is transparent to the user, who can open or save an MPD or MDB file without going through the ODBC interface (though the ODBC interface works for MPD/MDB files as well).

This is the complete list (in order) that appears in the File Save dialog Save as type drop-down list:

· Project (*.mpp)

· Template (*.mpt)

· Project Database (*.mpd)

· MPX 4.0 (*.mpx)

· Microsoft Access 8.0 Database (*.mdb)

· Microsoft Excel Workbook (*.xls)

· Microsoft Excel PivotTable (*.xls)

· HTML Document (*.htm)

· Text (Tab delimited) (*.txt)

· CSV (Comma delimited) (*.csv)

This is the complete list (in order) that appears in the File Open dialog Files of type drop-down:

· All Files (*.*)

· Microsoft Project Files (*.mp*)

· Projects (*.mpp)

· Project Databases (*.mpd)

· Templates (*.mpt)

· Workspaces (*.mpw)

· MPX (*.mpx)

· Microsoft Access Databases (*.mdb)

· Microsoft Excel Workbooks (*.xls)

· Text (*.txt)

· CSV (*.csv)

The File Open and File Save dialogs also have an ODBC button that can be used to specify a DSN to save to or open from. A DSN is a text string identifying an ODBC datasource. An ODBC datasource includes a description of the kind of database, what driver to use, and any additional information necessary to connect to it. DSNs can be created with the ODBC icon in the Control Panel.

The table below tells which file types can do partial or full saves, and which support multiple projects in a single file:

File Types (including ODBC DSNs)

File Type
Full or Partial Save?
Multiple Projects in Single File?

Project (*.mpp)
Full
No

Template (*.mpt)
Full
No

Project Database (*.mpd)
Full
Yes

MPX 4.0 (*.mpx)
Partial. Depends on the Export table definition. No View information and so on. See MPXFILE.WRI
No

Microsoft Access 8.0 Database (*.mdb)
Full or partial
Yes

Microsoft Excel Workbook (*.xls)
Partial
No

Microsoft Excel PivotTable (*.xls)
Partial. Special layout in Microsoft Excel
No

HTML Document (*.htm)
Partial. Options to base on custom HTML template and to insert an image
No

Text (Tab delimited) (*.txt)
Partial
No

CSV (Comma delimited) (*.csv)
Partial
No

ODBC DSN's
Full or Partial
Yes

The Read and Write Process

The following sections outline the various processes of storing and retrieving full and partial project data. The complexity varies widely with each of the processes and there are particular procedures specific to the data format and storage medium. The design maintains as much interface consistency as possible for all read and write operations independent of where the data is stored, what the data access method is, what format the data is in, and whether it’s a complete project read/write or a partial import/export.

Performing a Non-ODBC Save of a Complete Microsoft Project

The procedure for saving a complete project in the native MPP format remains the same as before: You select Save As on the File menu to display the File Save dialog, specify the filename, click Save, and the data is written out.

In Microsoft Project 98, you also have the option of directly saving a full project to a Microsoft Project MPD or Microsoft Access MDB database file. Selecting the type of the file usually implicitly determines whether a complete project is to be saved, or whether just partial data is exported (for example, MPP always implies full, TXT always implies partial). However, in the case of MDB files, the file type can support either complete project storage or selective data I/O, so you must intervene to make the distinction.

In the indeterminate cases, you still select the file type in the file type drop-down, specify (or navigate to) the filename, and then click Save. Instead of directly writing the data in this case, it displays a dialog where you specify whether you want to save a complete project or selective data:

[image: image43.png]Export Format

Export
 Entire project (includes all data, views, formatting, etc.)

Narme to give the project in the database:

Projectl

" Selective data (allows you to export particular fields)





The title bar of this dialog reads either Export Format or Import Format depending on the operation underway when the dialog is invoked. For the remainder of this lesson it is referred to as the Import/Export Format dialog.

For MPD files, the Entire project option is selected and the Selective data option is disabled. For MDB files, both the Entire project and Selective data options are enabled and the Entire project option is selected by default. Whenever the Entire project option is selected, the Save button gets the focus. The Import/Export map to use for exporting listbox and the New Map, Edit, Copy, and Organizer buttons are all disabled. 

In addition, when the Entire project option is selected, the Name to give the project in the database drop-down combo box is enabled. It is always disabled when the Selective data option is selected. For a full save, it must get the name under which to save the project in the database, since multiple projects may be stored in the same file, and the drop-down allows you to see the names of all the projects that already exist in the database.

The default project name displayed is the title of the project, as entered into the Properties dialog. Since Microsoft Project pre-fills the title field with a default title and re-inserts the default if you clear the title field, there is always a default project name to use. The Save button is disabled whenever the Entire project option is selected and there is no text in the Name to give the project in the database field.

Once a name is entered and Save is clicked, all the appropriate tables are automatically created in the database, the entire project is written out, and you are returned to Microsoft Project. The cancel button completely terminates the save process and returns you to Microsoft Project.

If Save is clicked and the entered project name is the same as an existing project already in the database, a standard alert is displayed:
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When you choose Overwrite, it overwrites the existing project data and returns you to Microsoft Project. When you choose Cancel (the default) it returns you to the Name to give the project in the database field in the Import/Export Format dialog and pre-selects the text entered there.

There’s one other case concerning filename conflicts during a Save As. If you specify the name of an existing file in the File Save dialog, Microsoft Project normally displays an alert to inform you that it is about to overwrite the file. Microsoft Project gives you an opportunity to change your mind. But when you save to an MPD or MDB file and specify an existing filename, there is no way for Microsoft Project to know whether your intention is to add additional data to the same database file or whether you want to overwrite the existing file altogether. To clarify this, when the Save button is clicked, the following alert is displayed if the specified file is an existing MPD or MDB file:
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Append is the default in Microsoft Project, so all of the existing data is maintained. If you choose Overwrite, all existing data is lost and only the new data is stored. You may choose Cancel to return to the File name field in the File Save dialog, where the conflicting filename is pre-selected.

This occurs prior to the situation described previously where the project name may conflict. That could still be the case. So, if you specify an existing filename, and choose Append when presented with the first alert, and then specify an existing project name in the Export Format dialog, you get the “project already exists” alert as well.

Cross-Language Compatibility

Prior to Microsoft Project 98, a project saved to a database contained many language-specific items, so a project exported by one version of Microsoft Project could not be read back in by a different language version of Microsoft Project. With Microsoft Project 98, whenever you specify that data is saved to a database, the data written out contains numeric values for all of Microsoft Project’s enumerated types and for fields such as Duration. In other words, instead of exporting text strings such as “Tuesday” or “As Soon As Possible” to the database, it exports the numeric constants for the strings. The numeric values are language-independent, so any version of Microsoft Project 98 can read the data back in, regardless of the language of the version used to save the data. This new format also allows easy analysis across multiple projects of any language.

The downside is that having a lot of numeric values means the data is not very readable if you just look at the tables in the database. To offset this, whenever the export destination is a database Microsoft Project also exports a set of numeric-to-text conversion tables. The tables give you the ability to create views of the data in the database that contain the text strings (like in Microsoft Project) rather than the enumerated values. The conversion strings in the tables are in the language of the version of Microsoft Project being used, so locale-specific reports, and so forth, can still be generated from the database.

Most non-database formats don't have the option of exporting multiple tables at once. For non-database files such as TXT, CSV, XLS, and, Microsoft Project only exports text strings to make the data more readable. Thus, non-database exports are not language-independent.

Saving a Complete Project to an Arbitrary Database via ODBC

To initiate the process for saving a complete project to an ODBC database, select Save As on the File menu to display the File Save dialog, and then click the new ODBC button. This button closes the File Save dialog and takes you to the system ODBC Select Data Source dialog:
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This dialog is ODBC-supplied. The majority of details are not covered in this course.

The dialog contains all the available ODBC data sources on the user’s system. In addition, by using the New button, you can get to a list of all the ODBC drivers installed on the system. 
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After setting up a new DSN, you are returned back to the Select Data Source dialog.

Selecting a DSN from the list and clicking the OK button invokes any database-specific routines that may be required for opening the database or establishing a connection (for example, Microsoft Project passes control over to the ODBC driver). In some cases, there is a direct connection between a data source and a database file. You don’t need to go through any driver-specific routines for establishing a connection or opening a database (for example, selecting the data source is all that’s required), but usually there are some intermediate steps (associated with the particular database/driver).

If there is a problem establishing the connection, the following alert is displayed:
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If you connect successfully, once everything is taken care of on the data source/database side, control is returned back to Microsoft Project and the Import/Export Format dialog is displayed. From this point on, the process for saving a complete project to an ODBC database is identical to that described above for the Import/Export Format dialog when saving a complete project to an MPD or MDB file.

MPD and MDB are special cases that don't require all the intermediate ODBC dialogs. Whenever you are doing an open or save operation and specify the MPD or MDB file type, and then enter or select the filename, and then click the respective Open or Save button, the interim ODBC dialogs are skipped and you go directly to the Import/Export Format dialog.

Loading a Complete Project

There are no changes for loading a native project from an MPP file. The process for loading in an entire project from a Microsoft Project, Microsoft Access, or ODBC database is essentially the reverse of saving it out.

To load from an ODBC database, you first select the ODBC button in the File Open dialog, which invokes the ODBC Select Data Source dialog. You can choose (or add) a data source and then any database-specific open or connection routines are carried out.

Alternately, to begin the process of loading a complete project from an MPD or MDB file, you select the file type in the drop-down in the File Open dialog, specify the filename, and then click Save.

At this point, whether loading from MPD, MDB or ODBC, Microsoft Project looks in the specified file or database, determines what projects it contains, and the Import/Export Format dialog is displayed:
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During the open process, the dialog title is Import Format and the frame around the option buttons says Import instead of Export. The label for the project name field is Name of the project in the database to import instead of Name to give the project in the database. The label for the map list is Import/export map to use for importing instead of Import/export map to use for exporting. The Open button takes the place of the Save button, and when the Entire project option is selected, the Open button gets the focus.

For the MPD file type, the Entire project option is selected and the Selective data option is always disabled. For any other database, if the specified file/database is found to contain one or more Microsoft Project projects, then the Entire project option is selected and the Name of the project in the database to import field is a combo box that contains all the existing projects in the drop-down. The list is sorted in alphabetic (or NLS) order and the first name in the list is selected by default. You can choose a project name from the list (or type in a name) and then click Open to open the project. Clicking Cancel terminates the open process and returns you to Microsoft Project.

If you type a name into the Name of the project in the database to import field that is not a valid project in the database and click Open, the following alert is displayed:
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Clicking OK returns you to the Name of the project in the database to import field with the offending name selected.

If no proper (for example, complete) Microsoft Project projects are detected in the database, then the Selective data option is pre-selected, the Entire project option is disabled, and the Name of the project in the database to import field is cleared and disabled (for example, the only option is selective loading, which is covered later in this lesson).

No valid project found opening an MDB...
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If the file type is MPD and there are no proper Microsoft Project projects found, or if there are no tables at all in a non-MPD type of file or database, then the Import/Export Format dialog is never displayed and this alert is presented instead:

No valid project found opening an MPD...
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Clicking OK returns you to Microsoft Project.

Loading a Microsoft Project 4.x project from a database

Microsoft Project 4.x allowed projects to be saved to a database, but a “full save” in these versions did not include anything but data – no views, formatting, and so forth, were saved. Microsoft Project 98 understands the database structures used in Microsoft Project 4.x and can open the projects, but it cannot write out the formats. To write the data back out, you need to do a Save As to save the project out as a Microsoft Project 98 project.

Concurrent Usage and Project Locking

If you open a project in a database through Microsoft Project, and that project is not in use by another user, you will be given full read/write access. Until you finish your session with the project, you or any other user will be able to open that project from that database as read-only.

Example

The computer named Computer1 has an MPD saved on its C: drive:

C:\WIN95\Personal\Db xls\TimePhasedTests\tiph2.mpd

Tiph2.mpd contains the project Tiph2.

The C: drive of Computer1 is shared as \\Computer1\C, and the user on another computer is the first to open the project Tiph2 in Tiph2.mpd.

Now the user on Computer1 tries to open the project Tiph2 in Tiph2.mpd and the following alert is displayed:
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The reason the alert displays both possibilities is that Microsoft Project has no way of knowing whether you really have the file open with a separate DSN or whether you crashed while previously accessing the project with a different DSN. 

Tracking usage

Microsoft Project stores a string in the UserMachineID field in the database, which identifies the machine that has the project open with read/write access through Microsoft Project at any one time. If you access the project through a data source name, then Microsoft Project stores a string in the Reserved_DataSourceName field that identifies the data source name.

If you have the project open with read/write access through Microsoft Project, then Microsoft Project will store a value of "1" in the Project_ReadWrite field. When you finish your session and close the database, the field value will be set to "0," the default. If you want to make updates to the database directly, you should temporarily set the value of this field to "1" to prevent other users from updating the project through Microsoft Project. While Microsoft Project is writing to a database, it sets the value of the Project_Locked field to "1." While this field has a value of "1," the project may not be opened by any user, not even as a read-only file. You should temporarily set the value of this field to "1" to prevent other users opening a project in the database. Before you do that, make sure the Project_ReadWrite field is set to "1", and the Reserved_ReadCount field is set to "0". It is recommended that you enter an appropriate string in the UserMachineID field after setting Project_ReadWrite to "1" so that any user attempting to open the project through Microsoft Project will get an appropriate message informing them that the project is currently opened for read/write by the correct name. Otherwise Microsoft Project can't identify to the user who has the project open for read/write access. The name should be an identifier for the user or the program opening the project. When you are ready to allow read/write access to the project again, set the UserMachineID field back to a null string right before you reset the Project_ReadWrite field to "0."

While any number of users have projects open read-only from a database through Microsoft Project, Microsoft Project stores the number of users in the Reserved_ReadCount field.

Microsoft Project will store the time of the last update to a database in the Reserved_LastUpdateTimestamp field.

If you open a project as read-only from a database through Microsoft Project, and no other users are currently accessing that project through Microsoft Project, Microsoft Project stores a string in the Reserved_Project_ReadOnly to record that information.

All these fields are part of the Project_Information table in the database.

These project-locking fields are in effect only when users are using Microsoft Project to read or update the database. Microsoft Project does not provide any kind of locking when a database is being read or updated directly by a user using a database program or tool. Any program or tool written to read or update the database should follow these conventions to ensure consistent data access. 

If a user with read/write access crashes or loses the connection to the database, there is no way for anyone else to clear the access field. The user who crashed must reopen the project and then close it down normally, since Microsoft Project only allows the same user on the same machine to bypass the access field for a particular project.

When Microsoft Project detects that the identification string of the machine attempting to open the project is identical to the string already stored, the following alert is displayed:
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This is just an informational alert that lets you know that Microsoft Project has detected that there was a problem and that you need to do a normal close. Click OK to clear the alert and return to the project. In the worst case scenario, when the user who has the project locked is unavailable or is unable to re-open and close the locked project, any other users could open the project as read-only and then do a Save As to store the project under a new name or to a different database.

Database Permissions

Microsoft Project performs three levels of operations on a database, each requiring a corresponding set of permissions.

To open a project read-only, and to view projects in a database, the user must have SELECT permission.

To modify existing projects in a database, to save a new project to pre-existing tables in a database, or to delete a project from a database, the user must have the following permissions: SELECT, INSERT, UPDATE, DELETE.

To save a new project to an empty database, or to selectively import and export data, the user must have the following permissions: SELECT, INSERT, UPDATE, DELETE, CREATE TABLE, DROP TABLE.

For databases that support granting privileges on cursors, Microsoft SQL Server requires that the user have execute privileges on keyset driven cursors, while Oracle and other databases require the user to have execute privileges on static cursors.

Oracle users should add the following line to the "INITxxx.ORA" file, (xxx is the Oracle SID):

open_cursors=200

Database Modification or Corruption

For projects stored in a database, it is possible to directly access the database and modify or corrupt the project tables. This includes the ability to rename a column or table, delete a column or a table, or change the data type of a column to an incompatible type. If this occurs, an alert is displayed during load or save of a project whenever data cannot be read or written.

Example

Open an MPD file in Microsoft Access. Then select the Task_Information table. Click the Design button. Change the name of the FinishDate field to the new shorter name, Finish. Save the changes and close the database. Now open the database in Microsoft Project. The following alert is displayed:
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In the case of a table that is completely missing (for example, if it was renamed), the alert title is shortened to “Cannot access table <table-name>.” If you choose OK to continue reading in the project, there are no guarantees that the project contains the expected data in all cases. In addition, the alert is redisplayed for every missing column or table encountered (but not for columns in a missing table). Choose Cancel to discard any data already loaded.

If a user encounters database corruption while saving a project, Microsoft Project displays an alert stating with which table and column it is having a problem. But Microsoft Project does not recreate corrupted or missing tables or columns.

In the case of a table that is completely missing, the alert title is shortened to just “Cannot save to table <table-name>.” Clicking OK skips writing data to the table or column in question. Clicking Cancel prevents any data from being saved.

In some cases, a company may choose to make certain columns in the database inaccessible to some of those with access to the database because of confidential or sensitive information (for example, pay rates). If column-specific permissions have been set in the database, any time a user who does not have access to the protected column attempts to open a project, the first alert above is not displayed. It is only displayed due to structural changes, not due to permission changes. On the other hand, any user with write permission who does not have access to every column will see the second alert for every affected field any time they try to re-save a project.

Exporting Selective Data to an Arbitrary Database via ODBC

Exporting selective data to an ODBC database is just the process of creating a new table in the database with only a subset of the fields from Microsoft Project. It also allows the application of a filter that defines which rows get written out.

Complete project saves are tracked in the Microsoft Project_Information table in the database. Selective exports are not tracked. Once written out, a selective export is just data in an external table. It has nothing to identify it as having been created by Microsoft Project. It doesn't try to merge or append into existing database tables. A selective export always goes into a new table in the database. Then it’s up to you to use the database functionality to manipulate the data in the desired way.

The one exception to this is that it allows you to overwrite an existing database table if you go through the File Save dialog and explicitly specify the database and table name and OK the appropriate alerts. In this case, it is still creating a completely new table in the database, but it is deleting the existing table with the same name first.

Choosing an Import/Export Map

The process for exporting selective data to an ODBC database initially parallels the full-save process. Everything must first be set up on the database side. Then, while the next step in a full save is to get the project name to be used for storing the project in the database, the next step in a selective save is to get the name of the import/export map for mapping the data from Microsoft Project to the database table(s). The map is specified in the Import/Export Format dialog. This is where the selective save process takes a different route than the full save:
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When the Selective data option is chosen, the Import/Export map to use for exporting listbox and the New Map and Organizer buttons are enabled. Since maps are stored globally, the map listbox contains all of the maps found, independent of when or where they were created. System resources are the only limit to the number of maps you can have. If there are existing maps in the listbox and one is selected, then the Edit and Copy buttons are enabled and the Save button gets the focus. When there is no selection in the map list, the Edit, Copy, and Save buttons are disabled and the New Map button gets the focus.

The Organizer button displays the standard Organizer dialog, which contains a new tab for Maps. You can do all the usual Organizer operations like copying, moving, renaming, or deleting maps. The Maps tab in the Organizer has the identical layout to the tabs like Views, Reports, Tool Bars, and so on.

Maps are stored in GLOBAL.MPT, but can be moved to the local Microsoft Project file for easy transferring to another user. The person receiving the MPP containing the map needs to use the Organizer to move the map from the local file back into their own GLOBAL.MPT before it is visible in the list of maps in the Import/Export Format dialog. Maps are handled like toolbars in the sense that local copies are only for transferring, and the item must reside in GLOBAL.MPT before it can be used.

Map Definition on Export

Choose New Map, Edit, or Copy in the Import/Export Format dialog to display the Define Import/Export Map dialog (hereafter referred to as the Define Map dialog):
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The Define Map dialog always defaults to the Options tab and the other four tabs are initially disabled. The Options tab is where you indicate the scope of the map. To do this, specify the categories of data to be written out. Initially all the checkboxes are blank. As you check (or uncheck) the desired data categories, the corresponding tabs are enabled (or disabled):
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Click the Task Mapping, Resource Mapping, or Assignment Mapping tabs to display the field-mapping interface for the respective data category:
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The primary purpose of each of the mapping tabs are to map the fields in Microsoft Project to the fields in the database, and to provide a preview to show how this mapping affects the actual data. Each tab contains identical controls, but some of them are disabled, depending on the category of data and the contents of the database to be written to.

The Destination database table name field is where you can enter a name (up to 255 characters long) that is used when creating the new table in the database. Depending on the current category tab, the destination table name defaults to “Task_TableX,” “Resource_TableX,” or “Assignment_TableX,” where X is “1” or the next unused integer. You can change the name.

The default table names contain no spaces (since spaces are normally not allowed in most databases), but Microsoft Project does not prevent you from entering spaces into the name, as spreadsheets, HTML and other file formats may permit them. Any leading or trailing spaces are ignored.

A default table name is not inserted into the table name field until you actually check the respective category checkbox in the Options tab, so only the categories you access have names stored in the map. If you check and then immediately uncheck a category, the default table name is stored in the map. This won’t hurt anything and it’s necessary if it is to maintain a consistent model where Microsoft Project 98 itself never deletes anything from a map, and everything showing in a map is always saved (further details of this is covered later under “Saving Mapping Data”).

If you clear the table name field in any of the mapping tabs and proceed to exit the Define Map dialog by clicking OK, the following alert is displayed:
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Clicking OK returns you to the empty Destination database table name field in the appropriate mapping tab. If more than one of the fields have been left blank, the focus returns to the first empty one, proceeding through the tabs from left to right. Of course, if you do not fill in all of the empty fields and click OK again to exit the Define Map dialog, the alert is redisplayed.

If you clear a table name in a particular mapping tab and then go to the Options tab and uncheck the category checkbox for that category to disable the mapping tab, then the alert is not displayed on exit. 

Mapping Fields on Export

The mapping grid in the center of the mapping tab is where you specify exactly which Microsoft Project fields get exported and what the corresponding fields in the database are called. It also shows what data type each database field is.

Initially, the grid has no data, but it does contain the instructional text, “Click here to map a field,” in the first data cell to help guide you and make the process more discoverable. This text disappears as soon as you click on one of the cells in the From: Microsoft Project Field column. At the same time, the entry bar is enabled (in other words, it allows edits) and the cell contents change to an in-place drop-down list control. The drop-down list contains all of the Microsoft Project fields of the category of the current tab (for example, all task-related fields, resource-related fields, or assignment-related fields):
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The Microsoft Project field drop-down lists are not limited to only those fields that appear in each respective database table during a full export, since the full-export tables are normalized and do not provide the range of fields within a single table that you may want to write out together during a selective export. Thus, the mapping grid lists contains all of the fields that can be added to a sheet of the same category. For example, on the Task Mapping tab, the drop-downs contain all of the Microsoft Project fields that can be added to the Task Sheet.

You can select the name of a field from the list, or type a name into the entry bar. To simplify the discussion, this lesson always assumes you make selections from the in-place drop-downs, but you can type in the data any time the entry bar is enabled. Once a field is added to the grid, it no longer appears in the drop-down. If you do type something in and it doesn’t match anything in the list, the standard entry bar alert for invalid data is displayed when you press Enter. 

If you type in a valid field name, but one that is not in the list because it has already been used, then an alert is displayed.

Attempting to include the same field twice causes an alert...

[image: image62.png]2] % work Complete]
From: Microsaft Project Field
%4 Work Complete

To: Database Field Data Type
Percent_Work Complets SHORT,
Microsoft Project

"% Wrk Complete" has alreacly been mapped! o a fied in the From
& colurmn.

W8 Project Click & new fiskd name in the lst, and then press ENTER
Databass!





Click OK to return to the entry bar where the entered field name is pre-selected.

Whenever a field is added, the preview grid is updated at the same time to display the newly added field and some sample data from the project (which may include summary tasks). 

Automatic Adjustments to Mapped Field Names

The vast majority of databases don’t allow spaces in field names or any symbols other than an underscore. In addition, some of the default field names in Microsoft Project (for example, Start, Finish, and Group) are reserved words in many databases. To greatly increase the likelihood that the name in the To: Database Field column is “database compatible,” the field name undergoes a conversion process if necessary before it’s inserted in the grid. The following actions are performed:

· Replace any spaces in the name with an underscore.
· Replace any forward slashes (‘/’) in the name with an underscore (slashes are not used in any default field names, but are used in the column titles of some tables).

· If there is a percent sign in the name (‘%’ is the one symbol that Microsoft Project uses by default), replace the ‘%’ with the string “Percent” (for example, % Complete becomes Percent_Complete).

· If there is a period in the name, drop it (periods are not used in any default field names, but are used in the column titles of many of the default tables).

· If the field name is a known database reserved word, replace the name with the “database-friendly” string. This is the list of replacements it does:

Field Name
Replacement String

Start
Start_Date

Finish
Finish_Date

Group
Group_Name

Work
Scheduled_Work

If the field is a custom field that you renamed, it does the conversion process on the user-defined name, but the conversion process routine does not try to do anything more sophisticated. So, for example, if you included symbols such as ‘*’ or ‘$’ in a custom field name, it leaves those symbols intact, which will likely generate an error if the export destination is a database. In that case, you need to manually change the name.

On an import, an opposite form of “unconversion process” is done where converted fields are automatically matched to their Microsoft Project counterparts.

The Data Type Column

As fields are added to the mapping grid, the data type of each field as it is created in the database, is shown in the Data Type column. Microsoft Project determines the data type and the column is read-only, so the data is grayed and you cannot change it. For export destination files such as TXT, CSV, and XLS, the data type for every mapped field is “Text.”

The actual wording used in the list to describe each data type depends on the database in use. Microsoft Project queries the database for the specific names it uses for each type and displays those names as the choices. While it can depend on the fact that there are standard data types that each database must support in order to be ODBC compliant, the format of certain data types (for example, dates) may depend on the particular database and the front end being used to view the data.

Add All, Clear All, and Other Functions

If you click the Add All button, all Microsoft Project fields of the current category are inserted automatically into the assignment grid (with the converted version of each name repeated in the To: Database Field column and the type in the Data Type column). If the map already includes some field names when the Add All button is clicked, the entered data is left untouched and all the additional fields that had not been included in the mapping grid yet are added below the existing data. No existing fields are duplicated (for example, only the missing fields are added). The Clear All button removes everything in the grid.

To rearrange the order of any of the fields, the up and down arrow buttons can be used. The buttons move the entire row up or down (for example, you can’t move one cell up or down independently of the other cells in the row). Similarly, Insert Row opens up a whole row of empty cells and Delete Row removes an entire row. Empty rows are ignored and removed when the map is saved.

Any time a change is made to the field mapping grid (including up, down, insert, and delete), the preview grid at the bottom of the dialog is updated in parallel and is populated with actual data to show how the mapping data applies to the current project and to the specified database table.

Renaming Fields in the Database

By default, Microsoft Project determines the database field names (by conversion process the Microsoft Project field names), but you don’t have to use the Microsoft Project-supplied names. To change the name of a field (for example, the column name) as it appears in the database, click on the cell (in the To: Database Field column) that contains the field name to be changed. This highlights the name in the cell and also causes the name to appear up in the entry bar where you can edit it:
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A cell in the To: Database Field column can never be empty on a row where there is something in the From: Microsoft Project Field column. Microsoft Project always pre-fills it with the default-converted name. It does not allow it to be cleared. If you select the database field name and clear the entry bar and try to confirm it, the previously existing value is restored. Deleting an entire row is the only way to clear an item. The entry bar is disabled if the selected cell in the To: Database Field column is on an empty row.

Additional Details About the Preview Grid

The data in the preview grid is always shown in the external format. Thus, if you are exporting data to a database table, normalized data and numeric constants are displayed in the preview, rather than text strings and Microsoft Project-formatted data. If you are exporting data to a text file or a Microsoft Excel worksheet, the preview contains Microsoft Project-formatted strings. For example, the picture below shows the first two tasks in a project:
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On export to a database, this is how the data appears in the preview:

[image: image65.png]MS Project:

[Tack Name

[Duration

[Constiaint Type

Dalabase

[Task Name

[Duation

[Constaint Type

Preview:

Task 1
Task 2

14400
24000

0
7





These numeric values are what actually get written to the database, so that’s what is displayed on export. If this same data is imported from the database, the data is displayed in the same way, since that’s how the data exists in the external storage.

On export to TXT, CSV, XLS, or HTML, this is how the data appears in the preview:
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Since it saves data as text strings in the formats, the preview displays the data that way too. If you import this data back in, the import preview again appears exactly the same as the export preview.

The columns in the preview are user-sizable by dragging the column border on the right side of each column. By default, all columns start out the same size. The preview grid has a horizontal scrollbar to allow you to navigate to see the mapping results, no matter how many fields are added to the map.

Basing a Map on a Microsoft Project Table

The Base On Table button provides the capability to base field mapping for a map on an existing Microsoft Project table. The button is enabled on the Task Mapping and Resource Mapping tabs and is always disabled on the Assignment Mapping tab. The button displays the Select Base Table for Field Mapping dialog, that depending on the current mapping tab, contains a list of all of the existing Microsoft Project task tables or resource tables:
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The listbox caption changes to reflect Task Tables or Resource Tables. The first table in the list is selected by default. Selecting any table and clicking OK closes the dialog and updates the field mapping data in the respective mapping tab to include all the fields in the selected table. The added fields are listed in the mapping grid in the same order as they appear in the chosen table. Clicking Cancel returns to the respective mapping tab without making any changes.

When a base table is chosen and the mapping grid is being updated, both the Microsoft Project and database sides of the grid are pre-filled with all of the fields that appear in the specified table. The names and order of the fields inserted in the grid correlate to the table as it currently exists. So, if the user modifies the selected table, the order matches the order of fields in the local copy of the table (or the global table’s order, if a local copy does not exist). The only exception to this is that duplicate field names are not allowed in the From: Microsoft Project Field column. So if you added a field to a table more than once, only the first occurrence is added to the mapping grid and the additional occurrences are ignored.

The names in the From: Microsoft Project Field are the default Microsoft Project field names for each field. But the names inserted in the To: Database Field column are converted versions of the names in the column titles for the particular table (for any title field that is not blank; otherwise, the default field name is converted). 

For example, suppose the picture below shows the table as you currently define it:
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Then this is the result in the mapping grid for the Base On Table operation:
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After you insert the fields in the grid when basing a map on a table, you are then free to add any additional fields to this map, remove any rows you don’t want, re-order the rows, or change the name of any field as far as how it appears in the database. As with the Add All button described previously, if the mapping grid is not empty when you select a base table, the additional fields are appended to the mapping data in the grid (after the existing mapping data) so that no field is duplicated and no existing mapping data gets overwritten. The appended fields follow the ordering from the table as best as possible. Fields from the chosen table that are already in the mapping grid are left in their original grid positions.

Filtering Exported Data

The respective Export filter drop-downs on the Task Mapping and Resource Mapping tabs are initially set to “All Tasks” and “All Resources.” The Export filter drop-down on the Assignment Mapping tab is always blank and disabled.

If the filter you choose from the list is an interactive filter, you are prompted for input after you click the Save button in the Import/Export Format dialog. It is not until that time that the filter is applied, so it cannot prompt for data any earlier.

If you specify a pre-existing map and the map specifies a task or resource filter that cannot be found, then the respective task or resource filter field shows the prefix “OUT OF CONTEXT:” before the filter name:
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You can leave it, as is, in which case Microsoft Project defaults to using “All Tasks” or “All Resources,” or you can select a valid filter name from the list.

Using an Existing Map on Export

Whenever you specify Edit or Copy in the Import/Export Format dialog, then existing mapping data is utilized. This overrides some of the default behavior and settings in the options and mapping tabs of the Define Map dialog.

A copied map inherits the settings of the original map, which you can then modify.

Saving Mapping Data

In the Define Map dialog, you can go back and forth at any time among the mapping tabs to review or change any field mapping data. There is also nothing to prevent you from going back to the Options tab at any time and checking different data categories. If a category checkbox is cleared after some mapping has been done, the mapping information associated with that category in the corresponding mapping tab is not discarded. The data is maintained as part of the current map, but it is never used unless the checkbox is re-checked.

Thus, on a new map, everything you have “touched” in the map is saved, while everything untouched is left blank. 

When you are satisfied with the mapping data and the other options, the OK button is used to save the completed map under the specified map name. If you originally specified Edit in the Import/Export Format dialog, the original map data is overwritten with all the changes (even if the map name is changed). 

If OK is clicked and you originally specify New Map or Copy and the entered map name is the same as an existing map, an overwrite/cancel alert is displayed. 
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Clicking OK overwrites the existing map with the new definition and returns you to the Import/Export Format dialog. Clicking Cancel keeps you in the Define Map dialog and returns focus to the Import/export map name field, where the conflicting name is pre-selected.

If you create a new map in the Define Map dialog and check some data category checkboxes in the Options tab, but don’t actually go to any of the mapping tabs and map any data (or if you don’t check any checkboxes at all), the result is a map that does not import or export anything, and a alert is displayed stating that the map cannot be created.
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Clicking OK returns you to the Define Map dialog.

Writing Out the Project Data

Once back in the Import/Export Format dialog, as long as you exited the Define Map dialog by clicking the OK button, the Cancel button is re-labeled as Close. Clicking the Save button closes the dialog and writes out the data using the parameters defined in the highlighted map. Double-clicking on a map name in the list also closes the dialog and saves the data (for example, it is equivalent to single-clicking a map name and then clicking the Save button). Clicking Close terminates the save process and returns you to Microsoft Project, but all mapping changes are retained.

If you create a map that specifies the same database table name(s) as one or more existing tables in the database, a confirmation alert displays. You must confirm the overwriting of existing tables. When overwriting, Microsoft Project deletes the entire existing table and then writes out a completely new table with the same name (for example, it’s not an update), so all previously existing data is lost.

The confirmation alert contains a list of all table names in the map that conflict with existing tables or views in the database. The Edit Map button is the default selection. It returns you to the Import/Export Format dialog, where the map is selected in the map list and the Edit button can be used to access and change the map. The Overwrite button saves out all the data specified in the map, overwriting any tables or views with conflicting names, and then returns you to Microsoft Project. The Cancel button halts the entire export process and returns you to Microsoft Project.

If a selective save to a database is invoked through Microsoft Visual Basic for Applications with the FileSaveAs method and there are conflicts between table names in the map and any tables or views in the database, an alert nearly identical to the one above is displayed, only OK and Cancel buttons are displayed.

If the map contains a name for a table or a database field that the current database considers illegal syntax, Microsoft Project has no way of knowing there’s a problem until it actually tries to create the table. When it is trying to write the data, it just gets an error back from ODBC and it may not know what the problem is (since it’s driver-specific), so it can only display the ODBC error string and return you to the project file. The ODBC alert also has a View SQL button that displays the SQL Statement dialog that contains the complete query that generated the ODBC error:
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If the ODBC driver can return the character position of the item that caused the error, it is included in the label at the top of the SQL Statement dialog. If the character position is not available, the phrase “character location x in” is dropped from the label:
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Clicking Close returns you to the ODBC alert (and clicking OK in the alert returns you to Microsoft Project).

Microsoft Project restores any tables it may have been attempting to overwrite.

Importing Selective Data from an Arbitrary ODBC Database

The process for reading selective data into Microsoft Project from an ODBC database is the opposite of writing out selective data. First click the ODBC button in the File Open dialog. That invokes the ODBC Select Data Source dialog for selecting the data source. After any database-specific open or connection routines, the Import/Export Format dialog is displayed:
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If there are no complete projects found in the database, then the Entire project option is disabled and the Selective data option is selected by default. But if complete projects do exist, the Entire project option is the default selection. You then need to choose the Selective data option to do a selective export.

No map is pre-selected in the import/export maps list. While there is no selection, the Edit, Copy, and Save buttons are disabled and the New Map button gets the focus. Once a map is selected, the Open button gets the focus.

If you want to create a new map for mapping the data from a database into fields in Microsoft Project, the New Map button is used. If you want to start with an existing map, or to a copy of an existing map, the Edit or Copy button is clicked after selecting the map name. 

If you previously saved data out with a particular map and want to read the equivalent set of data back in, select the map in the Import/export map to use for importing list and then click Open. If you want to review the mapping data, preview the effect of the map on the specified database, or make any changes, then you can use the Edit or Copy buttons to review or modify the mapping information.

Whenever an import/export map is used with a particular ODBC data source, Microsoft Project stores that map name with the DSN in the MRU file list. Then, if you reopen that data source by selecting it from the MRU list on the File menu instead of going through the File Open dialog, the same import/export map is automatically used. The user reads the data based on the map without any intervention.

Map Definition on Import

When creating a new map or modifying an existing one during the import process, the procedure closely resembles the previously described sequence for doing this during the export process, but there are a number of differences in the Define Map dialog to account for the different operations permitted during importing as compared to exporting:

· The Destination database table name field, as it’s called on export, is renamed to Source database table name on import.
· The Method for incorporating imported data field replaces the Export filter field.

· The Set Merge Key button replaces the Base On Table button.

· The “From and To” labels in the mapping grid are reversed to reflect the opposite direction of the data flow, so the grid column headings become To: Microsoft Project Field and From: Database Field.

· The instructional text “(Click here to map a field)” in the first cell of the Project column is replaced by the string “(Choose a source table above)” in the first cell of the database column.
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The Source database table name field is a drop-down combo box that lists all of the tables in the database (instead of the edit control used on export for entering the table name). The first entry in the list is “(none)” and this is the default selection.

The Method for incorporating imported data field is where you specify how to read in the data. The drop-down list has three choices:

· Place into a new project
· Append to end of current project

· Merge (by key) into current project

Place into a new project is the default. This is like doing a File/New to get an empty project and then reading the data into it. Append to end of current project appends the data to the end of the active project. Merge (by key) into current project does an actual merge of the data into the active project. Merging is discussed later.

There can be only one setting for a single map, so whichever choice you make for the Method for incorporating imported data field is reflected across the Task, Resource, and Assignment Mapping tabs. For example, if you choose Append to end of current project on the Task Mapping tab and then switch to the Resource Mapping tab, Append to end of current project also is selected there. 

Mapping Fields on Import

A primary difference between creating a map on import versus export is the way the default mapping takes place. On export, you select Microsoft Project fields and then Microsoft Project automatically fills in the same name for the database column, so the only data in the mapping grid is the fields that you explicitly add.

On import, as soon as you select (or type in) a source table name, Microsoft Project pre-fills the From: Database Field column in the mapping grid with all of the fields that exist in the database table. Each field name in the database column has its corresponding type displayed in the Data Type column and each field is matched to “(not mapped)” in the To: Microsoft Project Field column:
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Since it can’t predict what Microsoft Project fields you want to correspond to each database field, it can’t pre-map fields the way it can on export (when it is creating the database table and can call the column whatever it wants). But pre-listing all the database fields without actually mapping them does provide a means to preview the types of data in each database table (though you can only see the field names and not the actual data until you explicitly map the database fields to Microsoft Project fields, at which time the data appears in the preview). If a database table is empty (for example, it contains no fields) the mapping grid remains empty and disabled.

If you want to import data from a particular database field, the next step is to click on the adjacent “(not mapped)” cell in the Microsoft Project field column. This enables the entry bar (for example, it allows edits) and changes the cell contents to an in-place drop-down list control:
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The in-cell drop-down list contains “(not mapped)” at the top, followed by all of the Microsoft Project fields of the current category that are an appropriate match for the data type of the database field (for example, choosing a date field in the database result in all Project date fields appearing in the drop-down as well as all Microsoft Project text fields). 

There are several general rules governing what field types can and cannot be mapped between the database and Microsoft Project:

· Any field type in the database can be mapped to a Microsoft Project text field.
· Numeric fields in the database can only map to Microsoft Project numeric fields of the same size or bigger, (for example, 8-byte fields in the database can only map to 8-byte Microsoft Project fields. 2-byte database fields can be mapped to 2, 4, or 8-byte Microsoft Project fields, and so on.), or to Microsoft Project text fields.

· Date fields in the database can only be mapped to Microsoft Project date (or text) fields.

· Text fields in the database can be mapped to any Microsoft Project field (but Microsoft Project later generates an import error if the string is not in the right format for the chosen field).

The drop-down list can be used to select the desired Microsoft Project field into which the data is mapped, or the name can be typed into the entry bar. If you type in a legitimate Microsoft Project field name, but one that is the wrong type for the adjacent database field, an alert is displayed.

To save you time, if there are any Project fields of the same name and type as any of the database fields, then those field names are inserted by default into the cell in the To: Microsoft Project Field column at the time you select the database table. To make the match-up process work correctly, Microsoft Project does a “reverse conversion process” of field names during import to make sure that previously converted fields on export are automatically matched to their Microsoft Project counterparts. Microsoft Project converts all of the field names and then uses the converted name list for comparisons when trying to match up external field names with Microsoft Project names. 

When you map a database field in the grid to a Microsoft Project field (by selecting a Microsoft Project field name instead of “[not mapped]” or if there’s an exact name/type match by default), the heading rows for Microsoft Project and the database in the preview are updated to show the selected field names, and sample data from the database is displayed below them. The preview grid only shows headings and data for valid mappings:

[image: image79.png]AddAl | Clearél

| _lnseitRow | _Delets Row |

E3 |

—

T M Pt Fisd [fon: Dtabase Fid
Resouce Nome Erpoee

[(not mapped) Divison

[(not mapped) Supervisar

Standad Rte Saly

Notes =] Comments B

Yy

Mave

K]

WS Picject [Fesource Name [Salry [Comments
Database: [Employes. [tanderd Fete [Notes
[Adem $2200h  Has contiacted for Ta,
Preview: [Allen $35,000.00/y _ Switched to salay on.
Bob $30.00h

ki





To rearrange the order of any of the fields in the grid (and the preview), the move up and down arrow buttons can be used. But, unlike exporting, the ordering does not have any impact on the actual imported data (since ordering ultimately depends on the Microsoft Project table that you choose for viewing the data).

As long as the Define Map dialog is open, you can switch back and forth between the mapping and/or Options tabs and the “(not mapped)” rows remain intact. Once you close the Define Map dialog all of the “(not mapped)” rows are removed. 

Specifying a View Instead of a Table

In some instances, you may want to import from a database view/query, rather than from an actual database table. Because the table name field is a combo box, it permits the specification of a view by allowing you to type in the name. You must already know the name of the view you wish to use. If the name in the Source database table name field is not an existing table, Microsoft Project checks to see if it is an existing view. If so, everything proceeds just as if the view were a table. 

Switching Database Tables During the Mapping Process

As mentioned earlier, the Source database table name field defaults to “(none).” Consequently, the mapping grid and accompanying controls are disabled until you choose a table from the list from which to import. If you change the table name back to “(none)” at any time, the mapping grid and controls are disabled. If you do some actual mapping and then switch the table name back to “(none),” the existing mapping data remains in the disabled mapping grid, but the preview grid clears.

If you map some data based on a particular database table and then change the database table name field to a different table in the database, a number of things occur. First, any existing mapping data is retained in the mapping grid, but all “(not mapped)” rows are removed. Any field names that are unique to only the second database are then added to the From: Database Field column in the cells following the existing mapping data in the grid. The newly added fields have their type in the Data Type column and are all paired up with “(not mapped)” in the associated Microsoft Project field cells.

For the mapping data that was based on the first database table, any inconsistencies are flagged in the same way that Microsoft Project flags problems when you apply an existing map to a different data source that is not fully compatible. The most likely scenario is that database fields that existed in the first table do not exist in the second table. The fields in the grid get marked as “OUT OF CONTEXT.” Another possibility is that a particular field name added to the map from the first database table might also exist in the second table, but have a different data type. The database field name cannot be marked as OUT OF CONTEXT in the grid because it really exists in the second table, but the previously associated Microsoft Project field is of the wrong type, so the Microsoft Project field is flagged as having a “TYPE CONFLICT.”

Merging Imported Data

To merge external data into the currently active project, the Method for incorporating imported data field is set to Merge (by key) into current project.” By default, Microsoft Project always presets the Unique ID field as the merge key if a field by that name is present in the database table. Merging can be based on a different field, but utilizing any other field results in slower performance as the data is read.

As previously mentioned, the button labeled Base on Table changes during export to Set Merge Key during import. The Set Merge Key button is used to indicate which database/Microsoft Project field mapping pair is to be considered the primary key for data merging if a field named Unique ID is not present or if you want to merge based on a different field.

The Set Merge Key button is always disabled when the Method for incorporating imported data field is not set to “Merge (by key) into current project.” Once merging is specified, the Set Merge Key button is then enabled, but only when the focus is on a valid mapping row in the mapping grid.

Clicking the Set Merge Key button marks the fields in the current row as the merge keys and identifies them by attaching the prefix “MERGE KEY:” to the beginning of both field names:
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Only one merge key may be specified at a time, so if you move the focus to a different row and click Set Merge Key again, the key row (and identifying indicators) changes to the newly chosen row.

If you select the Merge (by key) into current project option and do not set a merge key (and Unique ID is not a field in the table), an alert is displayed when you attempt to change the current tab or click the OK button.

With a key properly specified, when the data is read in, the mapped fields are merged into the appropriate records in the current project based on the key. The merge key is saved with the map, but it is only displayed in the grid during the import process and only when the Method for incorporating imported data field is set to Merge (by key) into current project.

Microsoft Project does not prevent you from choosing a non-unique key. If you choose an ambiguous key field, the outcome will likely include multiple insertions of different data into the same Project records (with only the last overwrite appearing).

Data of a particular category (tasks, resources, or assignments) can only be imported from one table at a time. If you want to import one kind of data from more than one table, the only way to do it is to do a separate import with a separate map for each source table, with merging specified in each case.

Using an Existing Map On Import

Since you have the ability to select any existing import/export map independent of the database for which it is was created, it’s possible that the map may have no relation to the selected database or the specified tables. For example, the chosen map may have many fields specified that don’t actually exist in the table being read, or it may specify tables that aren’t in the current database.

The mapping grid shows all data in the map, regardless of applicability, but the preview always shows only the fields that have valid mappings within the context of the database in use.

Existing map data that is being applied out of context is flagged by listing the line in the mapping grid in red text. In the case where a database field in the map is missing from the currently selected table, the cell in the Data Type column is left blank and the field name in the From: Database Field column is prefixed with the string “OUT OF CONTEXT.”:
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You can leave the errant database fields as they are (in which case they are ignored during data import), you can permanently remove them from the map (by using the Delete Row button), or you can replace them. Replacement means clicking on the cell in the From: Database Field column (that contains one of the out-of-context field names) to invoke the drop-down list for that cell and then selecting a valid database field name from the list. This fills in the data type column and either leaves the Microsoft Project field name intact, if it’s compatible with the data type of the database field, or it flags the Microsoft Project field with the string “TYPE CONFLICT.” As long as the Microsoft Project field is compatible, the line changes from red to black.

If a database field name in the map does exist in the currently selected table but is of a different type than the original field that existed in the table used to create the map (for example, both tables have a field with the same name, but different data types). Since the map pairs the database field with a Microsoft Project field, the Microsoft Project field specified in the map now is incompatible with the data type of the field in the current table, since the database type is different than when the Microsoft Project field was paired up. In this case, the cell in the Data Type column shows the correct data type of the database field in the current table and the Microsoft Project field name is prefixed with the string “TYPE CONFLICT:”
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As with out-of-context data, you can fix, ignore, or delete a type-conflict problem. If ignored, the map can still be used to import from the currently selected source, but import errors are logged as the incompatible data is read. To permanently remove a type-conflict from the map, the Delete Row button is used. To fix it, you can click on the cell in the To: Microsoft Project Field column that contains the conflicting Microsoft Project field and then select a new field of the appropriate type from the drop-down list. In all cases, the preview only is updated to show fields and data for currently valid mappings.

If you apply a map that contains one or more table names that do not exist in the current database, those table names are listed as out of context as well. For example, if a map was created with the default task table name “Task_Table1” and then that map was used to import from another database without a table by that name, switching to the Task Mapping tab reveals that everything is out of context:
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The Source database table name field shows the “OUT OF CONTEXT” string preceding the missing table name and every field in the map is listed as out of context. 

If an out-of-context table name is encountered during an import, that table is just ignored and the import continues. If all tables in a map are out of context, then an empty project is displayed at the end of the import operation.

Import/Export with Non-Database File Formats

While the discussion up to this point has been centered on mapping data to or from a database, Microsoft Project also supports selective data import/export with various non-database file types (XLS, TXT, CSV, and HTML). 

For the non-database file types, there are additional settings specific to each format. The lower half of the Options tab, which is empty during database import/export, is used to display the various format-specific options. If you apply a map created for a database (where no additional options were specified) to a non-database file type, the options are set to the format-specific defaults.

The following sections describe the additional options, their defaults, and other specific differences for each file type.

Selective Import/Export to Microsoft Excel 

When importing or exporting selective data to/from Microsoft Excel, the Import/Export Format dialog is displayed as it is with database import/export. Since it is only supporting selective saving to the Microsoft Excel format, the Selective data option is selected by default and the Entire project option is disabled.

When you click New Map, Edit, or Copy to customize the import/export map, the Define Map dialog is displayed with an additional Microsoft Excel options section visible at the bottom of the Options tab:
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When exporting to Microsoft Excel, multiple tables can be exported at one time, since it can store each table in a different worksheet of the workbook.

Default Microsoft Excel Option Settings on Export

The picture above shows the default state of the Microsoft Excel options during export.

The Export header row/Import includes headers checkbox determines whether a header row is written out with the data. This option is turned on by default.

The Include assignment data in output checkbox indicates that the data is formatted like the new usage views, with assignments listed under each task or resource. This option is provided as a way for you to easily get output that looks the way the data appears on screen in the new usage view. This option is turned off by default.

Default Microsoft Excel Option Settings on Import

This is the Default State of the Microsoft Excel options during import:
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The Export header row/Import includes headers checkbox specifies whether the first row being read is a header row. This option is on by default.

The Include assignment data in output checkbox is disabled during import.

Mapping to Microsoft Excel

The only difference in creating a map for Microsoft Excel compared to creating a map for a database is that you are mapping fields in Microsoft Project to columns in a Microsoft Excel worksheet instead of mapping fields in Microsoft Project to columns in a database table. The difference is that in each mapping tab, the label Destination database table name is replaced by Destination worksheet name, each mapping grid shows Worksheet Field above the second column in place of Database Field, and each mapping preview says Worksheet next to the second row instead of Database:
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Selective Import/Export to Text File Formats

When saving to or importing from the TXT or CSV file format, the Selective data option is selected by default in the Import/Export Format dialog and the Entire project option is disabled.

The TXT and CSV file types only support the export of a single table at a time. When you are importing or exporting one of these formats, the checkboxes for Tasks, Resources, and Assignments on the Options tab of the Define Map dialog are replaced by option buttons (which limit the map to import/export of only one type of data):
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The fact that the file type can only support a single table is related to the fact that there is no concept of a table name within the file. In effect, the file itself serves as the table name. 

When importing to, or exporting from, a single table file type, if you apply a map that was created for a multiple-table file type, Microsoft Project picks the best choice. The priority is tasks, resources, then assignments. So, if a map specifies that all three are exported, then the Tasks option is pre-selected and only tasks are exported (unless you change it). If the map specifies resources and assignments are exported, but not tasks, then the Resources option is selected. Only if neither tasks nor resources are specified (and assignments are) is the Assignments option selected.

Default Text File Option Settings on Export

For TXT and CSV importing and exporting, there is a Text file options section at the bottom of the Options tab. The options and their default state during export are shown below:
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The Export header row/Import includes headers checkbox specifies whether Microsoft Project writes out a header row as the first line of the text file. This option is on by default.

As previously described, the Include assignment data in output checkbox indicates that the data is formatted like the new usage views, with assignments listed under each task or resource. This option is turned off by default.

The Text delimiter field is a drop-down combo box that contains the words “Tab” and “Space” in the drop-down, as well as the actual character that is set in the Control panel as the system list separator. It is always pre-set and disabled during export because the delimiters for TXT and CSV are pre-defined (it uses the same values Microsoft Excel uses). For TXT files, the field is always set to Tab. For CSV files, the default delimiter is the system list separator.

The File Origin combo box is blank and disabled during export and all exports use the current Windows code page. In the Far East versions of Microsoft Project 98, the File Origin combo box is hidden.

Default Text File Option Settings on Import

The Default State of the text file options during import are shown below:
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The Export header row/Import includes headers checkbox specifies whether the first row being read from the file is a header row. This option is on by default.

The Include assignment data in output checkbox is disabled during import.

The File origin drop-down list contains three choices: Windows (ANSI), Macintosh, and DOS or OS/2 (PC-8). This setting allows Microsoft Project to properly interpret the file contents based on the character set that was used when the file was created. The default setting is Windows (ANSI). In the Far East versions of Microsoft Project 98, the File Origin combo box is hidden (and any File Origin value contained in a map is ignored).

The Text delimiter combo box is used to specify which character was used to delimit columns in the file. The drop-down contains the words “Tab” and “Space” as well as the actual character that is set in the Control panel as the system list separator. For TXT files, the default setting is Tab and for CSV files, the default value displayed is the system list separator, but in either case, you can select a different choice from the list or type any character into the combo box.

Mapping to Text Files

As with Microsoft Excel, the mapping tabs reflect that mapping is being done to a text file:
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The mapping grid on each tab shows Text File Field above the second column in place of Database Field and each mapping preview says Text File instead of Database as the second row header.

The Destination database table name field is renamed to Destination table name on export and Source table name on import. This field is always disabled, since the table name field is not really used with TXT files (the file contents are equivalent to a single table and the file name already serves as the table name). But, while no table name is needed in this case, it’s necessary to save a table name in the map for map consistency, because the map could be used later with other file types. A default table name (Task_Table1, Resource_Table1, and so on) is inserted when the category option button is selected in the Options tab. Unlike all the other cases described so far, this default table name insertion occurs even when a map is being edited, if you select a different category option button and the corresponding table name field is empty.

Since there is no table selection required when importing from a TXT or CSV file, the fields in the file are displayed in the mapping grid as soon as you switch to one of the mapping tabs. If an existing map that contains a table name (from a database or a spreadsheet) is applied to a TXT or CSV import, the table name is displayed disabled and ignored. Again, the mapping data is displayed in the mapping grid as soon as you switch to one of the mapping tabs (and any out-of-context or type mismatched fields are flagged).

On import, if the text file contains a header row, then the headers are put in the text file fields of the mapping grid and preview. If there is no header row in the file, then the mapping grid and the preview just show Column 1, Column 2, and so on for the names of text file fields.

Selective Export to a Microsoft Excel Pivot Table

Like HTML, exporting to a Microsoft Excel pivot table is a one-way process and Microsoft Project 98 cannot read the data back in. The options in the Import/Export Format dialog are the same as a standard Microsoft Excel export and only the Selective data option is available. Once in the Define Map dialog, there are no format-specific options at the bottom of the Options tab, but there is some explanatory text:
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Mapping to a Microsoft Excel Pivot Table

The only difference in creating a map for a pivot table compared to creating a map for an ordinary Microsoft Excel export is that you must pick a field to be the Data field in Microsoft Excel around which everything is pivoted. To simplify this process, the last field in the mapping grid is automatically designated the pivot table Data field. To indicate this, the last field is displayed in red and the name of the field in the To: Worksheet Field column is automatically prefixed with the string “Pivot Data Field:”
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If you start with a blank map and then map a field in the first row of the mapping grid, that field becomes the pivot data field and is labeled as such. If you then map a field in the second row of the grid, that second field immediately becomes the pivot table field, changing color and getting the “Pivot Data Field” label. The first row returns to normal appearance.

Using Pivot Tables

Pivot Tables allow you to rearrange data and see different groupings of categories of data similar to outlining, but it is dynamic since you can group any field. For example, if you wrote out Task Name, Priority, and Cost, you could pivot on Priority to determine the cost of all High priority tasks and compare that to the cost of tasks of other priorities.

Microsoft Project has a new serializer for PivotTables and a new entry in the Save As dialog file type list for PivotTables. This replaces the Microsoft Project 4.x CreatePivotTables macro.

Task Names

Instead of writing out a single column for task names, Microsoft Project writes out multiple columns corresponding to different outline levels. 

The picture below shows a sample project:
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Task Name

Duration

Start

Finish

Resource Names

Resource Group

Cost

1

Summary1

19d

Wed 10/02/96

Mon 10/28/96

$2,128.00

2

Summary1.1

6d

Wed 10/02/96

Wed 10/09/96

$768.00

3

Leaf1.1.1

2d

Wed 10/02/96

Thu 10/03/96

Bob

Dev

$160.00

4

Leaf1.1.2

3d

Fri 10/04/96

Tue 10/08/96

Joe,Bob

Dev

$528.00

5

Leaf1.1.3

1d

Wed 10/09/96

Wed 10/09/96

Bob

Dev

$80.00

6

Summary1.2

13d

Thu 10/10/96

Mon 10/28/96

$1,360.00

7

Summary1.2.1

4d

Thu 10/10/96

Tue 10/15/96

$480.00

8

Leaf1.2.1.1

4d

Thu 10/10/96

Tue 10/15/96

Jack

Pgm

$480.00

9

Summary1.2.2

9d

Wed 10/16/96

Mon 10/28/96

$880.00

10

Leaf1.2.2.1

5d

Wed 10/16/96

Tue 10/22/96

Bob

Dev

$400.00

11

Leaf1.2.2.2

4d

Wed 10/23/96

Mon 10/28/96

Jack

Pgm

$480.00

12

Summary2

3d

Tue 10/29/96

Thu 10/31/96

$496.00

13

Leaf2.1

2d

Tue 10/29/96

Wed 10/30/96

Jack,Bob

Pgm,Dev

$400.00

14

Leaf2.2

1d

Thu 10/31/96

Thu 10/31/96

Joe

Dev

$96.00


Using the above sample project, the PivotTables format writes out the following for the name field:
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This allows you to continue to summarize against the outline structure in a PivotTable as illustrated in the pivot table shown below:
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Summary1

Summary1.1

Leaf1.1.1

(blank)

(blank) Total

Leaf1.1.1 Total

Leaf1.1.2

(blank)

(blank) Total

Leaf1.1.2 Total
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(blank) Total

Leaf1.1.3 Total

Summary1.1 Total

Summary1.2

Summary1.2.1

Leaf1.2.1.1

Leaf1.2.1.1 Total

Summary1.2.1 Total

Summary1.2.2

Leaf1.2.2.1

Leaf1.2.2.1 Total

Leaf1.2.2.2

Leaf1.2.2.2 Total

Summary1.2.2 Total

Summary1.2 Total

Summary1 Total


Task and Resource Names (Assignments)

Similarly, since tasks with assignments summarize the information about each assignment, Microsoft Project saves out multiple rows for each assignment.

Using the same project as above, you can see that Leaf 1.1.2 has 2 assignments. Microsoft Project writes this information as follows:
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Summary1.1

Leaf1.1.2

3d

10/04/96

10/08/96

Joe

288.00
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Summary1

Summary1.1

Leaf1.1.2

3d
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Bob
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Separate row for each assignment. This allow pivoting as shown below:
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(blank)

3d

10/04/96

10/08/96

Bob

240

Joe

288

(blank) Total

528

Leaf1.1.2 Total
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In addition, the pivot table allows you to pivot on the Resource to see how much work or costs are associated with a particular person:
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Resource Names

Name1

Name2

Name3

Name4

Duration

Start

Finish

Total

Bob

Summary1

Summary1.1

Leaf1.1.1

(blank)

2d

10/02/96

10/03/96

160

(blank) Total

160

Leaf1.1.1 Total

160

Leaf1.1.2

(blank)

3d

10/04/96

10/08/96

240

(blank) Total

240

Leaf1.1.2 Total

240

Leaf1.1.3

(blank)

1d

10/09/96

10/09/96

80

(blank) Total

80

Leaf1.1.3 Total

80

Summary1.1 Total

480

Summary1.2

Summary1.2.2

Leaf1.2.2.1

5d

10/16/96

10/22/96

400

Leaf1.2.2.1 Total

400

Summary1.2.2 Total

400

Summary1.2 Total

400

Summary1 Total

880

Summary2

Leaf2.1

(blank)

(blank)

2d

10/29/96

10/30/96

160

(blank) Total

160

(blank) Total

160

Leaf2.1 Total

160

Summary2 Total

160

Bob Total

1040


Without expanding the Resource Names, you get groupings on multiple resources (like “Joe, Bob”) instead of being able to look at individuals.

Task and Resource Group (Assignment)

There is a field for tasks called Resource Group. This is a read-only field that lists the groups for all the resources assigned to the task.

If this field is included in the map, Microsoft Project writes the resource’s group for each assignment as a separate row, similar to the discussion of Resource Names above.

Using the same project as above, you can see that Leaf 2.1 has two resources. Microsoft Project writes this information as follows:
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2d

10/29/96

10/30/96

Jack

Pgm

240.00
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Leaf2.1

2d

10/29/96

10/30/96

Bob

Dev

160.00
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This allows you to look at information pivoted on Group as shown below:
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Resource Names
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Dev

Summary1

Summary1.1

Leaf1.1.1

(blank)

2d

10/02/96

10/03/96

Bob

160

(blank) Total

160

Leaf1.1.1 Total

160

Leaf1.1.2

(blank)

3d

10/04/96

10/08/96

Bob

240

Joe

288

(blank) Total

528

Leaf1.1.2 Total

528

Leaf1.1.3

(blank)

1d

10/09/96

10/09/96

Bob

80

(blank) Total

80

Leaf1.1.3 Total

80

Summary1.1 Total

768

Summary1.2

Summary1.2.2

Leaf1.2.2.1

5d

10/16/96

10/22/96

Bob

400

Leaf1.2.2.1 Total

400

Summary1.2.2 Total

400

Summary1.2 Total

400

Summary1 Total

1168

Summary2

Leaf2.1

(blank)

(blank)

2d

10/29/96

10/30/96

Bob

160

(blank) Total

160

(blank) Total

160

Leaf2.1 Total

160

Leaf2.2

(blank)

(blank)

1d

10/31/96

10/31/96

Joe

96

(blank) Total

96

(blank) Total

96

Leaf2.2 Total

96

Summary2 Total

256

Dev Total

1424


Note that some fields like Duration, Work, and Resource Rates get saved as strings so you cannot do analysis. You would need to do a conversion to a common unit and then save that out in a Number field.

PivotTable Example

The following map is used with the sample project above:

Name

Duration

Start

Finish

Resource Names

Resource Group

Cost

Microsoft Project creates the following data sheet:
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Summary1.1

Leaf1.1.1

2d

10/02/96

10/03/96

Bob

Dev

160.00

$ 

 

Summary1.1

Leaf1.1.2

3d

10/04/96

10/08/96

Joe

Dev

288.00

$ 

 

Summary1.1

Leaf1.1.2

3d

10/04/96

10/08/96

Bob

Dev

240.00

$ 

 

Summary1.1

Leaf1.1.3

1d

10/09/96

10/09/96

Bob

Dev

80.00

$   

 

Summary1.2

Summary1.2.1

Leaf1.2.1.1

4d

10/10/96

10/15/96

Jack

Pgm

480.00

$ 

 

Summary1.2

Summary1.2.2

Leaf1.2.2.1

5d

10/16/96

10/22/96

Bob

Dev

400.00

$ 

 

Summary1.2

Summary1.2.2

Leaf1.2.2.2

4d

10/23/96

10/28/96

Jack

Pgm

480.00

$ 

 

Leaf2.1

2d

10/29/96

10/30/96

Jack

Pgm

240.00

$ 

 

Leaf2.1

2d

10/29/96

10/30/96

Bob

Dev

160.00

$ 

 

Leaf2.2

1d

10/31/96

10/31/96

Joe

Dev

96.00

$   

 


The default PivotTable is:
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Summary1

Summary1.1

Leaf1.1.1
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10/02/96
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Bob
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160
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Leaf1.1.1 Total

160

Leaf1.1.2
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3d

10/04/96
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Bob

Dev

240

Joe

Dev
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(blank) Total
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Leaf1.1.2 Total
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Leaf1.1.3
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1d

10/09/96

10/09/96

Bob

Dev
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(blank) Total

80

Leaf1.1.3 Total

80

Summary1.1 Total
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Summary1.2

Summary1.2.1

Leaf1.2.1.1

4d

10/10/96

10/15/96

Jack

Pgm

480

Leaf1.2.1.1 Total

480

Summary1.2.1 Total

480

Summary1.2.2

Leaf1.2.2.1

5d

10/16/96
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Leaf1.2.2.2
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480

Leaf1.2.2.2 Total

480

Summary1.2.2 Total

880

Summary1.2 Total

1360

Summary1 Total

2128

Summary2

Leaf2.1

(blank)

(blank)

2d

10/29/96

10/30/96

Bob

Dev
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Jack

Pgm

240

(blank) Total

400

(blank) Total

400

Leaf2.1 Total

400

Leaf2.2

(blank)
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1d
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10/31/96

Joe
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96
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96

(blank) Total

96
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96

Summary2 Total
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Lesson 3.2 - Exercises

1.
What file types can be used to save a complete project (including views, filters, and so on)?

What file types have the option to save either a complete or partial project?

What file types only allow you to save a partial project?

2.
Is ODBC listed in the Save as type list in the File Open dialog? 

How do you do a complete or partial save to an SQL database?

3.
Suppose that your computer crashes while you have a project open from an ODBC database. What happens the next time you try to reopen the project?

4. 
What is the purpose of the UserMachineID field that in the Project_Information table in a database that contains one or more complete projects?

5. 
Can multiple users open the same complete project from a database for write access?

6.
What kind of project information can be saved when doing a partial save? 

What determines what fields get saved?

7.
In Microsoft Project 4.x you could do a partial save by specifying a specific task or resource table and filter. Is there a way to do this in Microsoft Project 98?

8.
What might cause the Set Merge Key button to be disabled in the Define Import/Export Map dialog?

9.
What special options are available in the Define Import/Export Map dialog for Excel worksheets?

What special options are available in the Define Import/Export Map dialog for Text files?

10.
What Microsoft Project 95 macro did the Microsoft Excel Pivot Table file type replace?

Can Microsoft Project 98 intelligently read data back in a pivot table created by saving a project from Microsoft Project 98 with the Microsoft Excel Pivot Table file type?

11.
Where are the import/export maps stored?

Lesson 3.2 - Lab

This lab gives you practice using the new import/export map feature in Microsoft Project 98.

1.
Create a project with several tasks and several resources assigned to each task. Give each resource a nonzero Standard Rate.

2.
Save the project as Test1.xls using the Microsoft Excel Workbook file type and create a map to save the following fields:

· Task Fields: Name, Duration, Work, Cost, Start, Finish

· Resource Fields: Name, Work, Cost, Standard Rate

· Assignment Fields: Task Name, Resource Name, Work, Cost

For the Excel options section in the map, select the Export header row/Import includes headers option, but not the Include assignment data in output option.
Save the project using this map.

3.
Open Test1.xls in Microsoft Excel and examine the data in the three worksheets. Close the workbook.

4.
Repeat steps 2 and 3 above, only this time select the Include assignment data in output option too.

5.
Open Test1.xls from Microsoft Project 98 using a new map that only imports the Task Name, Start, and Finish fields (no resource or assignment fields). 

Lesson 3.3: Database Structure for Full Saves

Some Topics to be introduced in this lesson include:

· Saving Entire Microsoft Projects to a Database

· Supported ODBC Databases

· Detailed Structure of All Tables in the Database

· Enumerated to Text Conversion Tables

· Intl_FieldReferences table

· Intl_ TextConversions table

· Custom Fields

Saving Entire Projects to a Database

Supported ODBC Databases

· Microsoft Access 8.0.

· Oracle, versions 7.2 client, 7.3 server and client.

· SQL Server 6.5 with Service Pack 2, and higher. 

Database Overview

Microsoft Project 98 supports both full (entire project) and partial saving to ODBC databases. When a full save is done, all project information is saved, including formatting information. 

Complete documentation of the full save to database structure is contained in the Database.wri file that ships with Microsoft Project 98. It includes examples of how to edit, create, and delete records in the database, and how to create relationships and queries involving multiple tables in the database.

Microsoft Project 4.x has a Save to Database command on the Tools Multiple Projects submenu that can be used to save project, task, resource, and assignment data to an ODBC database, but not other information such as views, tables, and filters. It also has an Open from Database command to read the data back into Microsoft Project. These commands are actually macros in a password protected hidden Database module.

The picture on the right lists the 4 tables created by the Microsoft Project 4.x Save to Database command when it saves to a Microsoft Access database (compare this to the picture below of Microsoft Project 98's MPD format).


Microsoft Project 4.x database...

[image: image103.png]A, Microsoft Access

Eile Edit View Insert Tooks

48 Projg5_test: Database

E Tables | 1 Queries |

Project
Resource Assignments
Resources

Tasks

B E B





Microsoft Project 98 does not use the Save To Database and Open from Database commands from Microsoft Project 4.x. Instead, the functionality of those commands is now part of a consistent File Save dialog. The interface is discussed in detail in another section.

Microsoft Project 98 saves everything when you do a full save to database, including views, filters, tables, calendars, local project options, and so on. When a full read is done, the project will appear as it did when it was saved out (given that no data changes were made in the database). This section discusses the database structure that is used when the entire project is saved to a database. 

Saving in the MPD format is a full save to a Microsoft Access database. The MPD format is used throughout this lesson to illustrate the general concept of doing a full save to general ODBC databases.

The picture below lists the 38 tables created when saving a project in Microsoft Project 98's MPD format (compare this to the 4 tables created by Microsoft Project 4.x's Save to Database command).

Microsoft Access Tables tab listing the tables for Microsoft Project 98's MPD format...
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The table below lists the 38 tables in a full save to database, with brief comments about the purpose of each table. The structure of each table is discussed in detail later.

List of tables in a full save to database...

Table Name
What the table contains

Assignment_Actual_Cost
Time-phased actual cost for assignments. 

Assignment_Actual_Exceptions
Actual work for assignments that happened in non-working time.

Assignment_Actual_Work
Timephased actual work for assignments. If you add a record, you also need to adjust the corresponding assignment total actual work. This is true in general when adjusting time-phased values.

Assignment_Baseline_Cost
Timephased baseline cost for assignments. 

Assignment_Baseline_Work
Timephased baseline work for assignments. 

Assignment_Information
Assignment data (not time-phased data). The custom assignment Date<n>, Cost<n>, Duration<n>, Finish<n>, Number<n>, Start<n>, and Text <n> fields are not stored in the Assignment_Information table. Instead, data from these fields is stored in the Custom_Date, Custom_Duration, Custom_Number, and Text_Fields tables.

Assignment_Overtime_Work
Timephased actual overtime work for assignments. 

Assignment_Remaining_Work
Timephased remaining work for assignments. 

Calendar_Exceptions
Calendar exceptions.

Calendar_Working_Times
Calendar working times.

Calendars
Basic Calendar data.

Custom_Date_Fields
Project data from the following: task, resource, and assignment fields: Date1, ..., Date10; Finish1, ..., Finish10; Start1, ..., Start10

Custom_Duration_Fields
Project data from the following task, resource, and assignment fields: Duration1, ..., Duration10

Custom_Number_Fields
Project data from the following task, resource, and assignment fields: Cost1, ..., Cost10; Number1, ..., Number20

Intl_FieldReferences
Numerical FieldType codes corresponding to each general enumerated field category, such as the Accrual, Constraint Type, Display Units, and Task Type. 

Intl_TextConversions
Data to translate each enumerated value code (in the ConversionCode column) into the corresponding local text string (in the ConversionText column). For example, if the value 3 is in the FixedCostAccrual field in the Task_Information table, the Intl_TextConversions table indicates that the 3 stands for Prorated (for the English version). The FieldType and ConversionValue pair of fields in the Intl_TextConversions table uniquely determines its records. The Intl_FieldReferences table is used to identify the general enumerated field category for the value in the FieldType column.

Project_Information
Project level data. Project summary task information, such as duration and percent complete, is not saved in the Project_Information table, but rather in the Task_Information table under the ID number 0.

Reserved_AssignmentPoolInfo
Cached pool and sharer assignment data from the pool or other users in a resource-sharing scenario.

Reserved_CommandBars
Project commandbar formatting information, used to recreate the formatting of the commandbars, as they were before the save. This table is marked read-only if the database supports it.

Reserved_CustomForms
User defined form/dialog information, used to recreate any user-defined forms/dialogs in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_ExternalDataLinks
Project DDE and OLE links information, used to recreate any links in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_Filters
Project filter information, used to recreate any filters in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_ImportExportMaps
Import/Export map information, used to recreate any maps in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_Modules
Nothing. It is a place holder table. The actual module information is stored in the Project_Information table in the Reserved_BinaryInformation field, but for internal and compatibility reasons this table is created anyway. This table is marked read-only if the database supports it.

Reserved_Reports
Project report information, used to recreate any reports in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_Tables
Project table information, used to recreate any tables in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_V_iews
Project view information, used to recreate any views in the project, as they were before the save. This table is marked read-only if the database supports it. Note: The table is not named "Reserved_Views" because some database products (such as Microsoft Access 2.0) do not allow the word "view" as part of a table name.

Resource_Baseline_Cost
Timephased baseline cost for resources. 

Resource_Baseline_Work
Timephased baseline work for resources. 

Resource_Information
Resource data (not timephased data). The custom resource Date<n>, Cost<n>, Duration<n>, Finish<n>, Number<n>, Start<n>, and Text <n> fields, and the resource Code, Email Address, and Group fields, are not stored in the Resource_Information table. Instead, data from these fields is stored in the Custom_Date, Custom_Duration, Custom_Number, and Text_Fields tables. 

Resource_Rates
Resource rate tables.

Task_Baseline_Cost
Timephased baseline cost for tasks. 

Task_Baseline_Interim_Splits
Baseline splits for tasks. 

Task_Baseline_Work
Timephased baseline work for tasks. 

Task_Dependencies
Task Dependency (links) data.

Task_Information
Task data (not timephased data). The custom task Date<n>, Cost<n>, Duration<n>, Finish<n>, Number<n>, Start<n>, and Text <n> fields, and the task Contact, WBS, and Subproject File fields, are not stored in the Task_Information table. Instead, data from these fields is stored in the Custom_Date, Custom_Duration, Custom_Number, and Text_Fields tables.

Task_Percent_Complete
Timephased percent complete for tasks. 

Text_Fields
Project data from the task, resource, and assignment Text1, ..., Text30 fields; and the task Contact, SubProject File, and WBS fields; and the resource Code, Group, Email Address fields.

Timephased tables

Several of the above tables contain records that refer to specific periods of time, one period per record. These tables either include fields for the start and end dates of periods (for example FromDate and ToDate in the Assignment_Actual_Cost table), or fields for the start and duration of periods, for example FromDate and WorkingDuration in the Assignment_Actual_Work table. The tables that contain such period specific information are listed below. The word timephased does not appear in the name of any of these tables. See above for a description of each table.

Note that timephased task, resource, and assignment records are not stored in the Task_Information, Resource_Information, and Assignment_Information tables, but instead are stored in separate timephased tables.

Assignment_Actual_Cost
Resource_Baseline_Cost

Assignment_Actual_Exceptions
Resource_Baseline_Work

Assignment_Actual_Work
Resource_Rates

Assignment_Baseline_Cost
Task_Baseline_Cost

Assignment_Baseline_Work
Task_Baseline_Interim_Splits

Assignment_Overtime_Work
Task_Baseline_Work

Assignment_Remaining_Work
Task_Percent_Complete

Calendar_Exceptions


Table definition format used in this lesson

Each database table definition in a full save to database is described in this lesson by listing its implied key, its field names, and field types. For example, part of the structure of the Project_Information table in this lesson is shown below:

Key
Field Name
Field Type

X
ProjectID 
Long


ProjectName
Text(255)


Author
Memo

Order of fields

The fields in the table definitions in this lesson are listed in the order they are defined in the database. The order is not important to Microsoft Project when it reads or writes from or to an existing database, so you create or modify the database and define the fields in a different order. 

However, the names of the fields and tables must not change. When reading in a project, if Microsoft Project cannot find a column (because it has been renamed or deleted), an alert is displayed.

Keys, Indexes, and Relationships

An index for a table is a set of fields that you specify to speed up sorting and searching. A primary key is an index that uniquely determines records in the table. Primary keys can be used to establish relationships between tables, which are useful in creating queries that pull information from several tables. Table relationships also support referential integrity, a set of rules that keeps data consistent across tables with common fields. For example, with the appropriate relationships and referential integrity defined, deleting a project from the Microsoft Project_Information table would cause the assignments for that project to be deleted from the Assignment_Information table.

The implied Key column mentioned above is used in this lesson as part of descriptions of the table structures to identify which field or fields uniquely determine records for a table, and which could be used as primary keys or indexes. 

However, Microsoft Project does not actually set any keys or define any relationships between the tables in the database. For most of the tables, it does define an index corresponding to the fields identified in the Key column. 

Field Types

Most of the table definitions in this lesson list Microsoft Access field data types. However, if you do a full save to another ODBC database, the actual field types used, and their names, depend on the database product (Microsoft Access, Microsoft SQL, and so on). The table below shows the general field types that Microsoft Project will try to use if the database supports it:

General field type notation used in this lesson
Description

Binary - Long
A field containing binary data, where the field is greater than 255 characters.


Binary - Short
A field containing binary data, where the field is fewer than 255 characters.


Date 
A date, including Time.




Memo 
This is the longest text field available, which in Microsoft Access is a length of 64K. For Oracle, this will show up as Text 255 (since they don’t have a “Memo” field).


Number - Bit
A “bit” number. It will be used for Boolean (Yes/No) fields. Most databases support this type. If they don’t, then we will store a field type Integer.




Number - Double
A floating point number.




Number - Integer
An integer.




Number - Long
A long integer.




Text 
Text field of maximum length 255.



Text(<n>)
Text field of maximum length <n>.

Time 
Time without a date.



Examining the structure of a table in Microsoft Access

In Microsoft Access, you can examine the structure of a table by selecting it and clicking the Design button. For example, the picture on the right shows the field definitions for the Project_Information table in the file Master1.MPD that was saved from Microsoft Project and then opened in Microsoft Access. 
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The table that follows shows the Microsoft Access Data Types that are used for the general field types discussed above. The second column shows Data Type listed in the Microsoft Access table definition window (pictured above). The third column shows alternative terms used in this lesson to represent the Microsoft Access data types.

General field type notation
Microsoft Access table definition Data Type entry
Alternative terms used in this lesson

Binary - Long
OLE Object
Long Binary (OLE Object)

Binary - Short
Binary
Binary

Date 
Date/Time
Date/Time

Memo or LongText
Memo
Memo

Number - Bit
Yes/No
Boolean

Number - Double
Number - with Field Size set to Double
Double

Number - Integer
Number - with Field Size set to Integer
Integer

Number - Long
Number - with Field Size set to Long Integer.
Long

Text or Char
Text - with the default Field Size of 255
Text or Text(255)

Text(<n>)
Text - with the Field Size set to <n>
Text (<n>)

Time 
Date/Time
Date/Time

You cannot select Binary from the Data Type dropdown list in a Microsoft Access table definition dialog. You can set it programmatically using the Jet engine. See Microsoft Access help index on Binary data type.

Where Microsoft Project needs to store a time value, but not a date value, it will store the project start date as a date, with the desired time value in a Date field. When you read the project from the database, the date values in these particular fields will be ignored.

Reserved Fields

There are many database fields that must not be changed by the user outside of Microsoft Project in order to recreate the project exactly when reading from the database. These database fields have names that start with “Reserved_”. These fields are not truly read-only, but the naming convention is intended to let the user know that these fields should not be altered.

Read-Only Tables

Some of the tables in the database have table names that start with "Reserved_". All the fields in a reserved table are reserved and should not be altered outside of Microsoft Project. When doing a full save to a database, Microsoft Project attempts to set these tables to Read-Only. If the database does not support read-only tables, the table remains read-write (no warning messages are displayed). SQL and Oracle databases support read-only tables.

Marking reserved tables as read-only does not guarantee that a user will not change data in a reserved table, since a user may have the ability to change the permissions on the table. Saving out some tables read-only when possible prevents accidental changes and makes it harder for an average user to change reserved data.

International Issues

This section discusses language-related issues and the architectural features of a full save to database that allows a project in one language version to be opened in another language version.

Database Table and Field Names

All the table and field names are written in English. Language specific documentation is provided to indicate what the field and table names mean. This is a drawback for non-English users, but it makes the database format consistent across all languages. The field names can be modified in the database, but not the table names.

Proj95 saved different languages out into different “sets” of tables. This makes cross-project analysis difficult to do, and cross-project analysis is one of the big advantages of being able to store to the database.

Enumerated Types versus Text Strings

Some Microsoft Project fields and settings are enumerated types. In other words, they are restricted to a predefined list of values or strings. For example, the task Constraint Type field can only contain predefined strings like "As Soon As Possible," "Start No Earlier Than," and so on, and the Week Starts On setting in the Tools Options Calendar tab can only contain predefined strings "Sunday" through "Saturday." 

To avoid language conversion problems, when doing a full save to a database enumerated types are saved as numerical codes instead of the strings displayed in Microsoft Project. For example, instead of saving out "Start No Earlier Than," the internal integer value 4 is stored. By saving out the integer values, any international version of Microsoft Project 98 can read database output from another without conversion problems 

In previous versions of Microsoft Project, language specific strings were stored in the database, preventing databases created with one language version of Microsoft Project to be opened in another language version.

Enumerated to Text Conversion Tables

The drawback to storing numeric codes instead of language specific strings is the difficulty in visually interpreting the codes. For example, if you see a 4 in the Constraint Type field in the Task_Information table in an English database, it is not meaningful unless you know that it stands for "Start No Earlier Than." To assist with this interpretation process, a pair of conversion tables is also stored in the database:

· Intl_FieldReferences table: The FieldType field uniquely identifies a record for a kind of field, such as Display Units (work and duration are this kind of field). Note that the term field type is also used in a different context to mean the type of data that can be stored in a field.

· Intl_TextConversions table: Each FieldType-ConversionValue pair of field values uniquely identifies a conversion record. The LanguageID field identifies the language, and the ConversionText field contains the language specific string.

These tables are marked as READ-ONLY, if the database supports it. These two tables work together to provide conversion information.

Intl_FieldReferences table

This table assigns a numeric code called a FieldType, to each general enumerated field type, such as the Accrual, Constraint Type, Display Units, and Task Type. 

These general enumerated field types are not themselves Microsoft Project fields or settings. They instead represent categories of Project fields and settings whose values are restricted to enumerated sets of choices. 

For example, Accrual is an entry in the Field Type column in the Intl_FieldReferences table. Three Project fields/settings fall into that category: the resource field Accrue At, the task field Fixed Cost Accrual, and the Tools Options Calculation tab setting Default fixed costs accrual.

In other cases, only Microsoft Project field/setting has a particular enumerated field type. For example, Constraint Type is an entry in the Field Type column in the Intl_FieldReferences table. There is only one Microsoft Project fields/settings that falls into that category, the task field Constraint Type.

The database definition (structure) of the Intl_FieldReferences table follows. You can see something similar to this if you save a project in MPD format and open it in Microsoft Access, and then select the Intl_FieldReferences table and click the Design button to view its definition.

Intl_FieldReferences table definition...

Key
Field Name
Data Type
Description

X
FieldType
Long
A number representing the enumerated field category


LanguageID
Long
The ID of the language in which the FieldName is shown


FieldName
Text(200)
The name of the enumerated field category

For the English language, the Intl_FieldReferences table has the columns and records shown below. You can see something similar to this if you open an MPD file in Microsoft Access, and then double-click the Intl_FieldReferences table to open it.

Intl_FieldReferences table data records...

FieldType
LanguageID
FieldName

8
1252
Weekday

9
1252
Display Units

20
1252
Constraint Type

22
1252
Accrual

27
1252
Priority

28
1252
Work Contour Type

29
1252
Link Type

30
1252
Task Type

34
1252
Cost Rate Units

100
1252
Container Type

101
1252
Schedule Start

102
1252
Calendar Working

103
1252
Currency Symbol Position

104
1252
Workgroup Messages

105
1252
Field ID

The table below shows which Microsoft Project database fields have the previously enumerated types. The first column lists the enumerated types from the FieldName column in the previous Intl_FieldReferences table. The second column lists all of the Microsoft Project database fields that have that enumerated type. For example, the FixedCostAccrual field in the Task_Informtion table is of the enumerated field type "Accrual."

Note: This table is for illustration purposes; it is not in the database.

Enumerated field types...

Enum. Type Name
Fields of that Type - followed by the parent table

Accrual
AccrueAt - Resource_Information


DefaultFixedCostAccrual - Project_Information


FixedCostAccrual - Task_Information

Calendar Working
Working - Calendar_Exceptions


Working - Calendar_Working_Times

Constraint Type
ConstraintType - Task_Information

Container Type
ContainerType - Custom_Date_Fields


ContainerType - Custom_Duration_Fields


ContainerType - Custom_Number_Fields


ContainerType - Text_Fields


Reserved_ContainerUniqueID - Reserved_ExternalDataLinks

Cost Rate Units
OvertimeRateDisplayUnits - Resource_Rates


StandardRateDisplayUnits - Resource_Rates

Currency Symbol Position
CurrencyPosition - Project_Information

Display Units
ActualDurationDisplayUnits - Task_Information


BaselineDurationDisplayUnits - Task_Information


DelayDisplayUnits - Assignment_Information


DelayDisplayUnits - Task_Information


DurationDisplayUnits - Custom_Duration_Fields


DurationDisplayUnits - Task_Information


LinkLagDisplayUnits - Task_Dependencies


OvertimeRateDisplayUnits - Resource_Information


RemainingDurationDisplayUnits - Task_Information


StandardRateDisplayUnits - Resource_Information

Field ID
FieldID - Custom_Date_Fields


FieldID - Custom_Duration_Fields


FieldID - Custom_Number_Fields


FieldID - Text_Fields

Link Type
LinkType - Task_Dependencies

Priority
Priority - Task_Information

Schedule Start
ScheduleFrom - Project_Information

Task Type
DefaultTaskType - Project_Information


Type - Task_Information

Weekday 
Weekday - Calendar_Working_Times

Work Contour Type
WorkContour - Assignment_Information

Workgroup Messages
Workgroup - Resource_Information

About FieldID...

Most of the items previously listed in the first column are easily identifiable as enumerated types in Microsoft Project, except for the FieldID item. This is not a type of field that you can insert in a table in Microsoft Project. It is a field that shows up in the following tables in the database: Custom_Date_Fields table, Custom_Number_Fields table, Custom_Duration_Fields table, and Text_Fields table. Each of these tables has a single "value" column that can represent data from a variety of Microsoft Project task, resource, and assignment fields. For each record in these tables, the long integer code in the FieldID column tells you how to interrupt the data in the value column (for example, which Microsoft Project field it really is for). These tables are discussed in detail later.

Intl_ TextConversions table 

The database definition (structure) of the Intl_ TextConversions table follows. You can see something similar to this if you open an MPD file in Microsoft Access, and then select the Intl_ TextConversions table and click the Design button to view its definition.

Intl_ TextConversions table definition...

Key
Field Name
Data Type
Description


FieldType
Long
A number representing the enumerated field category


ConversionValue
Long
The value seen in the database fields


LanguageID
Long
The ID of the language in which the conversion text is displayed


ConversionText
Text(200)
The text representation of the conversion value

The FieldType and ConversionValue pair of fields uniquely determines the records in the Intl_TextConversions table.

For the English language, the Intl_TextConversions table columns and records (reordered by FieldType and then ConversionValue) follow. You can see something similar to this if you open an MPD file in Microsoft Access, and then double-click the Intl_FieldReferences table to open it.

Intl_TextConversions table data records...

FieldType
ConversionValue
LanguageID
ConversionText

8
1
1252
Sunday

8
2
1252
Monday

8
3
1252
Tuesday

8
4
1252
Wednesday

8
5
1252
Thursday

8
6
1252
Friday

8
7
1252
Saturday

8
8
1252
Saturday/Sunday

9
3
1252
m

9
4
1252
em

9
5
1252
h

9
6
1252
eh

9
7
1252
d

9
8
1252
ed

9
9
1252
w

9
10
1252
ew

9
15
1252
y

9
16
1252
ey

9
17
1252
DC

9
18
1252
eDC

9
19
1252
%

9
20
1252
e%

20
0
1252
As Soon As Possible

20
1
1252
As Late As Possible

20
2
1252
Must Start On

20
3
1252
Must Finish On

20
4
1252
Start No Earlier Than

20
5
1252
Start No Later Than

20
6
1252
Finish No Earlier Than

20
7
1252
Finish No Later Than

22
1
1252
Start

22
2
1252
End

22
3
1252
Prorated

27
0
1252
Lowest

27
1
1252
Very Low

27
2
1252
Lower

27
3
1252
Low

27
4
1252
Medium

27
5
1252
High

27
6
1252
Higher

27
7
1252
Very High

27
8
1252
Highest

27
9
1252
Do Not Level

28
0
1252
Flat

28
1
1252
Back Loaded

28
2
1252
Front Loaded

28
3
1252
Double Peak

28
4
1252
Early Peak

28
5
1252
Late Peak

28
6
1252
Bell

28
7
1252
Turtle

28
8
1252
Contoured

29
0
1252
FF

29
1
1252
FS

29
2
1252
SF

29
3
1252
SS

30
0
1252
Fixed Units

30
1
1252
Fixed Duration

30
2
1252
Fixed Work

34
1
1252
m

34
2
1252
h

34
3
1252
d

34
4
1252
w

34
7
1252
y

100
0
1252
Task

100
1
1252
Resource

100
2
1252
Calendar

100
3
1252
Assignment

100
4
1252
Dependencies

101
0
1252
Project Finish

101
1
1252
Project Start

102
0
1252
Non -Working

102
1
1252
Working

102
2
1252
Default

103
0
1252
Before

103
1
1252
After

103
2
1252
Before with Space

103
3
1252
After with Space

104
0
1252
Default

104
1
1252
None

104
2
1252
Email

104
3
1252
Web

104
4
1252
Email and Web

105
188743696
1252
Task WBS

105
188743706
1252
Task Subproject File

105
188743731
1252
Task Text1

105
188743732
1252
Task Start1

105
188743733
1252
Task Finish1

105
188743734
1252
Task Text2

105
188743735
1252
Task Start2

105
188743736
1252
Task Finish2

105
188743737
1252
Task Text3

105
188743738
1252
Task Start3

105
188743739
1252
Task Finish3

105
188743740
1252
Task Text4

105
188743741
1252
Task Start4

105
188743742
1252
Task Finish4

105
188743743
1252
Task Text5

105
188743744
1252
Task Start5

105
188743745
1252
Task Finish5

105
188743746
1252
Task Text6

105
188743747
1252
Task Text7

105
188743748
1252
Task Text8

105
188743749
1252
Task Text9

105
188743750
1252
Task Text10

105
188743767
1252
Task Number1

105
188743768
1252
Task Number2

105
188743769
1252
Task Number3

105
188743770
1252
Task Number4

105
188743771
1252
Task Number5

105
188743783
1252
Task Duration1

105
188743784
1252
Task Duration2

105
188743785
1252
Task Duration3

105
188743786
1252
Task Cost1

105
188743787
1252
Task Cost2

105
188743788
1252
Task Cost3

105
188743792
1252
Task Contact

105
188743938
1252
Task Cost4

105
188743939
1252
Task Cost5

105
188743940
1252
Task Cost6

105
188743941
1252
Task Cost7

105
188743942
1252
Task Cost8

105
188743943
1252
Task Cost9

105
188743944
1252
Task Cost10

105
188743945
1252
Task Date1

105
188743946
1252
Task Date2

105
188743947
1252
Task Date3

105
188743948
1252
Task Date4

105
188743949
1252
Task Date5

105
188743950
1252
Task Date6

105
188743951
1252
Task Date7

105
188743952
1252
Task Date8

105
188743953
1252
Task Date9

105
188743954
1252
Task Date10

105
188743955
1252
Task Duration4

105
188743956
1252
Task Duration5

105
188743957
1252
Task Duration6

105
188743958
1252
Task Duration7

105
188743959
1252
Task Duration8

105
188743960
1252
Task Duration9

105
188743961
1252
Task Duration10

105
188743962
1252
Task Start6

105
188743963
1252
Task Finish6

105
188743964
1252
Task Start7

105
188743965
1252
Task Finish7

105
188743966
1252
Task Start8

105
188743967
1252
Task Finish8

105
188743968
1252
Task Start9

105
188743969
1252
Task Finish9

105
188743970
1252
Task Start10

105
188743971
1252
Task Finish10

105
188743982
1252
Task Number6

105
188743983
1252
Task Number7

105
188743984
1252
Task Number8

105
188743985
1252
Task Number9

105
188743986
1252
Task Number10

105
188743987
1252
Task Number11

105
188743988
1252
Task Number12

105
188743989
1252
Task Number13

105
188743990
1252
Task Number14

105
188743991
1252
Task Number15

105
188743992
1252
Task Number16

105
188743993
1252
Task Number17

105
188743994
1252
Task Number18

105
188743995
1252
Task Number19

105
188743996
1252
Task Number20

105
188743997
1252
Task Text11

105
188743998
1252
Task Text12

105
188743999
1252
Task Text13

105
188744000
1252
Task Text14

105
188744001
1252
Task Text15

105
188744002
1252
Task Text16

105
188744003
1252
Task Text17

105
188744004
1252
Task Text18

105
188744005
1252
Task Text19

105
188744006
1252
Task Text20

105
188744007
1252
Task Text21

105
188744008
1252
Task Text22

105
188744009
1252
Task Text23

105
188744010
1252
Task Text24

105
188744011
1252
Task Text25

105
188744012
1252
Task Text26

105
188744013
1252
Task Text27

105
188744014
1252
Task Text28

105
188744015
1252
Task Text29

105
188744016
1252
Task Text30

105
205520899
1252
Resource Group

105
205520904
1252
Resource Text1

105
205520905
1252
Resource Text2

105
205520906
1252
Resource Code

105
205520926
1252
Resource Text3

105
205520927
1252
Resource Text4

105
205520928
1252
Resource Text5

105
205520931
1252
Resource Email Address

105
205520993
1252
Resource Text6

105
205520994
1252
Resource Text7

105
205520995
1252
Resource Text8

105
205520996
1252
Resource Text9

105
205520997
1252
Resource Text10

105
205520998
1252
Resource Start1

105
205520999
1252
Resource Start2

105
205521000
1252
Resource Start3

105
205521001
1252
Resource Start4

105
205521002
1252
Resource Start5

105
205521003
1252
Resource Finish1

105
205521004
1252
Resource Finish2

105
205521005
1252
Resource Finish3

105
205521006
1252
Resource Finish4

105
205521007
1252
Resource Finish5

105
205521008
1252
Resource Number1

105
205521009
1252
Resource Number2

105
205521010
1252
Resource Number3

105
205521011
1252
Resource Number4

105
205521012
1252
Resource Number5

105
205521013
1252
Resource Duration1

105
205521014
1252
Resource Duration2

105
205521015
1252
Resource Duration3

105
205521019
1252
Resource Cost1

105
205521020
1252
Resource Cost2

105
205521021
1252
Resource Cost3

105
205521062
1252
Resource Cost4

105
205521063
1252
Resource Cost5

105
205521064
1252
Resource Cost6

105
205521065
1252
Resource Cost7

105
205521066
1252
Resource Cost8

105
205521067
1252
Resource Cost9

105
205521068
1252
Resource Cost10

105
205521069
1252
Resource Date1

105
205521070
1252
Resource Date2

105
205521071
1252
Resource Date3

105
205521072
1252
Resource Date4

105
205521073
1252
Resource Date5

105
205521074
1252
Resource Date6

105
205521075
1252
Resource Date7

105
205521076
1252
Resource Date8

105
205521077
1252
Resource Date9

105
205521078
1252
Resource Date10

105
205521079
1252
Resource Duration4

105
205521080
1252
Resource Duration5

105
205521081
1252
Resource Duration6

105
205521082
1252
Resource Duration7

105
205521083
1252
Resource Duration8

105
205521084
1252
Resource Duration9

105
205521085
1252
Resource Duration10

105
205521086
1252
Resource Finish6

105
205521087
1252
Resource Finish7

105
205521088
1252
Resource Finish8

105
205521089
1252
Resource Finish9

105
205521090
1252
Resource Finish10

105
205521101
1252
Resource Number6

105
205521102
1252
Resource Number7

105
205521103
1252
Resource Number8

105
205521104
1252
Resource Number9

105
205521105
1252
Resource Number10

105
205521106
1252
Resource Number11

105
205521107
1252
Resource Number12

105
205521108
1252
Resource Number13

105
205521109
1252
Resource Number14

105
205521110
1252
Resource Number15

105
205521111
1252
Resource Number16

105
205521112
1252
Resource Number17

105
205521113
1252
Resource Number18

105
205521114
1252
Resource Number19

105
205521115
1252
Resource Number20

105
205521116
1252
Resource Start6

105
205521117
1252
Resource Start7

105
205521118
1252
Resource Start8

105
205521119
1252
Resource Start9

105
205521120
1252
Resource Start10

105
205521121
1252
Resource Text11

105
205521122
1252
Resource Text12

105
205521123
1252
Resource Text13

105
205521124
1252
Resource Text14

105
205521125
1252
Resource Text15

105
205521126
1252
Resource Text16

105
205521127
1252
Resource Text17

105
205521128
1252
Resource Text18

105
205521129
1252
Resource Text19

105
205521130
1252
Resource Text20

105
205521131
1252
Resource Text21

105
205521132
1252
Resource Text22

105
205521133
1252
Resource Text23

105
205521134
1252
Resource Text24

105
205521135
1252
Resource Text25

105
205521136
1252
Resource Text26

105
205521137
1252
Resource Text27

105
205521138
1252
Resource Text28

105
205521139
1252
Resource Text29

105
205521140
1252
Resource Text30

105
255852632
1252
Assignment Text1

105
255852633
1252
Assignment Text2

105
255852634
1252
Assignment Text3

105
255852635
1252
Assignment Text4

105
255852636
1252
Assignment Text5

105
255852637
1252
Assignment Text6

105
255852638
1252
Assignment Text7

105
255852639
1252
Assignment Text8

105
255852640
1252
Assignment Text9

105
255852641
1252
Assignment Text10

105
255852642
1252
Assignment Start1

105
255852643
1252
Assignment Start2

105
255852644
1252
Assignment Start3

105
255852645
1252
Assignment Start4

105
255852646
1252
Assignment Start5

105
255852647
1252
Assignment Finish1

105
255852648
1252
Assignment Finish2

105
255852649
1252
Assignment Finish3

105
255852650
1252
Assignment Finish4

105
255852651
1252
Assignment Finish5

105
255852652
1252
Assignment Number1

105
255852653
1252
Assignment Number2

105
255852654
1252
Assignment Number3

105
255852655
1252
Assignment Number4

105
255852656
1252
Assignment Number5

105
255852657
1252
Assignment Duration1

105
255852658
1252
Assignment Duration2

105
255852659
1252
Assignment Duration3

105
255852663
1252
Assignment Cost1

105
255852664
1252
Assignment Cost2

105
255852665
1252
Assignment Cost3

105
255852703
1252
Assignment Cost4

105
255852704
1252
Assignment Cost5

105
255852705
1252
Assignment Cost6

105
255852706
1252
Assignment Cost7

105
255852707
1252
Assignment Cost8

105
255852708
1252
Assignment Cost9

105
255852709
1252
Assignment Cost10

105
255852710
1252
Assignment Date1

105
255852711
1252
Assignment Date2

105
255852712
1252
Assignment Date3

105
255852713
1252
Assignment Date4

105
255852714
1252
Assignment Date5

105
255852715
1252
Assignment Date6

105
255852716
1252
Assignment Date7

105
255852717
1252
Assignment Date8

105
255852718
1252
Assignment Date9

105
255852719
1252
Assignment Date10

105
255852720
1252
Assignment Duration4

105
255852721
1252
Assignment Duration5

105
255852722
1252
Assignment Duration6

105
255852723
1252
Assignment Duration7

105
255852724
1252
Assignment Duration8

105
255852725
1252
Assignment Duration9

105
255852726
1252
Assignment Duration10

105
255852727
1252
Assignment Finish6

105
255852728
1252
Assignment Finish7

105
255852729
1252
Assignment Finish8

105
255852730
1252
Assignment Finish9

105
255852731
1252
Assignment Finish10

105
255852742
1252
Assignment Number6

105
255852743
1252
Assignment Number7

105
255852744
1252
Assignment Number8

105
255852745
1252
Assignment Number9

105
255852746
1252
Assignment Number10

105
255852747
1252
Assignment Number11

105
255852748
1252
Assignment Number12

105
255852749
1252
Assignment Number13

105
255852750
1252
Assignment Number14

105
255852751
1252
Assignment Number15

105
255852752
1252
Assignment Number16

105
255852753
1252
Assignment Number17

105
255852754
1252
Assignment Number18

105
255852755
1252
Assignment Number19

105
255852756
1252
Assignment Number20

105
255852757
1252
Assignment Start6

105
255852758
1252
Assignment Start7

105
255852759
1252
Assignment Start8

105
255852760
1252
Assignment Start9

105
255852761
1252
Assignment Start10

105
255852762
1252
Assignment Text11

105
255852763
1252
Assignment Text12

105
255852764
1252
Assignment Text13

105
255852765
1252
Assignment Text14

105
255852766
1252
Assignment Text15

105
255852767
1252
Assignment Text16

105
255852768
1252
Assignment Text17

105
255852769
1252
Assignment Text18

105
255852770
1252
Assignment Text19

105
255852771
1252
Assignment Text20

105
255852772
1252
Assignment Text21

105
255852773
1252
Assignment Text22

105
255852774
1252
Assignment Text23

105
255852775
1252
Assignment Text24

105
255852776
1252
Assignment Text25

105
255852777
1252
Assignment Text26

105
255852778
1252
Assignment Text27

105
255852779
1252
Assignment Text28

105
255852780
1252
Assignment Text29

105
255852781
1252
Assignment Text30

Intl_FieldReferences and Intl_TextConversions tables combined

It is easier to see the purpose of the Intl_FieldReferences and Intl_TextConversions tables if you combine some columns from each of them in a single table. 

In the following hybrid table, the first column, FieldType, is common to both the Intl_FieldReferences and Intl_TextConversions tables and is used to JOIN them. The second column, FieldName is from the Intl_FieldReferences table. The third and fourth columns are from the Intl_TextConversions table. This is from the English version of Microsoft Project 98.

Only a sampling of the FieldType 105 (FieldID) records are listed, since there are nearly 300 FieldID codes referring to various fields represented in tables like the Custom_Date_Fields and Text_Fields tables. Custom fields are discussed in detail later.

Note: This table is for illustration purposes; it is not in the database.

Hybrid combination of the Intl_FieldReferences and Intl_TextConversions tables ...

FieldType
FieldName
ConversionText
ConversionValue

22
Accrual
Start
1



End
2



Prorated
3

102
Calendar Working
Non -Working
0



Working
1



Default
2

20
Constraint Type
As Soon As Possible
0



As Late As Possible
1



Must Start On
2



Must Finish On
3



Start No Earlier Than
4



Start No Later Than
5



Finish No Earlier Than
6



Finish No Later Than
7

100
Container Type
Task
0



Resource
1



Calendar
2



Assignment
3



Dependencies
4

34
Cost Rate Units
m
1



h
2



d
3



w
4



y
7

103
Currency Symbol Position
Before
0



After
1



Before with Space
2



After with Space
3

9
Display Units
m
3



em
4



h
5



eh
6



d
7



ed
8



w
9



ew
10



y
15



ey
16



DC
17



eDC
18



%
19



e%
20

29
Link Type
FF
0



FS
1



SF
2



SS
3

27
Priority
Lowest
0



Very Low
1



Lower
2



Low
3



Medium
4



High
5



Higher
6



Very High
7



Highest
8



Do Not Level
9

101
Schedule Start
Project Finish
0



Project Start
1

30
Task Type
Fixed Units
0



Fixed Duration
1



Fixed Work
2

8
Weekday
Sunday
1



Monday
2



Tuesday
3



Wednesday
4



Thursday
5



Friday
6



Saturday
7



Saturday/Sunday
8

28
Work Contour Type
Flat
0



Back Loaded
1



Front Loaded
2



Double Peak
3



Early Peak
4



Late Peak
5



Bell
6



Turtle
7



Contoured
8

104
Workgroup Messages
Default
0



None
1



Email
2



Web
3



Email and Web
4

105
FieldID
Task WBS
188743696



Task Subproject File
188743706



Task Text1
188743731



Task Start1
188743732



Task Finish1
188743733



Task Number1
188743767



Task Duration1
188743783



Task Cost1
188743786



Task Contact
188743792



Task Date1
188743945



Resource Group
205520899



Resource Text1
205520904



Resource Code
205520906



Resource Email Address
205520931



Resource Start1
205520998



Resource Finish1
205521003



Resource Number1
205521008



Resource Duration1
205521013



Resource Cost1
205521019



Resource Date1
205521069



Assignment Text1
255852632



Assignment Start1
255852642



Assignment Finish1
255852647



Assignment Number1
255852652



Assignment Duration1
255852657



Assignment Cost1
255852663



Assignment Date1
255852710

The preceding table clearly shows the choices available for various enumerated types in the English version of Microsoft Project 98 (Constraint Type, Priority, and so on). These are the choices available in the dropdown lists for enumerated fields like Constraint Type and Priority in Project.

The above table also shows the long integer codes used to identify fieldnames corresponding to records in tables like the Custom_Date_Fields and Text_Fields tables. 

These custom fields are discussed in detail later.

Example

This example illustrates how the Intl_FieldReferences and Intl_TextConversions tables can be used to interpret enumerated codes contained in other tables.

A few of the columns from the Projects, Task_Information, and Resource_Information database tables are shown below, with one of the records from each:

Project_Information table...



ProjectID
ProjectName
ScheduleFrom
DurationEnteredIn

1
Project1
1
7






Task_Information table...

TaskID
ConstraintType
Priority
TaskType
Name

1
4
4
2
Task 1

Resource_Information table...

ResourceID
AccrueAt
Workgroup
Name

1
3
3
Resource 1

In the preceding tables, the ScheduleFrom, DurationEnteredIn, ConstraintType, Priority, TaskType, AccrueAt, and Workgroup fields are examples of enumerated fields. Notice that all of these fields contain numerical codes rather than the enumerated text you would see displayed in Microsoft Project.

The Intl_FieldReferences and Intl_TextConversions tables can help you interpret the enumerated codes. For example, to identify what the 7 means in the DurationEnteredIn field, you do the following:

· First, in the Intl_FieldReferences table, look up the appropriate FieldType category. DurationEnteredIn refers to the Tools Options Schedule tab setting "Duration is entered in," so it falls into the general FieldType of "Display Units" with a code of 9.

· Second, in the Intl_TextConversions table, look for the unique record that has a 9 in the FieldType column and a 7 in the ConversionValue column. That record has the string "d" in the ConversionText column. That means that the "Duration is entered in" setting is set to days.

However, it's quicker to use the above combined Intl_FieldReferences and Intl_TextConversions hybrid table to get the answer. If you look up Display Units in the second column of the combined table and then look for 7 in the fourth column, you can see that "d" is listed in the third column.

Some Notes on Field Types

Although Microsoft Project 98 allows you to enter or display the duration labels in different formats, these do not show up in the database (but they are stored in the project default settings so that they correctly display again when the database is read in). 

All duration and rate fields are saved to the database as two separate fields. The first is the actual value of the duration, and the second is the DisplayUnits (used for display purposes in Microsoft Project 98). For example, the Task_Information table contains both a Duration field and a DurationDisplayUnits field.

To reduce rounding problems, duration values are saved as minutes times 10, and work values are saved out as minutes times 1000. Rate fields are saved as dollars per hour, and Cost fields are saved as pennies.

The DisplayUnits general FieldType are mapped to text using the Intl_TextConversions and Intl_FieldReferences tables. These units are for text conversion for fields related to duration, delay, lag, and rates. Work rates are always shown in the default work units, shown in the Project_Information table under “Reserved_WorkShownIn.”

NLS Code Page

See the discussion of the Reserved_LanguageID and Reserved_NLSCodePage fields in the Microsoft Project table topic later in this lesson.

Multi-lingual Databases

Users can store multiple languages into the same project database, but the text conversion strings are determined by the project saved to the database. Subsequent projects/languages that write to the database will not add or change anything in the conversion tables. 

Note Fields

Microsoft Project 98 has rich text format (RTF) notes for assignments, tasks and resources. Notes are saved to a database as part of the Reserved_BinaryProperties field in the Task_Information table, along with all other binary information for that object. RTF notes cannot be viewed in the database. The first 255 characters of RTF notes can be viewed in the "plain" Notes field in the Task_Information table. Changes made to the Notes field in the database are not read back into Microsoft Project. Only the original RTF notes from the Reserved_BinaryProperties field are read into Microsoft Project. The Notes field and the RTF Notes in the Reserved_BinaryProperties field are not linked in the database. 

Custom Fields

This section discusses the storage of custom Task, Resource, and Assignment dates; start, finish, duration, number, and text fields, such as Date1, Date2,..., Start1, Start2,..., and so on.

The following custom fields are available for Tasks, Resources, and Assignments:

· Cost1, ..., Cost10

· Date1, ..., Date10

· Duration1, ..., Duration10

· Finish1, ..., Finish10

· Flag1, ..., Flag20

· Number1, ..., Number20

· Start1, ..., Start10

· Text1, ..., Text30

These custom fields are often referred to using notations such as Cost<n> or Costn or Cost#.

The Flag1, ..., Flag20 Project fields have equivalent fields in the Task_Information, Resource_Information, and Assignment_Information tables in the database. However, the other fields listed previously do not.

Data from all the Cost<n>, Date<n>, Duration<n>, Finish<n>, Number<n>, Start<n>, and Text<n> Project fields are stored in the following special database, along with a few other task and resource fields:

This database table...
Contains Project data from these fields...

Custom_Date_Fields
The following task, resource, and assignment fields:

Date1, ..., Date10

Finish1, ..., Finish10

Start1, ..., Start10

Custom_Duration_Fields
The following task, resource, and assignment fields:

Duration1, ..., Duration10

Custom_Number_Fields
The following task, resource, and assignment fields:

Cost1, ..., Cost10

Number1, ..., Number20

Text_Fields
The following task, resource, and assignment fields:

Text1, ..., Text30

And the following task-only fields:

Contact

SubProject File

WBS

And the following resource-only fields:

Code

Group

Email Address

The ConversionText column in the Intl_TextConversions table includes the words Task, Resource, or Assignment as part of the field name to avoid confusion. For example the "Task Text1" field, the "Assignment Text1" field, and the "Resource Text1" field are three separate fields.

As the table above shows, the custom Assignment, Resource and Task fields are not stored in the corresponding Assignment_Information, Resource_Information, and Task _Information tables. Instead, information corresponding to these fields is stored in the Custom_Date_Fields, Custom_Duration_Fields, Custom_Number_Fields, and Text_Fields tables. 

The Flag1-20 fields are stored in the various Information tables for performance reasons.

The Custom_Date_Fields, Custom_Duration_Fields, Custom_Number_Fields, and Text_Fields tables have a coded FieldID column that can be used to identify whether the custom field involved is for a task, resource, or assignment, and what the field is. For a given value in the FieldID column, look up the value in the ConversionValue column in the Intl_Textconversions table. The CoversionText column has the corresponding language specific custom field name, for example, Assignment Text1. 

The Custom_Date_Fields, Custom_Duration_Fields, Custom_Number_Fields, and Text_Fields tables also have a UniqueID that identifies the corresponding task, resource, or assignment. 

Note that records are only added to these tables if the custom field has a value (was used). Also, note that the FieldID values are unique for Tasks, Resources, and Assignments. For example, the Task Text1 field, the Resource Text1 field, and the Assignment Text1 field have three different FieldID's.

The definitions of the Custom_Date_Fields, Custom_Duration_Fields, Custom_Number_Fields, and Text_Fields tables are shown below.

Custom_Date_Fields table

This table holds Project data from the following task, resource, and assignment fields:

Date1, ..., Date10

Finish1, ..., Finish10

Start1, ..., Start10

Custom_Date_Fields table definition...

Key
Field Name
Data Type
Description

X
ProjectID
Long
The unique ID for the project


ContainerType
Long
Whether this is a record for a task, resource or assignment

X
UniqueID
Long
The uniqueID for the task, resource or assignment for which the custom date, start or finish field applies

X
FieldID
Long
The unique ID for the custom date, start or finish field. The ID also indicates whether it applies to a task, resource, or assignment because all task, resource, and assignment FieldID's are distinct, providing redundant verification of the ContainerType value.


DateValue
Date/Time
The date value stored in the custom date, start or finish field. Can be from a task, resource, or assignment Date1, ..., Date10, Finish1, ..., Finish10, or Start1, ..., Start10 field.

Custom_Duration_Fields table

This table holds Project data from the following task, resource, and assignment fields:

Duration1, ..., Duration10

Custom_Duration_Fields table definition

Key
Field Name
Data Type
Description

X
ProjectID
Long
The unique ID for the project


ContainerType
Long
Whether this is a record for a task, resource or assignment

X
UniqueID
Long
The uniqueID for the task, resource or assignment for which the custom duration field applies

X
FieldID
Long
The unique ID for the custom duration field. The ID also indicates whether it applies to a task, resource or assignment because all task, resource, and assignment FieldID's are distinct, providing redundant verification of the ContainerType value.


DurationValue
Long
The duration value stored in the custom duration field. Can be from a task, resource, or assignment Duration1, ..., Duration10 field.


DurationDisplayUnits
Integer
The units in which the custom field is displayed in Microsoft Project

Custom_Number_Fields table

This table holds Project data from the following task, resource, and assignment fields:

Cost1, ..., Cost10

Number1, ..., Number20

Custom_Number_Fields table definition...

Key
Field Name
Data Type
Description


ProjectID
Long
The unique ID for the project


ContainerType
Long
Whether this is a record for a task, resource or assignment


UniqueID
Long
The uniqueID for the task, resource or assignment for which the custom number or cost field applies


FieldID
Long
The unique ID for the custom number or cost field. The ID also indicates whether it applies to a task, resource or assignment because all task, resource, and assignment FieldID's are distinct, providing redundant verification of the ContainerType value.


NumberValue
Double
The value stored in the custom number or cost field. Can be from a task, resource, or assignment Cost1, ..., Cost10 or Number1, ..., Number20 field.

Text_Fields table

This table holds Project data from the following task, resource, and assignment fields:

Text1, ..., Text30

And the following task-only fields:

Contact

SubProject File

WBS

And the following resource-only fields:

Code

Group

Email Address

Text_Fields table definition...

Key
Field Name
Data Type
Description


ProjectID
Long
The unique ID for the project


ContainerType
Long
Whether this is a record for a task, resource or assignment


UniqueID
Long
The uniqueID for the task, resource or assignment for which the custom text field applies


FieldID
Long
The unique ID for the custom text field (task, resource, or assignment Text1, ..., Text30 fields; or the task Contact, SubProject File, or WBS fields; or the resource Code, Group, or Email Address fields). The ID also indicates whether it applies to a task, resource or assignment because all task, resource, and assignment FieldID's are distinct, providing redundant verification of the ContainerType value.


TextValue
Text(255)
The text value stored in the custom text field. Can be text from task, resource, or assignment Text1, ..., Text30 fields; or the task Contact, SubProject File, or WBS fields; or the resource Code, Group, or Email Address fields.



Example

This example illustrates how the Intl_TextConversions table can used to interpret the data in the Text_Fields table in the database.

The following records are in the Text_Fields table:

Text_Fields table...

ProjectID
ContainerType
UniqueID
FieldID
TextValue

1
0
1
188743731
stuff1

1
0
1
188743737
stuff3

Following are the records from the English Intl_TextConversions table corresponding to the FieldID's in the above Text_Fields table:

Intl_TextConversions table...

FieldType
ConversionValue
LanguageID
ConversionText

8
188743731
1252
Task Text1

8
188743737
1252
Task Text3

This means that "stuff1" and "stuff3" were entered in the Text1 and Text3 fields respectively for the task with UniqueID = 1.

Example

This example illustrates how the Intl_TextConversions table can used to interpret the data in the Custom_Date_Fields, Custom_Duration_Fields, Custom_Number_Fields, and Text_Fields tables.

Various custom and text data was entered in Microsoft Project for a task and a resource as shown in the following table. Then the project was saved in the MPD format.

Project Field
Data entered in Project for the task with ID=1
 Data entered in Project for the resource with ID=1

Code

My test resource code

Contact
My test task contact


Cost1
$200.00 
$100.00 

Date1
March 1, 1997
1-Jan-97

Duration1
20 days
10 days

Email Address

My test resource email address

Finish1
March 11, 1997
11-Jan-97

Group

My test resource group

Name
Test Task
Bob Miller

Number1
45.6
12.3

Start1
March 10, 1997
10-Jan-97

Text1
My test task Text1
My test resource Text1

WBS
My test task WBS


In addition, C:\Win95\Personal\Test1.mpp was entered in the Subproject File field for the task with ID=2.

The pictures below show the corresponding results in the several when the MPD file is opened in Microsoft Access. 

Custom_Date_Fields table...
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Custom_Duration_Fields table...
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Custom_Number_Fields table...
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Text_Fields table...
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Project_Information table

This table contains Project level data. Project level task information, such as duration and percent complete in the Project Statistics dialog, is not stored in the Project_Information table, but is instead stored in the Task_Information table under ID number 0.

Project_Information table definition...

Key
Field Name
Data Type
Description

X
ProjectID
Long
The unique ID for the Project.


ProjectName
Text(255)
The project name. The project name together with the Data Source name can't exceed 255 characters.


Author
Memo
The Author of the project. This corresponds to the File Properties Summary tab setting: Author.


Category
Memo
The Category of the project. This corresponds to the File Properties Summary tab setting: Category.


Company
Memo
The Company for the project. This corresponds to the File Properties Summary tab setting: Company.


CurrentDate
Date/Time
The current date in the project. C37.


FinishDate
Date/Time
The finish date of the project. This corresponds to the Project Information dialog setting: Finish date.


KeyWords
Memo
The Keywords for the project. This corresponds to the File Properties Summary tab setting: Keywords.


LastSaved
Date/Time
The last date the project was saved. This corresponds to the File Properties General and Statistic tabs setting: Modified.


Manager
Memo
The manager for the project. This corresponds to the File Properties Summary tab setting: Manager.


OriginalFileName
Memo
The original file name of the project when first saved to the database. For example: <C:\WIN95\Personal\Db xls\Test1.mpd>\project1.


OriginalSave
Date/Time
The date the project was originally saved.


ProjectCalendarName
Memo
The name of the project calendar. This corresponds to the Project Information dialog setting: Calendar.


ResourcePool
Boolean
Whether or not the project is a resource pool project.


PoolFileName
Memo
The path and name of the pool used by the project. Blank if the project uses its own resources.


ScheduleFrom
Integer
Whether the project is scheduled from the Project Start Date or the Project Finish Date. This corresponds to the Project Information dialog setting: Schedule from.


StartDate
Date/Time
The start date of the project. This corresponds to the Project Information dialog setting: Start date.


StatusDate
Date/Time
The status date for the project. This corresponds to the Project Information dialog setting: Status date.


Subject
Memo
The Subject of the project. This corresponds to the File Properties Summary tab setting: Subject.


Title
Memo
The Title of the project. This corresponds to the File Properties Summary tab setting: Title.


Version
Long
The version of the project.


CurrencySymbol
Text(20)
The currency symbol used in the project. This corresponds to the Tools Options View tab setting: Currency, Symbol.


DurationEnteredIn
Integer
The default duration unit (minutes, hours, days, weeks). This corresponds to the Tools Options Schedule tab setting: Duration is entered in.


WorkEnteredIn
Integer
The default work unit (minutes, hours, days, weeks). This corresponds to the Tools Options Schedule tab setting: Work is entered in.


DefaultMinutesPerDay
Long
The default number of minutes per day. This is the equivalent number of minutes corresponding to the Tools Options Calendar tab setting: Hours per day.


DefaultMinutesPerWeek
Long
The default number of minutes per week. This is the equivalent number of minutes corresponding to the Tools Options Calendar tab setting: Hours per week.


CurrencyPosition
Integer
The position of the currency symbol. This corresponds to the Tools Options View tab setting: Currency, Placement.


CurrencyDigits
Integer
The number of digits after the decimal, in currencies. This corresponds to the Tools Options View tab setting: Currency, Decimal digits


DefaultStartTime
Date/Time
The default start time of new tasks. This corresponds to the Tools Options Calendar tab setting: Default start time.


DefaultFinishTime
Date/Time
The default finish time of new tasks. This corresponds to the Tools Options Calendar tab setting: Default end time.


DefaultStandardRate
Double
The default standard rate for new resources. This corresponds to the Tools Options General tab setting: Default standard rate.


DefaultOvertimeRate
Double
The default overtime rate for new resources. This corresponds to the Tools Options General tab setting: Default overtime rate.


DefaultTaskType
Integer
The default type of the task. This corresponds to the Tools Options Schedule tab setting: Default task type.


DefaultEffortDriven
Boolean
Whether new tasks are effort driven by default. This corresponds to the Tools Options Schedule tab setting: New tasks are effort driven.


UpdateTaskUpdateResource
Boolean
Whether updates to tasks update resources. This corresponds to the Tools Options Calculation tab setting: Updating task status updates resource status.


SplitInProgressTasks
Boolean
Whether in-progress tasks can be split. This corresponds to the Tools Options Schedule tab setting: Split in-progress tasks.


HonorConstraints
Boolean
Whether tasks honor their constraint dates. This corresponds to the Tools Options Schedule tab setting: Tasks will always honor their constraints.


DefaultFixedCostAccrual
Integer
The default accrual of task fixed costs. This corresponds to the Tools Options Calculation tab setting: Default fixed costs accrual.


SpreadPercentToStatus
Boolean
Whether %Complete is spread to the status date. This corresponds to the Tools Options Calculation tab setting: Edits to total task % complete will be spread to the status date.


SpreadActualCostsToStatus
Boolean
Whether actual costs are spread to the status date. This corresponds to the Tools Options Calculation tab setting: Edits to total Actual Cost will be spread to the status date. (The 'Actual Costs are always calculated by Microsoft Project' setting must be unchecked).


AutoCalcActualCosts
Boolean
Whether actual costs are calculated by Microsoft Project, or are entered by the user. This corresponds to the Tools Options Calculation tab setting: Actual Costs are always calculated by Microsoft


MultipleCriticalPaths
Boolean
Whether multiple critical paths are calculated. This corresponds to the Tools Options Calculation tab setting: Calculate multiple critical paths.


CriticalSlack
Long
Number of slack days is less than or equal for tasks to be critical. This corresponds to the Tools Options Calculation tab setting: Tasks are critical if slack is less than or equal to <n> days.


Custom_Number_Field_Set
Boolean
Used internally by Microsoft Project.


Custom_Date_Field_Set
Boolean
Used internally by Microsoft Project.


Custom_Duration_Field_Set
Boolean
Used internally by Microsoft Project.


Text_Field_Set
Boolean
Used internally by Microsoft Project.


Reserved_LanguageID
Long
The language ID for the language in which the project is saved. For example, the US English version has ID 1252.


Reserved_NLSCodePage
Long
The NLS code page for the project. For example, the Japanese version has code page 932. During a cross-language read, this ensures that the correct NLS Page is installed so that the characters are displayed properly. For example, if the project is saved to the database in Chinese, and then the project is read from the database into an English version of Microsoft Project, then the Chinese NLS page must be installed in order to read the data correctly.


Reserved_Project_FormatID
Text(40)
The FormatID of the version of Microsoft Project (for example, “MSProject.mdb.8”) - used for forward compatibility so future versions of Microsoft Project can be read.


Reserved_DataSourceName
Text(128)
The DSN (Data Source Name) for the project. Used when Microsoft Project checks for concurrent usage (so only one user at a time can have write access to a project).


Reserved_Project_ReadOnly
Text(10)
Whether or not the project is read-only.


Project_ReadWrite
Text(4)
Whether or not the project is open for write.


Reserved_ReadCount
Text(10)
How many users have one or more project tables open read-only.


Project_Locked
Text(4)
Whether or not a user is writing to a table.


Reserved_LastUpdateTimestamp
Text(50)
Time of the last update made to the project.


UserMachineID
Text(100)
Machine ID of the user who is opening the project. Used in concurrent usage scenarios so only one user at a time can have write access to a project.


Reserved_BinaryProperties
Long Binary (OLE Object)
Internal project properties. Also includes the locations of the pool and/or sharer projects for Resource Pooling.

Additional Notes about the Project_Information table

Reserved_BinaryProperties is an array of binary byte values. The bytes can represent a variety of types of information. Some of the bytes represent ASCII text codes. In some cases, several consecutive bytes represent a multiple byte binary value (lowest byte + 256 times the next byte + 256 squared * times the next byte +....). For a resource pool file, the path and filenames of the sharing files are embedded in the Reserved_BinaryProperties field. See the following information.
Sharer File Locations. If a project is a pool, the list of sharer files that you normally access in Microsoft Project via the Tools Resources Share Resources command is embedded in the Reserved_BinaryProperties field (along with some other information). The sharer path and filenames are listed consecutively and separated by semicolons. The Reserved_BinaryProperties field can be treated programmatically as an array of byte values. The embedded string can be located in this array as follows:

· The first four bytes of the array contain the size of the text string that contains the sharer-information, plus and extra two zero bytes. So if the string of sharers is "C:\Dir1\Sh1.mpp;C:\Dir1\Sh2.mpp", then the first four bytes of the array represent the number 31 + 2 = 33.

· The next four bytes in the array represent the position in the array of the start of the string (the first byte in the array has an index of 0). 

Example

This example demonstrates how to extract the paths and filenames of the sharer files from the Reserved_BinaryProperties field of the Project_Information table for a resource pool saved in MPD format.

Originally, Sh1.mpp and Sh2.mpp both share resources from the pool file, Pool.mpp. Both sharer files are stored in the directory C:\Dir1. The pool file is then saved in the MPD format, and the MPD file is opened in Microsoft Access. If you open the Project_Information table, all that you see in the Reserved_BinaryProperties field is the placeholder text "Long binary data."
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You can write a Microsoft Access macro to parse the array of bytes stored in the Reserved_BinaryProperties field, as follows:

Click the Module tab.

Click the New button.

Enter the following macro:

Sub GetSharers()

  Set tb = CurrentDb.OpenRecordset("Project_Information")

  v = tb!Reserved_BinaryProperties

  nChars = v(0) + 256 * v(1) + 256# ^ 2 * v(2) + 256# ^ 3 * v(3)

  nOffset = v(4) + 256# * v(5) + 256# ^ 2 * v(6) + 256# ^ 3 * v(7)

  sharers = ""

  For i = nOffset To nOffset + nChars

    sharers = sharers & Chr(v(i))

  Next

  MsgBox "Number of chars: " & nChars & Chr(10) & _

         "Offset: " & nOffset & Chr(10) & _

         "Sharer paths and filenames: " & sharers

End Sub
Click anywhere in the macro and press the F5 key to run the macro. The following picture shows the output from the macro:
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The # character after the 256 in the macro means that 256 is treated as a data type of Double. The caret symbol ^ in the macro means "raise to the power." For example, 256#^3 means 256 raised to the 3rd power.

If you want to get the sharer names separately rather than all together, then the macro must look for the semicolon character at the end of every sharer path\filename. The following macro checks for the semicolon character and displays each sharer in a separate message box:

Sub GetSharers2()

  Set tb = CurrentDb.OpenRecordset("Project_Information")

  v = tb!Reserved_BinaryProperties

  nChars = v(0) + 256 * v(1) + 256# ^ 2 * v(2) + 256# ^ 3 * v(3)

  nOffset = v(4) + 256# * v(5) + 256# ^ 2 * v(6) + 256# ^ 3 * v(7)

  sharer = ""

  For i = nOffset To nOffset + nChars

    If Chr(v(i)) = ";" Then

      MsgBox sharer

      sharer = ""

    Else

      sharer = sharer & Chr(v(i))

    End If

  Next

End Sub

The pictures below show the sequence of message boxes that the macro displays for the files described above:
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Reserved_CommandBars table

This table contains the project commandbar formatting information, used to recreate the formatting of the commandbars, as they were before the save. This table is marked read-only if the database supports it.

Note: No data is written to the Reserved_BinaryProperties. It is saved out for internal performance reasons.

Reserved_CommandBars table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code. It exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
Reserved_ToolbarID
Long
The unique ID for this toolbar/menu in the project.


Reserved_BinaryProperties
Long Binary (OLE Object)
The data defining the Toolbar

Reserved_ExternalDataLinks table

This table contains the project DDE and OLE links information, used to recreate any links in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_ExternalDataLinks table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project


Reserved_Source
Text(255)
* The source location of the link


Reserved_Destination
Text(255)
* The destination location of the link

X
Reserved_UniqueID
Long
The unique ID for this link in the project


Reserved_Name
Text(51)
The name of the link


Reserved_Type
Integer
The type of link


Reserved_IsShownInMenu
Boolean
Not used - but for ease of saving, needs to be persisted


Reserved_Flags
Long
Various properties of the link


Reserved_Platform
Integer
What platform on which the object was created


Reserved_Aspect
Long
The aspect (picture) last requested for display


Reserved_ViewUniqueID
Long
The unique ID for the view in effect at the time the link was created


Reserved_TableUniqueID
Long
The unique ID for the table in effect at the time the link was created


Reserved_FilterUniqueID
Long
The unique ID for the filter in effect at the time the link was created


Reserved_SizelX
Long
The x-extent of the picture


Reserved_SizelY
Long
The y-extent of the picture


Reserved_ContainerUniqueID
Long
The “container” (for example task, resource, assignment) which is the source of the link


Reserved_BinaryProperties
Long Binary (OLE Object)
The data defining the link

*
Reserved_Source and Reserved_Destination are displayed separately from Reserved_BinaryProperties so that it is easy to identify the key particulars (source, destination and update) for the link. They are not read back into Microsoft Project.

Reserved_ImportExportMaps table

This table contains the Import/Export map information, used to recreate any maps in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_ImportExportMaps table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
Reserved_UniqueID
Long
The unique ID for the map in the project


Reserved_Name
Text(51)
The name of the map


Reserved_Type
Integer
The type of map (task or resource)


Reserved_IsShownInMenu
Boolean
Whether or not the filter is shown in a menu


Reserved_BinaryProperties
Long Binary (OLE Object)
The data defining the map

Reserved_Filters table

This table contains the project filter information used to recreate any filters in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_Filters table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
Reserved_UniqueID
Long
The unique ID for the filter in the project


Reserved_Name
Text(51)
The name of the filter


Reserved_Type
Integer
The type of filter (task or resource)


Reserved_IsShownInMenu
Boolean
Whether or not the filter is shown in a menu


Reserved_BinaryProperties
Long Binary (OLE Object)
The data defining the filter

Reserved_Modules table

This table is a place holder table. Nothing is stored in it. The actual module information is stored in the Project_Information table in the Reserved_BinaryInformation field, but for internal and compatibility reasons this table is created anyway. This table is marked read-only if the database supports it.

Reserved_Modules table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
This table is a place holder; nothing is written to it.

X
ProjectID
Long
This table is a place holder; nothing is written to it.

Reserved_Reports table

This table contains the project report information, used to recreate any reports in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_Reports table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
Reserved_UniqueID
Long
The unique ID for the report in the project


Reserved_Name
Text(51)
The name of the report


Reserved_Type
Integer
The type of report


Reserved_IsShownInMenu
Boolean
Whether or not the report is shown in a menu


Reserved_FontMap
Binary
Properties defining the fonts in the report.


Reserved_BinaryProperties
Long Binary (OLE Object)
The data defining the report

Reserved_Tables table

This table contains the project table information, used to recreate any tables in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_Tables table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
Reserved_UniqueID
Long
The unique ID for the table in the project


Reserved_Name
Text(51)
The name of the table


Reserved_Type
Integer
The type of table


Reserved_IsShownInMenu
Boolean
Whether or not the table is shown in a menu


Reserved_BinaryProperties
Long Binary (OLE Object)
The data defining the table

Reserved_CustomForms table

This table contains the user defined form/dialog information, used to recreate any user-defined forms/dialogs in the project, as they were before the save. This table is marked read-only if the database supports it.

Reserved_CustomForms table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
Reserved_UniqueID
Long
The unique ID for the custom form in the project


Reserved_Name
Text(51)
The name of the custom form


Reserved_Type
Integer
The type of custom form


Reserved_IsShownInMenu
Boolean
Whether or not the custom form is shown on a menu


Reserved_AcceleratorChar
Integer
The accelerator character for the custom form


Reserved_BinaryProperties
Long Binary (OLE Object)
The data defining the custom form

Reserved_V_iews table

This table contains the project view information, used to recreate any views in the project, as they were before the save. This table is marked read-only if the database supports it. Note: The table is not named "Reserved_Views" because some database products (such as Access 2.0) do not allow the word "view" as part of a table name.

Reserved_V_iews table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
Reserved_UniqueID
Long
The unique ID for the view in the project


Reserved_Name
Text(51)
The name of the view


Reserved_Type
Integer
The type of view, e.g. task, resource


Reserved_IsShownInMenu
Boolean
Whether or not the view is shown on a menu


Reserved_MasterSlave
Integer
Whether the view is a dual pane or single pane view


Reserved_Contents
Integer
The type of view, e.g. Gantt, PERT, etc.


Reserved_FontMap
Binary
Properties defining the fonts for the view


Reserved_BinaryProperties
Long Binary (OLE Object)
The data defining the view

Calendars table

This table contains the basic Calendar data.

Calendars table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The Unique ID for the project

X
CalendarUniqueID
Long
The Unique ID for the calendar in the project


BaseCalendarUniqueID
Long
The Unique ID of the base calendar if the record is for a resource calendar


ResourceUniqueID
Long
The Unique ID of the resource who owns this calendar


IsBaseCalendar
Boolean
Whether or not this is a base calendar


Reserved_CalendarAllocated
Boolean
Whether the calendar is being used


Reserved_IsNull
Boolean
Whether or not the calendar is null.


CalendarName
Text(255)
The calendar name


Reserved_PoolCalendarUniqueID
Long
The Unique ID of the calendar in the Resource Pool (since it can be a different number than in the sharer)


Reserved_BinaryProperties
Long Binary (OLE Object)
Properties associated with the calendar

Calendar_Working_Times table

This table contains the Calendar working times.

Calendar_Working_Times table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists to increase performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
UniqueID
Long
The unique ID for this working time 


CalendarUniqueID
Long
The unique ID for the calendar in the project


DayofWeek
Integer
The day of the week. This is an integer from 1, 2, ...,7 representing Sun, Mon, ..., Sat, as defined in the Intl_TextConversions table


Working
Integer
0 is non-working, 1 is working, and 2 is default. For base calendars, default refers to the default working week and times (for example, M-F 8a.m.-12p.m., 1 p.m.-5 p.m. for the English version.). For resource calendars, default refers to the base calendar for the resource.


FromTime1
Date/Time
Start time of the first shift


ToTime1
Date/Time
Finish time of the first shift


FromTime2
Date/Time
Start time of the second shift


ToTime2
Date/Time
Finish time of the second shift


FromTime3
Date/Time
Start time of the third shift


ToTime3
Date/Time
Finish time of the third shift

Calendar_Exceptions table

This table contains the Calendar exceptions.

Calendar_Exceptions table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project-ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
UniqueID
Long
The unique ID for this exception 


CalendarUniqueID
Long
The unique ID for the calendar in the project


FromDate
Date/Time
Date the exception starts


ToDate
Date/Time
Date the exception ends


Working
Integer
Whether the date range is working or non-working. 0 is a non-working day, and 1 is a working day


FromTime1
Date/Time
Start time of the first shift


ToTime1
Date/Time
Finish time of the first shift


FromTime2
Date/Time
Start time of the second shift


ToTime2
Date/Time
Finish time of the second shift


FromTime3
Date/Time
Start time of the third shift


ToTime3
Date/Time
Finish time of the third shift

Task_Dependencies table

This table contains the Task Dependency (links) data.

Task_Dependencies table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project


Reserved_ExternalChangeData
Binary
Cache of current calculated values so that Microsoft Project can determine what has changed when reading data back in from the database

X
DependencyUniqueID
Long
The unique ID of the dependency in the project


Reserved_IsNull
Boolean
Whether or not the dependency is null


*CrossProjectLink
Boolean
Whether this is a cross-project link. The source project is stored as an external task in the Tasks table


PredecessorTaskUniqueID
Long
The unique ID of the predecessor task


SuccessorTaskUniqueID
Long
The unique ID of the successor task


LinkType
Integer
The link type: FS, FF, SS, SF


LinkLagDisplayUnits
Integer
The units in which the lag is displayed in Microsoft Project


LinkLag
Long
The amount of lag 

*
If the CrossProjectLink field contains 1 (TRUE) indicating a cross project link, the source path for the link is not stored in this table. Instead, that information is stored as part of a "ghosted task" in the Task_Information" table. When a cross project link is created, the cross project task is "ghosted" in the current project, and given its own Unique ID in the current project, which is independent of its Unique ID in the source project. For an external predecessor, the "Unique ID Predecessors" field in Microsoft Project shows the source path of the external project and the Unique ID of the predecessor in the source project. Also, for each project record in the Project_Information table, the Reserved_BinaryProperties field includes identifiers for all the external projects that are linked to the project.

Reserved_AssignmentPoolInfo table

This table contains the cached pool and sharer assignment data from the pool or other sharers in a resource sharing scenario.

Reserved_AssignmentPoolInfo table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project


ActualFinish
Date/Time
The actual finish date of the assignment


ActualStart
Date/Time
The actual start date


ACWP
Double
Actual cost of work performed


BCWP
Double
Budgeted cost of work performed


BCWS
Double
Budgeted cost of work scheduled


OverAllocated
Boolean
Whether or not the assignment is over allocated


WorkContour
Integer
The type of work contour


Hyperlink
Memo
The Link Representation for the hyperlink


HyperlinkAddress
Memo
The URL or UNC for the target document of the hyperlink


HyperlinkSubAddress
Memo
The location within the target document of the hyperlink


Reserved_ExternalChangeData
Binary
Cache of current calculated values so that Microsoft Project can determine what has changed when reading data back in from the database


StartVariance
Long
The start variance


FinishVariance
Long
The finish variance


Notes
Memo
Up to the first 255 characters of the assignment Notes, or the first line if there is a hard return. Ellipses (...) are used at the end to indicate that not all the Notes are displayed. The 255 limit includes the three periods.


UpdateNeeded
Boolean
Whether or not a workgroup TeamUpdate message is needed. For example, if the assignment start date or duration changes. This only applies to confirmed assignments

X
AssignmentUniqueID
Long
The unique ID of the assignment in the project


Reserved_IsNull
Boolean
Whether or not this is a null assignment


Reserved_IsLinkSource
Boolean
Whether or not the assignment is the source for an external data link


LinkedFields
Boolean
Whether or not there are data links to the assignment


Reserved_ContourUserEdited
Boolean
Whether or not the work contour is user edited


Reserved_HasActualStart
Boolean
Whether or not “Start” is the actual start date


Reserved_HasActualFinish
Boolean
Whether or not “Finish” is the actual finish date


Confirmed
Boolean
Whether or not the assignment is confirmed (for example, whether or not the resource has responded affirmatively to a TeamAssign workgroup message)


ResponsePending
Boolean
Whether or not any type of workgroup message response is pending from the assigned resource


Reserved_EmailNone
Boolean
Whether or not the assigned resource responds to email (workgroup)


Reserved_HasPageBreak
Boolean
Whether or not there is a page break after this row when printing in Project


Reserved_IsVisibleAsTask
Boolean
Whether or not the assignment is displayed or not (collapsed) in the Task Usage view


Reserved_IsVisibleAsResource
Boolean
Whether or not the assignment is displayed or not (collapsed) in the Resource Usage view


Flag10
Boolean
Custom flag field


Flag1
Boolean
Custom flag field


Flag2
Boolean
Custom flag field


Flag3
Boolean
Custom flag field


Flag4
Boolean
Custom flag field


Flag5
Boolean
Custom flag field


Flag6
Boolean
Custom flag field


Flag7
Boolean
Custom flag field


Flag8
Boolean
Custom flag field


Flag9
Boolean
Custom flag field


Reserved_HasNotes
Boolean
Whether or not the assignment has notes


Reserved_LevelChanges
Boolean
Whether or not the assignment has had any type of leveling-related changes


TeamStatusPending
Boolean
Whether responses are pending from a TeamStatus message


Reserved_HasHyperlink
Boolean
Whether or not the resource has a hyperlink


Reserved_ContourLevelEdited
Boolean
Whether the contour has been changed due to leveling


Flag11
Boolean
Custom flag field


Flag12
Boolean
Custom flag field


Flag13
Boolean
Custom flag field


Flag14
Boolean
Custom flag field


Flag15
Boolean
Custom flag field


Flag16
Boolean
Custom flag field


Flag17
Boolean
Custom flag field


Flag18
Boolean
Custom flag field


Flag19
Boolean
Custom flag field


Flag20
Boolean
Custom flag field


TaskUniqueID
Long
The unique ID of the task in the assignment. This value must be a valid TaskUniqueID in the Task_Information table


ResourceUniqueID
Long
The unique ID of the resource in the assignment. This value must be a valid ResourceUniqueID in the Resource_Information table


StartDate
Date/Time
The start date of the assignment


FinishDate
Date/Time
The end date of the assignment


Reserved_ResumeDate
Date/Time
The Resume Date for the assignment


Delay
Long
The delay for the assignment


DelayDisplayUnits
Integer
The units in which the delay is displayed in Microsoft Project


LevelingDelay
Long
The amount of time the assignment is delayed due to leveling


Reserved_LastUpdatedMsgStart
Date/Time
The “start date” for the date range from the last update message (workgroup)


Reserved_LastUpdatedMsgFinish
Date/Time
The “finish date” for the date range from the last update message (workgroup)


Reserved_MsgUniqueID
Long
The unique ID for a workgroup message to associate it with an assignment


Reserved_WkgpMsgCounter
Long
A counter to determine if more than one message has been sent for this workgroup “request”


CostRateTable
Integer
The cost rate table used for this assignment


BaselineStart
Date/Time
The baseline start date


BaselineFinish
Date/Time
The baseline finish date


Reserved_StopDate
Date/Time
The Stop Date for the assignment


Reserved_InternalChangedBits
Binary
Values that were changed in the project in Microsoft Project 98. Used for correct calculation of dependent values


Units
Double
The number of units assigned


ScheduledWork
Double
The amount of work


OvertimeWork
Double
The amount of overtime work 


ActualWork
Double
The actual amount of work


ActualOvertimeWork
Double
The actual amount of overtime work


RegularWork
Double
The amount of regular work (actual + remaining - overtime)


RemainingWork
Double
The remaining work 


RemainingOvertimeWork
Double
The remaining overtime work 


BaselineWork
Double
The baseline work 


Cost
Double
The cost of the assignment


ActualCost
Double
The actual cost of the assignment


RemainingCost
Double
The remaining cost


ActualOvertimeCost
Double
The actual overtime cost 


RemainingOvertimeCost
Double
The remaining overtime cost 


BaselineCost
Double
The baseline cost 


Reserved_LinkedProps
Binary
Data for any linked fields


SharedResourceAssignTask
Text(255)
The name of the sharer project task that the pool resource is assigned to (For Pool projects only)


SharedResAssignSummaryTask
Text(255)
The name of the summary task for the sharer project task that the pool resource is assigned to. (For Pool projects only)


Reserved_OutlookTaskID
Memo
The unique ID the workgroup task created in Outlook


Reserved_BinaryProperties
Long Binary (OLE Object)
Properties associated with the assignment, including the RTFNotes

X
Reserved_ResourcePoolID
Long
The (internal) uniqueID that Microsoft Project uses to map the current project to the sharer/pool project who owns this assignment

Task_Information table

This table contains the Task data. The custom task Date<n>, Cost<n>, Duration<n>, Finish<n>, Number<n>, Start<n>, and Text <n> fields, and the task Contact, WBS, and Subproject File fields, are not stored in the Task_Information table. Instead, data from these fields is stored in the Custom_Date, Custom_Duration, Custom_Number, and Text_Fields tables. See the section above on Custom Fields.

Task_Information table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project


ACWP
Double
Actual cost of work performed


BCWP
Double
Budgeted cost of work performed


BCWS
Double
Budgeted cost of work scheduled


DurationVariance
Long
The duration variance


FinishVariance
Long
The finish variance


OutlineNumber
Text(255)
The outline number


StartVariance
Long
The start variance


Overallocated
Boolean
Whether or not the task is over allocated


Hyperlink
Memo
The Link Representation for the hyperlink


HyperlinkAddress
Memo
The URL or UNC for the target document of the hyperlink


HyperlinkSubAddress
Memo
The location within the target document of the hyperlink


Reserved_ExternalChangeData
Binary
Cache of current calculated values so that Microsoft Project can determine what has changed when reading data back in from the database


OvertimeWork
Double
The amount of overtime work


RegularWork
Double
The regular work (actual + remaining - overtime)


Objects
Long
The number of objects attached to the task, not including those in notes


Notes
Memo
Up to the first 255 characters of the task Notes, or the first line if there is a hard return. Ellipses (...) are used at the end to indicate that not all the Notes are displayed. The 255 limit includes the three periods

X
TaskUniqueID
Long
The unique ID for the task in the project


TaskID
Long
The task ID


Reserved_IsNull
Boolean
Whether or not this is a null task


Reserved_IsLinkSource
Boolean
Whether or not the task is the source for an external data link


LinkedFields
Boolean
Whether or not there are data links to the task


Milestone
Boolean
Whether or not the task is a milestone


Critical
Boolean
Whether or not the task is critical


Reserved_Fixed
Boolean
Proj95 Fixed field. Need to keep it for internal compatibility.


ProjectSummary
Boolean
Whether or not the task is a project summary


Summary
Boolean
Whether or not the task is a summary


Subproject
Boolean
Whether or not the task is a subproject


Reserved_InternalMarked
Boolean
Used internally by Microsoft Project 98


Marked
Boolean
Whether or not the task is marked


Reserved_NoSplitsCache
Boolean
Used internally by Microsoft Project 98


Reserved_HasPageBreak
Boolean
Whether or not there is a page break after this row when printing in Microsoft Project 98


Rollup
Boolean
Whether or not the task is rolled up


Reserved_LevelResume
Boolean
Whether the resume date is set by leveling


HideBar
Boolean
Whether or not the Gantt bars are hidden when displayed in Microsoft Project 98


Reserved_SummaryDuration
Boolean
Whether or not there is information on the task before it became a summary task


Recurring
Boolean
Whether or not the task is a recurring task


RecurringTaskSummary
Boolean
Whether or not the task is a summary for recurring tasks


ExternalTask
Boolean
Whether or not this is an external task to which another task in this project is cross-project linked


EffortDriven
Boolean
Whether or not the task is effort driven


Reserved_IsBeforeProjectStart
Boolean
Whether or not, on a Schedule-from-Start project, the task is starting before the project start date


Reserved_IsAfterProjectFinish
Boolean
Whether or not, on a Schedule-from-Finish project, the task is ending after the project finish date


Reserved_ComputeActualDuration
Boolean
Whether or not to calculate the Actual Duration (or if the user entered actual should be respected)


Reserved_IsVisible
Boolean
Whether or not the task (as a child) is displayed 


Reserved_IsCollapsed
Boolean
Whether or not the task (as a summary) is collapsed (for example, whether or not its children are displayed)


Reserved_IsAssnHidden
Boolean
Whether or not assignments are displayed (for example, are they collapsed) for this task in the Task Usage view


Reserved_ComputeResume
Boolean
Whether or not to calculate the Resume Date (or if the user entered date should be respected)


Reserved_HasNotes
Boolean
Whether or not the task has notes


Reserved_HasHyperlink
Boolean
Whether or not the task has a hyperlink


SubprojectReadOnly
Boolean
Whether or not the subproject is read-only


Reserved_RollupAssnWork
Boolean
Whether or not to rollup the assignment’s work to the task


Reserved_LevelChanges
Boolean
Whether or not the task has had any type of leveling-related changes


LevelingCanSplit
Boolean
Whether or not leveling can cause a task split


LevelAssignments
Boolean
Whether or not leveling can level individual assignments


Reserved_TaskSplit
Boolean
Whether or not the task has been split


Reserved_AssignedBefore
Boolean
Whether or not the resource was assigned before certain operations


EarlyFinish
Date/Time
The early finish date


LateStart
Date/Time
The late start date


StopDate
Date/Time
The stop date 


ResumeDate
Date/Time
The resume date


FreeSlack
Long
The amount of free slack


TotalSlack
Long
The total slack


Reserved_ParentUniqueID
Long
The unique ID of the parent task


OutlineLevel
Integer
The outline level


Reserved_PertX
Integer
The x-coordinate for drawing the PERT node


Reserved_PertY
Integer
The y-coordinate for drawing the PERT node


Reserved_NextPertBoxUID
Long
The unique ID of the next PERT node


Reserved_PrevPertBoxUID
Long
The unique ID of the previous PERT node


Reserved_PERTRightMostPredUID
Long
The UID of the right most predecessor of a task - used for displaying tasks in the PERT chart


Reserved_PertZorder
Integer
The z-order for drawing the PERT node


Duration
Long
The duration of the task


DurationDisplayUnits
Integer
The units in which the duration is displayed in Microsoft Project


ActualDuration
Long
The actual duration


RemainingDuration
Long
The remaining duration


BaselineDuration
Long
The baseline duration


BaselineDurationDisplayUnits
Integer
The units in which the baseline duration is displayed in Microsoft Project


ConstraintType
Integer
The constraint type


LevelingDelay
Long
The delay caused by leveling


LevelingDelayDisplayUnits
Integer
The units in which the leveling delay is displayed in Microsoft Project


StartDate
Date/Time
The task start date


FinishDate
Date/Time
The task finish date


ActualStart
Date/Time
The actual start date


ActualFinish
Date/Time
The actual finish date


BaselineStart
Date/Time
The baseline start date


BaselineFinish
Date/Time
The baseline finish date


ConstraintDate
Date/Time
The constraint date


Reserved_ResumeNoEarlierThan
Date/Time
Proj95 Resume No Earlier Than field. Need to keep it for internal compatibility


Priority
Integer
The priority


PercentComplete
Integer
The percent complete


PercentWorkComplete
Integer
The percent work complete


TaskType
Integer
The type of task


FixedCostAccrual
Integer
The way fixed costs are accrued


Created
Date/Time
The date the task was created


Reserved_RecurringTaskUniqueID
Integer
The unique ID for the recurring task


PreleveledStart
Date/Time
The start date of the task before leveling was done


PreleveledFinish
Date/Time
The finish date of the task before leveling was done


Reserved_InternalChangedBits
Binary
Values that were changed in the project in Microsoft Project 98. Used for correctly calculation dependent values


EarlyStart
Date/Time
The early start date


LateFinish
Date/Time
The late finish date


Reserved_BeforeDelay
Date/Time
Used by Microsoft Project on load and during recalculations


ScheduledWork
Double
The amount of work


BaselineWork
Double
The amount of baseline work


ActualWork
Double
The actual amount of work


RemainingWork
Double
The amount of remaining work


ActualOvertimeWork
Double
The actual amount of overtime work


RemainingOvertimeWork
Double
The amount of remaining overtime work


OvertimeCost
Double
The overtime cost


ActualOvertimeCost
Double
The actual overtime cost


RemainingOvertimeCost
Double
The remaining overtime cost


Cost
Double
The cost


FixedCost
Double
The fixed cost


ActualCost
Double
The actual cost


RemainingCost
Double
The remaining cost


BaselineCost
Double
The baseline cost


ActualFixedCost
Double
The actual fixed cost


RemainingFixedCost
Double
The remaining fixed cost


Reserved_SubprojectGUID
Binary
Identifier to the subproject


Reserved_SubProjectStart
Date/Time
Subproject start date


Reserved_SubProjectFinish
Date/Time
Subproject finish date


Name
Text(255)
The name of the task


Reserved_OriginalSummaryInfo
Binary
Internal information on the summary task (before it became a summary task)


Reserved_RecurringTaskInfo
Binary
Internal information on the recurring task series


Reserved_LinkedProps
Binary
Data for any linked fields


Reserved_ExternalTaskUniqueID
Long
The unique ID for the externally linked task. The unique is the task’s uniqueID in the project in which it resides


Reserved_NumberExtProjLinks
Long
Number of cross-project links to and from this task


Reserved_ExternalTaskIndex
Long
The row number in which the external task would appear in its native project (the external project)


Reserved_ProjectSummaryInfo
Binary
Internal information on the project summary task


Reserved_MySubprojDate
Binary
Used internally by Microsoft Project98


Flag1
Boolean
Custom flag field


Flag2
Boolean
Custom flag field


Flag3
Boolean
Custom flag field


Flag4
Boolean
Custom flag field


Flag5
Boolean
Custom flag field


Flag6
Boolean
Custom flag field


Flag7
Boolean
Custom flag field


Flag8
Boolean
Custom flag field


Flag9
Boolean
Custom flag field


Flag10
Boolean
Custom flag field


Flag11
Boolean
Custom flag field


Flag12
Boolean
Custom flag field


Flag13
Boolean
Custom flag field


Flag14
Boolean
Custom flag field


Flag15
Boolean
Custom flag field


Flag16
Boolean
Custom flag field


Flag17
Boolean
Custom flag field


Flag18
Boolean
Custom flag field


Flag19
Boolean
Custom flag field


Flag20
Boolean
Custom flag field


Reserved_BinaryProperties
Long Binary (OLE Object)
Properties for the task, including RTFNotes, Attachments, Recurring Task Info, etc.

Resource_Information table

This table contains the resource data. The custom resource Date<n>, Cost<n>, Duration<n>, Finish<n>, Number<n>, Start<n>, and Text <n> fields, and the resource Code, Email Address, and Group fields, are not stored in the Resource_Information table. Instead, data from these fields is stored in the Custom_Date, Custom_Duration, Custom_Number, and Text_Fields tables. See the section above on Custom Fields.

Resource_Information table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project


ACWP
Double
Actual cost of work performed


BCWP
Double
Budgeted cost of work performed


BCWS
Double
Budgeted cost of work scheduled


Hyperlink
Memo
The Link Representation for the hyperlink


HyperlinkAddress
Memo
The URL or UNC for the target document of the hyperlink


HyperlinkSubAddress
Memo
The location within the target document of the hyperlink


Objects
Long
The number of objects attached to the resource, not including those in notes


Notes
Memo
The first 255 characters of the Notes for the resource


Reserved_ExternalChangeData
Binary
Cache of current calculated values so that Microsoft Project can determine what has changed when reading data back in from the database

X
ResourceUniqueID
Long
The unique ID for the resource in the project


ResourceID
Long
The resource ID


Reserved_IsNull
Boolean
Whether or not this is a null resource


Reserved_IsLinkSource
Boolean
Whether or not the resource is the source for an external data link


LinkedFields
Boolean
Whether or not there are data links to the resource


Overallocated
Boolean
Whether or not the resource is over allocated


Reserved_HasPageBreak
Boolean
Whether or not there is a page break after this row when printing in Microsoft Project


Reserved_IsAssnHidden
Boolean
Whether or not assignments are displayed (for example, are they collapsed?) for this resource in the Resource Usage view


Flag10
Boolean
Custom flag field


Flag1
Boolean
Custom flag field


Flag2
Boolean
Custom flag field


Flag3
Boolean
Custom flag field


Flag4
Boolean
Custom flag field


Flag5
Boolean
Custom flag field


Flag6
Boolean
Custom flag field


Flag7
Boolean
Custom flag field


Flag8
Boolean
Custom flag field


Flag9
Boolean
Custom flag field


Reserved_HasNotes
Boolean
Whether or not the resource has notes


Reserved_HasHyperlink
Boolean
Whether or not the resource has a hyperlink


CanLevel
Boolean
Whether or not the resource can be leveled


Flag11
Boolean
Custom flag field


Flag12
Boolean
Custom flag field


Flag13
Boolean
Custom flag field


Flag14
Boolean
Custom flag field


Flag15
Boolean
Custom flag field


Flag16
Boolean
Custom flag field


Flag17
Boolean
Custom flag field


Flag18
Boolean
Custom flag field


Flag19
Boolean
Custom flag field


Flag20
Boolean
Custom flag field


StandardRateDisplayUnits
Integer
The units in which the standard rate is displayed in Microsoft Project


OvertimeRateDisplayUnits
Integer
The units in which the overtime rate is displayed in Microsoft Project


AccrueAt
Integer
The way resource costs are accrued


Workgroup
Integer
How the resource receives workgroup messages (None, Email, Web, or Email and Web)


CalendarUniqueID
Long
The unique ID for the resource calendar


AvailableFrom
Date/Time
The first date for which the resource is available


AvailableTo
Date/Time
The last date for which the resource is available


StandardRate
Double
The standard rate as of the current date


OvertimeRate
Double
The overtime rate as of the current date


MaxUnits
Double
The maximum number of units available for the resource


ScheduledWork
Double
The amount of work


ActualWork
Double
The actual amount of work


BaselineWork
Double
The baseline work


OvertimeWork
Double
The amount of overtime work


CostPerUse
Double
The cost per use as of the current date 


RemainingWork
Double
The amount of remaining work


RegularWork
Double
The amount of regular work (actual + remaining - overtime)


ActualOvertimeWork
Double
The actual amount of overtime work


RemainingOvertimeWork
Double
The amount of remaining overtime work


Peak
Double
The greatest number of resource units assigned at any time


ActualCost
Double
The actual cost 


Cost
Double
The cost 


BaselineCost
Double
The baseline cost


RemainingCost
Double
The remaining cost


OvertimeCost
Double
The overtime cost


ActualOvertimeCost
Double
The actual overtime cost 


RemainingOvertimeCost
Double
The remaining overtime cost


Name
Text(255)
The resource name


Reserved_InternalChangedBits
Binary
Values that were changed in the project in Microsoft Project 98. Used for correctly calculation dependent values.


Initials
Text(255)
The resource’s initials


Reserved_LinkedProps
Binary
Data for any linked fields


Reserved_PoolResourceUniqueID
Long
The UniqueID of the resource in the Resource Pool (since it can be a different number than in the sharer)


Phonetics
Memo
In some languages, the phonetic spelling of the resource name


Reserved_BinaryProperties
Long Binary (OLE Object)
Properties for the resource, including RTFNotes, Attachments, etc.

Assignment_Information table

This table contains the assignment data. The custom assignment Date<n>, Cost<n>, Duration<n>, Finish<n>, Number<n>, Start<n>, and Text <n> fields are not stored in the Assignment_Information table. Instead, data from these fields is stored in the Custom_Date, Custom_Duration, Custom_Number, and Text_Fields tables. See the section above on Custom Fields.

Assignment_Information table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project


ActualFinish
Date/Time
The actual finish date of the assignment


ActualStart
Date/Time
The actual start date


ACWP
Double
Actual cost of work performed


BCWP
Double
Budgeted cost of work performed


BCWS
Double
Budgeted cost of work scheduled


OverAllocated
Boolean
Whether or not the assignment is over allocated


WorkContour
Integer
The type of work contour


Hyperlink
Memo
The Link Representation for the hyperlink


HyperlinkAddress
Memo
The URL or UNC for the target document of the hyperlink


HyperlinkSubAddress
Memo
The location within the target document of the hyperlink


Reserved_ExternalChangeData
Binary
Cache of current calculated values so that Microsoft Project can determine what has changed when reading data back in from the database.


StartVariance
Long
The start variance


FinishVariance
Long
The finish variance


Notes
Memo
Up to the first 255 characters of the assignment Notes, or the first line if there is a hard return. Ellipses (...) are used at the end to indicate that not all the Notes are displayed. The 255 limit includes the three periods


UpdateNeeded
Boolean
Whether or not an workgroup update is needed

X
AssignmentUniqueID
Long
The unique ID of the assignment in the project


Reserved_IsNull
Boolean
Whether or not this is a null assignment.


Reserved_IsLinkSource
Boolean
Whether or not the assignment is the source for an external data link


LinkedFields
Boolean
Whether or not there are data links to the assignment


Reserved_ContourUserEdited
Boolean
Whether or not the work contour is user edited


Reserved_HasActualStart
Boolean
Whether or not “Start” is the actual start date


Reserved_HasActualFinish
Boolean
Whether or not “Finish” is the actual finish date


Confirmed
Boolean
Whether or not the assignment is confirmed (for example, whether or not the resource responds in the affirmative to a TeamAssign workgroup message)


ResponsePending
Boolean
Whether or not a workgroup message response is pending from the assigned resource.


Reserved_EmailNone
Boolean
Whether or not the assigned resource responds to email (workgroup)


Reserved_HasPageBreak
Boolean
Whether or not there is a page break after this row when printing in Microsoft Project


Reserved_IsVisibleAsTask
Boolean
Whether or not the assignment is displayed or not (collapsed) in the Task Usage view


Reserved_IsVisibleAsResource
Boolean
Whether or not the assignment is displayed or not (collapsed) in the Resource Usage view


Flag10
Boolean
Custom flag field


Flag1
Boolean
Custom flag field


Flag2
Boolean
Custom flag field


Flag3
Boolean
Custom flag field


Flag4
Boolean
Custom flag field


Flag5
Boolean
Custom flag field


Flag6
Boolean
Custom flag field


Flag7
Boolean
Custom flag field


Flag8
Boolean
Custom flag field


Flag9
Boolean
Custom flag field


Reserved_HasNotes
Boolean
Whether or not the assignment has notes


Reserved_LevelChanges
Boolean
Whether or not the assignment has had any type of leveling-related changes


TeamStatusPending
Boolean
Whether responses are pending to an TeamStatus message


Reserved_HasHyperlink
Boolean
Whether or not the resource has a hyperlink


Reserved_ContourLevelEdited
Boolean
Whether the contour has been changed due to leveling


Flag11
Boolean
Custom flag field


Flag12
Boolean
Custom flag field


Flag13
Boolean
Custom flag field


Flag14
Boolean
Custom flag field


Flag15
Boolean
Custom flag field


Flag16
Boolean
Custom flag field


Flag17
Boolean
Custom flag field


Flag18
Boolean
Custom flag field


Flag19
Boolean
Custom flag field


Flag20
Boolean
Custom flag field


TaskUniqueID
Long
The unique ID of the task in the assignment. This value must be a valid TaskUniqueID in the Task_Information table


ResourceUniqueID
Long
The unique ID of the resource in the assignment. This value must be a valid ResourceUniqueID in the Resource_Information table


StartDate
Date/Time
The start date of the assignment


FinishDate
Date/Time
The end date of the assignment


Reserved_ResumeDate
Date/Time
The Resume Date for the assignment


Delay
Long
The delay for the assignment


DelayDisplayUnits
Integer
The units in which the delay is displayed in Microsoft Project


LevelingDelay
Long
The amount of time the assignment is delayed due to leveling


Reserved_LastUpdatedMsgStart
Date/Time
The “start date” for the date range from the last update message (workgroup)


Reserved_LastUpdatedMsgFinish
Date/Time
The “finish date” for the date range from the last update message (workgroup)


Reserved_MsgUniqueID
Long
The unique ID for a workgroup message to associate it with an assignment


Reserved_WkgpMsgCounter
Long
A counter to determine if more than one message has been sent for this workgroup “request”


CostRateTable
Integer
The cost rate table used for this assignment


BaselineStart
Date/Time
The baseline start date


BaselineFinish
Date/Time
The baseline finish date


Reserved_StopDate
Date/Time
The Stop Date for the assignment


Reserved_InternalChangedBits
Binary
Values that were changed in the project in Microsoft Project 98. Used for correctly calculation dependent values


Units
Double
The number of units assigned


ScheduledWork
Double
The amount of work


OvertimeWork
Double
The amount of overtime work 


ActualWork
Double
The actual amount of work


ActualOvertimeWork
Double
The actual amount of overtime work


RegularWork
Double
The amount of regular work (actual + remaining - overtime)


RemainingWork
Double
The remaining work 


RemainingOvertimeWork
Double
The remaining overtime work 


BaselineWork
Double
The baseline work 


Cost
Double
The cost of the assignment


ActualCost
Double
The actual cost of the assignment


RemainingCost
Double
The remaining cost


ActualOvertimeCost
Double
The actual overtime cost 


RemainingOvertimeCost
Double
The remaining overtime cost 


BaselineCost
Double
The baseline cost 


Reserved_LinkedProps
Binary
Data for any linked fields


SharedResourceAssignTask
Text(255)
The name of the sharer project task that the pool resource is assigned to. (For Pool projects only)


SharedResAssignSummaryTask
Text(255)
The name of the summary task for the sharer project task that the pool resource is assigned to. (For Pool projects only)


Reserved_OutlookTaskID
Memo
The unique ID the workgroup task created in Outlook


Reserved_BinaryProperties
Long Binary (OLE Object)
Properties associated with the assignment, including the RTFNotes

Resource_Rates table

This table contains information on the resource rate tables.

Resource_Rates table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID for the project

X
UniqueID
Long
The uniqueID for this rate info in the project


ResourceUniqueID
Long
The unique ID for the resource in the project


RateTable
Long
The rate table with the integers 1 to 5 corresponding to the rate tables A to E


FromDate
Date/Time
The first date for which the rates are effective


ToDate
Date/Time
The last date for which the rates are effective


StandardRate
Double
The standard rate


StandardRateDisplayUnits
Integer
The units in which the standard rate is displayed in Microsoft Project


OvertimeRate
Double
The overtime rate


OvertimeRateDisplayUnits
Integer
The units in which the overtime rate is displayed in Microsoft Project


PerUseCost
Double
The per use cost

Assignment_Remaining_Work table

This table contains information on the timephased remaining work for assignments. 

Assignment_Remaining_Work table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the segment timephased data 


AssignmentUniqueID
Long
The unique ID of the assignment. This value must be a valid AssignmentUniqueID in the Assignment_Information table


FromDate
Date/Time
The start date of the segment time interval for which the remaining REGULAR work value applies


WorkValue
Double
Amount of remaining REGULAR work for the contour segment (remaining regular work = regular work - actual regular work). In Microsoft Project, you cannot display timephased remaining regular work or actual regular work. You can display timephased regular work, actual work, and actual overtime work. Note that actual regular work = actual work - actual overtime work


Units
Double
The assignment units for this remaining REGULAR work contour segment (segment remaining regular work divided by segment duration).


WorkingDuration
Long
The amount of working time that the remaining REGULAR contour segment covers


Flags
Long
Information on the work contour

Assignment_Actual_Work table

This table contains information on the timephased actual work for assignments. If you add a record, you also need to adjust the corresponding assignment total actual work. This is true in general when adjusting timephased values.

Assignment_Actual_Work table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the segment timephased data 


AssignmentUniqueID
Long
The unique ID of the assignment


FromDate
Date/Time
The start date of the segment time interval for which the actual REGULAR work value applies


WorkValue
Double
Total amount of actual REGULAR work for the contour segment (actual regular work = actual work minus actual OT work). You cannot display timephased actual regular work in Microsoft Project, but you can display timephased actual work and timephased actual OT work


Units
Double
The assignment units for this actual REGULAR work contour segment (segment actual regular work divided by segment duration)


WorkingDuration
Long
The amount of working time that the REGULAR work contour segment covers, except that segments on nonworking days use elapsed time


Flags
Long
Information on the work contour. Used internally by Microsoft Project

Assignment_Overtime_Work table

This table contains information on the timephased actual overtime work for assignments. 

Assignment_Overtime_Work table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the segment timephased actual overtime work data in the project


AssignmentUniqueID
Long
The unique ID of the assignment


FromDate
Date/Time
The start date of the segment time interval for which the actual overtime work value applies.


WorkValue
Double
Total amount of actual overtime work in this contour segment


Units
Double
The assignment units for this actual overtime work contour segment (segment actual overtime work divided by segment duration)


WorkingDuration
Long
The amount of working time that this actual overtime work contour segment covers; except that segments on nonworking days use elapsed time


Flags
Long
Information on the contour. Used internally by Microsoft Project

Assignment_Actual_Exceptions table

This table contains information on the actual work for assignments that happened in non-working time. 

Assignment_Actual_Exceptions table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the segment timephased data 


AssignmentUniqueID
Long
The unique ID of the assignment


FromDate
Date/Time
The start date of the non-working time interval for which actual work was done


ToDate
Date/Time
The end date of the non-working time interval for which actual work was done


Flags
Long
Information on the contour. Used internally by Microsoft Project

Assignment_Baseline_Work table

This table contains information on the timephased baseline work for assignments. 

Assignment_Baseline_Work table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the segment timephased baseline work data in the project


AssignmentUniqueID
Long
The unique ID of the assignment


FromDate
Date/Time
The start date of the segment time interval for which the baseline work value applies


WorkValue
Double
Amount of baseline work in this segment


Units
Double
The number of resource units assigned for this baseline work contour segment (segment baseline work divided by segment duration)


WorkingDuration
Long
The amount of working time that this baseline work contour segment covers


Flags
Long
Information on the contour. Used internally by Microsoft Project

Assignment_Baseline_Cost table

This table contains information on the timephased baseline cost for assignments. 

Assignment_Baseline_Cost table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the segment timephased data 


AssignmentUniqueID
Long
The unique ID of the assignment


FromDate
Date/Time
The start date of the segment time interval for which the cost applies.


ToDate
Date/Time
The end date of the time interval for which the cost applies.


Cost
Double
Amount of baseline cost incurred in this segment.


Flags
Long
Information on the contour. Used internally by Microsoft Project

Assignment_Actual_Cost table

This table contains information on the timephased actual cost for assignments. 

Assignment_Actual_Cost table definition…

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the actual cost timephased segment in the project


AssignmentUniqueID
Long
The unique ID of the assignment


FromDate
Date/Time
The start date of the segment time interval for which the actual cost applies


ToDate
Date/Time
The end date of the time interval for which the actual cost applies


Cost
Double
Actual cost in the contour segment. Records are added to this table only if you edit the timephased actual cost (which requires the Tools Options Calculation tab setting 'Actual costs are always calculated by Microsoft Project' to be turned OFF'


Flags
Long
Information on the contour. Used internally by Microsoft Project

Resource_Baseline_Work table

This table contains information on the timephased baseline work for resources. 

Resource_Baseline_Work table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the resource timephased baseline work segment


ResourceUniqueID
Long
The unique ID of the resource


FromDate
Date/Time
The start date of the segment time interval for which the baseline work value applies


WorkValue
Double
Amount of resource baseline work in the segment


Units
Double
The total resource units for this baseline work contour segment (baseline work in the segment divided by the duration of the segment)


WorkingDuration
Long
The amount of working time which this resource baseline work contour segment covers


Flags
Long
Information on the contour. Used internally by Microsoft Project

Resource_Baseline_Cost table

This table contains information on the timephased baseline cost for resources. 

Resource_Baseline_Cost table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the resource timephased cost segment


ResourceUniqueID
Long
The unique ID of the resource


FromDate
Date/Time
The start date of the segment time interval for which the resource cost applies


ToDate
Date/Time
The end date of the segment time interval for which the cost applies


Cost
Double
Total amount of resource baseline cost in the segment


Flags
Long
Information on the contour. Used internally by Microsoft Project

Task_Baseline_Work table

This table contains information on the timephased baseline work for tasks. 

Task_Baseline_Work table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the task timephased baseline work segment


TaskUniqueID
Long
The unique ID of the task


FromDate
Date/Time
The start date of the segment time interval for which the baseline work value applies


WorkValue
Double
Amount of task baseline work in this segment


Units
Double
The total task units for this baseline work contour segment (baseline work in the segment divided by the duration of the segment)


WorkingDuration
Long
The amount of working time which this task baseline work contour segment covers


Flags
Long
Information on the contour. Used internally by Microsoft Project

Task_Baseline_Cost table

This table contains information on the timephased baseline cost for tasks. 

Task_Baseline_Cost table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the task timephased baseline cost segment


TaskUniqueID
Long
The unique ID of the task


FromDate
Date/Time
Total amount of task baseline cost in the segment


ToDate
Date/Time
The end date of the segment time interval for which the task baseline cost applies


Cost
Double
Information on the contour. Used internally by Microsoft Project


Flags
Long
The start date of the segment time interval for which the task baseline cost applies

Task_Percent_Complete table

This table contains information on the timephased percent complete for tasks. 

Task_Percent_Complete table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the task timephased percent complete segment


TaskUniqueID
Long
The unique ID of the task


FromDate
Date/Time
The start date of the segment time interval for which the task percent complete applies


ToDate
Date/Time
The end date of the segment time interval for which the task percent complete applies


PercentCompleted
Long
Total amount of task percent complete in the segment


Flags
Long
Information on the contour. Used internally by Microsoft Project

Task_Baseline_Interim_Splits table

This table contains information on the baseline splits for tasks. 

Task_Baseline_Splits table definition...

Key
Field Name
Data Type
Description


Reserved_ElemDeleted
Text(1)
Whether or not this record was deleted. This field is used by the Project ODBC interface code and exists for performance on read and write to the database

X
ProjectID
Long
The unique ID of the project

X
UniqueID
Long
The unique ID of the timephased segment in this project


Baseline_Interim
Long
Whether or not it is a baseline split (0), or one of the 10 interim splits


TaskUniqueID
Long
The unique ID of the task


FromDate
Date/Time
The start date of the split


ToDate
Date/Time
The end date of the split


Flags
Long
Information on the contour. Used internally by Microsoft Project

Lesson 3.3 - Exercises

1.
What are some of the differences between the Microsoft Project 95 Save to Database command and the Microsoft Project 98 MPD file type?

Did Microsoft Project 95 officially support making changes to a project in a database outside of Microsoft Project? Does Microsoft Project 98 support this?

2. 
What is the purpose of the Intl_FieldReferences and Intl_TextConversions tables?

3. 
There is a table in the database called Task_Baseline_Work for storing timephased task Baseline Work. Why isn't there also a table for storing task timephased scheduled Work?

4. 
What tables in the database contain timephased data?

5. 
Does the Task_Information table contain data from all of the non-timephased task fields?

6. 
What kinds of data are stored in the database Text_Fields table?

7. 
The data below is from the Task_Information table for a complete project saved to a database.

Task_Information table...

TaskID
ConstraintType
Priority
TaskType
Name

1
4
4
2
Task 1

What values would be displayed in the following fields for this task if the project were opened from the database in Microsoft Project?

· Constraint Type:

· Priority:

· Type:

8. 
A complete project was saved to a database and the data below is from some of the database tables:

From the Task_Information table...

ProjectID
TaskUniqueID
Name

1
1
T1

1
2
T2

1
3
T3

From the Resource_Information table...

ProjectID
ResourceUniqueID
Name

1
1
Joe

1
2
Mary

1
3
Bob

From the Assignment_Information table...

ProjectID
AssignmentUniqueID
TaskUniqueID
ResourceUniqueID

1
4
1
1

1
5
1
2

1
6
2
2

1
7
2
3

1
8
3
1

1
9
3
3

From the Text_Fields table...

ProjectID
ContainerType
UniqueID
FieldID
TextValue

1
0
2
188743740
Check with Mary

1
1
1
205520899
Mkt

1
1
2
205520899
Dev

1
1
3
205520899
Sales

1
3
6
255852635
Responsible for schedule

For each of the five strings in the TextValue column, use the above information to fill in the corresponding task and/or resource name, and the corresponding field name in the table below.

TextValue


Task Name and/or Resource Name

(both if its an assignment)
Field Name

Check with Mary



Mkt



Dev



Sales



Responsible for schedule



Lesson 3.3 - Lab

This lab requires Microsoft Access.

This lab illustrates one of the ways you can combine the Intl_FieldReferences and Intl_TextConversions tables (similar to the combined table shown in this lesson).

1.
Create a project with several tasks and several resources assigned to each task. 

2.
Save the project as MyProject1 in Test1.mpd using the Project Database (*.mpd) file type. Close the project.

3.
In the Windows Explorer, locate Test1.mpd and rename it as Test1.mdb. 

4.
Double-click Test1.mdb to open it in Microsoft Access. 

5. 
Look at the definitions of the Task_Information, Resource_Information, and Assignment_Information tables (and other tables if you like). To do this, select a table, and then click the Design button. To see the indexes for a table while the table definition window is open, click Indexes on the View menu. The indexes uniquely determine records in the table.

6.
Click the Queries tab. Click the New button. Select Design View and click OK. From the Show Tables dialog, select Intl_FieldReferences and Intl_TextConversions, then click Add and then click Close. 

Use your mouse to relate the FieldType and LanguageID fields in the query design dialog, and fill in Field and Table names shown in the picture below:
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From the Query menu, click Run to display the query results. The picture below shows a few of the records displayed when you run this query:
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Close the query window and save the query if you like.

Close Microsoft Access.

Lesson 3.4: HTML File Type

Some Topics to be introduced in this lesson include:

· Selective Export to HTML.

· Exporting With and Without a Template.

· Using a Template.

· Output Without a Template.

· The Charset Tag.

· The HTML Output.

· Exporting Special Characters.

Selective Export to HTML

Microsoft Project 98 provides the ability to export project data to an HTML file. 

Microsoft Project 98 can only export data to the HTML format and not read HTML files back in. 

Example of an HTML page created from Microsoft Project 98...
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Working through the new import/export functionality, you can insert tables and project information into HTML files to produce custom web pages. A “Base on template” facility allows you to create your own custom HTML templates and then have Microsoft Project insert data into predefined locations within the file.

Saving to HTML is handled in the same way as any other selective export, through the Save As dialog. In line with Office 97, Microsoft Project 98 also has a Save As HTML command on the File menu. The File menu Save As HTML command displays the standard Save As dialog with the default file-type specified as HTML. After specifying the filename and clicking the Export button, the Export Format dialog is displayed. 
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Saving to HTML requires the use of an Import/Export map, just as with any other selective data export.

When exporting to HTML, the Selective data option is selected by default in the Import/Export Format dialog and the Entire project option is disabled.

In the Define Map dialog, there are data category checkboxes in the Options tab (not option buttons). An HTML options section is visible at the bottom of the Options tab:

[image: image118.png]w_Define Import/Export Map

Inpot/espon map name: [1op T

o |

Data to impart/esport
I Iasks
Selectthe types of data that you want 1 impot. o export

I™ Besources ‘and then use the cortesponing tabs above to specily the
mapping between Miciosolt Foject and the data storage.

I™ assignments
HTML options
7 Export headet ow

™ Includs sssigrment data in output

I~ Base export on HTML template:
™ Include image fie in HTML page:

o Cance





Default HTML Option Settings on Export

The Export header row checkbox specifies whether Microsoft Project writes out a header row as the first line of each HTML table. This option is on by default.

The Include assignment data in output checkbox indicates that the HTML tables are formatted like the new usage views, with assignments listed under each task or resource. This option is turned off by default.

The Base export on HTML template checkbox specifies whether the output goes to an empty file or if a special template file is used to control the layout of the HTML file. Checking this checkbox enables the associated template field and the Browse button. The Browse button displays the standard Browse dialog with HTML files set as the default file type. The choices in the file type list are:

· HTML Document (*.html; *.htm)
· All Files (*.*)

The Base export on HTML template option is off by default. Initially, though disabled, the template field contains the default Project HTML template name, as long as the template exists in the standard location (otherwise the template field is blank). The default template is stored in the Office template directory. The location of this directory depends on a number of factors centered on the install scenario for Microsoft Project and Office, including whether components are being upgraded or newly installed, and the order of installation. To avoid all the issues, the Setup programs for Office and/or Microsoft Project set two registry keys with the location of the shared template directory. Corresponding registry keys are shown below:

 HKEY_LOCAL_MACHINE\Software\Microsoft\Office\8.0\Common\FileNew\LocalTemplates

 HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Common\FileNew\LocalTemplates

The Name values for the keys are left blank. The Data values contain the drive and path string for the Office template directory (for example, “C:\Program Files\Office\Templates”). Within that directory, each application has one or more subdirectories for its own templates. The Microsoft Project HTML template subdirectory is called “Microsoft Project Web” (the regular project MPT templates go in a separate subdirectory called “Microsoft Project”).

For the default entry in the Base export on HTML template field, Microsoft Project looks in the registry to get the shared template directory and then adds “\Microsoft Project Web” and locates the default template in that directory. If located, the entire path and template name is inserted into the field. If not found, the field is left blank. In either case, if the Browse button is used when the field is blank, browsing begins in the Microsoft Project HTML template directory (and if that directory is missing, browsing begins in the Office template directory). If the Browse button is used and the field is not blank, browsing starts at the directory or location specified by whatever is already in the field.

The Include image file in HTML page checkbox specifies whether a GIF format image file is included in the HTML page being output. This option is primarily designed to allow you the ability to incorporate a picture of the Gantt Chart or another Microsoft Project screen shot that was taken with the Copy Picture capability, but any GIF, JPEG, or PNG file can be specified.

Checking the Include image file in HTML page checkbox enables the associated image file field and Browse button. If , there is a file that has the same base name as the active project, but a .gif extension, in the directory where the active project is stored, that file is inserted as the default name into the Include image file in HTML page filename field. This happens because that particular filename in that particular location is created if the default filename is used when copying to a GIF file with the Copy Picture functionality. If no such file exists, the filename field is left blank. The Browse button displays the standard Browse dialog with GIF set as the default file type. The choices in the file type list are:

· GIF Image Files (*.gif)
· JPEG Image Files (*.jpg, *.jpeg)

· Portable Network Graphics (*.png)

· All Files (*.*)

If a filename is entered into the Include image file in HTML page filename field before the Browse button is used, that name is inserted into the File name field in the Browse dialog and browsing starts in the directory specified. If no filename or path is entered, browsing starts in the directory where the active project is stored (or in the current working directory, if the active project is never saved).

The Include Image file in HTML page option is turned off by default.

If you checked Base export on HTML template and the template filename field is empty when you click the Define Map dialog OK button, an alert is displayed stating that a template file name is required, if you checked Include image file in HTML page and the image filename field is empty when you try to exit, then an alert is displayed stating that an image file is required.

In either case, clicking OK returns you to the empty field.

Mapping to HTML

As with the other file types, the mapping tabs reflect that mapping is being done to an HTML file:
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The table name field is renamed to Destination HTML table title and contains the same default table names as in the database case (for example, Task_Table1, Resource_Table1, etc.).You always default to ‘1’, since there is no conflict check that needs to be performed on HTML table titles. The specified title is displayed in the HTML page, just above the actual table. The table name must always be included in order to keep the map consistent for use in other contexts.

The mapping grid on each tab shows HTML Table Field above the second column and each mapping preview says HTML Table as the second row header.

Saving to HTML

If you check Base output on HTML template and the specified template file cannot be found when you click Save in the Export Format dialog, an alert is displayed stating that the template cannot be found. Clicking Continue generates the HTML code as if no template had been specified. Clicking Cancel returns you to the Export Format dialog, where the Edit button has the focus.

If you check Include image file in HTML page and the specified image file cannot be found when you click Save in the Export Format dialog, then an alert is displayed stating that the specified image file cannot be found.

Clicking OK generates the HTML code, including a reference to the image file as specified, but without the drive letter.

Exporting With and Without a Template

Once you specify a map to use for saving, Microsoft Project creates an HTML file based on the map. There are two distinct scenarios for the output, depending on whether the map specifies the use of a template or not. Without a template, you only determine the tables to be exported and their names, while Microsoft Project determines the layout of the HTML page and what additional data is included. When using a template, you can control the layout of the HTML page and determine which additional data beyond the tables are exported.

Using a Template

Templates are regular HTML files that contain special tags to indicate where to put the exported items. When saving with a template, you lay out the template file and include appropriate labels, and so on. You can also use the default template as a model in designing your own.

The primary concept of the template is that there are special Project template “tags” that can be included in the template and then Microsoft Project replaces those tags with the appropriate table or data. The supported tags are shown below:

· <!--MSProjectTemplate_Image-->

· <!--MSProjectTemplate_ProjectTitle-->

· <!--MSProjectTemplate_ProjectAuthor-->

· <!--MSProjectTemplate_CurrentDate-->

· <!--MSProjectTemplate_StartDate-->

· <!--MSProjectTemplate_FinishDate-->

· <!--MSProjectTemplate_StatusDate-->

· <!--MSProjectTemplate_TaskTable-->

· <!--MSProjectTemplate_ResourceTable-->

· <!--MSProjectTemplate_AssignmentTable-->

· <!--MSProjectTemplate_TaskTableTitle-->

· <!--MSProjectTemplate_ResourceTableTitle-->

· <!--MSProjectTemplate_AssignmentTableTitle-->

The “image tag” at the top of the list refers to a GIF or JPEG file specified in the Include image file in HTML page field in the HTML options section of the Options tab in the Define Import/Export Map dialog. The three “table title tags” at the bottom of the list refer to the respective Destination HTML table title fields in the mapping tabs of the Define Import/Export Map dialog. The three “table tags” above the three table title tags refer to the actual tables as defined in the mapping tabs. The remaining “data tags” in the middle correspond to the same-named fields in the Project Information and Properties dialogs.

When Microsoft Project actually writes out the data, the template file is copied to a new HTML file with the name specified in the Save As dialog. The file is then scanned for tags. When a tag is found, Microsoft Project inserts the appropriate table or data after the tag (for example, the tags remain in the file for reference). In the case of the image tag and the three table tags, the image or table is inserted on the line after the tag. In the case of all the other tags, the data is inserted after the tag on the same line.

So, for example, if you wanted to include the author field with a label, then include a line such as the following in the template:

<b>Project Leader:</b> <!--MSProjectTemplate_ProjectAuthor-->

The resulting generated HTML code appear as:

<b>Project Leader:</b> <!--MSProjectTemplate_ProjectAuthor-->Tom Smith

The formatting of the text is left to you and/or the browser (the above example specifies that the label “Project Leader:” is bold).

The <!--MSProjectTemplate_Image--> tag is slightly different. It produces the following:

<!--MSProjectTemplate_Image-->

<IMG SRC=“<GIF filename>” ALT=“Microsoft Project Image”>

The <GIF filename> is the relative path to the image file with respect to the HTML file. If the GIF file is in the same directory as the HTML file, the filename is included without the path. In any case, you may need to make adjustments to this part of the HTML code if you move the files (for example, to a Web server).

For a table tag, such as <!--MSProjectTemplate_TaskTable-->, the generated HTML appears as:

<!--MSProjectTemplate_TaskTable-->

<TABLE BORDER>

 [all the HTML code for the actual table]

</TABLE>

The template is the final guide, so a tag must be included in the template in order for the data to be exported. While the data tags have no corresponding controls in the mapping interface, the image tag and the table tags all have a one-to-one correspondence with a checkbox in the Options tab of the Define Import/Export Map dialog. This means that a situation can arise where you check a checkbox in the Options tab and then fail to include the corresponding tag in the template (or include it with incorrect spelling or formatting). In this case, the item associated with the checkbox cannot be exported. An alert is displayed stating that the export is incomplete because some HTML tokens could not be found (the alert lists the missing tokens).

The Default Template

The default template contains the start and finish tags (with labels), the project title tag, the image tag, the three table, and table title tags. At the bottom of the file is a footer that contains links to the Microsoft and Microsoft Project home pages.

<HTML>

<HEAD> 

<TITLE>Microsoft Project Exported Information</TITLE>

<META HTTP-EQUIV=”Content-Type” CONTENT=”text/html; charset=windows-1252”>

</HEAD>

<BODY>

<H1><!--MSProjectTemplate_ProjectTitle--></H1>

<P>

<!--MSProjectTemplate_Image-->

<P>

Project Start Date:<!--MSProjectTemplate_StartDate-->

<BR>Project Finish Date:<!--MSProjectTemplate_FinishDate-->

<P>

<H2><!--MSProjectTemplate_TaskTableTitle--></H2>

<!--MSProjectTemplate_TaskTable-->

<P>

<H2><!--MSProjectTemplate_ResourceTableTitle--></H2>

<!--MSProjectTemplate_ResourceTable-->

<P>

<H2><!--MSProjectTemplate_AssignmentTableTitle--></H2>

<!--MSProjectTemplate_AssignmentTable-->

<P>

<!--- Footer --->

</TABLE>

<HR>

<CENTER>

<TABLE WIDTH=500 BORDER=0>

<TD ALIGN=CENTER>

<A HREF="HTTP://WWW.MICROSOFT.COM/MSPROJECT">

<B>Microsoft Project Home Page</B></A></TD>

<TD ALIGN=CENTER>

<A HREF="HTTP://WWW.MICROSOFT.COM"><B>Microsoft Home Page</B></A></TD>

</TABLE>

<!--- End Footer --->

</BODY>

Output Without a Template

In the case where a template is not used, Microsoft Project determines everything about the resultant HTML page, except which category tables (for example, task, resource, and assignment) are to be included and whether an image file is inserted. In this case, it automatically includes a title, headings on the tables, and labels on the data fields. In addition, it includes the appropriate tags with each item to emphasize the template model.

The following is the default layout (displayed in terms of template tags) of a page exported without a template. The generated HTML page is identical to the default template results, but without the footer section.

<HTML>

<HEAD> 

<TITLE>Microsoft Project Exported Information</TITLE>

<META HTTP-EQUIV=”Content-Type” CONTENT=”text/html; charset=windows-1252”>

</HEAD>

<BODY>

<H1><!--MSProjectTemplate_ProjectTitle--></H1>

<P>

<!--MSProjectTemplate_Image-->

<P>

Project Start Date:<!--MSProjectTemplate_StartDate-->

<BR>Project Finish Date:<!--MSProjectTemplate_FinishDate-->

<P>

<H2><!--MSProjectTemplate_TaskTableTitle--></H2>

<!--MSProjectTemplate_TaskTable-->

<P>

<H2><!--MSProjectTemplate_ResourceTableTitle--></H2>

<!--MSProjectTemplate_ResourceTable-->

<P>

<H2><!--MSProjectTemplate_AssignmentTableTitle--></H2>

<!--MSProjectTemplate_AssignmentTable-->

</BODY>

If you do not specify that an image file is included, or if any of the category checkboxes are not checked, the corresponding items are not exported.

The Charset Tag

The <META … charset> tag included in the HTML code above is written out whenever a template is not used. This tag specifies character set information and allows a browser to know what code page is used when displaying an HTML document. The tag also is used when using a template, but it’s up to the template writer to include it (the supplied templates do have it).

When Microsoft Project creates an HTML page, the charset tag must be the first tag in the HEAD section. The format of the entire string is shown below:

<META HTTP-EQUIV=”Content-Type” CONTENT=”text/html; charset=xxx”>

The xxx is replaced by the actual HTML charset value, which is based on the system code page. The following table shows the charset values for each code page:

Windows Code Page
Description
HTML CharSet Value

1250
Windows Latin 2 (Central Europe)
windows-1250

1251
Windows Cyrillic (Slavic)
windows-1251

1252
Windows Latin 1 (ANSI)
windows-1252

1253
Windows Greek
windows-1253

1254
Windows Latin 5 (Turkish)
windows-1254

1257
Windows Latin 4 or Baltic
windows-1257

932
Japanese
x-sjis

949
Korean
korean

936
Simplified Chinese
chinese

950
Traditional Chinese
big5

1200
Unicode (UTF-8)
UTF-8

The HTML Output

To provide acceptable output, Microsoft Project 98 takes advantage of HTML style sheet capabilities for formatting the tables of Microsoft Project data. 

Sample task table as formatted by Microsoft Project...
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The table title “My Project Tasks” above is a second level (<H2>) heading that appears as it does when you export without a template (and, therefore, it includes the string from the Destination HTML table title field in the mapping tabs of the Define Import/Export Map dialog). The browser determines the format of the heading.

The cell background in the table is white, the table headers are silver, and the table itself is silver. Summary tasks are bold. The task Name fields are indented as they are in the Entry table using the formatting capabilities of HTML style sheets. Date, cost, number, and work formatting is the same as in Microsoft Project. The browser determines the font for the table entries. Any blank cells in tables are tagged as <BR> so they do not appear flat.

The data in the HTML tables is aligned as follows:

Field Type
Header
Data
Notes

ID (Task/Resource)
Centered
Centered


Name (Task/Resource)
Left
Left
Tasks have outline indenting

Yes/No
Centered
Centered


Duration
Centered
Right
Word wrapping turned off

Work
Centered
Right
Word wrapping turned off

Date
Centered
Right
Word wrapping turned off

Cost
Centered
Right


Number
Centered
Right


Text format output
(see the following list)
Left
Left
Includes all other fields that are output in a text string format

Any other
Centered
Right


The following list includes all the fields (besides those explicitly listed in the table above) that are treated as text strings and output to HTML with left alignment of the data and title:

AccrueAt
AssnContext
BaseCalendar

Code
ConstraintType
Contact

EmailAddress
FixedCostAccrual
GhostProjName

Group/ResourceGroup
Hyperlink
HyperlinkAddress

HyperlinkHREF
HyperlinkSubAddress
Initials/ResourceInitials

Notes/SheetNotes
OutlineNumber
Phonetics/ResourcePhonetics

Predecessors/Successors
Priority
Project

SubProjectName
TaskParentName
Text1-Text30

Type
UniqueIDPredecessors
UniqueIDSuccessors

WBS
WorkContour


If you check the option to Include assignment data in output, the table is laid out like the new usage views, with resources below each task in the task table and tasks below each resource in the resource table. The picture below illustrates this layout:
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Hyperlink Fields

If you save out any of the new Microsoft Project 98 hyperlink fields (for example, Hyperlink, Hyperlink Address, Hyperlink Href, and Hyperlink SubAddress), the field data is set up as a hyperlink in the exported HTML page.

Image File References

If you specify that an image file is included in the HTML page, the filespec in the SRC attribute of the <IMG> tag must be output as a relative path rather than an absolute path (absolute paths with drive letters do not work with browsers). Since you may specify the full path in the mapping interface (and the Browse button functionality inserts the absolute path if you browse to the desired file), Microsoft Project 98 must convert that path to a relative path when writing the HTML output. The “relative path” in the cases means relative to the HTML file that is being created.

The following examples demonstrate the method for creating the relative path:

Destination HTML File
Location of Image File
HTML Output

C:\DIR1\DIR2\FILE.HTM
C:\DIR1\DIR2\IMAGE.GIF
SRC=”image.gif”

C:\DIR1\DIR2\FILE.HTM
C:\DIR1\DIR2\DIR3\IMAGE.GIF
SRC=”dir3\image.gif”

C:\DIR1\DIR2\FILE.HTM
C:\DIR3\DIR4\IMAGE.GIF
SRC=”\dir3\dir4\image.gif”

C:\DIR1\DIR2\FILE.HTM
C:\DIR1\DIR3\IMAGE.GIF
SRC=”\dir1\dir3\image.gif”

C:\DIR1\DIR2\FILE.HTM
C:\DIR1\IMAGE.GIF
SRC=”\dir1\image.gif”

The scheme is to search for the path portion of the filespec for the destination HTML file within the filespec of the image file. If it’s found, then that portion of the filespec for the image file is removed in the HTML output; otherwise just the drive letter is removed.

For example, in each line of the table above, Microsoft Project first removes the file base name and extension, FILE.HTM, from the entire filespec for the destination HTML file to get just the path portion, C:\DIR1\DIR2\ (in the examples, the result of that operation is always the same). This substring is then compared against the filespec of the image file. In the first case, Microsoft Project checks it against C:\DIR1\DIR2\IMAGE.GIF. The substring is found, so it just removes that portion from the beginning of the filespec for the image file and writes out the remainder (IMAGE.GIF) to the HTML file. 

In the second example, it checks for C:\DIR1\DIR2\ in C:\DIR1\DIR2\DIR3\IMAGE.GIF. Again, it’s found, so it’s removed, but that still leaves DIR3\IMAGE.GIF to be written out. In the other three cases, the substring is not found, so only the drive letter is removed and the rest of the filespec is written out.

This scheme insures that when the HTML file is first created, the images show up correctly when the output is viewed in a browser. If you move the files, you will likely need to update the paths in the SRC attribute, but you can avoid this if you maintain the relative position of the two files. In the best case scenario, the image file is in the same directory where the destination HTML file is written (as in the first example above), so that there are no paths involved and as long as the files are kept together, they can be moved anywhere.

Exporting Special Characters

Certain characters, such as the less than and greater than symbols, require special handling when exported to HTML. They have special meaning in an HTML file. Exporting them directly may have unexpected results. The Office specification for HTML encoding also specifies that for code page 1252 (US ANSI), special handling is necessary for extended characters (from 192 on), since they may be treated differently by each browser depending on factors such as the current code page.

In both of the cases, the solution is to export special named character entities instead of the actual character codes. The character entities are non-ambiguous, and ensure that the browser always displays the intended text. The entities for extended characters are case sensitive.

The following table lists the Windows characters that require special handling and the entities that always are exported when the character is encountered:


Character
ANSI
Export String


Tab
9
&#9; (IE & NetScape treat tabs as a space)

“
Straight double quote
34
&quot;

&
Ampersand
38
&amp;

<
Less than
60
&lt;

>
Greater than
62
&gt;

‘
Curly left single quote
145
straight quote (ANSI 39)

’
Curly right single quote
146
straight quote (ANSI 39)

“
Curly left double quote
147
&quot; (resolves to straight double quote)

”
Curly right double quote
148
&quot; (resolves to straight double quote)

™
Trademark
153
&trade;

 
Non-breaking space
160
&nbsp;

©
Copyright 
169
&copy;

®
Registered trademark 
174
&reg;

This table lists all of the extended characters that require special handling under code page 1252 and the corresponding entities to export:


Extended Character
ANSI
Export String

À
Capital A, grave accent
192
&Agrave

Á
Capital A, acute accent
193
&Aacute

Â
Capital A, circumflex accent
194
&Acirc

Ã
Capital A, tilde
195
&Atilde

Ä
Capital A, dieresis or umlaut mark
196
&Auml

Å
Capital A, ring
197
&Aring

Æ
Capital AE diphthong (ligature)
198
&AElig

Ç
Capital C, cedilla
199
&Ccedil

È
Capital E, grave accent
200
&Egrave

É
Capital E, acute accent
201
&Eacute

Ê
Capital E, circumflex accent
202
&Ecirc

Ë
Capital E, dieresis or umlaut mark
203
&Euml

Ì
Capital I, grave accent
204
&Igrave

Í
Capital I, acute accent
205
&Iacute

Î
Capital I, circumflex accent
206
&Icirc

Ï
Capital I, dieresis or umlaut mark
207
&Iuml

Ð
Capital Eth, Icelandic
208
&ETH

Ñ
Capital N, tilde
209
&Ntilde

Ò
Capital O, grave accent
210
&Ograve

Ó
Capital O, acute accent
211
&Oacute

Ô
Capital O, circumflex accent
212
&Ocirc

Õ
Capital O, tilde
213
&Otilde

Ö
Capital O, dieresis or umlaut mark
214
&Ouml

×
Multiply sign
215
&times

Ø
Capital O, slash
216
&Oslash

Ù
Capital U, grave accent
217
&Ugrave

Ú
Capital U, acute accent
218
&Uacute

Û
Capital U, circumflex accent
219
&Ucirc

Ü
Capital U, dieresis or umlaut mark
220
&Uuml

Ý
Capital Y, acute accent
221
&Yacute

Þ
Capital THORN, Icelandic
222
&THORN

ß
Small sharp s, German (sz ligature)
223
&szlig

à
Small a, grave accent
224
&agrave

á
Small a, acute accent
225
&aacute

â
Small a, circumflex accent
226
&acirc

ã
Small a, tilde
227
&atilde

ä
Small a, dieresis or umlaut mark
228
&auml

å
Small a, ring
229
&aring

æ
Small ae diphthong (ligature)
230
&aelig

ç
Small c, cedilla
231
&ccedil

è
Small e, grave accent
232
&egrave

é
Small e, acute accent
233
&eacute

ê
Small e, circumflex accent
234
&ecirc

ë
Small e, dieresis or umlaut mark
235
&euml

ì
Small i, grave accent
236
&igrave

í
Small i, acute accent
237
&iacute

î
Small i, circumflex accent
238
&icirc

ï
Small i, dieresis or umlaut mark
239
&iuml

ð
Small eth, Icelandic
240
&eth

ñ
Small n, tilde
241
&ntilde

ò
Small o, grave accent
242
&ograve

ó
Small o, acute accent
243
&oacute

ô
Small o, circumflex accent
244
&ocirc

õ
Small o, tilde
245
&otilde

ö
Small o, dieresis or umlaut mark
246
&ouml

÷
Division sign
247
&divide

ø
Small o, slash
248
&oslash

ù
Small u, grave accent
249
&ugrave

ú
Small u, acute accent
250
&uacute

û
Small u, circumflex accent
251
&ucirc

ü
Small u, dieresis or umlaut mark
252
&uuml

ý
Small y, acute accent
253
&yacute

þ
Small thorn, Icelandic
254
&thorn

ÿ
Small y, dieresis or umlaut mark
255
&yuml

Lesson 3.4 - Exercises

1.
Does Microsoft Project 98 come with a serializer that can be used to open tables stored in HTML files?

2. 
What is the name of the default HTML template and what folder is it in? 

You can verify this by using the File Save as HTML command and creating a new map; in the map definition dialog, select the Base export on HTML template option and look at the default path and filename displayed in the edit box.

3. 
If you use the Include image file in HTML page option, where is the specified picture placed in the HTML page?

4. 
Describe in general how templates are used to save a project in HTML format.

5. 
What is the difference between saving a project in HTML format when the Base export on HTML template option is not selected, and saving a project in HTML format when the Base export on HTML template option is selected and the default template is used?

Lesson 3.4 - Lab

This lab gives you practice saving projects with the new HTML format, and editing HTML templates.

1.
Create a project with several tasks and several resources assigned to each task. 

2.
Click the camera button on the toolbar and select the To GIF image file option. Where is it getting the default path and filename? Click OK.

3.
On the File menu, click Save As HTML. 

· In the File Save dialog, note the default path and change the filename to Test.html.

· Click the Save button to display the Export Format dialog.

· Select the "Who Does What" report in the map list and click the Copy button.

· Select the Base export on HTML template option and accept the default template that it provides.

· Select the Include image file in HTML page option and verify that it is set to the path and filename of the GIF file you created in step 2.

· Click OK and then click Save.

4.
Use the Windows Explorer to locate Test.html and double-click it to open it in Internet Explorer. Examine the page and note what kind of information is on the page and where it is located. Close Internet Explorer.

5. 
Use the Windows Explorer to locate the default template that was displayed in step 3 beside the Base export on HTML template option. 

Open the default template in Notepad and edit and save it so that the tag for the GIF image will be displayed on the bottom of the page in Internet Explorer. (One of the ways to open a file in Notepad is to hold the Shift key down and right click the filename. Then click Open with on the shortcut menu and double-click Notepad from the list of applications.)

Repeat steps 3 and 4 and verify that the image is at the bottom of the page in Internet Explorer.
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Lesson 4.1: User Interface Overview

Some Topics to be introduced in this lesson include:

· View Bar

· Hyperlinks

· Default menus and Toolbars; Shortcut Menus 

· Dropdown, Date Picker, and Spin Controls

· The New Replace Command

· Fill Commands

· Linking Tasks Interface

· Autotab

· Outlining Interface; Outlining with Usage views and Inserted Projects

· AutoCorrect

· Most Recently Used Filename List

· Microsoft ( Intellimouse(
User Interface Overview

This lesson covers a variety of changes and improvements to the User Interface in Microsoft Project 98.

View Bar

Microsoft Project 98 has a new View Bar similar in functionality to the Outlook Bar in Microsoft Outlook(.

The View Bar displays icons for all of the task and resource views listed on the View menu, in the same order. It also has a More Views icon. Up and Down scroll buttons are displayed in the View Bar if necessary. 

The View Bar command on the View menu toggles the hidden/visible state of the View Bar. 

If the View Bar is displayed, the button corresponding to the active view is displayed depressed.

New View Bar in Microsoft Project 98...
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The name of each visible view pane is displayed in the left border of the pane only if the View Bar is not displayed.

View name in left pane border if View Bar not displayed...
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Hyperlinks

Microsoft Project 98 supports the Office Web hyperlink features. Hyperlinks are supported in Text<n> fields and in the special fields shown in the table:

Hyperlink Address
The URL for the destination (for example, http://www.microsoft.com) or UNC path (for example, \\proj1\public\project1.mpp).

Hyperlink SubAddress
For Microsoft Office documents, this is the location within the file. For Microsoft Word, this is a bookmark name. For Microsoft Excel, a named range. For Microsoft PowerPoint(, a slide number. For Microsoft Access, this is a <object type> <object name> (for example, Form Customers).

Hyperlink HREF
Combines the Hyperlink Address and the Hyperlink SubAddress fields with a # as the delimiter, for example:

C:\Dir1\Book1.xls#Sheet2!R3C4

Hyperlink
Stores the alias for the hyperlink. This can be any text you want to represent the link, for example, My Spreadsheet could represent C:\Dir1\MySheet1.xls.

Link Appearance

Hyperlinks are formatted to appear differently than normal text. By default, unfollowed hyperlinks are displayed as blue, underlined text, and followed hyperlinks are displayed as magenta (purple), underlined text.

You can change the hyperlink colors in the Tools Options Workgroup Tab, using the settings shown in the picture to the right.
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 When the mouse is over a hyperlink, the cursor changes to the follow Hyperlink cursor.

Single clicking a hyperlink in any of the hyperlink related fields follows the link.

Context Menu

The context menu (displayed by a right mouse click) for a cell containing a hyperlink includes a Hyperlink submenu as shown in the picture to the right. 

The table describes each of the Hyperlink submenu commands.
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Hyperlink submenu item
Description

Open
Follow the link (same as left single click the link).

Open in New Window
Opens a new window and follows the link.

Copy Hyperlink
Copies the link as a shortcut so it can be pasted into another application, a folder, or the desktop as a shortcut. This command only copies the shortcut.

It is included for consistency with Microsoft Internet Explorer and to make the functionality of copying a shortcut more discoverable. Otherwise the Copy command by itself suffices. The Copy command also puts the shortcut format on the clipboard.

Add to Favorites...
Adds the link to the favorites.

Edit Hyperlink...
Edits the properties of the hyperlink

Select Hyperlink
Selects the hyperlink. Used when you want to select the cell instead of follow the link. Note that click the left mouse button follows the link instead of selecting the cell. The keyboard can also be used to select the cell.

Web Toolbar Display

The Web toolbar is displayed when you follow a link. 

There also is a button on the standard toolbar that allows you to toggle the Web toolbar on and off.
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The Web toolbar is modeled after the Internet Explorer toolbar.

Web toolbar with the Go menu displayed...
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The Show Only Web Toolbar toolbar button toggles between showing only the Web toolbar or showing the other selected toolbars too.

Creating Links

You can enter hyperlinks directly into the hyperlink-related fields or in text fields, or you can use the Hyperlink command on the Insert menu.

The Insert Hyperlink command displays the Insert Hyperlink dialog, as shown in the picture.
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Insert Hyperlink dialog using relative path...
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The Use relative path for hyperlink setting causes Microsoft Project to search for hyperlink targets relative to the path of the active project. 

After you click OK in the Insert Hyperlink dialog above, the hyperlink-related fields are filled in automatically as shown. Click the hyperlink in any of these fields to follow the same hyperlink.

Hyperlink-related fields using relative path...
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If the Use relative path for hyperlink setting is unchecked, then Microsoft Project searches for hyperlink targets using absolute paths.

Insert Hyperlink dialog using absolute paths...
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Hyperlink-related fields using absolute path...
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Pasting Hyperlinks

You can also create hyperlinks by copying data from an Office application or Microsoft Project. Use the Paste as Hyperlink command on the Edit menu in Microsoft Project.

The examples illustrate how to paste hyperlinks from Excel into Microsoft Project, and from Microsoft Project into Microsoft Project.
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Example

Cell D3 in Sheet2 of the Excel Workbook C:\Dir1\XlsFolder\HypTarget.xls contains the word "wow." The cell is selected and copied.

Then a task is selected in Microsoft Project 98, and the Paste Hyperlink command is used. The resulting hyperlink-related fields are automatically calculated as shown:
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Example

The resource with ID = 2 is selected in the Resource Sheet view of a project and copied. 

Then a task is selected in the Gantt Chart view and the Paste Hyperlink command is used. The resulting hyperlink-related fields are automatically calculated as shown:
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Menus and Toolbars

This section reviews all of the default menu and toolbar commands.

Menus

Microsoft Project 4.x has two default menu bars, Standard and Standard (no file). You can create other menu bars using the Tools Customize Menu Bars submenu command. You can also right-click the menu bar and choose Customize Menu Bars. Menu bars can be moved into MPP files in the Organizer, but cannot be displayed unless they are in Global.mpt.

Microsoft Project 98 has only one menu bar as do other Office applications. If you use the Tools Customize Toolbars submenu command to display the Customize dialog, the one and only menu bar is listed under the Toolbars Tab as "Menu Bar."

The Menu Bar is customizable (menu commands and submenu commands can be added, removed, renamed and so on), but there is no command like the Microsoft Project 4.x Customize Menu Bars command to create additional menu bars. Likewise, there is no Menu Bars Tab in the Microsoft Project 98 Organizer (there is still a Toolbars Tab).
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The single Menu Bar and all of the Toolbars in Microsoft Project 98 are called CommandBars.

CommandBar font

Microsoft Project 4.x used the Display Scheme menu font and size for menu text.

Microsoft Project 98 uses the same font as other Office applications. If the Display Scheme menu font is set to MS San Serif, then Tahoma is used for CommandBars. Otherwise the Display Scheme menu font is used (Tahoma is a TrueType font that Microsoft Project 98 installs in the Font directory).

Microsoft Project 98 default menus

Only new Microsoft Project 98 menu items and menu items that have been moved or changed from Microsoft Project 4.x are discussed in detail.

The sample pictures in this section are from the Gantt Chart, Task Usage, and the Resource Usage views unless specified otherwise. Some of the items shown in this section are disabled in some views. 

If the Customize dialog is active, then menu command names in brackets [] are dynamic and change based on your actions. A ‘/’ is used to separate command names that change based on context. This is similar to the notation used in the Menu Bar Definition dialog in Microsoft Project 4.x.

File menu

The picture shows the File menu and its submenus if the Customize dialog is displayed.
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Save As HTML: Added for Office consistency. Displays the normal Save As dialog with the HTML Document (*.html;*.htm) file type selected. 

Send To: Has the submenu that follows that replaces the separate Microsoft Project 4.x File menu items Send, Add/Edit Routing Slip, and Post To Exchange Folder.
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The actual submenu displays as shown:

 Without a routing slip...              With a routing slip...
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More about the Sent To submenu: The Mail Recipient command is to send files without routing slips. The Next Routing Recipient command is to forward files with a routing slip. As in Microsoft Project 4.x, when the document has a routing slip, this command displays a dialog asking if you want to send the project to the next routing recipient or send the document as a normal send. The Routing Recipient and Other Routing Recipient commands replace the Microsoft Project 4.x Add Routing Slip and Edit Routing Slip commands. The Exchange Folder command replaces the Microsoft Project 4.x Post To Exchange Folder command.

Properties: Moved below the Send To item for consistency with Office 97.

Edit menu

The picture shows the Edit menu and its submenus if the Customize dialog is displayed.
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Cut, Copy, Paste, Delete, Hide and Clear Entire:

· Each of the commands can include selection-based text. In Microsoft Project 4.xeither Cell, Task, or Resource was appended after the command in parenthesis. In Microsoft Project 98, the text is appended without parenthesis and also includes Assignment or Row. Assignment is used when the selection includes only assignment rows in one of the Usage views. However, Clear Entire Assignment is not supported, so that command is disabled. Row is used when a selection includes both resources and assignment rows or both task and assignments rows in a Usage view. It also supports Delete Cells on the timescaled portion of the Usage view.

· Paste as Hyperlink: Creates a hyperlink to the copied data, if the source of the copied data supports it. Office 97 supports this feature. The hyperlink information is stored in the Hyperlink, Hyperlink Address, Hyperlink SubAddress, and Hyperlink HREF fields. 

· Clear Hyperlinks: Clears the information in the Hyperlink fields for the selected rows.

· Hide Column: When an entire column is selected, the command Hide Column is displayed on the menu instead of the Microsoft Project 4.x command, Delete Column. This makes it clearer that no data is deleted, and that the column is simply removed from the table.

Fill submenu: Replace the Microsoft Project 4.x Fill Down command. Only the Down and Up commands apply to tables. All the commands apply to the timescaled portion of Usage views. 

Split Task: New split task feature in Microsoft Project 98.

Replace: New search and replace features in Microsoft Project 98. 

View menu

The picture shows the View menu and its submenus if the Customize dialog is displayed.

[image: image142.png][Task Views]

[Resaurce Views]
[Tables]

e ews,

Table: [CurrentTable] >/ More Tables.

B reports.

e Clicking this does not

Tewter display the submenu
when the Customize
Headier and Footer. dialog is active.

Zoom.




In the four pictures, the Customize dialog is not displayed:

Default View menu 

items               
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Default Task Table submenu items
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Default Resource Table submenu items
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Default Toolbars 

submenu items               
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Task Usage and Resource Usage: New views in Microsoft Project 98 to view task/resource records and assignment records, both as totals in a table in the left pane, and timephased values in a timescaled right pane. Microsoft Project 4.x had a Resource Usage view, but it did not show both resource and assignment records together. The timephased data could also not be edited.

Tracking Gantt: Microsoft Project 4.x had this view, but it was not listed in the default view menu.

Toolbars: In Microsoft Project 4.x, this command displayed the Toolbars dialog. In Microsoft Project 98, it displays a submenu that lists available views and indicates which are displayed.

View Bar: This toggles the display of the new Microsoft Project 98 View Bar.

Header and Footer: For consistency with Office 97. This command displays the Page Setup dialog Header Tab. This is not listed in the Microsoft Project 4.x View menu.

Insert menu

The picture on the right shows the Insert menu when the Customize dialog is displayed.

The default Insert menu items depend on the active selection as shown in the following six pictures (when the Customize dialog is not displayed). 

Note: If a blank task or resource record is selected, then the Page Break and Object items are disabled. If a cell is selected in the timescaled grid of a Usage view, then the Object item is disabled.
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If a nonblank task record is selected in a task view:            
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If an assignment record is selected in a Task Usage view:
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If a nonblank resource record is selected in a resource view:      
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If an assignment record is selected in a Resource Usage view:             

[image: image151.png]Insert

New fssignment Ins

Column,

Page freak

& ook b





If a nonblank record is selected in the left pane of the Task Usage view and a cell is active in the timescaled grid.
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If a nonblank record is selected in the left pane of the Resource Usage view and a cell is active in the timescaled grid.
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Redundant use of the word Insert is eliminated: Microsoft Project 4.x included the redundant word Insert as part of several items listed on the Insert menu, such as Insert Recurring task. Microsoft Project 98 does not use the word, Insert, in the names of the items on the Insert menu.

New Task/Resource/Assignment: The Microsoft Project 4.x Insert Task/Resource/Resource assignment commands changed to New Task/Resource/Assignment in Microsoft Project 98. The Microsoft Project 4.x Resource Assignment command (which displays the Resource Assignment dialog) is now the Microsoft Project 98 Tools Resources Assign Resources submenu command (which displays the Assign Resources dialog).

Project: This is the new Insert Project command. It takes the place of Microsoft Project 4.x subprojects and consolidated projects.

Hyperlink: Displays the new Insert Hyperlink dialog.

Information commands moved to Microsoft Project menu: The Microsoft Project 4.x Task, Recurring Task, and Resource Information dialogs are on the Microsoft Project 98 Project menu (the new Assignment Information command is also on the Project menu).

Format menu
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The default Details submenu items are shown for various views:

Task Form
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Resource Form
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Task Usage
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Resource Usage
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Resource Graph
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Tools menu
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The Microsoft Project 4.x Workgroup submenu is repositioned in the Tools menu.

The Microsoft Project 4.x Multiple Projects command is removed. Some items no longer exist in Microsoft Project 98 (Consolidate Project, Save To Database, Save To Database As, Open From Database). The Share Resources command is now on the new Microsoft Project 98 Resources submenu.

Microsoft Project 98 has a new Links Between Projects command to provide information about cross project predecessor/successor links (new feature in Microsoft Project 98).

To make the Organizer more accessible, an Organizer command is added to the Tools menu to display the Organizer dialog.

The Microsoft Project 4.x Tools Outlining, Filtered for, and Sort commands are replaced by equivalent commands on the Microsoft Project 98 Project menu.

Each of the Microsoft Project 98 Tools submenus is discussed in detail.

Workgroup submenu

The new WebInbox command is enabled if the new Web server is installed (by specifying a URL and UNC path in the Tools Options Workgroup Tab). 

Set Reminder only works with Outlook rather than Schedule+.
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Resources submenu

The new Microsoft Project 98 Tools Resources submenu holds the resource related commands that follow.

.
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· Assign Resources: This is the old Microsoft Project 4.x Insert menu Resource Assignment command. 

· Share Resources: This was on the Microsoft Project 4.x Tools Multiple Projects submenu.

· Update Resource Pool: This command updates the resource pool with new information from the sharer. 

· Refresh Resource Pool: This command reloads the resource pool in order to view changes made by other users. 

Tracking submenu

The new Microsoft Project 98 Progress Lines command is added. It displays the Progress Lines dialog that is used to specify and format the new Microsoft Project 98 lightening bolt progress lines on Gantt Chart views.
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Macro submenu

The first two submenu items replace the Microsoft Project 4.x Tools Macros and Record Macro commands. The Microsoft Visual Basic( Editor command is new to Microsoft Project 98. The Microsoft Project 4.x Module Editor view does not exist in Microsoft Project 98.
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Customize submenu

The new Fields command displays the Customize Field Names dialog that can be used to assign aliases to field names.

The Microsoft Project 4.x Tools Customize Menus submenu command is removed in Microsoft Project 98. Its functionality is now included in the Microsoft Project 98 Tools Customize Toolbars submenu command. 
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Project menu

The picture shows the Project menu and its submenus if the Customize dialog is displayed.

[image: image166.png]Project|
sort
Eitered for: [Currentfiker]
Qutlne

3 [TaskiResource Information]  ShFL-+F2
> [TasklResource Notes]

Project Information,




The Sort, Filtered for, and Outline commands replace the equivalent commands on the Microsoft Project 4.x Tools menu.

The Task/Resource Information and Notes commands replace the equivalent commands on the Microsoft Project 4.x Insert menu. In addition, if an assignment record is selected in the new Microsoft Project 98 Usage views, then the commands change to Assignment Information and Assignment Notes.

The Project Information command replaces the Project Info command on the Microsoft Project 4.x File menu.

Sort submenu

This is how the Sort submenu appears when the Customize dialog is not displayed.

If a task view is active:
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If a resource view is active:
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'Filtered for' submenu

This is how the Filtered for submenu appears when the Customize dialog is not displayed.

If a task view is active:
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If a resource view is active:
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Outline submenu

This is how the Outline submenu appears when the Customize dialog is displayed.

[image: image171.png]P Indent
“ Qudent

# show Subtasks
= Hide Subtasks
Fi [Show/Hide Assignments]

%4 Show Al Subtasks

%= [ShowjHide Outiine Symbols]




Indent and Outdent are disabled in resource views.

The Show/Hide Assignments and Show/Hide Outline Symbols commands toggle between the words Hide and Show.

The Hide/Show Assignments command is only enabled in Usage views.



Window menu

This is how the Window menu appears when the Customize dialog is displayed.

It has the same commands as in Microsoft Project 4.x.
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Help menu
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The Microsoft Project 4.x Microsoft Project Help Topics command is changed to Microsoft Project Help in Microsoft Project 98. It now displays the Office Assistant rather than the Microsoft Project 4.x Help Topics dialog.

The Microsoft Project 4.x Answer Wizard command is removed in Microsoft Project 98.

Microsoft Project 98 has a new Contents and Index command that displays the Project Help Topics dialog. This is similar to the Microsoft Project 4.x Help Topics dialog except that it doesn’t have the Answer Wizard Tab.

The Microsoft Project 4.x Tip of the Day is available through the Office Assistant in Microsoft Project 98.

What’s This?: For consistency with Office, the Microsoft Project 4.x context sensitive Help button [image: image174.png]


 is removed from the Microsoft Project 98 Standard toolbar and the What's This? command is added to the Microsoft Project 98 Help menu.

Getting Started submenu: The Quick Preview command on the Microsoft Project 4.x Help menu is moved to the Microsoft Project 98 Getting Started submenu. The Getting Started submenu also contains the Create Your Project (tutorial), and Microsoft Project 101 commands.
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Microsoft on the Web submenu: 

For consistency with Office, The Microsoft Network item on the Microsoft Project 4.x Help menu is replaced by the Microsoft on the Web submenu in Microsoft Project 98.
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Toolbars

Right-click a toolbar to display the following shortcut menus in Microsoft Project 4.x and Microsoft Project 98:

Microsoft Project 4.x
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Project 
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The changes, new buttons, and removed buttons for each of the default toolbars in Microsoft Project 98 are discussed in this section. The default Standard and Formatting toolbars in Microsoft Project 98 are shown:

The Microsoft Project 98 Standard (top) and Formatting toolbars...
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Standard Toolbar

ToolTip changes 

Some of the Microsoft Project 4.x toolbar buttons have a different ToolTip in Microsoft Project 98, including the following:

· Print toolbar button: The ToolTip includes the default printer in parenthesis.
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· Undo: This ToolTip is now the same as the text displayed for the Undo command on the Edit menu. Microsoft Project 4.x always had the ToolTip text "Undo."
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New buttons on the Microsoft Project 98 Standard toolbar

[image: image182.bmp]
Insert Hyperlink: Displays the Insert Hyperlink dialog.

[image: image183.bmp]
 Web Toolbar: Toggles the display of the new Web toolbar as shown :
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[image: image185.bmp]
Split Task: Used to split tasks in Gantt Chart.

[image: image186.bmp]
Office Assistant: Shows the Office Assistant and its caption if the Assistant is not currently visible, otherwise it just toggles the Assistant's caption.

Microsoft Project 4.x buttons not on the Microsoft Project 98 Standard toolbar

Microsoft Project 4.x toolbar button removed from Microsoft Project 98
How to execute the command in Microsoft Project 98

[image: image187.bmp] 
Sort By Date
Sort by Start Date submenu command on the Project menu.

[image: image188.bmp] 
Drawing
Insert menu Drawing command.

[image: image189.bmp]
Help Topics
Contents and Index command on the Help menu.

[image: image190.bmp]
Help
'What's This?' command on the Help menu.

Formatting Toolbar

The following changes are made to the Microsoft Project 98 Formatting toolbar:

· The following two new buttons are added to the Microsoft Project 98 Formatting toolbar:

[image: image191.bmp]
Show/Hide Assignments: This new toggle button hides or displays assignment rows for the selected tasks/resources in Usage views

[image: image192.bmp]
AutoFilter: This new toggle button turns AutoFilter on or off (same as AutoFilter submenu command on the Project Filtered for submenu). 

· The Filter Dropdown list is moved to the right side of the Formatting toolbar.

· The Microsoft Project 4.x Outline Symbols toolbar button [image: image193.bmp] is not in Microsoft Project 98. An equivalent submenu command is available on the Project Outline submenu. You can also use the Show outline symbol setting in the Tools Options View Tab. 

Custom Forms toolbar

No changes from Microsoft Project 4.x.
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Drawing toolbar

The updated Drawing toolbar includes a Draw menu to be more consistent with Office. The difference from the Microsoft Project 4.x Drawing toolbar is shown:

Microsoft Project 4.x Drawing toolbar:
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Microsoft Project 98 Drawing toolbar:
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The 'Microsoft Project 3.0' toolbar in Microsoft Project 4.x

This is removed from Microsoft Project 98.

The 'Microsoft Project 95' toolbar in Microsoft Project 98

This is a new toolbar in Microsoft Project 98. This is the Microsoft Project 4.x Standard toolbar and is provided for users upgrading from Microsoft Project 4.x (who may want to use the Standard toolbar with which they are familiar). Some of the ToolTips and functionality changed as necessary.

[image: image197.png]DEE S&R_RY &R @ B C B QAT HE NSK?




Resource Management toolbar

The resource management toolbar adds three new buttons related to resource sharing, and removes the CreatePivotTables button (shown with the Excel icon). The Microsoft Project 4.x CreatePivotTables macro is replaced by the new Microsoft Excel Pivot Table file type in the Save as type list in the Save As dialog.

Microsoft Project 4.x Resource Management toolbar...
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Microsoft Project 98 Resource Management toolbar...
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The three new buttons in Microsoft Project 98 are Share Resources, Update Resource Pool, and Refresh Resource Pool (in that order, after the two-headed Assign Resources button).

Tracking toolbar

Microsoft Project 4.x Tracking toolbar...
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Microsoft Project 98 Tracking toolbar...
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New button added to the Microsoft Project 98 Tracking toolbar

[image: image202.bmp]
Add Progress Line: Displays a special cursor that adds a progress line at the date of the location on the Gantt Chart where you click the mouse button.

Add Progress Line cursor: [image: image203.png]


 

Microsoft Project 4.x buttons not on the Microsoft Project 98 Tracking toolbar

[image: image204.bmp]
Update Task Range: Ran the Microsoft Project 4.x TaskUpdate macro, not included in Microsoft Project 98.

The Microsoft Project 4.x macro stepped through each task or task in a specified date range and displayed the Tracking Dialog. It skipped milestones, summary, subproject, and completed tasks.

[image: image205.bmp]
Update Resource: Ran the TimeTrak.exe Visual Basic application that was included in Microsoft Project 4.x. 

TimeTrak.exe is not included in Microsoft Project 98. The Usage views are used instead in Microsoft Project 98 to enter actuals for date ranges.

Visual Basic toolbar

Microsoft Project 4.x had a Visual Basic toolbar with a complete set of programming related buttons, but Microsoft Project 98 provides only a minimal Visual Basic toolbar.

Microsoft Project 4.x Visual Basic toolbar...
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Microsoft Project 98 Visual Basic toolbar...

[image: image207.bmp] 

The buttons on the Microsoft Project 98 Visual Basic toolbar are Run Macro, Record Macro, and Visual Basic Editor.

Microsoft Project 98 provides only a minimal Visual Basic toolbar because Microsoft Project 98 includes the Visual Basic Editor shared by other Office applications. One of the ways to display the Visual Basic Editor is to use the Visual Basic Editor command on the Tools Macro submenu in Microsoft Project 98. The Visual Basic Editor is a separate application that runs in its own window. The Standard toolbar in the Visual Basic Editor window is shown:
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If you right-click the toolbar in the Visual Basic Editor, the shortcut menu lists the other toolbars that can be displayed.
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Web toolbar

The Web toolbar is modeled after the Internet Explorer toolbar.

Web toolbar with the Go menu displayed...
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The Show Only Web Toolbar toolbar button toggles between showing only the Web toolbar or showing the other selected toolbars too.

WorkGroup toolbar

Microsoft Project 4.x WorkGroup toolbar...
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Microsoft Project 98 WorkGroup toolbar...
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The default ToolTips for the Microsoft Project 4.x and Microsoft Project 98 WorkGroup toolbar buttons are listed in the order they appear on the respective toolbars:

Microsoft Project 4.x WorkGroup buttons in order:

· Routing Slip

· Send Mail

· Update Read Only

· Toggle Updates

· Consolidate Projects

· Open From Database

· Save To Database

· TeamAssign

· TeamUpdate

· TeamStatus

· Set Reminder
Microsoft Project 98 WorkGroup buttons in order:

· TeamAssign

· Team Update

· TeamStatus

· WebInbox

· Set Reminder

· Send to Mail Recipient

· Send to Routing Recipient

· Send to Exchange Folder

· Insert Project

· Open from Database

· Save to Database As

The table reorders the buttons so that buttons with the same or similar functionality in Microsoft Project 4.x and Microsoft Project 98 are on the same row. NA means that that button doesn't apply in that version of Project:

Microsoft Project 4.x WorkGroup buttons:
Microsoft Project 98 WorkGroup buttons:
Comments

Routing Slip
Send to Routing Recipient


Send Mail
Send to Mail Recipient


Update Read Only
NA
Runs the Microsoft Project 4.x UpdateFile macro that closes and reopens the active project file if it is read-only.

The macro is not included in Microsoft Project 98

Toggle Updates
NA
Runs the Microsoft Project 4.x ToggleReadOnly macro that closes and reopens the active project file read-only if it is currently read-write, or opens it read-write if it is currently read-only.

The macro is not included in Microsoft Project 98

Consolidate Projects
Insert Project
This is the new Insert Project command. It takes the place of Microsoft Project 4.x subprojects and consolidated projects.

Open From Database
Open from Database
In Microsoft Project 4.x, it executed a command to run the hidden OpenFromDatabase macro:

      Macro "OpenFromDatabase"

In Microsoft Project 98 it executes a command to open a project from an ODBC Data Source (the Select Data Source dialog is displayed):

      FileOpen FormatID:="MSProject.ODBC"

Save To Database
Save to Database As
In Microsoft Project 4.x, it executed a command to run the hidden SaveToDatabase macro:

      Macro "SaveToDatabase"

In Microsoft Project 98 it executes a command to save a project to an ODBC Data Source (the Select Data Source dialog is displayed):

      FileSaveAs FormatID:="MSProject.ODBC"

TeamAssign
TeamAssign


TeamUpdate
Team Update


TeamStatus
TeamStatus


Set Reminder
Set Reminder
Set Reminder only works with Outlook rather than Schedule+.

NA
WebInbox
The new WebInbox command is enabled if the new Web server is installed (by specifying a URL and UNC path in the Tools Options Workgroup Tab). 

NA
Send to Exchange Folder
Has the behavior of the Microsoft Project 4.x Post to Exchange command on the File menu.

Analysis toolbar

The Analysis toolbar is new to Microsoft Project 98. It is stored in Global.mpt, so if you boot without a global, then you will not have the Analysis toolbar.
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· Adjust Dates: Runs the Adjust_Dates macro.

· Program Evaluation and Review Technique (PERT) Analysis: Toggles the visible state of the Pert Analysis toolbar.

· Analyze Timescaled Data in Excel: Runs the Analyze_Timescaled_Data macro.

Shortcut Menus in Microsoft Project 98 versus Microsoft Project 4.x

This section compares some of the shortcut menus in Microsoft Project 98 versus Microsoft Project 4.x.

The table shows the shortcut menus in Microsoft Project 4.x and Microsoft Project 98 that are displayed by right-clicking on various parts of Project. The word Same in the third column means that Microsoft Project 98 has the same menu commands as Microsoft Project 4.x for that particular shortcut menu, although there may be some formatting. Microsoft Project 98 uses 3D checkmarks to indicate a current selection instead of the bullets or 2D checkmarks used in Microsoft Project 4.x. Also, Microsoft Project 98 displays small icons in front of some shortcut menu commands.

In the pictures, the word Hide toggles between Hide and Show, and the command Split toggles between Split and Remove Split.

Right click this
Project 95 shortcut menu
Microsoft Project 98 shortcut 

Application Title Bar Icons (Minimize, Maximize, and Close button)
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Removed

Office 97 no longer supports this shortcut menu.

Application Title Bar
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If the window is currently maximized then only Restore, Minimize, and Close are enabled.

This is displayed by the system.
[image: image216.png]Move
Size

Miinize
Magiize

Close  AltsF4




No change in the commands.



Window Title Bar

(Displayed if the MPP document window is not maximized.)
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Toolbars
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The top part is a list of available toolbars. The currently visible ones are marked. 
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Menu Bars
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The top part is a list of available menu bars. The current one is marked.
Removed

Microsoft Project 98 uses the Office 97 menu model. There is only one menu bar (it can be customized).

Drawing Layer Objects (Drawing or OLE Objects on the Gantt)
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(Shown with Order submenu.)

OLE Objects in a Form view with details set to Objects.
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Only the list of supported object verbs is displayed.
Same

Sheet Cells

Note: The two sample pictures are for a task table. If a resource table is active, then the word Resource replaces the word Task.
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Row Headers

Note: The two sample pictures are for a task table. If a resource table is active, then the word Resource replaces the word Task, and the Outdent and Indent commands are not displayed.
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Task and Resource table Column Headers
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Select Sheet button 

(The blank column header above the locked column.)
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The middle section is the list of tables on View Tables sub menu.
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Same...except for a different default list of tables, and the 3D checkmark.

Timescale
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Same...except for an icon in front of GanttChartWizard.

Gantt Background
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Resource Graph: Timescale Data Portion
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The bottom part is the Format Details list.
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Same ... except that the 'Show assignment units...' setting in the Tools Options Schedule Tab lets you show Peak Units as a percentage instead of a decimal.

Also, Microsoft Project 98 uses a 3D checkmark.

Resource Graph: Legend area
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Same...except for icons in front of the first two commands.

Resource Usage timescaled data portion.

This view has a completely different behavior in Microsoft Project 98.
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The Detail Styles dialog has settings to determine which items are listed on this submenu.

Task Usage timescaled data portion.


NA

Microsoft Project 4.x did not have this view.
Similar to the Microsoft Project 98 Resource Usage shortcut menu shown previously, except that the fields are resource and assignment fields, instead of task and assignment fields.

PERT Background
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PERT Node
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Gantt Bar
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Calendar Task Bar
[image: image249.png]T3, 14
Task Infomaton.
Task Notes

__ TetSyles
— BarSiyls.




[image: image250.png]& @000
[exE]
[ Task Information.
© Tesktte

Text Styls,
Bar styles.

Hyperlink





Calendar Day Box
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Calendar Row Titles or Column Titles
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Calendar Title
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Form View Background
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Same...except for the 3D checkmark.

View Bar
NA

No shortcut menu when right-clicking the left border of a view pane in Microsoft Project 4.x.
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The views listed in the first two sections depend on the Show-in menu setting in the View Definition dialog for each of available views.

Enumerated Field Dropdown Control

Microsoft Project 4.x has dropdowns in dialogs for enumerated fields such as Priority. When a table is active, it has a dropdown list of choices at the end of the entry bar.

Microsoft Project 98, like Microsoft Project 4.x, has dropdowns in dialogs for fields with enumerated types. For tables, however, the dropdowns are in the table cells rather than at the end of the Entry Bar.
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The dropdown arrow is displayed in the selected cell, and aligned with the top of the cell. When the cell with a dropdown receives focus, the text in the cell is left aligned. Because the Resource Names field may contain very long resource names, the width of in-cell dropdowns is limited to the maximum of the current width of the cell or a width of 20 characters.

An enumerated field in a table automatically enters edit mode if you type in the cell or display the dropdown list. To display the dropdown list, click the dropdown arrow button on the left side of the cell, or by press the F4 or ALT+DOWN keys. When the dropdown is displayed, if there are too many choices to display at the same time, you can use the scroll bar or the Up and Down keys to scroll through the list.

Date Picker Control

Microsoft Project 98 has a new Date Picker control for date fields in dialogs and in tables. This control provides an easy way to set dates. Single dates can be selected with the Date Picker control, but not date ranges.

Date Picker control in the Project Information dialog...
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Date Picker control in a task table...
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The Spin Control

Microsoft Project 98 introduces spin controls similar to those in other Office applications. 

Spin controls are used in several Microsoft Project 98 numeric fields. A spin control allows you to increase or decrease the value in a numeric field by predefined increments. Each field type has its own spin increment. The Microsoft Project 98 numeric fields that use spin controls can be grouped into the five types listed, along with their increment sizes:

Field Type
Increment

Duration/Delay/Work
1

Lag
1

Percent
5

Units
0.5 (= 50%)

The increment for Duration, Delay, Work and Lag field types is 1 of whatever the current unit is for the active cell. For example, if the Duration value displayed in a cell is 10d, then the increment is 1d. If the Duration value displayed in a cell is 2w the increment is 1w.

The pictures show the spin control in a table and in a dialog:

Duration field spinner in a task table...
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Lag field spinner in the Task Information Predecessors Tab...
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If a field has a spin control, you still have the option of entering a value rather than using the spin control. 

When using a spin control, it always displays in whole multiples of its increment size. If the current value lies between two spin increments (perhaps because you entered a value without the spin control), then the next spin begins at the increment value closest to the current entered value. 

Spin controls do not decrease or increase below or above the minimum or maximum legal values for the active field. For example, the task % Complete field cannot spin below 0% or above 100%.

Keyboard: The ALT+DOWN and ALT+UP keys can be used to spin down and up if the active cell has a spin control.

The New Replace Command

Microsoft Project 4.x has a Find command, but not a Replace command.

Microsoft Project 98 has both. The behavior of the Find and Replace commands in Microsoft Project 98 is similar to their behavior in other Office applications.

The new Replace command can be accessed from the Edit menu directly, or from the Find dialog.

Replace command on the Edit menu...
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Replace button in the Find dialog...
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Replace dialog...
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After clicking Replace All...
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What can be searched

Find is enabled in all views, except the Pert Chart. Replace is enabled in all views except the Calendar, Resource Graph, Pert Chart, Task Pert and Form views. 

Note that Find and Replace commands in the VBE (Visual Basic Editor) are implemented by VBE, not by Microsoft Project.

The new Replace command can be used to find and replace data in any editable field in a task or resource table. The Find what and Replace with fields accept up to 255 characters.

All fields that can be inserted into a table are available in the Look in field list, except the Indicators field. This includes noneditable fields such as ID and BCWP. If you search on a noneditable field, no replacements are made and no error messages display. If the field is editable for some records but not others, replacements are ignored on the noneditable fields and no error messages display. For example, replacing 1d by 2d in the Duration field is ignored for summary tasks.

The Find and Replace commands only look at records that are displayed in the current table. For example, records that are collapsed under summary tasks and records that are hidden by the current filter are ignored by the Find and Replace commands.

However, the specified Look in field is searched even if it is not part of the current table definition. 

Search sequence

The search begins with the record that is immediately below or above the active record, depending on whether the Search setting is Down or Up.

When the find reaches the bottom or top of the project, it automatically wraps around to the opposite end and continues.

If you are using the Find Next or Replace buttons (instead of Replace All) and if at least one match is found, then the alert at the right is displayed when the search is completed:
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If you are using the Find Next or Replace buttons (instead of Replace All) and if no match was found, then the alert on the right is displayed when the search is completed:
[image: image268.png]i Microsoft Project has searched the entie field and did ot find a match






If you are using Replace All then the alert displayed when the search is completed has the same form whether or not a match was found. For example, if no matches are found, then the alert on the right is displayed: 
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Note: When doing a Find Next or Replace (instead of Replace All), the cell containing a match is automatically selected if the search field is in the table, otherwise the entire record is selected.

Formatting issues

The Find and Replace commands take into account fields that with special formatting, such as date, duration, and cost fields. For example, searching for 1d in the Duration field will match entries formatted as "1 day."

If you do not specify a work or duration unit in the Find what and Replace with fields when the Look in field setting is a work or duration field, then the default unit specified in the Tools Options Schedule Tab is assumed. For example, if you are searching the Duration field and if Find what is set to 1 and Replace with is set to 2, and if the default duration unit is days, then 1d is replaced with 2d, but 1w is not a match.

Rich Text Notes

If a replace is done for a Notes field, then any rich text formatting is lost without any alerts. This is the same behavior that occurs when you edit a Notes field in a table instead of in the corresponding information dialog.

Invalid replacements

If a Replace or Replace All is tried, and the Replace with value is not valid for the Look in field then an alert is displayed as illustrated in the picture:

Alert when the replacement value is invalid...
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Fill Commands

Microsoft Project 4.x has a Fill Down command on the Edit menu. 

Microsoft Project 98 has a Fill submenu with choices Down, Right, Up, and Left. The Fill commands in Microsoft Project 98 support discontiguous multiple selections across multiple rows and columns. Invalid data is ignored during fills. The Fill Left and Right commands are only available in the timescaled grid portion of the Task and Resource Usage views.

Example of filling down across a multiple selection in a task table...
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Result...
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Example of filling right across a multiple selection in a Task Usage grid....
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Result...

[image: image274.png]wark ||

2 his
32 s

Bh 8h Bh






Linking Tasks

The Link Tasks command in Microsoft Project 98 has more functionality and is predictable than in Microsoft Project 4.x.

Discontinuous Selections

Microsoft Project 4.x always linked tasks by ID order. 

Microsoft Project 98 links tasks in the order they are selected.

Example

Control+Click was used to select T6, then T2, and then T4...
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Result...
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Autolink

Microsoft Project 98, like Microsoft Project 4.x, has the setting Autolink inserted or moved tasks in the Tools Options Scheduled Tab. Much of the Autolink behavior is the same in Microsoft Project 98 as it was in Microsoft Project 4.x. Some of the Microsoft Project 98 Autolink improvements are illustrated in the examples.

Example

Whole task records for tasks Tc and Td are selected and cut, and then pasted between task records Ta and Tb.

Originally...
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Microsoft Project 4.x result...
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Microsoft Project 98 result...
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Example

Whole task records for tasks Tc and Td are selected and cut, and then pasted between task records Ta and Tb.

Originally...
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Microsoft Project 4.x result...
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Microsoft Project 98 result...
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Example

Whole task records for tasks Tb and Tc are selected and deleted.

Originally...
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Microsoft Project 4.x result...
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Microsoft Project 98 result...
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Autotab

The Tab/Shift+Tab keys wrap the cursor to the next/previous row in tables. This behavior is new to Microsoft Project 98.

If the cursor is at the end/start of a row in a table and you press the Tab/Shift+Tab key, then Microsoft Project 98 automatically positions the cursor at the start/end of the next/previous row.

Cursor is at end of row three...
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Pressing the Tab key moves it to the start of row four...
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Outlining Interface

This section highlights the new outlining user interface in Microsoft Project 98, and the differences between the outlining interface in Microsoft Project 4.x compared to Microsoft Project 98.

Both Microsoft Project 4.x and Microsoft Project 98 have the setting Show outline symbol in the Tools Options View Tab. 

Microsoft Project 4.x supports ten levels of outlining. The outline symbol is for viewing only, and does not respond to mouse clicks. Summary tasks always use a "+" symbol and nonsummary tasks always use a "-" symbol. Double-click a summary task to toggle between collapsed/expanded state. When an outline level is collapsed, the only indication that not all tasks are shown is the gap in the numbering of the task ID. 

Microsoft Project 98 supports 65535 levels of outlining. In Microsoft Project 98, only summary tasks have outline symbols. The symbol is "+" if the summary task is collapsed, and it is "-" if the summary task is expanded. Click an outline symbol to toggle its collapsed/expanded state. This is consistent with the use of the outline symbols in Excel and in the Windows Explorer. Double-click a summary task to display the Summary Task Information dialog (rather than toggling the collapsed/expanded state as in Microsoft Project 4.x).

Example

This example illustrates the use of the new +/- outline symbols in Microsoft Project 98.

[image: image288.bmp] After pressing the Show All Subtasks toolbar button...

[image: image289.png]



After clicking the "-" outline symbol for task T2...
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After clicking the "-" outline symbol for task T1...
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After clicking the "+" outline symbol for task T1...
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Outline symbols in Usage views

In the new Microsoft Project 98 Task Usage and Resource Usage views, outline symbols are used to toggle between the collapsed/expanded state of the assignment records under their corresponding parent task or resource records.

Example

This example illustrates the use of the new +/- outline symbols in the new Microsoft Project 98 Task Usage view.

[image: image293.bmp] After pressing the Show All Subtasks toolbar button...
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After clicking the "-" outline symbol for task T1...
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Show/Hide Assignments Button 
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 In the new Microsoft Project 98 Usage views, there is an additional Show/Hide Assignments toolbar button that toggles between the collapsed/expanded states of the assignments for the selected tasks.

Double-clicking task, resource, and assignment records

The table lists the results when you double-click task, resource, and assignment records in Microsoft Project 98.

Double-click this type of record
Microsoft Project 98 displays this

Summary Task
Summary Task Information Dialog

Recurring Task
Recurring Task Information Dialog

Regular Task 
Task Information Dialog

Project Level Summary Task
Summary Task Information Dialog

Assignment
Assignment Information Dialog

Cross Project Linked Task (Ghost task)
If the external Project is in memory – Microsoft Project switches to the external Project with focus on the linked task

If the external Project is not in memory - Microsoft Project brings up the Task information dialog using the stored external field information that’s in the current project.



Resource
Resource Information Dialog

Assignment
Assignment Information Dialog

Expanding Inserted Projects

Inserted Project tasks that are not currently open (in memory) cannot be expanded using the Show All Subtasks toolbar button.
[image: image297.bmp]

Instead, such tasks must be selected, and the Show Subtasks toolbar button must be used. 
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This is for performance reasons. It prevents you from unintentionally opening all Inserted Projects.  Expanding an unopened Inserted Project causes it to be opened, which can slow performance, so you must explicitly select Inserted Projects in order to expand them.

AutoCorrect

AutoCorrect is improved in Microsoft Project 98. New features include automatically fixing common grammar errors such as changing "your a" to "you're a." This is part of the Microsoft IntelliSense( technology. The AutoCorrect dialog has the same appearance and functionality as the one in Excel 97.
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Most Recently Used Filename List

As with other Office 97 applications, Microsoft Project 98 has a new setting Recently used file list: <n> entries in the Tools Options General Tab that controls the maximum number of files that can be listed on the MRU (Most Recently Used) list at the bottom of the File menu.
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The checkbox turns the MRU ON or OFF.

If the checkbox is checked, then a number between 1 and 9 can be specified for the number of entries.

The following table shows the types of naming syntax that can show up in the MRU, depending on how a project was opened.

Scenario
MRU List Display
Title Bar Text

A full project opened from an MPP file
FileBasename.mpp
FileBasename.mpp*

A full project opened from an ODBC database (via a machine DSN)
<Data Source Name>\ProjectName
ProjectName*

A full project opened from an ODBC database (via a file DSN)
<ODBC Driver Name>\ProjectName
ProjectName*

A full project opened from an MPD or MDB file
<FileBasename.ext>\ProjectName
ProjectName

A full project opened from a Microsoft Project 4.x/95 database
<Data Source Name>\ProjectName
ProjectName (Read-Only)

Opening a template (MPT) file
FileBasename.mpt
FileBasename

A selective import from a TXT, CSV, or XLS file
FileBasename.ext (MapName)
FileBasename

A selective import from an ODBC database (via a machine DSN)
<Data Source Name> (MapName)
Projectx (where x = next unused number)

A selective import from an ODBC database (via a file DSN)
< ODBC Driver Name > (MapName)
Projectx (where x = next unused number)

* 
In the case where two projects in different directories with the exact same name are opened, the full path is displayed in the title bar with the file name (once the second project is opened). In the case where two projects in different databases with the same project name are opened, (or when the same project is opened twice via two different DSNs), the data source name is displayed in the title bar with the project name (once the second project is opened).

Intellimouse

Microsoft Project 98 supports the wheel features of the Microsoft Intellimouse. The IntelliMouse comes with drivers that create new mouse wheel events. This section describes how Microsoft Project 98 responds to various wheel events.

The table lists the wheel events that Microsoft Project 98 supports, and the physical actions that generate the events.
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Wheel Event 
Action that causes it

Scroll
Roll the mouse wheel.

Pan
Hold wheel button down and drag the mouse pointer up, down, left or right. This produces continuous scrolling while you drag. Special home and directional pointer icons indicate that panning is active and the direction of the panning. For example, if you hold the wheel button down and drag to the right in the timescaled pane of the Gantt Chart view, then the following icons are displayed:
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Zoom
Hold the Control key down while rolling the wheel.

DataZoom
Hold the Shift key down while rolling the wheel.

The rest of this section describes how Microsoft Project 98 responds to the above wheel events, depending on what type of view is active.

Sheet views

The table describes the wheel behavior in sheet views, like Task Sheet, Resource Sheet, and sheet portions of combined views, like the left pane of Gantt and Usage views.

Event
Project Response

Scroll
Rolling the wheel scrolls the sheet as if you click the scroll bar arrow buttons.

Pan
If you click the wheel and drag left, right, up, or down, it scrolls the sheet continuously in that direction. If the view has a timescaled right pane, vertical scrolling the sheet also scrolls the timescale pane.

Zoom
Not supported.

DataZoom
If the data in the sheet supports outlining, such as in the Gantt, Task Usage, Resource Usage views, then DataZoom expands/collapses the selected record. 

Timescaled views

The table describes the wheel behavior in the timescaled pane of views such as Gantt, Usage, and Resource Graph. 

Event
Project Response

Scroll
The timescaled pane does not support the Scroll event directly, although it scrolls vertically when the left pane is a sheet that responds to a vertical Scroll event. 

Pan
If you click the wheel and drag left, right, up, or down, it scrolls the timescaled pane continuously in that direction. If the view has a sheet in the left pane, vertical scrolling the timescaled pane also scrolls the sheet pane.

Vertical panning of the timescale pane is not supported in the Resource Graph view.

Zoom
If the mouse pointer is in the timescale side of the view and you do a Control-roll, then it zooms the timescale as if you had pressed the Zoom In or Zoom Out buttons on the toolbar.

DataZoom
Same as Zoom.

PERT

The table describes the wheel behavior in the Pert view.

Event
Project Response

Scroll
Roll the wheel to scroll the sheet as if you clicked the corresponding vertical or horizontal scroll bar button.

Pan
If you click the wheel and drag left, right, up, or down, it scrolls the Pert view continuously in that direction. 

Zoom
If you do a Control-roll then it zooms the timescale as if you pressed the Zoom In or Zoom Out buttons on the toolbar.

DataZoom
DataZoom is the same as Zoom in the PERT.

Calendar

The table describes the wheel behavior in the Calendar view.

Event
Project Response

Scroll
Rolling the wheel vertically scrolls the Calendar vertically as if you clicked the corresponding vertical scroll bar button.

Pan
If you click the wheel and drag up or down, it scrolls the Pert view continuously in that direction. 

Zoom
If you do a Control-roll, then it changes the height of the date boxes as if you pressed the Zoom In or Zoom Out buttons on the toolbar.

DataZoom
DataZoom is the same as Zoom.

Forms (Task and Resource)

The table describes the wheel behavior in the Form views.

Event
Project Response

Scroll
Scrolling is support for navigating ahead and back through the records. It is the same as if you click the Next or Previous buttons in the form.

Pan
Not supported.

Zoom
Not supported.

DataZoom
Not supported.

Resource Graph

The Resource Graph view is made up of two areas: the resource name area in the left pane and the timescaled right pane.

The timescaled right pane behaves the same as any other timescaled view, except that vertical panning is not supported in the Resource Graph view. 

The resource name area in the left pane supports only the Scroll event that behaves as if you clicked the horizontal scroll bar button to move to the previous or next resource. This is similar to the Scroll event in Form views.

Task PERT

The Task Pert view supports only the Scroll event that behaves as if you clicked the horizontal scroll bar button to move to the previous or next task. This is similar to the Scroll event in Form views.

Print Preview

The table describes the wheel behavior in Print Preview:

Event
Project Response

Scroll
When in multi-page view, or when zoomed in on a single page, it is the same as clicking the arrow buttons on the vertical scroll bar.

In single page mode, it is the same as clicking the Up or Down buttons on the toolbar (to move between pages vertically).

Pan
When zoomed in on a single page, it is the same as if you click on the scroll bar buttons to scroll the page, except that when it reaches the end of a page, it jumps to the next page.

When in the non-zoomed single page mode, it is the same as if you click the Up, Down, Left, and Right buttons on the toolbar (to move between pages).

In multi-page mode, it is the same as if you click the arrow buttons on the vertical or horizontal scroll bar.

Zoom
Moves between zoomed in, single page, and multi-page views of the preview.

DataZoom
DataZoom is the same as Zoom.

Lesson 4.1 - Exercises

1.
How do you show or hide the View Bar?

2. 
What controls which icons are displayed on the View Bar and the order in which they are displayed? 

3. 
How are the following fields related to one another?

· Hyperlink Address

· Hyperlink SubAddress

· Hyperlink HREF

· Hyperlink

4. 
What is the effect of the Use relative path for hyperlink setting in the Insert Hyperlink dialog?

5. 
Describe several ways to create a hyperlink in Microsoft Project 98.

6. 
Microsoft Project 95 had a Customize Menu Bars command that could be used to create additional menu bars. How has this changed in Microsoft Project 98?

7. 
What is the single term used to describe the Menu Bar and all the toolbars in Microsoft Project 98?

8. 
What improvements have been made to the Edit Fill command in Microsoft Project 98?

9. 
Microsoft Project 95 had the Project Info command on the File menu. What is the equivalent command in Microsoft Project 98 and what menu is it on?

10. 
What menu contains commands for displaying the Task, Resource, or Assignment Information dialog (depending on the type of record that is selected)? 

11. 
What new view is on the Microsoft Project 98 default View menu?

In your opinion, which view on the Microsoft Project 98 default View menu has the same name as it did in Microsoft Project 95, but has undergone the most change?

12.  For each of the following Microsoft Project 98 menus or submenus, what items on the menu have no equivalent in Microsoft Project 95?

· Workgroup

· Resources

· Tracking

· Macro

· Customize

13. 
Microsoft Project 95 had the Sort, Filtered For, and Outlining commands on the Tools menu. What menu in Microsoft Project 98 has the equivalent commands?

14. 
What new buttons are on the Microsoft Project 98 Standard toolbar and what do they do?

15. 
The picture below shows the Multiple Projects submenu on the Tools menu in Microsoft Project 95. This submenu does not exist in Microsoft Project 98. For each of the five commands on the Microsoft Project 95 Multiple Projects submenu, is there an equivalent or improved feature in Microsoft Project 98, and if so, how can you access it? 
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16. 
What three new editing features are illustrated by the task Duration, Type, and Start fields?

17. 
Did Microsoft Project 95 have a search and replace feature for tables? What about Microsoft Project 98?

18. 
In what views can a nonsummary task have an outline symbol by its name that can be used to expand or collapse the records indented below it?

19. 
Which of the following Microsoft Project 98 dialogs have no equivalent in Microsoft Project 95?

A. Project Information

B. Task Information

C. Resource Information

D. Assignment Information

20. 
Does Microsoft Project 98 support the Microsoft Intellimouse wheel button?

21. 
What changes in Microsoft Project 98 are related to the Most Recently Used file list?

Lesson 4.1 - Lab

Experiment with the in-cell spinner, dropdown, and date picker controls.

If you have a Microsoft Intellimouse, experiment using the wheel button in different places in Microsoft Project 98.

Lesson 4.2: Customizing the User Interface

Some Topics to be introduced in this lesson include:

· Custom Fields and Aliases

· Customizing Menus and Toolbars

Custom Fields

New Custom Fields

In Microsoft Project 4.x, tasks had custom cost, duration, finish, flag, number, start, and text fields. Resources only had custom cost and text fields, and assignments had no custom fields.

In Microsoft Project 98, tasks, resources, and assignments all have the same set of custom fields. The number of custom fields increased and there are new Date custom fields. 

Note: Microsoft Project 98 custom fields are not used in the timephased portion of Usage views.

The table compares the custom fields in Project 95 to Microsoft Project 98:

Project 95 Task Custom Fields
Project 95 Resource Custom Fields
Microsoft Project 98 Task, Resource, and Assignment Custom Fields

Cost1-3
Cost1-3
Cost1-Cost10



Date1-Date10

Duration1-3

Duration1-Duration10

Finish1-5

Finish1-Finish10

Flag1-10

Flag1-Flag20

Number 1-5

Number1-Number20

Start1-5

Start1-Start10

Text1-10
Text1-5
Text1-Text30

Assignment Custom Fields

In the Task Usage view, tasks and assignments share the columns, and in the Resource Usage view, resources and assignments share columns. 
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There is only one assignment field with a given field name regardless of whether you access it in the Task Usage view or the Resource Usage view. For example, if you enter the word HELLO in the Text1 column for an assignment in the Task Usage view, then when you switch to the Resource Usage view, the word HELLO is also displayed in the Text1 column for that assignment. 

There may be some confusion when you look at shared assignment fields in the Usage views if a resource field and a task field with the same field name have different column Titles or aliases. For example, the Text1 field in the Task Usage view could be renamed Company and the Text1 field in the Resource Usage view could be renamed Department. Both of these fields still represent the assignment Text1 field.

Task Usage view
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Resource Usage view
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In the same way, there may be confusion if the same column title or alias is given to a resource field and a task field that do not have the same field name.

Renaming Custom Fields

Microsoft Project 98 also allows you to rename custom fields, although Project still knows the built-in field names. The new name for a renamed custom field is sometimes referred to as an alias.

Note: Even if you give a custom field an alias, you can still change the column Title in the Field Definition dialog.

To rename a custom field, use the Tools Customize Fields submenu command shown at the right.

This displays the Customize Field Names dialog shown.
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Customize Field Names dialog with the dropdown field list displayed...
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You can specify whether you want to rename Task or Resource custom fields. There is no choice for Assignment, since assignments share field columns with tasks or resources in the Task Usage or Resource Usage view.

To rename a custom field, you enter or select it from the dropdown list in a cell in the Original Name column and then enter the new name in the New Name column in that row. 

The grid in the Customize Field Names dialog sorts by the Original Name column each time the dialog is displayed.

To delete an alias, select a cell in that grid row and then use the Delete Row button or press the Delete Key. You can also enter the original name of the field in the New Name column. The next time you display the Customize Field Names dialog, that row will not be in the grid.

Two custom task fields cannot have the same alias.  Two custom resource fields cannot have the same alias.  A custom task field can have the same alias as a custom resource field.

Alerts are displayed in the following cases:

· If you enter a New Name which is already in use.

· If you enter a New Name which matches the name of an existing field.

· If you enter an Original Name that doesn’t exist.

· If you enter an Original Name for a Project field other than a custom field.

· If you specify an Original Name for a field that appears in another row in the Original Name column (for example, that already is renamed).

How custom field aliases are displayed

If a custom field has an alias, then the field is listed twice in most dropdown field lists in Project, once with its original name followed by its alias in parenthesis, and once with the alias followed by the original name in parenthesis. Field lists are automatically sorted so the two entries may not be consecutive. For example, if the Cost1 field is given the alias Building Misc. Cost, then it is listed twice in the Column Definition field list as shown in the picture at the right.
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When a custom field with an alias is listed twice in the Column Definition field list, the alias is displayed as the column title unless you enter something else for in the Column Definition Title field. It doesn't matter which of the two items you select from the field list. 

For example, if you select Cost1 (Building Misc. Cost) from the field list in the Column Definition dialog, and if you leave the Title field blank, then Building Misc. Cost is displayed as the header of that column as shown.
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Where custom field aliases are displayed

Custom field aliases are displayed in most field lists in Microsoft Project, including Workgroup messages.

Custom field aliases are not displayed in the following:

· Copy and Into dropdown lists in the Save Baseline dialog when the Save Interim Plan option is selected.

· Fields to check grid in the Tools Options Spelling Tab.

Inserted Projects

The custom field aliases defined in an inserted project are not used. Only the custom field aliases of the parent container project are used.

Customizing Menus and Toolbars

Microsoft Project 4.x has two default menu bars, Standard and Standard (no file). You can create or edit menu bars using the Tools Customize Menu Bars submenu command. Or you may right-click the menu bar and choose Customize Menu Bars. You can also create and edit toolbars. Menu bars and toolbars can be moved into MPP files in the Organizer, but cannot be displayed unless they are in Global.mpt.

Microsoft Project 98 has only one menu bar as do other Office applications. If you use the Tools Customize Toolbars submenu command to display the Customize dialog, the one and only menu bar is listed under the Toolbars Tab as "Menu Bar." The Menu Bar is customizable (menu commands and submenu commands can be added, removed, renamed and so on), but there is no command like the Microsoft Project 4.x Customize Menu Bars command to create additional menu bars. Likewise, there is no Menu Bars Tab in the Microsoft Project 98 Organizer (there is still a Toolbars Tab). You can create additional toolbars.

In Microsoft Project 98, the single Menu Bar and all of the toolbars are called CommandBars.

The Menu Bar and toolbars are customized in the Customize dialog. To display the Customize dialog, you can use the Toolbars command on the Tools Customize submenu. Or, you may right-click the Menu Bar or toolbar and use the Customize command on the shortcut menu.

Customize dialog Toolbars Tab

The Toolbars Tab allows you to control which toolbars are displayed, and to created new toolbars.

[image: image313.png]Toolbars | Commands | options |

Tookars:
™ Meru Bar
¥ standard

¥ Formating e

™ custom Forms i

I oraving =

I Microsoft project 95 P
I Resource Hanagerert

I Tackng ]
I visul e

et

™ vorkaroup

I analyss
I PERT analyss





The first item in the Customize Toolbars Tab represents the one and only one Menu Bar allowed in Microsoft Project 98. You cannot uncheck it.

The first eleven items are built into Microsoft Project 98 and cannot be renamed or deleted. They can be modified. The Reset button can only be used to restore the Menu Bar and built-in toolbars to their original states.

The Analysis and Pert Analysis toolbars are in the Microsoft Project 98 Global.mpt file, but you can rename or delete them from Global.mpt.

The New button can be used to create additional toolbars, but not menu bars. Click it to name the new toolbar.  You still must use the Commands Tab to add commands to it.

You may use the Rename and Delete buttons to rename or delete any custom toolbar. This includes the Analysis and Pert Analysis toolbars that are in the Global.mpt when Microsoft Project 98 is first installed.

Customize dialog Commands Tab

The Commands Tab is used to add items to existing menus or toolbars, and to create new menu headers on the Menu Bar or toolbars (not to create new menu bars).
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The Categories list groups the items displayed in the Commands list. For example, if File is selected in the Categories list, then only commands related to the File menu are listed in the Commands list.

Built-in Menus category

If the Built-in Menus item is selected in the Categories list, then the Commands list displays a list of built-in menus as shown:
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This category holds all of the default menus and submenus. This allows you to restore a menu if it is deleted. Note that the menu here is a mirror of the one actually displayed. For example, if you add a command to the File menu and then drag the File menu from the Built-in Menus category, it will also have the new command. But, if you delete the File menu, you can restore it by dragging from this category. You can reset it to the original state by choosing Reset from the context menu.

The items in the Commands list when the Built-in Menus category is selected are shown  (in a multicolumn list to save space):

File
Format
Filtered for: [Current Filter]

Send To
Details
Outline

Edit
Drawing
Window

Fill
Tools
Help

Clear
Workgroup
Microsoft on the Web

[OLE Object]Object
Resources


View
Macro


Table: [Current Table]
Customize


Toolbars
Project


Insert
Sort


Special Items category

The Special Items category holds special elements which can be added to a menu such as the Window list which lists all the open windows, the MRU list, and so on.
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The items in the Commands list when the Special Items category is selected are shown  (in a multicolumn list to save space):

[Task Views]
[Sorts]
[Recently Used Files]

[Resource Views]
[Macros]
[Windows]

[Views]
[Custom Forms]
[OLE Actions]

[Tables]
[Form View Formats]


[Filters]
[Toolbars]


New Menu category

The new menu category is used to add a new menu to Menu Bar or to a toolbar. To do this, drag the New Menu item from the Commands list and drop it on the Menu Bar or a toolbar.

[image: image317.png]Categories:

‘Commands:

raving
it
Uity
Tracking
4l Commands
il Macros

il Forms
Buit-in Menus
Special Iems

|

New Menu

o=




Customize dialog Options Tab

The Options Tab allows you to control various display settings related to toolbars and the Menu Bar.
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How to Create/Modify the Menu Bar and Toolbars

The table shows how to create or modify the Menu Bar or a toolbar.

Desired Result...
How to do it...

Create a new toolbar
Use the New button in the Customize dialog Toolbars Tab. This creates a blank floating toolbar.

Delete or rename a toolbar
Use the Delete or Rename button in the Customize dialog Toolbars Tab. The built-in items (the first eleven items) cannot be renamed or deleted.

Show or hide a toolbar
Check or uncheck the toolbar in the Customize dialog Toolbars Tab.

Add a command to the Menu Bar or to a toolbar, or to a menu or submenu that is on the Menu Bar or a toolbar.
Use the Customize dialog Commands Tab. Select a category in the Categories list and then drag an item from the Commands list and drop in on the desired location. 

To add items to a menu or submenu, use the mouse to expose the menu or submenu first.

Remove a command from the Menu Bar or a toolbar, or from a menu or submenu that is on the Menu Bar or a toolbar.
Display the Customize dialog (it doesn't matter what Tab) and then drag the item you want to remove off of the Menu Bar, toolbar, menu or submenu.

To remove items from a menu or submenu, use the mouse to expose the menu or submenu first.

Assign/unassign a macro to a command on the Menu Bar or to a toolbar, or on a menu or submenu that is on the Menu Bar or a toolbar.

(Or find out what macro is already assigned).
Right-click the command and then click Assign Macro from the shortcut menu.

To assign a macro to a command on a menu or submenu, use the mouse to expose the menu or submenu first.

Rename a command on the Menu Bar or a toolbar or on a menu or submenu that is on the Menu Bar or a toolbar.
Right-click the command and then edit the Name property on the shortcut menu.

To rename a command on a menu or submenu, use the mouse to expose the menu or submenu first.

Rearrange/reorder toolbars or commands on the Menu Bar or on a toolbar, or on a menu or submenu that is on the Menu Bar or a toolbar.
Display the Customize dialog (it doesn't matter what Tab) and then drag the items to rearrange them.

To rearrange items on a menu or submenu, use the mouse to expose the menu or submenu first.

Control the formatting of the menu, submenu, or button.

This includes button faces and menu dividers.
Right-click the menu, toolbar button, or command on a menu, submenu, or toolbar. Then use the properties on the shortcut menu.

To edit the properties of an item on a menu or submenu, use the mouse to expose the menu or submenu first.

Customizing commands with the shortcut menu...
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Lesson 4.2 - Exercises

1.
What types of custom fields in Microsoft Project 98 did not exist in Microsoft Project 95?

2.
What is the difference between changing a field Title and giving it an alias (in the Customize Field Names dialog)?

Lesson 4.2 - Lab

In this lab you will customize the Menu Bar.

1.
Create a new menu called PasteOptions on the Menu Bar. Add the following commands to the PasteOptions menu: 

· Paste

· Paste Special...

· Paste as Hyperlink.

2.
Copy a cell containing text from a Microsoft Excel worksheet, and paste it into appropriate places in Microsoft Project using each of the commands on the PasteOptions menu that you created.

3.
Remove the PasteOptions menu from the Menu Bar.

4.
Add the three paste commands listed in step 1 to the right hand end of the Standard toolbar, using appropriate text on the buttons. Is it possible to paste a picture onto a toolbar button?

5.
Create a new toolbar called PasteOptions and put the above three paste commands on it.

Lesson 4.3: Formatting Improvements

Some Topics to be introduced in this lesson include:

· Rich Edit Features in Notes, Header, Footer, and Legend

· New Timescale Units: Half Years and Thirds of Months

· New Duration Label Formatting and intelligent entry

· Alignment of Column Titles independent from data alignment

Rich Edit Features

Rich Edit features include the ability to do the following:

· Format selected text: Includes control of the font, font size, bold, italic, underline, and color properties. The default text is Arial 8, with no other formatting. 

· Format paragraphs: Includes control of alignment (left, center, right) and simple bulleted lists (there is only one bullet format available).

· Insert objects/pictures: Includes embedding and linking.

· Drag and drop: Includes drag and drop of selected text, pictures, or objects within the edit area, or from the edit area to the outside, or from the outside into the edit area.

Rich Edit is sometimes referred to as RTF (Rich Text Format).

Rich Edit in Microsoft Project 98...
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Microsoft Project 98 supports Rich Edit features in the following places:

· Notes area in the Task Information, Resource Information, and Assignment Information dialogs Notes Tab. The Information dialogs can be displayed if you double-click a task, resource, or assignment record in a view with a task or resource table (assignment records can only be accessed in the Task Usage and Resource Usage views).

· Notes area in the Task and Resource Form views formatted to display Notes (right-click the form and select Notes).

· Page Setup dialog: Header, Footer, and Legend tabs (it's the legend text area in the Legend Tab). Exception: Pictures can be inserted in headers, footer, and legends, but not in embedded or linked objects such as Microsoft Excel Worksheet objects.

The above locations are the only places in Microsoft Project 98 that support the Rich Edit features. 

The next two sections discuss special issues that arise in some locations that do not support Rich Edit. 

Comments area in the File Properties dialog Summary Tab

Rich Edit formatting in the Notes for the Project Summary Task (in the Task Form or Task Information dialog) are lost if you make changes to any of the following controls in the Properties Summary Tab: Title, Subject, Author, Keywords, Comments, or the Save preview picture checkbox. There are NO WARNINGS.

No Rich Edit features in the Comments field in the File Properties Summary Tab...
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Notes field in a Task or Resource table

The Notes field in a task or resource table is referred to as Sheet Notes. Notes entered in an Information dialog Notes Tab or the Notes area of a Form view is called Rich Edit Notes. Sheet Notes do not support Rich Edit features, but they do support per cell Font formatting and per category Text Styles formatting like other sheet fields. Sheet Notes only show up to 255 characters (including room for ellipses...) or up to the first hard return. Sheet Notes formatting is independent of Rich Edit Notes formatting. Any objects or pictures inserted in Rich Edit Notes are not displayed in the corresponding Sheet Notes.

If you edit the Sheet Notes for a task, resource, or assignment in a task or resource table (in views such as the Gantt Chart and Task/Resource Usage), you lose Rich Edit formatting in the Information dialog Notes Tab, or the Task/Resource Form, with details set to Notes. You receive a warning if the corresponding Rich Edit notes (in the Information dialog Notes Tab) contain objects or pictures, but there is no warning if it just contains rich text formatting.

Edits to sheet notes removes object and formats from Rich Edit Notes...
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Alert when you edit sheet Notes if the Rich Edit Notes contains objects or pictures...
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Copying Sheet Notes

If you copy Sheet Notes individually or as part of a block of cells in a table and paste them elsewhere in the same project or in another project, the corresponding Rich Edit Notes are not copied.

Rich Edit Notes are copied if you copy entire table record (click the cell in the locked first column of the table).

Shortcut Menu

Right-click the Rich Edit Notes in an Information dialog Notes Tab or a Task/Resource Form Notes area to display the Rich Edit shortcut menu. 

Rich Edit shortcut menu...
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Paste Special can be used to paste pictures and text, but not objects. To paste objects, use the Ctrl+V keys. This works if the default clipboard format is object. Ctrl+V works for to copy data from Microsoft Word or Excel and to paste the data as an object instead of text.

To insert a new object or an object based on an existing file, use the Object command on the shortcut menu or the Insert Object tool on the Rich Edit toolbar.

Keyboard Interface

The tables list some of the key combinations for formatting and altering Rich Edit data.

Formatting Text
Keys

Bold
Ctrl+B

Italic
Ctrl+I

Underline
Ctrl+U

Left Align
Ctrl+L

Center Align
Ctrl+E

Right Align
Ctrl+R

Bullet Style
Ctrl + Shift + L

Altering Text Operation
Keys

Delete One Character to Left
BACKSPACE (Delete on MAC)

Delete One Word to Left
Ctrl + BACKSPACE

Delete One Character to Right
DEL

Delete One Word to Right
Ctrl + DEL

Cut
Ctrl+X or

Shift+DEL (on Win Only)

Copy
Ctrl+C or

Ctrl + INS (on Win Only)

Paste
Ctrl+V or

Shift + INS (on Win Only)

Drag and Drop Behavior

You can drag and drop selected text, pictures, or objects within the edit area or from the edit area to the outside or from the outside into the edit area.

A special behavior occurs when you drag data from the Notes area of a Task or Resource Form. It any edits are pending, the drag automatically clicks the OK button for you (displaying the Previous/Next buttons briefly), saves the changes, and then displays the OK/Cancel buttons again.

Activating objects

To activate embedded objects in Rich Edit Notes, double-click the object. 

The Task or Resource Form Notes area is an in-place container, but the Notes Tab in an Information dialog is not. The Notes Tab in an Information dialog always opens the object in a separate application window.

Proofing Tools

The Spelling tool checks text in Rich Edit Notes, but not in headers, footers, and legends.

The AutoCorrect tool does not check Rich Edit Notes or headers, footers, or legends.

Printing Rich Edit Notes

Printing a view with Rich Edit Notes

To include Rich Edit Notes when printing a view, select the Print notes option in the Page Setup View Tab. The notes start printing on a new page after the view prints.

Printing the Task Usage view includes task and assignment notes. Printing a non-Usage task view only prints task notes.

Printing the Resource Usage view includes resource and assignment notes. . Printing a non-Usage resource view only prints resource notes.
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Print Preview of the Rich Edit Notes page after the Gantt Chart pages...
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Printing Rich Edit Notes with a Report

To include task and/or assignment Rich Edit Notes in a Task Report, select the Task and/or Assignment Notes option(s) in the Task Report Details Tab. The notes are grouped with the corresponding task in the printout.
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Note: The Objects option in the Report Details Tab is for printing objects in the Task Form Object area. It is independent of objects in Rich Edit Notes.

  Print Preview of a Task Report with task and assignment notes...

[image: image328.png]D Task Name Duration Start Finish Resource Names
1 T 3 days Fri 81197 Tuedisis7  R1R2
T [ Reveure Wawe | Ui | Wark | Ovi Werk | Bavefine Wark | Avt Wark | Fem Wark
A T00% | 27he Thrs Thrs Thr Era
2 | &2 100% | 20ms ons ons ons 20hes

Assignn ent Wotes
G

QThese are the Rich Edit Notes for
assignment R1onT1

Assignn ent Notes
A2

QThese are the Rich Edit Notes for
assignment R2on T1

tes

QThese are the Rich Edit Notes fortask T1

T2 1 day Frigi/a7 Frigi/e7  R2ZR3





New Timescale Units

Microsoft Project 98 introduces two new timescale units for use with timescaled views such as the Gantt Chart and the Usage views:

· Half Years

· Thirds of  Months

These new units can be used with the major or minor timescale. Each has a corresponding set of new label choices.

In the picture, the Minor scale is set to use the new Half Years units, and the default label is currently selected. Some of the label choices for the Half Years units are shown in the Label dropdown list.

New timescale Half Years unit...
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The picture to the right is a sample Gantt Chart using the Half Years timescale units with the label shown above.
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In the next picture, the Minor scale is set to use the new Thirds of Months units, and the default label is currently selected. Some of the label choices for the Thirds of Months units are shown in the Label dropdown list.

New timescale Thirds of Months unit...

[image: image331.png]Tinescale

Major scale

|

Minor scale

kst [t

Uats: [Thrcsof orshs ] cowts [1 =

Beginning, Midde, End,

Warch] !/1 U1, 121,

B[ M| 1

January Beginning, January Midde,
an 1, Jan 11, Jan21,

Lobel:[Januery | bl
algn: [t o] mickines Algn:
[ember [December [January [ February
MIE[B[M[E[B[M|E[B[MI[E
Enlarge: [100 2] % ¥ scale separator

111497, 111/57, 1j24/57,





The picture to the right is a sample Gantt Chart using the Thirds of Months timescale units with the label shown above.
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Zoom In and Zoom Out

The table below shows the effect of the Zoom In and Zoom Out tools on the new timescale units when it is the minor or only timescale.

Timescale Units
[image: image333.bmp]  Zoom In
[image: image334.bmp]  Zoom Out

Half Years
Quarters
Not supported

Thirds of Months
Weeks
Months

New Duration Label Formatting

Accepted duration labels during data entry

Microsoft Project 4.x

In Microsoft Project 4.x, if you include a duration label when you enter a value in the duration field, the label can only be one of the following single characters: m (for minutes), h (for hours), d (for days), or w (for weeks). You can include spaces between the number and the label, but not before the number or after the label. If you don't enter a label, it uses the Show Duration In setting in the Tools Options Schedule Tab.  

So in Microsoft Project 4.x, you would get an error if you tried to enter natural language expressions like 5 days or 3 minutes in the Duration field.

Microsoft Project 98

Microsoft Project 98 has an expanded set of labels that it can use to display duration, work, and cost rate type fields. It allows you to enter values with any of the predefined labels and then converts them to the current label settings in the Tools Options Edit Tab.

Tools Options Edit Tab...
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Note: The settings in the Edit Tab are for formatting purposes only. The settings for the default duration and work units are still in the Schedule Tab.

The choices available for each of the above time label settings is listed in the table.

Setting
Choices

Minutes as
m, min, minute

Hours as
h, hr, hour

Days as
d, dy, day

Weeks as
w, wk, week

Years as
y, yr, year

The following formatting conversions take place during data entry in a duration, work, or cost rate type field:

· If you enter an "s" (for plural) at the end of one of the multiple character labels, it accepts it and automatically drops the "s" if the value is 1.  It doesn't accept an "s" at the end of a single character choice such as h (for example, if you enter "hs" you will get an error message).

· Any spaces entered before or after any of the distinct parts of the expression are removed. If the field is a duration or work type field, it then adds a single space between the number and label if the Add space before label setting is selected in the Tools Options Edit Tab (no spaces are used for cost rate fields like Standard Rate).

· If you enter an "e" for elapsed time, then an "e" is added to the front of the appropriate format.

Example

This example shows some of the conversions that take place during data entry in duration, work, and cost rate type fields. The following settings in the Tools Options Edit Tab are used for this example.
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The table shows various expression entered and the resulting expression displayed.

What is Entered
What is Displayed

1d
1day

2d
2days

3week
3weeks

4 ehours
4ehr

0.4 hours
0.4hr

0.5 weeks
0.5weeks

0min
0min

$30,000/year
$30,000/y

Alignment of Column Titles

In Microsoft Project 4.x, column titles in task and resource tables were automatically aligned based on the Align setting you chose for the column. The column titles could not be aligned independently of the data in the column. 

In Microsoft Project 98, column titles can be aligned independent of the data in the column. In the Table Definition dialog and in the Column Definition dialog, the Align setting from Microsoft Project 4.x is renamed as Align Data, and a new setting is added called Align Title.

To display the Table Definition dialog, from the View menu click Tables, then click More Tables, then click the Edit button. To display the Column Definition dialog, double-click the column title.

The pictures compare these dialogs in Microsoft Project 98 versus Microsoft Project 4.x.

Microsoft Project 98 Table Definition dialog...
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Microsoft Project 98 Column Definition dialog...
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Microsoft Project 4.x Table Definition dialog...
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Microsoft Project 4.x Column Definition dialog...
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Lesson 4.3 - Exercises

1.
What is the new Rich Edit features in Microsoft Project 98?

Where in Microsoft Project 98 are these features supported?

2.
What Rich Edit feature is supported in the Information dialog Notes tabs, but not in the Page Setup Header, Footer, and Legend tabs?

3.
If you use Rich Edit features in the Task Information Notes tab for a task, and then edit the notes for that task in the Notes field in a task table, what happens to the Rich Edit formatting?  

Does Microsoft Project behave differently depending on whether or not the Notes tab included objects or pictures?

4.
Is Rich Edit formatting copied when you copy an individual cell in a task table?  What about copying an entire task record (by clicking the locked cell in the first column before copying)?

5.
Does the Task Information Notes tab support in-place editing of objects associated with in-place servers?

6.
Which places in Microsoft Project support Rich Edit features but are not checked by the Spell Checker?

7.
Give an example in which Rich Edit notes print on separate pages after the main printout.

Give an example in which Rich Edit notes print as part of blocks of information for individual tasks.

8.
What new Units formats are available in the Microsoft Project 98 Timescale dialog?

9.
What happens in Microsoft Project 98 if you enter 1 days in the Duration field for a nonsummary task?  What about Microsoft Project 95?

10.
What new formatting feature is available in the Microsoft Project 98 Column Definition dialog?

11.
What tab in the Tools Options dialog has settings that determine how minutes, hours, days, weeks and years are displayed? Which places and fields in Microsoft Project respond to these settings?

Lesson 4.3 - Labs

Lesson 4.3 - Lab 1

Enter a task in a new project and in the Task Information dialog Notes tab for the task, create Rich Edit notes similar to the information shown below:
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All the items in the notes are formatted text, except for the embedded Microsoft Excel 97 range of cells, and the picture of the Microsoft Project icon. You can use a different small picture if you like. Use the color red for the word Example and the middle line (So is ...). Use blue for the phrase Rich Edit features.

Try double clicking the embedded worksheet.

Lesson 4.3 - Lab 2

Create a project and a Task Report that looks like the following when the report is previewed:
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The project should have one task and two resources assigned to the task as shown in the report above. Create the appropriate notes as shown in the report. You may use a different small picture if you like. 

Lesson 4.4: Filter Improvements and AutoFilter

Some Topics to be introduced in this lesson include:

· Grouping conditions in filters

· And before Or

· Filters in Usage Views

· Interaction between AutoFilter and the active named filter

· Where the state of AutoFilter is stored

· AutoFilter custom condition

· Saving an AutoFilter as a named filter

New Microsoft Project 98 Filter Features

In Microsoft Project 98, the Filter submenu is moved to the Project menu (it was on the Tools menu in Microsoft Project 4.x). The Filter submenu and the default Formatting toolbar include a new AutoFilter command. 

Filter submenu on the Project menu...
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The More Filters dialog in Microsoft Project 98 is similar to the one in Microsoft Project 4.x.
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The New, Edit, and Copy buttons display the Filter Definition dialog. 

Improved Filter Dialog
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The improvements to the interface and filter features available in the Microsoft Project 98 Filter Definition dialog as listed:

· And/Or is the first column instead of the last. The first 

· Conditions can be grouped to one level (there was no grouping in Microsoft Project 4.x). For example, you can use And/Or operators between groups. 

And has a higher precedence than Or both within groups and between them. The evaluations occur in the following order:

First, each group is evaluated separately. Within a group, conditions joined by And are evaluated before conditions joined by Or. 

Next each consecutive set of high-level And operators is applied to the above results, followed by the high-level Or operators.

Note: A Microsoft Project 4.x filter is similar to a Microsoft Project 98 filter with just a single group. However, they are not evaluated the same and may produce different results, because Microsoft Project 4.x evaluated the conditions sequentially, whereas Microsoft Project 98 evaluates the And's first and then the Or's.

· The And/Or, Field Name, Test, and Values(s) columns use the new dropdown controls.

· The dropdown list in the Test column uses more descriptive tests.

Explicitly grouping conditions

The Filter Definition dialog allows one level of condition grouping. Two groups are separated by a shaded row containing only an And or Or, with the other columns blank. The operators that are on a row by themselves are sometimes referred to as high-level operators or outdented operators.

To create filter grouping, separate the condition groups with a row that is blank except for an And/Or operator. When you click off of that row, the operator is automatically outdented and the row is shaded.

Each group of conditions between high-level operators behaves as if the group was enclosed in parenthesis in a logical expression. 

Several of the predefined filters that are included with Microsoft Project 98 use grouped conditions. The 'Late/Overbudget Task Assigned To...'  is shown:
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Example

This example illustrates how the new Microsoft Project 98 filter features make it possible to create filters that can not be created in Microsoft Project 4.x. The picture shows such filter:

No Microsoft Project 4.x filter can be created that is equivalent to this Microsoft Project 98 filter...

[image: image347.png]tr Definition in "Pig8FilterT est].mpp’
Mame: | Project 98 Test Filter 4 IV show in menu
e
cron | _cooyron | | M| |
andjor Fid e [ Tost T VA
et s I
o o2 cads )
nd
Teas cads
or free s

™ Show related summary raws

cancel





The above filter definition is equivalent to the following logical expression:

(Text1="x" Or Text2="x") And (Text3="x" Or Text4="x")

The picture shows a Project 95 filter that is similar to the Microsoft Project 98 filter above, but that functions differently:
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However, the Project 95 filter above is equivalent to the following logical expression:

[ (Text1="x" Or Text2="x") And Text3="x" ]  Or   Text4="x"

Example

Part A in this example illustrates the difference in how Microsoft Project 4.x and Microsoft Project 98 evaluate a sequence of And/Or operators within a single group (Project 95 didn't have grouping, so it behaved like a single group). 

In Part A, the new Microsoft Project 98 feature that allows operators between groups is not used. 

In Part B, the new Microsoft Project 98 filter grouping feature is used to make a filter behave differently.

A.
The pictures show a filter definition in Project 95 and one in Microsoft Project 98 that appears to be equivalent but is not.

Project 95 Test filter definition...
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Project 95 filters evaluates conditions in the order they are listed, so the Project 95 filter above is equivalent to the following logical expression:

(Text1="x" Or Text2="x") And Text3="x"

Microsoft Project 98 Test filter definition...
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Microsoft Project 98 filters evaluate all And's within a group first and then the Or's, so the Microsoft Project 98 filter above is equivalent to the following logical expression:

Text1="x" Or (Text2="x" And Text3="x")

The filters above are applied to the data shown in the first picture. The second and third pictures shown the filtered results using the above Project 95 and Microsoft Project 98 filters.

Original unfiltered tasks...

[image: image351.png]



Project 95 filtered results...
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(Text1="x" Or Text2="x") And Text3="x"
Microsoft Project 98 filtered results...

[image: image353.png]Name | Text1 | Text2 | Texts

o X x
S x

™ x x
Tk x

T x x x




Text1="x" Or (Text2="x" And Text3="x")

The results differ because Project 95 always evaluates the conditions sequentially from top to bottom, whereas Microsoft Project 98 evaluates And's first then Or's within a group. 

For example T5 does not satisfy the Project 95 filter:

(Text1="x" Or Text2="x") And Text3="x"

(    True  Or    False ) And    False

           True          And    False

  


      False 

However, using the Microsoft Project 98 logic, T5 does satisfy the Microsoft Project 98 filter:

     Text1="x" Or (Text2="x" And Text3="x")

     True  Or (   False  And    False )

     True  Or           False

           True   
If you want to force the

B.
The next picture shows how to use the new Microsoft Project 98 group filter to make a filter that behave like the above Project 95 one, for example, so it is equivalent to 

(Text1="x" Or Text2="x") And Text3="x"

Microsoft Project 98 filter using the new grouping feature...
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Unnecessary operators are discarded

Because And/Or is the first column in the Microsoft Project 98 Filter Definition dialog, there shouldn't be an operator specified for the first row. If you specify one, it is discarded when you click OK.

Similarly, if you use a high-level operator to connect two groups, then the row below the shaded row shouldn't have an operator. If you specify one, it is discarded when you click OK.

Filter Definition dialog with unnecessary operators...
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Unnecessary operators are discarded after you click OK and then display the dialog again....
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Filters in Usage Views

Task filters can be applied in Task Usage views, and resource filters can be applied in Resource Usage views. 

Assignment records share the task or resource columns in a Usage view and are subject to evaluation by filters.

In Usage views, assignment records share many fields with tasks or resources, for example the Start and Finish fields. Some fields such as % Complete and Duration are not used by assignments (they are blank for assignment records). Some fields are Assignment-only fields such as Assignment Units  (these fields are blank for task and resource records). 

There is a special Yes/No field called Assignment that can be used in filter definitions to control whether assignments should be displayed by the filter, and to define conditions that you want to apply only to assignment records. The Completed Tasks filter definition shown at the start of this section uses the Assignment field.

AutoFilter

Microsoft Project 98 has an AutoFilter feature similar to the one in Microsoft Excel. You access it by using the AutoFilter toggle command on the toolbar or on the bottom of the Filtered for submenu:
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When AutoFilter is active, there is a dropdown list of choices beside the title of each field in the current task or resource table.

New AutoFilter feature in Microsoft Project 98...
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AutoFilter works with any field displayed in a table except the Indicators field and the first column if it is locked. Selecting items from one or more title dropdowns is equivalent to applying a named filter with a series of And conditions.

Interaction between AutoFilter and the active named filter

When the AutoFilter is active, it is used in addition to the current active named filter. For example, it does an And operation with the results of the current named filer. Named filters are the ones that are listed in the filter dropdown list on the toolbar and also in the More Filters dialog (accessed from the Filtered for submenu).
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Switching do a different named filter has no effect on the choices already selected from the various AutoFilter choice lists, except for the following special cases:

The All Tasks and All Resources named filters have a special behavior when you apply them: They resets all AutoFilter settings to All, instead of doing an And operation with the current AutoFilter settings

AutoFilter also inherits the Highlight mode and the Show related summary rows from the active named filter. 

A named filter is in highlight mode if you select it and click the Highlight button in the More Filters dialog (displayed by choosing More Filters from the Filtered for submenu). In Highlight mode, all rows are displayed, and the ones that satisfy the filter conditions use the special Highlighted Tasks or Highlighted Resources font defined in the Text Styles dialog (displayed from the Format menu). Custom fonts applied to specific cells override the Highlight font.
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The Show related summary rows option is available in the Filter Definition dialog (displayed by clicking the New, Edit, or Copy buttons in the More Filters dialog).
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The special All Tasks and All Resources filters cannot be edited. They always show related summary rows. If you do not want AutoFilter to show related summary rows, you will have to apply some other filter that has Show related summary rows unchecked.

Note: Although you cannot display the Filter Definition for the All Tasks/Resources filters, you could make your own named filter that behaves like the All Tasks/Resources filters so that you could access the Show related summary rows in the Filter Definition dialog. For example, you could define a task/resource filter with the condition that Start does not equal NA. All tasks/resources and assignments satisfy this. If you uncheck Show related summary rows in the Filter Definition and apply this named filter, then when you apply AutoFilter, related summary rows will not be shown (unless they happen to satisfy the AutoFilter condition too).

Where the state of AutoFilter is stored

AutoFilter is on (active) in all sheet views in a project, or off (inactive) in all sheet views in a project (sheet views are the ones with a task or resource table). For example, you cannot have AutoFilter on in the Gantt view and off in the Resource Sheet view. 

If a project had AutoFilter on when it was saved and closed, then when the file is reopened, it has the same AutoFilter settings it had when last saved.

The current choices selected from the various title dropdown lists are view-specific. For example, what you select from the Text1 title dropdown in the Gantt view has no effect on what is selected in the Text1 title dropdown in the Task Sheet view.

AutoFilter dropdown choices

There are three kinds of choices available in the AutoFilter dropdown choice list for each field :

· The entries (All) and (Custom...) 

· A list of predefined choices specific to the field type.

· A unique sorted list that contains the current filtered contents of the field, without duplicates. 

The contents included in the AutoFilter choice list for a specific field is limited to contents from those records that satisfy the current named filter and AutoFilter choices for all other fields.

· If filters are already applied, only the contents of the records that are showing are included.

Note: Not all of the fields have all of the above kinds of choices available.

Example

The picture shows the contents of the Actual Start field, and the picture on the right shows its AutoFilter choices. 
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The (All) choice is scrolled out of view in the above picture. Only ten choices fit into the visible part of the dropdown. You must scroll to see the rest of the choices.

The entries (All) and (Custom...) are available on the AutoFilter list of choices for any field that has the dropdown displayed by its title (for example, for all unlocked fields except the Indictors field).

The table shows the AutoFilter pre-defined choices specific to various types of fields. 

AutoFilter redefined choices depend on the field type...

Type of Field
AutoFilter Pre-defined Choices

Currency 

Includes all fields that display only currency values.

(includes Cost1, ..., Cost10)
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Scheduled and Baseline Start/Finish
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Actual Start/Finish
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Duration

Includes Actual, Scheduled, and Baseline Duration.

(includes Duration1, ..., Duration10)
[image: image367.png]




% Complete and % Work Complete
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The following fields and types of fields do not have any pre-defined choices (other than All and Custom):

· Date1, ..., Date10

· Text1, ..., Text30

· Number1, ..., Number20

· Work field types (Work, Actual Work, Baseline Work)

· Priority

· Yes/No fields such as Flag1, Critical, Milestone an so on.

Comma separated fields

For comma separated fields such as the task Resource Names field and Predecessors field, each item in the comma separated list in the cell for a specific record is listed separately in the AutoFilter list of choices. If you select a resource name from the AutoFilter choice list, it matches all records that have that include that resource name in the Resource Names field. However, for other fields such as the Predecessors field, selecting a choice from the AutoFilter choice list matches only records that have that single entry.

All of the items in the comma separated list are included in the AutoFilter choice list, even if they don't all fit into the field. For example, if the Resource Names field for a particular task is too long, it is displayed truncated followed by ellipses (...), but all the resources assigned to the task are listed separately in the AutoFilter choice list, including the ones that didn't fit into the Resource Names column for the task.

Example

The table shows examples of the Predecessors and Resource Names fields and their AutoFilter choices.

Field Contents
Corresponding AutoFilter choices
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Using AutoFilter on multiple fields

Selecting something other than All from the AutoFilter choice list for more than one field behaves like a sequence of And operations. 

The contents listed on the AutoFilter choice list for a given field is limited only to records that are still showing. Selecting a choice for one field may hide some records, indirectly limiting the choices on the AutoFilter choice list for other fields.

Example

The table illustrates the use of AutoFilter with multiple fields and how it effects the choices available on the AutoFilter choice lists.

Records showing
Duration Choices
Resource Names choices

No filters applied originally (for example, just All Tasks)...
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After selecting 1 day for the AutoFilter Duration choice list...
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Next Bob is selected from the AutoFilter Resource Names choice list...
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Highlighted column titles

When you select a choice other than All from the AutoFilter choice list for a column, the column title changes color so you can tell which columns are currently controlling the AutoFilter filtering process. See the examples above.

The function of the '(Custom...)' choice in AutoFilter

(Custom...) is a choice on all AutoFilter choice lists. If you click it, then it displays the Custom dialog illustrated in the picture:

'(Custom)' choice displays the Custom AutoFilter dialog...

[image: image382.png]Shaw raws uhere:

Ouaton
et ENE] | |

cod o _swen. |





The currently defined conditions for the field is displayed in the dialog. 

It allows you to defined two conditions on the same field joined by And or Or. It does allow you to defined conditions on other fields.

Saving the AutoFilter choices as a named filter

The Save button is used to save the current AutoFilter choices for all fields into a single named filter. It gives the new filter a default name in the same way it does if you click the New button in the More  Filters dialog. For each field that currently has an AutoFilter choice other than All, it creates a condition. All the conditions are separated by a high-level And operator. You can modify the filter definition if desired. 

Custom AutoFilter Save button displays the Filter Definition dialog with appropriate conditions already defined...
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When either of the above selections are made, the New/Edit Filter dialog is displayed (the same dialog as Tools Filtered For: More Filters New.../Edit...)

Refreshing AutoFilter and named filters

If you change data while a named filter (other than All Tasks/Resources) is active or while AutoFilter is active with at least one choice other than All, then the record you edit may no longer satisfy the combined filter. This does not automatically cause the filters to recalculate. 

You can force all active filters to recalculate by doing either of the following:

· Reapply the current named filter. Note the exception. 

The All Tasks and All Resources named filters have a special behavior when you apply them: They resets all AutoFilter settings to All, instead of doing an And operation with the current AutoFilter settings

· Click the dropdown arrow on any AutoFilter choice list to display the list, then click again to close the list.

Resetting AutoFilter settings (to All)

You can reset all AutoFilter choices to All by doing any of the following:

· For each field that is changed (the ones with the highlighted titles), choose All from its AutoFilter choice list.

· Click the AutoFilter toggle button on the toolbar to turn it off and then click it again to turn it back on.

· Apply the All Tasks or All Resources named filter.

Keyboard access to the AutoFilter choice lists

To drop down the AutoFilter list for a specific column using the keyboard, first move the cursor to any cell in that column, then press the Control + Spacebar key combination, and then press ALT + Down. You can then use the Up and  Down arrow keys to move through the dropdown list.

Lesson 4.4 - Exercises

1.
Describe two new features that effect the logic of named filters in Microsoft Project 98.

2.
Is it true that any Microsoft Project 95 filter imported into Microsoft Project 98 always represents the same logic in Microsoft Project 98 as it did in Microsoft Project 95?

3.
What does it mean in the Filter Definition dialog when an And or Or operator is on a line by itself?

4.
How do you save an AutoFilter as a named filter?

5.
In a view with a task table, if the current named filter is not All Tasks, and then you apply an AutoFilter, which of the following is true?

A. The named filter automatically changes to All Tasks

B. The named filter doesn't change, but is simply ignored.

C. The combined effect is equivalent to combining the named filter and the AutoFilter with an And operator.

D. The combined effect is equivalent to combining the named filter and the AutoFilter with an Or operator.

E. AutoFilter is disabled if the current named filter is not All Tasks.

6.
Describe at least two ways to show all the tasks in a task table when the current named filter is All Tasks and the current AutoFilter is showing only some of the tasks.

Lesson 4.4 - Labs

Lesson 4.4 - Lab 1

Create a test project in which some assignments cost more than $100 and some less (you can do this by assigning resources to tasks and adjusting the Standard Rates of the resources).

Create a named Task Filter so that when it is applied in the Task Usage view, only assignment records with a total Cost greater than $100 are displayed (no task records are displayed).

Lesson 4.4 - Lab 2

1.
Create a project with the data shown below with the current named filter equal to All Tasks.
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2.
Activate AutoFilter and select > 1 week from the Duration AutoFilter value list, and select Joe from the Resource Names AutoFilter value list. You should get the results shown below:
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3.
Select (Custom...) from the Duration AutoFilter value list and click the Save button to save the AutoFilter as a named filter with the name Joe's Big Tasks with the Show in menu option selected.

4.
Turn off AutoFilter and then apply the new Joe's Big Tasks named filter. It should produce the same results as the AutoFilter in step 2.

Lesson 4.5: Printing and Reports

Some Topics to be introduced in this lesson include:

· Scaling for all printers

· Rich Text and pictures in the Header, Footer, and Legend

· More rows in Header, Footer, and Legend

· Crosstab Report Definition Improvements

· Changes to the Task and Resource Reports

· Report Gallery Improvements

· New Shipping Reports

· Printing Resource Cost Rate Tables

· Usage views as an alternative to Crosstab reports

Printing Improvements in Microsoft Project 98

There are two major changes to the printing in Microsoft Project 98:

· Scaling (and fit to page) is now available for all printers. Microsoft Project 4.x only supported scaling for postscript printers.

· You can insert pictures in headers, footers, and legend text.

Scaling

In Microsoft Project 4.x, scaling was available in the Page Setup dialog only if the current printer driver supported the postscript printer language. If a postscript driver was not selected, then the scaling features were disabled (grayed out). Project 95 added a label to explain why the scaling features were disabled:

Microsoft Project 95 Page Setup Page Tab...
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In Microsoft Project 98, scaling is available for all printers (printer drivers).

Microsoft Project 98 Page Setup Page Tab...
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Other than the fact that scaling in Project 95 is only available for postscript printers, the scaling in Microsoft Project 98 functions like the scaling in Project 95 and has a similar interface in the Page Setup Page Tab.

Scaling limits

In both versions of Project, the scaling percentage must be between 10% and 500%. If you enter a value for the scaling percentage outside this range, the alert at the right is displayed when you click the OK, Print, or Print Preview button. 
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Page-restricted elements

When Project builds a print image, there are some elements that must fit entirely within the a page. For example, if you are printing a Gantt Chart with a legend (Page Setup Legend Tab set for Legend on Every page or Legend page), the legend must fall within the printable area of each page. Other elements, such as long Gantt bars, can span multiple pages. It is possible to enter a valid percentage between 100% and 500% that creates an image that is too large for the element, such as the Legend, to fit within the printable area of each page. In that case, the following alert is displayed:

Page-restricted element won't fit within the printable page area...
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Fit to page

If you use the Fit to ... pages wide by ... tall setting, the scaling is calculated for you, but never greater than 100%. For example, you cannot use this setting to enlarge an image; you must enter a percentage greater than 100%.

If the Fit to ... pages wide by ... tall settings would have resulted in a percentage less than 10%, the following alert is displayed:

Print image too large to fit the specified number of pages...
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New Header, Footer, and Legend features

Print Preview showing pictures in the header...
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Microsoft Project 98 has the following new features and improvements regarding print headers, footers, and the legend text area:

· Rich Edit support, including separate formatting for text strings and inserting pictures from files or pasting them in from the clipboard.

· Multi-line footer (without the need for using the control key codes ALT + 0+1+3 on the number pad).

· More Project fields are available in the dropdown list of special code items. New fields are: Project Status Date, Subject, Author, and Keyword.

Page Setup Footer Tab illustrating the new features... 
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Zoomed Print Preview showing part of the legend bars and the footer...
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New field codes available for the header, footer, and legend...
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Rich Edit support

Microsoft Project 98 uses Rich Edit controls in the Header, Footer, and Legend text area. This includes the following features:

· Insert Picture: Use the Insert Picture button or the shortcut menu Picture command to display the Insert Picture dialog. You can also paste in a picture (that was copied earlier) from the clipboard by using the shortcut menu Paste or Paste Special commands, or by using the CTRL+V keyboard shortcut.

· Paste Special: The shortcut menu includes a Paste Special command. For headers, footers, and legends, Paste Special only supports picture and text formats. Object formats (such as a Microsoft Word document object) are not supported and Paste Link is disabled (grayed out).

· Format Font: Use the Format Font button or the shortcut menu Font command to display the Font dialog. This dialog box includes font name, size, bold, italic, color, and underline settings. You can also the CTRL+B, CTRL+I, and CTRL+U keyboard shortcuts for bold, italic, and underline.

· Cut, Copy, and Paste: Text and pictures can be cut, copied, and pasted. The commands are available on the shortcut menu, or you can use the CTRL+X, CTRL+C, and CTRL+V keyboard shortcuts.
Header, footer, and legend shortcut menu

The shortcut menu is displayed when you right-click the area in the Left, Center, or Right tabs as shown.

Header shortcut menu...
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Insert Picture dialog

The Insert Picture button and the shortcut menu Picture command display the Insert Picture dialog illustrated:

Insert Picture dialog...
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The Files of type list includes the following file types:

Windows Enhanced Metafile (*.emf)
Computer Graphics Metafile (*.cgm)

Windows Metafile (*.wmf)
Corel Draw (*.cdr)

JPEG File Interchange Format (*.jpg; *.jpeg)
Micrografx Designer/Draw (*.drw)

Portable Network Graphics (*.png)
Tagged Image File Format (*.tif)

Windows Bitmap (*.bmp; *.db; *.rle)
Targa (*.tga)

PC Paintbrush (*.pcx)
Kodak Photo CD (*.pcd)

Encapsulated PostScript (*.eps)
GIF (*.gif)

Macintosh PICT (*.pct)
WordPerfect Graphics (*.wpg)

AutocCAD Format 2-D (*.dxf)


Maximum number of rows in the header, footer, and legend

In Microsoft Project 4.x, the ENTER key can be used to create up to 3 rows in the header and legend text area, but only 1 row in the footer. In the Footer Tab, you'll need to use the ALT key with the keyboard number pad to enter the ASCII code for a new line character to get 2 more rows in the footer. The key combination is as follows: While pressing the ALT key, press 0, then 1, and then 3 on the keyboard number pad. This is sometimes written as ALT+0+1+3, and represents the ASCII code 13 for carriage return. ASCII code 10 (ALT+0+1+0) for linefeed will also work. Although you can create more than 3 rows this way, you can only display up to 3 rows when printing or previewing.

In Microsoft Project 98, the ALT key combinations are no longer necessary and won't work anymore. Headers can now have 5 rows, and footers and legend text can have 3 rows. The ENTER key can now be used to get to the next row in the Page Setup Header, Footer, and Legend tabs.

Report Improvements

Crosstab Report Definition Improvements

Microsoft Project 4.x and Microsoft Project 98 have crosstab reports that print timephased task or resource data across time, with the option to print the corresponding timephased assignment rows under each task or resource row. 

Crosstab example showing Work for Tasks with assignments...
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Crosstab example showing Cost for Resources with assignments...
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Support for new timescaled data fields

You can create a new crosstab report in Microsoft Project 98 the same way you did in Microsoft Project 4.x. Click Reports on the View menu to display the Reports dialog.
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Double-click Custom to display the Custom Reports dialog shown at the right.

Then click the New button to display the Defined New Report dialog 
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Note: Instead of creating a new crosstab report, you can also select an existing crosstab type of report in the Custom Report dialog and click the Copy button.

All reports are based on one of the four basic report types listed in the Defined New Report dialog. To create a crosstab report, choose Crosstab and then click OK to display the Crosstab Report dialog. 

More timephased fields can be displayed in the crosstab reports in Microsoft Project 98. The timephased fields available in the field list in the Definition Tab of the Crosstab Report dialog depend on whether you select Tasks or Resources for the Row setting. 

The next table compares the available timephased task and resource fields available in crosstab reports for Microsoft Project 4.x versus Microsoft Project 98.
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Row Setting
Microsoft Project 4.x available data fields
Microsoft Project 98 available data fields

Row set to Tasks
Work

Cumulative Work

Cost

Cumulative Cost
Actual Cost

Actual Overtime Work

Actual Work

ACWP

Baseline Cost

Baseline Work

BCWP

BCWS

Cost
Cumulative Cost

Cumulative Work

CV

Fixed Cost

Overtime Work

Regular Work

SV

Work

Row set to Resources
Work

Cumulative Work

Overallocation

Percent Allocation

Availability

Cost

Cumulative Cost
Actual Cost

Actual Overtime Work

Actual Work

ACWP

Availability

Baseline Cost

Baseline Work

BCWS

Cost

Cumulative Cost
Cumulative Work

CV

Overallocation

Overtime Work

Peak Units

Percent Allocation

Regular Work

SV

Work

Duration and Work Labels 

For work and duration type of data in reports, Microsoft Project 98 uses settings in the Tools Options Schedule Tab to determine the units (Microsoft Project 4.x has similar settings).
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Microsoft Project 98 has new settings to control the format of duration and work labels in the Tools Options Edit Tab. 

Both views and reports use these units and format settings.
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Changes to the Task and Resource Reports

Details Tab
The Details Tab in the Task Report and the Resource Report definition dialogs are  changed in Microsoft Project 98. The next two pictures compare the Details Tab in Microsoft Project 4.x and Microsoft Project 98.

Microsoft Project 4.x Task Report Details Tab...

[image: image405.png]o owts | s |
o r—
™ Notes I™ Schedule

_ _ Cancel
I~ Objects I~ Cost 4
I™ Predecessars. ™ Work

Ten

™ Sucosssors

¥ Border Around Details

7 Show Totels Help





Microsoft Project 98 Task Report Details Tab...
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Microsoft Project 4.x did not have assignment notes.

In Microsoft Project 98, assignment records can be displayed in the new Task Usage and Resource Usage views. Double-click an assignment record to display the new Assignment Information dialog that includes a Notes Tab for entering assignment notes. 

The layout of a Task/Resource report changes in Microsoft Project 98. Assignment notes are included, and the other "chunks" specified in the Details Tab are rearranged in the printout.

The next two pictures illustrate the Task Report layout differences between Microsoft Project 4.x and Microsoft Project 98. The Task Range filter is selected in the Task Report Definition tab so that only task T2 is included in the report. There are no assignment notes in the Microsoft Project 4.x picture since it does not support assignment notes.

The object is inserted by using the Window menu Split command to display the Gantt Chart view over the Task Form view. The Task Format is then formatted to show Objects (right-click, then select Objects). A picture is copied from Paint and pasted into the Object area of the Task Form view.

Microsoft Project 4.x Task Report...
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Microsoft Project 98 Task Report ...
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Report Gallery Improvements

When you double-click a report type icon in the Reports dialog, it displays the corresponding report gallery dialog. In Microsoft Project 98, an Edit button is added to make it easy to go back and forth between the gallery and the corresponding report definition dialog without having to double-click the Custom icon in the Reports dialog.

Microsoft Project 98 Report Galleries have an Edit button...
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New Shipping Reports

Some of the names of the predefined reports included in Microsoft Project 4.x have different names in Microsoft Project 98, including the following:

Microsoft Project 4.x Report Name
Microsoft Project 98 Report Name

Weekly Cash Flow Report 
Cash Flow Report

Weekly To Do List 
To Do List

Printing Resource Cost Rate Tables

In Microsoft Project 98, each resource has five Cost Rate Tables, labeled A through E. In each rate table, you can define up to 25 custom time specific rates (a cost rate for a specific date range). For each of the resource's assignments, you can choose one of that resource's five rate tables.

Cost rate tables can be customized in the Resource Information dialog Costs Tab. 

Resource Cost Rate Tables can only be printed as part of a Resource Report. The Resource Report dialog Details Tab contains a new Cost Rates checkbox that allows you to print the Cost Rate Tables.

Resource Report dialog Details Tab...
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The Resource Information dialog Cost Tab always displays rates using the single letter abbreviations, such as $20/h. However, the Resource Report displays the rates using the format specified in the Tools Options dialog Edit Tab.

An extra column, titled End Date, is added to the report to make it easier to interpret.

The font and size used for the table header and the column headings are the same as other “chunks” printed, such as the Calendar chunk.

Example

In this example, only Rate Table A for resource R1 is edited. Rate tables A through E contain the default zero values. The picture shows only the part of the report containing rate tables A and B. All the rate tables would print out on the actual report. 

Resource Report with Cost Rates option selected...
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Usage views as an alternative to crosstab reports

Printing the Task Usage and Resource Usage views in Microsoft Project 98 has the following advantages over printing crosstab reports:

· Multiple table columns can be shown on the left side.

· Multiple types of timephased data (work, cost, and so on) can be shown at the same time.

· Summary task rows rollup data from child tasks (plus any additional values coming from the summary task itself, for example when resources are assigned to the summary task).

The major disadvantage of printing Usage views is that there is no option to print row and column totals like there is for crosstab reports.

Printout of Microsoft Project 98 Task Usage view showing timephased Work and Cost...
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Lesson 4.5 - Exercises

1.
In your opinion, what are the two most important printing improvements in Microsoft Project 98?

2.
What is the valid print scaling percentage range?

3.
Describe some situations that might produce the following alert, even though the scaling percentage is within the valid range.
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4.
What improvements have been made to headers, footers, and legend text in Microsoft Project 98?

5. 
Can a Microsoft Excel 97 worksheet object be embedded in the Page Setup Header tab?

6.
What improvements have been made to Crosstab reports in Microsoft Project 98?

7.
How do you create assignment notes, and how do you print them?

Lesson 4.5 - Labs

Lesson 4.5 - Lab 1

1.
Create a test project and insert a picture and some Rich Edit text in the header in the Page Setup Header tab for the Gantt Chart view.

2.
Try double-clicking on the picture in the Header tab.

3.
Preview the Gantt Chart view.

Lesson 4.5 - Lab 2

1.
Create a project with a task that has a Duration of 300d. Using the default daily Gantt Chart timescale, set the scaling in the Page Setup Page tab to Fit to 1 pages wide by 1 tall and preview it. You should get an alert.

2.
Increase the scaling from 100% to 500% by hundreds, previewing each time. At some point, you should get the alert in exercise 3 above. In the Page Setup Legend tab, set the Legend on setting to None, and preview again. That may solve the problem. Now set the scaling to 500%. The alert may reappear if a single column is too wide to fit on a page.

Lesson 4.6: View Changes and Improvements

Some Topics to be introduced in this lesson include:

· View Overview

· New and Improved Views Types

· Changes in the More Views list

View Changes and Improvements

View Overview

To display a view, click its icon on the View Bar if it is available there, otherwise, click the More Views icon, click the desired view in the Views list, and then click the Apply button.

A view that occupies the entire project window is a single-pane view. You can combine two single-pane views to create a combination view, in which two views share the project window. To get rid of the bottom pane in a dual pane view from the Window menu, choose Remove Split. This leaves only the top pane. To display a bottom pane, click Split on the Window menu. You can change what view is displayed in the top pane or bottom pane independently. Click either the top or bottom pane and then use the previously mentioned method to display the desired view.

To learn about the different symbols used for Gantt Chart type views (such as Gantt Chart, Detail Gantt, Leveling Gantt and so on) click Bar Styles on the Format menu.

Basic View Types

Every combination view is based on two existing single pane views.

Every single pane view is based on one of the predefined view types

To create a new view, click the More Views icon on the View Bar to display the More Views dialog. Click the New button. You can also select an existing view and click the Copy button.

When you click the New button, the Define New View dialog displays.
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If you select Combination view and click OK, then you have to specify an existing view for the Top and Bottom panes in the View Definition dialog.
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If you instead click Single view, you must select one of the basic predefined view types listed in the Screen dropdown list in the View Definition dialog. You must also select an existing table and filter.
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New and Improved View Types in Microsoft Project 98

The Microsoft Project 98 View Definition dialog Screen list includes the following new or changed basic view types compared to Microsoft Project 4.x:

· Resource Usage
The Resource Usage view in Microsoft Project 98 is more powerful than the one in Microsoft Project 4.x. It includes Resource and Assignment records. It allows multiple rows of timephased data to be displayed, and it allows some kinds of timephased data (such as Work and Actual Work) to be edited in the timescale grid.

Microsoft Project 4.x Resource Usage...
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Microsoft Project 98 Resource Usage...
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· Task Usage
The Task Usage view is new to Microsoft Project 98. It is the flip side of the Resource Usage view. It includes Task and Assignment records, allows multiple rows of timephased data to be displayed, and allows some kinds of timephased data (such as Work and Actual Work) to be edited in the timescale grid.
Microsoft Project 98 Task Usage...
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Changes in the Microsoft Project 98 More Views list

This section discusses changes in the list of default views in the Microsoft Project 98 More Views dialog.

Bar Rollup view

This is new in Microsoft Project 98.

The Bar Rollup view works in conjunction with the Rollup_Formatting macro that comes with Microsoft Project 98. For each summary task, it displays rolled up child bars on top of the summary task alternating the name of the child task above and below the rolled up child bars.

The Bar Styles dialog for the Bar Rollup view include pairs of rollup bar definitions for task, split, and milestone. For each pair, the upper definition includes Flag10 in the Show For column and the bottom definition includes Not Flag10. 

For the task and milestone pairs of bar definitions, the upper definition has the Text Tab Top field set to Name. The lower definition has the Text Tab Bottom field set to Name.

The Rollup_Formatting macro alternately puts Yes or No in the Flag10 field for the child tasks. In combination with the upper/lower bar definition pairs in the Bar Rollup view, this causes the child task names to alternate above and below the rollup bars.

Part of the Bar Styles dialog for the Bar Rollup view...
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You normally start the rollup process by setting the Rollup field to Yes for the summary task and all the child tasks that you want to rollup. The macro requires at least one child task in the entire project to have Yes in the Rollup field or it gives an error message. You can insert the necessary “Yes” by inserting the Rollup field in any task table and entering Yes for the appropriate tasks. You can also select the tasks and choose Task Information from the Project menu, and select the Rollup Gantt bar to summary setting as shown in the sequence of pictures that follow (if you select only summary tasks, the setting is Show rolled up Gantt bars).

Gantt Chart before setting the Rollup field to Yes for the child tasks...
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Setting the Rollup field to Yes for the summary and child tasks...
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Resulting Gantt Chart showing the rollup bars...
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Next you can run the Rollup_Formatting macro when you click Macros on the Tools Macro submenu, and then double-click Rollup_Formatting in the Macros dialog. The macro displays the following dialog:

The Rollup_Formatting macro can be run before or after you apply the Bar Rollup view, but you must set the Rollup field to Yes for at least one of the child subtasks in the entire project or you get the alert as shown.
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After the macro runs, the Bar Rollup view shows the names of the rolled up child tasks alternately above and below the rolled up bars. It then collapses the summary tasks as shown.

Bar Rollup view after running the Rollup_Formatting macro...
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Milestone Rollup view

This is new in Microsoft Project 98,

The Milestone Date Rollup view works in conjunction with the Rollup_Formatting macro and alternates the names of the rolled up tasks just like the Bar Rollup view does. The difference is that the Milestone Rollup view shows milestone markers for rolled up tasks, even for tasks that are not milestones. It uses one pair of bar style definitions to do this. The upper definition has the Text Tab Top field set to Name, and the lower definition has the Text Tab Bottom field set to Name.

Part of the Bar Styles dialog for the Milestone Rollup view...
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Using the sample project in the above Bar Rollup view example, the resulting rollup is shown in the picture:
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Milestone Date Rollup view

This is new in Microsoft Project 98. The Milestone Date Rollup view works in conjunction with the Rollup_Formatting macro like the Bar Rollup view does, except that it displays rollup start date milestones instead of bars (even for tasks that are not milestones). It also displays task names above the rollup milestones and start dates below. It uses a single bar definition to handle the rolled up milestones, with the Text Tab Top field set to Name and the Bottom field set to Start.

Part of the Bar Styles dialog for the Milestone Date Rollup view...
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Using the sample project in the above Bar Rollup view example, the resulting rollup is shown in the picture:
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Leveling Gantt view

The Microsoft Project 98 Leveling Gantt view takes the place of the Microsoft Project 4.x Delay Gantt view (which is not in Microsoft Project 98).

In Microsoft Project 4.x, the Delay Gantt view shows bars for the delay and slack values on each task.

Part of the Microsoft Project 4.x Bar Styles dialog for the Delay Gantt view...
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In Microsoft Project 98, the Leveling Gantt view also shows the Delay and Slack bars, but in addition adds new Preleveled bars that make it easy to see the effects of leveling. It saves dates to the new Preleveled Start and Preleveled Finish task fields. It also saves split dates (internal only, not accessible) so the preleveled splits can be shown.

Part of the Microsoft Project 98 Bar Styles dialog for the Leveling Gantt view...
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Note: In the above picture, the bar definitions have been rearranged to show the ones of interest.

The following before and after pictures illustrate the use of the Leveling Gantt view. The column titles are  abbreviated.

Leveling Gantt before leveling...
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Leveling Gantt after leveling...
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Views related to PERT Analysis

The following views are associated with the PERT Analysis macros that come with Microsoft Project 98:

· PA_PERT Entry Sheet

· PA_Expected Gantt

· PA_Optimistic Gantt

· PA_Pessimistic Gantt

Each of these views has a table to go with it as shown in the picture of the More Tables dialog:
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The picture shows the Pert PERT Analysis toolbar and explains the functions of each button.

PERT Analysis toolbar...
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When you enter an optimistic, expected, and pessimistic value for a task in the PA_PERT Entry Sheet view and click Calculate PERT on the PERT Analysis toolbar, Microsoft Project calculates a probable duration for the selected task and places that value in the Duration field. By changing the weight that Microsoft Project attributes to each of the three estimated durations, you can tailor the probable estimate to be more accurate. Change the weight when you click the PERT Weights button on the PERT Analysis toolbar and alter the default settings. 

The next four pictures are examples of the PERT Analysis related views.

PA_PERT Entry Sheet view...
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PA_Optimistic Gantt view...
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PA_Expected Gantt view...
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PA_Expected Gantt view...
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Lesson 4.6 - Exercises

1.
What is the new item listed in the Screen dropdown list in the View definition dialog for a single pane view?

2.
Describe the differences between the Resource Usage view in Microsoft Project 98 versus Microsoft Project 95.

3.
What new default views have been added to the Views menu in Microsoft Project 98?

4.
Which new default views have been added to the More Views dialog in Microsoft Project 98?

Which Microsoft Project 95 default views have been removed from the More Views dialog in Microsoft Project 98?

Lesson 4.7: Usage Views

Some Topics to be introduced in this lesson include:

· Introduction to Usage Views

· Displaying data in Usage views

· The Unassigned Resource

· Outlining and grouping

· Displaying and formatting different sets of timephased data

· Sorting and filtering in Usage views

· Usage views as Master and Slave panes

· Editing data in the timescaled grid: Fill, inserting and deleting

· Editing the Name field in Usage views

· Task/Resource fields shared with Assignments

· Timephased Usage fields

Introduction to Usage Views

This lesson covers some of the basic usability and formatting features of the new Task Usage and Resource Usage views.

Microsoft Project 98 has new Task Usage and Resource Usage views that allow you to view task,  resource, and assignment data across time in a grid under a timescale, and in some cases, to edit the data in individual period cells. The term Usage View is used to refer to either of these views. 

Usage views consist of a task or resource table on the left and a timescale grid on the right. The table portion has either task or resource parent records with corresponding assignment records indented. 

The new Usage views are similar to the Resource Usage view in Microsoft Project 4.x with a few major differences. The new Usage views have the following new features:

· You can display timephased data for assignments grouped by task or by resource.

· With some exceptions, you can edit the values shown in the timescaled portion of the view. In particular, timephased Work can be edited. That is how predefined assignment contours can be customized.

· You can show multiple sets of data for the same task, resource, or assignment.

The main differences between the two Usage views are:

· Task Usage: Groups assignments by task and displays a task table on the left.

· Resource Usage: Groups assignments by resource and displays a resource table on the left. Also, only the Resource Usage view has the special Unassigned resource.

The pair of pictures shows the Task Usage view and corresponding Resource Usage view for some sample data. Task 3 has no assignments and is grouped under the special Unassigned resource in the Resource Usage view. It also has no assignment grouped under it in the Task Usage view. John has no assignments, so there are no assignments grouped under him in the Resource Usage view. He doesn't show up in the Task Usage view at all.

Task Usage View
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Corresponding Resource Usage View...
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The next picture illustrates that multiple timephased field can be displayed at once:

Task Usage with multiple timephased fields...
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Timephased Fields

The data displayed in the timescaled grid area is called timephased or timescaled data, and the kinds of data are called timephased fields. Fields found in task and resource tables are sometimes referred to as total fields or non-timephased fields, to distinguish them from timephased fields. 

Non-timephased fields on the left: The fields are sometimes referred to as totals, but most often, no adjective is used (for example, timephased work, total work, and work are all used to refer to the task Work field). These fields are displayed in vertical columns in task and resource tables, like the ones on the left side of Usage views. These fields are time independent. For example, a task non-timephased Work field represents the total Work on the task.

Timephased fields on the right: These fields are sometimes referred to as timescaled fields, usage fields, or detail fields. These fields are displayed horizontally across time in the timescaled grid portion of Usage views. The individual grid cells represent the value of a timephased field for a specific period of time. The values displayed, and the effects of editing them, depend on the granularity of the timescale, for example, on how the Major and Minor timescales are formatted in the Format Timescale dialog.

Assignment records in tables

There are two reasons assignment records can be displayed in the tables at the left of the Usage views. First, the tables in Microsoft Project 98 allow assignment specific fields to be inserted into Task and Resource tables. Second, some of the Task and Resource fields can be "shared" with assignment records. For example:

· Name field: In the Task Usage view, the Name field displays task names for task records and displays resource names for assignment records. In the Resource Usage view, it displays resource names for resource records, and displays task names for assignment records.

· Resource Names field: This field can only be inserted into task tables. In the Task Usage view, for task records it displays a comma-separated list of all the resources assigned to the task (maximum 255 characters). For assignment records it displays the single resource name for assignment records. 

· Start field: In Task Usage views, this field contains task Start dates for task records and assignment Start dates for assignment fields. In Resource Usage views, it contains resource Start dates for resource records (earliest Start of all of the assignments for that resource), and contains assignment Start dates for assignment records.

The fields that can be inserted into a Task or Resource table are  independent of the view being displayed. However, the assignment specific fields, like Assignment Units, will be completely blank in non-Usage views, since Usage views are the only views that can display assignment records in a task or resource table.

The Usage views are the only views in which assignment records can be displayed in a task or resource table. For example, assignment records can’t be displayed in the Task Sheet, Resource Sheet, or Gantt Chart views.

Displaying Data in Usage Views

The following features control what kind of data and how much of it is displayed:

· Column Widths

· Timescale Zooming & Nonworking time.

· Outlining and Grouping.

· The Unassigned Resource.

· What set of data to display.

· Displaying multiple sets of data.

· Sorting and Filtering.

· Slave Pane Issues.

Each of these features are discussed in detail:

Column Widths

Adjusting column widths

The width of columns in the table portion on the left, as well as the column titled Details at the edge of the timescale grid can be adjusted with the mouse. You may double-click the right edge of the title cell to do a best fit. The timescale grid column widths can only be adjusted by the units, labels, fonts, and Enlarge % in the Timescale dialog (discussion follows).

Cells narrower than non-text contents

Cells that are too narrow to display non-text data, such as the Start and Work fields, display # characters instead. The column containing the cell must be widened to display the data.

The picture illustrates the use of # characters in cells that are too narrow to display non-text data:
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Timescale Zooming and Nonworking Time

The Usage views support the same timescale zooming and labeling features as the Gantt Chart. The Timescale dialog can be displayed three ways. First, when you double-click the timescale. Second, when you choose Timescale from the Format menu. Third, when you right-click on the Timescale and choose Timescale from the shortcut menu.

Format Timescale dialog, Timescale Tab.
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Format Timescale dialog, NonWorking Time Tab.
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Unlike the Microsoft Project 4.x Resource Usage view, the nonworking time Tab of the format timescale dialog is enabled, and you can choose a base calendar or a resource calendar to display nonworking time and format the nonworking time.

Outlining and Grouping

In Usage views, the assignments are shown indented under the parent record. In the Task Usage view, assignments are grouped under parent tasks. In the Resource Usage view, assignments are grouped under parent resources. You can collapse and expand a parent record to show or hide the indented assignments. For outlining purposes the assignments are treated as Child Items that cannot be promoted or demoted.

Tasks are displayed at their normal outline level and their assignments are shown indented under each task. Since tasks can appear at any outline level, it is possible to have assignments displayed at various outline levels in a Task Usage view. Assignments are indented about 1.25 times the normal task indention. This helps to distinguish assignment rows from task rows.

In the Resource Usage view, the resources are displayed at the first outline level. Their assignments are shown indented one level under each resource. If the assignment represents a task that is indented under other summary tasks, it only shows the actual assignment under the resource, not any of its parent tasks.

No Resource Outlining

Resource records in resource tables cannot be indented or outdented manually to create a resource outline. In the Resource Usage view, you can only collapse and expand on the parent resource rows to show or hide the resource's assignment records. You cannot indent or outdent any parent or assignment record.

When displaying tasks and their resource assignments, you can collapse and expand task outlines as well as indenting and outdenting the tasks. 

Outline Symbols

Outline symbols can be used with parent records in a Usage view, just like they can be used with summary tasks in a task table. They provide a convenient way to expand or collapse indented subordinate rows. 

The Tools Options View Tab has a group of Outline Options, shown in the picture, that control the behavior of summary tasks and Outline Symbols:

Tools Options View Tab Outline Options...
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All of these settings can be used with any views containing a task table, including the Gantt Chart, Task Sheet, and Task Usage views. These settings are inaccessible (grayed out) when any resource views are active, except that the Show Outline Symbol setting is accessible when the Resource Usage view is active.

The Indent and Outdent buttons on the Formatting toolbar cannot be used to create custom outlines for resource or assignment records, so these buttons are disabled in the Resource Usage view. Although the buttons are enabled in the Task Usage view, they won't function until a task record is selected. 

The Unassigned Resource

The Unassigned resource is a special artificial resource. Whenever a task is created, it is assigned to the Unassigned resource. The first time the task is assigned to a real resource, the Unassigned resource is removed from the task. 

The only place to view the Unassigned resource is in the Resource Usage view. It serves as the parent of the group for all the tasks that have no resources assigned to them. As with any parent resource row, information on it is rolled up from its assignment rows. Unlike other resource parents, this row is completely non-editable.

The Unassigned resource allows tasks without resources to be scheduled using the same internal algorithms as tasks that have resources. It also allows tasks without resources to be manipulated like tasks with resources.

Assignments can be dragged from one group and dropped into another group. To do this, click the fixed column cell to select the source assignment record, and then drag the entire record up or down to a new group of assignments. Microsoft Project will try to preserve all of the original field values, including Actual Work, when you assign the task or resource of a dragged assignment to another resource or task. Alerts are displayed if you attempt to use drag and drop to assign a resource twice to the same task.

In the Task Usage view, the dragged assignment's resource is unassigned from its source parent task and will be assigned to the target parent task. In the Resource Usage view, the source parent resource is unassigned from the dragged assignment's task and the target parent resource is assigned to the task.

Drag and drop can also be used with the Unassigned resource in the Resource Usage view. A task can be dragged from the Unassigned group and dropped onto another resource to create a real assignment. Also, a real assignment can be dragged and dropped into the Unassigned resource group to delete the assignment. After the assignment is deleted, the corresponding task is listed under the Unassigned resource group only if the task has no other assignments.

Displaying and Formatting Different Sets of Timephased Data

This section discusses how to control what timephased fields are displayed, and how to format the timephased portion of a Usage view. A detailed list of which timephased fields can be displayed and edited is provided in the Usage Data section later. You can format the font and cell pattern used for each timephased field type. You cannot format individual grid cells.

The Detail Styles Dialog

This new dialog is similar in function to the Gantt Palette dialog in that it allows you to set the type and format of the information that is displayed in the timescaled portion of the view. You can display the Detail Styles dialog when you double-click the grid area, or when you right-click the grid area and choose Detail Styles from the shortcut menu, or you can choose Detail Styles from the Format menu.

Usage Details Tab

On the Usage Details Tab, you can choose which timephased fields to display and how their rows of cells are formatted.

Detail Styles dialog Usage Details Tab.
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A discussion of the controls in this dialog box follows:

Show: This button moves the selected item from the Available Fields list to the Show These Fields list.
Hide: This button moves the selected item from the Show These Fields list to the Available Fields list.
Available Fields: This lists the timephased fields that can be displayed on the usage side of the view. The list is sorted alphabetically and contains two special items:

All Task Rows (in the Task Usage view) or All Resource Rows (in the Resource Usage view), and All Assignment Rows. These are not real fields, but they can be used to format cell patterns for an entire category of timephased fields. Without these category fields, you'd have to format each of the timephased fields separately. When you add these category fields to the Show These Fields list, the formats you applied to them take precedence over any individual field formats.

Shows These Fields: You can add and remove fields from this control via the Show and Hide buttons. Any fields listed here are displayed as separate rows in the timescaled usage side of the view.

This list box is not sorted alphabetically. Instead the order in which the fields are listed represents their order of appearance in the view, except that it doesn't matter where the special All...Rows categories are in the list.

If you add a field to this list, it is removed from the Available Fields listbox. This means there is only one instance of the field in the dialog.

You can select multiple fields (using SHIFT + click or CTRL + click) and perform a group add or remove operation, as well as a group move up or group move down operation. You can also change the settings (font, cell background, etc.) of a selected group of fields. This allows you to quickly set the same format of a number of fields in one operation.

If you do not have any fields listed in the Show These Fields listbox, upon clicking OK, the timescaled side of the view is completely empty – no timescale or grid.

Move: The arrow buttons can be used to reorder the displayed fields in the list, which also represents the row order of these fields in the view.

Field settings for <selected field>: This label tells you what the current selection is from either of the two above mentioned listboxes. For example, the label is Field settings for Work when the timephased Work field is selected in either list. It says Field settings for selection if multiple items are selected.

Font: Shows the current font format for the selected items.

Change Font: Brings up the standard Font dialog that allows you to change the format of the selected items.

Cell Background: This control is used to change the background color of the cells for the selected items. 

Pattern: This control applies a pattern to the cell background color. It's similar to the other pattern controls in Project.

Show in menu: This checkbox determines whether the selected fields are displayed on the timescaled usage shortcut menu, and in the Format Details sub menu. This checkbox is grayed out (disabled) if only the special All...Rows category items are selected. The first picture shows the shortcut menu displayed when you right-click the grid. The second picture shows the Details submenu, displayed when you click Details on the Format menu. The pictures show the default list of fields. More fields can be added to this list in the Detail Styles dialog, and the list is saved with the view. 

Note the rules that follow regarding what is listed in the shortcut menu:

· All fields in the Show These Fields list in the Detail Styles dialog always appear in the shortcut menu, and have a checkmark beside them, regardless of their Show In Menu setting.

· If a field has a checkmark beside it in the shortcut menu and you click it to uncheck it, then that unchecked field will remain on the shortcut menu only if it has its Show In Menu setting selected. Otherwise it is removed from the menu.

· Fields in the Available Fields list in the Detail Styles dialog will only show up in the shortcut list if they have the Show In Menu setting selected. 

Timephased grid shortcut menu
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Details submenu on the Format menu...
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Usage Properties Tab

This Tab contains various controls that you can use to set different properties on the view. 

Detail Styles dialog, Usage Properties Tab (picture height is compressed)...
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Align details data: This setting allows you to align the usage data to the Left, Center, or Right. The default setting is right aligned.

Display details header column: The values for this dropdown are Yes, No, and Automatic. Yes and No mean show or don’t show the details header column. Automatic means show the details header column when there are two or more details fields displayed. This setting is set to Yes by default. This column displays the names of the timephased fields that are used. It is a locked column (i.e., it won't scroll out of view). 
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Note: The Details column is never displayed if the Usage view is in a top or bottom pane in a split window with a non-Usage timescaled view (such as the Gantt Chart) in the other pane. This is required to line up the Usage timescale with the non-Usage timescale.

Repeat detail header on all assignment rows: This checkbox setting allows you to have the multiple data field labels appear on every assignment row or just the task rows. The default is ON, so labels show for all rows.

Display short detail header names:

You have a choice between displaying predefined long or short versions of the data row labels, as shown in the double list:

Long Version
Short Version
Long Version
Short Version

%Complete
%Complete
Cumulative Work
Cum. Work.

Actual Cost
Act. Cost
CV
CV

Actual Overtime Work
Act. Ovt. Work
Fixed Cost
F. Cost

Actual Work
Act. Work
Overallocation
Overalloc

ACWP
ACWP
Overtime Work
Ovt. Work

Baseline Cost
Base. Cost
Peak Units
Peak Units

Baseline Work
Base. Work
Percent Allocation
% Alloc.

BCWP
BCWP
Regular Work
Reg. Work

BCWS
BCWS
Remaining Availability
Rem. Avail.

Cost
Cost
SV
SV

Cumulative %Complete
Cum. %Complete
Work
Work

Cumulative Cost
Cum. Cost



Default Format of  the Task Usage View

Default format of the Task Usage view
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Sheet Side (Left Side): The Task Usage table is displayed on the left. Summary Tasks are formatted Bold, task rows are formatted as Regular, and assignment rows are formatted Italic.

Timescaled Side (Right Side) of View: Work is the default detail field. All rows use a regular font style. All Assignment rows have light yellow shade, and all task rows use medium yellow shade. The row header column is displayed by default. The default timescale setting is weeks over days.

Sorting

Sorting in Usage views is the same as in other views, except that Usage views contain assignment records. You can sort by choosing Sort from the Project menu, and then clicking a predefined Sort, or clicking Sort By to display the Sort dialog. 

Sort command submenu when a Task Usage view is active...
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Sort dialog when a Task Usage view is active...
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Sorting in Task Usage Views

If a Task Usage view is active, then the Sort submenu predefined sorts are by Start Date, by Finish Date, by Priority, and by ID. Items cannot be added or removed from the submenu. The fields listed in the Sort dialog are task and assignment fields. The last checkbox in the Sort dialog is labeled Keep outline structure. If this checkbox is selected then records are sorted by groups under their parent record. This is repeated down to the lowest level tasks. In the Task Usage view, this means that tasks and assignment records are sorted under their parent task. If the Keep outline structure is not selected, then all records are sorted as a single group and the Indent/Outdent toolbar buttons are disabled. 

Sorting in Resource Usage Views

If a Resource Usage view is active, then the Sort submenu predefined sorts are by Cost, by Name, and by ID. Items cannot be added or removed from the submenu. The fields listed in the Sort dialog are resource and assignment fields. The last checkbox in the Sort dialog is labeled Sort resources by project. Resource tables have no outline structure other than the resource parent/assignment subordinate relationship in the Resource Usage view. One resource record cannot be indented below another resource record in a resource table, so there is no summary resource equivalent to a summary task. The last checkbox in the Sort dialog is instead used to group resources by project first, and then by whatever other fields you select. There is a resource field named Project, which lists the name of the project or pool to which a resource belongs. Selecting the Sort resources by project groups resources by project or pool and then sorts within each group. In the Resource Usage view, it also keeps assignments grouped under their parent resource during sorting. If the Sort resources by project checkbox is not selected, then all records are sorted as a single group.

Example

In this example, the resource ID (not shown) is 1 for Mary, and 2 for Bob. 

Task Usage Sorted by Name with Keep Outline Structure checked
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Task Usage Sorted by Name with Keep Outline Structure unchecked
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Sorting by Assignment-Only fields

Some of the fields that can be inserted into a task or resource table are assignment-only fields, such as the Assignment Units field. These fields contain blanks for task and resource records and are sorted accordingly when you sort by an assignment-only field. For example, sorting by Assignment Units in the Task Sheet or Resource Sheet view has no effect. In a Task Usage view, sorting by Assignment Units with Keep Outline Structure selected sorts the assignments under each parent task, and does not move the tasks. However, if the Keep Outline Structure is not selected, all tasks are sorted to the top of the table, since they have blanks in the Assignment Units field.

Filtering

Filtering in Usage views is the same as in other views, except that Usage views contain assignment records. To filter, choose Filtered For from the Project menu, and then on the submenu click a filter, More Filters, or AutoFilter. 

Default Filtered For submenu when a task view is active...
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More Filters dialog...
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Filter Definition dialog...
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The fields available in the Filter Definition dialog depend on the whether the Task or Resource option is selected in the More Filters dialog. Assignment fields such as Assignment Units, are available in either case. Resource Filters can only be applied in a Resource view, and Task Filters can only be applied in a Task view.

The Show related summary rows checkbox controls whether or not parent records are displayed with matching subordinate records. The phrase "summary row" refers to real summary tasks as well as to parent tasks or parent resources of assignment records in the Usage views.

The Yes/No field named Assignment can be used in filter conditions to test.

Example

The following sequence of pictures illustrates the effects of the Show related summary rows settings and how the Assignment field can be used when filtering. Text is entered in the Text1 field to keep track of which assignment involves which task. Note that the default title "Task Name" for the Name field was blanked out in the Column Definition dialog so that the real field name, "Name," is displayed instead.

First the special predefined All Tasks filter is applied in the Task Usage view:
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Next, apply a custom filter with the condition that Work equals 24h, and with the Show related summary rows checkbox checked:
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Next the Show related summary rows checkbox in the above filter is unchecked and the altered filter is reapplied:
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In the above picture, note that the indentations in the Name field make the R3 and R4 assignments appear to belong to Task A, although they really belong to Task B as the Text1 field shows.

Using "Assignment" field in filters

It is also possible to alter a filter so it displays only assignment records or only parent records, by adding the condition Assignment Equals Yes or Assignment Equals No to the filter definition.

The picture shows part of the Filter Definition dialog for a filter that is defined to display only assignment records that have Work equal to 24h, and that has Show related summary rows unchecked:
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Applying this filter to the same set of data produces the following:
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Next, the filter is edited so the Show related summary rows checkbox is checked, and the filter is reapplied:
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Using Assignment-Only fields in Filters

Assignment-only fields, such as Assignment Units, are blank for non-assignment records (task and resource records). In non-Usage views, assignment-only fields are entirely blank, since there aren't any assignments. 

Any filter condition based on an assignment-only condition is either True for all non-assignment records or False for all non-assignment records. 

For example, if a filter with the single condition, Assignment Units equals 100%, is applied in a Gantt Chart view, then no tasks will be displayed. If a filter with the single condition, Assignment Units does not equal 100% is applied in a Gantt Chart view, then all tasks will be displayed.

Usage Views as Master and Slave Panes

You can manually create a split pane view using the Window menu Split command, and then applying the desired views to the top and bottom panes. You can also create a combination view that automatically displays specific views in the top and bottom pane. In most split windows, selecting a record in the top pane automatically filters what records are displayed in the bottom pane. In these cases, the top pane is called the master pane, and the bottom pane is called the slave pane. 

This section discusses the behavior when a Usage view is the master pane and when it is the slave pane. 

The rules that follow are for the case of a single record selected in the master pane. If multiple records are selected in the master pane, then the effect on the slave pane is the union of the results from selecting the master records individually.

Slave Usage Views 

Usage views behave like other views when applied to a slave pane. The only difference is that all corresponding assignments are included with each parent record displayed in the slave pane. 

In the example, Task A is selected in the master pane, and all the resources that work on it are displayed, along with all of their assignments. That's why the assignment with Task B is listed under resource R1 in the bottom, even though only Task A is selected on the top.

Gantt Chart over Resource Usage. Task A is selected in the master pane.
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Master Task Usage View with a Slave Task View

When a task record or one of its assignments is selected in the master Task Usage view, then the slave task view displays that task. 

If the slave pane is a Task Usage view, then corresponding assignments are included with each task record it displays.

Examples

Task Usage over Gantt Chart. T1 is selected in the master pane.
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Task Usage over Gantt Chart. The assignment with Mary on T1 is selected in the master pane.
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Master Task Usage View with a Slave Resource View

When a task record is selected in the master Task Usage view, then the slave resource view displays all resources for that task.

When an assignment record is selected in the master Task Usage view, then the slave resource view displays only the resource for that assignment. 

In either case, if the slave pane is a Resource Usage view, then corresponding assignments are included with each resource record it displays.

 Examples

Task Usage over Resource Sheet. T2 is selected in the master pane.
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Task Usage over Resource Sheet. The assignment with Mary on T1 is selected in the master pane.
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Master Resource Usage View with a Slave Resource View

When a resource record or one of its assignments is selected in the master Resource Usage view, then the slave resource view displays that resource record. 

If the slave pane is a Resource Usage view, then corresponding assignments are included with each resource record it displays.

Examples

Resource Usage over Resource Sheet. Bob is selected in the master pane.
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Resource Usage over Resource Sheet. The assignment with Bob on T2 selected in the master pane.
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Master Resource Usage View with a Slave Task View

When a resource record is selected in the master Resource Usage view, then the slave task view displays all tasks for that resource.

When an assignment record is selected in the master Resource Usage view, then the slave task view displays only the task for that assignment.

In either case, if the slave pane is a Task Usage view, then corresponding assignments are always included with each task record it displays.

Examples

Resource Usage over Gantt Chart. Bob is selected in the master pane.
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Resource Usage over Gantt Chart. The assignment with Bob on T2 is selected in the master pane.
[image: image475.png]Resource Name [|Mo | Tu

= Bob 8h_8h
il 8h
i7] oh

= Mary 8h:
T | e

= Tom on

| »

Task Name [ Dur [[[Mo [Tu |

T2 1d| =






Editing Data in Usage Views

Moving (changing the cell with focus) in a Timescaled Grid

Moving and selecting in tables and timescaled grids in Microsoft Project is similar to moving and selecting in Microsoft Excel worksheets.

The table and grid have independent selection.

In Usage views, the table pane and the timescaled grid pane have independent cell cursors. Changing the selected cell in the table has no effect on the selection in the grid portion and vice versa.

Movement in the timescale grid

You can use the mouse and scroll bars to move around the grid and click to select any cell. 

The keyboard keys to move in the timescaled grid are listed in the following table:

Keys for moving the active cell in the timescaled grid...

To move ...
Press...

Up one cell
UP ARROW or SHIFT + ENTER

Down one cell
DOWN ARROW or ENTER

Left one cell
LEFT ARROW or SHIFT + TAB

Right one cell 
RIGHT ARROW or TAB

Left the beginning of time 1/1/1984
CTRL + LEFT ARROW

Right to end of time 12/31/2049
CTRL + RIGHT ARROW

Up to the first row
CTRL + UP ARROW

Down to the last row (last physical row, not the last row with a task)
CTRL + DOWN ARROW

Sideways to the Project Start date
HOME

Sideways to the Project Finish date
END

Down one screen
PAGE DOWN

Up one screen
PAGE UP

One screen to the Left
CTRL + PAGE UP

One screen to the Right
CTRL + PAGE DOWN

Toggle focus between the table on the Left and the timescaled grid on the Right
F6

Selection Behavior in a Timescaled Grid

The table shows the mouse and keys to select one or more cells in the timescaled grid: 

Use the mouse and keyboard to select cells in the timescaled grid...

To select ...
Do this ...

Select any continuous block of cells
Click and drag

Select multiple blocks of cells 
CTRL click and drag

Select between the cell with focus and the clicked cell
CTRL (or F8) click and drag

Extend selection by one cell
SHIFT (or F8) + ARROW key

Select entire column
CTRL + SPACEBAR

Select entire row
SHIFT (F8) + SPACEBAR

Fill Up/Down/Left/Right in a Timescaled Grid

A timescaled grid supports Fill Up, Down, Left, and Right (tables support only Fill Up and Down).

Edit Fill submenu...
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Some of the key features of the Fill command in a timescaled grid:

· Calculations occur in the order that the fill occurs, immediately after each cell value changes.

· Filling ignores uneditable cells and cells with a different data type. No alerts are given.

· Filling works with parent and assignment records. 

· If you select cells in a timephased field that rolls up from assignments to parent then Fill Down will fill the parent cell but may change it when the assignment cells get filled. 

· If you select cells in a timephased field that rolls down from parent to assignments then Fill Up will fill the assignment cells first but may change them when the parent gets filled.

· You can combine fill down and fill across to get block fill functionality.

· You can drag the cell Fill Handle at the lower right corner of a cell to do a Fill operations similar to Excel.
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Inserting and Deleting in a Timescaled Grid

The table describes how to insert and delete cells in a timescaled grid.

To accomplish this...
Do this...

Insert blank cells in a row and have existing cells shift to the right.
Select the cells where you want to insert and choose the Insert Cells menu command, or press the INSERT key.

Delete the contents of selected cells without shifting other cells.
Select cells and choose Edit Clear Contents, or press CTRL+DELETE, or press BACKSPACE and then ENTER.



Remove cells and have existing cells shift to the left.
Select cells and choose Edit Delete Cells 

Or press the DELETE key.

Insert copied cells.
Not Supported

Deleting Rows in Usage Views

The Edit menu includes variations of the Delete command depending on what is selected.

Selection
Edit Delete command

Single task record in a table
Delete Task

Single resource record in a table
Delete Resource

Single assignment record in a table
Delete Assignment

Multiple rows in the table
Delete Row

One or more Cells in a timephased grid
Delete Cells

You can delete a parent or assignment record in a Usage view. First select any cell in that row in the table portion (not in the timephased grid), and then choose Edit Delete Task/Resource/Assignment. You may also press the DELETE key.

· Deleting an assignment record removes the assignment but does not delete the corresponding task or resource.

· Deleting a resource record removes the resource from the project. All of its assignments are removed too.

· Deleting a task record removes the task from the project. All of its assignments are removed too.

If the record you are deleting has any actuals (such as Actual Work greater than 0h or an Actual Start other than NA, etc.)on it,  the following Alert is given:
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Inserting Rows in Usage Views

The text of the Insert menu command to insert a row depends on what kind of record is selected. The Insert menu has a New Task, New Resource, or New Assignment command depending on whether a task, resource or assignment record is selected.

Inserting tasks have the same outline level as the task above them, except for inserting a task at row 1, which gets outline level 1.

Inserting a task or resource creates a blank row until you enter some data.

Inserting Assignment Rows

Inserting an assignment creates a dummy assignment record. It has a blank in the Name field and other non-calculated fields, but it does have values in the calculated fields. No other field in the new record can be edited (not even fields like Text1) until you enter a name in the Name field (a resource name if it's the Task Usage view, or a task name if it's the Resource Usage view).

New no-name assignments remain in the project even if you leave the Name field blank.

If you enter an existing name, then the first resource with that name is assigned if you are in the Task Usage view, or the first task with that name is assigned if you are in the Resource Usage view.

If you enter a non-existent name,  a new resource is created if you are in the Task Usage view and a new task is created if you are in the Resource Usage view. These new resources or tasks receive the usual default values and are added to the end of the list of resources or tasks. New tasks created this way always get outline level 1.

Editing Names in Usage Views

In the Task Usage view

If you edit the Name field for an assignment record in the Task Usage view, you replace the original resource in the assignment by the one you enter. Other fields in the assignment record remain unchanged if possible, like Work, Work Contour, and Baseline Cost, but some calculated fields may change based on the different resource calendars and so on. If the assignment resource name you enter doesn't exist, a new resource is created at the end of the resource list.

Not in the Resource Usage view

In the Resource Usage view, you cannot change the assignment task name in the Name field of an assignment record, except in the case of an inserted assignment that still has a dummy blank assignment task name.

Adding Duplicate Assignments

Microsoft Project 98 does not allow a resource to be assigned more than once to the same task. Microsoft Project 4.x allowed this as a way to vary a resource's workload on a task, but in Microsoft Project 98, you can now accomplish this through resource contouring.

If you try to assign a resource more than once to the same task, the following alert is displayed:
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For example, this alert will be displayed when you:

· Use the Resource Assignment dialog to drag a resource to a task to which it is already assigned.

· Insert a new assignment record in the Task Usage view, and enter a resource name for a resource that is already assigned to the parent task.

· Insert a new assignment record in the Resource Usage view, and enter a task name for a task to which  the parent resource is already assigned.

Drag and Drop in Usage Views

In order to drag a record in the table portion, you must click the locked first column to select the whole record.

Dragging Parent Records in Usage Views

When you drag a parent row, the assignment rows are automatically selected and dragged along with the parent. This is similar to when you drag summary tasks in the Task Sheet or Gantt Chart views.

Dragging Assignment Records in Usage Views

You can drag an assignment record from one parent group to another in a Usage view. Microsoft Project attempts to leave the dragged assignment record fields unchanged if possible, like Work, Assignment Units, Work Contour, Actual Work, and Baseline Cost, but some calculated fields may change depending on the different resource calendars, cost rates, and task Type and Effort Driven setting, and so on. The parent record fields may change from rolled up calculations. 

Note: Actual data (like Actual Work) is moved too.

Dragging assignment records in the Resource Usage view

In the Resource Usage view, an assignment can be dragged from one resource parent's group of assignments and dropped onto another resource parent's group. This assigns the target parent resource to the task, and attempts to keep as many assignment fields as possible unchanged in the new assignment, but some calculated fields may change based on the different properties of the source and target parent resource record, such as resource calendars and cost rates.

The example illustrates dragging an assignment in the Resource Usage view. Mary's assignment on Task B will be dragged and dropped into parent resource Bob's group, meaning that Mary will no longer be working on Task B, and Bob will.

Before dragging Task B from Mary to Bob in the Resource Usage view...
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Drag operation under way...
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Drag operation complete...
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Note: To drag an assignment in the Resource Usage view is equivalent to typing a different resource name into the Name field for an assignment record in the Task Usage view. The first picture displays the Task Usage view before dragging took place: Task Usage before changing the assignment name Mary...
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If you then click Mary in the assignment record under Task B, and change it to Bob, the resulting Task Usage data is equivalent to the Resource Usage drag operation.

After changing Mary to Bob in the Name field for the assignment...
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If you switch back to the Resource Usage view, you will see that you end up with the same data as the result of the drag operation above.

Dragging assignment records in the Task Usage view

In the Task Usage view, an assignment can be dragged from one task parent's group of assignments and dropped onto another task parent's group. This assigns the resource of the dragged assignment to the target parent task, and attempts to keep as many assignment fields as possible unchanged in the new assignment. However, some calculated fields may change based on the different properties of the source and target parent task record, such as task Type and the Effort Driven setting.

Note: Actual data (like Actual Work) is moved too.

The following example illustrates dragging an assignment in the Task Usage view. The assignment for parent Task Y involving Paula will be dragged and dropped into the assignment group of parent Task X, meaning that Paula will no longer be working on Task Y, but will be working on Task X instead. Task X is Fixed Units and is not Effort Driven.

Before dragging Paula's assignment from Task Y to Task X the Task Usage view...
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Drag operation under way...
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Drag operation complete...

[image: image487.png](Mo [Tu |We

Tzsk Y

" Ohrs

© $0.00

Name | Work | Contour|Base. Cost| Units
5 Task X 1 hrs $0.00
.Inhn __Bhrs __ Flat___$0.00

100%|

1072h 3.14h 0.14h
8h
277h 314h 0.14h




If Task X had been Effort Driven (and Fixed Units or Fixed Work), then instead of the total work on Task X increasing, it would have remained 8h, and the 8h would have been divided up between John and Paula as shown:
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If Task X were Fixed Duration, the above drag operation would trigger the following Alert, because the assignment with Paula was 3d in Duration, and Task X was only 1d in Duration:
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The preceding Alert occurs whether Task X is Effort Driven or not, although the resulting total work on Task X does depend on whether it is Effort Driven or not. The following two pictures show the final result for the two cases:

If Task X is Fixed Duration Effort Driven...
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If Task X is Fixed Duration and not Effort Driven...
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Drag and Drop of Cells in the Timescale Side

You can select some cells in the timescaled grid and drag and drop them to another location within the timescaled grid. The timescale scrolls appropriately if you put the drag cursor near any edge of the pane. Dragging this way is equivalent to cutting the source cells and pasting them into the target cells.

Use CTRL+click drag to copy the cells instead of cut them.

Cutting, Copying and Pasting Records

Some of the Microsoft Project 98 copy behaviors in the Usage views, which are different from Microsoft Project 4.x, follow:

· Data can be copied independently from the left table portion or the right timescaled grid portion.

· You cannot copy data from the table and from the timescaled grid at the same time.

· You cannot copy the timescale labels with timescaled data. There is no option in the Tools Options Edit Tab to Copy Resource Usage Header.

As with most other paste operations in Microsoft Project, you can’t paste invalid data into cells. For example, you can't paste text into a cell that only accepts numbers. 

Copy and Pasting Whole Task Records

To select whole task records, click the first column if locked. These can be copied from a task table and pasted as whole records into a task table.

When an entire task record is cut or copied, the assignments go along with the task. These assignments are pasted along with the task when pasting into a project, but not when pasting into other applications like Microsoft Excel.

If you attempt to paste a whole task record over another task record, it inserts itself after the selected task record, rather than overwriting it. Assignments are pasted too. If you attempt to paste a whole task record over an assignment record, it inserts it after that block of assignments as a task.

As in Microsoft Project 4.x, when a task is pasted into another application, just the displayed fields of the task data are pasted into the other application, without the assignments.

Copy and Pasting Whole Resource Records

To select whole resource records, click the first column if it is locked. These records can be copied from a resource table and pasted as whole records into a resource table.

When an entire resource record is cut or copied, the assignments do not go along with it. 

If you attempt to paste a whole resource record over another resource record, it inserts itself after the selected resource record, rather than overwriting it. If you attempt to paste a whole resource record over an assignment record, it inserts it after that block of assignments as a resource.

Some resource fields, such as Work, are not editable, but are instead calculated from assignments. When pasting whole resource records into a project the values in these fields are not pasted with it. For example, the resource Work goes back to 0. When you paste into another application like Microsoft Excel, all displayed data is copied and pasted.

If you attempt to cut a resource record, the following alert is displayed:
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Note: The alert is not displayed if you delete the resource record instead of cutting it.

Copy and Pasting Whole Assignment Records

You can cut or copy a whole assignment record and then paste it onto another parent record (or any of its assignments). This action results in an inserted assignment record. It will not overwrite any records. The preservation of the field values of the inserted assignment record follows the same rules discussed in the Dragging Assignment Records in Usage Views section above.

In the Resource Usage view, when you paste a copied task assignment record from one parent resource onto another parent resource (or any of its assignments), the result is that a new assignment is  inserted on the resource. 

In the Task Usage view, when you paste a copied resource assignment record from one parent task onto another parent task (or any of its assignments) the result is that a new assignment is  inserted on the task. 

Formatting in Usage Views

This section covers some of the Usage specific formatting features and issues.

Cell Alignment

You can format the cell alignment of timescaled usage data using the control in the Format Detail Styles dialog Usage Properties Tab. 

Note: Microsoft Project 4.x did not allow this in its Resource Usage view.

Row Alignment Between Left and Right Panes

You have the ability to have different font sizes for the timescaled usage data, and you can do various category formatting and direct formatting of text on the tableside of the view. 

To keep table rows aligned properly with their corresponding timescaled usage data rows, the row heights in the left and right panes are automatically adjusted to use the larger of the table row height or the height of all the displayed corresponding usage data rows.

You can format the following text items:

· You can use the Format Text Styles command to format various categories of text, such as Critical Tasks, Assignment Rows, Major Timescale, and so on, or you can format All the categories the same way.

· You can format individual cells in a table using the Format Font command.

· You can format categories of timescaled data rows in the (Format) Detail Styles dialog Usage Details Tab.

Note: You cannot format text in individual timescaled data cells.

The picture illustrates various category and cell specific formatting.
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Note: If the All Assignment Rows, All Task Rows, or All Resource Rows categories are in the Show These Fields list in the Detail Styles dialog Usage Tab, then their formatting overrides specific field type formatting. All Task Rows (in the Task Usage view) or All Resource Rows (in the Resource Usage view), and All Assignment Rows are discussed in another section.

Page Breaks

As in Microsoft Project 4.x, you can insert a horizontal page break in all views containing tables, such as the Task/Resource Sheet, Task/Resource Usage, and Gantt Chart views. 

To insert a page break above a row, select a cell in the row and use the Insert Page Break menu command.

To remove a page break, select a cell in the row below the page break, and use the Insert Remove Page Break menu command.

The Format Gridlines dialog has a Page Break category for formatting page break gridlines.

Timescaled Gridlines

The Format Gridlines command displays the Gridlines dialog, which includes Usage Rows and Usage Columns categories. However, you cannot format major and minor timescale gridlines independently like you can in the Gantt Chart.

Note: The Resource Usage view in Microsoft Project 4.x allowed you to format major and minor timescale gridlines independently. 

Fields in Usage Views

Task Fields Shared with Assignments

The task table in a Task Usage view has a number of fields used to display information for both task and assignment records, such as % Work Complete, Actual Cost, Work, and so on. 

Special Cases

Assignment specific shared fields

Some of the fields that can be inserted into a task table are always blank for task records, and are only used to display assignment data in the Task Usage view. These fields follow:

· Assignment Delay

· Assignment Units

· Cost Rate Table

· Work Contour

Shared fields used differently by assignments

Some task fields are used in a special way to display data from an assignment field that does not have the same name as the task field, but is closely related to it. The table that follows lists these fields. 

The second and third columns indicate whether the field is edited or calculated for task and assignment records. The codes C, E, and CE stand for Calculated only, Edited only, and Calculated or Edited.

Task Field
Task
Assmt
Comments

ID
C
CE
For an assignment record, if an ID field in the Task Usage view is not a locked first column, then it is used to display the ID of the resource working on the assignment, otherwise it is blank.

If you edit the ID field for an assignment record in the Task Usage view, you replace the resource working on the assignment. Actuals are preserved.

Name
E
CE
For an assignment record, the Name field in the Task Usage view displays the name of the resource working on the assignment. 

If you edit the Name field for an assignment record in the Task Usage view, you replace the resource working on the assignment. Actuals are preserved.

Resource Initials
CE
C
For an assignment record, the Resource Initials field in the Task Usage view displays the initials of the individual resource working on the assignment. You can't edit the Resource Initials field in an assignment record, but you can in the corresponding task record.

For task records, Resource Initials is a list of initials since more than one resource can work on a task.

If you edit the Resource Initials field for a task record in any task table, you unassign the original resource and assign another. Actuals are not preserved.

Resource Names
CE
C
For an assignment record, the Resource Names field in the Task Usage view displays the Names of the individual resource working on the assignment. You can't edit the Resource Names field in an assignment record, but you can in the corresponding task record.

For task records, Resource Names is a list of Names since more than one resource can work on a task.

If you edit the Resource Names field for a task record in any task table, you unassign the original resource and assign another. Actuals are not preserved.

Resource Fields Shared with Assignments

The resource table in a Resource Usage view has a number of fields used to display information for both resource and assignment records, such as % Work Complete, Actual Cost, Work, and so on. 

Special Cases

Assignment specific shared fields

Some of the fields that can be inserted into a resource table are always blank for resource records, and are only used to display assignment data in the Resource Usage view. These fields follow:

· Actual Finish

· Actual Start

· Assignment Delay

· Assignment Units

· Baseline Finish

· Baseline Start

· Cost Rate Table

· Leveling Delay

· Resource Summary Name

· Work Contour

Shared fields used differently by assignments

Some resource fields are used in a special way to display data from an assignment field that does not have the same name as the resource field, but is closely related to it. The table that follows lists these fields. 

The second and third columns indicate whether the field is edited or calculated for resource and assignment records. The codes C, E, and CE stand for Calculated only, Edited only, and Calculated or Edited.

Res Field
Res
Assmt
Comments

ID
C
CE
For an assignment record, if an ID field in the Resource Usage view is not a locked first column, then it is used to display the ID of the task involved in the assignment, otherwise it is blank.

If you edit the ID field for an assignment record in the Resource Usage view, you are assigning the parent resource involved in the assignment to another task. Actuals are preserved.

Initials
CE
C
For an assignment record, the Initials field in the Resource Usage view displays the initials of the parent resource working on the assignment. You can't edit the Initials field in an assignment record, but you can in the parent resource record.

For resource records, the Initials fields contains the initials for that resource, and editing the Initials field for a resource record does not involve changing assignments.

Name
E
C
For an assignment record, the Name field in the Resource Usage view displays the name of the parent task working on the assignment. You can't edit the Name field in an assignment record, but you can in the parent resource record.

For resource records, the Name field contains the name of the resource, and editing the Name field for a resource record does not involve changing assignments.

Timephased Usage Fields

The timephased fields that can appear in the timephased Details part of a Usage listed in the first column of the table that follows. The first two columns indicate whether the timephased field can be displayed in the Task Usage (TU) or Resource Usage (RU) views. The next three columns indicate whether the field is calculated or edited in task-timephased (T-Ti), resource-timephased (R-Ti), and assignment-timephased (A-Ti) fields. The codes C, E, and CE stand for Calculated only, Edited only, and Calculated or Edited, and na means that field either can't be inserted into the view or is blank for that record type. 

Field
TU
RU
T-Ti
R-Ti
A-Ti

% Complete
Y
N
CE
na
na

Actual Cost
Y
Y
CE
C
CE*

Actual Overtime Work
Y
Y
C
C
CE

Actual Work
Y
Y
CE
C
CE

ACWP
Y
Y
C
C
C

Baseline Cost
Y
Y
CE
CE
CE

Baseline Work
Y
Y
CE
CE
CE

BCWP
Y
Y
C
C
C

BCWS
Y
Y
C
C
C

Cost
Y
Y
C
C
C

Cumulative Cost
Y
Y
C
C
C

Cumulative Percent Complete
Y
N
C
na
na

Cumulative Work
Y
Y
C
C
C

CV
Y
Y
C
C
C

Fixed Cost
Y
N
C
na
na

Overallocation
Y
Y
C
C
C

Overtime Work
Y
Y
C
C
C

Peak Units
Y
Y
na
C
na

Percent Allocation
Y
Y
na
C
C

Regular Work
Y
Y
CE
C
CE

Remaining Availability
N
Y
na
C
na

SV
Y
Y
C
C
C

Work
Y
Y
CE
C
CE

*Actual Cost can only be edited if the Tools Options Calculation setting Actual Costs are always calculated by Microsoft Project is unchecked.

Lesson 4.7 - Exercises

1.
How do you show or hide the Details column in a Usage view?

2.
Which factors control which timephased fields are listed in the Details shortcut menu (when you right-click in the Details column)?

3.
In the Detail Styles dialog Usage Details tab, what is the purpose of the All Task Rows or All Resource Rows items and the All Assignment Rows item?

4.
What are some uses of the Assignment field in a Usage view?

5.
In a combination view, if the top pane is a Task Usage view, what kind of view in the bottom pane makes it impossible to display the Details column in the Task Usage view?

6.
Does the Edit Fill command function in the timephased grid of a Usage view?

7.
If you select one or more cells containing nonzero work in a task timephased row in the Task Usage view and press the INSERT key, what happens and what is the term that describes the result?

8.
What happens if you try to delete an entire task, resource, or assignment record that contains nonzero Actual Work?

9.
If you edit the Name field for an assignment record in the Task Usage view, does it rename the resource or does it assign a different resource to the task? 

Can you do this in the Resource Usage view as well?

10.
What fields can be inserted into a Task Usage view, but not in a Resource Usage view?

What fields can be inserted into a Resource Usage view, but not into a Task Usage view?

11.
What Assignment specific fields in a Task Usage view are always blank for task records?

What Assignment specific fields in a Resource Usage view are always blank for resource records?

12.
What timephased fields in a Usage view are always blank for assignment records?

Lesson 4.7 - Lab

1.
Create a project with the data shown in the picture below. Change the Project Start date to 8/18/97 before entering the other data.
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2.
Format the Task Usage view as shown in the picture above: Display the timephased Work, Actual Work, and % Complete in that order and display the Details column. Format the timescale for weeks over days. Use the default color and patterns.

3.
Next, change the formatting as follows:

· Format all timephased task rows to use Bold Arial 12 with a yellow background and solid pattern.

· Format all timephased assignment rows to use Italic Courier New 8 with a white background and solid pattern.

The result should be similar to the picture below (except for the color in a black and white copy of this manual):
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4.
Next, change the formatting on timephased rows as follows (all of these changes are to be made in the Detail Styles dialog at the same time):

· All timephased task rows use Bold Arial 12 with a yellow background and solid pattern.

· Assignment timephased Work rows use Italic Courier New 8 with a white background and solid pattern.

· Assignment timephased Actual Work rows use Italic Courier New 8 with a white background and solid pattern.

· Assignment timephased % Complete rows use a black background and solid pattern (there is no data displayed in these rows).

The result should be similar to the picture below (except for the color in a black and white copy of this manual):
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Lesson 4.8: OLE and Copy Picture

Some Topics to be introduced in this lesson include:

· OLE support overview

· Microsoft Project 98 as an In-Place Server and Container

· Project as a DocObject in the Office Binder

· Improved Copy Picture tool with save to GIF feature and date range settings

OLE Support

Microsoft Project 98 implements some OLE 2.0 features not supported in Microsoft Project 4.x and adds supports for some of the OLE 3.0 features. The table summarizes some of the OLE features supported by Microsoft Project 98:

OLE Feature
OLE Ver.
Comments

In-Place Server
2.0
This allows Microsoft Project objects that are contained in other applications to be edited in-place within the containing document, as opposed to bringing up Project in a separate window.

In-Place Container
2.0
This allows you to edit OLE objects in-place in Microsoft Project OLE-enabled views: the Gantt Chart and the Objects Viewer.

In Microsoft Project 98, the Notes fields utilize Rich Edits and also support embedded objects, but they only permit in-place activation of objects from Notes fields within form views and not from areas such as the Task Information dialog. Outside activation is necessary to edit an object displayed in this way.



Drag and Drop to the Desktop or other container applications.
2.0
Same limited support as Microsoft Project 4.x.

The following parts of Microsoft Project 98 supports drag and drop: Gantt Chart drawing layer, object area of a Form view (displayed by right-clicking the Form and selecting Object), rich text Notes Tab in Information dialogs, and Page Setup Header and Footer tabs.

Document Object (DocObject)

.
3.0
This is required for Office Binder compatibility.

Microsoft Project 98 is a DocObject server. A project can be placed in a Binder section and manipulated like a standalone project, with some exceptions. This is different from In-place activation, which displays a project in a frame embedded in another application like Word.

Improved Storage Performance
3.0
Microsoft Project 98 uses the new OLE 3.0 DLL's for faster and more compact storage.

Microsoft Project 98 as an In-Place Server and Container

In-place activation is a feature of OLE 2.0 that allows an application object contained in another application to be edited in-place in its frame instead of in a separate application window. The embedded object is called an in-place server, and the host application is called an in-place container or client.

Microsoft Project 4.x did not support in-place activation either as a container or server. For example, Microsoft Project 4.x did not support in-place activation when an object was embedded in a project (in the Gantt view drawing layer or the Object area of a Form view), and it did not support in-place activation when a Project object was inserted in another application.

Microsoft Project 98 is both an in-place container and an in-place server.

OLE in-place activation includes the following:

· Negotiations between the server and container for a view port.

· Merging of the server and container menus.

· Display the server’s toolbars instead of the container’s.

Inserting a Project object

This section discusses Microsoft Project 98 as an in-place server.

To insert a Microsoft Project object in another Microsoft Office application, such as Microsoft Word, choose Object from the Insert menu in the other application. This displays the Object dialog. This dialog is similar for all Microsoft Office applications, but has some application specific options. The dialog that follows is for Microsoft Word. The Float over text option is specific to Microsoft Word (for example, it is not available from Microsoft Excel). If this option is selected, then the framed Microsoft Project object is only visible in Microsoft Word's Page Layout view (accessed from the View menu), where it can be dragged and repositioned (framed objects can always be dragged in Microsoft Excel).

Object dialog Create New Tab...

[image: image497.png]CReen el

bt o

™ Float over text

Mictosft Word Documene
Mcrost wWord Pt | T oslayasion

Result

Inserts a new Microsoft Poject 80 Project
E@ objectinta your document.

==





To create a new Microsoft Project object, click the Create New Tab and select Microsoft Project 8.0 Project from the Object type list. 

To create a Microsoft Project object from an existing Microsoft Project MPP file, click the Create from File Tab and enter the path and filename or use the Browse button.

Object dialog Create from File Tab...
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Using Paste Special to paste a Project object

You can also embed a Microsoft Project object into another Microsoft Office application by selecting data in a Microsoft Project task or resource table, then using Microsoft Project's Edit Copy (Task, Cell, or Assignment) menu command, and then using the Edit Paste Special menu command in the container application.

The picture shows the choices available in Microsoft Word's Paste Special dialog after clicking on the name task 2 in a task table in Source1.mpp and using Project's Edit Copy (Cell) command.
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If you select Microsoft Project 8.0 Project Object, then the Float over text and Display as icon options become available:
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If you select the Paste link option, the Word Hyperlink format becomes available:
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When Paste link is selected, the Microsoft Project 8.0 Project Object format and the Picture format have the same functionality. Double-clicking the Microsoft Project picture in the container application opens the corresponding MPP file in a separate Microsoft Project window rather than in an in-place frame.

Note: If you only want a static unlinked picture of a Microsoft Project view, you can use the toolbar camera icon in Microsoft Project to copy the picture and then paste it into the container application.

In-place activation

Double-click an in-place Microsoft Project object to activate it. A hatched border is used to indicate an active in-place object as illustrated in the picture below:
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When an in-place Microsoft Project object is active, the term view port refers to the area inside the hatched border excluding the scrollbars. Microsoft Project negotiates with the container for a view port, including additional area to allow the display of scroll bars and the hatched border outside of the view port. The view port is the same size as the inactive frame.

Deactivating an in-place Microsoft Project object

You can deactivate a Microsoft Project object by clicking outside of its frame. 

Microsoft Project 98 runs in the background

Assuming that Microsoft Project 98 is not currently running, it automatically launches when you do either of the following:

· Attempt to resize an inactive Microsoft Project object frame.

· Double-click a Microsoft Project object to activate it. 

Once launched, Microsoft Project 98 will run in the background, even if the object is never activated (double-clicked). If you use the Windows Close dialog (ALT+CTRL+DELETE) to close Winproj.exe in this state, you may cause the container application to become unstable.

Resize a Microsoft Project object

Resize an active Microsoft Project object

There is no sizing or moving of windows within Microsoft Project itself while in-place, but the object window can be resized while the Microsoft Project object is active. While active, Microsoft Project displays its own sizing handles within the hatched border area. You can use these handles to resize the active Microsoft Project frame. The dragging and resizing behavior of an active Microsoft Project object depends on the container application. In Microsoft Word, if the Float over text option is selected, then you can drag the inactive frame anywhere and have text flow around it. Microsoft Excel, however, doesn't need a Float over text option, and you can drag the inactive frame anywhere on a worksheet.

Whether an embedded Microsoft Project object can span multiple pages (cross page breaks) depends on the container application. For example, in Microsoft Excel, a Microsoft Project object can span page breaks. But in Microsoft Word, an embedded Microsoft Project object cannot span multiple pages and is cropped at the first page break encountered. You can resize an active Microsoft Project object in Microsoft Word across page breaks in Word's Normal view, but it snaps back to its original size as soon as you deactivate the object.

Resizing an active Microsoft Project object is a cropping operation, which displays more or less of the embedded object. This means that no scaling takes place; the Microsoft Project content of the object keeps its regular size but the amount of it that can be seen is increased or decreased accordingly). Upon deactivation, the object retains its new dimensions in the container, unless the container does further manipulation of the view port.

Resizing an inactive Microsoft Project object

Resizing a Microsoft Project object either results in scaling of the object’s cached metafile (enlarging or reducing the picture without changing what part of the view is displayed), or in a cropping operation (exposing more or less of the Microsoft Project view without doing any scaling), or a mixture of both. 

If the container allows the view port to be resized while the Microsoft Project object is inactive, then the cropping or scaling behavior  depends on the container application and whether the change is vertical or horizontal. For example, for an embedded Microsoft Project 8.0 project object in Microsoft Word or Microsoft Excel, resizing horizontally is primarily a cropping effect, whereas resizing vertically is primarily a scaling effect. Microsoft Word cannot resize an inactive Microsoft Project object vertically unless the Float over text option is selected.

Since Microsoft Project does not have a view scaling feature, any scaling that is done when a Microsoft Project object is inactive is not displayed when the object is activated. Instead, it displays as much of the view that will fit within the current view port using normal scaling. 

Upon deactivation, the embedded object may return to the original inactive scaling again, or it may use the normal-scale image that the project had when it was active. It depends on the application. In Microsoft Word, if an inactive Microsoft Project object is scaled vertically, then activated and deactivated, it returns to the scaling that it had before it was activated. In Microsoft Excel, if an inactive Microsoft Project object is activated and then deactivated, any vertical scaling done when it was inactive is lost and it instead uses the normal scaling it had when the object was active.

Example

The sequence of pictures shows the resizing effect in Microsoft Word of an embedded Microsoft Project object set to Float over text.

Inactive embedded Project 8.0 project object before resizing...
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After resizing the inactive object horizontally...
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Next, resize the inactive object vertically...
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Next, the object is activated, causing it to use normal Project scaling...
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Finally, the object is deactivated, returning it to Microsoft Word's scaling.
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Note: If this had been in Microsoft Excel instead of Microsoft Word, then it would have kept the normal Microsoft Project scaling upon deactivation.

In-place Views

Any Microsoft Project view can be applied while in-place active, but only printable views can remain in effect after deactivation. The following discussion focuses on non-printable and combination views and their special behaviors.

Non-Printable Views

If Microsoft Project is in-place active and you switch to a non-printable view and then deactivate the in-place object, the Microsoft Project application icon is displayed (scaled to fit the frame) in the container since Microsoft Project cannot render the non-printable view.

Combination Views

An active in-place project window can be split by applying a split view or when you right-click a view like the Gantt Chart with the Split command on its shortcut menu. 

Note: You cannot use the Window menu Split command, because the container application owns it and using it would split the container document, not the active in-place view.

The split in-place window only applies until deactivation and the combination view does not appear in the inactive object image, since both panes of a combination view cannot be printed simultaneously. The top (master) pane view is the one displayed in the inactive object image (even if the bottom pane was active last), although white space may indicate where the bottom pane would have been. If the master view is a non-printable view, then a Microsoft Project icon displays instead.

Upon reactivation, the split view reappears when the top pane is selected.

Command bars during in-place activation

Upon in-place activation, Microsoft Project’s Command Bars (the single Menu Bar and all the toolbars)  merge with the Command Bars of the container. 

If you right-click a toolbar during in-place activation and select or deselect various toolbars, those settings are remembered so that they can be restored the next time you activate the object. When the object is inactive, the container's toolbars and menus are restored again.

Menus during in-place activation

The File and window menus belong to the container application, and the Edit, View, Insert, Format, Tools, Project and Help menus belong to Microsoft Project. 

The File Page Setup, Print, and Print Preview commands refer to the container document, and for some containers some of these commands may be disabled while the in-place object is active. For example, in Word, the Print Preview command is disabled, but in Microsoft Excel it is available.

The following Microsoft Project 98 menu commands are disabled during in-place activation:

Menu or Submenu
Disabled items

View
Reports

Header and Footer

Insert
Page Break

Tools*
Links Between Projects (see the alert after this table).

Resources: 
Share Resources



Update Resource Pool



Refresh Resource Pool

Organizer

Customize: 
Toolbars



Workgroup

Options:
      
Workgroup Tab - everything is disabled



except the hyperlink appearance settings





*
An embedded project cannot be involved in cross-project links, resource sharing, or workgroup messaging.

Alert if you try to create cross project task links with an embedded project object...
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Toolbars during in-place activation
During in-place activation, the container handles display of toolbars. If the container is Command Bar compatible, it has the option of merging other toolbar controls with the Microsoft Project ones. For example, both Microsoft Excel and Microsoft Word add their toolbar Zoom percentage control to the merged Standard toolbar (Microsoft Project's Standard toolbar alone has no Zoom percentage control). 

Some commands common to Microsoft Project and to the container are handled by the container. This includes Print and Print Preview if available.

Shortcut Keys

During in-place activation, the following shortcut keys are disabled:

Keystroke
Command

CTRL+N
File New

CTRL+O
File Open

CTRL+S
File Save

CTRL+P
File Print

Option Settings

All global options are enabled while working in-place. They behave the same as when you run Microsoft Project as a standalone (for example, all global option changes persist beyond deactivation).

Only one instance of the Microsoft Project application can run at a time. If Microsoft Project is running standalone and a Project object is in-place active at the same time, then they share the same executable, so changing a global option in either place immediately is reflected in both places.

Macro Support

With the new VBE (Visual Basic Environment) support in Microsoft Project 98, substantial macro support is available during in-place activation. This includes editing and debugging in the VBE, and macro recording and playback. Except for the fact that some Microsoft Project commands are disabled during in-place activation, working with macros is no different than working with macros while running Microsoft Project standalone. Running a macro containing a disabled command generates an alert.

Project as an In-Place Container

This section discusses Microsoft Project 98 as an in-place container.

In-place objects from other Microsoft Office applications can be inserted into a Microsoft Project 8.0 project and activated in-place. Most in-place activation characteristics are determined by the in-place server rather than the container.

Inactive Microsoft Word document object in Project...
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Active Microsoft Word document object in Project...
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Where objects are allowed

Microsoft Project 98 allows OLE objects to be embedded in the following places:

· Gantt view drawing layer. To insert an object, use the Insert Object or Edit Paste Special commands.

· Object area of a Form view, such as Task Form or Resource Form. To insert an object, first format the Form view to show Objects (right-click the Form view and select Objects), then use the Insert Object or Edit Paste Special commands.

· Rich text Notes Tab in the Task, Resource, or Assignment Information dialogs. To insert an object, right-click the notes area and use the Object command on the shortcut menu.

Shortcut menu in the notes area of the Notes Tab...
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Where In-place activation is allowed

In-place activation is supported only in the Gantt drawing layer and in a Form view formatted to show Objects. Double-click an object in the Notes Tab notes area to open the object in a separate application window (also referred to as outside activation) instead of doing in-place activation.

Command Bars when an in-place object is active in Project

Double-click the in-place object to activate it. When an embedded object in Microsoft Project is activated, Microsoft Project supports merging of command bars (the single Menu Bar and all toolbars) with the in-place server. The object can merge menus into Microsoft Project’s Menu Bar, and replace Microsoft Project’s toolbars with its own.

During activation of an in-place object, the File and Window menus and the Open, New, Save, Zoom In and Zoom Out toolbar buttons belong to Microsoft Project. The File menu commands Page Setup, Print Preview, and Print and Properties are disabled, as are the Print and Print Preview toolbar buttons.

Command Bars when an in-place Microsoft Excel worksheet object is active...
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Command Bars when an in-place Microsoft Word document object is active...
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Object Sizing

If you resize an in-place object view port while the object is active or inactive, a cropping operation occurs (more or less of the object data is displayed), rather a scaling operation.

An in-place object in the Object area of a Form view (such as the Task Form view) can only be resized or moved when it is activated. When it is later deactivated, the change in position is lost, but the resizing is retained.

Object Commands on the Edit Menu

If no object is currently selected, the bottom of the Edit menu contains an Object submenu with a single disabled Convert command as shown at the right:
[image: image514.png]




If an object is selected, then the Object submenu changes it name to match the object type, and additional commands are added. Examples for a selected Microsoft Excel worksheet object and a Microsoft Word document object as shown below:
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Object shortcut Menus

The shortcut menu displayed when you right-click an object in Microsoft Project depends on the whether the object is in the Gantt drawing layer, the Object area of a Form view, or the rich text Notes Tab in an Information dialog. In the Notes Tab, the shortcut menu is the same whether or not there is an object.

Examples of these shortcut menus:

Object shortcut menu in the Gantt drawing layer...
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Object shortcut menu in the Task Form formatted to show Objects....
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In-place objects in the Gantt drawing layer

The object's shortcut menu Properties command displays the Format Drawing dialog. The Line & Fill Tab can be used to format the border and fill of the inactive object image, and the Size and Position Tab can be used to control the size and position of the object and whether its position is relative to a specific task or a specific date on the timescale.

Line & Fill Tab...
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Size & Position  Tab...
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When an object is originally inserted into the Gantt Chart drawing layer it has a transparent background and no border as shown.

Microsoft Excel worksheet object with transparent background...
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In the picture that follows, the inactive worksheet object is given a solid white fill and its view port is enlarged horizontally and vertically to expose more of the sheet (rather than scaling the image).
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Activating in-place objects in the Gantt drawing layer

You can activate an in-place object when you double-click it. When an in-place object is activated, the view port (the sheet cells in the case of a worksheet object) is the same size and any scroll bars, column headers and so on are drawn around the view port, surrounded by a hatched frame.

Before activating the selected worksheet object...
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After activating the worksheet object...

[image: image524.png]Jul 20,97 Aug 3,97
FIS[sMIT WITFIS[s MIT WIT[FIS[SMIT [

e B 5]

1. [This is an XL object in Project
2| $10000_§15,000

3| 512000 1 -
le[4]» [pihsheets 7 ] | [





In-place objects in a Form view

An inactive in-place object in the Object area of a Form view cannot be resized or moved. You can only resize and move it when it is active.

Inactive worksheet object in the Task Form formatted to show objects...
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Active in-place worksheet object...
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Active in-place worksheet object resized and moved...
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New size maintained after deactivation, but the move is lost...
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Objects in rich text Notes

To insert an object in the rich text Notes Tab in the Task, Resource, or Assignment Information dialog, right-click the notes area and use the Object command on the shortcut menu as shown.

Shortcut menu in the notes area of the Notes Tab...
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In-place activation is not supported in the Notes Tab. Double-clicking an object in the Notes Tab notes area to open the object in a separate application window (also referred to as outside activation) instead of doing in-place activation.

You can scale the object image when the object is not active, but your scaling is lost when you activate and deactivate the object.

Microsoft Excel worksheet object in the Task Information Notes Tab...
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DocObject and the Office Binder

Microsoft Project 98 is DocObject (Document Object) and Office Binder compatible.

The DocObject architecture is an extension to OLE in-place activation that separates a document into a document frame component and a document object component in such a way that ownership of the document view can be shared and controlled by both a document container application and the contained document. This enables new capabilities in combining and managing heterogeneous documents, and is a core part of the Office Binder.

The Office Binder is like a workbook, where each section is a separate document. Different types of documents can be stored in a single file, while maintaining their uniqueness. Once in the binder, the documents preserve their order, travel together, load and save together, print together, and live in a single file. Binder 97 adds a mechanism for common headers and footers across all documents in the binder, basic print preview capabilities, and a number of Office 97 consistency features.

For an application to be Office 97 Binder compatible requires that it be a DocObject server that supports the optional DocObject interfaces to share the toolbar with the container application and to receive print and setup commands from the container. 

The rest of this lesson discusses projects in an Office Binder, but much of the material is true for general DocObject containers.

You can use the Add or Add from File command on the Section menu to add a Project DocObject to a Binder file.
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An active Project DocObject stored in a Binder file...
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DocObject versus in-place activation

There are a number of differences between Microsoft Project as an in-place server and Microsoft Project as a DocObject server. The table lists some of the differences between a Microsoft Project object embedded in a container application such as Microsoft Word or Microsoft Excel and a Microsoft Project DocObject in a Binder file. Printing in the Office 97 Binder is discussed in more detail later.

Feature
Embedded Project 
Project DocObject in Binder

Prints just like a standalone project file
No

Only its view port image can be printed (which can be resized to show more).

If embedded in a Microsoft Word document, the view port cannot cross page breaks.

If embedded in Microsoft Excel, the view port can span multiple pages.


Yes



Reports
No
Yes

Independent Header and Footer
No
Yes

You can access this from the View menu or from Page Setup on the Binder's Section menu.

Note that if a header or footer is specified for the whole Binder file, it replaces any header or footer specified from Section Page Setup. 

Command to save a copy of the project object as a separate file
No
Yes

Use the Save as File command on the Binder's Section menu. The original project object is still in the Binder.

Command Bars

Upon DocObject activation, the Microsoft Project 98 Command Bars (the single Menu Bar and all toolbars) merge with the Binder Command Bars. 

Menu Merging

When a Project DocObject is active, the File menu is owned by the Binder and contains all Binder-level commands. Microsoft Project owns the Edit, View, Insert, Format, Tools and Project menus. 

The File menu contains binder-level commands such as commands to create a new binder file or save or print the current binder file.
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The Binder's Section menu (shown on the left) provides access to section-level commands similar to those that would normally be on the File menu if the section's application ran standalone. This includes commands to print or preview a specific section of the Binder and to save the section as a separate file (the original DocObject is still in the Binder file unless you then delete it).

The Help menu is shared with the Binder as shown.
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Viewing a project standalone

If you choose View Outside from the Binder Section menu, then the project is activated in a separate Microsoft Project window and can functions like any other project opened in Microsoft Project. Any Binder specific restrictions are removed. For example, you can now customize toolbars and the menus and toolbars belong entirely to Microsoft Project.

Disabled Tools menu commands

The following Microsoft Project 98 Tools menu commands are disabled for a Microsoft Project DocObject in a Binder file.

Disabled items

Reports

Header and Footer

Page Break

Links Between Projects (see the alert after this table).

Resources: 
Share Resources



Update Resource Pool



Refresh Resource Pool

Organizer

Customize: 
Toolbars



Workgroup

Options:
      
Workgroup Tab - everything is disabled



except the hyperlink appearance settings





*
An embedded project cannot be involved in cross-project links, resource sharing, or workgroup messaging.

Alert if you try to create cross-project task links with an embedded Microsoft Project object...
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Toolbars

The normal Microsoft Project 98 toolbars are displayed when a Microsoft Project DocObject is active in a Binder file, although some of the buttons refer to commands that are passed off to the Binder to control: New, Open, and Save. These buttons are equivalent to the New, Open, and Save commands on the Binder’s File menu.

The Print and Print Preview toolbar buttons are passed to the Binder, which then tells the current section (the Microsoft Project DocObject in this case) to print or preview itself. So it is equivalent to selecting Print or Print Preview from the Section menu rather than from the File menu.

Shortcut Keys

During in-place activation, the following shortcut keys are disabled (the same ones that are disabled when an embedded in-place Microsoft Project object is active):

Keystroke
Command

Ctrl+N
File New

Ctrl+O
File Open

Ctrl+S
File Save

Ctrl+P
File Print

Option Settings

All global options are enabled while working in-place and behave the same as when running Microsoft Project standalone (for example, all global option changes persist beyond deactivation). This behavior is the same for an embedded in-place Microsoft Project object.

Only one instance of the Microsoft Project application can run at a time. If Microsoft Project is running standalone and a Microsoft Project object is in-place active at the same time, then they share the same executable so changing a global option in either place immediately is reflected in both places.

Printing in Binder

There are two ways to print or preview Microsoft Project data when a project is included in a Binder. 

The Print Binder and Binder Print Preview commands on Binder’s File menu provide Binder-wide printing capabilities.

The Print and Print Preview commands on Binder’s Section menu provide access to printing at the section component document level, allowing you to print or print preview a project independent of the other Binder contents by using Microsoft Project’s own printing user interface 

Non-Printable Views

If a Microsoft Project DocObject is in one of the sections of a Binder file and if a non-printable view (such as the Task Form view) is its current view, then when you use the Print Binder or Binder Print Preview commands on the File menu, the print or preview proceeds normally until you reach the Microsoft Project section with the non-printable view. 

If you are doing Binder Print Preview, then a message is displayed in the preview window as shown:
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If you are doing Print Binder, then the following sequence of alerts is displayed :
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If you then choose the No button, then the following alert is displayed:
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Print Settings

You can control project-specific print settings by using the Print command on the Section menu. Two new controls are added to the normal Microsoft Project 98 Print dialog:

Section Print dialog when the active section is a Project DocObject...
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· Set as Section Default: The Set as Section Default button takes whatever settings are currently in effect and saves them as the printing defaults for the active Microsoft Project DocObject. If you change something in the Print dialog and do not use the Set as Section Default button, then your changes apply only to the current print job (if you print or preview before exiting the dialog).

The printing defaults are project-specific. If a binder contains more than one Microsoft Project section, then separate defaults can be set for each section.

When you use the Set as Section Default button, the Cancel button changes to a Close button.

· Display warnings for non-printable views: This controls whether or not alerts should be displayed when you print or preview and the current view in the project is not printable, as previously discussed.

Page Setup

The File menu has the Binder Page Setup command for the whole Binder file, and the Section menu has the Page Setup command for the selected DocObject. The Binder Page Setup settings override the ones in the Section Page Setup.

Binder Page Setup dialog Header/Footer Tab....
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Headers and Footers

Office Binder 97 allows you to specify global headers and footers for all documents in a binder, or to override the binder-wide headers and footers for any given section and use the application’s own page setup to specify section-level headers and footers.

If you want a Microsoft Project section to use the binder-level header and footer settings, you must either select the checkbox for that section or choose the All supported sections option in the Apply binder header/footer to area of the Header/Footer Tab in the Binder Page Setup dialog. If the global header and footer apply to a Microsoft Project section, any existing header/footer information in the Section Page Setup is replaced by the global information without warning, and any future changes you make in the Section Page Setup dialog are ignored.

Page Numbering 

You can use various page numbering formats for the whole binder in the Header/Footer Tab in Binder Page Setup. For those sections that the Binder Header/Footer information applies to, you have the option to restart page numbering at each section or to use consecutive page numbering. The settings to control page numbering across sections is in the Print Settings Tab in Binder Page Setup Tab:

Binder Page Setup dialog Print Settings Tab...
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Macro Support

With the new VBE (Visual Basic Environment) support in Microsoft Project 98, substantial macro support is available during when a Microsoft Project DocObject is active in a Binder file. This includes editing and debugging in the VBE, and macro recording and playback. Except for the fact that some Microsoft Project commands are disabled when a project is activated in a Binder file, working with macros is no different than working with macros while running Microsoft Project standalone. Running a macro containing a disabled command generates an alert.

Copy Picture tool

[image: image545.bmp]
Microsoft Project 98 has improved Copy Picture features. The Copy Picture dialog is displays when you click the Copy Picture toolbar button. The Microsoft Project 4.x Copy Picture dialog is shown at the right. The Microsoft Project 98 Copy Picture dialog follows.
Microsoft Project 4.x Copy Picture dialog...
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Microsoft Project 98 Copy Picture dialog...
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The Render image options

In the Render Image section, the For screen and For printer options are the same as in Microsoft Project 4.x.

The To GIF image file option is a new choice for creating a GIF file from the picture.

The To GIF image file text box is used to enter the file path and name. When you click the To GIF image file option, the text box is filled with a default file name and the Browse button is enabled.

Copy Picture has an option to save the picture to a GIF file...
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The default filename is the same base name as the Microsoft Project file with a GIF extension. 

The default location is the same directory as the Microsoft Project file if the project is saved as an MPP file. If the project is new and not yet saved, or if the project is opened from a database, the location defaults to the current working directory. 

The Browse button brings up the standard Browse dialog with GIF set as the default file-type. 

If you select the For screen or For printer option after you select the To GIF image file option, the GIF text in the path and filename textbox remains, but is disabled (grayed out).

The path and filename can be up to 256 characters.

If you select the GIF option but blank out the associated textbox, then when you click OK, an alert displays stating that you must enter a file name.

If you enter a path and filename and the specified GIF file already exists, then when you click OK, an alert is displayed to give you the choice to overwrite or cancel.

The GIF converter is discussed in more detail later.

The Copy options

The Copy section is only enabled in views that include a task or resource table, such as the Gantt Chart, Task Sheet, and Task Usage view. 

The Rows on screen option copies only the rows visible in the active pane. That includes  any partially visible rows. The copied image shows whole rows.
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The Selected rows option copies all the selected rows, no matter how many are selected. It copies the selected rows even if they do not all fit on screen or if the selection is scrolled off screen.

If you select more than one row, then the default setting is Selected rows. Otherwise it is Rows on screen.

The Timescale options

The Timescale options are only enabled in views that have a timescale, such as the Gantt Chart and Task Usage. 

The Timescale options allow you to use the displayed timescale data or to select a particular range of time. 
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The default setting is As shown on screen and the Dates from and To fields default to the corresponding date range displayed on screen.

If you select the Dates from option or edit the Dates from and To fields, Microsoft Project remembers the dates during the current session of Microsoft Project and shows them the next time the dialog is displayed during the same session of Microsoft Project. Each time Microsoft Project starts up, the default dates are used again.

Example

This example illustrates how the Copy and Timescale options are used to control what part of a Gantt Chart view gets copied. In part A, the Gantt is copied as displayed on screen. In part B, selected tasks for a specified date range are copied.

Gantt Chart view to be copied...
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A. 
Copy the Gantt Chart as displayed on screen.

Copy and Timescale options set to copying as displayed on screen...
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Resulting copied image...
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B. 
Copy only the selected task rows (10, 11, and 12) and the timescale date range from 6/6/97 to 6/11/97.

Copy and Timescale options set for selected tasks and a specified date range...
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Resulting copied image...
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How the copied image is created

When you press OK in the Copy Picture dialog, Microsoft Project constructs an Enhanced Windows Metafile representing the specified image. 

If you use the Selected rows option or the Dates from and To option, it is possible to specify too much data for Microsoft Project to render. In that case, the alert on the right is displayed.
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When you paste the picture into another application, that application determines what to do if the image is large. 

For example Microsoft Word, Excel, and Paint have a similar scaling behavior when pasting in a Microsoft Project picture. 

· Horizontally: As the horizontal size of the image increases, graphics is scaled but text is not, leading to text that is relatively too big to fit the columns as it did in Microsoft Project.

· Vertically: As the vertical size of the image increases, graphics and text is scaled, but column widths remain unchanged, leading to text that is relatively too small to fit the columns as it did in Microsoft Project.

After the scaling operation is finished, some applications such as Microsoft Word also crop the resulting scaled image to fit on a single page. 

Note: When you paste a picture into Microsoft Word, the Float over text option in the Format Picture dialog Position Tab is selected by default so you can only see the picture in Page Layout view. Uncheck this option if you want to see the picture in Normal view and don't want text to float around it.

Example

This example illustrates how the copied Gantt Chart image is scaled horizontally and vertically when pasted into Microsoft Excel (the behavior is similar for Microsoft Word and Paint, except that Microsoft Word will also crop to fit a single page).

Part A has a small number of rows and a small amount of timescale copied. 

Part B has a small number of rows, but a large amount of timescale. 

Part C has a large number of rows, but a small amount of timescale.

Part D has a large number of rows and a large amount of timescale.

A. 
5 rows and 7 days.
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B. 
5 rows and 120 days. Not all the timescale is shown in the picture that follows:
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C.
100 rows and 7 days. Not all the rows are shown in the picture.
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D.
100 rows and 120 days. Not all the rows or timescale is shown in the picture.
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How the GIF image file is created

If you use the To GIF image file option in the Copy Picture dialog, then when you press OK, Microsoft Project creates a metafile as described above and passes it to the metafile to GIF converter that, also known as the WMF-to-GIF filter. The filename of the filter is gifimp32.flt. This is the same filter that Office uses. On a standalone installation of Microsoft Project, the filters are normally in the folder C:\Program Files\Common Files\Microsoft Shared\Grphflt as shown in the picture of the corresponding Registry entry:
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The Registry key is:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shared Tools\Graphics Filters\Export\GIF

While Microsoft Project creates the metafile, an hourglass is displayed, but no progress meter. While the filter converts the metafile to a GIF file, a progress meter is displayed (it may flash by quickly if the file is not too large).
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Converter errors

If the WMF-to-GIF filter, gifimp32.flt, cannot be loaded for any reason (for example if it cannot be found or the GIF registry key is missing or invalid), then the following alert is displayed:
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If the GIF registry key discussed above cannot be found, then (gifimp32.flt) is not in the alert message since the filter filename would be unknown in that case.

If the filter encounters any type of error during the creation of the GIF file, it returns an error code to Microsoft Project, and Microsoft Project displays the following alert:

Alert if there is a problem saving to the GIF file...
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The above alert is also displayed in the case of an illegal string in the path, a non-existent path, or a read-only folder.

Lesson 4.8 - Exercises

1.
What OLE features are new in Microsoft Project 98?

2.
What are some of the differences between inserting an embedded project into a Microsoft Word document versus including a project in an Office Binder file?

3.
When you activate an embedded project for in-place editing in a Microsoft Word container document, the Split command is not on the Window menu. 

A. How can you display an activated in-place project in a split view?

B. What happens if a split view is displayed and then you deactivate the in-place project?

4.
What is the difference between resizing an embedded inactive in-place project frame horizontally versus vertically?

5.
What happens if you display a single pane Task Form view in an activated in-place project, and then deactivate the in-place project?

6.
What Microsoft Project menu and submenu commands are always disabled during activation of an in-place project?

7.
Where in Microsoft Project can embedded objects (such as Microsoft Word document objects and Microsoft Excel worksheet objects) be inserted?

Which of these places supports in-place activation of embedded objects associated with in-place servers?

8.
In Office Binder, what's the difference between the Print Binder command on the Binder File menu and the Print command on the Binder Section menu?

9.
If a project is in an Office Binder file, how can you view the project in a separate Microsoft Project window instead of in the Binder section window?

10.
What are some of the differences between the Copy Picture tool in Microsoft Project 95 versus Microsoft Project 98?

Lesson 4.8 - Labs

Lesson 4.8 - Lab 1

1.
Use the Insert Object menu command in Microsoft Word 97 to insert a Microsoft Project 98 project object in a Microsoft Word 97 document. Activate the in-place project and add some tasks, resources, and assignments. Deactivate it.

2.
Examine the menus when the project object is inactive. Activate it and examine the menus again. Deactivate it.

3.
Activate the in-place project, switch to a single pane Task Form view, and then deactivate the project.

4.
Activate the in-place project, apply a single pane Gantt Chart view, then split the view so the Gantt Chart is in the top pane and the Resource Usage view is in the bottom pane. Deactivate it. Activate it again. Deactivate it again.

5.
Resize the inactive project object horizontally and vertically. Activate the in-place project. Deactivate it.

Lesson 4.8 - Lab 2

1.
Create a new Office Binder 97 document and insert a Microsoft Excel worksheet in section 1, a Microsoft Project 98 project in section 2, and a Microsoft Word 97 document in section 3. Add some test data to each of the three sections.

2.
Examine the menus when the project section is active.

3.
With the Gantt Chart active in the project section, print preview the entire binder file.

4.
With a single pane Task Form view active in the project section, print preview the entire binder file.

5.
With the Gantt Chart active in the project section, print preview only the project section.

Lesson 4.8 - Lab 3

1.
Create a project with a couple of tasks and use the improved Camera tool to create a GIF file as shown below. Your project data and the path and filename of the GIF can be different than that shown in the picture.
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2.
Locate the GIF file that you created in step 1 and double click it to open it in Internet Explorer. Close Internet Explorer.

3. 
Use the Camera tool with the For screen option to paste the picture into a Microsoft Word document instead of saving it to a GIF file.

4. 
Use the Camera tool again only this time use the Date from option and enter a date range that covers only two days. Paste it into a Microsoft Word document.

5. 
Use the Camera tool again using a date range that covers many years, for example from 1997 to 2040. If the range is large enough, an alert will be displayed (after you click OK in the Copy Picture dialog). Paste the truncated image into a Microsoft Excel worksheet.

Lesson 4.9: Office Assistant

· Some Topics to be introduced in this lesson include:

· Office Assistant

· Planning Wizard Interface

Office Assistant

Introduction to Office Assistant

Microsoft Project 98 supports the Office Assistant; a small, separate window that contains one of a variety of animated characters (actors) that offers assistance to users. It can be hidden or visible with or without a "balloon" caption. 

Office Assist toolbar button. Clicking this displays the Assistant if hidden.
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Office Assistant window in rest mode (no "balloon" caption).
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The Office Assistant home "balloon" with IntelliSearch.
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The Office Assistant is often referred too simply as the Assistant or the Character or Actor. There are a variety of animated actors to choose from. To change the actor or change the kind of help the Assistant delivers, double-click the Assistant and then click the Options button to display the Office Assistant options dialog.

Microsoft Project communicates to users mainly through the Assistant interface. The Character has six roles in Microsoft Project:

· Optional interface for Alert messages.

· Optional interface for Planning wizards.

· The only interface to IntelliSearch. IntelliSearch is the natural language search, previously known as the Answer Wizard. The IntelliSearch interface is the "home" balloon caption of the Assistant as shown above.

· The only interface to the Tip of the Day.

· Animations to facilitate time consuming activities (for example, resource leveling) and provide amusement.

General Behavior

Shared Behavior

The Office Assistant behaves the same across all active Office Assistant compatible applications. It is either visible in all or hidden in all. It has the same position in all. Its properties are persistent and shared across all Office Assistant compatible applications. There are Registry settings that remember its properties, such as the actor being used and its screen position. The Registry settings are under:

HKEY_Current_User \Software\Microsoft Office\8.0\Common\Assistant

(Also duplicated under HKEY_Local_User).

The Assistant includes the following shared behavior:

· The Office Assistant is visible only if the following two conditions are met:

Some Office Assistant compatible application is running visibly and is active (has focus).

... and ...

The Assistant was visible the last time its state settings were saved to the Registry.

· The Office DLL starts the Assistant when the first Office Assistant compatible application starts. 

· The Office DLL closes the Assistant when the last Office Assistant compatible application is closed.

Popup Menu

Click the Assistant window with the alternate mouse button to display the dialog box that follows:
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The Hide Assistant command closes the Assistant window. See the Office Assistant Options Dialog section for explanations of the other menu commands.

Showing the Assistant

If the Assistant is hidden, it can be displayed in one of several ways:

· Click the Office Assistant toolbar button. This displays the Assistant, or toggles the home "balloon" if the Assistant is already displayed.

· From the Help menu, click "Microsoft Project Help."

· Press the F1 key - this only works if the "Respond to F1 key" options is selected in the Office Assistant options dialog.

The default position of the Character in the shared preferences file is in the lower right-hand corner of an application, just inside the scroll bars. The Character can be moved, and its new position is persistent across all Office Assistant compatible applications (its position is saved in the registry).

Hiding the Assistant

The Assistant can be hidden as follows:

· Click the "close window" X button in the upper right corner of the Assistant window.

· Click the Assistant window with the alternate mouse button and choose Hide Assistant from the dialog box.

Office Assistant Options Dialog

The Office Assistant dialog contains various options to control its behavior. To display the dialog, click the Office Assistant toolbar button or double-click the Assistant window if it is displayed. Then click the Options button in the balloon message it displays. 

The Office Assistant dialog is shown:
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The Gallery Tab is used to select an "actor" for the Assistant. 

The Options Tab (selected in the above picture) has various options controlling how much and what kind of help the Assistant gives, as described in the table:

Option/Command
Action

Respond to F1 key
If this option is selected, then pressing the F1 key displays the Assistant's search balloon, even if the Assistant was previously hidden.

If this option is not selected, then press the F1 key to display the old rectangular "Help Topics: Microsoft Project" dialog with the Content, Index, and Find tabs.

Help with wizards
If this option is selected and if the Assistant is already visible, then Planning wizards are displayed in an Assistant balloon. 

If this option is not selected or if this option is selected but the Assistant is not visible, then the Planning wizards are displayed in the old rectangular dialogs.

The Planning wizard settings in the Tools Options General Tab still apply.

Display alerts
If this option is selected and if the Assistant is already visible, then Alerts are displayed in an Assistant balloon. 

If this option is not selected or if this option is selected but the Assistant is not visible, then Alerts are displayed in the old rectangular dialogs.

Search for both product and programming help when programming
Not used in Microsoft Project

Move when in the way
Automatically tries to move the Assistant away from the part of the screen you are working in.

Guess help topics
Not used in Microsoft Project

Make sounds
Assistant makes various sounds when displaying messages.

Using features more effectively
Not used in Microsoft Project

Using the mouse more effectively
Not used in Microsoft Project

Keyboard shortcuts
Not used in Microsoft Project

Only show high priority tips
Not used in Microsoft Project

Show the Tip of the Day at startup
If this option is selected, then the Tip of the Day is displayed in the Assistant balloon when Microsoft Project starts, even if the Assistant was previously hidden. Also, the Tips button in the Assistant Home Balloon is enabled. The Assistant is the only way to display these tips. 

If this option is not selected, the Tip of the Day is not displayed at startup, and the Tips button in the Assistant Home Balloon is disabled.

Command button: Reset my tips


In Microsoft Project 98, many alerts and help topics have been combined, and Microsoft Project now supports the Office Assistant illustrated in the picture to the right.

The Search button provides a natural language search based on what you enter in the edit box. The Tips button displays a tip, but only if the "Show tip of the day at startup" option is selected in the Office Assistant options dialog.
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The Options button displays the Office Assistant options dialog. There are options to let the Office Assistant display various alerts and help messages:
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For example, if you try to copy data from a blank row and the Office Assistant is not visible or the above Display Alerts option is unchecked, then the following plain alert is given:
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But if the Office Assistant is visible and the above Display Alerts option is checked, then the following alert is given:
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Notice that the plain message without the Office Assistant contains a Help button that must be used to get more information, whereas the Office Assistant usually doesn't need a Help button since it provides all the follow-up information in the same "balloon" caption. Microsoft Project 98 follows this principle as much as possible when using the Office Assistant. However, for some complex and important topics, the Assistant does offer a "Learn more about this subject. (Help)" button in the message. For example, the message that follows is displayed when you type the same value down the Duration field for several rows:
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Office Assistant Alerts Format

Office Assistant alerts have three different parts:

· Heading Icon (some alerts have no heading icon)

· Heading Text

· Alert Text

Heading Icon

The table illustrates three general types of alerts and their heading icons. Note that the third type has no heading icon.

Alert Style
Description 
Sample

Information
Provides information about the results of a command. Offers no user choices; the user acknowledges the message by clicking the OK button. 
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Warning
Alerts the user to a condition or situation that requires the user's decision and input before proceeding, such as an impending action with potentially destructive, irreversible consequences. The message may be in the form of a question.
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Critical
Informs the user of a serious problem that must be corrected before work can continue. 
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Heading Text (or Alert Title)

This is a brief description of the problem (usually one sentence). It is displayed at the top of the alert in bold. For most alerts, Microsoft Project 98 and Microsoft Project 4.1 have the same or similar alert titles.

All Office alert heading text styles are the same. The font size is non-adjustable, but an option in the Assistant Options balloon allows the user to use the System Menu Font instead. 

Alert Text

The alert text is what normally is covered in a help topic. It gives background about the problem and proposes resolutions. It is displayed below the Alert Title.

The alert text style is non-bold, left aligned, and has the same font as the Heading Text. It supports bullets and numbered lists. There may be arbitrarily many paragraphs. A blank line (carriage return) separates paragraphs within a text block. Graphic elements may flow in the text stream, as well as Character phrases. Character phrases are randomly selected from a list of Character specific phrases. 

Many alerts provide resolution options for a resolution. For example, if a Task Start is currently after the Project Start and then you change the Task Start to be before the Project Start date, the following alert is displayed:
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Many common alerts (such as the alert to save changes) use the same text as other Office applications.

PlanningWizard Interface

The PlanningWizard in Microsoft Project 98 is very similar to the one in Microsoft Project 4.x, except that there is now an option in the Office Assistant dialog to use the Assistant as the interface. 

PlanningWizard without the Assistant...
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PlanningWizard with the Assistant...
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Kinds of PlanningWizard Messages

There are settings in the Tools Options General Tab that control what categories of advice PlanningWizards will give:

Planning Wizard settings in Tools Options General Tab
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PlanningWizard messages belong to subgroups of messages corresponding to the three sub-checkboxes shown above. The example above containing the phrase "You moved 'T2' just after 'T1'" belongs to the Advice about Scheduling subgroup. Another example from that subgroup occurs if you try to move a task to a nonworking day, for example:
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Controlling Which PlanningWizard Messages Are Displayed

There are three levels of control over what PlanningWizard messages are displayed.

· The Advice from PlanningWizards checkbox.
Unchecking this in the Tools Options General Tab stops all PlanningWizard messages from displaying. 

If you later reselect Advice from PlanningWizards, the subgroup checkboxes are restored to their previous state - they are not automatically selected. 

· The Subgroup checkboxes.
Checking or unchecking a subgroup checkbox enables or disables all messages in that subgroup.

· Disabling individual messages ("Don't tell me about this again").
Individual PlanningWizard messages contain a "Don't tell me about this again" checkbox, as shown in the pictures above. Clearing this checkbox only disables that specific message. If any message in a subgroup is disabled this way, then the checkbox for that subgroup is filled with a gray pattern as illustrated:
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Note: The only way to reactivate a specific message that was disabled using the "Don't tell me about this again" checkbox, is to reactivate the whole subgroup it belongs to (by clicking the grayed subgroup checkbox until it has a check in it). Then all messages in that subgroup are reactivated.

Lesson 4.9 - Exercises

1.
What are the six roles that the Office Assistant can play in Microsoft Project 98?

2.
Suppose that the Office Assistant is not showing in Microsoft Project and then you switch to Microsoft Excel and show the Office Assistant. Will the Office Assistant be showing when you switch back to Microsoft Project?

3.
Which options in the Office Assistant dialog Options tab does Microsoft Project use?
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Lesson 5.1: Schedule from Project Start/Finish Date

Some Topics to be introduced in this lesson include:

· Project Information dialog Schedule From option

· Difference between Schedule From Start and Finish

· New Schedule From Finish behavior

· Fields impacted when switching the Schedule From option

Scheduling a Project from Finish

Microsoft( Project 98 has several improvements over Microsoft Project 4.x regarding scheduling a project from Finish. This option is in the Project Information dialog accessible from the new Project/Project Information menu command:

New Project Menu
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New Project Information dialog
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The following are some of the drawbacks of the implementation of scheduling from finish in Microsoft Project 4.x:

· ASAP and ALAP tasks are scheduled the same way (ALAP) in a scheduled from finish project.

· Resource Delay is not applied to assignments in a scheduled from finish project.

· Task Leveling Delay is not applied in a scheduled from finish project.

· There are some issues when master projects are scheduled from either start or finish one way, and sub-projects are scheduled the other way.

You can now level resources in a project that is scheduled from a finish date. 

This involves allowing Delay to have negative values so that tasks or assignments can be pushed back in time. 

ASAP and ALAP task behavior.

In Microsoft Project 4.x, these task constraints behave the same way (for example, as ALAP) in a project that is scheduled from a finish date.

In Microsoft Project 98, ASAP tasks are scheduled using the calculated Early Start dates instead of the late dates as in Microsoft Project 4.x.

Also, Microsoft Project 98 uses the ALAP constraint for new tasks instead of ASAP when the project has is scheduled from finish.

This change can have a large impact if you read old Microsoft Project 4.x projects that are scheduled from a finish date. Most tasks in these Microsoft Project 4.x projects are ASAP tasks that behaved like ALAP tasks in Microsoft Project 4.x. In Microsoft Project 98 these old ASAP tasks behave like real ASAP tasks. 

When reading old Microsoft Project 4.x files, a generic warning is displayed regarding possible scheduling differences. There is no specific message about scheduling from finish: [image: image587.png]Planning Wizard
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The example below shows a project in Microsoft Project 95 scheduled from finish with all ASAP tasks and what happens when it is opened in Microsoft Project 98.

A project scheduled from finish in Microsoft Project 4.x - all ASAP
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... Opened in Microsoft Project 98 - all still ASAP
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Task Leveling Delay

In projects that are scheduled from a finish date, Microsoft Project 4.x does not apply any task or resource assignment Delay values when scheduling. One of the reasons it doesn't use Delay is that Microsoft Project 4.x does not support a negative Delay value that would cause the task or resource assignment to occur earlier than normal.

By not supporting negative Delay, it also means that Microsoft Project 4.x cannot level a project that is scheduled from a finish date.

Also in Microsoft Project 4.x, an ALAP task in a project scheduled from start cannot be leveled. It gives an alert saying that Microsoft Project cannot solve the overallocation.

In Microsoft Project 4.x, Leveling Delay is not counted as part of the task and so becomes part of the slack of predecessors of the task with the Delay. This often results in the "loss of the critical path" after leveling in Microsoft Project 4.x..

Microsoft Project 98 makes three improvements regarding task Leveling Delay:

· It supports negative Delay values in scheduled from finish projects. This causes a task or assignments finish date to occur earlier in time as the Delay is applied from the finish end of the task or assignment. It only uses positive Delay values when leveling a project that is scheduled from start and only uses negative Delay values when scheduling a project that is scheduled from finish.

· When doing a backward scheduling pass, Microsoft Project uses the Delay field.

· It counts Delay as part of the task and incorporates it into the early and late date calculations.

If the task has any MSO or MFO constraints it does not use task Leveling Delay values in forward or backward scheduling pass calculations. It maintains the Microsoft Project 4.x behavior in this case.

The following symbols are used in the rules below:

SS is scheduled start
SF is scheduled finish. 

ES is Early Start.
EF is Early Finish.

LS is Late Start.
LF is Late Finish.

For all tasks in a scheduled from start project:

· Delay values are positive and are applied on the start of the task.

· ALAP tasks ignore any Leveling Delay values as the task is already as late as possible.

· Predecessor refers to any task that’s linked to the start of the successor task.

In the forward pass (done first)

EF = ES + span of task + task Leveling Delay.

SS = ES + task Leveling Delay.

SF = SS + span of task.

In the backward pass

LS = LF - span of task.

predecessor LF = successor LS - successor task Leveling Delay. (if finish is linked)

predecessor LS = successor LS - successor task Leveling Delay. (if start is linked)

For all tasks in a scheduled from finish project:

· Delay values are negative and are applied on the finish of the task.

· ASAP tasks ignore any Delay values as the task is already as early as possible.

· Successor refers to any task that is linked to the finish of the predecessor task.

In the backward pass (done first)

LS = LF - span of task + task Leveling Delay.

SF = LF + task Leveling Delay.

SS = SF - span of task.

In the forward pass

EF = ES + span of task.

successor ES = predecessor EF - predecessor task Leveling Delay (if start is linked)

successor EF = predecessor EF - predecessor task Leveling Delay (if finish is linked)

Schedule From Start Example

There are 3 tasks A, B and C as shown, and all days are working days. 




In a Schedule From Start Project with a positive 3 day task Leveling Delay on B, the tasks are scheduled as follows:




In the forward pass, the Delay is added to B’s Early Start to give a new scheduled start and a new Early Finish date.

In the backward pass, the Delay is applied to the B’s predecessor link with A, giving A the Late Finish that is 3 days earlier than would normally have been calculated.

Schedule From Finish Example

In a Schedule From Finish Project with a negative 3 day task Leveling Delay on B, the tasks are scheduled as follows:




In the backward pass (which is done first) the negative Delay is added to B’s Late Finish date to produce an earlier scheduled finish and earlier last start date than would have normally been calculated.

In the forward pass, the negative Delay on B is subtracted from B’s Early Finish date (subtracting a negative number results in an add), giving C a later Early Start date than would normally have been calculated.

Resource Assignment Delay

What follows is a comparison of Resource Assignment Delay behavior in Microsoft Project 4.x versus Microsoft Project 98:

· In Microsoft Project 4.x, if you assign a resource to a task and give that assignment some Delay, the task’s start date is changed to the resource’s delayed start date. If you later assign another resource to the task (with no Delay), the start date of the task changes back to its original date.

Microsoft Project 98 changes this behavior to the more expected behavior of having the task start date stay at the same value and only change the resource assignment start date on the task if an assignment with resource Delay is assigned to a task.

· In Microsoft Project 4.x, resource Delay is not applied when the project is scheduled from a finish date. 

Microsoft Project 98 uses the resource assignment Delay field in both scheduled from start and scheduled from finish projects. Like task Leveling Delay, in scheduled from start projects it is applied from the start of the task. In scheduled from finish projects it is applied from the finish of the task.

No Later Than Constraints

· In Microsoft Project 4.x, if a task has an FNLT constraint beyond the finish date of the project, Late Finish date is set to the Project Finish date. This results in the task having zero slack.

In Microsoft Project 98, the task's Late Finish is set to the FNLT constraint date, thus giving the task some slack.

· In Microsoft Project 4.x, if a task has an SNLT constraint beyond the finish date of the project, the task's Late Finish date is set to the Project Finish minus Duration.

In Microsoft Project 98 the task's Late Start is set to the SNLT constraint date.

Flexible vs. Fixed Durations

Microsoft Project 4.x is inconsistent in how it treats task Duration values when scheduling. Most of the time it treats them as being fixed, but there are a few occasions when it treats them as being flexible. Microsoft Project 98 is consistent and treats all task Durations as fixed (for example, non-flexible).

 Below are examples of the inconsistent behavior in Microsoft Project 4.x:
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In this example, the LF of task 2 is 2/26, which is not equal to its LS plus Duration value. It treats task 2’s Duration as a flexible Duration instead of as a fixed value.

In task 3’s case, it treats the Duration as a fixed value and calculates LS = LF - Duration and ES = EF - Duration.

Microsoft Project 98 changes the above calculations as follows:

In a schedule from start project this change impacts MSO, SNLT tasks and the predecessor task of an SS link. And in a schedule from finish project, this change affects the Early Start calculation for MFO, FNET tasks and the successor task of an FF link.

· In schedule from start projects:

MSO and SNLT tasks: LF = LS + Duration 

Predecessor task of an SS link: LF = LS + Duration

(instead of Microsoft Project 4.x behavior which was LF = Project Finish.)

· In schedule from finish projects:

MFO and FNET tasks: ES = EF - Duration

Successor task of an FF link: ES = EF + Duration

(instead of Microsoft Project 4.x behavior which was ES = Project Start.)

Lesson 5.1 - Exercises

1.
What is the difference in how the ASAP constraint behaves when scheduling a project from finish in Microsoft Project 95 versus Microsoft Project 98?

2.
Can a project that is scheduled from finish be leveled in Microsoft Project 98?

Lesson 5.1 - Lab

1.
Create a project and change the Project Start to 6/2/97 and set the project to Schedule from Project Finish. Enter the tasks, resources and assignments shown in the picture below. Give tasks T2 and T3 an ALAP constraint (T1 is ASAP).
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2.
Level the project using the default leveling settings. Insert the Leveling Delay field into the task table and examine the values.

3. 
Clear leveling and then put an ASAP constraint on T2. It should go back to the start of the project. Would it do that in Microsoft Project 95?

Lesson 5.2: Calendars and Availability

Some Topics to be introduced in this lesson include:

· Relationship between Base calendars and resource calendars

· Predefined base calendars shipped (Standard, 24 Hour, Night Shift)

· Improved cell formatting

· Legend (new)

· Improved Week Starts On and Fiscal Year Formatting

· New Resource Availability setting

Calendars Overview

Creating, editing, and deleting calendars in Microsoft Project 98 is similar to the same functions in Microsoft Project 4.x. This lesson mainly covers calendar features that are new or improved in Microsoft Project 98.

Project calendars and base calendars 

The project calendar is used to schedule tasks with no assignments, summary tasks, and Fixed Duration tasks, and is used to schedule lag in relationships.

To specify which base calendar is the project calendar for the active project: From the Project menu, click Project Information, then select a calendar from the Calendar dropdown list in the Project Information dialog box. The list includes all the base calendars stored in Global.mpt and those stored in the active project.

IMPORTANT: Choosing a project calendar does not change the calendar that exists or on which new resources are based. A discussion on how to select a base calendar for a resource follows. 

To view/change the project calendar working days/times: From the Tools menu, click Change Working Time. Changes made to the base calendar are called base calendar exceptions.

To create new base calendars: From the Tools menu, click Change Working Time, then click the New command button in the Change Working Time dialog.

Resource calendars

Resource calendars impact the dates of Fixed Units and Fixed Work tasks. You cannot edit timephased work for an assignment on nonworking days for the resource, although you can edit timephased Actual Work on these nonworking days. Every resource calendar is based on a base calendar. The default is Standard. 

To specify the base calendar for a resource: Apply a resource view, such as the Resource Sheet, select one resource record, then from the Project menu, click Resource Information. Next click the new Resource Information dialog Working Time tab and select a calendar from the Base calendar dropdown list. You may also double click the resource in the Assign Resources dialog (use the Assign Resources toolbar button to display it ) to display the Resource Information dialog.  You may also double click the resource record in a resource table (such as in the Resource Sheet view), or use the shortcut menu for resource records in a resource view. 

To view/change the resource calendar working days/times: Select the resource calendar from the list of calendars in the Change Working Time dialog, or display the new Resource Information dialog Working Time tab as described above. Resource calendars inherit changes made to the parent base calendar, and can override the parent base calendar with resource calendar changes, called resource calendar exceptions.

Change Working Time dialog

Base calendars and resource calendars can be displayed or edited by using the Tools menu Change Working Time command to display the Change Working Time dialog:

Tools Change Working Time command displays this dialog…
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To edit a particular base calendar or resource calendar, choose it from the For dropdown list at the upper left corner of the Change Working Times dialog. It lists the names of the available base calendars, as well as the names of all the resources. The Project base calendars are listed first, in the order created, followed by resource calendars ordered by resource ID. If a resource record is selected in a resource view before displaying the Change Working Time dialog, then the selected item in the For list defaults to the selected resource. Otherwise the current project calendar is selected.

Select the base calendar or resource calendar to edit or view...
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If you choose a base calendar or resource calendar from the list, you can make edits to that calendar for things such as which days are working days and what the working times are. 

Every base calendar is based on the internal default working times (for US, Mon-Fri, 8am-12pm, 1pm-5pm). Any edits you make to the base calendar are called base calendar exceptions.

If you choose a resource name from the list, it displays the resource calendar, and includes the name of the base calendar on which  the resource is based. Any edits you make to a resource calendar are called resource calendar exceptions. You can also access resource calendars using the new Resource Information dialog Working tab. This is discussed in detail later.

Selecting Weekday letters versus date cells

If you select a weekday letter (S,M,T,...,S) and then choose working or nonworking or edit the working times, the changes for that weekday apply to all months.

If you select one or more date cells, the changes apply only to the selected dates. 

Dragging to select multiple cells in different weeks automatically selects all the days in between. For example, continuous selections use continuous date ranges. You can use Control+Click to select discontiguous cells in the same or different weeks within the same month. You cannot select multiple dates from different months.

Working Time Formatting

This section compares the formatting and options used in the Change Working Time dialog in Microsoft Project 4.x and Microsoft Project 98.

Formatting in Microsoft Project 4.x Change Working Time dialog

In Microsoft Project 4.x, base calendars and resource calendars have different behavior regarding the working, nonworking, and default settings, and different date cell shading.

Microsoft Project 4.x: Working, nonworking, and default settings

When you click on any day letter or date cell in a base calendar, the Default option is never displayed as selected. If you select day letters or date cells and click on the Default option, it resets the selected items to the default settings, and then shows the working or nonworking option selected, or no option selected. 
[image: image594.png]Make date(:]
@ Warking

€ Norwoting
€ Default





None of the options are shown as selected if you select multiple items in the calendar that don't have the same setting.

When you select an item in a resource calendar, the appropriate option button is selected, even if it's the default button.

Microsoft Project 4.x: Shading

Base calendar date cells are shaded as follows:

· White: Working day

· Medium gray: Nonworking day

· Light gray: Working day with modified shift times.

Resource calendar date cells inherit the above shading from the parent base calendar, and in addition have the following exception shading, which can override the inherited shading:

· Medium blue: Working day exception (which may or may not be working in the base calendar). This formatting is used when you click the Working option or edit the shift times.

· Light blue: Nonworking day exception (which may or may not be working in the base calendar). This formatting is used when you click the Nonworking option.

Formatting in Microsoft Project 98 Change Working Time dialog

The Change Working Time dialog formatting in Microsoft Project 98 has been improved and simplified. Base calendars and resource calendars use the working, nonworking, and default options and date cell formatting in a consistent way. In addition, a new underlining format is used to mark which day letters or date cells have been changed from the default setting.

Microsoft Project 98: Working, nonworking, and default settings

When you click on any day letter or date cell in a calendar, the Default option is always selected unless you had previously set the selection to another option. 

None of the options is shown selected if you select multiple items in the calendar that don't all have the same setting.
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Microsoft Project 98: Shading and bold underlining

In Microsoft Project 98, shading and bold underlining are used in a consistent way, for both base calendars and resource calendars, to make it easy to tell which weekdays or specific dates are working or nonworking, and which are using the default setting, and which have modified shift hours. The new legend at the bottom of the dialog shows how to interpret the shading, and the bold and underlining:

Base calendars and resource calendars both have the same date cell shading and bold underlining formatting scheme:

· White: Working day

· Medium gray: Nonworking day

· Light gray: Working day with modified shift times.

· Bold underline: Exception created in that calendar (not in the parent base calendar).

Exceptions created in a base calendar or resource calendar are indicated by bold underlined day letters or date cell numbers. If the exception applies to a day letter, then that day letter has the bold underline format, not the individual date cells below it.

A resource calendar inherits the shading from its parent base calendar, but not the bold underlining from exceptions created in the base calendar. Calendar exceptions created in the resource calendar do use the bold underlining. 

Formatting from changes made in the resource calendar overrides inherited formatting. 

Instead of the two blue shades that Microsoft Project 4.x uses to distinguish resource exceptions from inherited changes, Microsoft Project 98 uses bold underlining. If you select one or more day letters or date cells and click the Working or Nonworking option, the selected item gets underlined.

Example

This example illustrates the formatting used in the Change Working Time dialog in Microsoft Project 98.
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The New command (in the Change Working Time dialog)

The New command button can be used to create new calendars. 

Creating new base calendars...
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The Options command (in the Change Working Time dialog)

The Options command button displays the Tools Options dialog Calendar tab, with all other tabs disabled. 

Calendar Options tab displayed from Change Working Time dialog...
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All of the settings, except the Use starting year for FY numbering setting, were available in Microsoft Project 4.x. The behavior of the first two settings changed in Microsoft Project 98. The first three settings are discussed in detail later. The last four settings changed little from Microsoft Project 4.x. 
Week starts on: This setting impacts how various items such as timescale labels, displays the start of the week. This setting is discussed in detail later. The default is Sunday.

Fiscal year starts in: This setting impacts how timescale labels jump from one year to another to indicate the start of a fiscal year. The default is January. This setting is discussed in detail later.

Use starting year for FY numbering: This setting is new in Microsoft Project 98 and is used in conjunction with the Fiscal year starts in setting. It is disabled by default. It is discussed in detail later.

Default Start Time: This time is used for any entered start dates when no specific time is specified. This applies to the project start, task starts, and any start constraints. It does not impact calendar working hours.

Default End Time: This time is used for any entered finish dates when no specific time is specified. This applies to the Project Finish, task finishes, and any finish constraints. It does not impact calendar working hours.

Hours per Day: The number of hours in a working day. This does not affect, or depend on, calendar settings. It is used by Microsoft Project to interpret durations displayed with day formatting.

Hours Per Week: The number of hours in a working week. This does not impact, or depend on calendar settings. It is used by Microsoft Project to interpret durations displayed with week formatting.

Set As Default: The previous settings are for the individual project. You can use the Set as Default button to save those settings to the Windows Registry. Then they will be used when new projects are created. After a new project is created, you can still change its local settings.

Week Starts On

In Microsoft Project 4.x, the Week Starts On setting in the Tools Options Calendar tab could only be Sunday or Monday. The setting was global only, for example, the same for all projects.

In Microsoft Project 98, The Week starts on setting can be any day of the week. The setting is local (saved per project), but the Set as Default button can be used to change the default setting for new projects.

Microsoft Project 4.x: Week can start on Sun or Mon...
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Microsoft Project 98: Week can start on any day...
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Effects of the 'Week starts on' setting (in Microsoft Project 98)

The list below shows the impact of the Week starts on setting on various items in Microsoft Project 98:

Date Picker dropdowns
The date picker control available in date fields in tables, forms, and dialogs uses the Week starts on setting.


Example with 'Week starts on' set to Wed...
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Timescale labels

Units of Weeks and Days both use the Week starts on setting.

This includes Days with Count equal to a multiple of 7. Microsoft Project 4.x always showed this case as Sunday, but Microsoft Project 98 uses the Week starts on setting


Example with Week starts on Wed, using timescale formatting of Weeks Count 1 over Days Count 7...
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W#/# date formats

The Date format setting in the Tools Options View tab has formats that count the week of the year and the day of the week:

[image: image603.bmp]
These formats do not use the Week starts on setting (none of the Date formats do). Instead, they always use Sun to determine the week count (the first week of the year must have 4 days in that year). They always count the day of the week starting with 1 for Mon.

For example, W23/4 means the 23rd week of the year on Thursday.


Example with 'Week starts on' set to Tuesday' and the Date format set to W5/5...
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The Week starts on setting has no impact on the Date format (otherwise Thursday would have had a count of 3 based on Tuesday as 1.)

Change Working Time calendars
Calendars in the Change Working Time dialog (and the Resource Information Working Time tab) show weeks starting on Sunday if the Week starts on setting is Sunday. If the Week starts on setting is any other day (Mon, ..., Sat), then they show weeks starting on Mon.


Example of a Change Working Time calendar with 'Week starts on' set to Wed...
[image: image605.png]Wed 6/11/97

Wed 6/4/97
[Sa[Su i [Tulwe

(V)
[ R
Change Working Time
Fori  [Standrd (Project Calendar)

June 1957
wlm[F[s





Note that the above calendar starts on Monday, not Wednesday.

Calendar view

The Calendar view shows weeks starting on Sunday if the Week starts on setting is Sunday. If the Week starts on setting is any other day (Mon, ..., Sat), then the Calendar view shows weeks starting on Mon.


Example of the Calendar view with 'Week starts on' set to Wed...
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Note that the above Calendar view starts on Monday, not Wednesday.

Reports

Reports with timescales are impacted the same way as views with timescales.


Example of a Crosstab weekly report with 'Week starts on' set to Wed...
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Fiscal Calendar

In Microsoft Project 4.x, when the Tools Options Calendar tab setting, Fiscal year starts in, is set to any month other than January, then timescale labels always jump from the current year to the next year at the specified month. However, some countries (such as Japan) and some individual users prefer using the fiscal year labels to jump from the previous year to the current year.

Microsoft Project 98 has a new setting to control whether the timescale labels should jump from the current year to the next year (as in the Microsoft Project 4.x behavior) or from the previous year to the current year (new behavior). The new option is the Use starting year for FY numbering. It is only available if the Fiscal year starts in setting is not set to January.

The setting is stored on a per project basis with an option to store it globally using the Set as Default button (to set the default for new projects).

Tools Options Calendar tab has the new 'Use starting year for FY numbering' option...
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Example

This example illustrates the use of the new Use starting year for FY numbering setting in Microsoft Project 98. It also compares the Microsoft Project 4.x behavior with the Microsoft Project 98 behavior.

Microsoft Project 4.x: Fiscal Year always jumps from current to next year...
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Microsoft Project 98: Fiscal Year can jump from current to next year...
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...or from previous to current year...
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Default setting

The Use starting year for FY numbering setting is ON (selected) by default for Japanese and Korean versions of Microsoft Project. It is OFF by default for other countries.

Fiscal year starts in January - Special Case

If the Fiscal year starts in setting is set to January, then the Use starting year for FY numbering setting is disabled. 

Start in January disables 'Use starting year for FY numbering' option...
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Effects of the 'Fiscal year starts in' setting 
In Microsoft Project 98, as in Microsoft Project 4.x, the Fiscal year starts in setting has no impact on the calculation or display of data. It only impacts the appearance of date labels in views and reports that have timescales.

New Resource Information Working tab

Every resource calendar is based on some base calendar that you can specify in the Resource Information dialog Working Time tab (the default is Standard). To display the Resource Information dialog, double click a resource in the Assign Resources dialog (use the Assign Resources toolbar button to display it). You can also double click a resource record in a resource table, or you can select a resource in a resource table and choose Resource Information from the Project menu or shortcut menu (right click).

New Resource Information Working Time tab...
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In the Resource Information Working Time tab, there is no dropdown list in the upper left corner for selecting a calendar to view or edit. The resource calendar you see is the one you used to display the dialog. The resource calendar can be edited in the Working Time tab just as calendars are edited in the Change Working Time dialog.

The New and Options command buttons that are in the Change Working Time dialog are not in the Resource Information dialog Working Time tab.

The Resource Information dialog Working Time tab does have a Details command button not available in the Change Working Time dialog. The Details button displays email address information for the resource.

Details tab displayed from the Resource Information dialog Working Time tab...
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Saving Calendars

Calendars are saved as part of the individual project file. The default Standard calendar is contained in the Global.mpt file and copied to new project files as they are created. Any changes made to the Standard calendar or to any new calendars created are then saved as part of the project file.

The Organizer may be used to copy new calendars into the global file, or between project files. It may also be used to delete or rename calendars. The Organizer can be displayed from any dialog that has the Organizer command button, for example in the More Views, More Tables, and More Filters dialogs.

Resource Availability Dates

Microsoft Project 98 has new resource availability settings in the Resource Information dialog General tab. You can specify that a resource is available for the entire project, or you can specify a date range. 

New Availability dates...
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The default setting is Available for entire project. 

You can give a specific start and finish date to limit the availability of a resource on the active project entering From and To dates

There are two new resource fields corresponding to the From/To dates in the Resource Information dialog General tab. The fields are Available From and Available To.

Available From/To fields in Resource Sheet and Resource Information dialog General tab.
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The Available From/To dates are not linked directly to the resource's calendar. Edits to the resource calendar do not impact the Available From/To dates, and vice versa.

No impact on scheduling

The Resource availability settings do not determine non-working days for a resource. Instead, the resource max units behave as if it is zero outside of the availability range. The resource can still be scheduled outside the availability range as dictated by the resource calendar, but the resource will be over allocated on such assignments.

This is similar to the way you can assign a resource to work at 200% units on some days, even though the max units may only be 100%. The resource will still be scheduled on those days, however the resource will be marked as being over allocated.

Effect on leveling

The Resource availability settings can have an impact on leveling, since leveling will try to adjust the tasks and or assignments to resolve the overallocation introduced by the availability settings.

Lesson 5.2 - Exercises

1.
Describe some of the calendar exception format differences in the Change Working Time dialog in Microsoft Project 98 versus Microsoft Project 95. 

2.
What is the purpose of the new Use starting year for FY numbering setting in the Tools Options Calendar tab?

3.
How has the Week starts on setting in the Tools Options Calendar tab changed in Microsoft Project 98 versus Microsoft Project 95? Which parts of Microsoft Project 98 respect this setting completely and which only respect it partially?

4.
What are the two dialogs in Microsoft Project 98 that can be used to access a resource calendar? How does this differ from Microsoft Project 95?

5.
What is the effect of using the Resource availability From/to date range in the Resource Information dialog General tab?

A. All the days outside the specified date range are automatically marked as nonworking in the corresponding resource calendar. 

B. There is no effect on the resource calendar, but all the days outside the specified date range are scheduled as if they are nonworking regardless of what the resource calendar says.

C. For all the days outside the specified date range, leveling behaves as if the Max Units for the resource is zero, regardless of what the Max Units actually is.

Lesson 5.2 - Labs

Lesson 5.2 - Lab 1

Format the timescale in a Gantt Chart for years over months (where the month label includes the year) and change the Fiscal Year to start in July. Do this once when the Use starting year for FY numbering setting is OFF and once when it is ON, and observe how it effects the timescale labels for June, July, and August of any year.

Lesson 5.2 - Lab 2

1.
Create a project and set its Project Start date to 6/2/97. Enter a single one day ASAP task T1 and assign a resource R1. 

2. 
Switch to the Resource Sheet view and insert the Overallocated field (it will be No for R1). Double click the resource R1 and in the Resource Information dialog General tab set the Resource Availability From 6/4/97 to 6/30/97 and click OK. The Overallocated field for R1 should now say Yes. Switch back to the Gantt Chart. The task should still start on 6/2/97.

3.
Level the project using the default settings. The task should have been moved out to 6/4/97, and if you switch to the Resource Sheet view, you can see that R1 is no longer overallocated.

Why did leveling move the task even though the resource was only assigned to that one task and was only assigned at 100% units with the Max Units field set to 100%?

Lesson 5.3: Constraints

Some Topics to be introduced in this lesson include:

· Different kinds of constraints

· Effect of "Tasks will always honor their constraints" option setting

· Behavior when Schedule Project from Start versus Finish

New setting: Tasks will always honor their constraint dates

In Microsoft Project 4.x, future limiting constraints such as Must Start On (MSO) (and Finish No Later Than (FNLT) are hard constraints if the project is scheduled from start. For example, if the task has a constraint of FNLT 6/1/97, then even if its predecessor task has an Actual Finish of 8/1/97 the FNLT successor task is scheduled to finish on June 1. Microsoft Project flags this problem by putting negative slack in the Total Slack field for the predecessor task, and by providing Alerts. Likewise, leveling in Microsoft Project 4.x could not move tasks with certain hard constraints in order to solve overallocation problems.

In Microsoft Project 98, the new Tasks will always honor their constraint dates option in the Tools Options Schedule tab controls whether or not constraints can be violated in order to obey predecessor/successor relationships, or to resolve overallocations during leveling.
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This setting is selected by default. It is a per project setting.

The setting behaves as follows:

· If selected, then leveling cannot make adjustments to tasks that would violate their constraints, such as MSO (Must Start On), MFO (Must Finish On), FNLT (Finish No Later Than), and SNLT (Start No Later Than). Also, a successor task must honor its constraint even if it means violating a relationship with a predecessor.

· If not selected, then leveling can adjust tasks regardless of their constraints. Also, a successor can be scheduled as its predecessors dictate, even if it means that the successor constraint will be violated. In cases where a constraint is ignored to satisfy a relationship, the successor still has negative slack, although it is scheduled as the relationship dictates.

When the setting is on, it can impact the behavior of the MSO and MFO constraints, whether the project is scheduled from finish or start. It impacts the behavior of the future limiting FNLT and SNLT constraints only if the project is scheduled from start, and it impacts the past limiting FNET and SNET constraints only if the project is scheduled from finish.

Example

This example illustrates the impact of the new Tasks will always honor their constraint dates setting in a project scheduled from start. 

The picture below shows the original schedule with no scheduling problems. Task T2 is the predecessor of task T3, with a Finish-to-Start relationship with no lag, and T3 has the future limiting constraint of FNLT 6/4.

Original schedule before moving the predecessor...
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Next, the bar for the predecessor T2 is dragged into the future to 6/6 (giving it an SNET constraint), although giving it an Actual Start date of 6/6 would have had the same impact. After dragging T2 to 6/6 and dropping it, the following Alert is displayed, regardless of the Tasks will always honor their constraint dates setting:
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After you click OK, the result depends on the Tasks will always honor their constraint dates setting, as shown in the two pictures below:

'Tasks will always honor their constraint dates' setting is ON...
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'Tasks will always honor their constraint dates' setting is OFF...
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Lesson 5.3 - Exercises

1.
Assuming that the Tasks will always honor their constraint dates option is not selected, identify all of the following statements that are true? (There may be more than one true statement.)

D. All tasks behave liked ASAP tasks.

E. Leveling is allowed to move a task with an MSO constraint in order to resolve an overallocation.

F. Tasks with MSO, MFO, FNLT, and SNLT are scheduled as if they are ASAP.

G. The constraint on a successor task may be violated in order to honor the relationship with a predecessor.

2.
Should the Tasks will always honor their constraint dates option in Microsoft Project 98 be selected or not selected in order to produce the scheduling behavior most like that in Microsoft Project 95?

Lesson 5.3 - Labs

Lesson 5.3 - Lab 1

1.
Create a project with ASAP tasks T1 and T2, with 1d duration each. Make T1 be a predecessor of T2 with an FS relationship. Give T2 an MSO constraint with a constraint date equal to its Start date. Insert the Total Slack column into the task table in the Gantt Chart.

2.
With the Tasks will always honor their constraint dates option selected, drag the Gantt bar for T1 several days to the right of T2. This should produce an alert, and T2 should not move. Examine the Total Slack values.

3.
Unselect the Tasks will always honor their constraint dates option. T2 should now move to the right to follow T1. Examine the Total Slack values.

Lesson 5.3 - Lab 2

1.
Create a project with ASAP tasks T1 and T2, with 1d Duration each. Assign resource R to both of them. Give T1 and T2 MSO constraints with constraint dates equal to their Start dates. Insert the Total Slack column into the task table in the Gantt Chart.

2.
With the Tasks will always honor their constraint dates option selected, level the project using the default leveling settings. It should not be able to resolve the overallocation. 

3.
Unselect the Tasks will always honor their constraint dates option and level again. Now it should move one of the tasks to resolve the overallocation. Examine the Total Slack values.

Lesson 5.4: Task Types and Effort Driven Options

Some Topics to be introduced in this lesson include:

· Definitions of task Types: Fixed Duration/Units/Work

· New way Duration is calculated

· Definition of Effort Driven task: Try to keep task work constant as assignments are added/removed

· Fixed Work task always is Effort Driven

· Tools Options Schedule tab "Default task type" setting and "New tasks are effort driven" option

· Calculations for different choices of the Task Type setting and Effort Driven option

Task Type and Effort Driven settings

In Microsoft Project 4.x, you can have Fixed Duration tasks and resource driven tasks, which can be considered fixed unit tasks. Microsoft Project 4.x has a Yes/No field, named Fixed, that controls whether a task is Fixed Duration or not. Fixed Duration tasks behave as though the Duration is a fixed value and any changes to the work or assigned units on the task don’t impact the task Duration. Likewise Resource Driven tasks behave as though the assigned units on the task are fixed and any changes to work or Duration don’t impact the assigned units on the task.

In Microsoft Project 98, there is a new task field, named Type. It  extends and replaces the functionality of the Microsoft Project 4.x Fixed field. The Type field allows you to choose the Fixed Duration, Fixed Units, or new Fixed Work type. This means that you are able to fix any one of Work, Duration, or Units. Changes to either of the two non-fixed ones impact the other non-fixed one, leaving the fixed one alone. The task Type field can be inserted into a task, and is also available in the Task Information dialog Advanced tab.
New Microsoft Project 98 task field named "Type"
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Access the Type setting in a task table, Task Information, or a Task Form...
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The new task Type Fixed Work setting allows you to edit the Duration and have Microsoft Project calculate the units required to perform the work over the existing span of the assignments. Any changes to the task Duration or assignment unit values do not change the task or assignment work values. Instead, if you change Duration or units then the others are calculated, not the task works.
The behavior of the task Type setting propagates down to the individual assignments on the task, although the Type field is blank for assignment records (as viewed in the Task Usage view). The Type setting can be considered a task specific editing rule that also rolls down to the assignments on the task.

If one of the work, units, or Duration variables is fixed, and you edit one of the other two non-fixed variables, then the other non-fixed variable is calculated. For example, if the task has the Fixed Work type and you edit the task Duration, then the Units are calculated.

If the fixed variable is edited, then one of the other variables is changed according to the rules in the table below.

Field that you change
Field calculated if the task is Fixed Duration
Field calculated if the task is Fixed Units
Field calculated if the task is Fixed Work

Work
**Units are recalculated
Duration is recalculated
Duration is recalculated

Duration
Work is recalculated
Work is recalculated
Units are recalculated

Units
Work is recalculated
Duration is recalculated
Duration is recalculated

** Indicates change in behavior from Microsoft Project 4.

In the above table, Work refers to task or assignment total work. Units refer to assignment units, and Duration refers to task or assignment Duration.

Note: Assignment Duration is not an exposed field. The Duration field for assignments in Usage views is blank. The Assignment Start and Assignment Finish fields are exposed and editable. 

Formulas relating work, units, and Duration

Microsoft Project 4.x had a simple equation relating task Duration, assignment work, and assignment units, for assignments that spanned the whole task (driving assignment):

Assignment Work = (Task Duration) times (Assignment Units)

Because of the new predefined and custom contours, the Assignment Work = (Task Duration) times (Assignment Units) formula applies to Microsoft Project 98 only under special cases. The general directional change relationships always apply. For example, for a Fixed Duration task, increasing assignment units should increase assignment work for driving assignments. The increase is  not necessarily a proportional increase, however. Even when it is a proportional increase, another constant may be introduced into the above equation.

At the assignment level

Whether or not an assignment drives a task, there is still a relationship between assignment work, assignment units, and assignment Duration. Assignment Duration is not an exposed field, but you can think of it as the working Duration between the assignment start and finish. In the Task Usage view, the Duration field is blank for assignments, but you can edit the Start and Finish field in an assignment record to change the assignment Duration.

The general differences between edited and predefined contours follow:

· Predefined contours: When any non-timephased values change, the predefined contour is refitted into the new Assignment Duration, Work, and Units using the equation:

Wassmt = Dassmt * (Uassmt * UscaleAvg)

The symbols in the equation are abbreviations for the following:

Dassmt: Total Assignment Duration

Wassmt: Total Assignment Work

Uassmt: Peak (max) Assignment Units

UscaleAvg: For a predefined contour, this is the average of the ten segments Units scaling factors for the predefined contour. 

· Edited contours: When Assignment Work is increased, then the additional Work extends the current rightmost contour segment, using the rightmost segment Units. When Assignment Work is decreased, the Work is truncated from the rightmost segments.

Contours are discussed in detail in another lesson.

Fixed Work and Effort Driven Settings

Microsoft Project 98 has another new task field; Effort Driven. It relates to the Type field. The Effort Driven field extends and replaces the functionality of the Microsoft Project 4.x Effort_Driven macro.

Effort Driven is a Yes/No task field that determines what happens to task total Work when resources are added to or removed from a task. The Effort Driven field has an impact only when you add additional resources to the task, or remove resources from the task. If a task is Effort Driven, then whenever resources are added to or removed from the task, the task remaining Work is unchanged and is redistributed among all the resources on the task. This can cause the task and assignment Duration or the assignment units to change, depending on the task Type.

The Effort Driven field can be inserted into a task table, and is also available in the Task Information dialog Advanced tab, and in Task Form views. Whenever you set a task type at Fixed Work, the task Effort Driven field is automatically set to Yes and becomes noneditable. For Fixed Units and Fixed Duration types, you can choose whether or not the task is Effort Driven.

Interface changes related to the Type and Effort Driven fields

Task Form and Task Detail Form Views

Task Form view in Microsoft Project 98...
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Task Details Form view in Microsoft Project 98...
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· The functionality of the Microsoft Project 4.x Fixed checkbox has been extended and replaced by the Microsoft Project 98 Task type dropdown.

· The Microsoft Project 98 Effort Driven checkbox is new.

Task Information Dialog:

· The functionality of the Microsoft Project 4.x Duration Type control in the Task Information dialog Resources Tab has been extended and replaced by the Microsoft Project 98 Task type dropdown in the Task Information Advanced tab.

· The Microsoft Project 98 Effort Driven checkbox in the Task Information Advanced tab is new.

Tools Options Schedule tab

The functionality of the Microsoft Project 4.x Default Duration Type setting has been extended and replaced by the Microsoft Project 98 Default task type setting.

If you set the default task type at Fixed Work, then Microsoft Project automatically sets the equivalent effort driven default setting at Effort Driven, and disables the setting so you can’t change it.

Scheduling options in the Microsoft Project 98 Tools Options Schedule tab.
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Calculations related to the Fixed Work type

When a task has the Fixed Work type, then Microsoft Project tries to keep the total task work value at its current value when you perform editing operations on related task or assignment fields.

Increasing the value in the task Duration field

If you edit the task Duration, then only the assignments that originally finished when the task finished are  impacted. The new assignment finish is the same as the new task finish. 

For  impacted assignments, the total assignment work does not change, but the assignment timephased work values change so the same total assignment work is redistributed over the new assignment Duration. Microsoft Project does this by calculating a new unit value for each assignment segment. This keeps the total task work at the same Fixed Work value.

The number of Assignment Segments and each Segment Work is unchanged. The change in each Segment Duration is proportional to the change in Assignment Duration. The change in each Segment Unit is inversely proportional to the change in Assignment Duration.

Example

This example illustrates the impact of increasing the value in the Duration field of a Fixed Work task. T is a Fixed Work task with a Duration of 4d, and with the five assignments shown below.

Before increasing the Duration of this Fixed Work task....
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Next, the Duration is edited and increased to 8d.

After increasing the task Duration to 8d for this Fixed Work task...
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The total Work column values for the task and all of its assignments are unchanged, because T is a Fixed Work task. 

Only the durations and contours for R1, R4, and R5 changed, because they were the only assignments that had work scheduled at the finish of the task.

The calculations that occurred are shown below:

R5's assignment:

Originally it had 16h of work spread over 4d using the predefined Bell contour. Because the task is Fixed Work, when the Duration of R5's assignment doubled, its work stayed the same, and the units were cut in half. The Bell contour automatically adjusted to spread the 16h over the longer Duration. 

Predefined contours always consist of ten segments, each segment with its own unit and Duration. It is not easy to see the segments in this example, because the segment durations are integral multiples of whole days (the initial Duration of each segment was 4d/10, and the final Duration of each segment is 8d/10). Each of the ten segments doubled in length and had its units cut in half, keeping its work constant.

R1's assignment:

The assignment has a Flat contour and its Duration doubled so the units were simply cut in half (inverse proportion), spreading the same amount of work over the longer Duration.

R2's assignment and R3's assignment:

No change since they had no work at the end of the task.

R4's assignment:

The original assignment had work at the task Finish, so when the task Finish moved out, so did the assignment Finish. 

The original assignment consisted of two segments: {6h spread over 1d} and {3h spread over 1d}. It had a Start of 6/18 and a Finish of 6/19, so its Duration was 2d (not the task Duration of 4d). After changing the task Duration to 8d, the assignment Finish changed to match the new task Finish date of 6/23. So now the assignment dates are 6/18 to 6/23, and its Duration is now 6d (not the task 8d). So the assignment Duration tripled from 2d to 6d. Each of the two assignment segments gets its Duration tripled while its work remains constant, so the new segments are {6h spread over 3d} and {3h spread over 3d}. So the first segment gets 2h per day for 3 days, and the second segment gets 1h per day for 3d. 

Note that in general, a contour can have any number of segments, and the segments can have different Duration and work units.

The picture below takes a closer look at R4's assignment before (top line) and after (bottom line).

R4 assignment when the task Duration was 4d (top line) versus 8d (bottom line)...
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In each of the next two pictures, the top pane shows R4's assignment timephased work in the Task Usage view, and the bottom pane shows R4's assignments timephased Peak Units in the Resource Graph formatted for selected tasks only.

R4's assignment timephased work and units BEFORE the task Duration was changed...
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R4's assignment timephased work and units AFTER the task Duration was changed...
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Decreasing the value in the task Duration field

If you decrease the task Duration, then Assignments whose original Assignment Duration is greater or equal to the new Task Duration have their Assignment Duration set to the new Task Duration. Other Assignments are unchanged.

The number of Assignment Segments and each Segment Work is unchanged. The change in each Segment Duration is proportional to the change in Assignment Duration. The change in each Segment Units is inversely proportional to the change in Assignment Duration.

Special case: If you enter 0d for the task Duration, then all assignment information is lost.

Example

This example illustrates the impact of decreasing the value in the Duration field of a Fixed Work task.

Before decreasing the Duration of this Fixed Work task....
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After decreasing the Duration of this Fixed Work task....
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The calculations that occurred are shown below:

R1's assignment:

The original assignment Finish date is greater than or equal to the new task Finish, so its new Finish is set equal to the new task Finish, and the task duration is decreased from 12d to 6d, and its work is redistributed.

It originally had three segments: {16h spread over 2d, at 8h/d}, {24h spread over 4d, at 6h/d}, and {24h spread over 6d, at 4h/d}. Each segment Duration is decreased by the same factor as the task Duration was decreased, so each segment Duration is cut in half too, and its units doubled. So the new segments are {16h spread over 1d, at 16h/d}, {24h spread over 2d, at 12h/d}, and {24h spread over 3d, at. 8h/d}

R2's assignment:

The original assignment Finish date is greater than or equal to the new task Finish, so its new Finish is set equal to the new task Finish, and the Duration is decreased from 9d to 6d, and its work is redistributed.

The original assignment had one segment: {72h spread over 9d, at 8h/d}. The final segment Duration is 6d and its work is unchanged, so the new segment is {72h over 6d, at 12h/d}.

R3's assignment:

The original assignment Finish date is less than the new task Finish, so nothing happens to this assignment.

R4's assignment:

The original assignment Finish date is greater than or equal to the new task Finish, so its new Finish is set equal to the new task Finish, and the Duration is decreased from 12d to 6d, and its work is redistributed.

It originally had two segments: {32h spread over 4d, at 8h/d} and {12h spread over 2d, at 6h/d}. Each segment Duration is decreased by the same factor as the task Duration was decreased, so each segment Duration is cut in half too, and its units doubled. So the new segments are {32h spread over 2d, at 16h/d} and {12h spread over 1d, at 12h/d}.

Extending a task or task part in the Gantt Chart

You can use the mouse to increase the Duration of individual task parts. 

If you use the mouse to increase the Duration of an individual part of a Fixed Work task, then the assignment segments in that part are  impacted similarly to when the entire task Duration is increased.

Example

This example illustrates the impact of increasing the Duration on a Fixed Work task by dragging the end of a split task part. 

Before extending the middle part...
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After extending the middle part...
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The values in the Work column for the task and each assignment did not change because T is a Fixed Work task. 

The Duration of the middle part increased from 2d to 4d. The amount of work in the middle part for the task and each assignment did not change. 

Only assignments that have work scheduled at the end of the middle part are  impacted.

R1's assignment:

The 16h of work that R1's assignment had in the middle part is now spread over 4d, which gives 4h per day.

R2's assignment:

The 6h of R2’s work assignment at the end of the middle part is now spread over 3d. That gives 2h per day.

R3's assignment:

No change since it had no work on the end of the middle bar.

Reducing a task or task part in the Gantt Chart

You can use the mouse to decrease the Duration of individual task parts.

If you use the mouse to decrease the Duration of an individual part of a Fixed Work task, then an assignment is impacted only if its Finish date lies in that part and is greater or equal to the new task part Finish. In that case, it is impacted similarly to when the entire task Duration is decreased. 

If you drag the end of the task part to the left of its part Start then the entire part and all assignment information for that part is lost.

Summary Tasks and Subproject Tasks

Summary tasks and inserted projects are always Fixed Duration tasks.

However, Microsoft Project remembers what the task type of the summary task used to be before it became a summary task. So if the summary task is changed back into a regular task, it has its old task type restored instead of being set to Fixed Duration.

Effort Driven Tasks

When a task is Effort Driven, Microsoft Project tries to keep the total task remaining work value at its current value as resources are assigned or removed from the task. 

The Effort Driven setting has no impact unless the task already has some nonzero remaining work. If an Effort Driven task has zero remaining before you add a resource, or add multiple resources simultaneously, then these resource(s) are assigned as if the task were not Effort Driven. For example, if a 4d Effort Driven task has no assignments originally, and then you assign several resources at the same time, then they all get 32h of work.

Some of the ways to assign more than one resource at the same time are listed below:

· Assign several resources in a Task Form view before clicking OK.

· Select several resources in the Assign Resources dialog (displayed by the Assign Resources toolbar button), and then click the Assign button.

The rest of this discussion assumes the task already has some remaining work before the number of assignments is changed.

Effort Driven Calculations

Microsoft Project remembers the task remaining work before you change the number of resources assigned to it. After you add or remove assignments, Microsoft Project automatically resets the task remaining work to its prior value, and redistributes the remaining work to the assignments in proportion to their current Remaining Work values. 

Another way to understand the results of adding or removing assignments to or from an Effort Driven task is to think about how the same results could be produced manually if the task were not Effort Driven (and not Fixed Work). This manual process is described below:

· Before you assign or remove resources to or from the task, insert the Work column in a task table, and note the value for that task.

· Assign or remove resources to or from the task.

· Enter the original task work value back in the Work field for the task.

The above steps should produce the same result if the task had been Effort Driven, only you would not have had to reenter the original work value. Effort Driven tasks does that for you automatically.

Example

This example illustrates the impact of the Effort Driven setting in combination with the different Type settings. No Actual Work is used in this example; so work and remaining work are the same. 

Resources R1 and R2 have already been assigned to the task T and their contours edited as shown in the Task Usage picture below:
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Next, resource R3 is assigned to the task without specifying the amount of assignment work or units.

Microsoft Project gives the new assignment the default units of 100% and gives it the default amount of work, 32h, based on the current task Duration of 4d. It then calculates the proportions of total work that each assignment would have had if the task had not been Effort Driven. The picture below shows what the result would be for a Fixed Duration or Fixed Units task that is not Effort Driven. This picture is for illustration purposes only. Microsoft Project does not display it during its internal Effort Driven calculations.

Results if the task had not been Effort Driven...
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Microsoft Project internally uses the above hypothetical case to calculate the ratios that it uses to distribute the original task work value:

For R1: 16h/64h = 1/4

For R2: 16h/64h = 1/4

For R3: 32h/64h = 1/2

Since the task really is Effort Driven, the task remaining work does not change from 32h to 64h after R3 is assigned, but instead stays at 32h. Microsoft Project uses the above internally calculated factors to distribute the original 32h of remaining work across the three assignments:

For R1: 1/4 of 32h = 8h

For R2: 1/4 of 32h = 8h

For R3: 1/2 of 32h = 16h

Once the assignment work values are calculated, the final result depends on the task Type as shown in the pictures below. 

Effort Driven and Fixed Duration ...
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Effort Driven, and Fixed Units or Fixed Work...
[image: image642.png]




Adding/Removing assignments if the task has Actual Work

If the task already has some actuals entered against it and you then add or remove assignments, Microsoft Project keeps the task work at its original value and tries to preserve the Actual Work values as well.

Adding an assignment to an Effort Driven task that has Actual Work 

Regardless of the Effort Driven setting, the new assignment starts at the task current Resume date (which is the earliest assignment resume date).

No Actual Work is added to the new assignment. Only remaining work is distributed among the assigned resources. The task original remaining work value is distributed to the assignments based on the ratios of their remaining work values. 

Example

This example illustrates the impact of the Effort Driven setting in combination with the different Type settings, when adding an assignment to a task that already has Actual Work. 

Resources R1 and R2 have already been assigned to the task T. Their timephased work and Actual Work contours have been edited as shown in the Task Usage picture below. 
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Note that the assignments for R1 and R2 have resumes dates of Day4 at 8am and Day2 at 8am respectively, so the task Resume date is the Day2 at 8am (the task resume date is always the earliest assignment resume date).

Next, resource R3 is assigned to the task without specifying the amount of assignment work or units. Microsoft Project gives the new assignment the default units of 100% and gives it the default amount of work, 24h, based on the current task resume and finish dates. It then calculates the proportions of total task remaining work that each assignment would have had if the task had not been Effort Driven. The picture below shows what the result would have been for a Fixed Duration or Fixed Units task that is not Effort Driven. This picture is illustration purposes only. Microsoft Project does not display it during its internal Effort Driven calculations.

Results if the task had not been Effort Driven...
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Microsoft Project internally uses the above hypothetical case to calculate the ratios that it uses to distribute the original task remaining work value (48h remaining work, not the 65h work):

For R1: 8h/48h = 1/6

For R2: 16h/48h = 1/3

For R3: 24h/48h = 1/2

Since the task really is Effort Driven, the task remaining work does not change from 24h to 48h after R3 is assigned, but instead stays at 24h. Microsoft Project uses the above internally calculated factors to distribute the original 24h of remaining work across the three assignments:

For R1: 1/6 of 24h = 4h

For R2: 1/3 of 24h = 8h

For R3: 1/2 of 24h = 12h

Once the assignment remaining work values are calculated, the final result depends on the task Type as shown in the pictures below:

Effort Driven and Fixed Duration
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Effort Driven and Fixed Units

Or

Effort Driven and Fixed Work
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Removing an assignment that has Actual Work from an effort driven task

Microsoft Project displays an alert if you try to delete an assignment that has Actual Work. You can choose to proceed with the operation or cancel it. 

 If you proceed, Microsoft Project removes the resource assignment and adds all of its work (actual and remaining) to the task remaining work, which is then distributed to the other resources in proportion to their remaining work. If all of the other assignments are already completed, then the removed work is assigned as remaining work to all the resources in proportion to their Actual Work.

Example

This example illustrates the impact of the Effort Driven setting in combination with the different Type settings, when removing an assignment that has Actual Work from a task.

Resources R1, R2 and R3 have already been assigned to the task T. Their timephased work and Actual Work contours have been edited as shown in the Task Usage picture below. 
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Next, the assignment for R3 is selected and the Delete key is pressed, causing the Alert shown on the right to be displayed.
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After clicking Yes to the Alert, Microsoft Project then calculates the proportions of total task remaining work that each assignment would have had if the task had not been Effort Driven when R3's assignment was deleted. The picture below shows what the result would have been for a Fixed Duration or Fixed Units task that is not Effort Driven. This picture is for illustration purposes only. Microsoft Project does not display it during its internal Effort Driven calculations.

Results if the task had not been Effort Driven...
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Microsoft Project internally uses the above hypothetical case to calculate the ratios that it uses to redistribute R3's 12h of work.

For R1: 8h/24h = 1/3

For R2: 16h/24h = 2/3

Since the task really is Effort Driven, the task work does not change from 53h to 41h after R3 is removed, but instead stays at 53h. Microsoft Project uses the above internally calculated factors to redistribute the original 12h of work (actual and remaining) that R3 had before it was removed. This increases the remaining work of R1 and R2 as shown below:

Remaining work for R1 increases by: 1/3 of 12h = 4h

New remaining work for R1 is its original plus the increase = 8h + 4h = 12h

Remaining work for R2 increases by: 2/3 of 12h = 8h

New remaining work for R2 is its original plus the increase = 16h + 8h = 24h

Once the new assignment remaining work values are calculated, the final result depends on the task Type as shown in the pictures below:

Effort Driven and Fixed Duration 
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Effort Driven and Fixed Units

or

Effort Driven and Fixed Work
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Restrictions When Assigning a Resource to an Effort Driven Task

Alert when specifying work

If you attempt to enter a work value when creating an assignment on an Effort Driven task, the following alert is displayed:
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For example, the above Alert is displayed in the following cases for an Effort Driven task:

· In the Task Form view, you type an assignment resource name and assignment work before clicking OK.

· In the Assign Resources dialog (displayed by the Assign Resources toolbar button), you type a work value in the Units field before clicking the Assign button (if the task were not Effort Driven, Microsoft Project would calculate the units for you based on the entered work).

Alert when specifying units

If you attempt to enter a unit’s value when creating an assignment on an Effort Driven task that has the Fixed Duration type, the following alert is displayed:
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Summary Tasks and Inserted Project tasks are Never Effort Driven

The Effort Driven value for a summary task or inserted project task is automatically set to No.

If a summary task later becomes a regular task, its effort driven setting returns to the value it had before it became a summary task.

Lesson 5.4 - Exercises

1.
The Microsoft Project 98 task Type field replaces and extends what Microsoft Project 95 task field?

2.
The Fixed Work value for the Microsoft Project 98 task Type field replaces what Microsoft Project 95 macro?

3.
If a single resource is assigned across the whole duration of a Fixed Work task, which of the following fields change if you change the total assignment Work?

A. Task Duration.

B. Assignment Units

4.
What is an Effort Driven task?

5
What effect (if any) does the Effort Driven setting have when you increase the Duration of a task?

6.
What kinds of tasks are never Effort Driven?

What kinds of tasks are always Effort Driven?

7.
What happens if you try to assign another resource to a task in the Task Form and enter a work value at the same time before clicking OK?

Lesson 5.4 - Labs

Lesson 5.4 - Lab 1

Recreate the example in the Increasing the value in the task Duration field section of this lesson: Create a project as shown in the Before picture and then increase the duration to 8d and compare your results to the After picture. Read the explanation of the results.

Lesson 5.4 - Lab 2

Recreate the example in the Extending a task or task part in the Gantt Chart section of this lesson: Create a project as shown in the Before picture and then extend the middle part with the mouse as shown in the After picture. Compare your results to the After picture. Read the explanation of the results.

Lesson 5.4 - Lab 3

Recreate the example in the Adding an assignment to an Effort Driven task that has Actual Work section of this lesson: Create a project as shown in the Before picture and then extend the middle part with the mouse as shown in the After picture. Compare your results to the After picture. Read the explanation of the results.

Lesson 5.5: Resource Contouring

Some Topics to be introduced in this lesson include:

· Resource Information dialog General tab "Working contour" setting

· Predefined contours

· Custom (edited) contours

· Actions impacting contours

Resource Contouring

Resource Contouring allows you to vary the working load of a resource at the Assignment level. 

Microsoft Project 4.x accomplished contouring by allowing a resource to be assigned multiple times to the same task. The Start of each Assignment segment was adjusted using the Assignment Delay field.

Microsoft Project 98 has a more powerful and flexible approach that allows you to specify the amount of time a resource works per time period on a task. It only allows a resource to be assigned once to the same task, because the new contouring features don't need to have a resource assigned more than once per task.

Scheduling of Overtime Work has also been improved in Microsoft Project 98.

The main User Interface (UI) for these new features is an editable usage view that can show task and assignments (Task Usage) or resources and assignments (Resource Usage) in the same view. You can then edit the Work loading (and other usage related data) for each Assignment under each task or resource record.

New Task Usage View
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Improved Resource Usage View
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Values displayed in the grid under the timescale in usage views are referred to as timephased or timescaled values.

You can contour task, resource, and Assignment Work by period to better reflect real world Work patterns and constraints. This feature also works closely with the new Task Splitting feature.

Resource contouring is an attribute of the Assignment rather than an attribute of the task or the resource. Regular non-contoured assignments behave like a sub set of contouring. By default when a resource is assigned to a task it gets an even distribution of Work that is front loaded (as in Microsoft Project 4.x). You can at any time edit the Work values per time period to contour the Workload. This editing can be done via a Task Usage or Resource Usage view. There are other timephased values that can be displayed in the usage views as well, such as Actual Cost and Overtime Work.

You can specify a predefined contour such as front loading, back loading, and bell-curves from the new assignment dialog (see Creating a Resource Contour below). You can then alter specific parts of the contour in a usage view.

Smallest Timeslice

The smallest Work unit is minutes.

The daily timescale is the default timescale unit in Format Timescale. Hours per day is the default for the "Work is entered in" setting in the Tools Options Schedule tab.

Technical Definition of a Contour

Note: Sometimes the term contour is used to describe the absolute distribution of Work, including the Assignment Start and the relative Work pattern (or shape). More often, the term is used to refer only to the relative Work pattern (regardless of Start). In contexts where confusion might arise, the term "absolute contour" can be used  to refer to a specific Start date. The term "relative contour" (or "contour shape/pattern") can be used to refer only to the shape, regardless of Start.

A relative Assignment contour can be thought of as a one or more segments, each segment consisting of a {Duration, Units} pair. In this context, Duration is an amount of time (not necessarily the task Duration), and Units is a Work rate. 

Note that the Duration field is blank for Assignment records in Usage views. However, the concept of an Assignment Duration is useful in understanding how Microsoft Project 98 manipulates Assignment contours.

When you first assign a resource to a task, the Assignment has a single contour segment  with a Duration equal to the task Duration and Units of 1 (or the resource's Max Units if smaller than 1).

You can then switch to the Task Usage or Resource Usage view and double click the Assignment to display its Assignment Information dialog and select one of the predefined contour types from the Work Contour tab (described in the Assignment Information Dialog section later). Applying a predefined contour breaks the Assignment up into ten segments (fewer are used for small Duration tasks since no segment can be less than a minute in length). Predefined contours are described in detail later.

You can also edit the Work values in the usage view to create a custom contour, known as a custom contour. When you edit values, the timescale granularity format (hour by hour, day by day, week by week, and so on) plays a role in determining the number and Duration of the segments for your custom contour. The Work you enter divided by the segment Duration produces the Units for that segment.

Note: The segment Units calculation also depends on whether the cell you type in contains the task Start or Finish - more on this later.

Even Distribution of Edited Timescaled Data

Entered timephased Work is spread evenly over the Work period in which you enter the data. There are some exceptions to this rule to account for the Start and Finish of a task. This is covered in more detail later

For example, if you enter 4h in a specific day cell for one of Joe's assignments, then it spreads Joe’s Workload evenly over that entire day, so that the Assignment has 4h of Work at a Work rate of 0.5 Units. 

Preservation of Contour Shape
One of the important concepts in contouring is the preservation of the Work contour shape when the task is moved, or when calendars are edited.

Moving Work Contours 

Work contours are preserved when tasks are moved. For example, the number of segments, and the definition of each segment (its Duration and Units), are preserved, although shifted in time.

Note that the underlying definition of the contour shape is what gets preserved. The data in particular views may appear to change depending on what kind of data is displayed (Work, Units, and so on), and on the timescale granularity format.

For example, suppose you assign Bob to a 3d Duration task, and then edit the contour so Bob has 4h, 8h, and 6h Work distributed as shown below. The top pane is the Task Usage view formatted to display Work, and the bottom pane is the Resource Graph formatted to show Peak Unit bars for Selected Tasks only.

Task Usage over Resource Graph
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Now suppose you move the task into the future by half a working day (4 working hours), by changing its task Start to begin at 1:00PM. The timephased data changes as shown below:

... After shifting the Start 4 working hours to the right to 1:00PM
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Where did the {2h, 6h, 7h, 3h}distribution come from? 

The relative contour pattern has actually been preserved, although it is not clear that this is the case until you use a finer timescale granularity. You could switch to hour by hour, but since the original and shifted contour segments lie entirely within half days, it is sufficient to look at half days to see what is happening.

If the timescale is formatted to show hours with a count of 12, the original graph looks like this:

8:00AM Start shown by half days
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The shifted 1:00PM Start has the following graph when viewed by half days:

1:00PM Start shown by half days
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Comparing the two graphs with half-day timescale granularity makes it clear that the original contour shape hasn't changed. Each of its segments has simply shifted half of a working day (4 working hours) to the right. You can also see that there is 2h of Work on Monday, 6h=2h+4h of Work on Tuesday, 7h=4h+3h on Wednesday, and 3h on Thursday.

Calendar Exceptions

Work contours flow around nonworking time.

Another basic rule is that a contour represents Work over available working time.

For example, in the above 1:00PM Start example, suppose you now change the working times for Bob so he has Tuesday afternoon off - for example, his new working times for Tuesday are just 8am to 12pm. Then the contour pattern flows around this nonworking "hole." The new half-day and whole day graphs are shown below:

1:00PM Start with Tuesday afternoon nonworking (granularity half days)
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1:00PM Start with Tuesday afternoon nonworking (granularity whole days) 
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Contours, Calendars, and Over allocations

Changing calendar-working times does not remove existing allocations. Work values in timephased cells must be edited so that the sum of Units across all the resource's assignments do not exceed the resource's Max Units for even one minute.

For a resource with a single Assignment, an overallocation occurs when at least one of the contour segments has a Units value bigger than the resource's Max Units. In the above example, if you enter 8h for Bob on Tuesday using timescale granularity of days, you just overallocated Bob on Tuesday. The 8h you enter is distributed across whatever working times are contained with that cell, namely the first half of Tuesday since the calendar says he has Tuesday afternoon off. So that contour segment has a Duration of 4 hours (Tuesday morning) with Units = 8h/2h = 200%.

8h entered on Tuesday cell is distributed over the working first half of the day
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... Viewed with half day granularity
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Can you solve the overallocation on Tuesday by changing the working times so Bob does not have the afternoon off (for example, so he works 8am-12pm, 1pm-5pm)? No. Not unless you reenter the 8h on Tuesday after you change his working times. If you only change his working times, here's what you get:

... Changing the working times does not solve overallocations by itself
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Make Tuesday afternoon a work time shifts the relative contour pattern {2h, 8h, 4h, 4h, 3h, 3h}, but does not  change the relative {Duration, Units} segment pairs. The {8h, 200%} segment is still there.

However, you can now remove the overallocation by changing the 8h in the Tuesday morning half-day cell to 4h. Or you can format the timescale for days and entering 8h in the Tuesday day cell.

Assignment Information Dialog

Once you create an Assignment, double click the Assignment in the Task Usage or Resource Usage view to display the Assignment Information dialog. You can also choose Assignment Information from the Insert menu when an Assignment is selected.

This is new to Microsoft Project 98 and consolidates information from various Microsoft Project 4.x dialogs, as well as providing control of new Assignment features. It contains the following tabs:

· General tab: Use this to choose a predefined contour, overall Units scaling factor and total Assignment Work, and a cost rate table.

· Tracking tab: Use this to track Assignment actuals.

· Notes tab: Use this to enter Assignment specific rich text notes.

Assignment Information General Tab

Microsoft Project 98 uses a flat contour for new assignments. This is similar to what Microsoft Project 4.x does when you assign a resource once to a task. The default Assignment Units is the 1 or the resource's Max Units if it's less than 1.

In Microsoft Project 98 you can later edit these Assignment contours to any desired shape. You can also choose a predefined contour from the Assignment Information dialog General tab.

Assignment Information General tab
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The fields in the Assignment information General tab dialog are described below assuming a single Assignment is selected. The Multiple Assignment Information dialog is discussed later.

· Task and Resource edit boxes: Names of the task and resource involved in the selected Assignment.

In the Task Usage view, the Name field (default title Task Names) contains task names for task records. Indented below each task name are the Assignment resource names for that task's Assignment records. Editing an Assignment resource name in the Task Usage Name field assigns a different resource, creating it if necessary. It does not rename current resource. When the Assignment Information General tab is activated from a Task Usage view, the Task edit box is disabled. The Resource edit box is enabled corresponding to the editable Assignment resource name in the Task Usage Name field. If you change the assigned resource to another resource that is already assigned to the task, then it brings up an alert that warns you about the duplicate Assignment. It asks if you want to combine the assignments. 

Cannot assign a resource multiple times to the same task
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In the Resource Usage view, the Name field (default title Resource Names) contains resource names for resource records. Indented below each resource name are the Assignment task names for that resource's Assignment records. Assignment task names in the Resource Usage Name field cannot be edited. When the Assignment Information General tab is activated from a Resource Usage view, the Resource and Task edit boxes are both disabled.

· Work: Amount of Work the resource is scheduled to perform on the task.

· Units: The peak Units for the entire Assignment. For multiple segment contours, this is the maximum of all of the Units for all of the segments.

· Start, Finish: Assignment Start and Finish dates. These dates can be edited to limit the date range for the Assignment. How this impacts existing contour values is covered later in detail.

· Cost: Scheduled Assignment Cost. Non-editable.

· Cost Rate Table: Resource cost rate table that is used to calculate the cost of this Assignment. Each resource has five to choose from, rate tables A through E. Each rate table can define up to 25 custom {date range, cost rate} pairs, each with a different cost rate. Cost rate tables can be customized in the Resource Information dialog Costs tab.

· Work Contour: List box for specifying how the Assignment Work is distributed over time. It is either Contoured (edited) or one of the predefined contours. Changes to Assignment dates, total Work or Units has a different impact on assignments with predefined contours versus assignments with edited custom contours. This includes indirect impacts due to changes at the task level, such as edits to task Duration. 

Edited Contoured assignments extend or truncate according to various rules. Predefined contours always retain their basic shape and are stretched or compressed to fit the new Assignment.

Work contour dropdown in Assignment Information General tab
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Once you make any timescaled Work edit to a predefined contour, it's then treated as an edited Work contour and is labeled as such in this field.

The predefined contours are described in detail later.

Assignment Information Tracking Tab

The tracking tab makes it easy for you to edit one or more of the tracking related fields for the selected Assignment(s).

Assignment Information Tracking tab
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The following descriptions of the fields in the Assignment information Tracking tab dialog assume that a single Assignment is selected.. The Multiple Assignment Information dialog is discussed later.

· Task and Resource edit boxes: Names of the task and resource involved in the selected Assignment. See the above notes on these fields for the General tab.

· Actual Cost: Actual Cost of the Assignment. Non-editable.

· Cost Rate Table: Resource cost rate table that is used to calculate the cost of this Assignment. Each resource has five to choose from, rate tables A through E. Each rate table can define up to 25 custom {date range, cost rate} pairs, each with a different cost rate. Cost rate tables can be customized in the Resource Information dialog Costs tab.

· Work, % Work Complete, Actual Work, Remaining Work, Actual Start, Actual Finish: Values are displayed for the selected Assignment. A detailed discussion of calculations involving these fields follows. 

When one or more of these values is edited, specific rules are used to determine how to calculate the other fields. Microsoft Project arbitrates user-entered information based on the following rules:

· Actual Start and Actual Finish take precedence over Actual Work, Remaining Work, % Work Complete and Work.

· Any two related Work fields (Actual Work, Remaining Work and % Work Complete)  take precedence over Work.

· Actual Work and Remaining Work take precedence over % Work Complete. Additionally, the assignments Work  changes to the total of the Actual Work and the Remaining Work.

· If only Actual Work and % Complete are entered, the task's Work is changed to 

. Additionally, the Remaining Work is calculated based on the new Assignment Work.

· If only Remaining Work and % Work Complete are entered, the Assignment’s Work is changed to 

. Additionally, the Actual Work is calculated based on the new task Work.

Assignment Information Notes Tab

Contains Assignment specific rich text notes.

Assignment Information Tracking tab
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Group Editing of Assignments

You can select multiple assignments and do group edits in the Multiple Assignment Information dialog on any editable field in the dialog. 

Just as with task and resource group edits, the Notes tab is disabled for group edits.

Internally Microsoft Project deals with the group edits as multiple individual edits on each Assignment. 

Predefined Contours

Before looking at the predefined contours in detail, keep in mind the following:

Once you make any timescaled Work edit to a predefined contour, it is then treated as an edited Work contour.

The following tables illustrate the shape of the various predefined contours. Each predefined contour is broken into 10 segments. For each segment, the tables show the assigned Units assuming the original Assignment was made at 100%. If the Assignment was made at a lower or higher percentage, then the individual segment percentages are scaled accordingly.

In the Microsoft Project 98 pictures shown below, the top pane is the Task Usage view formatted to display Work, and the bottom pane is the Resource Graph formatted to show Peak Unit bars for Selected Tasks only. The column titled "Contour" is the Work Contour field. 

All of the contour examples below use ten one day segments with Assignment peak Units of 100% (maximum of all the segment peak Units). Notice that for a given 10d Duration and 100% Units, different contours have different amounts of Assignment Work.

Flat

Its shape looks like:


1
2
3
4
5
6
7
8
9
10

Units
100%
100%
100%
100%
100%
100%
100%
100%
100%
100%

Flat
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This is the default setting. There is no global option to specify a different default contour.

The Flat contour means that Microsoft Project schedules the Work to occur at an even, flat Work rate across the entire Assignment. This matches Microsoft Project 4.x behavior. 

If you change the Duration of the task, the impact on the contour depends on the task type. In the simple case of a task with one Assignment:

· Fixed Work type: If the task has the Fixed Work type, then changing the Duration of the task leaves the total task Work unchanged, and changes the flat Assignment Units to Assignment Work divided by the new Duration. For example, cutting the Duration in half doubles the flat Assignment Units.

· Fixed Duration or Fixed Units: For these task types, changing the Duration leaves the flat Assignment Units unchanged, and changes the amount Assignment Work to the Units times the new Duration.

If you change the task Work, the impact on the contour depends on the task type. In the simple case of a task with one Assignment:

· Fixed Duration type: If the task has the Fixed Duration type, then changing the task total Work leaves the Duration unchanged, but changes the Assignment Units to the new Work divided by Duration.

· Fixed Units or Fixed Work: For these task types, changing the Work leaves the flat Assignment Units unchanged, but changes the Duration to Units times the new Work.

Back Loaded: 

This contour has the majority of the Work occurring at the end the task. 

Its shape looks like:


1
2
3
4
5
6
7
8
9
10

Units
10%
15%
25%
50%
50%
75%
75%
100%
100%
100%

Back loaded
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Front Loaded:

This contour has the majority of the Work occurring at the front of the task.

Its shape looks like:


1
2
3
4
5
6
7
8
9
10

Units
100%
100%
100%
75%
75%
50%
50%
25%
15%
10%

Front loaded
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Double Peak:

This contour has two peaks in it.

Its shape looks like:


1
2
3
4
5
6
7
8
9
10

Units
25%
50%
100%
50%
25%
25%
50%
100%
50%
25%

Double Peak
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Early Peak:

This contour is similar to front loaded, except there is a ramp up to the peak.

Its shape looks like:


1
2
3
4
5
6
7
8
9
10

Units
25%
50%
100%
100%
75%
50%
50%
25%
15%
10%

Early Peak
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Late Peak:

This contour is similar to back loaded, except there is a ramp down from the peak.

Its shape looks like:


1
2
3
4
5
6
7
8
9
10

Units
10%
15%
25%
50%
50%
75%
100%
100%
50%
25%

Late Peak
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Bell:

This is a bell shaped curve

Its shape looks like:


1
2
3
4
5
6
7
8
9
10

Units
10%
20%
40%
80%
100%
100%
80%
40%
20%
10%

Bell
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Turtle:

This is a ramp up and ramp down contour.

Its shape looks like:


1
2
3
4
5
6
7
8
9
10

Units
25%
50%
75%
100%
100%
100%
100%
75%
50%
25%

Turtle
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Contoured

You can edit the timephased usage values of any Assignment that is using any of the above Assignment types. If you edit the timescaled Work values, then the Assignment type is automatically changed to Contoured, because it no longer corresponds to its predefined Assignment type. 

Predefined Contour Assignment Calculations

For predefined contours that have not been edited, there is a definite relationship between the Assignment (total) Duration, Work, Units, and the contour's ten Units scaling factors. The relationship is similar to the relationship in Microsoft Project 4.x between task Duration and Assignment Work and Units.

The formula is given first with some examples, and a proof is given.

Wassmt = Dassmt * (Uassmt * UscaleAvg)

The symbols represent the following:

Wassmt: The total Work on the Assignment.

Dassmt: The total Duration of the Assignment.

Uassmt: The peak (maximum) Units of the Assignment.

UscaleAvg: The average of the ten scaling factors of the predefined contour.



The average Units scaling factors for each of the predefined contour types is shown below:

Predefined contour type
UscaleAvg

Flat
100%

Back Loaded
60%

Front Loaded
60%

Double Peak
50%

Early Peak
50%

Late Peak
50%

Bell
50%

Turtle
70%

For example, for the Back Loaded type, 

UscaleAvg = (10% + 15% + 25% + 50% + 50% + 75% + 75% + 100% + 100% + 100%) / 10

UscaleAvg = 60%

The following table shows which of the three variables Dassmt, Wassmt, or Uassmt is calculated when one of the others is edited, depending on the task type.

For Predefined contours, Wassmt = Dassmt * (Uassmt * UscaleAvg)

Change this variable
What gets calculated for Fixed Duration task
What gets calculated for Fixed Units task
What gets calculated for Fixed Work task.

Dassmt
Wassmt
Wassmt
Uassmt

Uassmt
Wassmt
Wassmt
Dassmt

Wassmt
Uassmt
Dassmt
Dassmt

Derivation of the Equation

The equation Wassmt = Dassmt * (Uassmt * UscaleAvg) can be derived as follows.

Each predefined contour consists of ten scaling factors for scaling the Assignment (peak) Units for each of ten uniform Duration contour segments. 

The derivation uses the following symbols:

Dassmt: Total Assignment Duration

Wassmt: Total Assignment Work

Uassmt: Peak (max) Assignment Units

uscale1,..., uscale10: The 10 Units scaling factors (in decimal format)

UscaleSum: Sum of uscale1, ... , uscale10

UscaleAvg: Average of uscale1, ... , uscale10

useg1, ..., useg10: The 10 segment Units values.

dseg: The 10 segment Duration values - there all the same.

wseg1,...,wseg10: The 10 segment Work values.

Note that

dseg = Dassmt/10

and for each segment # 1 to 10,

useg# = uscale# * Uassmt, 
for example useg1 = uscale1 * Uassmt

wseg# = dseg * useg#,

for example wseg1 = dseg * useg1

Now for the derivation of Wassmt in terms of the other variables:

Wassmt = wseg1 + wseg2 + ... + wseg10

  = (dseg * useg1) + (dseg*useg2) + ... + (dseg * useg10)

  = dseg * [useg1 + useg2 + ... + useg10]

  = dseg * [(uscale1 * Uassmt) + (uscale2 * Uassmt) + ... + (uscale10 * Uassmt)]

  = dseg * Uassmt * [ uscale1 + ... uscale10]

  = dseg * Uassmt * UscaleSum

  = (Dassmt/10) * Uassmt * UscaleSum

  = Dassmt * Uassmt * (UscaleSum/10)

Wassmt = Dassmt * Uassmt * UscaleAvg

Any of the variables Wassmt, Dassmt or Uassmt can also be solved from the above equation: 

Wassmt = Dassmt * (Uassmt * UscaleAvg)

Dassmt = Wassmt / (Uassmt * UscaleAvg)

Uassmt = Wassmt/ (Dassmt * UscaleAvg)

For example, a single resource R is assigned to a Fixed Units type task T with Assignment Units of 100%, total Work of 28h, and using the Turtle contour type.

What is the Duration of the task?

You can use the formula

Dassmt = Wassmt / (Uassmt * UscaleAvg)

From the table above, the Turtle contour has a Units scaling factor average of 70% = 0.70.

So,

Dassmt = Wassmt / (Uassmt * UscaleAvg)

Dassmt = 28h / (0.7) = 40h = 5d.

Using the Turtle contour, Assignment Units of 100%, and 28h Work, the Work is spread out over a 5-day period.

The table below shows the formulas and results for the individual segment Units scale factors and Work. Each segment has a 4h Duration as described previously.

Seg#
Uscale#

(decimal)
useg# = Uscale# * Uassmt

with Uassmt = 1.00
wseg# = dseg * useg#

with dseg = 4h.

1
0.25
0.25
4h * 0.25 = 1h

2
0.50
0.50
4h * 0.50 = 2h

3
0.75
0.75
4h * 0.75 = 3h

4
1.00
1.00
4h * 1.00 = 4h

5
1.00
1.00
4h * 1.00 = 4h

6
1.00
1.00
4h * 1.00 = 4h

7
1.00
1.00
4h * 1.00 = 4h

8
0.75
0.75
4h * 0.75 = 3h

9
0.50
0.50
4h * 0.50 = 2h

10
0.25
0.25
4h * 0.25 = 1h

Each of the ten half day (4h) segments has the various segment Units and Work shown in the above table. The Task Usage with the timescale formatted to show half days (hours count 12) is shown below:
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This table shows the Task Usage with the timescale formatted to show whole working days:
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What would happen if you increased the Assignment Work by 25% to 28h +7h = 35h?

Does the task Duration change? Does the assignment Units change?

Answers: The task is Fixed Duration, so changing the Assignment Work can't change the Units. The Duration will have to change, and since Duration is proportional to Work in the formula Dassmt = Wassmt / (Uassmt * UscaleAvg), then increasing the Work by 25% should increase the Duration by 25% to 1.25 * 5d = 6.25d = 50h. The result is shown in the picture below:
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It's not obvious from where the daily Work values come,  because the timescale is formatted to show days, but each of the ten segments has a Duration of 

dseg = Dassmt/10 = 50h/10 = 5h

Formatting the timescale to hours count 5 doesn't help much because it bases this on 1984 at midnight and throws the numbers off. You could go all the way do a timescale granularity of hours, but that's pretty messy. You can figure it out manually using the appropriate formulas. For example, the first 5 hours on Day1 is all of segment1 which has a 25% Units scaling factor, and the last 3 hours of Day1 is part of segment2 which has Units scaling factor 50%. The Assignment Units (Uassmt) is 100%, so in this case, the segment Units are the same as their scaling factors. So the Work on Day1 is

Work Day1 = 25% times 5h + 50% times 3h = 1.25h + 1.5h = 2.75h

So that's where the 2.75 hours came from in the Day1 cell. The other values could be calculated similarly. 

Of course there's no reason to calculate all these daily values. Microsoft Project does that for you. However, verifying a few values manually can help you understand the calculations involved.

What would happen if you manually reduce the Duration by 50%? 

Since it's a Fixed Units type task, the Assignment Work would be cut by 50% according to the formula

Wassmt = Dassmt * (Uassmt * UscaleAvg)

What would happen if the task is a Fixed Duration type task and you change the Assignment Work? 

Since the task Duration can't change, the Assignment's Units would change according to the formula:

Uassmt = Wassmt / (Dassmt * UscaleAvg)

Formulas for Edited Contours

The above formulas for Predefined contours do not Work for assignments with edit Contoured contours. 

Edit contours have no predefined set of segment Units scaling factors, can have an arbitrary number of segments, and may not have uniform segment durations.

The following general formulas apply to predefined and edited contours:

dseg# = wseg#/useg# applies to each individual segment

Dassmt = Sum of all dseg#

Wassmt = Sum of all wseg#

Uassmt = Max of all useg#

Editing Duration, Units, and Work

Unless stated otherwise, the remaining material in this lesson assumes that all projects are scheduled from Start and none of the tasks are ALAP. There is a section later that deals specifically with projects scheduled from Finish and ALAP tasks.

Usage Records that Can be Edited

The Resource Usage view contains resource records with subordinate (indented) Assignment records. The Work field cannot be edited for resource records, but it can be edited for the Assignment records. Editing resource Work isn't allowed because there isn't a meaningful way to describe how the individual assignments should be impacted.

The Task Usage view contains task records with subordinate assignments. The Work field can be edited for both of these kinds of records.

Editing Assignment Timephased Work

If you edit timephased assignment Work in a specific grid cell, the Work is distributed as follows:

· If the cell contains neither the assignment Start or assignment Finish, then the entered Work is distributed over the whole cell. 

· If the cell contains the assignment Start, but not the assignment Finish, then entered Work is distributed between the assignment Start and the right end of the cell. 

· If the cell contains the assignment Finish, but not the assignment Start, then the entered Work is distributed between the left end of the cell to the assignment Finish.

· If the cell contains the assignment Start and assignment Finish, then the entered Work is distributed between the assignment Start and assignment Finish.

In all cases, once the Start and end of the contour segment is determined within that cell, the Units is calculated as the entered Work divided by the Duration (working time) of the contour segment within that cell.

For example, suppose a task starts Mon 8:00am and Finish the next day, Tue 10:am. Default settings and calendars are used, and the Task Usage timescale is formatted to show days. If you enter 4h in the Mon cell, the Units is calculated as 4h divided by 8h, equals 50% Units. If you enter the same 4h in the Tue cell, it does not change the Finish of the task. Instead, it calculates Units as 4h divided by 2h (Tue cell left end of 8am to the task Finish of 10am), which equals 200% Units.

Editing/entering timephased Work in a cell that contains the task Start or Finish will not change the task Start or Finish.

Editing non-timephased Work (in the table pane) can change the task Start and Finish.

Note that entering too large a value in a timephased Work cell can cause an overallocation, and that editing calendars (Change Working Times) cannot solve these overallocations. See the section above on "Contours, Calendars, and Overallocations" for an example.

Editing Assignment (Total) Duration, Units, and Work

The predefined contours without Actual Work behave differently than edited contours in how they are impacted when non-timephased Task or Assignment totals are edited. 

Once a predefined contour has Actual Work, it behaves like an edited contour.

The symbols below have the following meaning:

Dassmt: Total Assignment Duration

Wassmt: Total Assignment Work

Uassmt: Peak (max) Assignment Units

UscaleAvg: Average of the ten segment Units scaling factors for the particular predefined contour. See the Predefined contour section above for a table of these factors.

The general difference between edited and predefined contours is listed below:

· Predefined contours: When any non-timephased values change, the predefined contour is refitted into the new Assignment Duration, Work, and Units using the equation:

Wassmt = Dassmt * (Uassmt * UscaleAvg)

See the previous section for the derivation and examples of this equation.

· Edited contours: When Assignment Work is increased, then the additional Work extends the current rightmost contour segment, using the rightmost segment Units. When Assignment Work is decreased, the Work is truncated from the rightmost segments.

Assignment Duration is not an exposed field. The Duration field for assignments in Usage views is blank. The Assignment Start and Assignment Finish fields are exposed and editable. 

Predefined Contours

As discussed earlier, there is a definite equation relating these variables for Predefined contours:

Wassmt = Dassmt * (Uassmt * UscaleAvg)

Written in plain English,

Assignment Work = Assignment Duration * (Assignment Units * Average of the Predefined scaling factors)

If you keep in mind that you are talking about Assignment Work, Assignment Duration, and Assignment Units, you can write the equation like this:

Work = Duration * (Units * Average of the Predefined scaling factors)

The table below shows the relationships between Assignment Duration, Assignment Work, And Assignment Units for Predefined contours and various task types. The first column in the table refers to directly or indirectly changing one of the variables. Note that there is no exposed Assignment Duration field, so it can only be changed indirectly (for example, by changing Assignment Start and Assignment Finish, or by changing the Task Duration).

For Predefined contours, Wassmt = Dassmt * (Uassmt * UscaleAvg)

Change this
For Fixed Duration task, calculates this
For Fixed Units task, calculates this
For Fixed Work task, calculates this

Dassmt
Wassmt
Wassmt
Uassmt

Uassmt
Wassmt
Wassmt
Dassmt

Wassmt
Uassmt
Dassmt
Dassmt

Edited Contours

For Edited (customized) contours, the above equation is no longer true. In some cases there is still a proportionality, for example, Wassmt is proportional to Dassmt times Uassmt, but the proportionality constant depends on the specific edits that were done. In other cases, there isn't even a proportionality. In those cases, changes are not reversible. For example, in the case of a Fixed Units type task, if Dassmt is decreased and then restored, the final contour is not the same as the original.

The table below shows the relationships between Assignment Duration, Assignment Work, and Assignment Units for Edited contours and various task types.

For Edited contours - relationship between Assignment Duration, Units, and Work

Action
Result for Fixed Duration task 
Result for Fixed Units task
Result for Fixed Work task

Inc/dec Dassmt


Inc/dec Wassmt

The rightmost segment is extended or truncated. 

Not a proportional change.

Truncation is not reversible. I.e. Dec Dassmt and then restore it does not give you back the original contour necessarily.

Inc/dec Wassmt

The rightmost segment is extended or truncated. 

Not a proportional change.

Truncation is not reversible. I.e. Dec Dassmt and then restore it does not give you back the original contour necessarily.
Dec/inc Uassmt

Inversely proportional. 

No information lost if Dassmt is changed then restored.

Inc/dec Uassmt


Inc/dec Wassmt

Directly proportional. 

No information lost if Uassmt is changed then restored.
Dec/inc Dassmt

Inversely proportional. 

No information lost if Dassmt is changed then restored.
Dec/inc Dassmt

Inversely proportional. 

No information lost if Dassmt is changed then restored.

Inc/dec Wassmt


Inc/dec Uassmt

Directly proportional. 

No information lost if Wassmt is changed then restored.
Inc/dec Dassmt

The rightmost segment is extended or truncated. 

Not a proportional change.

Truncation is not reversible. I.e. Dec Wassmt and then restore it does not necessarily give you back the original contour.
Inc/dec Dassmt

The rightmost segment is extended or truncated. 

Not a proportional change.

Truncation is not reversible. I.e. Dec Wassmt and then restore it does not necessarily give you back the original contour.

Editing Task Timephased Work

Editing a task specific timephased Work value changes the timephased Work proportionately for all the task's assignments for that same timephased period column. The task type (Fixed Duration, Fixed Units, or Fixed Work) doesn't matter.

Example

In this example, the task timephased Work on Tue is changed from 10h to 15h.

Before ...
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After changing task timephased Work on Tue from 10h to 15h ...
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The task Work on Tuesday was increased from 10h to 15h. This caused the Assignment Work to be scaled up according to the ratio of Work within that time period. So in the above example Tom’s Work on Tuesday changes from 6h to 9h (for example,6/10 * 15 = 9) and Bob’s Work changes from 4h to 6h (i.e. 4/10 * 15 = 6). These new Work values behave exactly as if they had been entered at the Assignment level. See the Editing Assignment Timephased Work section above for the detailed rules.

Similarly, if the task timephased Work is reduced, then the new Work value is distributed proportionally to the assigned resources. 

Important: Editing of task timephased Work causes the impacted assignments to become Edited contours.

Editing Task Total Work

Editing a task's total Work causes its Remaining Work or Actual Work to change.

· Increasing Task Work increases the Task Remaining Work by the same amount. This increase in Remaining Work is distributed to the task's assignments as follows:

Additional Remaining Work is allocated to the assignments in proportion to their current Remaining Work values. If none of the assignments has Remaining Work, then the additional Remaining Work is allocated in proportion to the Assignment (total) Work values. 

· Decreasing Task Work decreases the Task Remaining Work until it runs out, then it starts decreasing Task Actual Work. As long as there is Remaining Work left after the Task Work is decreased, then the Remaining Work of Assignments are decreased in proportion to the amount of Remaining Work they have left. If the Task Work is decreased to the point that no Remaining Work is left, then all of the Assignments have Remaining Work of zero. Any further reductions in Task Actual Work is removed from tasks in proportion to their Actual Work.

Note: In Microsoft Project 4.x, increasing task Work increases Assignment scheduled Work proportionately, not just the remaining Work as in Microsoft Project 98. 

Examples Involving Actuals

The following examples involve Actual Work. 

Decreased Work Example Involving Actuals

In the before/after example below, Task Work is reduced by 6h for 84h to 78h, which still leaves nonzero Remaining Work, so that no Actual Work is removed. The Assignments for R1 and R2 are edited contours, and the assignment for R3 is a predefined Turtle contour. The Assignment for R1 is complete and so is not involved in the reduction of Remaining Work. R2 has twice as much Remaining Work as R3, so it gets twice as much of the reduction in Remaining Work. R2 will lose 4h of Remaining Work, and R3 will lose 2h of Remaining Work.

Before reducing Task Work ...
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After reducing Task Work from 84h to 78h
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The Assignment for R3 is a predefined Turtle Contour even though it has actuals, because the 18h was entered for the Assignment Actual Work, not Assignment Timephased Actual Work. 

Note: If you enter any Timephased Assignment values for a Predefined Contour, it becomes an Edited Contour.

The Turtle Contour for R3 was truncated like an edited contour, rather than refitted, because it had actuals.

Predefined Contours with no actuals are rescaled to fit the new amount of Assignment Work, Assignment Units, and Assignment Duration. 

Predefined Contours with actuals are truncated or extended just like edited contours.

Increased Work Example Involving Actuals

The before/after example starts with the same Before data as in the previous example, only this time the Task Work is increased by 6h for 84h to 90h. The Assignments for R1 and R2 are edited contours, and the assignment for R3 is a predefined Turtle contour. The Assignment for R1 is complete and so is not involved in the increase in Remaining Work. R2 has twice as much Remaining Work as R3, so it gets twice as much of the increase in Remaining Work. R2 will gain 4h of Remaining Work, and R3 will gain 2h of Remaining Work.

After Increasing Task Work from 84h to 90h
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The Turtle Contour for R3 was extended like an edited contour, rather than refitted, because it had actuals. To see this more clearly, the Before/After pictures are shown below using half-day granularity:

Before increasing Task Work ...
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After Increasing Task Work from 84h to 90h
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Unless specified otherwise, the following material assumes tasks with no actuals, so Task Work and Task Remaining Work are the same. Keep in mind, that Microsoft Project 98 will try to preserve Actual Work whenever possible, scheduling only Remaining Work.

How Editing Task Work impacts Edited Assignment Contours

Task Type
How Editing Task Work impacts Edited Contours

Fixed Duration
Task: Task Work was edited. Task Duration is unchanged.

Assignments: Assignment Duration is unchanged. The change in Assignment Work and Assignment Units is proportional to the change in Task Work.

Segments: Each Segment Duration is unchanged. The change in each Segment Work & Segment Units is proportional to the change in Task Work.

Fixed Units or 

Fixed Work
Task: Task Work was edited. The new Task Duration is computed from the sum of the new Segment Durations. The change in Task Duration is not necessarily proportional to the change in Task Work.

Assignment: Each Assignment Units is unchanged. The change in Assignment Work is proportional to the change in Task Work.

Segments: Increases or decreases in Assignment Work are accounted for by extending or truncating segments at the right end of the contour. Extensions use the Segment Units of the rightmost segment. Segments not involved in the extension or truncation are unchanged (their Segment Duration, Segment Units, and Segment Work is unchanged). The last surviving Segment on the right has its Segment Units unchanged, and its Segment Work adjusts to its new extended or truncated Segment Duration.



How Editing Task Work impacts Predefined Assignment Contours

Task Type
How Editing Task Work impacts Predefined Contours

Fixed Duration
Task: Task Work was edited. Task Duration is unchanged.

Assignments: For all Assignments, the change in Assignment Work is proportional to the change in Task Work.

For driving assignments (that Finish when the task finishes): Assignment Duration is unchanged. The change in Assignment Work and Assignment Units is proportional to the change in Task Work.

For non-driving assignments:

If Task Work was decreased: Same behavior as driving assignments. 

If Task Work was increased: (BUG?) The change in Assignment Work is proportional. to the change in Task Work. The Assignment Duration is not constant, but is set equal to the Task Duration. The Assignment Units are adjusted as needed so the Predefined Contour fits the new Assignment Duration. and Assignment Work.

 Segments:

For driving assignments: Each Segment Duration is unchanged. The change in Segment Units and Segment Work is proportional to the change in Task Work.

For non-driving assignments: 

If Task Work was decreased: Same behavior as driving assignments.

If Task Work was increased: (BUG?) Each Segment Work, Segment Units, and Segment Duration changes so the Predefined Contour fits the new Assignment Duration and Assignment Work.

Predefined

Fixed Units

or

Fixed Work


Task: Task Work was edited. The new Task Duration is computed from sum of the new Segment Durations. The change in Task Duration is not necessarily proportional to the change in Task Work.

Assignments: Assignment Units is unchanged. The change in Assignment Work and Assignment Duration is proportional to the change in Task Work.

Segments: Each Segment Units is unchanged. The change in each Segment Duration and Segment Work is proportional to the change in Task Work.

Increased Work Example

In this example, the task total Work is changed from 30h to 45h. There are no actuals in the example, so Work and Remaining Work on the same. The result depends on whether the task is Fixed Duration or not. To see this more clearly, the Before and After pictures below include the Assignment Units field (renamed Units) in the table on the left. It's the peak Units for the whole Assignment.

Before ...
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After increasing task total Work from 30h to 45h ...

... for Fixed Duration task type: Proportionally increased Units & Work
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After increasing task total Work from 30h to 45h ...

... for Fixed Units or Fixed Work task type: Extended Segments
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Fixed Duration Results: The task Work was manually increased by 50% from 30h to 45h. For a Fixed Duration task, changing the Work can't change Duration.  Instead, the Units and Work of each assignment are increased by 50%, as well as the Units and Work for each contour segment. I.e., segment Durations were unchanged, and segment Units increased by 50%.

Non-Fixed Duration Results: For a Non-Fixed Duration task, changing the task Work does not change the Assignment Units for existing segments, but instead extends the rightmost contour segment. I.e., segment Durations changed, and segment Units were extended from the right.

Here's a more detailed before and after comparison of just Bob's Assignment, with the Task Usage over the Resource Graph showing the Peak Units for Bob's Assignment on Task1. The Resource Graph on the bottom pane is formatted for Peak Units and its Bar Styles are formatted for selected tasks only.

Bob's Assignment before ...
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Bob's Assignment after increasing task total Work from 30h to 45h ...

... for Fixed Duration task type: Proportionally increased Units & Work
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Bob's Assignment after increasing task total Work from 30h to 45h ...

... for Fixed Units or Fixed Work task type: Extended Segments
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% Allocation versus Units

In the Non-Fixed Duration case, Bob has 3h of Work on Fri on Task1, so why isn't his Peak Units 3h/8h = 38% on Fri? Because the segment ends at 12:00PM on. So the Units that day is 3h/4h =75%. Actually, the Wed segment with 75% Units was extended one and a half days to the right to account for the extra 9h of Work at 75% Units, such that {Wed, Thu, half of Fri} is really one segment with 75% Units. Note also that the whole 15h segment Work divided by the whole 20h segment Duration is 75%.

There is a timephased field called %Allocation that can be inserted in the right part of Usage views. It represents Assignment Work in a period cell divided by potential Assignment Work for the whole cell. I.e. on Fri, it would have shown %Allocation of 3h/8h = 38% for Bob's Assignment on Fri even though the Assignment ends at noon. Here's the "After" picture with the %Allocation field for the Non-Fixed Duration case:

After increasing task total Work from 30h to 45h ...

... for Fixed Units or Fixed Work task type: Extended Segments
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Decreased Work Example

This example starts with same data as the previous example, but this time the task total Work is decreased by 50% from 30h to 15h. Similar rules apply in determining the impact on contours, except that this example involves segment proportional decreases and truncation (rather than proportional increases and extension).

Before ...
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After decreasing task total Work from 30h to 15h ...

... for Fixed Duration task type: Proportionally decreased Units & Work
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After decreasing task total Work from 30h to 15h ...

... for Fixed Units or Fixed Work task type: Truncated Segments
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Truncation Not Reversible

If an Assignment contour segment is indirectly truncated as a result of decreased Assignment Work for a Non-Fixed Duration task, the truncated information is lost. To get it back, the contour would have to be edited again. Restoring the Assignment Work to its original value does not reverse the previous truncation. It just extends the new rightmost segment. 

The sequence pictures below for the Non-Fixed Duration case illustrate the results of decreasing the task total Work from 30h to 15h and then back to 30h:

1. Start with 30h total task Work on a Fixed Units or Fixed Work type task.
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2. Decrease the total task Work from 30h to 15h.
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3. Increase the total task Work from 15h back to the original 30h.
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Edits to Task Duration

Increasing the Task Duration changes the Assignment Finish for Assignments that already had an Assignment Finish equal to the Task Finish. The result then is the same as if the Assignment Finish had been changed manually. It extends the rightmost contour segment for Non-Fixed Work assignments, and proportionately adjusts each segment Duration while decreasing each segment Work, leaving the Units alone.

How Editing Task Duration impacts Edited Assignment Contours

Task Type
How Editing Task Duration impacts Edited Contours

Fixed Duration

or

Fixed Units
Task: Task Duration was edited. The new Task Work is the sum of the new Work of the Assignments. The change in Task Work is not necessarily proportional to the change in Task Duration.

Assignments: Each Assignment Units is unchanged. The change in Assignment Work is not necessarily proportional to the change in Task Duration, but depends on the sum of the Work of the surviving Segments after extension or truncation (see below)

If Task Duration was decreased: Assignments whose original Assignment Duration is greater or equal to the new Task Duration have their Assignment Duration set to the new Task Duration. Other Assignments are unchanged.

If Task Duration was increased: All Assignment Durations are set to the new Task Duration (including non-driving assignments - bug?).

Segments: Increases or decreases in Assignment Duration are accounted for by extending or truncating segments at the right end of the contour. Extensions use the Segment Units of the rightmost segment. Segments not involved in the extension or truncation are unchanged (their Segment Duration, Segment Units, and Segment Work is unchanged). The last surviving Segment on the right has its Segment Units unchanged, and its Segment Work adjusts to its new extended or truncated Segment Duration.

Fixed Work
Task: Task Duration was edited. Task Work is unchanged.

Assignments: Assignment Work is unchanged.

If Task Duration was decreased: Assignments whose original Assignment Duration is greater or equal to the new Task Duration have their Assignment Duration set to the new Task Duration. Other Assignments are unchanged.

If Task Duration was increased: All Assignment Durations are set to the new Task Duration (including non-driving assignments - bug?).

Segments: The number of Segments and each Segment Work is unchanged. The change in each Segment Duration is proportional to the change in Assignment Duration. The change in each Segment Units is inversely proportional to the change in Assignment Duration.

How Editing Task Duration impacts Predefined Assignment Contours

Task Type
How Editing Task Duration impacts Predefined Contours

Fixed Duration

or

Fixed Units
Task: Task Duration was edited. The new Task Work is the sum of the new Work of the Assignments. The change in Task Work is not necessarily proportional to the change in Task Duration.

 Assignments: Assignment Units is unchanged. The change in Assignment Work is proportional to the change in Assignment Duration. The Predefined Contour is adjusted if necessary to fit the Assignment Duration and Assignment Work.

If Task Duration was decreased: Assignments whose original Assignment Duration is greater or equal to the new Task Duration have their Assignment Duration set to the new Task Duration. Other Assignments are unchanged.

If Task Duration was increased: All Assignment Durations are set to the new Task Duration (including non-driving assignments - bug?). 

Segments: Predefined Contours have ten Segments. Each Segment Duration and Segment Work changes by the factor of new Assignment Duration divided by the original Assignment Duration. Each Segment Units is unchanged. 



Fixed Work
Task: Task Duration was edited. Task Work is unchanged.

Assignments: Assignment Work is unchanged. The change in Assignment Units is inversely proportional to the change in Assignment Duration. The Predefined Contour is adjusted if necessary to fit the Assignment Duration and Assignment Units.

If Task Duration was decreased: Assignments whose original Assignment Duration is greater or equal to the new Task Duration have their Assignment Duration set to the new Task Duration. Other Assignments are unchanged.

If Task Duration was increased: All Assignment Durations are set to the new Task Duration (including non-driving assignments - bug?). 

Segments: Predefined Contours have ten Segments. Each Segment Work is unchanged. The change in each Segment Duration is proportional to the change in Assignment Duration. the change in each Segment Units is inversely proportional to the change in Assignment Duration. 



New Duration Definition

In Microsoft Project 4.x, the Duration of a task is the length of the longest Assignment, and if a task’s Duration is changed, then the longest Assignment(s) are also changed accordingly.

The definition of Task Duration has changed in Microsoft Project 98. Now a task's Duration represents the working span of the task. I.e. Between the Task Start and Task Finish, examine each minute to see if any Assignment on that task is doing Work that minute. If any Assignment has Work during that minute, then that minute counts towards the Duration of the Task (if two or more assignments have Work during the same minute, the Duration only counts that minute once).

The picture below shows a task in which the longest Assignment is only 3d, but the task has a Duration of 5d, because there is a 5d span of working time during which at least one Assignment has Work. Microsoft Project 4.x would have given this task a Duration of 3d.

New Duration calculation in Microsoft Project 98
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Note: Splits on a task are not considered as working time on the task and are not reflected in the Duration of the task.

New Default Behavior When Assigning a Resource

Unless stated otherwise, this section is referring to the default work assigned to a new assignment when you do not specify it. 

When a resource is assigned to a task and the Assignment Units and Assignment Work are not specified, Microsoft Project has to assign default values. The default behavior has improved in Microsoft Project 98. In this section, the Microsoft Project 4.x behavior is reviewed first, and then the new improved Microsoft Project 98 behavior is discussed.

Microsoft Project 4.x default assignment work

In Microsoft Project 4.x, the default work assigned to a resource is always equivalent to the task Duration. It does this in all cases, regardless of the resource calendar and whether or not the task has elapsed Duration, Fixed Duration, or Actual Work, except for completed tasks. The rest of this section assumes the task is not complete, unless stated otherwise. 

Once the default work has been assigned, then the resource calendar is used to come up with the assignment dates and distribution of work across time (as in the Resource Usage view).

Non-Fixed Duration (Microsoft Project 4.x)

If there are no assignments, then the task uses the project calendar.

If there are assignments, then task dates can expand or contract according to the earliest and latest assignment dates determined by the task start, resource calendars, and assignment work, units, and delay. The project calendar is irrelevant. If the resource has nonworking exceptions between the task dates, the task dates can expand, and if it has working exceptions, the task dates can contract.

The task Duration is the span of the longest assignment. If existing assignments use the assignment Delay field, then the Duration of the longest assignment may be less than the actual number of working days used by at least one assignment between the task start and finish. In any case, the task Duration is still used as the default work for new assignments.

Example (Microsoft Project 4.x)

This example shows how assignment Delay in Microsoft Project 4.x impacts the default work assigned to additional resources.

Originally, three resources are assigned with the delays shown below. The task has a Duration of 3d, which is the longest assignment Duration. All days are working days.

Microsoft Project 4.x resources assigned using the assignment Delay field...
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Corresponding Gantt over Resource Usage view...
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Next, another resource, R4, is assigned without entering units or work, so it is assigned the default work equal to the task Duration, 3d, instead of the full working span of the assignments, 6d.

New assignment gets Duration for default work...
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Fixed Duration (Microsoft Project 4.x)

If the task is Fixed Duration, then the resource can end up being assigned outside the task. Microsoft Project decides if a resource is assigned outside the task by comparing the time-distribution of resource work to the task dates and working time specified in the project calendar (not the resource calendar). Since Microsoft Project 4.x does not consider resource calendars when assigning default Work, a resource would be assigned outside the Fixed Duration task if the resource calendar had less working time between the task Start and Finish than the project calendar. 

If the resource calendar forces the resource to work outside the task dates, then a Planning wizard is displayed if it is enabled in the Tools Options General tab, otherwise a brief Alert is displayed.

Microsoft Project 4.x Planning Wizard for a resource assigned outside a task ...
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Corresponding Microsoft Project 4.x alert if Planning Wizard is disabled...
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Example (Microsoft Project 4.x)

This example illustrates how assigning a resource to a Fixed Duration task in Microsoft Project 4.x can cause a resource to be assigned outside of a task. It also shows what happens if the task had not been Fixed Duration.

This example shows a resource assigned to a task with Fixed Duration. The project calendar and resource calendar both use default standard working times, except that the resource has a nonworking day on Thursday 6/5/97. This causes the resource to be assigned outside the task.

Microsoft Project 4.x: Resource assigned outside of elapsed Duration task...
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The picture below shows the corresponding result if the task had not been Fixed Duration.

Microsoft Project 4.x: Result if task is NOT Fixed Duration...
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Elapsed Duration (Microsoft Project 4.x)

If the task has elapsed Duration, it is automatically Fixed Duration, and the resource is assigned the full amount of elapsed Duration for default work. This makes it even more likely to cause the resource assigned outside of task scheduling problem. 

Example (Microsoft Project 4.x)

The example below shows a resource using the default standard working times assigned to a task with elapsed Duration of 1ed:

Microsoft Project 4.x: Resource assigned outside of elapsed Duration task...
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Tasks with Actual Work (Microsoft Project 4.x)

In Microsoft Project 4.x, when you assign a resource to a task that has Actual Work, but that is not complete, the resource is assigned the same as if the task had no Actual Work.

If the task is complete, then the resource is assigned only as much work as will fit within the task dates, whether the task is Fixed Duration or not.

Microsoft Project 98 default assignment work

In Microsoft Project 98, the default work assigned depends on whether the task has Fixed Duration, elapsed Duration, or Actual Work. Also, since the task Duration is always the full working span of the task, the resource will be assigned across the whole span, not just the span of the longest resource.

Microsoft Project 98 also has the new Type and Effort Driven fields that can impact what happens when resources are assigned or removed from a task. These settings are discussed in another section. This section is for non-Effort Driven, Fixed Unit tasks unless stated otherwise.

Compare the examples in this section with those in the previous Microsoft Project 4.x section.

Non-Fixed Duration (Microsoft Project 98)

If there are no assignments, then the task uses the project calendar.

If there are assignments, then task dates can expand or contract according to the earliest and latest assignment dates determined by the task start, resource calendars, and assignment work, units, and delay. The project calendar is irrelevant. If the resource has nonworking exceptions between the task dates, the task dates can expand, and if it has working exceptions, the task dates can contract.

Unlike Microsoft Project 4.x, in Microsoft Project 98 the task Duration is the full working span of all the assignments rolled up, so when the task Duration assigned as default work to new assignments, they too span the whole task.

Example (Microsoft Project 98)

This example shows how Duration and default assignment work in Microsoft Project 98 takes into account the full rolled up assignment durations. Compare this to the corresponding Microsoft Project 4.x example above.

Originally, three resources are assigned with the contours shown below. 

The task has a Duration of 6d which is the full rolled up working span of its assignments (the task has a split gap on Day5). All days are working days. The task has the Fixed Units type and is not Effort Driven.

Microsoft Project 98: Gantt over Task Usage view...
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Next, another resource, R4, is assigned without entering units or work, so it is assigned the default work equal to the task Duration, 6d.

Microsoft Project 98: New assignment gets Duration for default work...
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Fixed Duration (Microsoft Project 98)

Microsoft Project 98 takes resource calendars into account when assigning default Work for Fixed Duration tasks, and only assigns as much default Work as the resource calendar allows over the task Duration (this can even be zero if the resource has all non-working time during the task Duration). 

In Microsoft Project 98, you won't get a resource assigned outside of task problem when assigning a resource to a Fixed Duration task. 

You can get a warning if you add nonworking exceptions to the resource calendar after the resource has been assigned to a Fixed Duration task. If you don't cancel the operation, the Duration of the Fixed Duration task expands, so the resource still will not be assigned outside the task.

Example (Microsoft Project 98)

This example shows a resource assigned to a task with Fixed Duration. The project calendar and resource calendar both use default standard working times, except that the resource has a nonworking day on Thursday 6/5/97. Instead of assigning default work of 32h as Microsoft Project 4.x does, Microsoft Project 98 bases the default work on the resource calendar and only assigns 24h default work.

Microsoft Project 98 default work based on resource calendar...
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Note: If you change the Type to Fixed Units in the above picture after the resource is assigned, the assignment work and task Duration do not change.

The picture below shows the corresponding result if the task had not been Fixed Duration.

Microsoft Project 98: Result if task is NOT Fixed Duration...
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Elapsed Duration (Microsoft Project 98)

In Microsoft Project 98 when a resource is assigned to a task that has elapsed Duration, the resource is still assigned a default amount of Work equal to the task elapsed Duration, but the Work is scheduled using elapsed time, rather than the resource calendar. I.e., the resource is allowed to Work 24h per day, 7d per week on an elapsed task, regardless of the resource calendar. You can still use Assignment Units to scale the Work. For example Units of 50% would give 12h day (spread over 24h days). The resource can still become overallocated if it is the total units across overlapping assignments exceeds its max units for some instant of time.

Example (Microsoft Project 98)

This example illustrates the new behavior in Microsoft Project 98 for resources assigned to tasks with elapsed Duration.

The resource R is assigned to the task T that has 1ed of elapsed Duration. The time of day in the task Start date was manually changed to 12:00am to make the Start and Finish line up with day boundaries. The resource calendar has the default standard working times, but the resource calendar is ignored because the task has elapsed Duration. The resource behaves as if it has a 24h calendar too.

Microsoft Project 98:Resource automatically works full elapsed Duration...

[image: image714.png]i 6/2 | 6/3 |6/4 | 6/5
Name |Dur Start Finish e
T | 1ed 6/39712:00AM 614971200 AM| @
il »
i 6/2[6/3[6/4 [6/5
Name |Dur Start Finish e
T Ted 6/3/97 12:00 AM_6/4/97 12 24
R 6/3/9712:00 AM 6/4/97 1 24h.





Tasks with Actual Work (Microsoft Project 98)

In Microsoft Project 98, when you assign a resource to a task that has Actual Work, the new assignment starts on the task Resume date, which is the earliest resume date of any of its assignment, and the default amount of work assigned is the remaining Duration of the task.

Example (Microsoft Project 98)

This example illustrates the new behavior in Microsoft Project 98 for resources assigned to tasks that already have Actual Work.

Originally, resources R1 and R2 have timephased scheduled and Actual Work as shown below. The task is Fixed Units and is not Effort Driven. The task Resume date is 6/4 at 8am, because that is the earliest resume date of any of its assignments: The assignment resume dates (not shown) for R1 and R2 respectively are 6/4 at 8am and 6/5 at 8am.

Microsoft Project 98: Task Resume date is earliest assignment resume date...

[image: image715.png]Name

[Dur|  Resume

| RemDur

|6/2 |6/3 674 | 675

44 64/97800AM 15

Name

[ Dur [ ADur |

Details

612 |6/3 |6/4 |6/5

5T

R

4 25

Work

Act, Work

Work

sh

Act, Work

sh

Work

sh

“Act. Work

8h

sh
sh
sh
8h

16k 16k 16k
16k 16k

sh
sh
sh
sh

T6n

8h

8h




Next, the resource R3 is assigned. The default work is the combined working span of the existing assignments, from the task Resume date to the task Finish, which is 2d. Note that this is not the same as the calculated Remaining Duration of 1.67d. If the Actual Work on R1 and R2 was entered through the same date then the remaining Duration would match the default assigned work for R3. For example, if both had been statused through 6/3 at 5pm, then the task remaining Duration would have been 2d.

New assignment assigned default work between task Resume and Finish dates...
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Actual and Remaining Duration

Editing the Task Actual Duration field has the same impact in Microsoft Project 98 as in Microsoft Project 4.x. If the new Actual Duration is bigger than the original Duration, then the Task Duration is set equal to the new Actual Duration. Otherwise the Duration is unchanged. In any case, the new Remaining Duration is then


Remaining Duration = Duration - Actual Duration

The impact of editing task Remaining Duration improves in Microsoft Project 98. Microsoft Project 4.x increases Actual Duration when you decrease Remaining Duration, and increases Duration when you increase Remaining Duration. Microsoft Project 98 always changes Duration when Remaining Duration is edited and leaves Actual Duration alone.

Assignment Start and Finish Dates

Microsoft Project 98 makes it possible for Assignment Start, Finish, Actual Start and Actual Finish dates to be edited (Microsoft Project 4.x did not). In addition, Microsoft Project 98 has new Assignment Baseline Start and Baseline Finish fields, which can also be edited.

These fields allow you to determine when the Assignment Work occurs. You can accomplish the same result by editing timephased Work, but changing the Assignment Start and Finish is easier.

Editing Assignment Start and Finish Dates

Note: The Information in this section applies to projects that are scheduled from Start. The behavior in this section is reversed between Assignment Start and Finish if the project is scheduled from Finish.

Microsoft Project 98 remembers if you edited the Assignment Start and Finish dates and uses this information intelligently when you make future edits.

Although there is no exposed Assignment Finish date, internally, the Assignment Duration is the amount of time during which Work is done on the Assignment. Assignment Duration is also referred to as the Assignment span. The Assignment Start, Finish, and Duration fields are related by the equation:

Assignment Finish = Assignment Start + Assignment Duration

When one of these three fields is edited, which one of the other two changes depends on previous edits.

· If you edit an Assignment Start date (but not its Finish), then Microsoft Project adjusts the Assignment Finish.

· If you edit an Assignment Start date after editing its Finish, then Microsoft Project adjusts the Assignment Duration, unless you make the Start greater than the Finish, in which case it calculates the Finish.

· If you then edit the Finish date (regardless of whether you ever edited the Start), then the Assignment Duration is calculated, unless you make the Finish smaller than the Start, in which case it calculates a new Start.

In cases where Microsoft Project adjusts the Assignment Duration, the impacts on the Assignment Work and Units is described in the earlier section, Editing Assignment (Total) Duration, Units, and Work. Here's is a brief review:

Task Type
Result of changing Assignment Duration (or Start and Finish)

Fixed Units
Assignment Units are unchanged and the Assignment Work is changed to reflect the new Assignment Duration.

Fixed Work
Assignment Work is unchanged and the Assignment Units changed to reflect the new Assignment Duration and unchanged Work value.

Fixed Duration
Assignment Units are unchanged and the Assignment Work is changed to reflect the new Assignment Duration.

Assignment Start Date Before The Task Start Date

Entering timephased assignment work for a date before the current task Start, or entering an assignment Start earlier than the current task Start changes the task Start to this earlier date, and any assignments without actuals move back in time too. There are no warning messages, except for the usual messages associated with changing a task Start, such as changing a task to Start before the project Start, or changing a successor task Start so that it violates a relationship with a predecessor.

Editing Assignment Actual Start and Actual Finish Dates

If you enter an assignment Actual Start that is before the current task Start, then the task Start and any assignments without Actual Work have their Starts change to the entered Actual Start. There are no alerts.

If an assignment already has an Actual Start and Actual Finish, then editing the Assignment Actual Start date moves the existing Actual Finish date as well, keeping the assignment Duration unchanged.

How Start and Delay are used by Leveling

This section discusses the relationship between Leveling and the Task Start, Assignment Start, Task Delay, and Assignment Delay Fields.

In Microsoft Project 4.x, both tasks and assignments had a Delay field, but they were used for different purposes. The task Delay field was use by leveling, and the assignment Delay field was used to "contour" assignments; that is, delay when the assignment starts relative to the task Start.

Microsoft Project 98 has the following improvements: 

· The task Delay field from Microsoft Project 4.x has been renamed Leveling Delay in Microsoft Project 98.

· The Delay field used by assignments in Microsoft Project 4.x is now called Assignment Delay, and assignments support the Leveling Delay field as well. The Tools Resource Leveling menu command displays the Resource Leveling dialog, which includes the option "Leveling can adjust individual assignments on a task". If this option is selected, then leveling can use the Assignment Delay field as needed to move assignments within tasks to solve overallocation problems. You can edit both the Leveling Delay and Assignment Delay fields for an assignment (in a Usage view for example), but leveling only uses the Leveling Delay field.

· For projects scheduled from start, task Leveling Delay is added to the task Start, and assignment Leveling Delay is added to the assignment Start. Both of these delays are positive values.

· For projects scheduled from finish, the task Leveling Delay is added to the task Finish, and assignment Leveling Delay added to the assignment Finish, however, both of these delays must be negative values, so adding a negative delay to a Finish is the same as subtracting the magnitude of the delay.

Note: The task Leveling Delay field always uses elapsed Duration units, whereas the assignment Leveling Delay field always uses non-elapsed Duration units.

The pictures below illustrate the use of these delay fields when a project is scheduled from start versus scheduled from finish. Ovals were drawn on the picture to point out the data to focus on. Task T2 was added to span the entire project. In the Scheduled From Start picture, T1 has an ASAP constraint, and in the Scheduled From Finish picture, T1 has an ALAP constraint. The constraint had to be switched manually - changing the Schedule From setting does not automatically change ASAP constraints to ALAP.

Scheduled From Start uses Positive Assignment & Leveling Delay 

[image: image717.png]|AssmiDel | LevDel |DI |D2 |D3 |D4

2ERE

Ocd 8w 2m 32n 24m
@D oa| (@n) su sn  sn
0a_ Cad (ow) sn sn sn
Ta__Ta)) (n 0w sk sn

04 04 sn 8k sk
oed| sn snsn gk





Scheduled From Finish uses Negative Assignment & Leveling Delay
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Notice that the impacts of Assignment Delay and Leveling Delay are combined for the assignment with R3.

Entering a value with the appropriate sign (positive for scheduled from start and negative for scheduled from finish) in the Assignment Delay field shifts the assignment and generates zeroes in the appropriate timephased cells.

Likewise, if you enter zeroes in the timephased cells at the appropriate end of an assignment (left for scheduled from start and right for scheduled from finish), the Assignment Delay field is automatically filled in. Of course, entering zeroes in timephased cells doesn't shift the assignment; it just truncates it. You can use the Insert Cells menu command to shift cells to the left or right depending on the Schedule From setting. 

Entering the Wrong Delay Sign

If you enter the wrong sign for a delay field, the following alert is displayed:
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Changing Schedule From setting removes delay

Changing the Schedule From setting in the Project Information dialog removes task and assignment Leveling Delay, and Assignment Delay.

When changing the Schedule From setting in the Project Information dialog, the following alert is displayed if any nonzero assignment or task Leveling Delay is found:

Changing Schedule From displays an alert if it finds nonzero Leveling Delay
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Entering Actuals

Predefined versus Edited

Previous sections discussed how predefined contours without Actual Work respond differently than edited contours to edits in non-timephased task and assignment fields. However, once an assignment has actual values, there is no difference:

Once any kind of actual is entered for an assignment, then predefined contours behave like edited contours.

Editing Assignment Timephased Actual Work

If you edit timephased assignment Actual Work in a specific grid cell, the edited Actual Work is distributed between dates Date1 and Date2 that lie within or on the ends of the cell period as follows:

· Date1: If the assignment Start is contained in the cell period, then Date1 is the assignment Start. Otherwise Date1 is the beginning date of the cell. 

· Date2: If the task Finish is contained in the cell period, and the new Remaining Work is zero, then Date2 is set to the task Finish. Otherwise, Date2 is the end date of the cell period.

Any Remaining Work after entering the Actual Work is rescheduled after Date2. This includes any Remaining Work that had previously been scheduled earlier than Date1.

If the previous assignment Start was earlier than Date1 and there was no previous Actual Start, then the Start and Actual Start are set to Date1.

If there is no Remaining Work after the edit, then the assignment Finish and Actual Finish are set to Date2. Otherwise, the assignment Finish is rescheduled after Date2 based on the Remaining Work.

The following rules apply if the amount of timephased assignment Actual Work entered in a cell does not match the scheduled timephased assignment:

· If the entered Actual Work is less than the Work for that cell period, then the unused portions of the segment(s) in that cell period are moved to end of the assignment.

· If the entered Actual Work is greater than the Work for that cell period, then segments are truncated from the end of the contour to account for the excess of Actual Work entered in the cell.

Example of entering less Actual Work than was scheduled:

Before entering Actual Work on Day1 ...
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After entering 1h Actual Work on Day1 ...
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Originally the scheduled Work on Day1 for R1 was 4h at 50% Units. After entering 1h of Actual Work for Day1 for R1, 3h at 50% had to be scheduled after the original end of the assignment, for example, after Day2. The 3h at 50% got rescheduled starting at 8:00AM on Day3, and at 50% Units, ends at 3:00PM on Day3 (3h divided by 50% Units is 6h).

Example of entering more Actual Work than was scheduled:

This example starts with the same Before picture as the previous example, for example, the original contour was 4h at 50% on Day1 and 8h at 100% on Day2.

After entering 7h Actual Work on Day1 ...
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After entering 7h of Actual Work on Day1, the 3h excess is automatically removed from the end of the assignment, leaving only 5h at 100% on Day2.

Editing Assignment Remaining Work

In Microsoft Project 4.x, if you edit assignment Remaining Work, it would change the assignment Actual Work to keep the total Work constant.

Microsoft Project 98 has an improved behavior: If you edit assignment Remaining work, it adjusts the assignment Work and leaves actual assignment Work unchanged. The gain or loss of assignment Remaining Work extends or truncates the rightmost contour segments. The impacts on the contour are similar to the impacts in the previous section, Editing Assignment (Total) Duration, Units, and Work.

Editing Assignment (Total) Actual Work

If you enter (total) assignment Actual Work, it assumes that the work got completed as entered. If you enter assignment Actual Work greater than assignment Work, then assignment Work is set to the Actual Work. In any case, assignment Remaining Work is calculated as assignment Work minus assignment Actual Work.

Editing Assignment % Work Complete

Microsoft Project 98 has a new assignment % Work Complete field that reflects assignment Actual Work as a percentage of assignment (total) Work. You can edit the % Work Complete field and it causes Actual Work and Remaining Work to change appropriately.

Note: There is no assignment % Complete field.

Editing Task Timephased Actual Work

Edits to task timephased Actual Work rolls down to the assignment level in proportion to the assignment Work scheduled for that time period. Any existing timephased assignment Actual Work for that time period is overwritten. 

The rolled down timphased assignment Actual Work is treated as if it had been entered directly and behaves as described in the previous section, Editing Assignment Timephased Actual Work. 

If you skip any days when entering actuals, then the skipped days get zero timephased task Actual Work, and the zeroes roll down to timephased assignment Actual Work. The work originally scheduled for those zeroed days is rescheduled at the end of the task as described in previous sections. 

Example

Before entering task timephased Actual Work ...
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After entering task timephased Actual Work in Day1 and Day2 ...
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Editing Task Actual Work

Entered task Actual Work is assumed to have been done according to the schedule, and is distributed to the task timephased Actual Work, and then rolls down to the appropriate assignment timephased Actual Work. If Actual Work greater than the original Work is entered, the Work is set to the Actual Work. Otherwise, the Work is unchanged. In any case, Remaining Work is set equal to the difference between Work and Actual Work. 

· If task Actual Work is decreased, then Microsoft Project rolls back the task timephased Actual Work to the new lower value and leaves the timephased task Work alone. 

· If task Actual Work is increased, then all the task timephased Work is converted to Actual Work, and excess Actual Work is distributed to assignments in proportion to their assignment Actual Work (not timephased), and then assignment segments are extended as needed.

Example

Before entering task Actual Work ...
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After entering task Actual Work ...

[image: image727.png]Name | Work |AW| RW |[Details |D1 |D2 |D3 |D4 |DS
o1 56 1(16 1) 40 | Worle Sh_loh 16w leh
Act.Work | 8h 8k
RL 32k 12h 20k Work sh_sh_ ®h oh
Act.Work | 8h 4k
R2 24k 4h 20K Work o sh_ sh en
Aok | ok Ak





Important: Make sure you understand the difference between this example, and the previous example in which 8h was entered directly in the task timephased Actual Work for Day1 and Day2. 

Task Remaining Work

If you edit task Remaining Work, it adjusts the task (total) Work and leaves the task Actual Work unchanged. 

Task Actual Start Date

If you enter a task Actual Start date, then the contour is shifted to begin on that date. Any Actual Work is moved relative to the new task Actual Start, to the appropriate new position relative to the new Actual Start of the task. For example, if a task has actuals on days 1, 3 and 5. Then if the Actual Start is moved from day 1 to day 10, then the actuals are moved to days 10, 12 and 14.

Important: If you enter an assignment Actual Start that causes the task Actual Start to change, then other assignments with actuals are not affected. Only assignments that don’t have an Actual Start are moved relative to the new task Actual Start date.

Task Actual Finish Date

Only assignments that occur at the end of the task, or assignments that fall outside the new task span (if Duration was made smaller), have their Work altered when a task Duration changes.

The exact behavior depends on whether the task is a Fixed Work task or not.

If the task Finish date changes indirectly due to an edit to an assignment Finish date or a timescaled edit of assignment Work, then only that assignment is affected. Any other assignments on the task are not impacted by resultant change in the task Finish date.

Fixed Duration or Fixed Unit Task:

If you enter an Actual Finish that is sooner than the scheduled Finish date, then Microsoft Project assumes that the task took less Work and was completed early. If you enter an Actual Finish date that is later than the scheduled Finish date then Microsoft Project assumes that the task used more Work and took longer to complete.

If you enter an Actual Finish date that is earlier than the scheduled date, then Microsoft Project truncates the contour to the Actual Finish date.

If you enter an Actual Finish date that is later than the scheduled date, then Microsoft Project extends out the Remaining Work contour to the new Actual Finish date using the last non-zero Work rate. 

If the Actual Finish date is the same or earlier than the date represented by the last entered actual, then it sets remaining Work to zero and truncates previously entered actuals to the newly entered Actual Finish date. This causes Actual Work and thus (total) Work on the task to change.

Example

Before entering a task Actual Finish ...
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After setting the task Actual Finish to the third day of the task (5/28) ...
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Fixed Work Task:

Microsoft Project keeps the task Work unchanged if possible, but may change it in some cases. There are three cases to consider:

1. If you enter an Actual Finish date that is later than the Finish date, then Microsoft Project spreads out the remaining Work to the entered Actual Finish date and converts it to Actual Work. The amount of Work on the task does not just change the contour.

2. If you enter an Actual Finish date that is earlier than the Finish date, but still greater than the last date containing actuals. Then Microsoft Project squeezes in the Remaining Work and converts it to Actual Work. Note that this may cause an overallocation.

3. If you enter an Actual Finish date that is earlier than the last date containing actuals, then Microsoft Project truncates existing actuals.

The following example illustrate these cases. All of the examples are based on the "Before" picture shown below:

Before entering a task Actual Finish for this Fixed Work task ...
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Example 1
Start with the above Before picture.

Suppose you enter an Actual Finish of 5/30, two days past the original Finish of the task. The contour would change as shown below:

After setting the task Actual Finish two days past the previous Finish ...
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Example 2
Start with the above Before picture.

Suppose you enter an Actual Finish of 5/28, one day earlier than the original task Finish. The contour would change as shown below:

After setting the task Actual Finish one day earlier than the previous Finish ...
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Example 3
Start with the above Before picture.

Suppose you enter an Actual Finish of 5/27, a day before the existing latest actual date. The contour would change as shown below:

After setting the task Actual Finish one day earlier than the previous Finish ...
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Editing an existing Actual Finish date

In Microsoft Project 4.x the Actual Work is recalculated based on the new Actual Duration of the task. It implements a similar behavior in Microsoft Project 98. It extends Work using the last known non zero Work rate, or it truncates the Actual Work. This behavior applies regardless of the task type setting.

· If you enter an earlier Actual Finish date, then it truncates the Actual Work on the task accordingly. If the new Actual Finish date is earlier than the Actual Start on the task, it’ll match the Microsoft Project 4.x behavior of setting Actual Start to be the same as the new Actual Finish and zero out all the Actual Work. 

· If you enter a new Actual Finish date that is after the original Actual Finish date, Microsoft Project extends the rightmost contour segment, increasing its Duration. What happens then depends on the Task type. For Fixed Work tasks, the segment Work of the last segment is unchanged, and its Units do changes inversely to the segment Duration to keep the segment Work constant. For Non-Fixed Work tasks, the segment Units is unchanged, and its segment Work increases proportionately to the segment Duration.

The pictures below illustrate the difference between Fixed Work and Non-Fixed Work tasks when a later Actual Finish is entered for a task with an existing Actual Finish.

Before editing the existing task Actual Finish ...
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After entering a later Actual Finish if it's a Fixed Work task ...
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After entering a later Actual Finish if it's NOT a Fixed Work task ...
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Task % Complete

In Microsoft Project 4.x, if the "Updating Task Status Updates Resource Status" option setting in the Tools Options Schedule tab is selected, then entering task % Complete updates assignment Actual Work.

 In Microsoft Project 98, if the "Updating Task Status Updates Resource Status" option setting in the Tools Options Calculation tab is selected, then entering task % Complete updates task (total) Actual Work, which updates the task timephased Actual Work. Then the tasks timephased Actual Work is rolled down to assignment timephased Actual Work. 

If the above option setting is turned off, then updating task % Complete has no impact on Actual Work values.

For example, In Microsoft Project 4.x, if the task % Complete was set to 10% it would then set all the Actual Work for the assigned resources to be 10% of their total values. It would do so with out regard as to when the Work was scheduled to be done. For Microsoft Project 98, the method outlined above takes the time parameter into consideration.

Update Task Status Updates Resource Status 

In Microsoft Project 4.x, if the Tools Options Schedule tab Update Task Status Updates Resource Status option is selected, then edits to % Complete cause assignment Actual Work to be recalculate as that percentage of the assignment Work. This is not a two-way behavior. I.e. changes to assignment Actual Work does not calculate % Complete (it does calculate % Work Complete). If the setting is not selected, then % Complete has no impact on assignment Actual Work.

In Microsoft Project 98, the Updating task status updates resource status setting was moved from the Tools Options Schedule tab to the Calculation tab (the Split in-progress tasks setting is still in the Schedule tab). The Updating task status updates resource status setting is now a two way setting. When selected, edits to % Complete cause Actual Work and Stop dates to be calculated, and edits to Actual Work and Stop dates cause % Complete to be calculated. When that setting is not selected, % Complete is independent of Actual Work and Stop dates.

The calculations relating % Complete and Actual Work are listed below:

· If you change the task % Complete, then the Actual Duration of the task is changed accordingly, and then for each minute in the span of the task Actual Duration, timephased Actual Work is set equal to the corresponding scheduled work for that minute. 

· If you edit assignment total or timephased Actual Work, then the task total Actual Work changes. The task Actual Duration is then calculated as the amount of time it would take the task to do that Actual Work, based solely on how the task timephased Work is currently distributed over time. I. e. the new task Actual Work value and the task's current work contour are used to figure out how much Actual Duration is represented by the new task Actual Work value. The task % Complete is then recalculated as task Actual Duration divided by task Duration. 

Example

This example illustrates the relationship between % Complete and Actual Work. The Updating task status updates resource status option is selected. 

A. 
Resources R1 and R2 are assigned to task T as shown in the picture below. No actuals have been entered yet. Note that each of the timephased scheduled work values are spread over whole days (as opposed to working at a unit of 1 and doing all the work before the day is over).

Before editing task % Complete ...
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B. 
Next, 50% is entered for the task % Complete. This changes Actual Duration to 2d, and so Actual Work is calculated corresponding to the scheduled Work on Mon and Tue. This causes the task total % Work Complete to become 65% (26/40).

50% is entered for task total % Complete ...
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C. 
Next 20h is entered for the R2 assignment Actual Work. This causes the task % Work Complete to become 90% (36/40), and the task total % Complete to become 86%. 

20h is entered for the R2 assignment Actual Work ...
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The % Complete value comes from stepping along the task Work contour using the total Actual Work value (36h) and seeing how much of the task Duration it would take (hypothetically) to do the Actual Work, assuming it could be done as the task Work is scheduled. The task is scheduled for 13h, 13h, 7h, and 7h on Mon, Tue, Wed, and Thu. To reach the 36h total Actual Work value, 13h of it could be done on Mon, 13h of it could be done on Tue, and 7h of it could be done on Wed, leaving only 3h more to be done on Thu. On Thu, the scheduled work was 7h spread out over an 8h day, so if 3h of that 7h were Actual Work, that would represent 3/7 = 0.43 of a day. So the 36h could be done in 3.43d. That's where the 3.43d total task Actual Duration comes from.

Task % Work Complete

Like the above change to task % Complete, instead of the Microsoft Project 4.x behavior of updating all the assignments regardless when they occur, Microsoft Project 98 updates the task timephased Work and then rolls down the task actuals to the assignments. This method takes the time parameter into consideration.

Conflicts With Timephased Edits

This section discusses how Microsoft Project handles conflicts between timephased edits and other confining factors on a task such as constraints and the Project Start date.

When you attempt to make conflicting timephased edits, they are treated if you are attempting to change the Start or Finish date of the task, and gives the appropriate warning.

In Schedule From Start Projects:

Conflicting Timephased Edit Action
How Microsoft Project Responds

Edit on dates before the Start date of a task that has a predecessor linked to its Start
Displays the Break Link alert with options to cancel or continue:

The timephased edit will cause '<task1>' to start before '<task2>' finishes.  As a result, the link cannot be honored.

Edit on dates after the Finish date of a task that has a link to its Finish.
Puts a FNET constraint on the task..

Edit on dates before the Start date of a task that has a Start constraint
For MSO or SNLT constraints, it displays the Change Constraint with options to cancel or continue:

Task '<T1>' already has a constraint. To keep the timephased edit, the task constraint will be changed to a 'Start No Earlier Than' constraint'

For SNET constraints, the constraint date is changed without an alert.

Edit on dates after the Finish date of a task that has a Finish constraint
For MFO or FNLT constraints, it displays the Change Constraint with options to cancel or continue:

Task '<T1>' already has a constraint. To keep the timephased edit, the task constraint will be changed to a 'Finish No Earlier Than' constraint'

For other constraints, the constraint is changed to FNET without an alert.

In Schedule From Finish Projects:

Microsoft Project 4.x, the break link and change constraint planning wizards aren’t displayed for scheduled from finish projects, but in Microsoft Project 98, they are.

Depending on the circumstances, two Planning Wizards may be displayed. For example, if an edit causes a task constraint to change and at the same time breaks a predecessor task link.

See the table above for the detailed alert messages.

Conflicting Timephased Edit Action
How Microsoft Project Responds

Edit on dates before the Start date of a task that has a link to its Start
This does not cause any problems. The task just gets longer.

Edit on dates after the Finish date of a task that has a link to its Finish
Displays a Break Link alert with options to cancel or continue.

Edit on dates before the Start date of a task that has a Start constraint
For MSO or SNLT constraints, it displays the Change Constraint with options to cancel or continue:

For SNET constraints, the constraint date is changed without an alert.

Edit on dates after the Finish date of a task that has a Finish constraint
For MFO or FNLT constraints, it displays the Change Constraint with options to cancel or continue:

For other constraints, the constraint is changed to FNET without an alert.

Overtime Work

The following tables show the various work related assignment total and timephased fields: 

Assignment Fields

Scheduled Field
Corresponding Actual Field
Corresponding Remaining Field

Work
Actual Work
Remaining Work

Regular Work
not exposed
Not exposed

Overtime Work
Actual Overtime Work
Remaining Overtime Work

Timephased Assignment Fields

Scheduled Field
Corresponding Actual Field
Corresponding Remaining Field

Work
Actual Work
Not exposed

Regular Work
not exposed
Not exposed

Overtime Work
Actual Overtime Work
Not exposed

The fields in these tables that are labeled not exposed, for example Remaining Regular Work, can be useful in discussing editing behavior, just keep in mind these fields cannot be displayed and accessed in any view. These unexposed fields are mentioned in the following discussion. Refer to the above tables to avoid confusion about which fields are "real" and which aren't.

Equations

In general the following relationships exist in the above tables, across the rows ...

Scheduled = Actual + Remaining

and down the columns ...

Total = Regular + Overtime

Going across the rows in the Assignment Fields table:

Work = Actual Work + Remaining Work

Overtime Work = Actual Overtime Work + Remaining Overtime Work

You can also say that

Regular Work = Actual Regular Work + Remaining Regular Work
keeping in mind that the two fields on the right of the equation are not exposed.

Going down the columns in the Assignment Fields table:

Work = Regular Work + Overtime Work

You can also say that

Actual Work = Actual Regular Work + Actual Overtime Work

keeping in mind that Actual Regular Work is not exposed.

Comparison between Microsoft Project 4.x and Microsoft Project 98:

· In Microsoft Project 4.x, there was an assignment level field for Overtime Work. The overtime time was subtracted from the Assignment Work to give a new Duration and the overtime time was scheduled at the very end of the Assignment. 

· In Microsoft Project 98, there is an overtime field for each assignment and the overtime value is subtracted from the initial assignment Duration to give a new shorter assignment Duration. Microsoft Project 98 spreads the overtime evenly over the assignment span.

Although Microsoft Project 98 does not allow you to edit the timephased Overtime Work, you can edit the timephased Actual Overtime Work. 

Like regular Actual Work, overtime-actual values can be edited in non-working periods. For example, it is possible to give actual Overtime Work that occurs on a Saturday or other non-working days without first changing the resource calendar.

If a task or assignment that has overtime is moved to another point in time, then the contoured actual overtime values are moved relative to the Start of the Assignment. For example, if the Assignment started on Monday and you gave actual overtime for Wednesday, then if the Assignment is later moved to Tuesday, then the actual overtime is moved to Thursday. 

Overtime, Overallocation and Leveling

Overtime Work does is ignored when Microsoft Project determines which resources are overallocated. If Leveling moves an assignment, the Overtime Work moves with it.

Splits

If there is a split day on the Assignment contour, then that day does not get any Overtime Work.

Fixed Duration Tasks and Overtime

You can have overtime on assignments on a fixed Duration task. The overtime shortens the Assignment span, but won’t impact the overall Duration of the task. For example, if a task has a 5d fixed Duration task and Bob is assigned to the entire task, then giving Bob 8h of Overtime Work shortens his assignment to 4d with the 8h of overtime spread out over 4d. The Duration of the task stays 5d. In a Usage view, there is a blank for the assignment on the last day, not a zero.

How Overtime is Scheduled

Unless specified otherwise, this discussion assumes no actuals. The last two examples in this section illustrates how Remaining OT Work is scheduled when there are actuals.

When you enter Overtime Work, the Regular Work is calculated from

Regular Work = Work - Overtime Work

As you increase Overtime Work (but not bigger than Work), the Regular Work decreases and Work is unchanged. The assignment span is adjusted to the lower Regular Work. and then ...

... the remaining Overtime Work is distributed evenly over the new assignment remaining regular work segments in proportion to their new spans, not proportional to their segment units.

For example, if due to calendar exceptions or detailed contour edits, an Assignment is only working for half a day, then the Overtime Work for that day is half of what it would be on a day that the Assignment is doing Work over the entire day.

If you enter a value for OvertimeWork that is bigger than Work, then the Work is set equal to the Overtime Work and the Regular Work becomes zero.

Remaining Overtime Work is normally spread evenly over the remaining span of the assignment. If there is no remaining regular work on an assignment, then the remaining overtime work is put onto the last minute of the assignment.

The Before/After examples below illustrate how Overtime Work is distributed, and how entering Overtime Work reduces Regular Work and can allow the task to finish sooner. Overtime Work is distributed. The Work, Regular Work, and Overtime Work column titles have been abbreviated.

Example 1

Before entering OT ...
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After entering 9h assignment OT ...
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In the above picture, note that the units on Day3 is 5h/8h = 13% and the units on Day1 and Day4 are both 8h/8h = 100%, but that the OT Work was distributed evenly across all the days that had work. Here's what happened:

· The increase in OT Work by 9h caused the remaining Regular Work to decrease by 9h to 21h.

· The reduction in remaining Regular Work truncated the contour from the right end, leaving only three nonzero segments, Day1={8h over 1d}, Day3={5h over 1d} and Day4 = {8h over 1d}. 

· The units and work of each of the three segments doesn't matter when distributing the 9h of OT Work. It only cares that there are 3d total of remaining segment contours left and it spreads the 9h OT uniformly across those 3 days.

Example 2

A. 
Before entering OT ...
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B.
After entering 6h assignment OT ...
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Here's what happened ...

· The increase in OT Work by 6h caused the remaining Regular Work to decrease by 6h to 16h.

· The reduction in remaining Regular Work truncated the contour from the right end, leaving only three nonzero segments, Day1={4h over 1d}, Day3={8h over 1d} and Day4 = {4h over 1d}. 

· The units and work of each of the three segments doesn't matter when distributing the 6h of OT Work. It only cares that there are 3d total of remaining segment contours left and it spreads the 6h OT uniformly across those 3 days.

C.
Next enter timephased assignment work in Day4 ...
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Here's what happened ...

· When the span of the assignment increased from 3d to 4d, the remaining OT was redistributed over the new remaining assignment span. That's 6d of OT over 4d of remaining assignment span which is 1.5d of OT per day.

Example 3

The pictures below illustrate how assignment Remaining OT Work is scheduled when actuals are involved. Only the assignment record is shown. Work, Actual Work, Overtime Work, and Actual Overtime Work column titles are abbreviated.

A.
Before the Actuals are entered ...
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B.
After entering 16h for assignment Actual Work ...
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C.
Next enter 4h for Overtime Work ....
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Here's what happened:

· After entering the 16h of Actual Work, there was 28h-16h = 12h of remaining regular work, 6h spread over all of Day3, 4h spread over all of Day4, and 2h spread over all of Day5.

· When the 4h of OT Work was entered, the remaining Regular Work decreased by 4h. The 2h in Day5 and the 2h in the second half of Day4 were truncated. That leaves a day and a half over which the remaining regular 8h of work is spread.

· The 4h of remaining OT Work is distributed evenly over the remaining regular work span of 1.5 days. Since Day3 has 1d of the 1.5 day span and Day4 has 0.5d of the 1.5 day span, the OT Work is distributed in a ratio of 1d to 0.5d over those two days. I.e. Day3 get twice as much of the OT as Day4. Also, the sum of OT has to be 4h. That's where the 2.67h and 1.33h come from. 

Another way to look at it is that the 4h of OT is spread over 3 half days. That's equivalent to 4h divided by 3 half days = 1.33h per half day. That's 2*1.33 = 2.67h for Day3 (it has 2 half days of the span) and 1.33h for Day4 (it has one half day of the span).

How Changes Task Duration impacts OT

If you change the task Duration, then the overtime on an Assignment only changes if the change in task Duration impacts the span of the assignment. This does not impact the total amount of scheduled Overtime Work, but it impacts when that Overtime Work is done

· If the task Duration is increased, Microsoft Project redistributes the remaining overtime evenly over the new longer remaining span of the Assignment. 

· If the task Duration is reduced, then Microsoft Project truncates the Regular Work contour of the task. 

Starting with Example 2/Part B above, if the task Duration is reduced from 3d to 2d, then the Overtime Work would still be 6h, but it would now be done over two days instead of three and so it now be scheduled as 3h and 3h, as shown below:
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How Changes to Assignment Units impacts OT

If an assignment has some overtime, and you change the Units on the Assignment, Microsoft Project redistributes the remaining Overtime Work over the new span of the Assignment. This has the impact of keeping the Overtime Work and the Regular Work totals the same.

How OT is Scheduled Within a Day

How OT is distributed within days depends on whether that day is working or nonworking in the resource calendar for the resource involved in the assignment. OT is never scheduled on nonworking days, but Actual OT can be entered on a nonworking day.

· Working day: Calculated Scheduled OT and entered Actual OT are spread evenly over the resource worktime for that day. So if Monday 8:00am to 4:00pm is working time in the resource calendar, then any OT on Monday is spread evenly over 8:00am to 4:00pm.

· Nonworking day: Entered Actual OT is displayed over the default task Start time and default task Finish time.

Actual Overtime

There are assignment total and timephased Actual Overtime Work fields. You can enter overtime actuals for the assignment as a whole or on a timephased basis. When you edit any regular Actual Work values, some of that Actual Work is given to overtime Actual Work, if any was scheduled on the Assignment.

The assignment OT and Actual OT fields can both be edited. The timephased OT field cannot be edited, can but the timephased Actual OT can.

Edits to the % Work Complete or the % Complete fields impact the assignment Actual Work and Actual OT Work values.

Note: There are assignment total and timephased Actual Work and Actual OT Work fields, but no total or timephased Actual Regular Work fields.

How OT is related to other Assignment Fields

This section discusses how various assignment total and timephased fields are related to assignment OT Work and Actual OT Work.

Editing Work

This field shows the sum of Regular Work plus Overtime Work on the assignment. Edits to this field only impacts Regular Work data. The exception is when Work is set below the Overtime Work value, then Regular Work is set to zero and Overtime Work is set to the Work value (as in Microsoft Project 4.x ). 

The table below shows sample data and a sequence of edits to the assignment Work field and the resulting changes to assignment OT Work or Regular Work. The Regular Work field is displayed in the table, but keep in mind that there is no timephased Regular Work field.

Sequence of Edits
Work
OT Work
Regular Work

Original Work, OT Work, and Regular Work values entered.
20h
5h
15h

30h is entered for Work.

This causes Regular Work to change..
30h
5h
25h

4h is entered for Work 

This causes OT Work to change.
4h
4h
0h

24h is entered for Work.

This causes Regular Work to change..
24h
4h
20h

Editing Actual Work

The pictures below illustrate how editing assignment Actual Work impacts related assignment and timephased fields. Only the assignment record is shown. Work, Regular Work, Overtime Work, Actual Work, and Actual Overtime Work column titles are abbreviated.

A.
Before any OT Work is entered ...
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2. 
After 6h of OT Work is entered ...

[image: image750.png]W _|RegW | OTW | Act W | Act OTW || Details Dl [D2 [D3 [D4
30n 24h C6R) Oh 0| Work 10h_10h 10k
Reg. Work sh Sh sk
Ovt. Work 2 2 2
Aot Work
R





3.
Next 5h of Actual Work is entered ...
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4. 
Next change Actual Work back to 0h, and then change it to 30h ...
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5.
Next change Actual Work directly from 30h to 34h ...

[image: image753.png]W _|RegW | OTW | Act W | Act OTW || Details Dl _|D2 |D3 |D4
Sh 28n 6h (4R 6h| Wk 10h 10k 10h 4k
Reg. Work sh Sk Sh 4h
Ovt. Work 2 20 2 on
ActWork | 10h 10k 10h 4k
Act Ov.Work | 2k ok an on





In all of the above cases, note that if Actual Work is nonzero, then 

Ratio of Actual Overtime Work to Actual Work = Ratio of Overtime Work to Work

This is true for timephased values as well in the pictures, except for the picture 5.

In picture 4, the task assignment is done (Actual Work = Work = 30h). In picture 5, the Actual Work was then increased from 30h to 34h. The existing timephased Actuals were left alone, and the additional 4h of Actual Work was placed after the current end of the assignment.

Editing Remaining Work

Edits to this field can impact the span of the assignment, causing any remaining Overtime Work to be redistributed over the new remaining span.

If you enter Remaining Work that is lower than the current remaining Overtime Work, then the Overtime Work is set to the new lower Remaining Work, and the Regular Remaining Work goes to zero. 

The pictures below illustrate how editing assignment Remaining Work impacts related assignment and timephased fields. Only the assignment record is shown. Work, Overtime Work, Remaining Work, and Remaining Overtime Work column titles are abbreviated.

A.
Before any Remaining Work is changed ...
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2.
After Remaining Work is edited from 30h to 26h ...

This causes the assignment work to be truncated by 4h. The remaining scheduled overtime changes in proportion to the scheduled remaining work.
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3. 
Next change Remaining Work back to 30h, and then change it to 34h ...

This causes additional work to be added to the regular work after the current end of the task. The remaining scheduled overtime is redistributed accordingly.
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Editing Actual Overtime Work

If you decrease Actual Overtime Work, then Remaining Overtime Work is increased.

If you increase Actual Overtime Work (but not greater than Remaining Overtime Work) then the Remaining Overtime Work is decreased. 

If you enter a value for Actual Overtime Work that is larger than the current Remaining Overtime Work, then the excess is spread over the last remaining segment if any, or is placed all at the end of the assignment.

Actual Overtime Work
Remaining Overtime Work
Timescaled Overtime Work

Mon Tue  Wed
Notes

2
4
2   2   2  (Overtime)
2h of actual and 4h remaining

8
0
2   3   3  (Overtime)
User now entered Actual Overtime Work of 8h. It spreads the new increase (6h) over the last remaining portion (2 days) giving the following.

This increase in actual overtime over the scheduled overtime causes the total Work for the task to be increased. Normally edits to scheduled Overtime Work do not impact the total Work on the task. But in this case where you has entered an actual overtime value greater than the scheduled overtime, the easiest thing to do is to increase the overall Work on the task.

The pictures below illustrate how editing assignment Remaining Work impacts related assignment and timephased fields. Only the assignment record is shown. Work, Actual Work, Overtime Work, and Actual Overtime Work column titles are abbreviated.

A.
Before any actuals or overtime are entered ...
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2.
After entering 16h for Actual Work, the same value as Work so there is no remaining work ...
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3.
Next enter setting entering 3h, 5h, and 7h into the timephased Actual Overtime Work for Day1, Day2, and Day3 ...
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3.
Next enter 115h in the Actual Overtime Work assignment field (that's an increase of 100h) ...
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Notice that the extra 100h of total assignment Actual Overtime Work is all scheduled at the very end of the assignment (on the single assignment Finish date), because there was no remaining work segment for it to be distributed over (the assignment was complete).

% Work Complete:

% Work Complete is Actual Work divided by (total scheduled) Work. This is a task and assignment field.

Edits to % Work Complete impact Actual Overtime Work and vice versa.

If you edit % Work Complete, Microsoft Project sets Actual Regular Work to be that percentage the total Regular Work, and sets Actual Overtime Work to be that percentage of the total Overtime Work. Changes in these assignment fields impact the timephased fields as discussed in previous sections.

Note: Changing the % Work Complete may change timephased Actual Work values that were previously entered.

Baselines

The Microsoft Project 98 Save Baseline Command

Menu command Tools Tracking Save Baseline ...
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... displays the Save Baseline dialog ...
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Microsoft Project 4.x Baseline Features

Microsoft Project 4.x has baseline fields corresponding to task fields: Start, Finish, Duration, Work and Cost. It also stored resource cost and resource Work as well as Assignment Work and Assignment cost. These fields allow you to compare the current values to the baseline. In addition it allows you to store up to 5 sets of task Start and task Finish dates as interim plans (Start1, Finish1, and so on). These interim plans can be displayed on the Gantt and compared with each other or with the current project.

Microsoft Project 98 Improved Baseline Features

In addition to storing all the baseline information that Microsoft Project 4.x did, Microsoft Project 98 baselines have the following improved features:

· Microsoft Project 98 baselines save the timescaled Work and Cost values for each task, resource and assignment. By saving this timescaled information as part of the baseline, it allows you to compare the current or baseline timescaled actuals/scheduled Work and Costs. 

· Microsoft Project 98 baselines also store task-split dates, so that baseline tasks can be drawn on the Gantt Chart with their original splits. You cannot explicitly see or edit the scheduled or baseline split dates.

Microsoft Project 98 Tracking Gantt showing lower split baseline bars

[image: image763.png]



In Microsoft Project 98, you can edit baseline data, but as in Microsoft Project 4.x, there is no rollup or any recalculations done on baseline information.

Baseline Information Saved

The table below shows what information is saved in a Microsoft Project 98 baseline:

Task Information
Resource Information
Assignment Information

Start

Finish

Work

Cost

Duration

Cost Contour

Work Contour

Split Dates
Work

Cost

Work Contour

Cost Contour

Resource Calendars and the corresponding base calendars for resources with assignments
Start

Finish

Cost

Work

Cost Contour

Work Contour



Interim Plans

Microsoft Project 98 can save up to 10 sets of Start and Finish dates, Start1, Finish1, and so on. 

In addition, the Microsoft Project 98 interim plans save split dates.

Microsoft Project 98 Interim Plan Information Saved

· Start

· Finish

· Split Dates

No resource or assignment data is saved in an interim plan.

Splits

Baseline and Interim split bars are drawn on the Gantt only if you use matching pairs of dates in the From and To fields, for example, From Baseline Start To Baseline Finish, or From Start3 To Finish3. The Show For field must also include the new condition, Split.

Baseline and Interim split bars can be moved in the Gantt view just like scheduled task bars.

ALAP and Schedule From Finish Contour Effects

Increases/decreases in Work always occur at the end of the Assignment.

Changing non-timephased factors such as task total Work or Duration can result in more or less Assignment Work, causing the contour to be extrapolated, truncated, or scaled, depending on whether its a predefined contour or an edited contour. 

The resulting relative changes to the contour are independent of whether the project is scheduled from Start or Finish, or whether the task is ASAP or ALAP. The relative expansion or contraction of a contour always occurs at the right hand side of the contour. 

If the (non-timephased) Assignment Work is increased then the additional Work segment uses the Units value of the current rightmost segment; therefore the new segment has a Duration equal to the additional Work divided by the current rightmost Units. Since the current rightmost segment has the same Units as the new segment being tacked onto the right, you can think of the original rightmost segment and the new segment as a single segment representing the "extension" of the original rightmost segment.

For an ASAP task, the additional Work leaves the Assignment Start alone, and forces the Assignment Finish to the right.

For an ALAP task, the new segment is inserted between the current rightmost segment and the Assignment Finish date, leaving the Assignment Finish date alone, and forcing the Assignment Start to the left, as shown in the following before/after illustration:
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The example below begins with an ASAP task T1 and an ALAP task T2, each with a single Assignment with identical relative contours. The relative contour they have in common is:

Segment1
Segment2

1h Work over 8h dur, 12.5% Units
4h Work over 8h dur, 50% Units

The picture below shows the Task Usage view with the assignments hidden (collapsed). Note that the task Work is the Assignment Work since each task has only one Assignment.
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Now suppose the total Work of the task is increased by 1h. This results in the following extrapolation of the contours:

[image: image766.png]Hame |Work | Dur [Hotes | Start | Finish || D1 | D2 | D3 | D4 | DS

FTI | 6h 2250 ASAP | Mon:00AM Wed 1000A| 4 gh
©T2  oh 225 ALAP  Wed 3:00PM  Fri5:00P| 026h 4750, b





Note that the Start of the ASAP task T1 has not changed, and its Finish has moved to the right by 2h. The Finish of the ALAP task T2 has not changed, and its Start has moved to the left by 2h.

Important: The two relative contours are still the same.

If the two relative contours are the same, why do the timphased sequences of daily Work values look different ({1h,4h,1h} versus {.25h,1.75h, 4h})? Because of the timescale granularity, if you formatted the timescale by hours, the sequences would be the same.

But there's an easier way to see that two relative contours are the same. Temporarily make the two assignments have the same Start date, and see if the timephased sequences of Work numbers match. The picture below shows what you get if you manually edit the Start of T1 to match the Start of T2:
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Now it's clear the two Assignment relative contours are identical.

In both assignments, the additional Work was added to the right most segment, so the new common relative contour definition is:

Contour Segment 1
Contour Segment 2
New Segment

1h Work over 8h dur, 12.5% Units
4h Work over 8h dur, 50% Units
1h Work at 50% Units (rightmost Units),

calculated dur = 2h

Or, since the new segment has the same Units as the previous rightmost segment, you can combine the new segment with the old rightmost segment:

Contour Segment 1
Combined old segment 2 and the new segment

1h Work over 8h dur, 12.5% Units
5h Work over 10h dur, 50% Units

Assignment delay is applied at the Start or Finish of the Assignment, depending on whether the project is scheduled from Start or Finish.

For tasks that are scheduled from Start, any positive Assignment delay is applied to the Start of the Assignment. This causes the Assignment Start to be later than the Start date of the task. 

For assignments that are scheduled from Finish, the Assignment delay is applied from the Finish of the Assignment. This causes the Assignment Finish to be earlier than the Finish date of the task.

Lesson 5.5 - Exercises

1.
What kind of views can display assignment records? 

2.
How do you select a predefined work contour type for an assignment?

3.
What is the default work contour type when you create an assignment?

Is there a setting to change the default work contour type?

4.
What can cause the Work contour setting to change to Contoured?

5.
What is an assignment segment?

6.
What formula relates the duration of an assignment segment with the segment units and segment work?

7.
Is assignment Duration an exposed field, i. e. if you insert the Duration field in the task table in a Task Usage view, does it display values for assignment records?

What about assignment Start and Finish fields?

8.
Did Microsoft Project 95 have an Assignment Information dialog? If yes, how did it compare to the one in Microsoft Project 98?

9.
List the names of the 8 predefined contours.

10.
Can you create additional named contours and add them to the Work contour dropdown list in the Assignment Information dialog General tab? For example, can you edit the timephased Work and then save the contour as MyContour and have MyContour appear in the Work contour list?

11.
In Microsoft Project 95 you could vary the work load of an assignment on a task by assigning the resource multiple times to the same task. Can you assign a resource multiple times to the same task in Microsoft Project 98? What happens in Microsoft Project 98 if you open a Microsoft Project 95 project that has a resource assigned multiple times to the same task?

12.
For an assignment with a predefined contour, what formula relates the assignment total work, the assignment duration, the assignment units, and the assignment predefined contour?

Is there a similar formula for edited contours?

13.
What Microsoft Project 98 predefined contour most closely resembles assignments in Microsoft Project 95?

14. 
How is task Duration calculated differently in Microsoft Project 98 versus Microsoft Project 95?

15. 
When you assign a resource to a task and do not specify the amount of Work, Microsoft Project will assign a default Work value for you. How does the calculation of this default assignment Work differ in Microsoft Project 98 versus Microsoft Project 95? Consider the case where the task has non-elapsed duration and the case where it has elapsed duration.

16. 
Can you edit the assignment Start and Finish dates in Microsoft Project 98? What about Microsoft Project 95?

17. 
How does the Updating task status updates resource status setting in Microsoft Project 98 differ from the Update Task Status Updates Resource Status option in Microsoft Project 95?

Where are these setting located in the two versions of Microsoft Project?

18. 
What is the difference in how Microsoft Project 98 handles Overtime Work versus how Microsoft Project 95 handled it?

19. 
What kind of task information is saved when you save a baseline? What about resource information? What about assignment information?

20. 
What kind of information is saved when you save an interim plan?

21. 
If a project is scheduled from finish and you increase the total work on an edited assignment for a Fixed Units ALAP task, which of the following is true?

A. The assignment work contour gets extended back in time from the start of the assignment, causing the assignment to start earlier.

B. The assignment work contour gets extended forward in time from the finish of the assignment and then entire task is moved back in time so that the assignment finish is the same as it was originally.

C. The assignment start and finish are unchanged and all additional work is spread uniformly across the assignment.

D. The assignment start and finish are unchanged and all additional work occurs at the very start of the assignment.

Lesson 5.5 - Labs

Lesson 5.5 - Lab 1

1.
Create a project with a single Fixed Units task. Assign a single resource R1. Edit the Standard calendar so that every day is a working day with the standard working hours 8a-12p, 1p-5p.

2.
Switch to the Task Usage view, double click the assignment and select Bell for Work contour, and click OK. Change the Duration of the task to 10d.

3. 
Format the task table, timephased grid and timescale as shown in the picture below (including the labels for work and duration and the column titles):
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4. 
Verify that the following formula is satisfied for this example by plugging in the appropriate values from the example and seeing if both sides of the equation give the same value:

Wassmt = Dassmt * (Uassmt * UscaleAvg) 

These terms are defined in the lesson in the section Predefined Contour Assignment Calculations.

5. 
Change the Assignment Units to 50%. Which other variable in the above equation changes? Is the equation still satisfied?

6. 
Change the Assignment Work to 10h. Which other variable in the above equation changes? Is the equation still satisfied?

7. 
Change the task Duration to 10d. Which other variable in the above equation changes? Is the equation still satisfied?

8. 
Change the Duration to 5d. On the first day of the project (D1), click in the cell for the assignment timephased work and re-enter the same value that you see there (or press Ctrl+C and then Ctrl+V to copy and paste the value back on top of itself). Does the assignment still have the Work contour set to Bell in the Assignment Information dialog?

9. 
Increase the Duration to 10d. 

Does it distribute the assignment work across the 10d duration as a Bell contour? 

Is the equation in step 4 still satisfied?

Explain what happened.

Lesson 5.5 - Lab 2

1.
Create a project that starts on 6/2/97. Enter a single task Fixed Units task T that is not Effort Driven. Assign resources R1 and R2 to task T.

2.
Switch to the Task Usage view. Format the view and enter the values shown in the timephased grid below (the values in the table on the left will be calculated for you).
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By looking at the timephased Actual Work for the assignments, what is the Resume date for task T? Verify it by inserting the Resume field into the task table on the left.

3.
Assign another resource R3 to task T without specifying the assignment units or work, and examine the default work contour for the new assignment.

Explain what happened. If you need help understanding the result, this lab is the example in the lesson under the heading Tasks with Actual Work (Project 98). 

4.
Redo steps 1-3, only this time make the task Fixed Units and Effort Driven.

5.
Redo steps 1-3, only this time make the task Fixed Duration and not Effort Driven.

6.
Redo steps 1-3, only this time make the task Fixed Duration and Effort Driven.

Lesson 5.5 - Lab 3

1.
Create a project with a single Fixed Units task T. Assign a single resource R1. 

2.
Switch to the Task Usage view. Format the view and enter the values shown in the timephased grid below. The fields titled W, RegW, and OTW are Work, Regular Work, and Overtime Work.
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3.
Enter 6h in the Overtime Work column in the table on the left for the assignment. The Duration of the task should change to 3d and the timephased Overtime Work should be 2h per day for each of the 3 days. 

Explain what happened. If you need help understanding the result, this lab is the second example in the Overtime Work section of this lesson.

Lesson 5.6: Task Splitting

Some Topics to be introduced in this lesson include:

· Different Ways to Create Task Splits

· Splitting tasks with no assignments

· How splitting impacts timephased work

· Baselines and interim plans

· Behavior of splitting tasks with Fixed Duration

· Split Task Formatting

Task Splitting and Scheduling

Task splitting is a new feature in Microsoft Project 98. Task splitting supports the Stop and Resume fields from Microsoft Project 4.x, but is much more powerful, since there is no limit to the number of splits in Microsoft Project 98.

Task splitting is a useful way to model interruptions to a task. This can take a very simple form of stopping work on a task for a period of time and starting up again on the task. Or it can take more complex forms such as assigning resources to different parts of the task or to model a number of very similar tasks as a single task much like recurring tasks.

You split tasks by using the Edit menu Split Task command...
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You can also right click on a bar to display the shortcut menu...
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After you click Split Task, you move the mouse pointer to the place you want to split the bar...
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You can then click to make a one day split gap and then drag the individual pieces, or you can click and drag the new right part immediately without releasing the mouse button. 

Note: If a task has a nonzero % Complete, and if the Split in-progress tasks setting in the Tools Options Schedule tab is selected, then you don't need to use the Split Tools command. You can also click the remaining part of the task and drag it. There is more information on this setting later in this lesson.

You can use the Split Task tool repeatedly to split pieces into smaller pieces, creating multiple splits as illustrated below:
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Splits are sometimes referred to as gaps. In the above picture, the splits are represented by the dotted lines. The length of each gap is called the span of the split, measured in working days. The date at the beginning and ends of a dotted line segment are called the split start and split finish dates.

Kinds of Splits

Microsoft Project 98 supports relative splits, not absolute splits. The difference is described below:

· Absolute splits (not supported): An absolute split means that the split gap dates are fixed and if the task Start changes, the task "flows" around the fixed gaps. It may even move entirely beyond a fixed gap. Microsoft Project 98 does not support absolute splits.

· Relative Splits (supported): A relative split means that if the task Start date changes, the gaps move with it. For example, if a 5-day break must occur in a task exactly 2 working day after the task starts, regardless of when the task starts, then a relative split could be used.

Splits and Resource Contours

Tasks can be split whether they have resources or not. 

A split on a task automatically gives all of the task's resources zero work during the gap period. The Usage views show the zeroes in the timescaled grid.

If a task has resources, a split is equivalent to giving all of its resources zero work during the desired split gap. 

Example

The sequence of pictures below illustrates how a split can be created in a Usage view. Task T1 originally has a 3d Duration with resources R1 and R2 each doing 24h of work. 

Gantt Chart showing 3d task with no split...
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Corresponding Task Usage view...
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A split will be made next so that task T1 stops completely at the end of Monday (Day1), and resumes the following Tuesday (Day9). So the split Start should be at the beginning of Day2 and its finish should be at the end of Day8. To accomplish this in the above Task Usage view, you click in the row for task T1 in the timescaled grid on Day2 (when the split will begin), and drag to Day8 (when the split will end), and then use the Insert Cells menu command, or press the INSERT key. 

Before pressing the INSERT key...

[image: image777.png]Name ‘Dm‘m D2 [D3 |D4 D5 |D6 |D7 |D8 D9 |D10
M| T (W[ T [F|S S M|[T[W
BT 3d|[ 16h7 16n K3
R1 8h 8h 8h
RrR2 8h 8h 8h.





After pressing the INSERT Key...
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Corresponding Gantt Chart...
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If zeroes had been inserted for only one of the resources, then it does not create a split. The task would run from Day1 to Day10 though.

Splits can also be removed in a Usage view by selecting a timescaled range in the grid in the task row, and then using the Edit Delete Cells menu command, or pressing the Delete key.

Nonworking Time is not a Split

A split gap is different than specifying a nonworking period on project or resource calendars by using the Change Working Times command, or the Working Times tab in the Resource Information dialog. It impacts the Start and Finish of tasks, but does not split them.

Storage of Split Dates

In addition to looking at zero work gaps, Microsoft Project internally stores pairs of split dates for all splits on a task. Splits created with the Split Task tool in the Gantt Chart view are rolled down to assignments if there are any, and edits to assignments are rolled up to the internal task split dates. The split dates can only be observed in a Usage view by looking at periods of zero work. There are no fields you can insert it a table to see these split dates.

The number of splits allowed per task is only limited by the memory on the machine.

Tasks with no assignments

Tasks can be split even if they have no assignments. This is possible because the storage of split dates discussed above.

Split Behavior

· A split is relative to the start of the task. When the entire task is moved to another point in time, the split is moved with the task.

· If the Units of an assignment change, the split is moved, but the span of the split does not change. 

· The split span is based on working time and not elapsed time. 

Duration and Splits

· Splits in a Fixed Duration task count as part of the total task Duration.

· Splits in a non-Fixed Duration task do not count as part of the total task Duration.

The Before/After pictures below illustrate the impact splits have on Duration for the there task types:

Before splitting...
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After splitting...
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Dragging Gantt Task Portions

You can use the mouse to drag individual pieces of a split task independently, except for the first piece. 

Dragging the first piece moves the all pieces relative to the first piece. Any other piece can be dragged independently. A gray outline shape of part or parts being dragged moves as you drag so you can tell what is being dragged.

If you drag a piece independently and bump into another piece on the left or right, those pieces are merged back into a single piece.

Extending or Reducing Gantt Task Portions

You can use the mouse to extend or reduce the Duration of individual pieces. When you adjust the Duration of an individual piece, only assignments that have work at the end of that piece are impacted. If an assignment does not have work at the end of a piece, then increasing the Duration of that piece doesn't impact the contour of that assignment, and decreasing the Duration of that piece will not  impact the contour of that assignment as long as it doesn’t decrease earlier than the original finish of the assignment.

The impact on the resource contour depends on whether the task Type is Fixed Work or not.

Example

This example illustrates the impact of extending one of the pieces of a split task, and how it depends on task Type. Split tasks T1 and T2 begin with identical schedules except that T1 is Fixed Work and T2 is not. The sequence of pictures below shows what happens when the first piece of each task is dragged to the right one day. Note that R2 on each task does not work to the end of the first piece on T1 and T2.

Start with the same resource contours on split Fixed Work and Fixed Units task...
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Corresponding Gantt Chart...
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Next drag the right end of the first piece of each task 1d to the right...
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Corresponding Task Usage...
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R1 had work at the end of the first piece of each task; therefore its contour was impacted when the Duration of the first piece increased. 

· For the Fixed Work task T1: R1 originally had 24h spread over the 3d first piece of T1. The Duration of the first piece was dragged to 4d so now R1's 24h of work on the first piece of T1 has to be spread over 4d. That's 24h divided by 4d which is 6h per day.

· For the non-Fixed Work task T2: Extending the Duration of the first piece simply extends R1's contour, using R1's Units (work rate) at the end of the first piece, which was a rate of 100% (8h per day). Extending 1d to the right at that same work rate gives 8h on Day4.

R2 on the other hand did not originally work at the end of the first piece on either task, so increasing the Duration of each task didn't change either contour for R2.

Note that if you now drag the first piece of T1 and T2 back to the left to their original positions, the reverse impact occurs, and everything ends up as it was at the start.

Splits Caused by Leveling

Leveling can also create splits. The Tools Resource Leveling menu command displays the Resource Leveling dialog, which contains the option Leveling can create splits in remaining work, as shown in the picture below:

Bottom portion of the Resource Leveling dialog...
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With this option selected, leveling may create split tasks if necessary to help solve overallocations more effectively. When split information is saved, splits created by leveling are flagged internally so that they can be distinguished from other splits. If you later choose the Clear Leveling button, task and assignment Leveling Delay is cleared, and only the splits created by leveling are removed.

Note: There are no fields that display the internally stored split dates, and there is no way you can tell by viewing a project which splits leveling creates.

Example

This example illustrates the difference between manually created splits and splits created by leveling. Tasks T1 has a manual split on Day2, and resource R is overallocated on Day4 where T1 and T2 overlap. T2 has the Do Not Level priority.

Gantt Chart showing manually created split on T1...
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Corresponding Task Usage view...
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Note: Priority is read-only for assignment records.

Next, the entire project is leveled, with the Leveling can create splits in remaining work option selected, resulting in a leveling created split on T1.

Gantt Chart showing a leveling created a split on T1...
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Corresponding Task Usage view...
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If you use the Clear Leveling command now, only the split created by leveling would be removed.

Stop and Resume Fields 

Review of Microsoft Project 4.x Stop, Resume, and Resume No Earlier Than 

Microsoft Project 4.x. uses the task Stop and Resume fields to split the remaining portion of a task from the work done on the first portion. 

The Stop and Resume fields are calculate-only fields in Microsoft Project 4.x.  Tasks are split in Microsoft Project 4.x either by entering a resume date in the RNET (Resume No Earlier Than) field, or by using the Tools Tracking Update Project menu command with the Reschedule Uncompleted Work to Start option. If the task has no Actual Work, then a simple Start No Earlier Than constraint reschedules the task. 

The Microsoft Project 4.x Update Project dialog has the controls as the Microsoft Project 98 Update Project dialog shown below:

Microsoft Project 98 Update Project dialog...
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The Update Project dialog also has an Update Work as Complete Through, Set 0% - 100% option to set the % Complete through a date that you enter. This calculates the % Complete based on the task Start and Finish date compared to the status date. There is also an option to just calculate 0% or 100%.

There are two options in the Tools Options Schedule tab that impact Stop and Resume dates and the use of the Update Project commands. The settings are Split In-Progress Tasks and Updating Task Status Updates Resource Status. 

· Split In-Progress Tasks: If selected, then remaining work on an in-progress successor task that violates a relationship with a predecessor task, is automatically rescheduled to honor the relationship with the predecessor. Also, the setting must be selected in order to have Stop and Resume dates, and for the Reschedule Uncompleted Work to Start feature to have any impact on in-progress tasks. See the Split In-Progress Tasks section later in this lesson for more information.

· Updating Task Status Updates Resource Status: If this option is selected, then edits to % Complete cause assignment Actual Work to recalculate as that percentage of the assignment Work. This is not a two-way behavior. Changes to assignment Actual Work do not calculate % Complete (it does calculate % Work Complete). If the setting is not selected, then % Complete has no impact on assignment Actual Work.

The following apply to both Stop and Resume:

If Split In-Progress Tasks is not selected, then Stop and Resume are NA. 

If % Complete is 0, then Stop and Resume are NA.

Assuming that Split In-Progress Tasks is selected and that % Complete is nonzero, then the following rules apply:

If a task has no resources, then the task Stop is the date derived from Actual Start + Actual Duration.

If a task has resources, then the task Stop is the earliest of all of the internal non-exposed assignment stop dates. Each assignment stop date is based on how long it would take to do its current Actual Work. Note that if the Updating Task Status Updates Resource Status setting is selected, then assignment Actual Work changes when you enter a value for % Complete, otherwise it is independent from % Complete. Even, so, % Complete must be nonzero before Stop and Resume can have dates.

The task Resume date is the RNET (Resume No Earlier Than) date if RNET is not NA, otherwise the task Resume date is the working date immediately after the Stop Date.

If an in-progress successor task has an Actual Start and violates a relationship with a predecessor task, then the uncompleted work on the successor task is automatically rescheduled to honor the relationship with the predecessor. That's where the setting Split In-Progress Tasks got its name.

RNET is an editable field. It is also filled in when you use the Microsoft Project 4.x Tools Tracking Update Project menu command with the Reschedule Uncompleted Work to Start option, provided the task has remaining work. Otherwise, The Update Project dialog also has an Update Work As Complete Through, Set 0% - 100% option to set the % Complete through a date that you enter. This calculates the % Complete based on the task Start and Finish date compared to the status date. There is also an option to just calculate 0% or 100%. The Microsoft Project 4.x Update Project dialog has the same controls as the Microsoft Project 98 Update Project dialog shown below.

If you repeatedly reschedule uncompleted work, the split history is lost. Each time you reschedule remaining work in Microsoft Project 4.x, it simply assumes the current Actual Work was done as scheduled. It ignores previous splits and stop dates, and creates one new split based on a new stop date based on the current % Complete or assignment Actual Work, and based on the new date you enter in the RNET field or in the Reschedule Uncompleted Work to Start date box.

In Microsoft Project 4.x, split history is not saved. You can only have one split at any give time.

Microsoft Project 98 Stop and Resume Fields New Behavior

Some of the changes in Microsoft Project 98 regarding Stop, Resume, and related fields are listed below:

· There is no RNET (Resume No Earlier Than) field.

· The Stop and Resume fields can be edited directly. 

Editing the Stop field has the same impact as using to the Update Work as Complete Through, Set 0% - 100% option in the Update Project dialog.

Editing the Resume date has the same impact as using the Update Project, Reschedule uncompleted work to start option.

Microsoft Project 98 Update Project dialog...
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· The History of assignment Actual Work is preserved. There is still only one pair of Stop and Resume fields in Microsoft Project 98, but setting a new Stop and Resume date does not impact existing Actual Work contours. Only remaining work is scheduled on or after the Resume date, after the current Actual Work already on the assignment. 

· The Updating task status updates resource status setting was moved from the Tools Options Schedule tab to the Calculation tab. The Split in-progress tasks setting is still in the Schedule tab. The Updating task status updates resource status setting is now a two way setting. When selected, edits to % Complete cause Actual Work and Stop dates to be calculated, and edits to Actual Work and Stop dates cause % Complete to be calculated. When that setting is not selected, % Complete is independent of Actual Work and Stop dates.

· It is no longer necessary to have a nonzero % Complete in order to have a Stop date, however there has to be a task Actual Start date. In particular, if the Updating task status updates resource status setting is not selected then enter Actual Work sets a Stop date but leaves % Complete alone.

Example

This example compares Microsoft Project 4.x and Microsoft Project 98 behavior regarding task splitting. There are four steps to this example (A, B, C, and D). There is a pair of pictures at each step comparing the Microsoft Project 4.x and Microsoft Project 98 states. 

A.
Task T1 has a 4d Duration and is 25% complete.

Microsoft Project 4.x...
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Microsoft Project 98...
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B.
The task stops at the end of Day1 (6/16) and  resumes on Day4 (6/19). The Microsoft Project 4.x Gantt below has a custom From Stop To Resume bar style for emphasis. The reschedule date of 6/19 could have been entered in the Update Project dialog instead of entering it directly in the table. Both versions of Microsoft Project behave similarly at this step.

Microsoft Project 4.x after entering 6/19 in the RNET field...
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Microsoft Project 98 after entering 6/19 in the Resume field...
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C.
Later during the life of the project, you determine that the project is 50% complete. Microsoft Project 4.x throws out the original split information and recalculates the split based on 50% having been done in the first part and only 50% needing to be rescheduled on Day4 (6/19) in the second part. Microsoft Project 98, however, keeps the first split, and the progress bar jumps over the split.

Microsoft Project 4.x after entering 50% in the % Complete field...
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Microsoft Project 98 after entering 50% in the % Complete field...
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D.
Next you find out the remaining two days can't start until Day6 (6/21). The difference is clearer at this step that Microsoft Project 4.x doesn't do multiple splits while Microsoft Project 98 does.

Microsoft Project 4.x after entering 6/21 in the RNET field...
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Microsoft Project 98 after entering 6/21 in the Resume field...
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Stop and Resume Calculations

Assignment and Task Stop Dates

Every assignment has an internal stop date that equals the assignment start plus how long it would take to do the current assignment Actual Work. If the assignment has no Actual Work, then its stop is the same as its start. If the assignment Actual Work is edited, then the right most cell that is ever edited determines the assignment stop date, even if you enter 0h for Actual Work in that cell. All Actual Work on an assignment occurs on or before its stop date.

If there are no assignments, then the task Stop date is based on the task % Complete and any task splits. From the task Start, measure off the Actual Duration, jumping over splits and nonworking time.

Editing a task Stop date marks assignment scheduled work as Actual Work through the task Stop date and unmarks assignment Actual Work after the Stop date.

The task Stop date is impacted by assignment actuals as follows:

· If a task has assignments and if they are all complete, then the task Stop date is the latest Actual Finish of all of the assignments.

· If a task has assignments and if any of the assignments is  not complete, then the task Stop date is the earliest assignment stop.

Assignment and Task Resume Dates

Every assignment has an internal resume date that is the earliest that remaining work can be scheduled for the task. It is the beginning of the block of working time starting on or after the assignment stop. The assignment has no Actual Work on or after its resume date.

If there are no assignments, then the task Resume date is based on the task Stop date and any task splits. It can be at the beginning of the block of working time starting on or after the task Stop. Or, you can separate it from the Stop by all or part of a split. It can be in the middle of a split if you enter it that way.

If there are assignments, the above rules still apply, except that the task Resume can never be in the middle of a split when there are assignments. 

If a task Resume date is entered that is in the middle of a split, it closes the part of the split on its right, so that the shortened split gap ends on the task Resume date.

Editing a task Resume date marks remaining assignment work on or after the Resume date, and unmarks existing assignment Actual Work on or after the Resume date (but doesn't touch existing Actual Work before the task Resume date).

Example

This example illustrates how the task Stop and Resume is calculated from assignment Actual Work contours. The Stop and Resume have not been entered in this example. The assignment with R1 stops on 6/6 at 5pm, and the assignment for R2 stops on 6/4 at 5pm. The task Stop is the earlier of the two assignment stops, 6/4 at 5pm. The Resume is on the next working day since the task Stop is not the beginning of a split.

Task Stop is the earliest assignment stop...
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Example

This example shows the impact of entering a Resume date that is earlier than existing assignment actuals (even if you reenter the same Resume date that was previously calculated). Continuing from the picture in the above example, the Resume date of 6/5 is reentered manually. The result is shown below:

Entering Resume truncates existing assignment Actual Work...
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Example

This example shows the impact of entering a Resume date that is inside an existing split gap. 

Two day task with a 4d split...
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After changing the resume date to 6/5...

[image: image804.png]Stop

D5 [ D&

D7

Jun 3 5:00 PM





Summary Task Stop and Resume

You cannot edit the Stop and Resume fields on a summary task.

The Stop date for a summary task is the earliest Stop date of its child tasks, and the Resume date is the earliest Resume date of its child tasks.

If all of the child tasks have NA for Stop and Resume, then so does the summary task, otherwise NA is treated as the child Start date for comparison purposes.

Example

This example illustrates how the Stop and Resume fields are calculated summary tasks. 

For S1: The Start of T1b (6/3) is used for comparison purposes since T1b has NA for its Stop and Resume. Both the earliest Stop and earliest Resume of the child tasks is 6/3.

For S2: T2b has both the earliest Stop and earliest Resume dates.

For S3: The Start of T3b (6/5) is used for comparison purposes since T3b has NA for its Stop and Resume. The earliest Stop (6/3) comes from and T3a, and the earliest Resume (6/5) comes from T3b.

Stop and Resume roll up to summary tasks.
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Summary Task % Complete

In Microsoft Project 4.x, you cannot edit the % Complete field of a summary task; however, in Microsoft Project 98 you can. Editing a summary task %Complete sets the Actual Work on the appropriate subs tasks, which in turn impacts the summary task Stop and Resume fields.

Split In-Progress Tasks

This setting is located in the Tools Options Schedule tab.

Selecting this option is required to enable the following features:

· Remaining work on an in-progress successor task that violates a relationship with a predecessor task is automatically rescheduled to honor the relationship with the predecessor. 

· The Stop and Resume fields for non-summary tasks can be edited. If the Split In-Progress Tasks option is not selected, Stop and Resume fields are still calculated, but cannot be edited.

· The Tools Tracking Update Project Reschedule Uncompleted Work to Start feature can split in-progress tasks to reschedule remaining work. Otherwise this feature can only move tasks that have not started (by giving them SNET constraints).

· You can click on the remaining portion of an in-progress task Gantt bar and drag it to reschedule it. This creates a split that runs from the original Stop date to the new Resume date, and you do not need the Split Task tool to do this. 

Baseline and Interim Plan Split Information

Baseline Splits

When you save a baseline plan, the split information is saved with the baseline internally. This means that the baseline bars can be displayed on the Gantt Chart with the splits intact. Clearing a Baseline Start or Finish field clears the split information from the project.

There are no fields that display scheduled, baseline, or interim split dates. You can access scheduled split dates using the tasks SplitParts collection, but there is no SplitParts collection for baseline bars. 

You can use the task Baseline Start and Baseline Finish fields to move, truncate, or extend the baseline end pieces, but you cannot adjust individual baseline split pieces, either through task fields or with the mouse. 

If the task had assignments when the baseline was saved, you can use Visual Basic( for Applications to read the task-timephased Baseline Work, from which you can deduce splits from periods with zero work. You can also edit task timephased Baseline Work in a Usage view, but it has no impact on the baseline split dates and the appearance of baselines bars on the Tracking Gantt, since no calculations are done with baseline data.

Interim Plan Splits

The Save Baseline dialog (displayed by the Tools Tracking Save Baseline menu command) also includes an option to Save interim plan. This option by default saves scheduled dates into the Start1 and Finish1 fields. The Copy and Into dropdowns allow you to move saved plans between any combination of Start/Finish, Start1/Finish1, Start2/Finish2, and so on. Save a baseline means to save scheduled information to corresponding baseline fields such as Baseline Start, Baseline Finish, Baseline Work, and so on. Save an interim plan means to save scheduled information to fields like Start1/Finish1.
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If you save an interim plan to a pair of fields such as Start1/Finish1, then Microsoft Project saves the split information with the interim plan dates. Clearing interim fields such as Start1/Finish1 clears the corresponding split information from the project.

Interim bars can be displayed on the Gantt Chart including their splits. 

You can drag interim bar pieces, but not Baseline split pieces.

You can also use the task interim start and finish fields, such as Start1/Finish1 to move, truncate, or extend the interim bar end pieces.

There are no fields that display scheduled, baseline, or interim split dates. Unlike Scheduled and Baseline information, interim plans do not include timephased work information.  Their splits cannot be seen in Usage views either. Also, Interim plan split dates cannot be accessed using Visual Basic Applications 

Split Bar Styles

Bar Styles definition requirements for drawing split bars:

· From and To must be a matched set, such as Start/Finish, Baseline Start/Baseline Finish, and Start1/Finish1, and the fields must be saved using the Save Baseline command. If the dates aren't a matched set, then the Show For Split condition is ignored.

· Do not include the word Split in Show For to draw only the non-gap part of the bar and include the word Split to draw only the gap part of the bar.

In the Bar Styles dialog, if a bar is defined From Start To Finish and the word Split is not included in the Show For field, then the bars skip over task Splits whenever they are drawn.

If the Show For field includes the word Split, then the bar is only drawn where the split gaps occur.

The above rules also apply to baseline and interim From/To pairs, such as From Baseline Start To Baseline Finish, and From Start1 To Finish1, provided that baseline or interim plan has been saved.

Example

This example illustrates the impact of the Bar Styles Show For Split condition on scheduled, baseline, and interim bars.

The first picture shows the Bar Styles definitions for three pair of bar styles, one pair each for scheduled, baseline, and Start1/Finish1 interim dates. Each pair has one bar for the non-gap portions, and another bar for the gap itself.

The second picture shows previously mentioned  bar styles applied to a Gantt Chart with two tasks. The sample data was prepared as follows:

Tasks T1 and T2 were entered with 2d Duration each.

T1 was split.

The baseline was saved.

T1 was moved.

The Start1/Finish1 interim plan was saved.

T1 was moved again.

Upper part of the Bar Styles dialog for the Gantt Chart...
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Corresponding Gantt Chart showing the Scheduled, Baseline, and Interim plan bars for a task...
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Note: The text Schedule, Baseline, and Start1/Finish1 was entered into the Text1, Text2, and Text3 fields for T1 and T2, and the Bar Styles Text tab was used to associate these Text# fields with the three bar styles.

Task Splitting Interface and Formatting

A split task consists of two or more discontiguous date ranges where the task is scheduled. The active portions are referred to as split parts, parts, pieces, or bits. The inactive portions between the active ones are referred to as splits or gaps. Sometimes the word "split" is used to refer to either an active part or a gap. To avoid, confusion, the word part or gap can be used for clarity.

You can only split tasks in a Gantt Chart view or Task Usage view. The Split Tasks tool is only available in the Gantt Chart view.

Timephased assignment and task work can be split in the Task Usage views by editing the timephased values. 

Task versus Assignment Splits

This applies to tasks with assignments.

An assignment split means that the assignment has zero work during a period of time, whereas a task split means that all of its assignments have overlapping zero work periods during the task split period.

Example

The R2 assignment has an assignment split, but the R1 assignment has no split. Since not all of the assignments have splits, then the task has no split
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Now both assignments have splits that overlap to form a task split. The task split shown could be created by editing the Task Usage timephased values, or by using the Split Task tool in the Gantt Chart view (discussed below).
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The word Split in the remainder of this lesson refers to splitting tasks in the Gantt view unless specified otherwise.

Splits and Predefined Work Contours

In the Usage views, you can double click an assignment to display the Assignment Information dialog, and select a predefined Work Contour in the General tab. If you edit timephased work for an assignment or its parent task, then the contour type changes to "Contoured", which means it is now considered a custom edited contour.

An assignment cannot have a predefined contour type and also have splits. In particular:

· If an assignment has splits and then you change the contour, the splits are removed from the assignment and from the task if it had any splits in that date range.

· If you split a task that has a predefined contour, the contour type changes to Contoured.

Basics of Dragging

There are several drag operations that can be performed on bars in the Gantt Chart view, such as moving a task bar, changing its Duration, and changing the length of progress bars. 

For all of the Gantt Chart click and drag operations discussed in this section, a gray outline shape of the task, split part, or progress bar being moved, extended, or shortened is displayed, and a Gantt Tip box showing the dates, Duration, or other appropriate information is displayed.

Drag operations can be canceled by moving the cursor off of the row that the drag was initiated.

Summary Tasks Do Not Support Splits

Task parts and split gaps are not drawn for summary tasks and do not rollup from child tasks.

Creating Split parts (and Tasks) 

You can create splits in the Gantt chart and Task Usage view. 

In the Gantt chart, you can create a split part in any of the following ways:

· By splitting an existing task or split part into smaller parts.

· By moving the remaining split part of an in-progress task away from the completed split parts.

· By clicking and dragging a new split part between or after other split parts.

In the Calendar view, you can see splits but you cannot create or move split parts.

Splitting an existing task or split part

[image: image811.bmp] To split a Gantt bar, you can use the Split Task toolbar button, or use the Split Task command is on the Edit menu and on the task bar shortcut menu (right click a bar). The Split Task button and command is only available in a Gantt Chart view.

Clicking the button changes the cursor to the split cursor:

Split cursor
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The Split toolbar button stays in the down state until you click again or press the ESC key. 

Pressing the ESC key or clicking away from task bars releases the Split toolbar button and cancels the split operation.


You can also lock the Split Task button in the down state by double-clicking it. Then you can repeatedly click task bars to create multiple splits without having to click the Split Task button each time. Otherwise, the button is released the first time you click to make a split.

While the Split Task command is active, a Split tip box is displayed when the cursor passes over an existing Gantt bar, showing the date that the split is created if you clicked the bar at that point. The Split tip date uses the Tools Options View Date Format.

While the Split tip is displayed, you can do one of the following:

· Click and release the mouse to insert a split with a span equal to one minor scale unit, if there is a minor scale in use or one major scale unit if there is no minor scale in use. This refers to the settings in the Timescale dialog. The scale count setting is ignored. For example, if the timescale is formatted for weeks over days, count two, then a one-day split is created. 

· Click and drag the mouse to the right, to create a split at the insertion point and move the right-hand part to the right until the mouse is released. While you are moving the split part the Gantt tip box is displayed. To cancel the operation, either drag back to where you started (the tip box switches to bold font there) and release the mouse button, or drag down or up, away from the current Gantt row, and release. The latter method is also how you can cancel drag operations when moving an existing task bar or part.

During the process of creating a split in an existing bar or part, any existing parts to the right of the new one also move to the right along with the new one, by the same amount as the new one. 

Later you can drag individual parts independently, except for the first part.

Splitting completed portions

Typically, you not want to split the completed part of a task; however, the Split Task command does allows you to create task splits in completed portions of tasks and assignments. 

Once you release the mouse button, the impact of dragging in-progress parts without using the Split Task command depends on whether the Split In-Progress Task options are selected, as described in the next section.

Example

This example illustrates using the Split Tasks tool to split a completed portion of a task with no assignments. 

First click the Split Task tool, and then click the bar in the first picture on Day2. The mouse button remains down while the split cursor is dragged to the right and dropped on Day4, resulting in the second picture.

Before splitting task with progress but no assignments...
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After splitting the progress portion...
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Example

This example illustrates using the Split Tool to split a completed portion of a task that has assignments. In each picture, the Gantt Chart is in the top pane and the Task Usage is in the bottom pane, showing timephased Work and Actual Work.

The Split Task tool is clicked and then the bar in the first picture is clicked on Day2. The mouse button remains down while the split cursor is dragged to the right and dropped on Day4, resulting in the second picture.

Note: The Details column cannot be displayed when a Usage view is in one pane and a non-Usage view such as the Gantt Chart is in the other pane, because the timescales are forced to line up.

Before splitting the task...
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After splitting the progress portion...
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Dragging to reschedule the remaining part 

The Split Task tool is not being used in this section. You are simply clicking on part of a bar and dragging.

This section assumes that the default progress Bar Style is being used, defined as From Start or Actual Start To CompleteThrough. 

If the Split In-Progress Tasks option in the Schedule tab of the Tools Options dialog is not selected, then dragging a bar part moves the entire part and any associated timephased work and Actual Work.

However, if the Split In-Progress Tasks option is enabled, then dragging the remaining portion of an in-progress bar part does the following:

· If the task has no assignments, then a split is created at the task Stop date, at the end of the progress bar (ignoring nonworking days at the end of the progress bar). The Resume date and the end of the progress bar are the same if the progress bar is defined as To CompleteThrough, but they may differ by some nonworking days if the progress bar is defined To % Complete.

· If the task has assignments, then remaining assignment work is rescheduled at the date on which you drop the dragged part. This creates assignment splits, which may not rollup to a task split in cases where assignments are not all statused to the same date. After the assignments are rescheduled, the rolled up task split is the overlap of the assignment splits, if there is any overlap.

If there is a  rolled up task split, it  does not necessarily start at the original end of the displayed progress bar.

Progress Bars must be displayed

The feature of dragging the remaining portion of a task to split it without the Split Task command requires the following:

· The Tools Options Schedule tab Split In-Progress Tasks option is selected.

· In the Bar Styles dialog, there must be a progress bar defined to run From Start or Actual Start To % Complete or CompleteThrough.

If the preceding requirements are true, then any in-progress task satisfying the Show For condition of the progress bar style definition can be split without using the Split Task command, even if the progress bar is covered by another bar style.

Progress bars use the % Complete or CompleteThrough (not accessible) which are both related to Actual Duration. There are two factors to consider:

· If the Tools Options Schedule tab Updating Task Status Updates Resource Status option is not selected, then % Complete and assignment Actual Work are independent, in which case the split dates are independent of % Complete (and Actual Duration), and thus are independent of the original end of the progress bar.

· If the Tools Options Schedule tab Updating Task Status Updates Resource Status option is selected, then % Complete and assignment Actual Work are related, but the relationship is not one-to-one. There are many assignment work contours with various Stop and Resume dates that can produce the same task % Complete.

Example

The sequence of pictures below illustrates rescheduling remaining assignment work by dragging the remaining part of a task when the Split In-Progress Tasks option is selected. The Split Task tool or command is not used in this example.

Starting with the second picture, the Gantt Chart view is in the top pane and the Task Usage view is in the bottom pane. The Task Usage view shows the timephased Work row above the Actual Work row for the task and each assignment. The Gantt Bar Styles have been customized to show a Stop arrow above the bar and a Resume arrow below the bar. The Stop and Resume arrows have their Bar Text set to the Stop and Resume fields.

Bar Styles used in this example...
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The two assignments in the example are not statused to the same date:

Resource R1 has 4 days of scheduled work, and the three days have been marked as Actual Work. 

Resource R2 has 3 days of scheduled work, and only the first has been marked as Actual Work. 

Before dragging the remaining part...
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Click to begin drag operation ...

When you click the remaining part of the bar, the Tool Tip indicates you are dragging the 4 day shadow portion that runs from 6/5 (the task Resume date) to 6/8 (5pm). 

The task Resume date is 6/5 8am because the earliest assignment Resume date (not accessible) is for R2's assignment.
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Drag operation under way ...

Now the remaining part is dragged two days to the right, so the dragged shadow part is over the 6/7 to 6/10 range.
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The next picture shows the result when the dragged part is dropped on 6/7. A two-day split is created in R2's assignment because two days of work remained work prior to 6/7. But R1's assignment is not split because it had only Actual Work prior to 6/7. There is no task split in T1 because there is no overlapping split in the two assignments.

After dropping the start of the dragged part at 6/7...
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Finally, the new remaining part is dragged again and dropped one more day to the right at 6/8. The result is shown in the picture below. This time the two assignments both have splits and their splits overlap to give the task T1 a task split of one day.

Overlapping assignment splits produce a task split...
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Creating a new split part

Just as you can enter new timephased work in the Task Usage view, you can create new split parts in the Gantt Chart by dragging in an empty portion of the timescale pane. 

The resulting behavior depends on where you drag to create the new split part.

· If you create the split part before the beginning of the task, then Duration, and possibly work, is added to the task and the task Start date is changed. Depending on existing links, constraints, and so on, you may get a Planning Wizard (for example if the new task Start is before the project Start).

· If you create the split part between existing split parts, then Duration, and possibly work, is added to the task, and the equivalent amount of time is removed from the existing split.

· If you create the split part after the end of the task, then Duration, and possibly work, is added to the task and the task Finish date is changed. Depending on existing links, constraints, and so on, you may get a Planning Wizard (for example if the new task Finish is after the Project Finish).

To create a split part, you must click in an empty space on the same Gantt row as the scheduled bar and drag. Users cannot create split parts for Baseline or StartX/FinishX bars. When you click down, the cursor changes to the cross-hair cursor [image: image823.png]


.

While dragging, the outline of the new bar is displayed, along with a Create Task tip box is displayed.

Dragging in an existing task row to create a new split...
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You can drag the outline of the new part to the left or right, but the outlined bar cannot extend beyond existing tasks. If you drag the outlined bar until you hit an existing piece and then release the mouse button, the new part is appended to the existing one.

You can cancel the drag operation by moving the cursor off of the task row and releasing the mouse button.

New part merged with existing one...
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How work is assigned to the new part

For tasks with assigned work, the following rules are used for assigning work to the new task part:

1. For split parts created before the start of a task, Microsoft Project assigns only the resources that were already scheduled at the previous start of the task, and assigns them at the units they had there.

2. For split parts created between other split parts, Microsoft Project assigns only the resources that were already scheduled at the finish of the part on the left of the new part, and assigns them at the units they had there.

3. For split parts created after the finish of a task, Microsoft Project assigns the resources that were already working at the finish of the task, and assigns them at the units they had there.

Each of the examples below uses a Gantt Chart view in the top pane over the Task Usage view in the bottom pane.

Example 1

This example illustrates how work is assigned to new task parts created before the current start of the task.

Before creating the new task part ...

The Duration is 3d
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After creating the new task part ...

The new task part was created on Day1, before the original task start, Day3.

The work rates (units) on Day3 were used for the new part on Day1, and zeroes were filled into the split on Day2.

The new Duration is 4d.
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Example 2

This example illustrates how work is assigned to new task parts created between existing parts.

Before creating the new task part ...
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After creating the new task part ...

The new task part was created on Days 4-5, inside the original split on Days 3-6.

The work rates (units) on Day 2 were used for the new part.
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Example 3

This example illustrates how work is assigned to new task parts created after the Finish of the task.

Before creating the new task part ...
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After creating the new task part ...

The new task part was created on Days 5-6, after the original task finish on Day 3.

The work rates (units) on Day 3 were used for the new part.
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Moving and Editing Tasks and Parts

You can edit individual split parts in the Gantt chart and in the Task Usage view. You cannot edit individual split parts in the Calendar view.

You can use the mouse to move or change the Duration of an entire task or individual parts. All changes are restricted to increments of the minor timescale unit

Moving an entire task

In Microsoft Project 4.x, you could move a task in the Gantt chart by moving the cursor over the task bar until it changed to the move cursor, 
[image: image832.png]


, and then click and drag the outlined bar. Microsoft Project 4.x did not have split bar parts (although it did have tasks that recurred).

Microsoft Project 97 has the same behavior as Microsoft Project 4.x for dragging non-split bars.

For split tasks in Microsoft Project 97, you can move entire tasks using either of two different methods:

· Move the cursor over the first split part of a task until the cursor changes to the move cursor and then click and drag the bar.

· Hold  down the Shift key. Click any split part of the bar and then drag the bar.

While you move the task, outlines of all of the split parts move with the drag cursor.

Moving all the parts simultaneously...
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Extending or shortening an entire task

In Microsoft Project 4.x, you could extend or shorten a task by moving the cursor over the end of a task until it changed to the extend cursor [image: image834.png]


 and then clicking and dragging the end of the task left or right. While dragging, an outline of the bar showed how the drag would impact the task.

Microsoft Project 97 has the same behavior as Microsoft Project 4.x for changing the Duration of non-split bars.

For split tasks in Microsoft Project 97, you can extend or shorten a task using either of two different methods:

· Move the cursor over the last split part of a task until it changes to an extend cursor. Then click and drag the split part Finish to extend or shorten the task. 

· Move the cursor over the last split part of a task until it changes to a move cursor.  Click and move the last split part of a task, but do not change its Duration. To move a split part inserts zero work between it and the previous split part. To extend a task this way does not increase the work on the task.

In both methods, the Gantt Tip box discussed is displayed.

When you drag the Finish of the last split part, an outline bar is drawn for the entire task.

Dragging the task Finish to change Duration...
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However, if you drag the cursor back before the start of the split part, the outline bar snaps back to the Finish of the previous split part, because if you release the mouse button at that point, the new task Finish will be the Finish of the previous split part.

Dragging the task finish to the left of the last split part...
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The outline bar resumes tracking with the drag cursor if you move the cursor over a split part again.

Moving an individual split part

To move an individual split part, other than the first part, you move the cursor over the split part until the cursor changes to the move cursor [image: image837.png]


 and then click and drag. Split parts can be moved independently this way, as long as you don't drag them up against another part. In that case, the part being dragged is merged with the other part.

Note: Moving the first split part of a task always moves the entire task.

When you drag  a split part, an outline of the bar moves with the drag cursor.

Dragging an individual split part...
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Extending or shortening an individual split part

To extend or shorten an individual split part, move the cursor over its end until the cursor changes to the extend cursor [image: image839.png]


 and then click and drag.

While you drag, the extended or shortened version of the split part is shown outlined, and a Gantt Tip is displayed showing the dates for that part.

Dragging the finish of an individual split part...
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How a change in Duration impacts assignment work
When a split part is extended, resource assignments on the split part are extended at the current effort levels, except in the case of effort driven tasks. When a split part is shortened, resource assignments on the split part are truncated, except for effort driven tasks. 

Dragging the progress bar

This section assumes that the default progress Bar Style is being used, defined as From Start or Actual Start To CompleteThrough. 

In the Gantt Chart view, you can move the pointer over the end of the Progress bar on a task (or over the Start of the task if it has no progress) until the pointer changes to the % complete cursor 
[image: image841.png]


, and then click and extend or shorten the Progress bar. You can drag the end of the progress bar across split gaps and continue onto another task part. A Gantt Tip box shows you the CompleteThrough date corresponding to the current position of the mouse pointer.

Dragging the end of the progress bar changes the task Actual Duration and % Complete. If you select the Tools Options Calculation tab Updating Task Status Updates Resource Status setting , then it also impacts the Actual Work and % Work Complete fields. With this setting selected:

· Extending the progress bar sets timephased Actual Work to correspond with timephased scheduled work. For, example, at the same work rates as the scheduled work. It statuses all assignments to the same date. 

· When you shorten the progress bar, timephased Actual Work truncates .

For information on the role of progress bars and the Split In-Progress Tasks setting, see the above section, Dragging to reschedule the remaining part.

Example

This example shows how the progress bar can be extended across splits, and the impact it has on assignment timephased Actual Work.

The split pane views have the Gantt Chart view in the top pane and the Task Usage view in the bottom pane. The Task Usage view shows the timephased Work row above the Actual Work row for the task and each assignment. 

A.
Before the drag operation, R1 has Actual Work statused through the first four days of the task, and R2 has only the first day statused. 

Why is the Actual Duration 2d?
Only the task total Actual Work and the task timephased work contour are used to calculate the task Actual Duration - the assignment timephased distribution of that work and Actual Work don't matter. The calculation of the task Actual Duration is as follows: The task Actual Work is 32h. If it were done according to the task timephased scheduled work contour it could be done in two days (look at the 16h each on Day 1 and 2 in the task timephased work row). That's why you see 2d in the task Actual Duration field in the table on the left.

Before dragging the end of the progress bar...
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B. 
Now you drag the end of the progress bar  to the right across the gap so the progress bar fills up 6/2-6/9. In order to mark all days up to and including 6/9 as complete, drag the end of the progress bar over the next day, 6/10, so the Gantt Tip box shows a CompleteThrough date of 6/10 at 8am.

Drag in progress...
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C. 
After the end of the progress bar is dropped on 6/10, the progress bar fills up 6/2-6/9. All assignment timephased Actual Work is set to the corresponding assignment timephased scheduled work.

After dropping the end of the progress bar on 6/10...
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D. 
The picture shows the result after you drag the end of the progress bar to the left, back across the split, and drop it on 6/5 (meaning the CompleteThrough will be 6/5 at 8am, so the new progress bar fills up all 6/2-6/4). Previous assignment timephased Actual Work to the right of the new CompleteThrough is truncated ( removed).

After dragging the end of the progress bar to the left and dropping on 6/5...
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Features Specific to the Entire Task 

This section discusses features that apply only to the task as a whole and not to the individual split parts independently. This includes the following:

· Linking (predecessor/successor relationships): You cannot link individual split parts.

· Assigning resources: You cannot assign resources to individual split parts, but you can edit assignment contours so all the work is done on specific parts.

· Bar Styles and Format Bar: You cannot format or define bar styles for individual split parts and gaps, but you can format and defined styles for parts separately from gaps.

Each of these is discussed below.

Linking

You cannot create relationships where  the predecessor,  successor, or both are  single parts of a split task. You cannot create links between split parts of different tasks or between a split part and another task. 

You can drag to create links between tasks. Click  any part of the task you want to be the predecessor and drop any part of the task you want to be the successor. You cannot start a link by clicking in a gap between parts. During the drag operation, the entire task is highlighted with a gray outline.

Aside from the fact that tasks can be split in Microsoft Project 98, linking tasks with the mouse is the same as in Microsoft Project 95. 

Creating links with the mouse...
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Assigning Resources

You cannot assign resources to individual split parts in the Gantt Chart or in the Calendar view. If you assign a resource to a task, it is always assigned to all the split parts of the task.

You can however, edit the assignment timephased work contour so that the resource does work only on specific parts. If the entire task is moved later, the contours move too.

Gantt Chart Bar Styles for Split Tasks

Each task has two sets of bar styles and formatting - one for the task parts, and one for the split gaps. All split parts use the one formatting and all split gaps use another.

The "Show Bar Splits" setting

When the Gantt Chart is active, the Layout command on the Format menu and the Gantt shortcut menu displays the Layout dialog, which contains the Show Bar Splits setting. 

Gantt Chart Layout dialog...
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If the setting is selected, then task parts and split gaps are displayed. If the setting is not selected, only whole task bars display. 

Even when the setting is not selected, you can still use the Split Task tool to create task splits in the Gantt Chart, but you can't see the gap you create. Also, you cannot use drag operations on individual split parts unless they are displayed.

The Show Bar Splits setting is selected by default for new and imported projects.

Bar Styles dialog

When the Gantt Chart is active, the Bar Styles command on the Format menu and the Gantt shortcut menu displays the Bar Styles dialog, which is used to defined categories of bar formatting. The Show For column determines to what category of task, task part or split gap to which the formatting should apply.

Microsoft Project 98 has a new Show For condition called Split that can be used in conjunction with other conditions. 

· If Split is one of the conditions listed in the Show From column for a specific bar style definition, then that style can only be used to draw split gaps for tasks that satisfy the rest of the conditions for that style (if there are any). 

· If Split is not one of the conditions for a bar style, then that style can be used for tasks without splits and for tasks with split parts. As mentioned above, if the Show Bar Splits setting is selected in the Layout dialog, then all tasks can only use bar styles that do not have the Split condition, and those bars are drawn without splits whether they have any or not.

Bar Styles dialog with new Split condition in Show For...
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Bar styles defined with the Split condition can use the same Bars tab settings as any other bar style; however, you cannot associate Bar Text with them. The Text tab is disabled (grayed out) when a bar definition is selected in the top half of the dialog that uses the Split condition. 

The picture below shows the Gantt Chart view predefined bar styles. Two of them use the Split condition. 

Note: In the picture below, the work "Summary" is chopped off in several rows in the Show For column.

Gantt Chart view Predefined bar styles 
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Example

This example uses custom Gantt Chart Bar Styles with the Flag1, Flag2, and Split Show For conditions to illustrate the difference between formatting the task parts and the split gaps.

Custom bar definitions in the Bar Styles dialog...
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In the following Gantt Chart all the tasks are identical except for the values in the Flag1 and Flag2 fields, which control what shows for each task because of the previously defined custom Bar Styles. T1 shows the task parts and the split gaps. T2 shows only the task parts. T3 shows only the split gaps, and T4 doesn’t show  anything.

The Format Layout Show Bar Splits setting is selected so splits can be drawn.

Notice that the end pieces for the Parts style are only used at the start and end of the very first and very last piece, whereas the end pieces for the Gaps style are used with every gap.

Formatting for task parts and split gaps are independent...
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Now the Show Bar Splits setting is turned off. The tasks that  showed task parts are now drawn as continuous task bars.

Show bar Splits setting is off...
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From/To pairs that support splits

Task parts and split gaps are only supported for certain pairs of fields in the From and To columns in the Bar Styles dialog, as follows. Bar style definitions that use any other From/To pair are never drawn if the Show For column includes the Split condition. If the Show For column does not include the Split condition, and if a task satisfies the other conditions, then the bar is drawn as a continuous piece whether the task is split or not.

From
To

Start
Finish

Start

Actual Start
% Complete

CompleteThrough

% Work Complete

% Complete

CompleteThrough

% Work Complete
Finish

Baseline Start
Baseline Finish

Start 1
Finish 1

Start 2
Finish 2

Start 3
Finish 3

Start 4
Finish 4

Start 5
Finish 5

Start 6
Finish 6

Start 7
Finish 7

Start 8
Finish 8

Start 9
Finish 9

Start 10
Finish 10

Minimum length for drawing splits

To avoid visual clutter in the Gantt Chart, split gaps are not drawn if they are under a minimum size. The minimum size depends on the base unit of the minor timescale if it is displayed, otherwise it depends on the base unit of the major timescale. The table below shows the minimums for various timescale base units.

Timescale Base Unit
Don’t Display Splits Less Than…

Minutes
1 minute

Hours
10 minutes

Days
2 hours

Weeks
1 day

Thirds of Months
1 day

Months
2 days

Quarters
1 week

Years
3 weeks

Format Bar dialog

Double-click any bar in a Gantt Chart to display the Format Bar dialog as in Microsoft Project 4.x, where you can apply bar formatting.

In Microsoft Project 98, double-click  a task part or split gap bar and edit the formatting in the Format Bar dialog. Formatting done to any task part applies to all the parts for that task, and formatting done to any split gap applies to all the split gaps for that task.

Calendar View

The Calendar view can display split parts but does not support editing them. 

Calendar view showing split task parts and gaps...
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The "Show Bar Splits" setting

When the Calendar view is active, the Layout command on the Format menu and the Calendar view shortcut menu displays the Layout dialog, which contains the Show Bar Splits setting. 

If the setting is selected, then task parts and split gaps are displayed. If the setting is not selected, then only whole task bars are displayed. 

The Show Bar Splits setting is selected by default for new and imported projects.

Calendar view Layout dialog...
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Bar Styles dialog

Split parts are formatted in the Calendar view by using the Bar Styles command on the Format menu and Calendar shortcut menu. The Bar Styles dialog contains a new Split Pattern setting. Each category of Bar in the Task Type list gets its own split pattern. Only the pattern of the split gap is controlled separately. Its shape and color are the same as the task part formatting for the category. 

Calendar View Bar Styles...

[image: image855.png]Task type: Bar shaps T
[— —
[ pater
iy
Froject summary Coor
o
Fiapeed ot pattern
s
i Project 98 Calendar

|

view Bar Styles has a
Split pattern style

7 Bar rounding

Text

Field(s): [Name,Duration
s [Corter o] I wraptestinbars

Sample

[ Sample Task Bar





Some sample Calendar view bar styles follow. All use  a dashed split pattern.

Bar Type is Line.
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Bar Type is Bar and bar pattern is a solid bar. Note that the split gap is always hollow.


[image: image857.png]




Bar Type is Bar and bar pattern is a hollow bar. The Shadow option is selected. Note that the shadows go separately with each task part, but no shadow for the gaps.
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Calendar view Task Types that support split patterns

The Calendar view only displays split parts for the following Task Types listed in the Bar Styles dialog:

· Noncritical

· Critical

· Milestone

· Marked

· Highlighted

· External

Lesson 5.6 - Exercises

1.
In what views can you split a task?

In what views can you split a specific assignment?

2. 
If you split an assignment, can it still have a predefined work contour?

3. 
Can a task with no assignments be split?

4. 
For a Fixed Duration task, does the split gap count as part of Duration? How about for a Fixed Units or Fixed Work task?

5. 
Describe situations in which Microsoft Project might automatically split a task.

6. 
What feature in Microsoft Project 95 was related to task splitting and how many splits could a task have in Microsoft Project 95? How many splits can a task have in Microsoft Project 98?

7. 
If a task has assignments and you split the task, is it possible for some of the assignment to have no splits?

8. 
In order to drag the remaining portion of a task bar to the right in the Gantt Chart, breaking it off from the completed part, what option setting must be selected?

9. 
What new Show For ... condition in the Gantt Chart Bar Styles dialog is used to show split gaps and what default fields are used for From and To?

10. 
Are there any fields in dialogs or tables that list all the split dates for a task?

Are the split dates accessible via a macro?

11. 
Which of the following features are supported by individual split parts on the Gantt Chart (the parts where the task occurs)?

A. You can drag them individually to the left or right, including the first part, without effecting other parts (assuming you don't drag one part into another part).

B. You can drag them individually to the left or right, except for the first part, without effecting other parts (assuming you don't drag one part into another part).

C. You can give each part its own predecessor.

D. You can assign a resource to a specific part in the Gantt Chart view by dragging a resource from the Assign Resources dialog and dropping it on a specific part.

E. If the task is not a Fixed Work task, you can increase the duration of an individual part without effecting other parts (assuming you don't drag one part into another part).

F. Individual bar parts can be formatted independently from other bar parts by double clicking the bar part that you want to format.

12. 
Can you tell by looking at the timephased grid in a Task Usage view if an assignment has a split, or if instead the assigned resource's calendar has nonworking days in the middle of the assignment?

13. 
Suppose that the Bar Styles dialog is set up correctly to show bar parts and split gaps, but that all tasks are currently displaying as single solid bars, including tasks that you know have splits. What setting is probably currently not selected?

14. 
Is there a minimum length (duration) that a split gap must have in order for the split gap to be drawn on the Gantt Chart?

Does it depend on the timescale formatting?

15.
What fields are used for the Bar Styles From and To when drawing split gaps in baseline bars?

16.
Can split gaps be displayed in the Calendar view?

Lesson 5.6 - Labs

Lesson 5.6 - Lab 1

1.
Create a project with a single task T with 4d Duration. Edit the Standard calendar so that every day is a working day with the standard working hours 8a-12p, 1p-5p. 

2.
Format the Gantt Chart view and enter the values shown in the picture below (no resources are assigned to the task, so you must enter the work value).
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3.
Use the split tool to split the task into two parts with a three day split gap between them.

4.
Switch to the Task Usage view with the timephased grid formatted to display timephased Work. You should be able to identify the split gap. 

5.
Select the cells that make up the split gap and press the Delete key to remove the split. Switch back to the Gantt Chart, and you should see that the split has been removed.

6.
Switch back to the Task Usage view and select the timephased cells for day two and day three and press the Insert key. This should create a one day part and a three day part separated by a two day split gap. Switch back to the Gantt Chart view to verify this.

Lesson 5.6 - Lab 2

1.
Create a project with a single task T with Duration 4d. Edit the Standard calendar so that every day is a working day with the standard working hours 8a-12p, 1p-5p. 

2.
Use the split tool to split the task into four one day parts with a three day split gap between consecutive parts.

3.
Save the baseline for the project.

4.
Use the mouse to move several of the parts individually and change the Duration of several of the parts individually.

5.
Apply the Tracking Gantt view. You should be able to identify the baseline split parts and the currently scheduled split parts.

Lesson 5.7: Multiple Critical Paths

Some Topics to be introduced in this lesson include:

· "Calculate multiple critical paths" option (in the Tools Options Calculation tab)

Multiple Critical Paths

Microsoft Project 98 has a new Calculate multiple critical paths setting in the Tools Options Calculation tab. 
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If this is selected then tasks that normally have slack to the end of the project (no successors or future limiting constraints) will instead have 0 slack. This makes it even more difficult to level if the Level only within available slack option is selected.

The Calculate multiple critical paths setting works whether the project is scheduled from start or finish, however, the behavior of various constraints such as ASAP and ALAP are reversed. 

For the rest of this lesson, it is assumed the project is scheduled from Start.

The Calculate multiple critical paths feature allows you to see multiple critical paths in a schedule. When this setting is selected, then any task that does not have a successor or a future limiting constraint, such as FNLT, has its Late Finish date set to its Early Finish date, so it has zero slack. 

Whether or not zero slack means the task is critical still depends on the setting, Tasks are critical if slack is less than or equal to ... days in the tools Options Calculation tab.
From the Microsoft Project 98 Tools Options Calculation tab...
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Note: Microsoft Project 4.x has a similar setting for determining how much slack a task had to have before it was considered critical, but Microsoft Project 4.x did not have the multiple critical path feature.

In the rest of this lesson, it is assumed that the previous setting is 0, so that a task is critical only if it has 0 slack.

Calculate multiple critical paths is a per project setting. It is stored with individual project files, but you can use the Set as Default button in the Calculation tab so all new projects use the current setting. The option is set to OFF (not selected) when old version projects.

If the Calculate multiple critical paths setting is not selected then the usual slack calculations occur (as in Microsoft Project 4.x). For example, any non-ALAP task that does not have a successor or a future limiting constraint has its Late Finish date set to the Microsoft Project Finish date, and its slack is the difference between its early and Late Finish dates. 

ALAP tasks

An ALAP task has a special behavior in a project scheduled from start when the Calculate multiple critical paths setting is ON.

If it has no parent summary task other than the project summary task, then the previously mentioned setting has no impact and the ALAP task is scheduled as usual. The ALAP task moves  as far into the future as possible, until it bumps up against the Microsoft Project Finish or against a successor task that can't move any farther.

· If it is indented below a parent summary task, other than the project summary task, then its usual behavior is modified to be relative to its summary parent task, as though the parent summary task and its child tasks were a separate project.

· If the ALAP task has no successors, then the above behavior means its Late Finish date is set equal to the Finish of its parent summary task.

An ALAP task is scheduled relative to its parent task only if the Calculate multiple critical paths setting is ON.

Note: If the project is scheduled from Finish, then the roles of ASAP and ALAP are reversed.

Example

This example illustrates the impact of the Calculate multiple critical paths setting on summary tasks, ALAP tasks, task relationships, and Total Slack. The project is scheduled from start. The before/after pictures below show the schedule when the setting is OFF compared to when it is ON. In both cases, the task spanning the entire project, T1, is unaffected. The summary task S1 is impacted greatly because of its ALAP child task, S1C. Both summary tasks calculate slack like independent projects when the setting is ON.

Calculate multiple critical paths setting is OFF...
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Calculate multiple critical paths setting is ON 
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Lesson 5.7 - Exercises

1.
If a project is scheduled from start and the Calculate multiple critical paths setting is selected, what is the Total Slack for an ASAP task with no successors?

2. 
The project in the picture below uses the default settings, is scheduled from start and the Calculate multiple critical paths setting is not selected. The project starts on Mon 6/2/97 and ends on Fri 6/6/97. There are only two tasks, both ASAP, and there are no relationships or actuals.
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A. If you select the Calculate multiple critical paths setting, what happens to the Total Slack for T1 and T2?

B. If you then also change the constraint on T1 to Finish No Later Than 6/4/97, what happens to the Total Slack for T1 and T2?

3. 
The project in the picture below uses the default settings, is scheduled from start and the Calculate multiple critical paths setting is not selected. The project starts on Mon 6/2/97 and ends on Fri 6/6/97. The project has only the four tasks shown below. All the tasks are ASAP, and there are no relationships or actuals.
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If you now select the Calculate multiple critical paths setting, what happens to the Total Slack for the tasks and does the Start date of any of the tasks change?

Lesson 5.8: Leveling

Some Topics to be introduced in this lesson include:

· Old task Delay replaced by task/assignment Leveling Delay fields (there is also an assignment Delay field)

· Improved tie breaker

· More options: granularity; date range; level assignments; split tasks/assignments (no split for Fixed Duration task)

· Improved feature: Leveling doesn't destroy critical path. Leveling Delay field of successor doesn't count as slack on predecessor

· Can level schedule from finish (using negative leveling delay. Switching schedule from start/fin or ALAP/ASAP warns it will clear leveling <ok/cancel>. ASAP can have leveling delay only for Schedule from Start.  ALAP can have leveling delay only with Schedule from Fin)

· Can override constraints (if "Tasks will always honor their constraint dates" is OFF)

· Tools Resource Leveling “Leveling can create splits in remaining work” option

· "Clear Leveling" does not touch leveling delay on Do Not Level tasks. It only removes splits created by leveling

· Recurring tasks set to "Do Not Level" by default

· Leveling Assignments

· Fields: Task field "Leveling Can Split"; Resource field "Can Level."

· Can continue leveling rest of a resource's assignments when it hits an unresolvable situation

· New Leveling Gantt (replaces Delay Gantt)

· New leveling progress indicator

· Relationship between task Start/Finish and Leveling Delay fields and assignment Start/Finish, Delay and Leveling Delay fields

Leveling

Task, Resource and Assignment Fields Related to Leveling

The following table lists some of the Task, Resource, and Assignment fields that are related to leveling and describes what each field does. The fields can be seen for Assignment records in the Task Usage view.

Field
Description

Level Assignments
This Yes/No task-only field controls whether leveling is allowed to adjust assignments. Default is Yes.

When the Level Assignments field is Yes, then leveling is allowed to adjust the task's assignments only if the Leveling can adjust individual assignments on a task setting is also selected in the Tools Resource Leveling dialog. An adjustment to an assignment is either a move or split. See the Leveling Can Split field that follows for possible restrictions to assignment splitting.

When the Level Assignments field is No, it means leveling cannot adjust the task's assignments, regardless of the Leveling can adjust individual assignments on a task setting.

Leveling Can Split
This Yes/No task-only field controls whether or not leveling is allowed to create splits in the remaining portion of a task or one of its assignments*. Default is Yes.

When the Leveling Can Split field is Yes, then leveling is allowed to split the remaining work on the task or one of its assignments* only if the Leveling can create splits in remaining work setting is also selected in the Tools Resource Leveling dialog.

When the Level Assignments field is No, it means leveling cannot split the task or any of its assignments, regardless of the Leveling can create splits in remaining work setting.

* See the previous comments on the Level Assignments field for settings that can prevent assignment adjustments, including splitting.

Leveling Delay
If leveling decides to solve an overallocation by moving an entire task or assignment, it puts an elapsed Duration in the Leveling Delay field for the task or a working Duration for the assignment.

You can also manually edit these fields. In the Task Usage picture below, the task has been shifted 2ed, and the assignment 1d.
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Priority


Used by leveling as a tiebreaker when deciding which task or assignment should be moved or split to solve an overallocation. The Do Not Level priority prevents any changes from being made to a task or its assignments.
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The same priority is displayed for tasks and assignments (in the Task Usage view), but can only be edited for tasks.
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Can Level
This Yes/No resource-only field controls whether a specific resource can be leveled or not. Default is Yes.

Table 5.8.1
Tools Options Settings that Effect Leveling

The following table lists some of the settings in the Tools Options dialog that impact leveling:

Setting
Description

Tasks will always honor their constraint dates


Located in the Tools Options Schedule tab.
If selected, then leveling cannot make adjustments to tasks that violate their constraints, such as MSO (Must Start On).

If not selected, then leveling can adjust tasks regardless of their constraints.

Split in-progress tasks


Located in the Tools Options Schedule tab.
If selected, then leveling can split the remaining portion of a task from the completed portion, even if the Leveling can create splits in remaining work setting is not selected in the Tools Resource Leveling dialog.

Calculate multiple critical paths
Located in the Tools Options Calculation tab.
If selected, then tasks that normally have slack to the end of the project (no successors or future limiting constraints) will instead have 0 slack. This makes it more difficult to level if the Level only within available slack option is selected in the Tools Resource Leveling dialog.

Table 5.8.2
Resource Leveling Dialog

The Tools menu Resource Leveling command displays the Resource Leveling dialog shown below:

Resource Leveling dialog...
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Figure 1
A discussion of the  controls in the Resource Leveling dialog follows:

Automatic/Manual

The default is setting is Manual.

This is the same control as in Microsoft Project 4.x. Choose whether leveling is done all the time or only when you initiate it by choosing the Level Now button.

When the setting is set to automatic, leveling uses the existing settings to perform automatic leveling between the Level From and To dates.

This is a global setting. Any change to this setting affects all opened or to be opened projects.

Look for overallocations on a ... by ... basis

The default is Day by Day.

This setting is also referred to as the leveling granularity or leveling sensitivity.

Leveling granularity choices...
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Figure 2
The granularity choices are 

· Minute by Minute

· Hour by Hour

· Day by Day

· Week by Week 

· Month by Month

In Microsoft Project 4.x the leveling sensitivity is hard coded to minutes. If there is an overallocation of even a minute anywhere in the project, then Microsoft Project 4.x tries to resolve the overallocation.

In Microsoft Project 98, the new Look for overallocations on a ... by ... basis option allows you to control the leveling sensitivity. A resource is leveled only if the resource is scheduled to do more work than they have capacity in the specified period.

This is a global setting that impacts all projects. It is not saved per project. 

In deciding whether to resolve an overallocation, Microsoft Project looks at the work capacity for the resource on time periods of the size determined by the previously mentioned granularity setting. If the scheduled work for the period exceeds the work capacity for the period then Microsoft Project’s leveling tries to resolve the overallocation. Otherwise it moves on to the next period, even if there is some overallocation within the period at a finer granularity.

The time slices that leveling examines start on integral time boundaries. For the Hour by Hour settings it looks at whole hours (starting at 12 am, 1 am, and so on), and for the Day by Day setting it looks at whole days. For the Week by Week setting, it looks at whole weeks as defined by the Week starts on setting in the Tools Options Calendar tab. For the Month by Month setting it looks at whole months. . 

Microsoft Project compensates for project start dates and calendar working times that do not align with the period by period setting. For example, if the Week starts on setting is Sunday and the granularity setting is Week by Week, and if the project starts on a Wednesday, then leveling knows that the resource capacity is 24h that first week, not 40h. Likewise, if the working day begins at 8:30am instead of 8:00am, then when using the Hour by Hour granularity, leveling knows that the resource capacity is 0.5h during the hour starting at 8am.

Example 1
During a specific week, a resource using the standard calendar works 10h on Mon and 4h per day the rest of that week, for a total of 26h. If the leveling granularity is Day by Day, it tries to resolve the overallocation on Mon, but if it is Week by Week or Month by Month, then it does not level  Monday.

Example 2
This example illustrates the new leveling granularity feature, controlled by the Look for overallocations on a ... by ... basis option. Default working times are used in the schedule shown below. R is assigned uniformly at 1 unit to both T1 and T2.
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Leveling takes the following actions depending on the granularity:

Day by Day or lower: T2 is shifted one day to the right.

Week by Week: Depends on the Week starts on setting in the Tools Options Calendar tab. If the week starts on Sun or Mon, then T2 is shifted one day to the right, but if the week starts on any other day then leveling does not resolve the overallocation. For example, if the week starts on Tue, then R does a total of 16h on the week that ends on Mon 6/2/97, and does a total of 32h on the week beginning on Tue 6/3/97. 

Month by Month: Leveling does not resolve the overallocation.

Leveling range for '<project>'

The default is setting is Level entire project.
It is a per project setting.

Level From/To 

The From and To settings use the new date picker control. 

You can change the dates so that leveling only operates on overallocations that fall within the specified date range.

Leveling order

The default is Standard.

Leveling order choices...
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The choices are:

· ID Only

· Standard

· Priority, Standard

This setting has nearly the same behavior as in Microsoft Project 4.x, although there have been some improvements in the tie-breaking algorithm, for example, how the algorithm determines which overallocated assignment to change. (Actually, Microsoft Project 98 has more ways to resolve overallocations than just moving whole tasks. These other methods are discussed later.)

The improvements include the following:

· Microsoft Project 98 in some cases will change the task or assignment that has the least impact on the project Duration.

· Microsoft Project 98 can do partial leveling in cases when it can't completely resolve an overallocation due to task constraints. For example, if there are three or more tasks causing an overallocation and two of them have MSO (Must Start On) constraints, Microsoft Project 4.x does not attempt to level any of them. Microsoft Project 98 can resolve part of the overallocation by moving or changing some of the unconstrained tasks or assignments, even it can’t resolve all of the overallocations.

Example 3
This example illustrates a case in which Microsoft Project 98 makes the change that has the least impact on the project Duration. It also compares the Microsoft Project 98 result with the Microsoft Project 4.x result.

Before leveling...
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Microsoft Project 98 after Standard leveling...
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Microsoft Project 4.x after Standard leveling...
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Example

This example illustrates how Microsoft Project 98 can level part of an overallocation even if it can't solve the overallocation completely, and it compares the Microsoft Project 98 result with the Microsoft Project 4.x result.

It also shows the impact of the new Tasks will always honor their constraint dates setting in the Tools Options Schedule tab.

Before leveling...
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A.
If the Tools Options Schedule tab Tasks will always honor their constraint dates setting is selected, then T1 and T2 cannot be moved because of their MSO (Must Start On) constraints. Microsoft Project 98 displays the following message when you level:
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If you choose the Skip button, then another message is displayed for 6/3/97. If you choose Skip again, or if you chose Skip All in the first message then leveling provides the following partial solution:

Microsoft Project 98 solution if the 'Tasks will always honor their constraint dates' setting is selected...
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B.
If the Tasks will always honor their constraint dates setting is not selected, then T1 and T2 can be moved despite their MSO (Must Start On) constraints, and leveling provides the following full solution without any messages:

Microsoft Project 98 solution if the 'Tasks will always honor their constraint dates' setting is not selected...
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C.
Microsoft Project 4.x would not have moved any of the tasks in the original schedule above. Instead it just displays the following message.

Microsoft Project 4.x can't resolve the overallocation...
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If you choose the Continue button, Microsoft Project 4.x still doesn't move any of the tasks in the original schedule above.

Level only within available slack

The default is off (not selected).

This is similar to the Microsoft Project 4.x Delay Only Within Slack setting, but the Microsoft Project 98 setting also restricts new leveling features regarding how tasks and assignments can be split during leveling.

In addition, Microsoft Project 98 has a new Calculate multiple critical paths setting in the Tools Options Calculation tab. If this is selected tasks that normally have slack to the end of the project (no successors or future limiting constraints) instead have 0 slack. This makes it even more difficult to level if the Level only within available slack option is selected.

Leveling can adjust individual assignments on a task

The default is on (selected)

In Microsoft Project 98, leveling can delay and split individual assignments instead of entire tasks when resolving overallocations. It does this by using a new assignment Leveling Delay field. The old Microsoft Project 4.x assignment Delay field still exists, but it is only for manual delaying of assignments as in Microsoft Project 4.x. It is not used by leveling. Note that the assignment Delay field is titled Delay in the Task or Resource Form with Details set to show Resource Schedule, but is named Assignment Delay when inserted in a task or resource tables (normally displayed in a Usage view to see assignment records).

Part of the Task Form view with Details set to Resource Schedule...
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When the Leveling can adjust individual assignments on a task setting is selected then leveling can move or split individual assignments for a task, provided that the Level Assignments field for the task is set to Yes. Whether the adjustment to the assignment is a move or a split depends on the Leveling can create splits in remaining work setting in the Resource Leveling dialog, and the Leveling Can Split task field.

When the Leveling can adjust individual assignments on a task setting is not selected, then leveling cannot adjust any of the assignments of any task. For example, Microsoft Project 98 will revert to the old Microsoft Project 4.x behavior.

Note that adjusting individual assignments may cause existing splits on the task to be adjusted.

Leveling can create splits in remaining work

The default is on (selected).

When this setting is on, leveling may split some assignments/tasks in order to resolve overallocations. The leveling order algorithm determines which assignments/tasks get split.  Instead of delaying the start of an assignment or task to another point in time, leveling interrupts the assignment or task so that the resource can perform another assignment and then schedule the remaining part of the interrupted assignment at another point in time.

If the setting Leveling can adjust individual assignments on a task is not selected, and if leveling needs to split one assignment on a task, then it has to split the whole task. If the setting Leveling can adjust individual assignments on a task is selected, then only the one assignment is split.

As mentioned above there is an equivalent task level field that allows you to control on a per task basis whether leveling can create splits in remaining work or not. This new field is called Leveling Can Split, and its default values are Yes.

Leveling can split assignments multiple times. There is no limit on the number of size of splits that leveling can perform on an assignment, so it's possible in some very complex cases to have a task or assignment split so many names or with such wide gaps as to not be practical. In that case leveling should be cleared and the Leveling Can Split setting set to No for individual tasks.  Or, unselect the Leveling can create splits in remaining work setting.  That  prevents any task or assignment in the entire project from being split by leveling.

Microsoft Project internally keeps track of the leveling splits (splits created by leveling), so that when you use the Clear Leveling command in the Resource Leveling dialog, the splits created by leveling are undone, and the task and assignment Leveling Delay fields are cleared.

Example

This example illustrates the use of the Resource Leveling dialog settings, Leveling can create splits in remaining work and Leveling can adjust individual assignments on a task.

Originally resources R1 and R2 are assigned as follows to tasks T1 and T1 as follows:

Original Gantt Chart...
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Corresponding Task Usage showing timephased Work...
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Note: Each part below shows the Gantt Chart and corresponding Task Usage as separate windows, not in the top and bottom panes of a split window.

A.
The following picture shows the results of leveling if the setting, Leveling can adjust individual assignments on a task, is ON (selected), but the setting, Leveling can create splits in remaining work, is OFF:

Leveling adjusted (shifted) R2's assignment on T1...
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B.
The following picture shows the results of leveling if the setting, Leveling can adjust individual assignments on a task, is OFF (selected), but the setting, Leveling can create splits in remaining work, is ON:

Leveling split the entire task, not just R2's assignment on T1...

[image: image886.png][Name | Lev.Del. |[D1 [D2 |D3 |D4 |D5 [D6 |D7 |
™ Oed Emmmm R1R2
7 Oed| g R2





[image: image887.png]Name | Lev.Del. |D1 [D2 D3 [D4 |D5 |D6 | D7

ERL] Oed|[ 16h/{OR] 16h 16h_8h'
R1 [T Bh 8h_8h_Bh
0d[| 8h 8h_8h.
512 Oed Bh

0d] Bh'




C.
The next picture shows the results of leveling if the settings, Leveling can adjust individual assignments on a task and Leveling can create splits in remaining work, are both ON:

Leveling split ONLY R2's assignment on T1...

[image: image888.png]Name [Lev.Del. |D1 [D2 [D3 |D4 |D5 |D6 |D7 |
m =0

k] Oed|





[image: image889.png]Name [Lev.Del. |D1 |D2 [D3 [D4 [D5 |D6 |D7

=T Ocd[ 16h_8h 16h, 16h,
R od 8h sh 8h 8h
od("8n(on) 8h sh

212 ted| o

0d| ‘ap




Level Now

In Microsoft Project 4.x, the Resource Leveling dialog had an option to Automatically Remove Delay, which when checked, would clear the task Delay field before starting the leveling operation.

In Microsoft Project 98, this option is gone. When you click the Level Now button in Microsoft Project 98, the always undoes all previous leveling (clears all the values in the task Leveling Delay field and any splits created by leveling) within the specified leveling date range message appears, except for in tasks with the Do Not Level priority, before starting the leveling operation.

If a resource view such as the Resource Sheet view is active when you level, you get a choice to level the entire project, or selected resources (default is selected resources).

Leveling from a resource view...
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Clear Leveling

The Clear Leveling command clears all the values in the task Leveling Delay field and any splits created by leveling for the selected tasks or for all tasks in the project, except for tasks with the Do Not Level priority. It does this across all time. It does not use the From/To date range settings. You cannot clear leveling for a specified date range. 

Note that in Microsoft Project 4.x, the Clear Leveling command cleared leveling Delay even if a task had the Do Not Level priority.

Leveling and Hard / Soft Constraints

The new Tasks will always honor their constraint dates option in the Tools Options Schedule tab controls whether or not constraints can be violated in order to obey predecessor/successor relationships, or to resolve overallocations during leveling.

This setting is selected by default.

· If selected leveling cannot make adjustments to tasks that  violate their constraints, such as MSO (Must Start On), MFO (Must Finish On), FNLT (Finish No Later Than), and SNLT (Start No Later Than). Also, a successor task must honor its constraint even if it means violating a relationship with a predecessor.

· If not selected leveling can adjust tasks regardless of their constraints. Also, a successor can be scheduled as its predecessors dictate, even if it means that the successor constraint will be violated. In cases where a constraint is ignored to satisfy a relationship, the successor still has negative slack, although it is scheduled as the relationship dictates.

Examples of the interaction between leveling related settings

This section contains examples of the complex interactions between the two Tools Options Schedule tab settings and the two Resource Leveling dialog settings listed below:

In Tools Options Schedule tab:

· Tasks will always honor their constraint dates.

· Split in-progress tasks.

In the Resource Leveling dialog:

· Leveling can adjust individual assignments on a task.

· Leveling can create splits in remaining work.

Note: Each part that follows  shows the Gantt Chart and corresponding Task Usage as separate windows, not in the top and bottom panes of a split window.

All of the examples begin with the schedule shown. 

Original schedule before leveling...
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A.
The picture that follows shows the results of leveling if ...

Tasks will always honor their constraint dates – OFF.

Leveling can adjust individual assignments on a task - OFF.

It doesn't matter what the other two settings are.
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B.
The next picture shows the results of leveling if ...

Tasks will always honor their constraint dates – OFF.

Leveling can adjust individual assignments on a task – ON.

Leveling can create splits in remaining work – OFF.

It doesn't matter what the other setting is.
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C.
The next picture shows the results of leveling if ...

Tasks will always honor their constraint dates – OFF.

Leveling can adjust individual assignments on a task – ON.

Leveling can create splits in remaining work – ON.

It doesn't matter what the other setting is.
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D.
The next picture shows the results of leveling if ...

Tasks will always honor their constraint dates – ON.

Split in-progress tasks – OFF.

Leveling can adjust individual assignments on a task – OFF.

It doesn't matter what the other setting is.
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E.
The next picture shows the results of leveling if ...

Tasks will always honor their constraint dates – ON.

Split in-progress tasks – OFF.

Leveling can adjust individual assignments on a task – ON.

It doesn't matter what the other setting is.
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F.
The next picture shows the results of leveling if ...

Tasks will always honor their constraint dates - ON

Split in-progress tasks - ON

Leveling can adjust individual assignments on a task - OFF

It doesn't matter what the other setting is.
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G.
The next picture shows the results of leveling if ...

Tasks will always honor their constraint dates – ON.

Split in-progress tasks – ON.

Leveling can adjust individual assignments on a task – ON.

It doesn't matter what the other setting is.
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Leveling from a Finish Date

In Microsoft Project 4.x, you cannot level a project that is scheduled from a finish date. The reason is that it doesn't allow delay to move a task backward in time to resolve an overallocation. 

In Microsoft Project 98, Leveling Delay uses negative numbers to level tasks and assignments backward when a project is scheduled from Finish.

Recurring Tasks Default to Do Not Level

Because of the complexity of leveling all the subtasks in a recurring task, by default recurring subtasks are created with a priority of Do Not Level and the task Leveling Can Split and Level Assignments task fields are set to No. This means that all other tasks and assignments are leveled around recurring tasks. 

However, these settings can be changed to allow the subtasks of the recurring task to level.

Leveling Progress Indicator

A standard progress meter is displayed in the Status bar at the bottom of the Project window during leveling, indicating approximately how far along the leveling process is.

This progress indicator does not correspond to the amount of time involved. It approximates leveling progress. It shows how far along the leveling date- range the leveling process is.  The number of assignments that need to be checked may vary from one date to the next, and require more or less calculation time.
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Leveling Gantt View

In Microsoft Project 4.x, the Delay Gantt view shows bars for the delay and slack values on each task.

Microsoft Project 98 has an additional view, the Leveling Gantt view, designed specifically to show before and after leveling bars on the same chart, making it easy to see the impacts of leveling. It saves dates to the new Preleveled Start and Preleveled Finish task fields. It also saves split dates (internal only, not accessible) so the preleveled splits can be shown.

Leveling Gantt Bar Styles...
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Leveling Gantt before leveling...
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Leveling Gantt after leveling...
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Overtime

In Microsoft Project 98, as in Microsoft Project 4.x, leveling ignores any overtime work when looking for overallocations that need to be resolved.

Leveling Alerts/Messages

In Microsoft Project 98, if you press the ESC key during a leveling operation, you get an Alert similar to the one in Microsoft Project 4.x:

Alert when you press the ESC key...
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In both Microsoft Project 98 and Microsoft Project 4.x, if leveling cannot resolve an overallocation, an Alert is displayed. The Alert in Microsoft Project 98 is slightly different than the one in Microsoft Project 4.x:

Microsoft Project 4.x Alert when it cannot resolve an overallocation...
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Microsoft Project 98 Alert when it cannot resolve an overallocation...
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In Microsoft Project 98, pressing the Skip All button allows leveling to continue and to automatically skip all other unresolveable overallocations. This allows leveling to complete its operation without requiring you to be present the entire time.

The other important difference is that Microsoft Project 98 can do partial leveling in cases when it can't completely resolve an overallocation due to task constraints. For example, if three or more tasks cause an overallocation and two of them have MSO (Must Start On) constraints, Microsoft Project 4.x does not attempt to level any of them. Microsoft Project 98 resolves part of the overallocation by moving or changing some of the unconstrained tasks or assignments, even it can’t resolve all of the overallocations.

Changing Project Type or Changing Task Type

Project Information dialog...
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Lesson 5.8 - Exercises

1.
What's the difference between the following fields: Level Assignments, Leveling Can Split, and Can Level?

2. 
Can you set the leveling Priority for individual assignments?

3. 
What settings in the Tools Options Schedule tab can effect leveling and how? What about in the Calculation tab?

4. 
If you set the Look for overallocations on a ... basis setting to Week by Week, what is the effect on leveling?

5. 
What is the effect of using the Level From/To settings?

6. 
If leveling created splits in tasks or assignments, does the Clear Leveling command remove these splits?

7. 
What task fields are related to leveling?

What resource fields are related to leveling?

What assignment fields are related to leveling?

8.
In a Task Usage view, you can edit the Leveling Delay field and the Assignment Delay field for assignment records. What's the difference between these two assignment fields? 

Did Microsoft Project 95 have an assignment field that was similar to either of these two fields?

9.
What task field in Microsoft Project 95 does the Microsoft Project 98 task Leveling Delay field replace?

10.
What is the main difference between the Leveling Delay values when you level a project that is scheduled from start versus a project that is scheduled from finish?

11.
What new view allows you to see the before and after effects of leveling?

What new From/To Bar Style fields does this view use?


What Microsoft Project 95 view does this new Microsoft Project 98 view replace and improve?

Lesson 5.8 - Lab

Duplicate as many of the examples (A through G) as time permits in the section titled Examples of the interaction between leveling related settings.
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Lesson 6.1: Progress

Some Topics to be introduced in this lesson include:

· Status Date

· How Task % Complete related to Actual Work

· Effects of Task Splitting on Actuals

· Timephased Percent Complete

· Earned Value fields: Timephased % Complete used to compute timephased BCWS and BCWP

· Progress Lines

Status Date Setting

Microsoft( Project 98 has a new Status date field in the Project Information dialog (accessible from the Project menu):

New Status date setting in the Project Information dialog...
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Status Date defaults to NA for new files and when importing previous version Microsoft Project files or other file types. 

You can enter a date for it or you can enter NA. If Status Date is NA, then any calculations that depend on it will use the Current Date instead.

In the remainder of this lesson, when the term Status date is used, it is understood that this means the current date if the Status date setting is blank.

Status Date is a project level field, which can be used in the following ways:

· Earned value field calculations: The timephased earned value fields are blank on dates later than the Status date. Task, resource, and assignment total BCWS, BCWP, and ACWP are the corresponding timephased values on the Status date. 

· Timephased % Complete distribution: If the Tools Options Calculation tab option, Edits to total task % complete will be spread to the status date is selected. Edits to task total % Complete are distributed as timephased % Complete up to the Status date specified in the Project Information dialog.

· Lightening bolt Progress Lines: The Status Date can be used to draw lightening bolt Progress Lines on the Gantt Chart if the At project status date option is selected in the Progress Lines dialog (accessible from the Tools Tracking submenu).

Gantt Progress Lines can use the Status date ...
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· Gridlines: Status Date is included in the Lines to change list in the Gridlines dialog (accessible from the Format menu), so you can have a vertical line drawn at the Status Date in the Gantt and Resource Graph views.

· Header, Footer, and Legend: The list of predefined items at the bottom of the Page Setup Header, Footer, and Legend tabs includes Project Status Date.

Predefined items in the Page Setup Header, Footer, and Legend tabs.
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Status Date and the Update Project dialog

The Update Project dialog (accessible from the Tools Tracking submenu) includes two date fields that are related to the Status Date field in the Project Information dialog.
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· Every time the Update Project dialog is displayed, the two date fields default to the greater of the Current Date or Status Date (if not NA). It doesn't matter what the settings were the previous time the dialog was displayed.

· Select the Update work as complete through option. If you select the Set 0% - 100% complete sub-option, and the Entire project option as shown in the above picture then when you click OK the Status Date changes to the Update work as complete through date (in the upper right corner of the dialog). It doesn't matter what the previous Status Date was, even if it was NA.

Status Dates and Inserted Projects 

For a parent project containing inserted projects, the Current and Status dates from the parent project are used in the Gantt Chart and Update Project dialog features listed previously.

Earned Value is calculated using the individual project’s Status Date (or Current Date if the Status Date is NA).

How Task % Complete relates to Actual Work 

The behavior of edits to the total % Complete field is controlled by several settings, including the following:

· The Tools Options Calculation tab option, Edits to total task % complete will be spread to the status date. If selected, then edits to task % Complete are distributed as timephased % Complete up to the Status date specified in the Project Information dialog. If the Status date is blank, then the current date is used instead. If the option is not selected, then timephased % Complete is distributed between the assignment start and stop dates (assignment stop is not exposed).

· The Project Information dialog Status date. This date can be used to draw lightening bolt Progress Lines on the Gantt Chart, and is used to distribute timephased % Complete when the task % Complete is edited, as described above.

· The Tools Options Calculation tab option, Updating task status updates resource status. If this option is selected, then % Complete and assignment Actual Work are related, but the relationship is not one-to-one. The details are discussed later. If this option is not selected then task % Complete and assignment Actual Work are independent.

Regardless of Updating task status updates resource status setting, task % Complete is always the Actual Duration divided by Duration.

The remainder of this lesson assumes that the Updating task status updates resource status option is selected, unless specified otherwise.

If you know what the task timephased (scheduled) work contour is, and if you know what the task Actual Work is, then you can determine what the task Actual Duration is, as follows:

Task Actual Duration is how long it would take to complete the task Actual Work if it were done as scheduled in the current task timephased work contour.

You don't need to know the details of the assignments to make this calculation, however, the task Actual Work and its timephased work contour do depend on the assignments. For a given amount of task Actual Work and set of assignment work contours, there are many possible assignment Actual Work distributions that produce the same task Actual Duration, and hence task % Complete.

Edits to task % Complete or Actual Duration sets assignment timephased Actual Work equal to the corresponding assignment timephased scheduled work over the period of time corresponding to the task Actual Duration. 

Example

This example shows two different distributions of assignment timephased Actual Work that produces the same task Actual Duration and % Complete.

In each picture, the Gantt Chart is in the top pane and the Task Usage is in the bottom pane, showing timephased Work and Actual Work.

A. 
The picture that follows shows the original task before any actuals are entered. The task has a split spanning Days 4 and 5, so the task Duration is only 5d instead of 7d.

Before entering assignment timephased Actual Work...
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B. 
Next, 22h and 4h are entered in the Actual Work (A.W) column in the table on the left, for the R1 and R2 assignments as shown. Also, instead of entering values in the assignment Actual Work column in the table portion, you could enter the timephased Actual Work values day by day in the timephased portion on the right.

After entering assignment timephased Actual Work...
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How the task Actual Duration, % Complete, and % Work Complete are calculated:

The task Actual Work is 26h (the sum of the assignment Actual Work), so the task % Work Complete is Actual Work divided by Work = 26h / 58h = 44.8% rounds to 45%.

Next, look at the task timephased work contour:
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Hypothetically, if the 26h of task Actual Work is completed as quickly as the task timephased work contour allows, then that 26h of Actual Work could be done in Days 1 and 2, since Day1 (12h) and Day2 (14h) have a total of 26h of scheduled work. 

So the task Actual Duration is 2d. Then the task % Complete is 2d /5d = 40%. 

What about the fact that R1 has actuals all the way out to Day 6 and R2 has actuals only on Day 1? Never mind the current distribution of assignment timephased Actual Work - it's not part of the calculation of task Actual Duration.

C. 
Finally, click the task Actual Duration (A.Dur) column and enter the very same value of 2d. Edits to task Actual Duration (or % Complete) redistribute the assignment timephased Actual Work so all assignments are now statused to the same date. In this case, both assignments have calculated timephased Actual Work for Day 1 and 2.

After entering the same 2d in the task Actual Duration...
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Look at the picture in (B) and compare it to this one. You can see that the task totals are identical for the two different assignment timephased Actual Work distributions.

Timephased % Complete

You can enter timephased task % Complete values in the right side of the Task Usage view. If you edit the task total % Complete or Actual Work, it updates the task timephased % Complete data in a logical manner. There is also a timephased cumulative % Complete field that cannot be edited.

The timephased % Complete data is used to implement Progress Lines in the Gantt Chart view, and for calculations of earned value fields (BCWP, BCWS). 

% Complete and timephased % Complete are used by tasks only. These fields are not used by assignments.

Any changes to total or timephased % Complete that produce a total % Complete greater than 100% trigger the following alert:
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Edits to Task Timephased % Complete

The effect on timephased Actual Work 

Assuming the Updating task status updates resource status options is selected, edits to timephased % Complete effect assignment timephased Actual Work.

Edits to task timephased % Complete produce a change in the task total % Complete, which in turn effects assignment timephased Actual Work as discussed in the previous sections: 

Edits to task % Complete or Actual Duration sets assignment timephased Actual Work equal to the corresponding assignment timephased scheduled work over the period of time corresponding to the task Actual Duration. 

It doesn't matter what order or in what periods you enter the timephased % Complete values. Only the resulting total task % Complete effects the assignment timephased Actuals. You can even enter a task timephased % Complete on a day outside of the task date range. This does not reschedule the task or change where the assignment timephased actuals occur.

Example

This example illustrates the effect that editing task timephased % Complete has on assignment timephased Actual Work. 

In each picture, the Gantt Chart is in the top pane and the Task Usage is in the bottom pane, showing timephased Work and Actual Work.

A. 
The picture that follows shows the original task before timephased % Complete is entered. 

Before entering timephased % Complete...
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B. 
Next, 20% is entered in the task timephased % Complete for Day -1, before the task Starts. 

20% entered before the task Start date...
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B. 
Then another 10% is entered in the task timephased % Complete on Day 3, in the middle of the task.

Additional 10% entered in the middle of the task...
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C. 
Then another 15% is entered in the task timephased % Complete on Day 6, after the end of the task.

Additional 15% entered after the task Finish date...
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Note: You could enter the 20%, 10%, and 15% anywhere in the task timephased % Complete row, in any order, and you would end up with the same picture as (C) above. For example, the 15% could be entered first and then the 20%, and then the 10%, and it wouldn't matter on what days you entered them.

Distribution of timephased % Complete edits within a cell

When you edit a task timephased % Complete value, it is spread only over the project working time. However, if you edit a non-working cell, the entry is accepted.

As with most other timephased edits, timephased % Complete edits are spread over the entire timephased cell in which they are entered. For example if you enter 25% into a week cell then it is spread over the entire week and so each day get a value of 5%.

Unlike timephased work edits, timephased edits to % Complete do not factor in task Start and task Finish, because you are allowed to make these edits outside the task Start and task Finish dates. 

How edits to total % Complete are distributed

When you edit the task total % Complete, that value is distributed over time in the task timephased % Complete row. How it is distributed depends on whether there were already some task timephased % Complete values for some days, and whether the Tools Options Calculation tab option, Edits to total task % complete will be spread to the status date, is selected or not.

If the '...Spread to the Status date' setting is not selected

The section covers the case when the Edits to total task % complete will be spread to the status setting is not selected.

If % Complete is originally zero, and if this setting is not selected, then task % Complete is spread uniformly from the task Start date to the task Stop date, including across task split gaps if any. The project Status date in the Project Information dialog is not used.

If there are already task timephased % Complete values, then any subsequent increases to total % Complete (new value - old value) are spread uniformly from the latest date currently containing a timephased % Complete value to the task new Stop date resulting from the increased Actual Duration and Actual Work. This is a two step process and is reviewed again as follows:

· First the new Actual Duration is the new task % Complete times the task Duration. The increase in Actual Duration sets assignment timephased Actual Work equal to the assignment timephased scheduled Work during the span of the task Actual Duration. The new assignment Actual Work distribution produces new assignment stop and resume dates (not exposed), and therefore new task Stop and Resume dates.

· The increase in task % Complete is spread uniformly from the previous latest date that contained a timephased % Complete to the new task Stop date.

If you continue to increase the task total % Complete, the distribution of the timephased % Complete keeps moving to the right because the task Stop moves to the right. 

Note: Decreases to total task % Complete throws out exiting timephased values and behaves as if there were no existing timephased values.

Example

This example illustrates how timephased % Complete is distributed when you edit the task total % Complete, when the Edits to total task % complete will be spread to the status setting is not selected.

A. 
The picture that follows shows the original task before task total % Complete is entered. The task has a split gap that spans Days 2 and 3.

Before entering task total % Complete...
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B. 
Next, 40% is entered in the task total % Complete. This produces an Actual Duration of 40% times 5d = 2d. So assignment timephased Actual Work is set equal to assignment timephased (scheduled) Work for two working days, which is Day 1 and Day 4 because of the task split gap that spans Day 2 and 3. So the new task Stop date is Day 4 at 5pm, and the 40% total task % Complete is distributed uniformly from the start of the task at Day 1, to the new task Stop date at Day4, excluding the gap.

After entering 40% for task total % Complete...
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C. 
Next, 0% is entered in the task total % Complete to remove all actuals, which results in picture (A) again (not shown), and then 20% is entered in Day -1 (that follows). This produces an Actual Duration of 20% times 5d = 1d. So assignment timephased Actual Work is set equal to assignment timephased (scheduled) Work for Day1.

0% is entered for total % Complete and then 20% for Day -1...
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B. 
Next, 40% is entered in the task total % Complete, increasing it from 20% to 40%. The amount of the increase is 40% - 20% = 20%. This new Actual Duration is 40% times 5d = 2d. So assignment timephased Actual Work is set equal to assignment timephased (scheduled) Work for two working days, which is Day 1 and Day 4 because of the task split gap that spans Day 2 and 3. So the new task Stop date is Day 4 at 5pm, and the extra 20% of total task % Complete is distributed uniformly from the day after the existing 20% to the new task Stop date. For example, it is distributed from Day 1 to Day 4, including over the task split gap.

Total % Complete, increased from 20% to 40%....
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If the '...Spread to the Status date' setting is selected

The section covers the case when the Edits to total task % complete will be spread to the status setting is selected.

If % Complete is originally zero, and if this setting is selected, then distribution of the task % Complete depends on the project Status date in the Project Information dialog.

· If the status date of the project was earlier than the start date of the task, then the timephased value for % Complete is placed exactly on the status date. It is not spread over any time period.

· If the status date of the project is later than the task Start date, then the task % Complete is spread from the task Start date to the Status date. The task Stop, Resume, and Finish don't matter.

If there are already edited task timephased % Complete values, then any subsequent increases to total % Complete (new value - old value) are spread uniformly from period after the latest date currently containing a timephased % Complete value to the project Status date, with restrictions similar to those above.

If you continue to increase the task total % Complete, the timephased % Complete is distributed over the same date range unless, until you change the Status date. 

Normally you would increase the Status date appropriately before entering in the new total % Complete.

· If you increase the Status date, any farther increases to the task total % Complete are distributed over the new date range that runs from the previous Status date to the new one.

· If you decrease the Status date, then % Complete is spread from the task Start to the new Status date.

Note: Regardless of what you do with the Status date, decreases to total task % Complete throws behaves as if there are no existing timephased values.

Example

This example illustrates how timephased % Complete is distributed when you edit the task total % Complete, when the Edits to total task % complete will be spread to the status setting is selected.

A. 
The picture that follows shows the original task before task total % Complete is entered. The Project Information Status date is 6/4 at 5pm.

Before entering task total % Complete...
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B. 
15% is entered in the task % Complete. It is distributed from the task Start to the project Status date of 6/4 at 5pm.

After entering 15% for task total % Complete...
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C. 
The task % Complete is changed to 30%. It is again distributed from the task Start to the project Status date of 6/4 at 5pm.

After entering 30% for task total % Complete...
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D. 
Now the project Status date is changed to 6/6 at 5pm and then the task % Complete is increased from 30% to 70%. The extra 40% is distributed from the old Status date of 6/4 5pm to the new Status date of 6/6 at 5pm.

After changing the Status date to 6/6 and entering 70% for task total % Complete...
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Example

This example highlights the difference between editing task total % Complete when the Edits to total task % complete will be spread to the status setting is selected versus when it's not selected.

The task in this example is a simple 5d-Duration task with a single resource working a flat 8h/day across the task. The two columns that follow shows what happens as you change the % Complete from 0% to 50% to 100%. 

· The first column shows the results when the previous setting is not selected.

· The second column shows the results when it is selected. The Status date in the third column remains constant at 6/4 at 5pm. 

The Edits to total task % complete will be spread to the status setting is not selected
The Edits to total task % complete will be spread to the status setting is selected

The Status date is 6/4 at 5pm.
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How edits to timephased Actual Work effect timephased % Complete

As with the rest of this lesson, it is assumed that the Updating task status updates resource status option is selected (otherwise Actual Work and % Complete are independent).

Regardless of the Edits to total task % complete will be spread to the status date option, edits to assignment timephased Actual Work can change the task total % Complete. However, how this change in total % Complete is distributed over time, does depend on the "...spread to the status date" option.

· If the Edits to total task % complete will be spread to the status date option is selected, then the effect that edits to timephased Actual Work has on timephased % Complete is similar to the effects discussed in the previous section If the '...Spread to the Status date' setting is selected. Changes to assignment Actual Work cause the task total % Complete to change, and that change is distributed by the rules previously explained regarding the Status Date. The only difference is that you edit assignment timephased Actual Work through different dates for different assignments, whereas editing the task total % Complete forces all assignments to have Actual Work through the same date (determined by the task Actual Duration).

· If the Edits to total task % complete will be spread to the status date option is not selected, then changes to task total % Complete caused by edits to timephased Actual Work are spread through the task new Stop date. This is the earliest of the new assignment Stop dates after the edits. If for example, you don't edit all of the assignments through the same date, then the assignment with the earliest Stop date limits how for to the right the timephased % Complete values can go.

Example

This example highlights the difference between editing assignment timephased Actual Work when the Edits to total task % complete will be spread to the status setting is selected versus when it's not selected.

A. 
The picture that follows shows the original task with two assignments before any actuals are entered. 

Before entering assignment timephased Actual Work...
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B. 
In the picture that follows, assignment timephased Actual Work was entered while the Edits to total task % complete will be spread to the status option was not selected. Notice that the calculated timephased % Complete could not be distributed to the right of the task Stop date 6/2 (the earliest assignment Stop date is from the R2 assignment).

After entering assignment timephased Actual Work while the '...spread to the status' option was not selected...
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C. 
In the next picture, assignment timephased Actual Work was entered while the Edits to total task % complete will be spread to the status option was selected. Notice that the Status Date of 6/4 now determines how the task timephased % Complete is spread, and not the task Stop date.

After entering assignment timephased Actual Work while the '...spread to the status' option was selected...
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Summary Task total and timephased % Complete

Summary tasks can have both totaled and timephased % Complete values. These values are calculated when various values for the child tasks change. In addition, you can edit summary task total % Complete and have it calculate % Complete for the child tasks.

Summary task has total and timephased % Complete...
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Calculating Summary task total and timephased % Complete

The total % Complete of a summary task equals the sum of the Actual Duration’s of the child tasks divided by the sum of the Duration’s of the child tasks.
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The timephased % Complete for a specific period for a summary task is the sum of the child timephased Actual Duration’s for that period divided by the sum of the total Duration’s of the child tasks. 
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The child timephased Actual Duration in the above formula is not an exposed field. The timephased Actual Duration of a child task for a specific period equals the timephased % Complete of the child task for that period (which is exposed) times the total Duration of the child task.
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Note that the summary Actual Duration does not appear in the above formulas. It is calculated separately as summary task % Complete times summary task Duration, but plays no direct role in the timephased calculations.

Example

The example illustrates how the summary task total and timephased % Complete values are calculated from the child tasks.
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· Summary task total % Complete 

= (Sum of child Actual Duration’s) divided by (Sum of child total Duration’s)


= (4d + 2d + 1d) divided by (8d + 4d + 4d)


= 7d / 16d


= 43.75 %


= 44% (rounded)





· Summary task timephased % Complete values

Before computing the three Summary task timephased % Complete values shown above, the child timephased Actual Duration’s for each period should be calculated first. This timephased field cannot be displayed.

Task T1: For Day 1, 2, and 3, take the corresponding timephased % Complete values 30%, 20%, and 0% and multiply by the total Duration of 8d. That results in timephased Actual Duration’s of 2.4d = 30% of 8d, 1.6d = 20% of 8d, and 0d = 0% of 8d.

Using the same technique for task T2 and task T3 gives the following grid of timephased Actual Duration’s (remember these cannot be displayed).


Day 1
Day 2
Day 3

Child task T1
2.4d
1.6d
0d

Child task T2
0d
2d
0d

Child task T3
0.2d
0.6d
0.2d

Sum of child timephased Actual Duration’s
2.6d
4.2d
0.2d

Finally, for each day, the sum of the child timephased Actual Duration’s that day can be divided by the sum of the child total Duration’s, 8d + 4d +4d = 16d, to get the summary task timephased % Complete for that day. For example, for Day 1

Summary task timephased % Complete for Day 1

= (Sum of child Actual Duration’s for Day 1) divided by 

 (Sum of child total Duration’s)

= 2.6d / 16d

= 16.25%

= 16 % (rounded)

Note that the distribution of the work and Actual Work of the tasks and any resources working on them is irrelevant in the summary task total and timephased % Complete calculations. For example, one of the many possible sets of assignments that produces the data used is shown in the following example:

Possible schedule to produce the data in this example...
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Editing Summary task total % Complete

If you edit the total % Complete for a summary task, any previous edits to timephased % Complete for child tasks is lost. The new total % Complete for the child tasks and the new timephased % Complete for the child tasks and summary task are computed as follows:

1. Sum of child Actual Duration’s can be solved for from the formula for Summary task total % Complete in the previous section:
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Solving for Sum of child Actual Durations gives:

Sum of child Actual Duration’s

= (Summary task total % Complete) times (Sum of child total Duration’s)

2. The next step is to mark off timephased Actual Duration from left to right on all child tasks as they are encountered. Minute by minute from the start of the summary task, mark off 1 minute of Actual Duration for any child tasks scheduled during that minute, until the Sum of child Actual Duration is used up. Every child task is treated equally during this process. All that differentiates how much Actual Duration each child gets is its location and span. When this process is completed, all the progress bars on all child tasks should end at the same time, except for the ones that finish earlier and are 100%.

3. Next, for each period and each child, Child timephased % Complete for the period can be solved from the formula for Child timephased Actual Duration for the period in the previous section::
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Solving for Child timephased % Complete gives

Child timephased % Complete for the period

= (Child timephased Actual Duration for the period) 

  Divided by the (Child total Duration)

4. Finally, the summary task timephased % Complete can be calculated from the child timephased % Complete values as discussed in the previous section.

Example

This example illustrates how edits to summary task total % Complete are distributed to child timephased % Complete. 

The Edits to total task % complete will be spread to the status option is not selected in this example.

The Summary Progress bar was added to the Gantt Bar Styles that follows:

Bar Styles definitions for summary and summary progress bars...
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A. 
The picture that follows shows the original tasks before the summary total % Complete is entered.

Before entering summary total % Complete...
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B. 
Next, 80% is entered in the % Complete column for the summary task.

After entering 80% for the summary total % Complete...
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Here are the calculations that occurred...
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Here's the corresponding Task Usage view...
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How the timephased % Completes were calculated:

Sum of child Actual Duration’s

= (Summary task total % Complete) times (Sum of child total Duration’s)

= 80% times 5d

= 4d

The 4d is distributed across the child tasks as they are encountered, yielding the timephased Actual Duration’s listed:


Day 1
Day 2
Day 3

Child task T1
0d
1d
0d

Child task T2
1d
1d
0d

Child task T3
0d
1d
0d

Sum of child timephased Actual Duration’s
1d
3d
0d

For each child and for each day, you can divide its timephased Actual Duration by its total Duration to get its timephased % Complete, as shown:


Day 1
Day 2
Day 3

Child task T1
0d /1d = 0%
1d / 1d = 100%
0d / 1d = 0%

Child task T2
1d / 2d = 50%
1d /2d = 50%
0d / 2d = 0%

Child task T3
0d /2d = 0%
1d / 2d = 50 %
0d / 2d = 0%

Sum of child timephased Actual Duration’s
1d
3d
0d

Finally, for each day, the summary task timephased % Complete is computed from the formula in the previous section.

Day 1:

Summary task timephased % Complete for Day 2

= (Sum of child Actual Duration’s for Day 2) divided by 

 (Sum of child total Duration’s)

= 1d / 5d

= 20%

Day 2:

Summary task timephased % Complete for Day 2

= (Sum of child Actual Duration’s for Day 2) divided by 

 (Sum of child total Duration’s)

= 3d / 5d

= 60%

Day 3:

Summary task timephased % Complete for Day 2

= (Sum of child Actual Duration’s for Day 2) divided by 

 (Sum of child total Duration’s)

= 0d / 5d

= 0%

Changing the task Actual Start

If you change the Actual Start date of a task, any existing timephased % Complete values move relative to the new task Actual Start date. 

Changing the '...Spread to the Status date' setting

If you change the Edits to total task % complete will be spread to the status date setting after you start tracking, previously entered values will be preserved. However when you next update a task total % Complete value, the rules associated with the new state of the setting are applied. These rules are discussed in previous sections in this lesson.

Changing Duration After Entering % Complete Values

If you edit the Duration of a task, the task total % Complete values changes. If there are no assignments then it’s a simple inverse relationship. For example, double the Duration and the % Complete is cut in half. If assignments are involved, it's still a simple inverse relationship if you increase the Duration, but if you reduce the Duration, some Actual Work might be truncated.

Changing the task Duration also effects timephased % Complete. The result depends on whether you edit the timephased % Complete values or if they are calculated from edits to task total % Complete. When you edit the timephased % Complete, Microsoft Project remembers the location of the last edits. Microsoft Project tries to distribute changes to task total % Complete over the period from the last timephased edits to the new Stop date (or Status date if the, Edits to total task % complete will be spread to the status date setting is selected).

Example

This example illustrates how the effects caused by changing task Duration depend on whether timephased % Complete is edited or not. The Edits to total task % complete will be spread to the status date setting is not selected in this example.

Both cases start with the following Gantt Chart over Task Usage, with the Task Usage details formatted to display timephased % Complete. In this simple example, there are no assignments.
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In the case on the left that follows, 50% is entered in for the task total % Complete, and then the task Duration is cut in half.
In the case on the right that follows, 25% is entered in the timephased % Complete for Days 1 and 2, and then the task Duration is cut in half.
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For the case on the left, no timephased % Complete was entered, so Microsoft Project spreads the new total % Complete over the whole Duration.

For the case on the right, Microsoft Project remembered that timephased % Complete was edited. Microsoft Project tried to make additional adjustments only to the latest timephased % Complete cell edited.

Earned Value

This lesson discusses the new behavior of the earned value fields in Microsoft Project 98. The discussion focuses primarily on Budgeted Cost of Work Scheduled (BCWS) and Budgeted Cost of Work Performed (BCWP). 

Note: In this lesson, the term Status date means the Status date setting in the Project Information dialog, or the Current Date if the Status date is NA.

In Microsoft Project 98, all of the of the earned value fields are defined for task, resource, and assignment records, and all of them except VAC have a corresponding timephased field. For example, Microsoft Project 98 Help includes information on the following six record-type BCWP fields:

BCWS (task field)

BCWS (task-timephased field)

BCWS (resource field

BCWS (resource-timephased field)

BCWS (assignment field)

BCWS (assignment-timephased field)

The first column in the table that follows lists the Project Management earned value term for each earned value field. The second column lists the corresponding field name in Microsoft Project 98, and the third column contains description excerpts from Microsoft Project 98 Help, for the Task version of the field. The BCWS, BCWP, and ACWP fields are discussed in detail later in this section. For detailed information on all the versions of these fields, (task-timephased, resource, and so on) search on "earned value" in Microsoft Project 98 Help. 

Earned Value Term
Microsoft Project 98

Field
Task field short & long descriptions (based on Microsoft Project 98 Help topics)

ACWP 

Actual Cost of Work Performed
ACWP*

Note: This is not the same as the Actual Cost field. See the Actual Cost versus ACWP topic later in this lesson.
Actual Cost of work performed, through the project status date.

This is the cost of Actual Work plus any Fixed Costs for the task to date (for example, through the Status date). How and when ACWP is calculated depends on the assigned resources' Standard Rate, Overtime Rate, Per Use Cost, and Cost accrual settings in the Resource Information dialog box, as well as on the Actual Work reported, task Fixed Costs, and the status date or today’s date.

BAC

Budget at Completion
Baseline Cost
Budgeted at completion.

Shows the total planned cost for a task.

BCWP

Budgeted Cost of Work Performed
BCWP
Budgeted cost of work performed, through the project status date.

Contains the cumulative value of the assignment’s timephased percent complete multiplied by the assignment’s timephased baseline cost. BCWP is calculated up to the status date or today’s date. This information is also known as earned value.

BCWS

Budgeted Cost of Work Scheduled
BCWS
Budgeted cost of work scheduled, through the project status date.

Contains the cumulative timephased baseline costs up to the status date or today’s date.

CV

Earned Value Cost Variance
CV
Earned value cost variance, through the project status date.

Shows the difference between how much it should have cost to achieve the current level of completion on the task, and how much it has actually cost to achieve the current level of completion up to the status date or today’s date.

CV = BCWP – ACWP

EAC

Estimate At Completion
Cost
Estimate at completion, of the scheduled cost for a task.

Shows the total scheduled, or projected, cost for a task. Based on costs already incurred for work performed by all resources assigned to the task, in addition to the costs planned for the remaining work for the assignment.

SV

Earned Value Schedule Variance
SV
Earned value schedule variance, through the project status date.

Shows the difference in cost terms between the current progress and the baseline plan of the task up to the status date or today’s date. You can use SV to check costs to determine whether tasks are on schedule.

SV = BCWP – BCWS

VAC

Variance At Completion
Cost Variance
Variance at completion, between baseline cost and scheduled cost for a task.

Shows the difference between the baseline cost and total cost for a task. The total cost is the current estimate of costs based on actual costs and remaining costs. 

Cost Variance = Cost – Baseline Cost

Microsoft Project 98 supports all of the earned value fields for task, resource, and assignment records, and has timephased support for all of them except for Cost Variance. Some general features regarding the earned value:

· All of the fields can be inserted in any task or resource table.

· All of the fields except Cost Variance can be inserted in the timephased Details of a Usage view.

· All of the fields have the Currency data type.

· Most of the fields are calculated only, except for the baseline fields, which are calculated when you save the baseline and can be edited later. There are also some special situations that allow edits, such as the task Actual Cost field when the task has no assignments.

Changes from Microsoft Project 4.x

Resource and assignment field versions

Microsoft Project 4.x supported all of the earned value fields for tasks, but did not support all of the earned value fields for resource and assignment records. Resources and assignments both had Actual Cost, Baseline Cost, and Cost fields. In addition, resources had the Cost Variation field.

Microsoft Project 98 supports all of the earned value fields for task, resource, and assignment records, and has timephased support for all of them except for Cost Variance.

Timephased earned value calculations

Microsoft Project 4.x calculated earned values from various total field values.

Microsoft Project 98 bases earned value calculations on timephased fields. These calculations are discussed in detail later.

FAC vs. EAC

Microsoft Project 4.x used the title Forecast At Completion (FAC) for the Cost field in the Earned Value table, rather than the standard Project Management term, Estimate At Completion (EAC). Microsoft Project 98 uses the title EAC.

CV (Cost Variance)

Microsoft Project 98 uses the standard definition of CV: CV = BCWP - ACWP.

Microsoft Project 4.x used CV = ACWP -BCWP, which gave a CV value opposite in sign to the standard definition. 

Resource Baseline Cost

Microsoft Project 4.x did not allow you to edit Baseline Cost for resource records (but you could for task and assignment records).

Microsoft Project 98 allows all baseline fields to be edited, including timephased baseline fields.

Actual Cost versus ACWP

Microsoft Project 4.x used the title ACWP (Actual Cost of Work Performed) for the Actual Cost field in the Earned Value task table, but there was no separate ACWP task field. Actual Cost and ACWP were the same thing.

Microsoft Project 98 has a separate ACWP task field that is a running sum of the timephased Actual Work through the Status date. This running sum can be displayed in a separate timephased Cumulative Percent Complete field in the Task Usage view. The task Actual Work field however contains the total Actual Work on the task, including any timephased Actual Work at dates to the right of the Status date. So in Microsoft Project 98, it's possible for ACWP to be less than Actual Cost. This is discussed in detail later.

Summary task calculations

In Microsoft Project 4.x, BCWP and BCWS were calculated incorrectly for summary tasks (see Microsoft KB article Q75051). It used the same calculation for summary tasks as it did for nonsummary tasks, instead of rolling up values from the child tasks.

Microsoft Project 98 correctly rolls up these fields for summary tasks.

Status Date

In Microsoft Project 4.x, most of the earned values were based on the current date specified in the Project information dialog. Unless you updated actuals every day, the earned value data was more and more incorrect (not up to date), until you entered actuals again. 

Microsoft Project 98 has a new Status date field in the Project Information dialog (accessible from the Project menu) that can be set whenever you want to update tracking information on the entire project. The earned value calculations use this new status date instead of the current date. If you leave this field blank, then the current date is still used. 

New Status date setting in the Project Information dialog...
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In the remainder of this lesson, when the term Status date is used, it is understood that this means the current date if the Status date setting is blank.

BCWS, BCWP, and ACWP Calculations

Totals

Task, resource, and assignment total BCWS, BCWP, and ACWP are not calculated from other total fields. Their values are just the corresponding timephased values on the Status date. 

Timephased

The table shows how the timephased versions of these fields are calculated.

The timephased earned value fields are blank on dates later than the Status date; otherwise these calculations are used:

BCWS timephased


Task timephased BCWS on a specific date
Sum of the task timephased Baseline Cost through the specified date.

Not calculated as the sum of the assignment timephased BCWS on that date.

Assignment timephased BCWS on a specific date
Sum of the assignment timephased Baseline Cost through the specified date.

Resource timephased BCWS on a specific date
Sum of the resource timephased Baseline Cost through the specified date.

Not calculated as the sum of the assignment timephased BCWS on that date.

BCWP timephased


Task timephased BCWP on a specific date
Sum of the task timephased Baseline Cost over a Duration determined by the task timephased Cumulative % Complete on the specified date multiplied by the task total Baseline Duration.

Not calculated as the sum (rollup) of the assignment timephased BCWP on that date.

Assignment timephased BCWP on a specific date
Sum of the assignment timephased Actual Work through the specified date, divided by the total assignment (scheduled) Work multiplied by the assignment total Baseline Cost.

You can think of the underlined part as the assignment cumulative % work completed on the specified date, although there is no such exposed timephased field.

Resource timephased BCWP on a specific date
Sum (rollup) of the assignment timephased BCWS on the specified date.

Does not depend on the resource timephased Baseline Cost.

ACWP timephased


Task timephased ACWP on a specific date
Sum of the task timephased Actual Cost through the specified date.

Not calculated as the sum (rollup) of the assignment timephased ACWP on that date. For example, the task might have prorated Fixed Cost contributing to the timephased Actual Cost.

Assignment timephased ACWP on a specific date
Sum of the assignment timephased Actual Cost through the specified date.

Resource timephased ACWP on a specific date
Sum of the resource timephased Actual Cost through the specified date.

Also equals the sum (rollup) of assignment timephased Actual Cost 

BCWS (Budgeted Costs of Work Scheduled)

In Microsoft Project 4.x, task BCWS = Planned Percent Complete * Baseline Cost, where Planned Percent Complete (not accessible) was based on the current date and on the baseline start and finish dates of the task. 

Microsoft Project 98 has both total and timephased BCWS for task, assignments and resources, and the calculations involve timephased Baseline Cost. See the above table for the calculation details.

Example

This example illustrates how BCWS is calculated for tasks, assignments and resources. 

A. 
The Task Usage picture that follows shows the original task and assignments after the baseline is saved. The Status date in the Project Information dialog is set to 6/4. The assignment BCWS appears to rollup to the tasks, but that's only because nothing was edited after the baseline was saved.

Just after saving the baseline...
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B. 
Next, the Status date is changed to 6/5. The entire total and the timephased Baseline Cost values are edited with meaningless values to make it clear that the task BCWS is not a rolled up from the assignment BCWS, and that the total Baseline values have no effect. The BCWS values are still calculated using the above rules.

New Status date and timephased Baseline Cost entered...
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C. 
The picture that follows shows the corresponding Resource Usage view where you can see the timephased BCWS for the parent resource records and their assignment records. In the Task Usage view you saw assignment records, not resource records. It's clear that timephased BCWS does not roll up from the assignments.

Corresponding Resource Usage view...
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BCWP (Budgeted Costs of Work Performed)

In Microsoft Project 4.x, task BCWP = Percent Complete * Baseline Cost.

Microsoft Project 98 has both total and timephased BCWP for task, assignments and resources, and the calculations involve various timephased fields. See the above table for the calculation details.

Example

This example illustrates how BCWS is calculated for tasks and assignments.

A. 
The Task Usage picture that follows shows task T with a 3d Duration starting on 6/2. The resource R1 has a Standard Rate of $1.00 and is assigned to task T as shown. The baseline has just been saved.

Just after saving the baseline...
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B. 
The task has now slipped one day to 6/3, and its Duration has been increased to 4d.

Start moved to 6/3 and Duration increased to 4d...
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C. 
Next, custom timephased % Complete values are entered for the task, and custom timephased Baseline Cost values are entered for the task and the assignment.

Edited timephased % Complete and Baseline Cost...
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D. 
As an example of the task timephased BCWP calculation, here's how the $14.80 on 6/4/97 was calculated:

First, take the timephased Cumulative % Complete on 6/4/97 and multiple it by the task total Baseline Duration. That gives (60%) times (3d) equals 1.8d.

Next, add up 1.8 days of the task timephased Baseline Cost. Start with the earliest entry. The 1.8 means to count all of the $10 on 6/2/97, and only 0.8 of the $6 on 6/3/97. That's (1 times $10) plus (0.8 times $6) = $10.00 + $4.80 = $14.80.

E. 
As an example of the assignment timephased BCWP calculation, here's how the $12.00 on 6/4/97 was calculated:

First, add up all of the assignment timephased Actual Work from the start of the assignment to 6/4/97 and divide that by the assignment total scheduled Work. That's (8h on 6/3/97 plus 8h on 6/4/97) divided by 32h = 16h/32h = .0.5 or 50%. Think of this as the assignment cumulative % work complete through 6/4/97, however, this field cannot be viewed.

Next, multiply the assignment total Baseline Cost by the above ratio. That gives $24.00 times 50% equals $12.00.

Note that the total Baseline Cost of $24 from the table on the left is used in the calculation, not the sum of all the assignment timephased Baseline Cost ($6 + $3 + $8 = $17). Editing timephased Baseline values does not change the total Baseline value in the table on the left.

ACWP (Actual Costs of Work Performed)

See the Actual Cost versus ACWP topic above for the differences between Microsoft Project 4.x and Microsoft Project 98.

Microsoft Project 98 has both total and timephased ACWP for task, assignments and resources. See the above table for the calculation details.

Example

This example illustrates how ACWP is calculated for tasks and assignments. 

A. 
The resource R1 has the following variable rates defined in the Resource Information dialog Costs tab:

Variable Rate table A in the Resource Information dialog Costs tab...
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B. 
The Task Usage picture that follows shows R1 assigned to a 5d-Duration task T. The task total % Complete was set to 80%. The date 6/5/97 was entered for the Status date in the Project Information dialog.

Because the timephased Actual Cost values don't go past the Status date, the assignment and task total Actual Cost is equal to the total ACWP.

80% entered for task total % Complete...
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C. 
Next the Status date is edited and moved a day earlier, to 6/4/97.

Now there are timephased Actual Cost values to the right of the Status date. The ACWP values stop right at the Status date, so now the total task and assignment ACWP ($280) is less than the total Actual Cost ($400).

6/4/97 was entered for Status date...

[image: image974.png]Status date

Hame |%Comp| Cost [A.Cost| ACWP||Detai 62 |63 64 | [65 66
T o $520.00 (340000 52800 Work ;e m m m
Acvork | e on s on
No fonger equal Cost | $i000 S000 $1200 $12000, $12000
Aot Cont | $6000 " $6000 $12000 $12000
acwe_| s000 416000, $75000
R $520.00 $400.00 $280.00 | Work s s o o 8h
tvork| e el
Cost | Si000 Si000 $13000 $12000 $12000
Aot Cont | 56000 50000, $12000 $120.00]
P s i





Earned Value from Inserted Projects

When an Inserted Project is opened or closed, updated total earned values fields from the Inserted Project are stored in the parent project.

The behavior of timephased earned value fields for an Inserted Project depends on whether it is open or closed.

· If an Inserted Project is closed in the parent project, then the Inserted Project does not display any timephased earned value data. 

When you save a baseline in the parent project, the Inserted Project’s total BCWS, and BCWP values are saved too. If there are any assignments on the Inserted Project task in the parent project, the assignment earned value data is saved, but assignment timephased earned value data is not displayed.

If you have not saved a baseline on the parent project, then BCWS, Baseline Cost and BCWP for the Inserted Project task are all 0 and cannot be displayed. Also, SV is zero, and CV = negative of ACWP, since CV = BCWP - ACWP = 0 - ACWP = - ACWP.

The Inserted Project’s ACWP value is saved with the parent project, without having to save a baseline in the parent project. That's because ACWP does not depend on baseline values.

When an Inserted Project is open in the parent project, then it can get and display timephased earned value data. The earned value data coming from the Inserted Project uses the Inserted Project's Status date, not the parent project's status date. 

Progress Bars

This section discusses Bar Styles defined From Start or Actual Start and drawn To the fields related to progress listed in the first column of the table that follows. The default Standard Calendar and working times are assumed throughout.

Upper part of the Bar Styles dialog...
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Bar Styles related to progress...

From Start or Actual Start To ...
Description of the bar ...

CompleteThrough
This is the default progress bar defined in the Gantt Chart view.

CompleteThrough is the task Start + Actual Duration. If it is at the beginning of a nonworking period (in the project calendar), then it is pushed forward to the next working period. 

For example, if the Start + Actual Duration is Tue 5pm, then the CompleteThrough is Wed 8am. If the Format Layout Round bars to whole days setting is selected and the timescale is formatted for days, then the CompleteThrough bar is drawn to the end of Tue, otherwise it would be drawn to Wed 8am

As another example, if the Start + Actual Duration is Fri 5pm, then the CompleteThrough is the following Mon 8am.

The CompleteThrough field is not exposed. It– cannot be inserted in a task table.

% Complete
Not defined in default views.

This uses the % Complete field to draw the progress bar in proportion to the task bar, regardless of working times during the span of the task. The % Complete progress bar can end in the middle of a nonworking period.

The % Complete field can be inserted in a task table, but is not exposed for assignments.

Resume
Not defined in default views.

For tasks without assignments, this is the same as CompleteThrough.

For tasks with assignments that have been uniformly statused (for example, all assignments have the same resume date as the task), the task Resume date is the same as its CompleteThrough. Otherwise, the task Resume date could be earlier than the CompleteThrough date.

The Resume field can be inserted in a task table, but is not exposed for assignments.

Summary Progress
Defined in the default Tracking Gantt view.

New to Microsoft Project 98.

Never drawn for nonsummary tasks regardless of the Show For condition.

Used to draw progress bars on summary tasks more realistically. Tied to the dates and Duration’s that work was actually done, rather than depending directly on the task % Complete. 

Note: The ends of the CompleteThrough and % Complete progress bars can be dragged to change the Actual Duration and % Complete of a task. The Resume bar cannot be dragged.

The example that follows compares the various Bar Styles for nonsummary tasks. The next section covers summary progress in detail.

Example

The pictures that follow illustrate the differences between the CompleteThrough, % Complete, and Resume bar styles described previously. No summary tasks are involved in this example. The default Standard calendar is used in this example. The Gantt Chart has been customized to show the CompleteThrough, % Complete, and Resume bars on separate rows from the task bar. Also, these three bars use the Text1, Text2, and Text3 fields for Right Bar Text, to display labels beside the progress bars. The Format Layout Round bars to whole days setting is not selected for picture A, B, and C, but is selected for picture D.

Custom Bar Styles used to compare CompleteThrough, % Complete, and Resume...
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In the remaining pictures, the Gantt Chart is in the top pane and the Task Usage is in the bottom pane. They show timephased Work above timephased Actual Work.

A.
For task T1, the two assignments are  statused uniformly through Tue 6/3. Both assignments have a resume date (not exposed) of 6/4 at 8am, and so does the task. In this case, the task Resume and CompleteThrough dates are the same. Also, since the Actual Duration on T1 does not end at the beginning of nonworking time (weekends here), then the % Complete progress bar is the same as the CompleteThrough progress bar.

Uniformly statused assignment...
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B.
For task T2, the two assignments are not uniformly statused. The actuals for R1 were entered through Wed 6/4, but the actuals for R2 were only entered for Mon 6/2 (this also can be produced by entering the assignment totals of 24h and 8h in the Actual Work field in the table on the left).

When you look  at the assignment timephased Actual Work for the assignments, you can deduce their assignment resume dates (not exposed). The R1 assignment has a resume date of 6/5 at 8am, but the R2 assignment has an earlier resume date of 6/3 at 8am (assuming default working times). The task Resume date is the earliest assignment resume date, namely 6/3 at 8am. So the task Resume date is earlier than its CompleteThrough date. 

Irregularly statused assignment...
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C.
For task T3, the two assignments are uniformly statused again, so the task Resume and CompleteThrough date are the same. However, the task Start + Actual Duration ends at 6/6 Fri 5pm, the beginning of a nonworking period (the weekend here), so the CompleteThrough date is the following 6/9 Mon 8am. 

Uniformly statused assignments up to a nonworking day...
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D.
The picture that follows shows the same three tasks, only now the Round bars to whole days setting is selected. 

"Round bars to whole days" setting is selected...
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Calculations Related to Summary Task Progress

This section provides detailed descriptions of progress-related calculations involving summary tasks, including:

· Calculation of Summary Progress dates, regarding the new Bar Styles From/To Summary Progress choice. 

· Calculation of summary task total and timephased % Complete.

· Calculation of child task timephased % Complete when the Summary task total % Complete is edited.

Calculating Summary Progress dates

The Bar Styles dialog in Microsoft Project 98 has a new From/To field choice called Summary Progress.

New Bar Styles From/To Summary Progress choice...
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The Summary Progress choice is used to draw progress bars on summary tasks more realistically. Microsoft Project 98 calculates the Summary Progress dates for summary tasks and uses them to draw the corresponding progress bars.

The Summary Progress field is only accessible in the Bar Styles dialog. It is not exposed anywhere else. You cannot insert it into a task table or in the details of a Task Usage view.

The Summary Progress date is also used to draw progress points on summary tasks. A progress point is the point at which  a Progress Line connects to a task. Progress Lines and progress points are discussed in detail in another lesson.

How Summary Progress dates are calculated

Summary Progress dates are calculated as follows:

1.
Sum up the child total Actual Durations. This sum is required by the calculation in the next step, but is not necessarily equal to the summary task Actual Duration. The summary Actual Duration is the summary % Complete times the summary Duration.

2.
Minute by minute, moving left to right from the start of the task, keep a running count of how many tasks have scheduled working time that minute. When the count of minutes is equivalent to the sum of the child Actual Durations (from step 1), that date is the Summary Progress date.

If you want to manually calculate a Summary Progress date to verify that you understand how it is being computed, you don't necessarily have to think through step 2 on a minute by minute basis. For example, if all the task durations are in days, you can think through the calculation in step 2 on a day by day basis.

If you want to see the physical equivalent of the above hypothetical counting process, simply click the summary task % Complete field and reenter the value that is already there. This throws out existing child % complete values and marks off Actual Duration on the child tasks as they are encountered moving left to right from the Start of the summary task to the summary Start plus the summary Actual Duration. Use the Edit Undo menu command to restore the original actuals.

Note that the Summary Progress date depends on the distribution of child task durations and on the sum of the child task Actual Durations, not on how that Actual Duration is distributed among the child tasks. The examples that follow illustrate this point.

Interpreting Summary Progress bars

Summary Progress bars are easiest to interpret in cases where you give progress to the entire child tasks through the same date. For example, child progress bars end at the same date except for those that have been completed at an earlier date. In these simple cases, the Summary Progress date is the date at the end of the rightmost child progress bar or bars.

However, Microsoft Project allows you to status tasks out of chronological order. For example, you can put progress on a task that isn't scheduled to occur until some time in the future. Also, you cannot bother statusing some tasks while statusing others that occur in the same timeframe. It's more difficult to assign a meaningful interpretation to the Summary Progress date in these cases (but not difficult for Microsoft Project to calculate it).

Regardless of whether you status the child tasks in a meaningful way, the same logical rules apply to how the Summary Progress date is calculated.

Example

This example illustrates the computation of Summary Progress dates for two summary tasks in which all the child tasks are statused throughout the same date. This is the easy case to interpret. It also highlights the difference between the Bar Styles CompleteThrough date and the Summary Progress date.

Part A and B both use the Bar Style definitions shown in the picture that follows. Note that the CompleteThrough and Summary Progress bars have the numbers 2 and 3 in the Bar Styles Row column. They are  displayed as follows in the summary bar (for clarity).

Bar Styles used in this example...
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A. 
To calculate the Summary Progress bar that follows,  think of the sum of child Actual Durations (1d) as being distributed over Day1 (which in this case it really is).

Values were entered into the % Complete of the child tasks of S1...
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The Summary Progress date in the picture above is calculated as follows:

First, the sum of the child Actual Durations is 1d +0d = 1d.

Next, count the tasks occurring each day, day by day, until the count reaches the sum of the child Actual Durations, 1d. In this simple case, it's used up on Day1, so the Summary Progress date is at the end of Day1.

The summary task % Complete in the picture above is calculated as follows:

Summary task total % Complete 

= (Sum of child Actual Durations) divided by (Sum of child total Durations)

= (1d + 0d) / (1d + 1d) = 1d / 2d = 50 %

The summary task Actual Duration is then calculated as follows:

Summary Actual Duration

= (Summary % Complete) times (Summary Duration)

= (50%) times (8d) = 4d

Note that the CompleteThrough bar  not the Summary Progress date uses the summary Actual Duration. Also note that the summary Duration is the full span of all child tasks, not the sum of the child Durations.

B. 
To calculate the Summary Progress bar that follows, think of the sum of child Actual Durations (6d) as being distributed over Day1 through Day4 (which in this case it really is).

Values were entered into the % Complete of the child tasks of S2...
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The Summary Progress date in the picture  is calculated as follows:

First, the sum of the child Actual Durations is 3d +2d + 1d + 0d = 6d.

Next, count the tasks occurring each day, day by day, until the count reaches the sum of the child Actual Durations, 6d:

Day1: Task S2-T2 occurs on that day which adds 1d to the count. The count is now at 1d.

Day2: Tasks S2-T1 and S2-T2 occur that day, which adds 2d more to the count, so the count is now at 3d.

Day3: Task S2-T1 occurs on that day, which adds 1d more to the count, so the count is now at 4d.

Day4: Tasks S2-T1 and S2-T3 occur that day, which adds 2d more to the count, so the count is now 6d. That matches the sum or the child Actual Durations, so the Summary Progress date must be the end of Day4.

The summary task % Complete in the picture previous  is calculated as follows:

Summary task total % Complete 

= (Sum of child Actual Durations) divided by (Sum of child total Durations)

= (3d +2d + 1d + 0d) / (5d + 2d + 2d + 1d) = 6d / 10d = 60 %

The summary task Actual Duration is then calculated as follows:

Summary Actual Duration

= (Summary % Complete) times (Summary Duration)

= (60%) times (9d) = 5.4d

Example

This example illustrates the computation of Summary Progress dates for a summary task in which the child tasks have been statused out of chronological order. For example, the child tasks have not been statused through the same date. The same logic is used in the calculation of the Summary Progress date; however, it's more difficult to interpret the result. 

Parts A and B both use the Bar Style definitions shown in the picture as follows. 

Bar Styles used in this example...
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A. 
80% is entered for the % Complete of task T1. To calculate the Summary Progress bar that follows, think of the sum of child Actual Durations (4d) as being distributed over Day1 and Day2 (which in this case it really is not).

80% was entered for task T1...
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The Summary Progress date in the picture above is calculated as follows:

First, the sum of the child Actual Durations is 4d +0d + 0d + 0d + 0d = 4d.

Next, count the tasks occurring each day, day by day, until the count reaches the sum of the child Actual Durations, 4d:

Day1: Task T2 occurs on that day which adds 1d to the count. The count is now at 1d. Note that it does not matter that task T2 has no Actual Duration on Day1. Microsoft Project counts Duration, not Actual Duration during this calculation.

Day2: Tasks T1, T2, and T3 occur that day, which adds 3d more to the count, so the count is now at 4d. That matches the sum or the child Actual Durations, so the Summary Progress date must be the end of Day2.

The summary task % Complete in the picture above is calculated as follows:

Summary task total % Complete 

= (Sum of child Actual Durations) divided by (Sum of child total Durations)

= (4d +0d + 0d + 0d + 0d) / (5d + 2d + 2d + 4d + 2d) = 4d / 15d = 27 %

The summary task Actual Duration is then calculated as follows:

Summary Actual Duration

= (Summary % Complete) times (Summary Duration)

= (27%) times (11d) = 2.93d

B. 
This is a continuation of part A. Next, 50% is entered for the % Complete of tasks T5. To calculate the Summary Progress bar that follows, you can think of the sum of child Actual Durations (5d) as being distributed over Day1, Day2, and half of Day3 (which in this case it really is not). The half-day comes on Day3 because there are two tasks that day, but only one day of Actual Duration needs to be accounted for, since Day1 and Day2 account for 4d. See the details of the calculation that follow the picture. 

80% is entered for T1 and 50% is entered for T5...
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The Summary Progress date in the previous picture  is calculated as follows:

First, the sum of the child Actual Durations is 4d +0d + 0d + 0d + 1d = 5d.

Next, count the tasks occurring each day, day by day, until the count reaches the sum of the child Actual Durations, 5d:

Day1: Task T2 occurs on that day, which adds 1d to the count. The count is now 1d. 

Day2: Tasks T1, T2 and T3 occur that day, which adds 3d more to the count, so the count is now 4d. 

Day3: Tasks T1 and T3 occur that day. However, there is only 1d remaining before the count matches the sum or the child Actual Durations, 5d. So the remaining 1d of count has to be divided among T1 and T3. That means that only half of Day3 is needed for the count to reach 5d. So the Summary Progress date must be the middle of Day3.

The summary task % Complete in the picture above is calculated as follows:

Summary task total % Complete 

= (Sum of child Actual Durations) divided by (Sum of child total Durations)

= (4d +0d + 0d + 0d + 1d) / (5d + 2d + 2d + 4d + 2d) = 5d / 15d = 33 %

The summary task Actual Duration is then calculated as follows:

Summary Actual Duration

= (Summary % Complete) times (Summary Duration)

= (33%) times (11d) = 3.63d

Calculations Involving Summary Task Total and Timephased % Complete

Summary tasks can have both totaled and timephased % Complete values. These values are calculated when various values for the child tasks change. In addition, you can edit summary task total % Complete and have it calculate % Complete for the child tasks.

Summary task has total and timephased % Complete...

[image: image988.png]6% 26% 1%

0% 20%
[EY

8% 1% 5%




Calculating summary task total and timephased % Complete from child tasks

The total % Complete of a summary task equals the sum of the Actual Durations of the child tasks divided by the sum of the Durations of the child tasks.
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The timephased % Complete for a specific period for a summary task is the sum of the child timephased Actual Durations for that period divided by the sum of the total Durations of the child tasks. 
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The child timephased Actual Duration in the previous formula is not an exposed field. The timephased Actual Duration of a child task for a specific period equals the timephased % Complete of the child task for that period (which is exposed) times the total Duration of the child task.
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Note that the summary Actual Duration does not appear in the previous  formulas. It is calculated separately as summary task % Complete times summary task Duration, but plays no direct role in the timephased calculations.

Example

The example illustrates how the summary task total and timephased % Complete values are calculated from the child tasks.
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· Summary task total % Complete 

= (Sum of child Actual Durations) divided by (Sum of child total Durations)


= (4d + 2d + 1d) divided by (8d + 4d + 4d)


= 7d / 16d


= 43.75 %


= 44% (rounded)





· Summary task timephased % Complete values

Before computing the three Summary task timephased % Complete values shown previously, the child timephased Actual Durations for each period should be calculated. This timephased field cannot be displayed.

Task T1: For Day1, 2, and 3, take the corresponding timephased % Complete values 30%, 20%, and 0% and multiply by the total Duration of 8d. That results in timephased Actual Durations of 2.4d = 30% of 8d, 1.6d = 20% of 8d, and 0d = 0% of 8d.

Using the same technique for task T2 and task T3 gives the following grid of timephased Actual Durations (remember these cannot be displayed).


Day1
Day2
Day3

Child task T1
2.4d
1.6d
0d

Child task T2
0d
2d
0d

Child task T3
0.2d
0.6d
0.2d

Sum of child timephased Actual Durations
2.6d
4.2d
0.2d

Finally, for each day, the sum of the child timephased Actual Durations  can be divided by the sum of the child total Durations, 8d + 4d +4d = 16d, to get the summary task timephased % Complete for that day. For example, for Day1

Summary task timephased % Complete for Day1

= (Sum of child Actual Durations for Day1) divided by 

 (Sum of child total Durations)

= 2.6d / 16d

= 16.25%

= 16 % (rounded)

Note that the distribution of the work and Actual Work of the tasks and any resources working on them is irrelevant in the summary task total and timephased % Complete calculations. For example, here's one of the many possible sets of assignments that produce the data used in this example:

Possible schedule to produce the data in this example...
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Calculating child task total and timephased % Complete when the summary task % Complete is edited

If you edit the total % Complete for a summary task, any previous edits to timephased % Complete for child tasks is lost. The new total % Complete for the child tasks, and the new timephased % Complete for the child tasks and summary task, is computed as follows:

5. Sum of child Actual Durations can be solved from the formula for Summary task total % Complete in the previous section:
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Solving for Sum of child Actual Durations gives:

Sum of child Actual Durations

= (Summary task total % Complete) times (Sum of child total Durations)

6. The next step is to mark off timephased Actual Duration from left to right on all child tasks as they are encountered. Minute by minute from the start of the summary task, mark off 1 minute of Actual Duration for any child tasks scheduled during that minute, until the Sum of child Actual Durations is used up. Every child task is treated equally during this process. All that differentiates how much Actual Duration each child gets is its location and span. When this process is completed, all the progress bars on all child tasks should end at the same time, except for the ones that finish earlier and are 100%.

7. Next, for each period and each child, Child timephased % Complete for the period can be solved from the formula for Child timephased Actual Duration for the period in the previous section:
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Solving for Child timephased % Complete gives

Child timephased % Complete for the period

= (Child timephased Actual Duration for the period) 

  Divided by the (Child total Duration)

8. Finally, the summary task timephased % Complete can be calculated from the child timephased % Complete values as discussed in the previous section.

Example

This example illustrates how edits to summary task total % Complete are distributed to child timephased % Complete.

The Summary Progress bar was added to the Gantt Bar Styles as defined:

Bar Styles definitions for summary and summary progress bars...
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A. 
The picture that follows shows the original tasks before the summary total % Complete is entered.

Before entering summary total % Complete...
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B. 
Next, 80% is entered in the % Complete column for the summary task.

After entering 80% for the summary total % Complete...
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Here are the calculations that occurred...
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Here's the corresponding Task Usage view...
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How the timephased % Completes were calculated:

Sum of child Actual Durations

= (Summary task total % Complete) times (Sum of child total Durations)

= 80% times 5d

= 4d

The 4d is distributed across the child tasks as they are encountered, yielding the timephased Actual Durations that follow:


Day1
Day2
Day3

Child task T1
0d
1d
0d

Child task T2
1d
1d
0d

Child task T3
0d
1d
0d

Sum of child timephased Actual Durations
1d
3d
0d

For each child and for each day, you can divide its timephased Actual Duration by its total Duration to get its timephased % Complete, as follows:


Day1
Day2
Day3

Child task T1
0d /1d = 0%
1d / 1d = 100%
0d / 1d = 0%

Child task T2
1d / 2d = 50%
1d /2d = 50%
0d / 2d = 0%

Child task T3
0d /2d = 0%
1d / 2d = 50 %
0d / 2d = 0%

Sum of child timephased Actual Durations
1d
3d
0d

Finally, for each day, the summary task timephased % Complete is computed from the formula in the previous section.

Day1:

Summary task timephased % Complete for Day2

= (Sum of child Actual Durations for Day2) divided by 

 (Sum of child total Durations)

= 1d / 5d

= 20%

Day2:

Summary task timephased % Complete for Day2

= (Sum of child Actual Durations for Day2) divided by 

 (Sum of child total Durations)

= 3d / 5d

= 60%

Day3:

Summary task timephased % Complete for Day2

= (Sum of child Actual Durations for Day2) divided by 

 (Sum of child total Durations)

= 0d / 5d

= 0%

Progress Lines

A progress line is a new Gantt Chart feature in Microsoft Project 98 that provides a visual representation of project progress. 

The line starts just below the timescale at a specified progress date and runs down the screen connecting progress point markers on those tasks that have them, forming a zig zag line, sometimes referred to as a lightening bolt line. The progress point for a task is determined by the task timephased cumulative % Complete for the progress date. No markers are drawn for a task if the cumulative % complete of a task is zero on the progress date, even if the task has progress starting farther to the right. 

Example

This example illustrates the main features of Progress Lines. In this example, the progress date is the Status Date, and the Tools Options Calculation tab option, Edits to total task % Complete will be spread to the Status date, is selected. Total task % Complete is entered for various tasks. The '... spread to the Status date' option caused task timephased Cumulative % Complete to build up before or on the Status Date.  Progress points to the right of the progress date indicate tasks that are ahead of schedule. Progress points to the left of the progress date indicate tasks that are behind schedule. This is one of the more useful ways to use Progress Lines.

New Progress Line feature...
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Multiple Progress Lines

Many Progress Lines can be displayed simultaneously. The options on where to display Progress Lines include the following:

· Display one of the Progress Lines at the Current Date or Status Date.

· Display custom Progress Lines at arbitrary date that you specify.

· Display recurring Progress Lines at regular recurring dates where you specify the pattern, like every Friday.

Each Progress Line has its own set of progress points determined by the value of each task Cumulative % Complete on the progress date for that Progress Line.

Custom and recurring Progress Lines are discussed in detail later.

Actual versus Baseline

You can also specify whether progress points should be drawn relative to the Start and Finish fields or the Baseline Start and Baseline Finish fields. This is discussed in detail later.

Usefulness of Progress Lines

Any Microsoft Project settings or edits that effect timephased % Complete will also effect timephased Cumulative % Complete, and so will effect how the Progress Lines are drawn and how you interpret them. In the most common cases, progress points drawn to the left of the Progress Date indicate tasks that are behind schedule, and progress points to the right of the progress date indicate tasks that are ahead of schedule. On the other hand, Microsoft Project allows you to make completely arbitrary edits to timephased % Complete if you wish. That can make the interpretation of the corresponding Progress Lines a private matter. How to interpret Progress Lines is discussed in detail later.

Setting Progress Dates and Formatting Progress Lines

The Progress Lines dialog is where you select the progress dates and where you control the format of Progress Lines and how they are drawn.

You can display the Progress Lines dialog by selecting the Progress Lines command on the Tools Tracking submenu or the Gantt shortcut menu, or by double-clicking an existing Progress Line on the Gantt Chart.

Tools Tracking Progress Lines submenu command 
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Gantt Shortcut menu

Progress Lines command ...
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The Progress Lines dialog contains the following two tabs:

· The Dates and Intervals tab is where you turn Progress Lines on and off and specify the progress dates where they are drawn. 

· The Line Styles tab is where you indicate the visual style of the Progress Lines.

Progress Lines can only be displayed in Gantt views, and all Progress Line settings are on a view-by-view basis. When you accesses the Progress Lines dialog to turn on the display of Progress Lines and set various attributes, everything applies only to the current view.

Dates and Intervals tab in the Progress Lines dialog, 

There are three categories of Progress Lines that can be displayed and they are controlled in the Dates and Intervals tab by the three-checkbox frames. Each checkbox enables or disables all of the controls associated with that particular category and each category can be turned on and off independently of the others. 

The picture that follows shows the Progress Lines dialog with all checkboxes selected for clarity, but by default, all three checkboxes are initially unchecked and Progress Lines are not drawn.

Progress Lines dialog, Dates and Intervals tab determines WHERE to draw Progress Lines (the four sections are circled)...
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Current Date and Status Date Progress Lines

In the top left frame of the Dates and Intervals tab, the Always display current Progress Line checkbox controls two options for automatically displaying a Progress Line representing the most recent state of the project. Checking this checkbox enables the At project Status Date and At Current Date sub options. The default is the At project Status Date option.

Depending on whether the At project Status Date or At Current Date option is selected, then the corresponding progress date is set to the Status Date or Current Date setting from the Project Information dialog (accessible from the Tools menu). This progress date dynamically changes if the Status Date or Current Date setting changes. The Progress Line is drawn at the progress date. By default, the Status Date field in the Project Information dialog is NA. Any option in Microsoft Project that depends on the Status Date will use the Current Date automatically if the Status Date is NA. 

If the At project Status Date is selected when you click the OK in the Progress Lines dialog, and if the Status Date is NA, the following alert is displayed:
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Displaying Progress Lines at custom dates

In the top right frame of the Dates and Intervals tab, the Display selected Progress Lines checkbox controls whether or not to display Progress Lines for the custom dates that you can enter in the Progress Line Dates list. The list is empty by default, and you must select the Display selected Progress Lines checkbox before dates can be added or deleted from the list.

You can enter up to 1024 dates in the Progress Line Dates. You can enter dates or click a cell and use the dropdown date-picker control . The date picker control is the dropdown arrow that is displayed in the right end of the cell when you click the cell. You can type in the date in any format that Microsoft Project normally accepts. However, but the date is always converted to the ddd_mm_dd_yy. It is arranged according to the international settings in the Control Panel, meaning that there are no times shown in the grid, since Progress Lines are always drawn at the end of the day and cannot be displayed at a finer granularity. If you close and the reopen the Progress Lines dialog, any custom dates you enter in the list will be automatically sorted in descending order.

When you uncheck the Display selected Progress Lines checkbox after entering dates in the Progress Line Dates list you see that it does not have any affect on the listed dates, but they are not used to draw Progress Lines.

If the Status/Current Date Progress Line is on the same day as a custom, then only the Status/Current Date Progress Line is drawn for that day. Custom Progress Lines can be drawn to the right of the Status/Current date.

Example

The Status Date and custom Progress Lines are enabled in this example. The Status Date is 6/4. The picture on the left that follows shows custom progress dates 6/2, 6/4, and 6/5. The picture on the right shows that on 6/4, the Status Date line is drawn instead of the custom Progress Line.

Custom Progress Lines and the Status Date Progress Line...
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The Add Progress Line toolbar button

You can also create custom date Progress Lines using the new Add Progress Line button on the Tracking Toolbar. Pressing it does not bring up the Progress Lines dialog, but instead provides a point and click way to create a custom date Progress Line.

 This button is active in the Gantt views and is used to draw a Progress Line at a date determined by pointing and clicking.
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When the Add Progress Line button is pressed, the mouse cursor changes to the Progress Line cursor. The button remains down until you click the Gantt chart, press the ESC key, or click anything outside of the Gantt pane. 
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Once you move the Progress Line cursor over the Gantt chart, Microsoft Project displays a Gantt Tip showing the date that the Progress Line will be drawn if you click at that point in the Gantt chart:
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If you move the cursor over the Gantt Tip, the tip box moves out of the way. When you click the Gantt chart, a Progress Line is drawn at the specified date and the cursor returns to normal.

The Display selected Progress Lines checkbox in the Progress Lines dialog is automatically selected, and; 

The date is added to the list of custom Progress Line Dates in the Display selected Progress Lines section of the Progress Lines dialog, and the Display selected Progress Lines checkbox is automatically checked. This causes any other custom progress dates in the list to be displayed too. 

Displaying Progress Lines at Recurring Intervals

In the lower left frame of the Dates and Intervals tab, the Display Progress Lines at recurring intervals checkbox controls the display of Progress Lines at regular intervals throughout the project. While unchecked, everything is disabled:

Checking the Display Progress Lines at recurring intervals checkbox enables the all of the controls in that frame. The Weekly option and begin at Project start options are selected by default:

The middle frame title changes to match the Daily, Weekly, or Monthly options selected above it. The middle frame is similar to the Daily/Weekly/Monthly/Yearly frame in the Recurring Task dialog, except that there is no Yearly option for Progress Lines, and the default choices are different, and there are some additional choices in the dropdown lists. Weekly is the default. 

If Daily is selected, then by default, every is selected in the dropdown, and the Workday option is selected.
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If Weekly is selected, the default in the dropdown is “every,” but all of the day checkboxes are initially unchecked. You must select a day of the week or an Alert is displayed when you click OK
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The default is the The option and the defaults for the three associated dropdowns are “last,” “workday’” and “every.” The second dropdown for this option (the one with “workday”) has three additional entries in the list in addition to the names of the days of the week that are in the respective Recurring Task dropdown. The new entries are “day,” “workday,” and “nonworking day.” They are used to specify formats like “the last workday of the month.”

The Day option defaults are “1” for the spin control and every for the dropdown.
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Note: All of the dropdowns in the Progress Lines dialog that contain the choice every also contain the choices for every other, every 3rd,..., every 12th.

The Begin at option at the bottom left defaults to Project start and the date picker is disabled. If you want to start displaying recurring Progress Lines at a different point than the beginning of the project, you can choose the date option, which enables the date picker. 

Regardless of the start date, the end date for a set of recurring Progress Lines is always the project Status Date or the Current Date if the Status Date is NA. 

If the Status/Current Date Progress Line is on the same day as the last recurring Progress Line, then only the Status/Current Date Progress Line is drawn for that day. Recurring Progress Lines cannot be drawn to the right of the Status/Current date.

Unlike recurring tasks, if the recurring Progress Line settings result in progress dates that are non-working days, the progress dates are not moved to working time. The Progress Lines always are drawn on exactly the dates specified by the settings. In the case where some progress dates may not exist (for example, if you specify “Day 31 of every month”), those dates are ignored when the Progress Lines are drawn.

Example

The picture that follows shows weekly Progress Lines every Friday from 6/6/97 to the Status Date of 6/27/97. Since the Status Date Progress Line is also being drawn and happens to be a Friday too, it is drawn instead of the last recurring Progress Line on 6/27/97.

Weekly recurring Progress Lines and the Status Date Progress Line...
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Progress Lines Relative to Actual or Baseline

The frame labeled Display Progress Lines in relation to in the bottom right corner of the Progress Lines dialog, Dates and Intervals tab is where you can specify whether progress points should be drawn relative to the Start and Finish fields or the Baseline Start and Baseline Finish fields. 

[image: image1015.png]Display progress lines in relation to
@ actual plan  Baseline plan




The two options are Actual plan and Baseline plan. 

· If you select the Actual plan option, then the progress points are drawn relative to the Start and Finish fields. This is the default setting.

· If you select the Baseline plan option, then the progress points are drawn relative to the Baseline Start and Baseline Finish fields.

All three kinds of Progress Lines (Status/Current Date, Recurring, and Custom) are affected by the above options.

Regardless of which option you choose, the percentage that controls horizontal position of the progress point is based on the task timephased Cumulative % Complete value on the progress date for the Progress Line.

Drawing progress points relative to the Baseline Start and Baseline Finish fields requires the following additional condition:

The task must have at least one assignment at the time the baseline is saved for the selected task or the entire project.

If the above condition is not met by a task, then no progress points are drawn for that task. In that case, it is not enough to assign a resource to the task. You then have to save the baseline for that task or the entire project, even if it was already saved previously.

Also, it is not enough to type baseline information into baseline fields in a task table. You must save the baseline with the Tools Tracking submenu Save Baseline command. This is because the Timephased Baseline Information would not be set.  This information is needed for all Earned Value calculations.

Once the baseline is saved for the task, any changes to the baseline fields or assignments have no affect on the Progress Lines until you save the baseline again.

Example

This example illustrates the difference between displaying progress points relative to the Start and Finish fields or the Baseline Start and Baseline Finish fields.

The Tools Options Calculation tab option, Edits to total task % complete will be spread to the Status date, is selected in this example.

The first picture that follows shows some Custom Bar Style definitions used in the example. Baseline bar will be displayed in bar row 2.
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A. 
In the Gantt picture that follows, the baseline has not been saved yet and the % Complete not entered yet. The Progress Line dialog options are set to display the Status Date Progress Line for the Actual plan.

Status date Progress Line displayed for the Actual plan...
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B. 
Next, the Display Progress Lines in relation to option is changed to Baseline plan, but since the baseline has not been saved, it does not draw a progress point for the task. Note that typing dates into the Baseline Start and Baseline Finish fields will not cause the progress point to be displayed.

Progress Line changed to use Baseline plan (not saved yet)...
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C. 
Next, the Tools Tracking Save Baseline command is used to save the baseline for the task (or entire project). That causes the progress point to be displayed.

Progress Line drawn using the Baseline dates...

[image: image1019.png]% | St. |Fin. | B.St. | B.Fin.

641 |62 |63 |64

65 |6/ |67 |63 |69 |

o 62 6 62

o5





D. 
Next, the scheduled task bar (upper bar) is dragged to the right, its Duration increased, and 75% entered for % Complete. Notice that progress set on the scheduled task is reflected proportionately in the positioning of the progress marker along the Duration of the of the baseline bar.

Scheduled % Complete effects the baseline progress point...
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E. 
Next, the predefined Tracking Gantt view is applied and the settings in the Progress Lines dialog are adjusted to match the ones above. These settings are saved independently with each view.

Tracking Gantt showing Progress Lines using the baseline plan...
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F. 
Next original custom Gantt view is applied again and the Display Progress Lines in relation to option is changed back to Actual plan.

Setting changed to show Actual plan...
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Progress Lines and Gantt Bar Styles

Whether or not Progress Lines and progress points are displayed is independent of Gantt Bar Styles. Even if there are no Gantt bar styles defined in the Bar Styles dialog, Progress Lines and progress points can still be displayed. Progress points drawn where no bars exist are called floating progress points.

Bar Styles can affect the vertical placement of a progress point on a task. The Bar Styles dialog has a Row column that can be used to display up to four separate bar rows for each task. In addition, many style definitions can use the same bar Row value.

If a task satisfies the Show For condition for two or more bar styles that are From Start To Finish, then Microsoft Project determines on which style it should draw the progress point, using the following rules:

1. Examine all From Start To Finish bar style definitions whose conditions are satisfied by the task. If no conditions are satisfied, then draw the progress point in bar Row 1.

2. Sort these bar style definitions by the Row column (this is a calculation, it doesn't really sort them in the dialog).

3. Of these, find the one that has the lowest value in the Row column. If there is a tie, then use the bar definition farther down the list.

Example

This example illustrates which bar progress points are drawn on if there is more than one bar style defined From Start To Finish. 

The first picture that follows shows some custom Bar Style definitions that use Flag fields in the Show For column. Note that the definitions are not in the same order as the Row column. Bar Styles 2 and 4 both have a 1 in the Row column.
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A. 
In the Gantt picture that follows, task T1 satisfies all four-style conditions. Both bar styles 2 and 4 had a 1 in the Row column in the above picture. The progress marker is drawn using style 4 instead of 2, because style 4 comes farther down the bar style definition list. The fact that style 2 is an upper half bar and style 4 is a lower half bar is irrelevant.

Progress point displayed on Bar Style 4...
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B. 
Task T2 doesn't satisfy the style 4 Show For condition (Flag4), so the progress point is drawn on style 2.

Progress point displayed on Bar Style 2...
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C. 
Task T3 doesn't satisfy style 2 or 4 Show For conditions (Flag2, Flag4), so bar style definitions that have a 2 in the bar style definition Row column are examined next. Style 3 is the only one that has a 2 there, so the progress point is drawn on the bar with style 3.

Progress point displayed on Bar Style 3...
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D. 
Task T4 doesn't satisfy any of the style Show For conditions, so the progress point is drawn in bar Row 1 by default.

Progress point displayed in bar Row 1.
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Line Styles tab in the Progress Lines dialog

The Line Styles tab in the Progress Lines dialog provides a number of options that control 

the following:

· The style of the Progress Lines (Progress Line type options).

· The pattern and color of the Progress Lines.

· The shape and color of the progress point markers.

· Whether dates should be displayed, and if so, the date format.

Progress Lines dialog, Line Styles tab determines type and format of lines and date labels ...
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Progress Line type 

The Progress Line type section contains four options for how the Progress Line is drawn. The four graph types do not have names. Select the desired graph type by clicking the image. The upper left type is the default.

The two choices on the left are lightening bolt variations. After connecting to one progress point, the line comes back to the progress date before heading out to connect to another bar.

The two choices on the right are connect-the-dot variations. After connecting to progress point, the line heads directly to the next one without being required to go back to the progress date first. 

Example

The four pictures that follow show each of the line types applied to the same sample project. The pictures are arranged in the same order as the line types
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Line Style

In the Line style section, there are two sets of identical controls for setting the line attributes of Progress Lines. 

· The Current Progress Line section formatting applies to the Status Date or Current Date Progress Line that is displayed when Always display current Progress Line is checked in the Dates and Intervals tab. 

· The All other Progress Lines section refers to recurring and custom progress dates defined in the Dates and Intervals tab. Note that there is no way to independently format individual custom Progress Lines, or to format custom Progress Lines differently than recurring Progress Lines.

The settings allow you to control the line color and type (dashed, solid, and so on) and to control the color and symbol used for progress points. The default for the current Progress Line is a solid red line with a red circled diamond progress point. The default for the other Progress Lines is a black solid line with no progress point symbol.

The two Line color dropdowns are the standard 16 color Project dropdowns, such as the one in the Gridlines dialog.

Date Display

The Date display section includes the Show date for each Progress Line option, which controls whether or not date labels should be displayed under the timescale at the beginning of each Progress Line. This is not selected by default.
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Checking the Show date for each Progress Line checkbox enables the Format dropdown and Change Font button. The dates are displayed in small boxes with white backgrounds that are placed over the lines where the Progress Line intersects the timescale:

Progress Line with date label...
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The date box border and the date font are the same color as the Progress Line.

The font is initially set to Arial 8 point. You can change the font and the font size using the Change Font button to display the Font dialog. This is like the dialog that the Format Font menu command displays, except that the Color control is hidden since the font color is always based on the line color and cannot be set independently.

When the date box is displayed it positions two pixels to follow the timescale. The horizontal position depends on the graph type. 

· For the lightening-style graph, the date box is always centered right at the progress date. 

· For the connect-the-dots-style graph, the date box is centered at the progress date at the very top of the Gantt. Once you scroll down the date box remains centered over the line itself. So it moves back and forth along the timescale during scrolling. When printed, the date box appears at the top of every page at the point where each line crosses the timescale.

If there is a task bar on the first row, the date box is just drawn on top of it. If many Progress Lines are being displayed, then the date boxes may overlap each other. Nothing is done to position  the dates to try to avoid this.  Each date box is positioned according to the above rules for its own associated Progress Line.

Example

The sequence of pictures that follows illustrates how the date box for the connect-the-dots line type slides horizontally as you scroll vertically.

Before scrolling vertically ...
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Sequence of vertical scrolling pictures ...
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Progress Line Drawing Calculations

This section discusses the details of how progress points are calculated and some special cases that might arise.

Filtering and Sorting

Progress Lines are based only on visible tasks in the order that they are displayed. When you change the active filter or re-sort the tasks the Progress Lines are redrawn.

Progress Line Z-ordering

Progress Lines are always drawn in front of visible bars, link lines, and nonworking time shading. The only items that draw in front of Progress Lines are the gridlines for Current Date, Status Date, Project Start and Project Finish. Drawing objects cover everything, including Progress Lines, unless you use the Format Drawing, Send to Back command.

When date labels are displayed, they are drawn at the same level as the Progress Lines.

How to Calculate Progress Points

The calculation

The location of a progress point for a task is determined as follows:

· For a non-summary task

The task timephased cumulative percent complete on the progress date is used to proportionally locate the progress point from the start of the task, considering only working time. For example, if the cumulative percent complete on the progress date is 43%, the progress point is 43% of the way across the bar (taking nonworking time into account). 

· For a summary task

The progress point is calculated as follows:

1.
For each child, take its Cumulative % Complete on the Status date times its Duration. Keep a running sum of these results across all the child tasks.

2.
Minute by minute, move left to right from the start of the task. Keep a running count of how many tasks scheduled working time that minute. When the count of minutes is equivalent to the sum in step 1 above, that date is the progress point for the summary task.

Please note: This is the same algorithm used to calculate the new Bar Styles From/To Summary Progress date, except that the Summary Progress date uses the full % Complete of each child. The calculation of the Progress Line's progress point for a summary task uses only each child Cumulative % Complete values on the Status date. When computing the progress point, any % Complete to the right of the Status date is ignored. If the Cumulative % Complete of all child tasks on the Status date is the same as the full % Complete of the child task, then the Progress Line's progress point for the summary task is the same as its Summary Progress date. For example, the Progress Line crosses right at the end of the From Actual Start To Summary Progress bar.

See the section Calculating Summary Progress dates for more information.

New Bar Styles From/To Summary Progress choice...
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The Summary Progress field is only accessible in the Bar Styles dialog. It is not exposed anywhere else. You cannot insert it into a task table or in the details of a Task Usage view.

Affects of the '... spread to the Status date' setting, and edits to timephased values

Since a Progress Line's progress points (where it crosses the tasks) depend heavily on the Cumulative % Complete values of the child tasks on the Status date, then in order to meaningfully interpret Progress Lines, you should adhere to the following rule: 

For normal Progress Line behavior, the Tools Options Calculation tab option, Edits to total task % complete will be spread to the Status date, should be selected, and timephased % Complete should not be edited.

The reason that the above rule gives the best results is that when you enter total % Complete for tasks, the timephased % Complete will be distributed to the left or on the Status date. This allows the Progress Lines to be drawn to the right for a task that has a % Complete and a Start date after the Status date. If the Edits to total task % complete will be spread to the Status date, is not selected, then when you enter task % Complete, the % Complete can extend to the right of the Status date and the progress points won't be drawn any farther right than the Status date.

Note: Changing the 'Edits ... spread to the Status date' setting has no affect on existing progress points or timephased % Complete. It only affects new changes that you make. If you change the setting hoping to "correct" your Progress Lines, then you will have to change each task's % Complete (to any value different from the current value) and then change it back to the its original value.

Regardless of the 'Edits ... spread to the Status date' setting, if you choose to edit timephased % Complete yourself, then the interpretation of the Progress Lines depends completely on which dates you entered the values. Microsoft Project allows you to enter timephased % Complete on any dates, even outside of the task. If you make completely arbitrary edits to timephased % Complete, then it is impossible to interpret the resulting Progress Lines in any meaningful way.

Example

This example illustrates the affect of the Edits to total task % complete will be spread to the Status date setting on Progress Lines and progress points. All the Gantt Charts in this example use the Bar Style definitions shown in the picture that follows. 

Bar Styles used in this example...
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All parts in this example begin with the same project, the only difference being the 'Edits ... spread to the Status date' setting and how % Complete is entered. The Status date is set to 6/6/97 in all three parts.

Original project used by all parts of this example...
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A. 
In this part, the 'Edits ... spread to the Status date' option is selected and then values are entered for the % Complete for child tasks T1 and T2. 

The two pictures that follow show the resulting Progress Lines in the Gantt Chart, and the corresponding timephased % Complete values in the Task Usage (it is possible to display the Cumulative % Complete in a Task Usage view, but only the % Complete is displayed in this example).

% Complete of T1 and T2 edited while '... spread to Status date' is selected...
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Corresponding Task Usage showing timephased % Complete...
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Because the 'Edits ... spread to the Status date' setting is selected before the % Complete values are entered, the 25% entered for T1 automatically spreads from the Start of T1 to the Status date of 6/6. Since the Start of T2 is already past the Status date, the 50% entered for it  piles up right on the Status date. 

On the Status date of 6/6 the Cumulative % Complete is 25% for T1 and 50% for T2. The Cumulative % Complete is used to draw locate their progress points (the circled diamonds). The Summary task does not use the Cumulative % Complete. Its progress point is at the end of the Summary Progress bar.

How summary % Complete and Summary Progress dates are calculated is discussed in another section.

B. 
In this part, the 'Edits ... spread to the Status date' option is not selected when values are entered for the % Complete for child tasks T1 and T2. 

The two pictures that follow show the resulting Progress Lines in the Gantt Chart, and the corresponding timephased % Complete values in the Task Usage.

% Complete of T1 and T2 edited while '...spread to Status date' is not selected...
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Because the 'Edits...spread to the Status date' setting is not selected before the % Complete values are entered, the 25% entered for T1 is automatically spread from the Start of T1 according to its scheduled Duration (25% of 4d is 1d). The Status date is ignored. Likewise, the 50% entered for T2 is  automatically spread from the Start of T2 according to its scheduled Duration (50% of 4d is 2d). 

On the Status date of 6/6 the Cumulative % Complete is 25% for T1 and 0% for T2 (its values are farther to the right). The progress point for T1 is 25% of the way across  and the progress point for T2 is not drawn at all. Progress points are not drawn for tasks to the right of the Status date if they have 0% Cumulative % Complete on the Status date.

The Summary task does not use the Cumulative % Complete. Instead its progress point is based on the distribution of the total child Actual Duration to the left of the Status date. The summary task is drawn at the end of where the Summary Progress bar would have been if the T2 had no Actual Duration. In this case it is based only on the 1d Actual Duration of T1. 

How summary % Complete and Summary Progress dates are calculated is discussed in another section.

C. 
In this part, the 'Edits ... spread to the Status date' option is irrelevant because timephased % Complete values are entered directly instead of task total % Complete values.

The two pictures that follow show the edited timephased % Complete values in the Task Usage and the resulting Progress Lines in the Gantt Chart.

Timephased % Complete of T1 and T2 edited...
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This time no progress point marker is drawn because it has 0% Cumulative % Complete on the Status date. The 25% timephased % Complete was entered on 6/8, to the right of the Status date 6/6. The fact that T1 is located to the left of the Status date is irrelevant. The calculation is looking at the Cumulative % Complete on the Status date. If it is zero, then no progress point is drawn.

Task T2 has Cumulative % Complete of 50% on the Status date because the 50% timephased % Complete was entered on 6/5, to the left of the Status date. So the progress marker is placed half way across T2.

As for the summary progress point, only Actual Duration corresponding to the Cumulative % Complete on the Status date is involved in the calculation. T1 contributes 0d (0% Cumulative % Complete on the Status date times 4d), and T2 contributes 2d (50% Cumulative % Complete on the Status date times 4d). The progress point on the summary task is then drawn at the end of where the Summary Progress bar would have been if T1 had no Actual Duration.

Split Tasks

Progress points for split tasks are computed relative to the sum of the Duration of the task parts. Gaps are accounted for and jumped when the location of progress points is measured off.

The progress points are also independent of the Format Layout Show bar splits setting 

Example

This example illustrates how progress points are drawn relative to the scheduled parts of a split task, and the effect of the Show bar splits setting.

Show bar splits is selected...
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Show bar splits is not selected...
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Excessive Calculation Time Alert

With the ability to specify recurring Progress Lines as well as up to 1024 custom lines, the calculation time involved may become very long, and you will not have control again until all the lines are drawn. If you specify a large number of lies in the Progress Lines dialog and click OK, Microsoft Project displays the following alert if it decides that the calculation time may be excessive:
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Microsoft Project does not compute and display an estimate of how long it will take, only that it may task several minutes. The point where the calculation time becomes unreasonable is dependent on a number of factors such as processor speed, number of tasks, number of Progress Lines, and so on. The decision algorithm is complex and is not publicly available. 

Pressing Cancel returns you to the Dates and Intervals tab of the Progress Lines dialog.

If you press OK in the Alert message, Microsoft Project proceeds calculating and drawing all the lines. You cannot regain control until all drawing is complete. If you proceed with the calculation and then later open the Progress Lines dialog and click OK, the alert is not displayed unless you have added at least 3 more lines. In addition, the alert is never displayed when adding a Progress Line with the mouse.

Printing Progress Lines

Progress Lines are printed as they appear on screen.

Progress Lines can be defined on dates outside of the project start to finish range. If the All option is specified in the Timescale section of the Print dialog, then the print timescale range is automatically expanded, if needed, to include all progress dates for displayed Progress Lines. The expanded print start and end dates are not automatically displayed in the Dates From/To settings. You can always select the Dates From/To option and specify a different date range. Progress Lines outside of the specified dates are clipped or discarded.

Timescale options in the Print dialog...
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Lesson 6.1 - Exercises

1.
In order for edits to task or assignment Actual Work to have an effect on the task total % Complete, what option has to be selected in Microsoft Project 98? This option (with slightly different wording) was also available in Microsoft Project 95. Did it behave the same in Microsoft Project 95 as it does in Microsoft Project 98?

2.
Where in Microsoft Project 98 do you set the Status date?

3.
What features in Microsoft Project 98 make use of the Status date?

4.
If you leave the Status date set to NA, some features that would have used the Status date will use some other date field instead. What date field?

Are there any features that cause an alert when they are applied while the Status date is set to NA?

5.
Assuming the Updating task status updates resource status option is selected, does the scheduled work contour of a task and the total task Actual Work uniquely determine the task Actual Duration, or do you need to know the Actual Work contours of the individual assignments?

6.
If the Edits to total task % complete will be spread to the status date option is selected, what happens when you enter a % Complete value for a task? What if the option is not selected?

7.
Assuming the Updating task status updates resource status option is selected, if you edit the total % Complete of a task, does it cause all of the task's assignments to have timephased actual work through the same date except possibly those assignments that end earlier?  I. e. are the assignments all statused through the same date?

8.
If you enter a total % Complete for a summary task, does it cause the standard progress bars of all child tasks to end on the same date except possibly tasks that end earlier?  I. e. are all the child tasks statused through the same date?

9. 
When you enter a timephased % Complete value for a task, does it always fill in Actual Work at the same date that you entered the timephased % Complete? 

10.
Assuming the Status date is not NA, what is always true about the timephased BCWP, BCWS, or ACWP for dates greater than the Status date?

11. 
In Microsoft Project 95 the ACWP column in the Earned Value table was just the Actual Cost field with the title changed to ACWP, so ACWP meant exactly the same thing as Actual Cost. Is the task ACWP always the same as task Actual Cost in Microsoft Project 98?

12. 
What new From/To item in the Gantt Chart Bar Styles dialog makes it possible to define an improved progress bar for summary tasks? What predefined view in the More Views list uses such a summary progress bar?

13. 
How can you display the Progress Line dialog?

14. 
What are the different ways that progress line dates can be defined?

15. 
When using progress lines, which of the following are recommended guidelines? (There may be more than one correct answer):

A. The Edits to total task % Complete will be spread to the status date option should be selected.

B. Task timephased % Complete should be edited instead of editing task total % Complete.

C. The Status date should always be set equal to the Project Start date.

D. Calculations should always be left on manual.

16. 
What determines the date at which a progress line crosses a nonsummary task?

17. 
Suppose that you have been statusing tasks by editing only the total task % Complete, but the progress line never points to the right of the progress date even though you have some tasks with progress bars to the right of the progress date.  An example of this situation is shown in the picture below:

Why doesn't the progress line cross task T2?
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What is the most likely cause for progress lines not crossing in-progress tasks to the right of the progress date?

18. 
Can you enter timephased % Complete outside of the task dates?

Lesson 6.1 - Lab

1.
The project shown in the picture below starts on 6/2/97. Seven cells in the picture have been whited out so you can calculate them yourself. The Duration and Actual Duration of the summary task has been whited out and the % Complete has been whited out for all the tasks. Using the calculations described in this lesson, enter the correct values in the seven whited out cells without using Microsoft Project.
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2. 
If the new summary progress bar were displayed in the above Gantt Chart where would it end?

3.
Create a project based on the data in the above picture and verify that your answers for the seven blank cells are correct. I. e. enter in the five Durations and five Actual Durations and see if the other seven values are calculated as you expected.

4.
Edit the Gantt Chart Bar Styles as shown in the picture below and verify that the summary progress bar ends on the date that you expected.
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5.
Set the Project Status date to 6/6/97 in the Project Information dialog. Use the Tools Tracking Progress Lines submenu command to display the Progress Lines dialog, and select the options to Always display current progress line ... At project status date. Click OK. You should now see a progress line at 6/6/97. The progress line might not cross task T4.

6. 
In the Tools Options Calculation tab, select the Edits to total task % complete will be spread to the status date option and click OK. The progress line still might not cross task T4. To force it to recalculate and cross task T4, change the % Complete on T4 to 0% and then back to 100%. The progress line should now cross T4 too.

Lesson 6.2: Costing

Some Topics to be introduced in this lesson include:

· Fixed Costs

· Actual Costs

· Cost Per Use

· Cost Rate Tables

Cost Rate Tables

In Microsoft Project 4.x, each resource had one Standard Rate that did not vary over time. That rate applied to all of its assignments.

In Microsoft Project 98, each resource has five Cost Rate Tables, labeled A through E. In each rate table, you can define up to 25 custom time specific rates (a cost rate for a specific date range). For each of the resource's assignments, you can choose one of that resource's five rate tables.

Cost rate tables can be customized in the Resource Information dialog Costs tab as shown in the example that follows:

Resource Information dialog...
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Note that the Resource Sheet field, Cost per Use, is labeled Per Use Cost in the Resource Information Cost tab.

Rate Tables and the Resource Rate Fields

The Resource Standard Rate, Overtime Rate, and Cost Per Use fields, as listed in a resource table, have a two-way link to the row in the resource's Rate Table A that corresponds to the current date (in the Project Information dialog). As the current date changes, the rates listed in the Resource Sheet change to match the appropriate row in the resource's Rate Table A. Edits to values in the resource's Rate Table A that correspond to the current date affect the rates listed in the Resource Sheet.

In the above picture, the Current date (in the Project Information dialog) is earlier than 8/1/97. The resource sheet shows the rates from Rate Table A relative to the current date. Since the current date is earlier than 8/1/97, rates from the first row of Rate Table A are listed in the Resource Sheet. When the current date changes to 8/1/97, the Resource Sheet will list the rates from the second row of Rate Table A.

Default Resource Cost Rate Tables

When a resource is created, it is given the default standard and overtime rates as defined in the Tools Options General tab. This default rate only affects cost rate table A for the resource. The other cost rate tables, B through E, have their first line of rates set to zero.


Bottom of the Tools Options General tab...
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Rate information in the Resource Sheet view is linked to the row in rate table A, which corresponds to the current date.

When you assign a resource to a task, the assignment uses rate table A by default.

Editing Rate Tables

Each of the rate tables for a resource in the Resource Information dialog Costs tab consists of up to 25 sets (for example, rows) of date and cost rate fields.

The default display for the grid is blank, except for the first row. For Rate Table A, the default first row corresponds to the Standard Rate, Overtime Rate, and Cost Per Use fields as viewed in the Resource Sheet. For Rate Tables B-E, the first row defaults to $0.00.

In the first row of a rate table, the Effective Date column always has "--" and cannot be edited. The other three fields can be edited. You cannot delete the first row.

All other rows in the rate table can be edited or deleted.

Editing the Effective Date

The Effective Date column in a rate table specifies the date on which the new rates in that row take effect. You can type in dates or use the date picker control to edit the Effective Date. It uses the Tools Options dialog View tab Date Format setting. 

If you enter dates out of order, they are automatically sorted the next time the dialog is displayed. If you enter duplicate dates in the Effective Date column, the following alert is displayed when you OK the dialog:
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Default Values

If you enter some values in a row (other than the first row) in a rate table but leave some rates blank, they get their values from the row above.

If you enter some values in a row in a rate table but leave the Effective Date blank, it uses the Effective Date from the row above, plus one year later, but not past the end of Project time, 12/31/2049.

Selecting, Copying, Pasting 

Selections

You can select a cell or block of cells, whole rows, whole columns or the whole grid, the same way you can in a spread sheet, except that discontiguous blocks are not supported (no support for control+click).
Cut, Copy, and Paste

You can use the keyboard to cut, copy or paste (Ctrl+X, Ctrl+C, and Ctrl+V) data within or between Rate Tables for the same resource while the dialog remains open. In particular, copied data is not saved to the Clipboard, so you can't copy rate table data and paste it outside of the dialog, or copy data outside of the dialog and paste it into a rate table.

You can paste a cell or block of cells, whole rows, whole columns or the whole grid within or between rate tables while the dialog remains open. Data is pasted into those cells where the data is the correct data type. Invalid data types are ignored without an Alert.

Insert and Delete

You can insert a blank row into the grid using the Insert key. If you attempt to insert a row before the first row of the grid, then the following Alert is displayed:
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You can also delete any row except the first row using the Delete key. No Alert is given if you attempt to delete the first row.

Deleting a Cell Value

If you try to enter a blank in a specific cell, then the previous value is simply reassigned. 

Using Percent to Enter a Rate

In addition to entering a numeric value for a rate, you can enter a positive or negative percentage change, which converts to a rate when you press the Enter key or move out of the cell. The percentage is converted to a rate as follows: The new rate is 100% plus the entered percentage multiplied by the rate in the corresponding cell in the row above.

Instructions at the bottom of the Resource Information Costs tab...
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Example

Type 50% for Std. Rate...   
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Press the Enter key...

[image: image1061.png]Effective Date
$10.000
6/14{97. 15.00/h





Press the Down key...
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The ability to enter a percent change is a shortcut for entering a rate value. The percentage you enter is not remembered once it has been converted. There is no permanent link to the cell above the one in which the percentage was entered. 

Cells cannot be linked

Changing the value in one cell in the grid has no affect on any existing values in other cells.

Resource Cost Accrual Setting

At the bottom of the Resource Information dialog Costs tab is the Cost accrual setting:
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Do not confuse the resource Cost Accrual setting  with the Task Fixed Cost Accrual setting. They are completely independent.

The resource Cost Accrual control behaves the same as it does in Microsoft Project 4.x, as does most of its functionality, with some minor changes to account for variable rates. 

If the resource costs accrue at Start or End, the total cost of the assignment is still calculated using all of the appropriate time specific rates across the span of the assignment, instead of using only the rate at the Start or End. However, the resulting cost accrues at the Start or End of the assignment. In the Task Usage view timephased Cost field, the full cost of the assignment is displayed at the Start or End of the assignment.

Note that the accrual of cost is relative to the assignment, not the task. For example, if the assignment does not begin when the task begins, then accrue at start means the start of the assignment, not the start of the task.

Example

This example illustrates how timephased Cost distributes for variable resource rates and different accrual settings.


Rate Table A used in this example ...
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The resource R is assigned to the task T, using Rate Table A as shown in the preceding example.

The pictures that follow show the distribution of timephased Cost for the three different resource accrual settings. Note that in all three cases, the total Cost of the assignment is the same.

Cost accrued at the Start of the assignment...
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Cost prorated across assignment...
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Cost accrued at the End of the assignment...
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Per Use Cost

As with Standard and Overtime rates, Per Use Cost rates can vary over time and can be accrued at start, end, or prorated. However, the Per Use Cost in effect at the start of the assignment is the cost that is used. 

For example, if a 10d task from 5/1/95 to 5/12/95 has R1 assigned to it, and R1 has a per use cost of $100 on 5/1/95 and a per use cost of $200 on 5/12/95, then the cost will be $100 regardless of the accrual setting.

Resource Pools

If a resource pool is shared by multiple projects and the projects have different current dates, then the current date used for calculations is the current date in the project that is being edited.

Example

Project1 and Project 2 share a common pool. Project1 has a current date of 3/1/96, Project2 has a current date of 5/1/96, and the pool has a current date of 7/1/96. Resource1 is in the pool, has the following variable rates:

Effective Date
Standard Rate
Overtime Rate
Per Use Cost

--
$10.00/h
$15.00/h
$20.00

3/1/96
$11.00/h
$16.50/h
$20.00

5/1/96
$12.10/h
$16.50/h
$20.00

7/1/96
$12.10/h
$16.50/h
$20.00

If you edit the Resource Sheet in Project1 and change the standard rate to $11.50, then the variable rates become:

Effective Date
Standard Rate
Overtime Rate
Per Use Cost

--
$10.00/h
$15.00/h
$20.00

3/1/96
$11.50/h
$16.50/h
$20.00

5/1/96
$12.10/h
$16.50/h
$20.00

7/1/96
$12.10/h
$16.50/h
$20.00

If instead you edit the Resource Sheet in the pool and change the overtime rate to $20/h, then the variable rates become:

Effective Date
Standard Rate
Overtime Rate
Per Use Cost

--
$10.00/h
$15.00/h
$20.00

3/1/96
$11.50/h
$16.50/h
$20.00

5/1/96
$12.10/h
$16.50/h
$20.00

7/1/96
$12.10/h
$20.00/h
$20.00

Printing the Variable Costs 

The Cost Rate Tables can only print as part of a Resource Report. The Resource Report dialog Details tab contains a new Cost Rates checkbox that allows you to print the Cost Rate Tables.

Resource Report dialog Details tab...

[image: image1071.png]Defintion Detail | sort
— e
I~ hotes I Notes
I~ Obiects I schecle _coel |
I~ Calendar I~ cost.
I Cost Rates I work e |

¥ order around details
7 rdines between detais

I Show totals




The Resource Information dialog Cost tab always displays rates using the single letter abbreviations, such as $20/h. However, the Resource Report displays the rates using the format specified in the Tools Options dialog Edit tab.

An extra column, titled End Date, is added to the report to make it easier to interpret.

The font and size used for the table header and the column headings are the same as other “chunks” printed, such as the Calendar chunk.

Example

In this example, only Rate Table A for resource R1 is edited. Rate tables A through E contain the default zero values. The picture that follows shows only the part of the report containing rate tables A and B. All the rate tables would print out on the actual report. 

Resource Report with Cost Rates option selected...
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Specifying a Cost Rate Table for an Assignment

You can define up to 5 different Cost Rate Tables, labeled A through E, for each resource in the Resource Information Cost tab.

When a resource is assigned to a task, rate table A is used by default. To change which rate table is used for a specific assignment do either of the following:

· Insert the Cost Rate Table column in a table in a Usage view and use the cell dropdown to choose a rate table for the assignment.

· Display the Assignment Information for an assignment by double-clicking the assignment record in a Usage view, or by clicking Assignment Information on the Project menu or the assignment shortcut menu. Then select a rate table from the Cost Rate Table dropdown at the bottom of the Assignment Information dialog General tab.

The picture that follows shows the result of double-clicking an assignment record in the Task Usage view. The picture shows the Cost Rate Table column as well.

Double-clicking assignment in Task Usage displays the Assignment Information dialog...
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Note that when you double-click a resource name in an assignment record in a Task Usage view, it displays the Assignment Information dialog. If you double-click a resource name in the Resource Sheet, it displays the Resource Information dialog.

Prorating Fixed Cost

In Microsoft Project 4.x, the Fixed Cost is incurred when the task is 100% complete. 

In Microsoft Project 98, the Fixed Cost can be prorated over the task Duration. Fixed Cost is prorated by default rather than by accruing at the End. 

Default Fixed Cost Accrual

You can change the default Fixed Cost accrual on a per project basis. The Default fixed cost accrual setting in the Tools Options Calculation tab allows you to set the default Fixed Cost accrual for all new tasks in the project, and the Set as Default button changes the default setting for new projects.

New setting in Tools Options Calculation tab...
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The field has three values: Start, Prorated and End. The default value is prorated after Microsoft Project is installed. When you change the value, all new tasks created after the setting is changed have their Fixed Cost accrual property set to the default value.

Fixed Cost Accrual setting for individual tasks

The task Fixed Cost Accrual field allows you to set the Fixed Cost accrual for each task independently. This field is in the default task Cost table.

From the default task Cost table...
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Accrual Choices

· Start: The entire Fixed Cost is allocated at the beginning (first minute) of the task. It is added to the Actual Cost as soon as there is an Actual Start date. 

· End: The entire Fixed Cost is allocated at the end (last minute) of the task. It t is added to the Actual Cost as soon as there is an Actual Finish date.

· Prorated: The Fixed Cost is uniformly allocated over all project calendar working days within the task, including over split task gaps, and regardless of resource calendars.

These settings also affect the way the task timephased Fixed Cost is distributed in the Task Usage view.

Example

This example illustrates how timephased Fixed Cost is distributed for the different accrual types. In each of the pictures, the Gantt Chart view is in the top pane, and the Task Usage view is in the bottom pane, formatted to show timephased Fixed Cost.

The task has a split gap on Thu, and is not scheduled on the project calendar nonworking days Sat and Sun. Note that the Fixed Cost in the prorated example includes the split gap in the calculation, spreading the $10 over 4 days instead of the 3d task Duration

Accrue from Start
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Accrue from End
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Prorated Fixed Cost Contribution to Actual Cost

There is no separate Actual Fixed Cost field. 

When Fixed Cost is prorated, the % Complete of each task is used to calculate the portion of Fixed Cost to be added to Actual Cost for the task. 

Actual Fixed Cost = Total Fixed Cost * % Complete 
Importing Old Microsoft Project Files

Microsoft Project 4.x files do not have Fixed Cost accrual information. When a Microsoft Project 4.x project is opened, the project default accrual type and the accrual type of all tasks are set to accrue at End. 

Actual Cost Calculations

In Microsoft Project 98 you have the option to edit task and assignment total and timephased Actual Cost. There are two new settings in the Tools Options dialog Calculation tab that affect Actual Cost calculations:

Tools Options dialog Calculation tab settings effecting Actual Cost...
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Setting calculation to manual has no impact on this feature. 

The 'Actual costs are always calculated by Microsoft Project' option

This checkbox setting is selected by default. It is a local setting and is saved with each individual project file. The Set as Default button can be used to change the default settings for new projects.

If this option is not selected:

If this option is not selected, then Microsoft Project does not calculate task and assignment total and timephased Actual Cost (for example, when you change % Complete or Actual Work). Also, you can edit task and assignment total and timephased Actual Cost. 

Microsoft Project still calculates remaining costs based on the normal calculations of remaining work times resource rates. Microsoft Project continues to roll up entered Actual Cost values appropriately from assignments to tasks and resources, and from child tasks to summary tasks.

You can use the option, Edits to total Actual Cost will be spread to the status date, to control how timephased Actual Cost is distributed when you edit task or assignment total Actual Cost.

If this option is selected:

If this option is selected then Microsoft Project calculates task and assignment total and timephased Actual Cost and you cannot edit them. 

The option, Edits to total Actual Cost will be spread to the status date, does not apply and is inaccessible (grayed out). Also, the Updating task status updates resource status option plays a role in this case. If it is selected then edits to % Complete affect Actual Work, which in turn affects Actual Cost.

How changing the option effects existing data.

Changing the Actual costs are always calculated by Microsoft Project setting has the following effect on existing Actual Cost data:

Changing the setting from on to off (selected to unselected)

If the setting is currently on, then any existing Actual Cost data is calculated by Microsoft Project. If you then unselect the setting, existing data is unchanged, and you are allowed to start editing Actual Costs.

Changing the setting from off to on (selected to unselected)

If the setting is off, then any existing Actual Cost data was either calculated by Microsoft Project earlier when the setting was on, or is data that you entered. If you then select the setting, all existing Actual Cost is thrown out and Microsoft Project recalculates Actual Costs.

Alert displayed when you specify that Microsoft Project should calculate Actual Cost...
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The 'Edits to total Actual Cost will be spread to the status date' option

When the Actual costs are always calculated by Microsoft Project is not selected, then you can use the Edits to total Actual Cost will be spread to the status date option to control how edits to task or assignment total Actual Cost is distributed across time. Detailed calculations are discussed in the next section.

The Edits to total Actual Cost will be spread to the status date option controls the timephased distribution of Actual Cost when you edit total Actual Cost in a way similar to how the Edits to total task % complete will be spread to the status date option controls the timephased distribution of % Complete when you edit total task % Complete. One difference is that Actual Cost applies to tasks and assignments, whereas % Complete is a task field only. 

The rest of this lesson assumes that the 'Actual costs are always calculated by Microsoft Project' option is not selected, unless specified otherwise.

How changing the option effects existing data

When you change the Edits to total Actual Cost will be spread to the status date setting, no change takes place  until you enter total Actual Cost again.

How changes to total Actual Cost are distributed across time

If the "Edits to total Actual Cost will be spread to the status date" option is not selected:

If there are no timephased edits to Actual Cost, and if you edit the total Actual Cost, then it is spread between the task and assignment Start and Stop date.

When you increase task or assignment total Actual Cost and the current Stop date is later than the latest date of existing entered or calculated timephased Actual Cost, then the increase in the total Actual Cost spreads between the latest date with calculated or entered Actual Cost and the task or assignment current Stop date. However, if the current Stop date is earlier or the same as the latest date with calculated or entered Actual Cost, then the total Actual Cost spreads between the task or assignment Start and Stop dates, overwriting existing actuals.

If you decrease task or assignment total Actual Cost, then it is spread between the task or assignment Start and Stop dates, ignoring existing values.

If the "Edits to total Actual Cost will be spread to the status date" option is selected:

If there are no timephased edits to Actual Cost and you edit the total Actual Cost, then it is spread between the task and assignment Start and the Status date (as defined in the Project Information dialog). 

If you increase task or assignment total Actual Cost, and the Status date is later than the latest date with Actual Cost, then the increase in Actual Cost is spread between the latest date with Actual Cost and the Status date. However, if the Status date is earlier or the same as the latest date with Actual Cost, then the total Actual Cost is spread between the task or assignment Start and the Status date, ignoring existing values.

If you decrease task or assignment total Actual Cost, then it is spread between the task or assignment Start and the Status date, ignoring existing values. 

In all cases, if the Status date is before the task or assignment Start date, then the total Actual Cost occurs on the Status date.

Example

This example illustrates the impacts of the Actual costs are always calculated by Microsoft Project option and the Edits to total Actual Cost will be spread to the status date option. All parts of the example involve the resource R assigned to the 4d task T. The resource has a Standard Rate of $10.00/hour. The Task Usage view is shown in each picture.

A. 
Initially, the Actual costs are always calculated by Microsoft Project option is not selected, and the Edits to total Actual Cost will be spread to the status date option is not selected. No actuals have been entered yet.

Before entering actuals...
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B. 
Next, 16h is entered for the assignment total Actual Work. Microsoft Project is now only calculating timephased Actual Cost corresponding to the for the Remaining Work.

16h entered for the assignment total Actual Work...
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C. 
Next, $150 is entered for the assignment total Actual Cost. Microsoft Project distributes it only over the part of the assignment that has timephased Actual Work, because the Edits to total Actual Cost will be spread to the status date option is not selected. 

$150 entered for the assignment total Actual Cost...
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D. 
Next, $400 is entered for the assignment total Actual Cost. Microsoft Project again distributes it only over the part of the assignment that has timephased Actual Work. 

$400 entered for the assignment total Actual Cost...
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D. 
Next, the Edits to total Actual Cost will be spread to the status date option is selected, and the Status date in the Project Information dialog is set to 6/6/97. 

Then $700 is entered for the assignment total Actual Cost. This time Microsoft Project calculates the amount of the increase, $700 - $400 = $300, and distributes that amount between the previous latest date that had Actual Cost (6/3) and the Status date (6/6). So the $300 increase is spread over 6/4, 6/5, and 6/6, resulting in $100 per day for those three days.

Note that the assignment Finish date is irrelevant. The Actual Cost gets spread to the Status date, which happens to be greater than the assignment Finish in this case.

$300 increase in assignment total Actual Cost spread to the Status date...

[image: image1085.png][ Cost_[ACost [ Awork

$860.00 $700.00

R $860.00

6h|

6n|

Work

Act, Work|

s

Cost

$200.00 $200.00 $180.00 $180.00 $100.00

act, Cost

$200.00'$200.00$100.00 $100.00 $100.00

work

s s wn

Act, Work|

o an

Cost

[$200.00 $200.00 $180.00 $180.00 $100.00

AN Chok

[$200.00 :$200.00  $100.00 :$100.00 $100.00




E. 
Next, $0 is entered for the assignment total Actual Cost.

$0 is entered for the assignment total Actual Cost...
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F. 
Next, $700 is entered again for the assignment total Actual Cost. Now the increase is the full $700. Since there wasn't any previous timephased Actual Cost the $700 is distributed between the Start of the assignment and the Status date. That results in $140 per day for the five days from 6/2 to 6/6.

$700 is entered again for the assignment total Actual Cost...
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G. 
Next, the Actual costs are always calculated by Microsoft Project option is selected, rendering the Edits to total Actual Cost will be spread to the status date option irrelevant.


An Alert is displayed and then timephased Actual Cost is recalculated based on the distribution of Actual Work. Previous edits to Actual Cost are lost. Note that the assignment total Actual Cost is recalculated as $160.00 (8h of Actual Work times $10/h standard rate).

Microsoft Project is calculating all Actual Cost values now....
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Edits to timephased Actual Cost

When you edit the value in a timephased Actual Cost cell, the value is distributed uniformly within the cell as follows:

If there is working time in the cell, the value is distributed only over the working time. For example, if you are using standard working times, and if the timescale is formatted so one cell is one week long, then entering a value for timephased Actual Cost in a cell distributes the value uniformly across the five standard working days within the cell.

If you edit a cell that is entirely non-working, then Microsoft Project spreads it out over the entire elapsed period. For example, if the timescale is formatted so one cell is one week long, and if a resource has a specific non-working day in the resource calendar for a particular cell, then when you enter timephased Actual Cost of $700 in that cell, it is distributed as $100 per day for the 7 elapsed days, and $100/24 for each hour on each of the seven days.

Task Start and Finish not considered

Unlike timephased work edits that take the task start and task finish into consideration, timephased edits to Actual Cost do not depend on whether or not a cell contains the task start and task finish, so you could end up distributing Actual Cost outside of the task. This is consistent with the fact that you are allowed to enter Actual Cost in a cell that is entirely outside the task or that consists entirely of non-working time.

Actual Cost calculations that roll up or down

Edits to assignment total or timephased Actual Cost roll up to the parent task and from there up to parent summary tasks if any.

Edits to task total or timephased Actual Cost roll up to the parent summary tasks if any and also roll down to the assignments if any.

Task total or timephased Actual Cost rolls down to assignments in proportion to total Actual Work on the assignments, or in proportion to the total Work on the assignments if there is no Actual Work. This is true for both total and timephased Actual Cost roll downs. 

The proportion of assignment timephased Actual Work or Work is never used to roll down task total or timephased Actual Cost. This is different from the way task timephased Work rolls down. Assignment timephased Work proportions are used to roll task Work down to assignments.

For example, if there are 3 assignments on a task and only one of the assignments has Actual Work, then any edits to the task Actual Cost are only rolled down to the assignment that has an Actual Work value. If two assignments have Actual Work values, then the task Actual Cost is distributed to those two assignments in proportion to the amount of Actual Work that each has.

Roll down calculations affect only existing assignments at the time of the edit to task Actual Cost. Roll down calculations do not automatically recalculate each time you add a new assignment to a task.

If you remove an assignment that has Actual Cost from a task, the assignment costs roll up again to the task, removing the corresponding assignment Actual Cost from the task. The task ends up with a lower Actual Cost value. An Alert is displayed to warn you that you are about to loose some Actual Cost data.

Summary Actual Costs

You cannot edit the Actual Cost for a summary task.

Remaining Actual Costs

Microsoft Project always calculates the Remaining Cost. This comes from remaining work multiplied by resource cost rates and from task Fixed Costs.

How changing Actual Start effects Actual Cost

If the 'Actual costs are always calculated by Microsoft Project' option is not selected, then Timephased Actual Cost values do not move when the task Actual Start is changed.

If the 'Actual costs are always calculated by Microsoft Project' option is selected, then Timephased Actual Cost values do move when the task Actual Start is changed.

Lesson 6.2 - Exercises

1.
Which of the following makes it possible for a resource to charge different rates for different tasks that occur at the same time? (Choose the best answer)

A. The fact that you can have up to 25 cost rate periods within a given cost rate table.

B. The fact that a resource can have up to 5 cost rate tables and you can choose any of these 5 for each of the resource's assignments.

C. You can type different standard rates directly into the Standard Rate field for assignment records in the Resource Usage view.

2.
Which of the following makes it possible for a resource to charge different rates at different dates for the same task? (Choose the best answer)

A. The fact that you can have up to 25 cost rate periods for each cost rate table.

B. The fact that a resource can have up to 5 cost rate tables and you can choose any of these 5 for each of the resource's assignments.

C. You can type different timephased standard rates directly into the timephased grid for timephased assignment records in the Resource Usage view.

3.
In which dialog and tab can you define cost rate tables for a resource?

4.
In which dialog and tab can you select a cost rate table for an assignment?

5.
How can you print out the cost rate tables?

6.
What new task field in Microsoft Project 98 allows you to specify how task Fixed Cost values are distributed over time? 

How was task Fixed Cost distributed in Microsoft Project 95? 

Is there a timephased Fixed Cost field in Microsoft Project 98?

7.
What option must not be selected if you want to edit Actual Cost?

8.
What option determines how timephased Actual Cost is distributed across time when you edit task or assignment total Actual Cost?

Lesson 6.2 - Lab

1.
Create a project with a task T1 with Duration 4d and assign a resource R1 to task T1. Specify Cost Rate table B for the assignment.

2. 
Edit Cost Rate table B for resource R1 so that R1 charges $10/h the first two days of the assignment and $20/h the last two days of the assignment.

3. 
In the Resource Usage view, display the timephased Cost field and verify that the timephased Cost values on the first two days and last two days agree with R1's Cost Rate table B.

Lesson 6.3: Recurring Tasks Improvements

Some Topics to be introduced in this lesson include:

· Recurring task improvements

Recurring Tasks Improvements

The Recurring task feature in Microsoft Project 98 has nearly the same functionality as it did in Microsoft Project 4.x. Some of the new features specific to Microsoft Project 98 are::

· Recurring Field

Microsoft Project 98 has a new Yes/No read-only task field, called Recurring, that can be used to filter for filter for recurring tasks.

Only recurring tasks and their child tasks have a Yes in the Recurring field.

· Recurring Tasks Default to Do Not Level

Because of the complexity of leveling all the subtasks in a recurring task, by default recurring subtasks are created with a priority of Do Not Level. The task Leveling Can Split and Level Assignments task fields are set to No. This means that all other tasks and assignments are leveled around recurring tasks. 

However, these settings can be changed to allow the subtasks of the recurring task to level.
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Lesson 7.1: Working with Projects in a Database

Some Topics to be introduced in this lesson include:

· Supported Databases

· Loading Microsoft Project 4.0 and 95 Projects That Were Stored in a Database

· Database Permissions

· Ensuring Data Integrity in a Project in a Database

· Precedence for Field Calculations When Importing Data

· Cross-Language Usage and the Text Conversion Tables

Supported Databases

Microsoft Project supports the following databases through ODBC:

· Microsoft Access 8.0

· Oracle Server, version 7.3 server and client

· Microsoft SQL Server 6.5 with Service Pack 3 or later.

Microsoft Project can also make the ODBC connection automatically when writing to and reading from Microsoft Access 8.0 databases if you directly select Microsoft Project Database or Access 97 Database as the file type in the File Open and File Save dialog boxes.

Note:  Saving or loading data is not supported with tables that are linked in Microsoft Access such that the data exists in another application and Microsoft Access is just providing the connection.  To access the data you must actually import it into Microsoft Access or connect to the source directly.

Loading Microsoft Project 4.0 and 95 Projects That Were Stored in a Database

You can open a Microsoft Project 4.0 and 95 project saved to a database in Microsoft Project 98, but if you save the project to a database again, it will be saved with the Microsoft Project 98 database structure.

Updating a Microsoft Project 98 Database for Use with Microsoft Project 98 Service Release 1 (SR-1)

If you created the Microsoft Project database tables in Microsoft Project 98 and have upgraded to the Microsoft Project 98 SR-1 maintenance release, the original tables require some minor additions to enable the full Microsoft Project 98 SR-1 functionality. In addition, you can achieve significant performance gains by upgrading the original tables. If you use Microsoft Project 98 Service Release 1 (SR-1) to save a project to an existing database, Microsoft Project SR-1 will automatically make the necessary upgrades, which consist of adding a column to the Project_Information table, creating several new indexes, and dropping and recreating several indexes with some modifications. If you want to make the upgrades independent of Microsoft Project, then you need to manually execute several SQL statements to add the column and create the index. You can find scripts that perform the necessary actions for each of the primary databases supported by Microsoft Project in the \Valupack\Database directory, on the Microsoft Project 98 SR-1 CD (See MPD98Upd.sql,, SQL98Upd.sql, Ora98Upd.sql).

Note:  Due to compatibility issues, all users must use Microsoft Project 98 SR-1 if you are saving a project to an Oracle Server database.

The following lists the column and index changes in Microsoft Project 98 SR-1.

All formats
New Columns and Indexes:

External_Edit_Flag column added to Project_Information table

I_ProjectName index on Project_Information table

Modified Indexes:

I_Text_Fields index on Text_Fields table

I_Custom_Number_Fields index on Custom_Number_Fields

I_Custom_Duration_Fields index on Custom_Duration_Fields

I_Custom_Date_Fields index on Custom_Date_Fields

Oracle Server
New Indexes:

I_Assignment_Actual_Cost on Assignment_Actual_Cost

I_Assignment_Actual_Exceptions on Assignment_Actual_Exceptions

I_Assignment_Actual_Ovt_Work on Assignment_Actual_Ovt_Work

I_Assignment_Baseline_Cost on Assignment_Baseline_Cost

I_Assignment_Baseline_Work on Assignment_Baseline_Work

I_Assignment_Information_Work on Assignment_Information

I_Assignment_Remaining_Work on Assignment_Remaining_Work

I_Calendars on Calendars

I_Calendar_Exceptions on Calendar_Exceptions

I_Calendar_Working_Times on Calendar_Working_Times

I_Project_Information on Project_Information

I_Reserved_AssignmentPoolInfo on Reserved_AssignmentPoolInfo

I_Reserved_CommandBars on Reserved_CommandBars

I_Reserved_CustomForms on Reserved_CustomForms

I_Reserved_ExternalDataLinks on Reserved_ExternalDataLinks

I_Reserved_Filters on Reserved_Filters

I_Reserved_ImportExportMaps on Reserved_ImportExportMaps

I_Reserved_Reports on Reserved_Reports

I_Reserved_Tables on Reserved_Tables

I_Reserved_V_iews on Reserved_V_iews

I_Resource_Baseline_Cost on Resource_Baseline_Cost

I_Resource_Baseline_Work on Resource_Baseline_Work

I_Resource_Rates on Resource_Rates

I_Task_Baseline_Cost on Task_Baseline_Cost

I_Task_Baseline_Interim_Splits on Task_Baseline_Interim_Splits

I_Task_Baseline_Work on Task_Baseline_Work

I_Task_Dependencies on Task_Dependencies

I_Task_Information on Task_Information

I_Task_Percent_Complete on Task_Percent_Complete

Database Permissions and Configuration

Microsoft Project has three levels of operations it performs on a database, each requiring a corresponding set of object permissions.

To open a project read-only and view projects in a database, the user must have SELECT permission on the tables.

To modify existing projects in a database, save a new project to pre-existing tables in a database, or delete a project from a database, the user must have the following permissions on the tables:  SELECT, INSERT, UPDATE, DELETE.

To save a new project to an empty database, or to selectively import and export data, the user must have the following permissions:  SELECT, INSERT, UPDATE, DELETE, CREATE TABLE, DROP TABLE.

For Oracle Server, in addition to the object privileges above, the user must have the following system privileges.

For read only:

Create session

Create synonym

Execute any procedure

For modifying a project:

Same as for read only

For saving a new project as a new project owner:

Same as for read only, plus

Create table

Appropriate quotas on tablespaces for indexes and for data

Assign the user to the default tablespace

In Microsoft SQL Server, permit the user to the appropriate database(s). The user also must have the following statement privileges.

For read only:

Create a view

For modifying a project:

Same as for read only

For saving a new Project as a new project owner:

Same as for read only, plus

Create table

Save transaction

When Tables and Table Privileges are Created

User privileges to a new project for a new project owner should be granted after the tables are created. The tables are created in two ways:

1. Microsoft Project will create the tables and indexes for you automatically, in the tablespace (for Oracle Server) or database (for Microsoft SQL Server) that the project owner has as the default, if it does not find tables in the database for that owner.

2. Microsoft Project provides scripts that the database administrator can modify as desired for purposes of data and index tuning, and space management. These scripts can be found in the \Valupack\Database directory, on the Microsoft Project 98 SR-1 CD.

Note:  Microsoft Project never grants privileges; these are the prerogative of the database administrator.

Changing a User's Security Level

For all three permission levels above, the user must have the specified permissions on all tables created or accessed by Microsoft Project and at no time should different column-level permissions be used.

To change a user from read-only to allow the user to modify a project, you must change the corresponding database permissions, (INSERT, UPDATE, and DELETE) on all the Microsoft Project tables.

To restrict a user from modifying a project, revoke the insert, update, and delete permissions on all the Microsoft Project tables.

Note:  You should not change permissions for a user in a table from which they have opened project data in Microsoft Project. Ensure that the user does not have any projects open from that table before attempting to change permissions for that user.

If using Oracle Server, Microsoft Project does not support the user ID "internal" for saving and opening projects.

Project Isolation with Multiple Project Owners

It is possible to have multiple projects, for multiple organizations, in the same database, and yet isolate projects from each other. To do this, projects are grouped by project owner.

For example:
AccountingProjectOwner creates AcctProject1 and AcctProject2.


HumanResourcesProjectOwner creates HRProject1…

AccountingProjectOwner grants select on their tables to AcctUser1 and AcctUser2. Without being granted access explicitly to HRProject1, AcctUser1 and AcctUser2 are isolated from project information belonging to Human Resources.

When implementing multiple table owner and multiple UserID access permissions in Oracle Server and Microsoft QL Server, the UserID will require views in Microsoft SQL Server to tables belonging to the other UserID (unless system administrator created the tables and granted the permissions). Each view must be the same name as the table it references.

For Oracle Server, each user must create synonyms referencing the tables belonging to the other UserID. Each synonym must be the same name as the table it references. The read-only and modification privileges are not affected by synonyms.

For databases that support granting privileges on cursors, Microsoft SQL Server requires that the user have execute privileges on keyset-driven cursors, while Oracle Server and other databases require the user to have execute privileges on static cursors.

INIT.ORA Parameters

Oracle Server database administrators must adjust the open_cursors and db_block_buffers of the "INITxxx.ORA" file (xxx is the Oracle SID), depending on the number of simultaneous connections. Each open connection by any user on the server requires the following:

· At least 10 db_block_buffers

For the total number of connections that any single user will open at one time, Microsoft Project will open no more than 34 open cursors for all open projects.

If you are using the same DSN on a machine, all of the open projects through this DSN count as one connection.

Examples:

· For a single user to have simultaneous access to a master project and 19 inserted projects, all through the same DSN, the following minimum settings are required:

open_cursors=34
(i.e., 1 connection * 34)

db_block_buffers=10
(i.e., 1 connection * 10)

· For 5 users to simultaneously open 5 projects each on a server where no user will ever open more than 10 projects at once requires the following minimum settings:

open_cursors=170
(i.e., 5 connections * 34)

db_block_buffers=50
(i.e., 5 connections * 10)

Performance Tuning

For Oracle Server, follow these guidelines to obtain optimal performance.

When setting up the database structure:

· Separate the tables and indexes, because tables are accessed by index values. This separation may be in separate files on the same disk. However, separate files on separate disks is better and multiple disks on a RAID array is best.

· Place data for random index reads.

· Implement your database following the OFA Oracle standards.

· Follow the guidelines for physical file separation of database file placement in the ORACLE Tuning Guide or the ORACLE DBA Handbook from Oracle Press.

· For recovery purposes, use archivelogmode.

· Allow for redo and rollback generation that is normal for updates, and more intense for initial loads and large incremental saves, where up to 34 tables may be created or updated.

Other INIT.ORA values:

· Set the INIT.ORA parameter CURSOR_SPACE_FOR_TIME equal to True if the shared pool is large enough.

· DML_LOCKS should be increased from the default of 4 tables per transaction; the number of tables can be 2 or 3 times greater depending on the options used with Microsoft Project.

· OPEN_CURSORS (see above) should be increased. Microsoft Project uses 34 cursors on an initial load, dropping to about 4 per user per DSN.  The cursors are reused if they go through the same DSN.

· Adjust the DB_BLOCK_BUFFERS as required for the best Hit Ratio performance.

For more information, see Performance Tuning Tips, ORACLE Corporation, ORACLE Tuning Guide, ORACLE Corporation, ORACLE DBA Handbook, Oracle Press, and Advanced ORACLE Tuning and Administration, Oracle Press.

For Microsoft SQL Server, follow these guidelines to obtain optimal performance.

When setting up the database structure:

· Separate the database files, using multiple devices on the same disk, or, more effectively, with different files on different disks, or most effectively physically with a controller per disk, with a RAID array. For more information, see "Chapter 7, Managing Drives" in the Microsoft SQL Server Administrator's Companion, Microsoft Corporation.

· Set the Master database to be 40 MB initially and change it from the default device.

· Set the tempdb database to be 2K per task per concurrent user and on a different device. For example, if 10 users will open a 50-task project, then the tempdb requirement will be 10*50*2K, or 1 MB.

· Set the tempdb log to be about one-third the size of tempdb and on a different device.

· Set the project_data database to be 100 MB and on a different device. Make this device the default device for the table owner.

· Set the project_log on a different device.

· As a general rule, the more memory, the better the performance, so use whatever is left over from the operating system and other applications. Performance Monitor can provide this information.

Other configuration values:

· Increase open objects to 20,000 for a medium-sized project and 30,000 for a large-sized project.

· Increase max_async_io if your hardware requires it.

· Set memory to use available machine memory, as noted above.

· Increase user connections from the default of 20, if needed.

· Leave the procedure cache at the default, and monitor as necessary.

For more information, see Microsoft SQL Server Administrator's Companion, Microsoft Corporation, or Microsoft SQL Server 6.5 DBA Survival Guide, Spenik and Sledge.

Setting the QueryTimeout Property for DAO Connection Objects

For Microsoft Windows 95, if you are using Data Access Objects to access an Oracle Server database, you may need to set the QueryTimeout property to 0. The following Visual Basic for Applications code provides an example of how to set this property:

Sub test()

    Dim dbsProject As Database

    Dim wspDefault As Workspace

    Dim strSQL As String

    Dim rstFromQuery As Recordset

    strSQL = "SELECT Project_Information.ProjectName FROM Project_Information"

    Dim con as Connection

   'Create a default workspace Object

    Set wspDefault = CreateWorkspace("NewSQLWorkspace", "", "", dbUseODBC)

    'Open a connection

    Set dbsProject = wspDefault.OpenConnection("")

    Set con = dbsProject.Connection

    con.QueryTimeout  = 0

    Set rstFromQuery = con.OpenRecordset(strSQL, dbOpenSnapshot)

     ' Display results of queries.

     With rstFromQuery

       Do While Not .EOF

            MsgBox !ProjectName

            .MoveNext

        Loop

        .Close

    End With

End Sub

Ensuring Data Integrity in a Project in a Database

Because Microsoft Project writes to and reads from a certain database structure, some changes to a database may cause corruption to a project in a database and prevent Microsoft Project from opening or saving part or all of the project. The following actions could corrupt a project stored in a database:

· Changing the values of reserved fields and tables.

· Renaming a column or table.

· Deleting a column or table.

· Changing the data type of a column or table to an incompatible data type.

Microsoft Project will perform some data verification when you read a project from a database (or any other external format). The following cases may cause Microsoft Project to display an alert, change data to an appropriate value, or not read the data at all:

· The data type is incompatible. 

· The value is out of range.

· The value would create inconsistencies in a project.

· The value is part of an interdependent mathematical relationship.

· The value is a not editable by the user and always calculated by Microsoft Project.

The data in some Microsoft Project fields is stored in binary format in the Reserved_InternalCompareBits database field. If you make an external change to a value in a Microsoft Project field, while the project is stored in a database, the binary field will contain the original value that was stored when you last saved the project to a database from Microsoft Project.

Microsoft Project will use the information in the Reserved_ExternalChangeData field in the Assignment_Information table, Task_Information table, Resource_Information table, and Task_Dependencies table to help determine which fields have been modified in the database, and these modifications will be preserved if they do not cause one of the above listed conditions.  Information in the following fields will also be stored in binary format in the Reserved_ExternalChangeData field.

Task Fields

% Complete

% Work Complete

Actual Cost

Actual Duration

Actual Finish

Actual Start

Actual Work

Constraint Date

Constraint Type

Cost

Duration

Finish

Fixed Cost

Fixed Cost Accrual

ID

Leveling Delay

Remaining Duration

Remaining Work

Start

Stop

Work

Resource Fields

Accrue At

Available From

Available To

ID

Assignment Fields

Actual Cost

Actual Finish

Actual Overtime Work

Actual Start

Actual Work

Assignment Delay

Assignment Units

Finish

Leveling Delay

Overtime Work

Regular Work

Remaining Overtime Work

Remaining Work

Start

Work

Constraint Fields (in the Task_Dependencies table)

LinkLag

LinkType

Precedence for Field Calculations When Importing Data

When you import data from any source, Microsoft Project will recalculate the fields in the project data based on an order of precedence. If there are inconsistent values in any set of two interdependent fields, Microsoft Project maintains the value in the field with the highest precedence and recalculates the values of the other field. If there are three interdependent fields with inconsistent values, Microsoft Project will maintain the values of the two fields with the highest precedence and recalculate the value of the third.

When opening a full project from a database, Microsoft Project will first verify if any external changes to the data can be preserved by looking at the binary data in the Reserved_ExternalChangeData field. If the data in this field indicates that more than one interdependent value has changed and the new values are not consistent, then the order of the precedence listed below will be used to resolve the inconsistencies.

If the data in an Assignment field and the corresponding Task field is inconsistent, the data in the Assignment field will take precedence.

The order of precedence listed below always applies when you open an entire project from a database with Microsoft Project. If you open only part of a project from a database, there may be other factors that determine which fields take precedence in resolving inconsistencies between interdependent fields.

The order of precedence follows.

Assignment Fields

Actual Start

Actual Finish

Start

Finish

Overtime Work

Work

Actual Work

Remaining Work

Assignment Units

Assignment Delay

Leveling Delay

The order of precedence for the Finish and Start fields is reversed for projects scheduled from a finish date.

Task Fields

Actual Start

Actual Finish

Leveling Delay

Start

Finish

% Complete

Constraint Date

Constraint Type

Work

Actual Work

Remaining Work

Actual Cost

Fixed Cost

Cost

Actual Duration

Duration

Remaining Duration

% Work Complete

Stop

The order of precedence for the Finish and Start fields is reversed for projects scheduled from a finish date.

Cross-Language Usage and the Text Conversion Tables

To enable different language versions of Microsoft Project to read a project in a database, the contents of some fields will be converted to numeric constants. Microsoft Project writes two tables to the database containing the conversion information for those fields, Intl_FieldReferences, which contains the mapping between the enumerated field categories and the field name, and Intl_TextConversions, which contains the mapping between the numeric constants and the possible text values for each field. The following field categories are converted to numeric constants:

Field Category
Fields in this Category
From Table

Weekday 
DayOfWeek 
Calendar_Working_Times 

Schedule Start
ScheduleFrom
Project_Information

Accrual
AccrueAt
Resource_Information


FixedCostAccrual
Task_Information


DefaultFixedCostAccrual 
Project_Information

Link Type
LinkType
Task_Dependencies

Display Units
LinkLagDisplayUnits
Task_Dependencies


DelayDisplayUnits
Assignment_Information


DurationDisplayUnits 
Task_Information


BaselineDurationDisplayUnits
Task_Information


DelayDisplayUnits 
Task_Information


DurationDisplayUnits
Custom_Duration_Fields

Cost Rate Units
StandardRateDisplayUnits
Resource_Information


OvertimeRateDisplayUnits
Resource_Information


StandardRateDisplayUnits
Resource_Rates


OvertimeRateDisplayUnits
Resource_Rates

Work Contour Type
WorkContour 
Assignment_Information

Constraint Type
ConstraintType
Task_Information

Priority
Priority
Task_Information

Task Type
Type
Task_Information


DefaultTaskType
Project_Information

Calendar Working
Working
Calendar_Working_Times


Working
Calendar_Exceptions

Container Type
ContainerType
Custom_Duration_Fields


ContainerType
Custom_Date_Fields


ContainerType
Custom_Number_Fields


ContainerType
Text_Fields

Field ID
FieldID
Text_Fields


FieldID
Custom_Number_Fields


FieldID
Custom_Date_Fields


FieldID
Custom_Duration_Fields

Workgroup Messages
Workgroup
Resource_Information

Currency Symbol Position
CurrencyPosition
Project_Information

The Intl_FieldReferences and Intl_TextConversions tables are described in detail below, under Microsoft Project Database Structure.

In order to read a project from a database saved with a different language version of Microsoft Project, you need to have the correct NLS code page installed. The NLS code page value that Microsoft Project stores in Reserved_NLSCodePage, in the Project_Information table is the NLS (code) page that the language requires. Here are the code page values for each set of languages.

Windows code page
Description

1250
Windows Latin 2 (Central Europe)

1251
Windows Cyrillic (Slavic)

1252
Windows Latin 1 (ANSI)

1253
Windows Greek

1254
Windows Latin 5 (Turkish)

1257
Windows Latin 4 or Baltic

932
Japanese

949
Korean

936
Simplified Chinese

950
Traditional Chinese

1200
Unicode (UTF-8)

If you selectively save partial project data to a database, Microsoft Project will create the Intl_FieldReferences and Intl_TextConversions tables in the database, if they do not already exist in the database. It will not create them if they do exist.

Microsoft Project uses English for the names of the fields and tables in the database, in each language version. If you change the name of a table in a database you will likely corrupt the database, and Microsoft Project will not be able to read that table, and perhaps the entire project.

Lesson 7.2: Adding and Changing Records in the Database

Some Topics to be introduced in this lesson include:

· Creating the Microsoft Project Database (MPD) Structure

· Deleting a Project from a Database

· Concurrent Usage and Project Locking

· Creating a New Task, Resource, or Assignment

· Creating Task Dependencies

· Creating a New Project

· Specifying Custom Text, Number, Date, and Duration Fields

· Creating an Inserted Project

· Create (or Modify) a Contour for a Timephased Field

· Creating Splits in Scheduled Work

· Creating a New Calendar and Calendar Exceptions

· Modify Resource Rates

· Create a Recurring Task

· Using the Text Conversion Tables

· Outlining with Summary Tasks and Subtasks

· Edit Work on a Summary Task Assignment

· Reading and Writing Notes Fields in the Database

· Get the Names of Sharer Files

· Retrieve Workgroup Message Status

Working with Microsoft Project Data in the Database

When working with Microsoft Project data in a database, you should always follow the guidelines described in the sections below.

Note  If you make changes to project data in a database directly, or if you create a database for use for Microsoft Project directly instead of creating it using Microsoft Project, you must set the External_Edit_Flag field in the Project_Information table to True (for Microsoft Access or Microsoft SQL Server), or 1 (for Oracle Server).

Microsoft Project Tables

You should never delete any tables created by Microsoft Project, and you should never delete any of the table columns. You also should not change the data type of any database field. A number of tables and fields created by Microsoft Project have names that begin with the word "Reserved." You should never alter these tables or fields in any way.

You may notice that some of the tables Microsoft Project created in the database contain some records with large negative values in the UniqueID field. These records usually appear at the top of a table or at the beginning of each project and the values are -65536, -65535, and -65534. These records are used internally by Microsoft Project and should never be edited or deleted.

If you create the tables yourself (see the section "Creating the Microsoft Project Database (MPD) Structure"), you should never make any of the fields a required field.

Specifying Times with Dates

When you enter a date value directly in the database, you should always include the time with the date. Because database date and time fields use a default time when you don't specify the time, relying on the default can lead to unexpected results. The database fields usually default to 12:00 AM, which is normally nonworking time in most calendars. When Microsoft Project encounters 12:00 AM, it "rounds" the time to the next closest working time for start times and to the last working time for finish times.

Thus, if you specify dates without times, it can result in the following situation: You create what you think is a 5-day task in the database by specifying the task start as Monday's date and the task finish as Friday's date. The Monday time in the database is really Monday at 12:00 AM, so Microsoft Project treats this as Monday 8:00 AM (per the calendar default start time), which works fine. For Friday's time, though, the default is Friday at 12:00 AM, which are rolled back to Thursday at 5:00 PM (the calendar default finish time). Thus, your 5-day task becomes only 4 days when it is read in by Microsoft Project. By explicitly specifying the time in each date/time field, you can always avoid this problem.

Duration Values, Work Values, and Rate Values

Microsoft Project saves all duration and rate fields to two separate fields in the database. The first field is the duration value, work value, or rate value, and the second field is the corresponding DisplayUnits field. If you change the value in a DisplayUnits field in the database, it will have no effect on the value of the corresponding duration, work, rate or cost field, which Microsoft Project saves as absolute values. The DisplayUnits field simply indicates which units label Microsoft Project will use to display the value.

Because duration, work, rate and cost values can be displayed using different units, Microsoft Project saves each using a standard multiple:

· Duration values are saved as minutes * 10. Eight hours would be saved as 4800 (i.e., 8*60*10). 

· Work values are saved as minutes * 1000. Eight hours would be saved as 480000 (i.e., 8*60*1000).

· Rate values are saved as dollars per hour. Fifteen dollars an hour would be saved as 15.

· Cost fields are saved as dollars * 100. Seventy dollars and twenty-five cents would be saved as 7025.

Creating the Microsoft Project Database Structure

If you have a need to create a Microsoft Project database from scratch, the easiest method is to save out an empty project using Microsoft Project and then delete the project from the database with the DeleteFromDatabase method, which will retain the table structure. If you do not want to use Microsoft Project to facilitate the process, you will need to create an empty database through the ODBC driver and then create all of the appropriate tables. Creating all of the tables manually would be an extensive undertaking, as you would need to use this document as a reference and ensure that you have exactly the right table and column names for every table and the correct data types for every field. So, to facilitate table creation, Microsoft Project includes five script files with the SQL statements necessary to set up all of the tables for Microsoft Access, Microsoft SQL Server, or small, medium or large databases with Oracle Server. These script files are called MPDtable.sql, SQLtable.sql, OraTbl_L.sql, OraTbl_M.sql and OraTbl_S.sql, and can be found on the Microsoft Project 98 installation CD in the \Valupack\Database directory.

Note that in all five scripts, the SQL statements that populate the Intl_FieldReferences and Intl_TextConversion tables are for the English conversion values and, therefore, will need to be modified for other languages.

Deleting a Project from a Database 

To delete a project from a database, you can use the DeleteFromDatabase method.  For more information about this method, and other Microsoft Visual Basic for Applications objects, methods and properties, look for the appropriate topic in Microsoft Project 98 VBA Help.

DSN Requirements for Multiple Users and Projects

If multiple users will be accessing project files in the same database, each user making changes to the data must use the same Data Source name (DSN) for connecting to the database. Microsoft Project combines the DSN and project name (in "<DSN>\projectname" format) as the identifier to locate a project. If someone uses a DSN with a different name, it will result in unresolved references for items such as inserted projects, cross-project links, and sharer projects utilizing the same resource pool.

This also applies to projects that are stored in a Microsoft Access database (as an MPD or MDB file).  If multiple users will be modifying the database, then those users should all access the database with a same-named DSN and not do any saves by selecting the MPD or MDB file-type from the "Save as type" list in the File Save dialog.

Because of the way Microsoft Project caches login passwords and other connection information, the same DSN cannot be used by more than one user ID on a single machine for different simultaneous logins to the database.  Once a DSN connection is established, that connection will be reused even if a different login name and/or password is entered at login time.  To login through a different user ID, you must first close all projects opened with the DSN or, for simultaneous connections, you must create additional alternate DSNs to use with each different user ID.

ODBC now supports the use of File DSNs in addition to traditional Machine DSNs, but Microsoft Project does not support the use of File DSNs in any situation where another project is referenced. Whenever Microsoft Project must refer to another project, certain information must be stored to be able to later locate that project. File DSNs do not provide the amount of information that is needed to be able to retrieve a project. Therefore, you should not use File DSNs when using features where other projects are referenced (e.g., project consolidation, cross-project linking, resource sharing links, and OLE links).

Concurrent Usage and Project Locking

If you open a project in a database through Microsoft Project, and that project is not in use by another user, you will be given full read/write access. Until you finish your session with the project, you or any other user will only be able to open that project from that database as read-only.

The read/write access permission and some other properties used in managing concurrent usage are all maintained in a number of fields in the Project_Information table in the database. These project-locking fields are in effect only when users are using Microsoft Project to read or update the database. Microsoft Project does not provide any kind of locking when a database is being read or updated directly by a user using a database program or tool. Thus, any program or tool written to read or update the database should follow the same conventions to ensure consistent data access. Each of the project-locking fields is described below.

If you have the project open with read/write access through Microsoft Project, then Microsoft Project will store a value of "1" in the Project_ReadWrite field. When you finish your session and close the database, the field value will be set to "0" which is the default. You should temporarily set the value of this field to "1" to prevent other users from updating the project through Microsoft Project if you want to make updates to the database directly.

While any users are currently in the process of opening a project read-only from a database through Microsoft Project, Microsoft Project will store in the Reserved_ReadCount field the number of users actively reading in data at that moment.

While Microsoft Project is writing to a database, it will set the value of the Project_Locked field to "1". While this field has a value of "1", the project may not be opened by any user, not even read-only. You can temporarily set the value of this field to "1" to prevent other users from opening a project in the database, but you should not set it unless the Reserved_ReadCount field is at "0" (and you should not modify Reserved_ReadCount yourself). Before you set the Project_Locked field, the Project_ReadWrite field should be set to "1".

Microsoft Project stores a string in the UserMachineID field in the database, which identifies the machine that has the project open with read/write access through Microsoft Project at any one time. If you access the project through a data source name, then Microsoft Project will store a string in the Reserved_DataSourceName field, identifying the data source name.

It's recommended that, after setting Project_ReadWrite to "1", you enter an appropriate string in the UserMachineID field so that any user attempting to open the project through Microsoft Project will get an appropriate message informing them that the project is currently opened for read/write by the correct name, otherwise Microsoft Project can't identify to the user who has the project open for read/write access. The name should be an identifier for the user opening the project, or the program opening the project. When you are ready to allow read/write access to the project again, you should set the UserMachineID field back to a null string right before you reset the Project_ReadWrite field to "0".

Microsoft Project will store the time of the last update to a database in the Reserved_LastUpdateTimestamp field.

If a user has read/write access to a project in a database through Microsoft Project, and another user changes data in that project directly in the database, that change will not be reflected in Microsoft Project for the first user. In addition, if the first user saves project data back to the database, that data will overwrite any changes made directly in the database by the second user.

Creating a New Task

To create a new task in the database, you must add a new record to the Task_Information table and enter values for at least the following fields:

Table
Fields
Notes

Task_Information
ProjectID
Must refer to a valid project in the Project_Information table


TaskUniqueID
Must be unique within the project.


TaskID
Must be unique within the project.


Name
The name of the new task.


Duration
The duration of the new task.

Example:

Assume your current project has 22 tasks with TaskUniqueIDs 1 to 22 and TaskIDs 1 to 22. If you want to create a new 1-week task named "Research Competitors" and you want this task to be the eighth task in the project, you would add the following record to the Task_Information table:

ProjectID
TaskUniqueID
 TaskID
Name
Duration

3
23
8
Research Competitors
24000

Obtain the correct ProjectID from the Project_Information table. For the TaskUniqueID, use 23 because it is the next available number. Set TaskID to 8, to make this task eighth in the list, but this also requires that the TaskIDs of each subsequent record be adjusted by one to make room (since TaskIDs must be unique). So, while not shown here, the original records with TaskIDs 8 to 22 must be renumbered with TaskIDs 9 to 23. Set the Duration to 24000, since one 8-hour day is specified as 4800 in the database and 5*4800=24000.

Creating a New Resource

To create a new resource in the database, you must add a new record to the Resource_Information table and enter values for at least the following fields:

Table
Fields
Notes

Resource_Information
ProjectID
Must refer to a valid project in the Project_Information table


ResourceUniqueID
Must be unique within the project.


ResourceID
Must be unique within the project.


Name
The name of the new resource.

Creating a New Assignment

To create a new assignment in the database, you must add a new record to the Assignment_Information table and make sure certain values are set for the associated task record in the Task_Information table. You must enter values for at least the following fields:

Table
Fields
Notes

Assignment_Information
ProjectID
Must refer to a valid project in the Project_Information table.


AssignmentUniqueID
Must be unique within the project.


TaskUniqueID
Must refer to a valid record for the same ProjectID in the Task_Information table.


ResourceUniqueID
Must refer to a valid record for the same ProjectID in the Resource_Information table.


StartDate
The assignment start date and time.


FinishDate
The assignment finish date and time.

Task_Information
StartDate
The task start date and time.


ConstraintType
The constraint type for the task. The values can be obtained from the ConversionValue field in the Intl_TextConversions table where the FieldValue equals 20 (e.g., As Soon As Possible = 0).

Creating Task Dependencies

To create a new task link dependency in the database, you must add a new record to the Task_Dependencies table and enter values for at least the following fields (which will give you a simple Finish-to-Start link with zero lag):

Table
Fields
Notes

Task_Dependencies
ProjectID
Must refer to a valid project in the Project_Information table.


DependencyUniqueID
Must be unique within the project.


PredecessorTaskUniqueID
Must refer to a valid record for the same ProjectID in the Task_Information table.


SuccessorTaskUniqueID
Must refer to a valid record for the same ProjectID in the Task_Information table.

If you want to specify lag when you create a link, then you must specify both of the following fields:

Table
Fields
Notes

Task_Dependencies
LinkLag
The amount of lag, specified as a duration value (i.e., minutes * 10).


LinkLagDisplayUnits
The value representing the units to use when the LinkLag is displayed inside Microsoft Project. The range of values can be obtained from the ConversionValue field in the records in the Intl_TextConversions table where the FieldType is 9.

Note   It is not possible to create cross-project links in the database; you must create them inside Microsoft Project.

Creating a New Project

To create an entirely new project in the database, you must add a new record to the Project_Information table and create a project summary task in the Task_Information table. You must enter values for at least the fields specified below. Then, to add the associated tasks, resources, and assignments to the project, you must create the task, resource, and assignment records as described above.

Table
Fields
Notes

Project_Information
ProjectID
Must be unique within the table.


ProjectName
Must be unique within the table.


StartDate
The project start date and time.

Task_Information
ProjectID
Specify the same ProjectID value as in the Project_Information table.


TaskUniqueID
This value must be zero for a project summary task.


TaskID
This value must be zero for a project summary task.

Task_Information

Resource_Information

Assignment_Information
[various]
For the specific fields and their values, see the respective sections on creating tasks, resources, and assignments.

Notes

· If you only enter the minimal values specified above when creating a new project in the database, Microsoft Project will display a message upon opening the project that says the Standard calendar is missing. To prevent this warning from being displayed, you must also create a Standard calendar when creating a new project.

· For a new project created in the database, all of the Microsoft Project option settings will default to False, not to the normal Microsoft Project default values. To ensure Microsoft Project behaves in the desired way once the project is opened, all of the option values in the Project_Information table should be set to the desired settings.

Specifying the Value of a Custom Field

Custom flag fields are stored in the database in the respective Task_Information, Resource_Information, and Assignment_Information tables and can be set directly in those tables. All other custom fields are stored in four special tables that are based on the custom field type. To specify the value of a custom field, you must add a new record to the appropriate custom field table and set a corresponding flag in the Project_Information table. To specify custom field values for a project summary task, the procedure is identical, but you must use the special TaskUniqueID of zero.

Specifying Custom Text Fields

You must enter values in the following database fields to specify a custom text field:

Table
Fields
Notes

Text_Fields
ProjectID
This value must refer to a valid project in the Project_Information table.


ContainerType
The ContainerType is 0 for task fields, 1 for resource fields, or 3 for assignment fields.


UniqueID
Depending on the ContainerType, specify the corresponding TaskUniqueID, ResourceUniqueID, or AssignmentUniqueID value of the record for which the custom field is being set.


FieldID
The field identifier of the custom field, which can be obtained from the ConversionValue field in the Intl_TextConversions table.


TextValue
The custom text value.

Project_Information
Text_Field_Set
Set this value to True.

Specifying Custom Number Fields

You must enter values in the following database fields to specify a custom number field:

Table
Fields
Notes

Custom_Number_Fields
ProjectID
This value must refer to a valid project in the Project_Information table.


ContainerType
The ContainerType is 0 for task fields, 1 for resource fields, or 3 for assignment fields.


UniqueID
Depending on the ContainerType, specify the corresponding TaskUniqueID, ResourceUniqueID, or AssignmentUniqueID value of the record for which the custom field is being set.


FieldID
The field identifier of the custom field, which can be obtained from the ConversionValue field in the Intl_TextConversions table.


NumberValue
The custom number value.

Project_Information
Custom_Number_



Field_Set
Set this value to True.

Specifying Custom Date Fields

You must enter values in the following database fields to specify a custom date field:

Table
Fields
Notes

Custom_Date_Fields
ProjectID
This value must refer to a valid project in the Project_Information table.


ContainerType
The ContainerType is 0 for task fields, 1 for resource fields, or 3 for assignment fields.


UniqueID
Depending on the ContainerType, specify the corresponding TaskUniqueID, ResourceUniqueID, or AssignmentUniqueID value of the record for which the custom field is being set.


FieldID
The field identifier of the custom field, which can be obtained from the ConversionValue field in the Intl_TextConversions table.


DateValue
The custom date/time value.

Project_Information
Custom_Date_



Field_Set
Set this value to True.

Specifying Custom Duration Fields

You must enter values in the following database fields to specify a custom duration field:

Table
Fields
Notes

Custom_Duration_Fields
ProjectID
This value must refer to a valid project in the Project_Information table.


ContainerType
The ContainerType is 0 for task fields, 1 for resource fields, or 3 for assignment fields.


UniqueID
Depending on the ContainerType, specify the corresponding TaskUniqueID, ResourceUniqueID, or AssignmentUniqueID value of the record for which the custom field is being set.


FieldID
The field identifier of the custom field, which can be obtained from the ConversionValue field in the Intl_TextConversions table.


DurationValue
The custom duration value.


DurationDisplayUnits
The units to use when displaying this duration in Microsoft Project.

Project_Information
Custom_Duration



Field_Set
Set this value to True.

Example:

Let's say you want to enter the value 226 into the Number3 field for a particular resource that already exists in the database. Assume that the record for the resource in the Resource_Information table includes the following information:

ProjectID
ResourceUniqueID
Name

42
17
Bob

To set the Number3 field for this resource to 226, add the following record to the Custom_Number_Fields table:

ProjectID
ContainerType
UniqueID
FieldID
NumberValue

42
1
17
205521010
226

The ProjectID must match the resource record. The ContainerType is 1 in this case, because we are setting a resource custom field. The UniqueID is taken directly from the ResourceUniqueID field in the Resource_Information table. The FieldID value is taken from the ConversionValue field in the Intl_TextConversion table from the record where the ConversionText field equals "Resource Number3." The NumberValue field contains the actual data.

In order for Microsoft Project to read this record, you must set the Custom_Number_Field_Set flag in the Project_Information table to True.

Specifying Other Task and Resource Text Values

Three text data fields containing task information and three text data fields containing resource information are stored in the Text_Fields table rather than in the respective Task_Information and Resource_Information tables. One task field is SubprojectFile, which is covered in a separate section on creating inserted projects below. The other two task fields are WBS and Contact, and the three resource fields are Code, EmailAddress, and ResourceGroup. These five fields are handled the same way as the custom text fields. You must enter values in the following database fields to specify one of these task or resource fields:

Table
Fields
Notes

Text_Fields
ProjectID
This value must refer to a valid project in the Project_Information table.


ContainerType
The ContainerType is always 0 (task) for the WBS and Contact fields, or 1 (resource) for Code, EmailAddress, or ResourceGroup.


UniqueID
Specify the corresponding TaskUniqueID (for WBS or Contact) or ResourceUniqueID (for Code, EmailAddress, or ResourceGroup) of the record for which the value is being set.


FieldID
Specify the appropriate field identifier (from the ConversionValue field in the Intl_TextConversion table): 

WBS:188743696 

Contact:188743792 

Code:205520906 

EmailAddress:205520931 

ResourceGroup:205520899


TextValue
The string to store in the field.

Project_Information
Text_Field_Set
Set this value to True.

Note:  The only WBS values that are stored internally in Microsoft Project (and, therefore, the only ones that will ever be written out) are WBS values that have been changed from the default values that are automatically assigned by Microsoft Project.

Example:

Let's say you want to enter the values 3.2.4 and 3.2.5 into the WBS fields for two existing tasks in the database. Assume that the records for the tasks in the Task_Information table include the following information:

ProjectID
TaskUniqueID

3
24

3
25

To set the WBS fields for these tasks, the add the following records to the Text_Fields table:

ProjectID
ContainerType
UniqueID
FieldID
TextValue

3

24
188743696
3.2.4

3
0
25
188743696
3.2.5

The ProjectID values must match the Task records. The ContainerType is zero in this case, because we are setting a task text field. The UniqueID values are taken directly from the TaskUniqueID field in the Task_Information table. The FieldID value is taken from the ConversionValue field in the Intl_TextConversion table from the record where the ConversionText field equals "Task WBS." The TextValue field gets the actual WBS strings.

In order for Microsoft Project to read these records, you must set the Text_Field_Set flag in the Project_Information table to True.

Creating an Inserted Project

The process for creating an inserted project in the database is a combination of the procedures for creating a new task and specifying the value of a custom text field. You must add new records to the Task_Information and Text_Fields tables with values for at least the following fields, as well as setting the flag in the Project_Information table:

Table
Fields
Notes

Task_Information
ProjectID
This value must refer to a valid project in the Project_Information table. This is the ID of the master project, not the inserted project.


TaskUniqueID
Must be unique within the master project. This is the unique ID of the inserted project task.


TaskID
Must be unique within the master project. This is the ID of the inserted project task.

Text_Fields
ProjectID
Specify the same ProjectID value as in the Task_Information table.


ContainerType
The ContainerType is always 0 (task) for inserted projects.


UniqueID
Specify the same TaskUniqueID value used for the inserted project task in the Task_Information table.


FieldID
The FieldID is always 188743706 for inserted projects.


TextValue
The full name of the inserted project (i.e., path and filename or database and project name).

Project_Information
Text_Field_Set
Set this value to True.

Example:

Let's say you have two projects stored in a database and you want to make one of them an inserted project of the other. Assume the two projects are in an MPD file that you access with a data source (DSN) called "Projects" and the project names are "Master Project" and "The Subproject." First you need to create a task in Master Project to hold the inserted project. This record in the Task_Information table would appear as follows:

ProjectID
TaskID
TaskUniqueID
Name

1
5
5
My subproject

The TaskID and TaskUniqueID used here are just chosen for demonstration purposes and have no significance. The important issue to remember is that they must be unique among all the IDs for the current project. Once you have this task, you need to specify the name of the inserted project file, and this is done the same as the custom text fields described earlier. This is the record that you need to add to the Text_Fields table:

ProjectID
ContainerType
UniqueID
FieldID
TextValue

1
0
5
188743706
<Projects>\The Subproject

The ProjectID value must match the Task record. The ContainerType is zero in this case, because we are setting a task text field. The UniqueID value is taken directly from the TaskUniqueID field in the Task_Information table. The FieldID value is taken from the ConversionValue field in the Intl_TextConversion table from the record where the ConversionText field equals "Task SubprojectFile." The TextValue field gets the actual project name, which, in this case, is specified in the <DSN>\ProjectName syntax for a project in a database.

In order for Microsoft Project to read this record, you must set the Text_Field_Set flag in the Project_Information table to True.

Creating (or Modifying) an Assignment Remaining Work Contour

To create or modify an assignment remaining work contour, you must add one or more records to the Assignment_Remaining_Work table. Each record represents a segment of the contour with a consistent unit value. When the units change, a new segment is required. The order of the work contour segments is dependent on the actual order of the UniqueIDs. If you add or insert a new segment, it may require renumbering of the existing values in the UniqueID field. Anytime you add or modify a record in a contour table, you must set a bit in the Flags field to indicate that a change has been made.

When the WorkValue and Units are both non-zero, the WorkingDuration field is not required. If either WorkValue or Units is zero, WorkingDuration must contain a value for how much working time the segment covers. Creating a split in an assignment is simply a matter of creating a record with a zero WorkValue and specifying the length of the split in the WorkingDuration field.

To create a new assignment remaining work contour segment, you must enter values for the following fields:

Table
Fields 
Notes

Assignment_Remaining_Work
ProjectID
Must refer to a valid project in the Project_Information table.


UniqueID
A unique ID for this segment of the contour (must be unique within the project). All segments that make up a contour will be ordered by ascending UniqueIDs, so they must be numbered accordingly (sequential numbering is not required).


AssignmentUniqueID
Must refer to a valid record for the same ProjectID in the Assignment_Information table.


FromDate
This field is not read by Microsoft Project, but is a useful reference when setting up a contour.


WorkValue
The total work for this segment of the contour.


Units
The units for this segment of the contour.


WorkingDuration
The duration of this segment if units or work are zero (e.g., specifying the length of a split).


Flags
The second bit of this value must be set (see "Setting the Contour Table Flags" below). If creating a new record, just set the value of this field to 2.

Note:  Contour records are applied on top of calendars to get the actual contour, thus the contour flows around non-working time. This is why there is only one record, for instance, for a task that occurs on Friday and Monday with the weekend off in-between. It is also the reason the FromDate field is for reference only – the real FromDate is calculated based on the calendar and all of the previous segments.

Example:

Assume a project contains the following assignment contours:


Sun
Mon
Tue
Wed
Thu
Fri
Sat
Sun 2
Mon 2
Tue 2

Assignment 6 :

4h
4h
4h
4h






Assignment 8 :



8h
8h
4h


4h


Microsoft Project saves these contours in the database in the Assignment_Remaining_Work table as follows (note that the Row # field is for reference in this example only and does not exist in the database):

Row #
Project ID
Unique ID
Assignment UniqueID
From Date
Work Value
Units
Wrkng Duration
Flags

6-1
3
17
6
Mon 8:00AM
960000
0.5
19200
0

8-1
3
19
8
Wed 8:00AM
960000
1
9600
524288

8-2
3
20
8
Thu 5:00PM
480000
0.5
9600
0

Let's say you now want to modify the first contour to assign 8 hours of work on Tuesday, instead of 4, and in the second contour, you need to create a one-day split on Thursday. First, let's look at the contour for Assignment 6. The modified Assignment_Remaining_Work table records appear as follows (all new and modified values are displayed in bold):

Row #
Project ID
Unique ID
Assignment UniqueID
From Date
Work Value
Units
Wrkng Duration
Flags

6-1
3
17
6
Mon 8:00AM
240000
0.5

2

6-2(new)
3
18
6
Tue 8:00AM
480000
1

2

6-3(new)
3
21
6
Wed 8:00AM
480000
0.5

2

Since the Units value needs to change to 100% on Tuesday, it means a new record (6-2) needs to be added. Furthermore, the insertion of that new record means you need to change the Units back to the previous level on Wednesday. So, you must add another record (6-3), for a total of three records to cover all of Assignment 6. Remember, the FromDate is strictly for reference and will not be read by Microsoft Project.

The WorkValue in 6-1 is reduced to reflect just 4 hours of work and the Flags field bit is set, making that value 2. In 6-2, the UniqueID 18 is used, since it's the next available number. The WorkValue and Units are set to reflect 8 hours on one day and the Flags field bit is set. In 6-3, the Unique ID is set to 21, since 19 and 20 are already in use (by Assignment 8). The WorkValue is set to 8 hours and the Units is set to 50% to make the work occur over two days. Lastly, the 6-3 Flags field bit is set.

For Assignment 8, to add a one-day split on Thursday, the modified Assignment_Remaining_Work table records appear as follows (again, the additions and changes are marked in bold):

Row #
Project ID
Unique ID
Assignment UniqueID
From Date
Work Value
Units
Wrkng Duration
Flags

8-1
3
19
8
Wed 8:00AM
480000
1

524290

8-1a(new)
3
22
8
Thu 8:00AM
0
0
4800
2

8-1b(new)
3
23
8
Fri 8:00AM
480000
1

2

8-2
3
24
8
Mon2 8:00AM
480000
0.5

2

To create the split, a new record (8-1a) with no work must be created for Thursday. This record for the split must specify WorkingDuration for the length of the split (8 hours in this case), since the WorkValue and Units cannot be used in determining the contour. The UniqueID used for 8-1a is 22, since 21 was used above when making Assignment 6 changes. The insertion of record 8-1a means that record 8-1 now represents only one day of work, so its WorkValue must be set to 8 hours. Record 8-1b must be newly created to contain the second day of work at 100% Units that was originally included in 8-1 before the split was inserted. The UniqueID for 8-1b is set to 23, since that's the next available number.

The WorkValue and Units in record 8-2 don't need to change. Because of the split, the start date moves out to after the weekend, so FromDate is updated to make things clear, but it has no effect on the actual contour. Since the UniqueID fields must contain ascending values to specify the order of the segments in the contour, the UniqueID for 8-2 is no longer acceptable and must be changed from its original value of 20 to 24 (or higher). So, the only real change for 8-2 is the UniqueID, but that's enough to require that the Flags bit be set.

In fact, all four Assignment 8 records are new or modified, so the Flags field bit must be set for each one. In 8-1, the Flags value was typical of the sort of large value that Microsoft Project may save out when a number of other bits representing internally used flags have already been set. Regardless of the original value, setting the bit just requires performing an OR with 2.

Creating Splits in Scheduled Work

Creating a split in scheduled work is just a specific case of modifying the assignment remaining work contour such that one segment of the contour does not contain any work. This entails creating a record in the Assignment_Remaining_Work table with zero in WorkValue and the length of the split in WorkingDuration. This is covered in the "Creating (or Modifying) an Assignment Remaining Work Contour" section and example above.

Tasks without resources assigned go into the Assignment_Remaining_Work table as assignments for the Unassigned Resource. Thus, a split created in a task with no assignments will still appear in the Assignment_Remaining_Work table. So, if you are creating a project from scratch in the database and you need to add splits to unassigned tasks, the only difference in this case is that you must use the value -65535 for the ResourceUniqueID on the assignment records, since -65535 is always the unique ID for the Unassigned Resource. 

Note:  In the case of "stop/resume" splits, where the split immediately follows actual work, the split information is stored in the Task_Information table in the Stop and Resume fields, not in the Assignment_Remaining_Work table. Stop/resume splits are often created by leveling, and they can also be created by dragging out the remaining portion of a task that is already marked with a partial percent complete.

Example:

Assume you have an existing 2-day task that has no resource assigned and you want to insert a 3-day split in the middle. The task is originally represented by a single record in the Task_Information table such as the following:

ProjectID
TaskID
TaskUniqueID
Duration
StartDate
FinishDate

6
7
5
9600
Mon 8:00AM
Tue 5:00PM

To create the split, you need to create a contour in the Assignment_Remaining_Work table, which, in turn, relies on having an assignment record in the Assignment_Information table. Since there is no resource assigned to the task, you need to create the assignment under the Unassigned Resource. Because the task already exists in the database, the assignment already exists as well and you just need to reference it, but if you were actually creating everything from scratch, this is the record that would need to be added to the Assignment_Information table:

Project ID
Assignment UniqueID
Task UniqueID
Resource UniqueID
Start Date
Finish Date

6
59
5
-65535
Mon 8:00AM
Fri 5:00PM

The ProjectID is the same as the task record. The AssignmentUniqueID is just a value that is not already in use for this project. The TaskUniqueID value is taken directly from the task record in the Task_Information table. The ResourceUniqueID value is set to -65535 to indicate the Unassigned Resource. The StartDate is the same as the task record, but the FinishDate represents the new finish with the split incorporated (since the assignment takes precedence over the task, changing the FinishDate in the task record is not required).

To create the actual contour and indicate the length and position of the split, these are the records that you need to add to the Assignment_Remaining_Work table:

Project ID
Unique ID
Assignment UniqueID
From Date
Work Value
Units
Working Duration
Flags

6
43
59
Mon 8:00AM
480000
1

2

6
44
59
Tue 8:00AM
0
0
14400
2

6
45
59
Fri 8:00AM
480000
1

2

In all three records, the ProjectID just matches the other tables and the AssignmentUniqueID is taken directly from the record just created in the Assignment_Information table. The sequence of the UniqueIDs determines the ordering of the contour segments, so the three UniqueIDs are chosen such that they are in ascending order and they don't duplicate any others in the project. All three records also need to have the bit in the Flags field set so that they will be read by Microsoft Project.

The first record covers the 8 hours of work on Monday. The second record covers the split, hence the WorkValue and Units are set to zero and the WorkingDuration must contain the value to indicate 3 days. The third record covers the 8 hours of work on Friday.

Creating (or Modifying) an Assignment Actual Work Contour

Creating or modifying an assignment actual work contour is identical to the procedure described above for the remaining work contours, but there is an additional requirement if any of the work occurred during non-working time (e.g., on the weekend). In that case you must add exception records for the non-working time.

When actual work is entered in the Assignment_Actual_Work table, Microsoft Project will decrease the work a complementary amount in the Assignment_Remaining_Work table contours upon reading the data (unless the bit in their Flags field is set, in which case Microsoft Project will retain whatever is in the remaining work contour as well).

Notes

· With exceptions in the Assignment_Actual_Exceptions table, the FromDate and ToDate fields do determine the actual range, so these values must both be entered. UniqueID ordering has no effect.

· It is important to make sure the Units values are correct for each segment of the contour when entering actual work in the database. If Microsoft Project has stored out some actuals, the Units value of the last segment of the contour may appear incorrect because there may have been additional remaining work on the last day. In that case, Microsoft Project sets the Units at a higher value so that any additional remaining work entered will start from the last day with actuals, rather than from the next day (i.e., the first day without actuals). If you add additional actual work contour segments in the database following a record with the inflated Units value, you should first set the Units of that segment to the correct value. By the same token, if you want to have some remaining work appear on the last day of the contour where you already have some actual work entered, you can increase the Units above the normal amount.

Example:

Assume your calendar covers the normal Monday-Friday 8:00 to 5:00 working time and you have a 2-day task that starts on Friday and ends on Monday. Assume also that there is only one resource assigned to this task and he decides to work 4 hours each day on Friday, Saturday, Sunday, and Monday, rather than the scheduled 8 hours each on Friday and Monday. If you want to create records to show the actual work exactly as it occurred, you not only need to create an actual work contour in the Assignment_Actual_Work table, you must also indicate the weekend hours in the Assignment_Actual_Exceptions table. These are the records that you must create in the Assignment_Actual_Work table:

Project ID
Unique ID
Assignment UniqueID
From Date
Work Value
Units
Flags

1
11
20
Fri  8:00AM
240000
0.5
2

1
12
20
Sat 12:00AM
480000
0.1667
2

1
13
20
Mon  8:00AM
240000
0.5
2

This is the exception record that you need to create in the Assignment_Actual_Exceptions table:

ProjectID
UniqueID
Assignment UniqueID
FromDate
ToDate
Flags

1
11
20
Sat 12:00AM
Mon 12:00AM
2

Since the work was evenly distributed on Saturday and Sunday, only one exception record is needed to cover the whole weekend. The FromDate and ToDate fields reflect this range.

In the actual work contour records above, the first and third records cover the 4 hours of actual work on Monday and Friday. The second record covers the 8 hours of actual work for both weekend days. The Units value is set to 16.67% to force 4 hours of actual work to be assigned to each day. The Units is determined by taking the actual work (8 hours) and dividing it by the total exception period (48 hours). Thus, 8 divided by 48 gives .1667 (fractional unit values should be entered to four decimal places to insure accuracy). All the records in both tables need to have the bit in the Flags field set so that they will be read by Microsoft Project.

If the actual work amounts were different on Saturday and Sunday and you wanted to represent them exactly as they occurred, separate actual work contour records would be required for each of the weekend days.

Creating (or Modifying) Cost Contours

To create or modify an assignment actual cost contour, you must add one or more records to the Assignment_Actual_Cost table. In order for Microsoft Project to actually read the cost data, you must set a flag in the Project_Information table that indicates that costs are not to be calculated automatically by Microsoft Project.

Each record in the contour normally represents a segment of the contour with a consistent cost value. When the cost changes, a new segment is required. When creating contour segments itself, Microsoft Project creates records based on how the data was entered -- a database record is created for each timephased value entered – so there may be multiple individual segments for a period even though the costs are uniform. For instance, entering $1000 at the weekly level will result in one record in the cost table, while entering $200 per day over the work week will result in five records in the cost table. In both cases, the cost values displayed inside Microsoft Project are the same, even though they are saved out to the database differently.

The order of cost contour segments is determined by the FromDate and ToDate fields, so segments do not need to be ordered by UniqueID values like work contours. Again, anytime a record in a contour table is added or modified, a bit must be set in the Flags field to indicate that a change has been made.

This information applies to all other cost contour tables as well (Assignment_Baseline_Cost, Resource_Baseline_Cost, Task_Baseline_Cost). Values are required in all of the following fields for each segment of the contour:

Table
Fields
Notes

Assignment_Actual_Cost
ProjectID 
Must refer to a valid project in the Project_Information table.


UniqueID
A unique ID for this segment of the contour (must be unique within the project).


AssignmentUniqueID
Must refer to a valid record for the same ProjectID in the Assignment_Information table.


FromDate
The start of this contour segment.


ToDate
The end of this contour segment.


Cost
The cost for this segment of the contour.


Flags
The second bit of this value must be set (see  "Setting the Contour Table Flags" below). If creating a new record, just set the value of this field to 2.

Project_Information
AutoCalcActualCosts 
This value must be set to False for the data to be read.

Note:  The AssignmentUniqueID field listed above will actually be a different field for some of the other cost contour tables. It will be ResourceUniqueID (from the Resource_Information table) for the Resource_Baseline_Cost table and it will be TaskUniqueID (from the Task_Information table) for the Task_Baseline_Cost table.

Example:

Assume you have a 3-day assignment that starts on Tuesday and you want to enter actual costs of $60.00 on Tuesday and $80.00 on both Wednesday and Thursday. These are the records that must be created in the Assignment_Actual_Cost table:

Project ID
Unique ID
Assignment UniqueID
From Date
To Date
Cost
Flags

1
3
2
Tue 8:00AM
Tue 5:00PM
6000
2

1
4
2
Wed 8:00AM
Thu 5:00PM
16000
2

The FromDate and ToDate fields determine the exact range for each contour segment. Since the first day has a different cost value, it requires a separate segment. Wednesday and Thursday have the same cost value, so one segment can be created for both days with the total cost entered into the Cost field. For Microsoft Project to read these records, the bit must be set in both Flags fields and the AutoCalcActualCosts field in the Project_Information table must be set to False.

Creating (or Modifying) Task Percent Complete Contours

To create or modify a task percent complete contour, you must add one or more records to the Task_Percent_Complete table. Working with percent complete is identical to working with cost contours, except that each record represents a segment of the contour with a consistent percent complete value, rather than cost. When the percent complete changes, a new segment is required. Values are required in all of the following fields for each segment of the contour:

Table
Fields
Notes

Task_Percent_Complete
ProjectID
Must refer to a valid project in the Project_Information table.


UniqueID
A unique ID for this segment of the contour (must be unique within the project).


TaskUniqueID
Must refer to a valid record for the same ProjectID in the Task_Information table.


FromDate
The start of this contour segment.


ToDate
The end of this contour segment.


PercentCompleted
The percent complete for this segment of the contour.


Flags
The second bit of this value must be set (see "Setting the Contour Table Flags" below). If creating a new record, just set the value of this field to 2.

Note:  Percent values are stored in the database as whole numbers from 0 to 100 (i.e., to enter 27% you would just enter the value 27).

Setting the Contour Table Flags

Whenever a record in any of the contour tables in the database is modified, a bit in the Flags field must be set to let Microsoft Project know which records have changed. In most cases, setting the flag should be a simple matter, but the complexity depends on the method used to access the Flags field and whether it needs to be updated directly in the database.

The bit to be set is the second bit from the right (i.e., the twos bit in binary). The simplest case involves retrieving the existing value of the Flags field and performing a bitwise OR operation with the number 2, then substituting the result back into the Flags field. For example, setting a bit can be done in VBA as follows:


Flags = Flags OR 2

If you need to set the flag directly in the database, it can be done via the following SQL statement:


UPDATE <table name> SET Flags = Flags + 2


WHERE <condition to identify record> AND ((Flags - ((Flags / 4) * 4)) <=1)

If the database supports the MOD operator, the above SQL statement can be simplified to:


UPDATE <table name> SET Flags = Flags + 2


WHERE <condition to identify record> AND ((Flags / 2) MOD 2 = 0)

Creating a New Calendar

To create a new calendar in the database, you must add a new record to the Calendars table and enter values for at least the following fields:

Table
Fields
Notes

Calendars
ProjectID
Must refer to a valid project in the Project_Information table.


CalendarUniqueID
Must be unique within the project.


IsBaseCalendar
Set this value to True for new base calendars.


BaseCalendarUniqueID
Specifies the base calendar when IsBaseCalendar is False. Must refer to a valid record for the same ProjectID in this table.


CalendarName
The name of the new calendar.

You are not required to specify working time for the new calendar because working time is determined by the base calendar, or is set to the default for new base calendars. If you want to specify working times, you can add records to the Calendar_Working_Times table with values for at least the following fields:

Table
Fields
Notes

Calendar_Working_Times
ProjectID
Must refer to a valid project in the Project_Information table.


UniqueID
Must be unique within the project.


CalendarUniqueID
Must refer to a valid record for the same ProjectID in the Calendars table.


DayOfWeek
Specify the appropriate DayOfWeek value (from the Intl_TextConversion table):

Sunday: 1
Thursday: 5

Monday: 2
Friday: 6

Tuesday: 3
Saturday: 7

Wednesday: 4


Working
Set this flag to 0 if the day is non-working or 1 if it is working. When set to 1, at least one start and end time must be specified (in the FromTime1/ToTime1 fields). For resource calendars, you can also use 2, which defaults to the base calendar settings.


FromTime1
If Working is set to 1, the starting time is required.


ToTime1
If Working is set to 1, the end time is required.

To specify specific time ranges for the working time, values can be entered for up to three ranges per day in the FromTime1/ToTime1, FromTime2/ToTime2, and FromTime3/ToTime3 field pairs. Because the database only supports a combined time and date format, you will need to enter the date along with the time, but Microsoft Project will ignore the date in these fields and only use the time portion.

Notes

· Microsoft Project creates records in the Calendars and Calendar_Working_Times tables for the resource with UniqueID zero (these records usually have a CalendarUniqueID value of 2).  These records should never be modified or deleted.

· To specify working times for a new calendar you must set a working time for each of the seven days of the week. In the database, this means you must create seven records in the Calendar_Working_Times table, one for each DayofWeek value.

Example:

Assume you want to create a new base calendar for a part-time shift that works 9:00 AM to 1:00 PM Monday through Thursday and 8:00 AM to 12:00 PM on Friday. This is the record that needs to be added to the Calendars table:

ProjectID
CalendarUniqueID
IsBaseCalendar

2
4
1

The CalendarUniqueID is just a value that is not already in use for this project. Since we are creating a new base calendar, the IsBaseCalendar field is set to True and the BaseCalendarUniqueID does not need to be specified.

These are the records that need to be added to the Calendar_Working_Times table:

Project ID
Unique ID
Calendar UniqueID
DayOf Week
Working
From Time1
To Time1

2
15
4
1
0



2
16
4
2
1
<date> 9:00AM
<date> 1:00PM

2
17
4
3
1
<date> 9:00AM
<date> 1:00PM

2
18
4
4
1
<date> 9:00AM
<date> 1:00PM

2
19
4
5
1
<date> 9:00AM
<date> 1:00PM

2
20
4
6
1
<date> 8:00AM
<date> 12:00PM

2
21
4
7
0



The UniqueID values are selected such that they are unique for the project. The CalendarUniqueID value is taken directly from the record just created in the Calendars table. The DayOfWeek values are 1 to 7, corresponding to Sunday through Saturday. Working is set to False on the Sunday and Saturday, and True the rest of the days. The <date> portion of the FromTime1 and ToTime1 fields is required by most databases, but it will be ignored by Microsoft Project, so any date can be entered. The time portion of these fields is set for each working day.

Creating Calendar Exceptions

There are two kinds of calendar exceptions. One is where a particular day of the week always has the same exception, while the other is a one-time occurrence for a specific date and time. To create the first kind (e.g., Saturday morning is always working or Tuesday is always non-working), the exception needs to be created in the Calendar_Working_Times table. A record should be added with values for the fields described above with Workday set to the day of the exception and the FromTime and ToTime fields filled in as necessary.

To create a specific calendar exception in the database (e.g., December 26th is non-working), you must add a new record to the Calendar_Exceptions table and enter values for at least the following fields:

Table
Fields
Notes

Calendar_Exceptions
ProjectID
Must refer to a valid project in the Project_Information table.


UniqueID
Must be unique within the project (See the note below about the ordering of UniqueID values).


CalendarUniqueID
Must refer to a valid record for the same ProjectID in the Calendars table.


FromDate
The starting date of the exception.


ToDate
The ending date of the exception.


Working
Set this flag to 0 if the exception is non-working time, 1 if it is working time.

As with the Calendar_Working_Times table, to specify a specific time range for an exception, values can be entered for up to three ranges per record in the FromTime1/ToTime1, FromTime2/ToTime2, and FromTime3/ToTime3 field pairs. Because the database only supports a combined time and date format, you will need to enter the date along with the time, but Microsoft Project will ignore the date in these fields and only use the time portion. 

Notes
· The order of the calendar exception records is important and is determined by the UniqueID values. The ascending order of the UniqueIDs must sequence the exceptions in chronological order. If a new exception record is added or inserted, it may require renumbering of the existing values in the UniqueID field. Exceptions that are not placed in the proper chronological order by UniqueID will be ignored.

· If calendar exceptions conflict, one will be ignored, so exception records should not overlap. For example, if you wanted to make the month of July non-working, except for July 10th, you would need to create one non-working exception record for July 1-9 and one for July 11-31. You cannot create a non-working exception for July 1-31 and then another working exception for July 10th.

Modifying Resource Rates

To set resource rates in the database, you must add one or more records to the Resource_Rates table and enter values for at least the following fields. The UniqueIDs and FromDates must be in ascending order in the database.

Table
Fields
Notes

Resource_Rates
ProjectID
Must refer to a valid project in the Project_Information table.


UniqueID
Must be unique within the project and in ascending order.


ResourceUniqueID
Must refer to a valid record for the same ProjectID in the Resource_Information table.


RateTable
Specify a value from 0 to 4, representing the respective rate table A to E in Microsoft Project.


FromDate
The first date on which the rate is effective, and must be in ascending order.


StandardRate
The standard rate for the period.

Creating a Recurring Task

While it is possible to create a recurring task in the database, it's preferable to create recurring tasks inside Microsoft Project because the Recurring Task dialog in Microsoft Project will not reflect the actual recurring task settings for a recurring task created directly in the database. For recurring tasks created in the database, the Recurring Task dialog in Microsoft Project will always default to showing a weekly recurring task that occurs on Mondays with a 1d duration.

To create a recurring task in the database, you must add records to the Task_Information table for the summary recurring task and each of the reoccurring subtasks. The minimum set of values required is specified below. Most of the required values are the same for both kinds of recurring tasks, but summary recurring tasks require setting an additional flag, while recurring subtasks require constraint information. 

Table
Fields
Notes

Task_Information
ProjectID
Must refer to a valid project in the Project_Information table.


TaskUniqueID
Must be unique within the project.


TaskID
Must be unique within the project.


Name
The name of the summary or sub recurring task.


Duration
This value is required for each recurring subtask. 


OutlineLevel
The OutlineLevel of recurring summary tasks should be one less than that of the recurring subtasks.


Recurring
This flag should be set for both recurring summary tasks and subtasks.


RecurringTaskSummary
This flag should only be set for recurring summary tasks.


Rollup
This flag should be set for both recurring summary tasks and subtasks.


StartDate
The start of the summary task or the subtask.


ConstraintType
Required for recurring subtasks. Usually set to 4 (SNET).


ConstraintDate
Required for recurring subtasks.


HideBar
This flag should be set for recurring summary tasks to have them display properly.

Example:

Assume your project runs 4 weeks and you want to create a recurring task for a meeting that occurs every week on Wednesday from 3:00 to 4:00 PM. These are the records that need to be added to the Task_Information table to create the recurring task:

ProjectID
TaskID
Task UniqueID
Name
Duration
StartDate

4
14
14
Weekly Meeting
600
Wed1 3:00PM

4
15
15
Weekly Meeting 1
600
Wed1 3:00PM

4
16
16
Weekly Meeting 2
600
Wed2 3:00PM

4
17
17
Weekly Meeting 3
600
Wed3 3:00PM

4
18
18
Weekly Meeting 4
600
Wed4 3:00PM

 (records continued…)

TaskID
Outline Level
Recurring
Recurring TaskSummary
Rollup
Constraint Type
Constraint Date
Hide Bar

14
1
1
1
1


1

15
2
1

1
4
Wed1 3:00PM


16
2
1

1
4
Wed2 3:00PM


17
2
1

1
4
Wed3 3:00PM


18
2
1

1
4
Wed4 3:00PM


The record with TaskID 14 is the summary recurring task. The OutlineLevel is 1 in this case, but could be something else, as long as the recurring subtasks are at one outline level higher. The Recurring, RecurringTaskSummary, Rollup, and HideBar flags are all set to True for the summary recurring task.

The remaining records represent the 4 weekly subtasks and all are at OutlineLevel 2 in this case, since the summary recurring task was at level 1. Each has an SNET ConstraintType with an associated ConstraintDate to space the tasks out to occur in successive weeks. Only the Recurring and Rollup flags need to be set to True for the subtasks.

Using the Text Conversion Tables

If you want to display strings and values the same as they are displayed in Microsoft Project, you can extract the appropriate text strings from the text conversion tables. The Intl_FieldReferences table contains the categories of conversion text (e.g., duration units, weekday names, constraint types) and the Intl_TextConversions table contains the actual strings for each constant (e.g., Sunday, Monday, As Soon As Possible, Must Finish On).

The query required to extract the appropriate text is dependent upon the particular data in the database that you need to access. For example, the following query displays the task name, duration (as it is stored in the database) and the duration units as they would be displayed in Microsoft Project:

SELECT TASKS.Name, TASKS.Duration, TEXT.ConversionText

FROM Task_Information TASKS, Intl_TextConversions TEXT

WHERE TASKS.DurationDisplayUnits = TEXT.ConversionValue

AND TEXT.LanguageId = 1252

AND TEXT.FieldType = (SELECT FieldType


FROM Intl_FieldReferences


WHERE FieldName = 'Display Units')

For a task that has 2 day duration and appears as "2d" in Microsoft Project, the query will return "9600" and "d". To actually show this as "2d", you would need to divide the 9600 by 4800 (since 1 day is normally 4800 in the database) and then concatenate the label string. In reality, you would probably want to create a table with multiplication values based on the values of the ConversionText field in the Intl_TextConversions table and do multiplications on the duration. This will also need to be based off of the DefaultMinutesPerDay value stored in the Project_Information table.

Accessing and/or Modifying Other Data in the Database

As opposed to having a minimal set of required field values that need to be specified in all of the cases above where new records are being created (or contours are being modified), making modifications to most other data in an existing project in the database usually consists of little more than entering a new value in place of the existing value. But there are still some specific scenarios where there are additional values required to be able to successfully modify database data. This section covers some of those cases as well as some other helpful information about extracting certain information from the database.

Entering Total Actual Work on an Assignment or Task

If, instead of entering one or more assignment actual work contours, you want to enter a single value in the database for the total actual work for an assignment, you must enter data into several other task and assignment fields in addition to entering the actual work value into the ActualWork field in the Assignment_Information table.  If the actual work entered will make the task 100% complete, you must also enter values for ActualStart and ActualFinish in the Task_Information table.  If the amount of actual work being entered will not complete the task, you should enter values for ActualStart and StopDate in the Task_Information table and also make sure the ScheduledWork field in the Assignment_Information table contains an appropriate value.

Entering total actual work on a task (rather than on an assignment) will only work if there are no assignments on the task; otherwise, you must always enter the actual work on the assignment to have Microsoft Project read it in correctly.  When entering actual work on a task with no assignments, you still need to enter values for the start and finish times of the actual work (i.e., ActualStart and either ActualFinish or StopDate) in the Task_Information table.

Outlining with Summary Tasks and Subtasks

When creating summary tasks and subtasks in the Task_Information table in the database, the TaskID order comes into play. To create subtasks, the OutlineLevel should be set to one greater than the desired summary task, the summary task should have a lower TaskID value than all of the subtasks, and no other tasks at the same level of the summary task should have a TaskID that falls between the TaskIDs of the summary and the associated subtasks. In addition, the Summary flag should be set in the record for the desired summary task.

Editing Work on a Summary Task Assignment

If you have a resource assigned to a summary task and you want to edit the work on that assignment in the Assignment_Information table in the database, you must specify values for both the ScheduledWork and Units fields in order for the edit to take effect.

Reading and Writing Notes Fields in the Database

Microsoft Project writes the contents of the Rich Text Format notes fields to a non-editable binary field called Reserved_BinaryProperties, which also includes other binary information about the project. The first 255 characters of the notes field, or up to the first line end or first object, are also written to the Notes field corresponding to the type of note. If you make changes to that field they will be lost when you read the project back into Microsoft Project, since they will be over written by the notes information in the Reserved_BinaryProperties.

To extract the contents of Rich Text Format notes from a binary field, you can use the following Microsoft Access Basic code:

Option Compare Database

Option Explicit

Sub getrtf()

Dim db As Database

Dim rs As Recordset

Dim bytBuffer() As Byte

Dim strData As String, strExtracted As String

Dim intSize As Integer, intOffset As Integer

    'This macro will look for Task Notes and extract the rtf.  This rtf can then be written to file

    '(that Word will understand), or displayed in a richedit control.

    'Open the Task_Information table to look for Task Notes

    Set rs = CurrentDb.OpenRecordset("Task_Information", dbOpenTable)

    'Enumerate across the recordset looking for notes

    With rs

    Do While Not .EOF

        If !Reserved_hasnotes <> 0 Then

            ' Extract string

            strData = StrConv(rs!Reserved_BinaryProperties, vbUnicode) ' Put binary column data into text 








string

            intSize = GetIntegerFromPosition(strData, 1)    ' Size starts at position 1

            intOffset = GetIntegerFromPosition(strData, 5)  ' Offset starts at 5

            strExtracted = Mid(strData, intOffset + 1, intSize) 

            Debug.Print strExtracted

        End If

        .MoveNext

    Loop

    .Close

    End With

End Sub

Function GetIntegerFromPosition(s As String, p As Long) As Integer

Dim i As Long, intResult As Integer

    For i = p + 3 To p Step -1

        intResult = intResult * 255  ' Shift one byte

        intResult = intResult + Asc(Mid(s, i, 1))

    Next i

    GetIntegerFromPosition = intResult

End Function

Getting the Names of Sharer Files

Obtaining the names of sharer files from a resource pool stored in a database requires some programmatic manipulation of the data, which can be accomplished with the following code sample if you are working in Microsoft Access Basic:

Option Compare Database

Option Explicit

Sub getSharers()

Dim db As Database

Dim rs As Recordset

Dim bytBuffer() As Byte

Dim strData As String, strExtracted As String

Dim intSize As Integer, intOffset As Integer

    'This macro will look for Pool projects and extract the name of the sharers

    '(which will be semicolon delimited).

    'Open the Project_Information table to look for Pool projects

    Set rs = CurrentDb.OpenRecordset("Project_Information", dbOpenTable)

    'Enumerate across the recordset looking for notes

    With rs

    Do While Not .EOF

        If !ResourcePool <> 0 Then

            'Extract string

            strData = StrConv(rs!Reserved_BinaryProperties, vbUnicode) ' This is the trick you have to do to extract ANSI....

            intSize = GetIntegerFromPosition(strData, 1)    ' Size starts at position 1

            intOffset = GetIntegerFromPosition(strData, 5)  ' Offset starts at 5

            strExtracted = Mid(strData, intOffset + 1, intSize)  

            Debug.Print strExtracted

        End If

        .MoveNext

    Loop

    .Close

    End With

End Sub

Function GetIntegerFromPosition(s As String, p As Long) As Integer

Dim i As Long, intResult As Integer

    For i = p + 3 To p Step -1

        intResult = intResult * 255  ' Shift one byte

        intResult = intResult + Asc(Mid(s, i, 1))

    Next i

    GetIntegerFromPosition = intResult

End Function

Retrieving Workgroup Message Status

The task and resource workgroup message status fields (Update Needed, Confirmed, Response Pending, and TeamStatus Pending) are not saved out to the database, so if you want to obtain status information about messages that have been sent out to the team, you have to extract the information from the assignment fields. By looking at all of the associated assignment records for a given task or resource, the values of the task or resource status can be determined.

For example, to determine if a task has been confirmed, you must check the Confirmed field of all assignments on that task. If the Confirmed field for every assignment is True, then Confirmed for the task is True. To determine if an update is needed on a task, you must check the UpdateNeeded field of all assignments on that task. If any one of the assignment UpdateNeeded fields is True, then UpdateNeeded for the task is True.

Lesson 7.2 - Lab
1.
Create a project with tasks T1 and T2 and a resource R1 and save the project with the name MyProject1 stored in a new database file named Test.mpd.

2.
Create a second project with several tasks, resources, and assignments and save it with the name MyProject2 stored in the same database Test.mpd as in step 1. When an alert is displayed warning you that Test.mpd already exists, click the Append button. After saving the project, examine the MRU list at the bottom of the file menu and note the kind of syntax used to designate projects stored in a database.

3.
Exit Microsoft Project.

4. In the Windows Explorer, locate Test.mpd and rename it as Test.mdb, then double click Test.mdb to open it in Microsoft Access. 

5. Use the information provided in this lesson to modify MyProject1 in the database in Microsoft Access as follows:

A. Create an FS relationship with a 2d lag between T1 and T2 where T1 is the predecessor of T2. (Is it possible to create predecessor/successor links between projects in Microsoft Access?)

B. Put the word Hello in the Text1 field for task T1.

C. Assign resource R1 to task T1 with the Flat contour at 50% units.

D. Create a new task T3 with an ASAP constraint and 5d duration

E. Create a new resource R3 with a Standard Rate of $20.00/h

6. Exit Microsoft Access.

7. In the Windows Explorer, locate Test.mdb and rename it as Test.mpd, then double click Test.mpd to open it in Microsoft Project. Open MyProject1 from Test.mpd.

8. Verify the changes you made in Microsoft Access by locating the corresponding values in MyProject1 while it is open in Microsoft Project.
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Lesson 8.1:  Inserted Projects

Some Topics to be introduced in this lesson include:

· Replaces Microsoft Project 95 subprojects and consolidated projects

· Inserted Project Information dialog

· Special behaviors

· Outline Level behavior when inserting projects

Inserted Projects

Microsoft( Project 4.x introduced the concept of a consolidated project, a special project that contained other projects. In Microsoft Project 4.x, all projects are included in the consolidated project at the same summary level, so all of the projects are peers. Additionally, there are several features that are disabled when working in a consolidated project. 

Microsoft Project 98 does away with Subprojects and Consolidated projects and uses a general flexible Insert Project command that allows a project to live at any outline level within a container project. 

A project that has been inserted in a container project is referred to as an Inserted Project. However, the older term, subproject, can still be used. The container project can be referred to as a container, master, or consolidated project.

Consolidated projects can be further included in other projects (nested) to develop a project hierarchy. It eliminates many of the cases where the functionality of the product is limited when dealing with consolidated projects. Microsoft Project 98 also increases the upper limit on the number of consolidated projects from 80 to 1000 Inserted Projects.

In the new unified Microsoft Project 98 Inserted Projects model, the only real difference between the subtasks in an outline and Inserted Projects is that Inserted Projects are stored in a separate file instead of being stored in the master project. 

The picture that follows illustrates nested Inserted Projects in the Gantt Chart view. Notice the ID numbers and cross-project links.

Example of nested Inserted Projects and cross-project links
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Definitions

Term
Definition

Consolidated Project

Container Project

or 

Master Project
A project that contains one or more other projects. Every project (MPP) is capable of being a Consolidated Project.

Inserted Project
A project contained within another project.

Subproject
Another name for an Inserted Project. Also refers to Subproject functionality in previous versions of Microsoft Project. Inserted Projects and Cross Project Linking replace the earlier functionality.

Cross-Project Link
A task relationship (or link) between tasks that exist in different projects.

Ghost Task

Or

External Task
A representation of a task from a different project in the current project. Ghost Tasks are created for both Cross-Project links and Inserted Projects.

Overview of Features

· Hierarchies of consolidation (an Inserted Project can contain other Inserted Projects).

· Increased number of projects that can be consolidated. Previously 80. Now 1000.

· Replace 4.0 Subprojects and Consolidated Projects with unified Inserted Projects model.

· Cross Project Links.

User Interface

Inserting a Project

Choose the Insert/Project menu command to create an Inserted Project:

Insert Project menu command
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This displays a version of the File Open dialog with options for the Inserted Project(s). The dialog supports multi-select so that you can select more than one project to be inserted. 
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Most controls in this dialog are supplied by the standard Office File Open dialog. The others correspond to the options for Inserted Projects that are derived from their counterparts in Microsoft Project 4.x’s Consolidated Projects dialog:

Link To Project

Checked by default. This allows you to determine whether a link exists between the source project and the Inserted Project. If a link exists, then when changes occur in the source project they are reflected in the master project and vice versa.

If not selected, then the information in the source project is copied into the master project (like a copy/paste operation).

Read Only

The Read Only option is unchecked by default. This control determines whether the Inserted Project is read-only in the master project. If the Inserted Project is read-only, then changes cannot be made from the Master Project. If the Inserted Project is not read-only, then changes can be made in the Master Project and the changes are reflected in both the Master Project and the source project.

If Link to Project is unchecked, then this control is disabled. 

Hide Subtasks 

The Hide Subtasks option is unchecked by default. This control determines the default viewing state of the Inserted Project. When checked, the Inserted Project is displayed as a project summary task and the tasks in the Inserted Project are hidden. In this mode, the Inserted Project acts more like current subproject functionality. When unchecked, the Inserted Project is displayed fully expanded so all of its tasks are visible.

This control is a subset of the functionality available in the Inserted Project Information dialog. In that dialog, you can control the number of levels of the Inserted Project that should be viewed by default in the Master Project.

ODBC

If you choose the ODBC button, you first get the ODBC Data Sources dialog. Once you choose a data source, if there are Full projects saved in the database, they are presented in the following dialog:
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The list box displays all of the Full projects in the database. The list box is multi-select so that you can choose more than one project to insert. The order of selection is used to determine the order of insertion (as it does in Microsoft Project 4.x).

The label for the list box replaces the ^1 at run-time with the Data Source Name you select.

The rest of the controls are the same as in the standard Insert Project dialog. Note that the controls are not linked to the controls in the standard dialog (for example, if you check ‘Read Only’ in the standard dialog, it will not be checked in this dialog).

Some differences from Microsoft Project 4.x:

In Microsoft Project 4.x, you could independently control the read-only status of each file being consolidated. With Microsoft Project 98, you can only control this setting for all projects being inserted at the same time. You either need to insert each project separately or modify the read-only setting using the Inserted Project Information dialog.

In Microsoft Project 4.x, you could specify the ordering of the projects. With Microsoft Project 98, it inserts the projects in the order in which they are selected in the dialog (in the same way that Microsoft Project 4.x used the order selected in the Browse dialog for the initial order in the consolidation list). Also, since the Inserted Projects appear in the normal outline structure of the master project, you can re-order the Inserted Projects in the same way that they would re-order normal tasks (drag/drop, cut/paste, and so on).

In Microsoft Project 4.x, you could specify wild cards for consolidation (for example, c:\*.mpp). Microsoft Project 98 does not support this functionality.

Window New Window

Microsoft Project 98 supports “on-the-fly” consolidation via the Window/New Window command (as in Microsoft Project 4.x). You are given a list of the open projects and can choose multiple projects to be displayed in the same window.

With Microsoft Project 98, this functionality is translated to create a new project (with names like Multi1, Multi2, and so on) and to insert each project into this new project at outline level 1. This is similar to how Microsoft Project 4.x consolidated projects are converted to Microsoft Project 98 Inserted Projects.

The list of projects should include all projects open in their own windows in addition to all Inserted Projects (just as Microsoft Project 4.x lists all the component projects of a consolidated project).

If you choose to consolidate two projects that are already related, then there is no alert, but the relationship is preserved in the new consolidated project. 

For example, if ProjA contains ProjB which contains ProjC. The Window/New Window dialog lists ProjA, ProjB, and ProjC. If you choose ProjB and ProjC, then the new consolidated project would have both ProjB and ProjC. ProjB would be at outline level 1 and ProjC would be contained in ProjB as it normally is.

Inserted Project Information dialog

When a project summary task for an Inserted Project is selected and you select the Project menu Task Information command, the new Inserted Project Information dialog is displayed, instead of the Task Information dialog. Some properties are disabled, and some special properties are available.

Changes from Task Information Dialog

The title of the dialog is Inserted Project Information.
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All tabs have a “Project Information...” button that tunnels to the Project Information dialog. In Microsoft Project 4.x this was the File Project Information menu command. This function allows you to change settings on the project (calendar, schedule from start/finish and so on).

The Advanced tab has the following controls for the Inserted Project.
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Link to Project

When checked, this indicates that the Inserted Project is linked back to its source project. The edit control allows you to change the path to the source project (to correct it if the file has moved, and so on)

When unchecked, the edit control, the Browse button, the Read Only checkbox, and the Show Subtasks checkbox are all disabled. When the dialog is OK’d, the information from the Inserted Project is copied into the master project as normal tasks.

Browse Button

When pressed, the Browse Button displays the standard File Open dialog with the title ‘Insert Project.’ The default directory and path are taken from the edit control.

Read Only

When unchecked, edits made to the Inserted Project in the Master Project are reflected in the source project.

When checked, edits are not permitted to the Inserted Project (the Inserted Project is read only).

Disabled Items in the Inserted Project Information dialog

For the most part, the controls that are disabled when an Inserted Project is selected are the same as those disabled in Microsoft Project 95 when a Project Summary Task is selected. The disabled controls include the Start, Finish, and Duration fields.

Inserted Project Display Behavior

In general, formatting information is pushed down from the master project onto the tasks in the subproject (Text Styles/Bar Styles, and so on).

In addition, direct formatting is lost when you view a project from within another project (since formatting is stored with the view).

Indicator (Task Sheet/Gantt)

The Project Summary Task for an Inserted Project has an Inserted Project indicator in the Indicator column. This allows you to easily distinguish between normal tasks and Inserted Projects. The indicator is modified when the Inserted Project is read-only and/or when the file cannot be found.
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Task Bars

Task Bars are drawn using the formatting from the master project. Direct formatting of bars in the individual project is not displayed in the master project. Direct formatting is stored in the view, not in the task.

Text Styles

The Project Summary Task category is used to format the text of the Inserted Project. The same default formatting was used in Microsoft Project 95.

Bar Styles

It adds a new line to the default Gantt Bar Styles for Project Summary Task using the Show For Project Summary bar style. Below is the default bar it uses:
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This is a mixture of the Summary and External Task bars format, also referred to as a ghost summary bar.

Information dialog

The information dialog displays the cached information in the Inserted Project Summary task.

The Inserted Project Summary task acts very much like an External (Ghost) task. 

The set of fields that is synchronized and editable is exactly the same as for External Tasks except that the following fields are not synchronized:

Name

Type

PERT view

Only the Inserted Project Summary Task can be displayed in the PERT Chart. You cannot see the individual tasks that it contains. There are several new Box Styles for Inserted Projects and External Tasks:

New Box Styles
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Task PERT view

There are no changes in the Task PERT. Inserted Projects and the tasks they contain are displayed no differently than any other task in this view.

Task Usage view

The Sheet portion displays like the Task Sheet. The Usage portion (timescale) just displays the rollup like a normal summary task. 

Resource views

In Microsoft Project 4.x consolidation, when displaying a resource view, all of the resources are listed for all of the projects (in order of consolidation). They retain their ID from their original project. If all of the projects are using the same resource pool then each resource is listed only once. In Microsoft Project 4.x there was no easy way of determining in which project the resource lives if there is no resource sharing pool.

Microsoft Project 98 provides a Project field for Tasks, Resources and Assignments.

Example of the Project Field in a Resource Sheet view
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Editing Rules

Inserting Tasks near Inserted Projects

When you choose to insert a task at the boundary between an Inserted Project and tasks in the Master Project, it follows the same rules as used in Microsoft Project 4.x for “Smart Insert” functionality.

Inserted Project Summary Task Selected

The insert occurs immediately above the Inserted Project. It follows the normal rules for default outline level as Microsoft Project 4.x.

Task Below Inserted Project Summary Task Selected

There are two cases here:

· The Inserted Project Summary Task is collapsed so that it is the only task of the Inserted Project being displayed. In this case, the new task is inserted into the Master Project at the same level as the Inserted Project.

· The Inserted Project Summary Task is expanded. The new task is inserted into the Inserted Project. The outline level is determined by the “Smart Insert” behavior.

Deleting an Inserted Project

If the Inserted Project Summary Task is selected and you choose Edit/Delete (or press the Delete key) the Project Summary Task and all of its children (for example, the entire project) are deleted from the Master Project (just like deleting a normal summary task). The deleted project file still exists and contains all of its child tasks. It is just no longer part of the master project. If however, you select specific child tasks without selecting the inserted project summary task, then you really do delete child tasks from the inserted project.

Navigating an Inserted Project

Outlining

The most natural way for navigating an Inserted Project is through the outline commands. 

Show Subtasks

Show Subtasks (Expand) displays the next outline level of details in the Inserted Project. 

Hide Subtasks

Hide Subtasks (Collapse) collapses the Inserted Project so it displays only the Project Summary task, without showing the child tasks.

Show All Subtasks 

Show All Subtasks (Expand All) is changed to work on only the selected project. This allows you to more finely control the display of subtasks and keeps the operation consistent with Microsoft Project 4.x subprojects.

If you want to show all subtasks for all summary tasks and inserted projects, you can select everything by clicking a table column and using the Show All Subtasks command.

Indent & Outdent

You can indent or outdent tasks within a particular project. You cannot move tasks between an Inserted Project and its master via outdenting (or vice versa via indenting). You can think about this as if each project is being handled independently of one another. 

If you attempt to outdent a task past its project summary task, Microsoft Project 98 does not allow the action whether the project is stand-alone or is inserted in another project.

Similarly, if you attempt to indent a task in the master project that follows an Inserted Project’s summary task, Microsoft Project 98 does not allow the action. 

Saving Inserted Projects

Saving when other projects are not saved

For each unsaved Inserted Project, it prompts you to save the document.

Saving in the same database

It does not allow multiple projects to live in the same MPP file. It does however, allow multiple projects to be stored in the same database (ODBC data source). 

When you save a project for the first time or when you perform a Save As to a data source that contains other projects, if you choose the MPD format directly, or choose a full save via ODBC, Microsoft Project 98 asks if you want to save all of the projects into the same file (DSN).

Currency

When you choose to insert a project that has a different currency setting than the master project, the following alert is displayed:
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If you choose Cancel, the Insert Project operation is cancelled. 

If you choose OK, then it continues normally. To the master project, the cost information is rolled up as 0. The information within the Inserted Project is displayed as it would normally (in its currency format).

Each time you open the master, if the currency format in the subproject is different than the master project, the same alert is displayed, only without the cancel button.

Custom Fields

In Microsoft Project 98, a custom field is an alias you give to a pre-defined field when you use the Tools Customize Fields menu command. For example, you can give the pre-defined Text1 field the alias "OBS." Then, whenever you want to refer to the Text1 field, you can instead refer to OBS. The aliases show up in all dropdown lists of fields.

In a master project, the aliases used are the ones defined in the master project. Aliases defined in Inserted Projects are ignored while the master is active. For example, if you give Text1 the alias OBS in the master project, but give it the alias Cost Code in the Inserted Project, then it uses the alias OBS defined in the master project, when the master is active.

Backwards Compatibility

Opening Microsoft Project 4.x Consolidated Projects in Microsoft Project 98

When opening a Microsoft Project 4.x consolidated project, Microsoft Project 98 converts the project to a normal MPP using Inserted Projects.

For each MPP referred to in the consolidated project, an Inserted Project is created at outline level 1 in the new, normal MPP.

The read-only setting for each Inserted Project is set according to the setting for the consolidated project.

If the “Hide Subtasks” check box in Microsoft Project 4.x is selected, then the Inserted Project Summary tasks are collapsed. If it is unchecked, then the inserted projects are expanded.

Subprojects

When opening a Microsoft Project 4.x project that includes a subproject, Microsoft Project 98 converts the subproject reference to an Inserted Project. The Read-only setting is False and the Show Subtasks to level setting is 1.

If there are any links (dependencies) to the subproject, these are converted to cross-projects links to the project summary task of the Inserted Project (note that it needs to open the subproject invisibly in order to create this link).

Effects on Existing Commands

Resource Assignment

In Microsoft Project 4.x, the Resource Assignment dialog was disabled for Consolidated Projects. 

In Microsoft Project 98, it is renamed as the Assign Resources dialog, and can be used with master projects containing Inserted Projects.

Resource Assignment dialog
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Pool Display in the Assign Resources Dialog

The Resources From label in the Assign Resources dialog always displays the name of the current file. No pool is displayed even if multiple tasks are selected and they don't all come from projects using the same pool.

The Resource Assignment list changes when the selected task uses resources from a different file, but the “Resources From:” will remain the same.

Multi-Project Selection

If multiple tasks are selected from multiple projects and those projects share the same resource pool, then that pool is displayed by the "Resources From" label in the Assign Resources dialog.

If the tasks selected do not share the same pool, then no pool is displayed in the dialog and all buttons are disabled except the Close button. This eliminates the possibility of you attempting to assign a resource from one pool to a task in a project not using that pool.

Find/Replace

The Edit menu Find and Replace commands work across all projects in a master project.

The Replace command does not work on a selection, but it does work on filtered tasks. To apply it only to a specific Inserted Project, activate that project, or apply a filter that only displays that Inserted Project.

Edit Go To

For Edit/Go To, when going to an ID, it only jumps to tasks within the master project.

Link Tasks/Unlink Tasks

Tasks in a master project can be linked using the mouse as in a standalone project. If the link involves tasks in separate files, a cross-project link is automatically created.

Fill Down

Fill Down works in a master project as it does in standalone projects.

Sort

Sorting works the same in Microsoft Project 98 as in Microsoft Project 4.x. Consolidation allows sorting to occur as it does in a normal project. Tasks from different projects can become intermingled if the “Keep Outline Structure” is unchecked.

Filtering

Filtering works the same in Microsoft Project 98 as in Microsoft Project 4.x. 

File/Properties

The File Properties command displays the properties for the master project. To view the properties for an Inserted Project, you need to open the Inserted Project into its own window and then use the File Properties command from that window.

File/Project Information

The Project menu Project Information command displays the project information for the master project. To view the project information for the Inserted Project, you can do one of the following:

· Display the Inserted Project Information dialog and use the Project Information button to tunnel to the Project Information dialog for that project.

· Open the project in its own window and use the Project Information command from that window.

File Send

If you send only the master project, then the references to the Inserted Projects will be incorrect.

Drawing Objects and OLE Objects on the Gantt Chart

Drawing and OLE Objects are stored in the Master Project.

Inserted Project before Master Project Start Date

In Microsoft Project 4.x, when you drag a task before the start of the project, the project start date does not change, but the Project Summary Task takes into account the earliest start of any task in the project.

Microsoft Project 98 does the same thing when a project is inserted that starts before the project start date.

Change Working Time (Project Calendars)

In the Change Working Time dialog (and other places where calendars are listed) displays calendars from all projects inserted into the master project. The calendar will be listed with the project name enclosed in square brackets after the calendar name.

You can open the inserted project in its own window in order to edit its calendars.

Status Date, Current Date and Update Project dialog

Microsoft Project 98 introduces the concept of the Status Date that allows project managers to track the last time they entered actuals for their project. The Update Project dialog uses the entered Status date (by default) to calculate progress information. If the Status Date is not entered, then it uses the Current Date.

For Consolidated Projects, it uses the Current and Status dates from the Master Project for display on the Gantt Chart and for the Update Project dialog.

Calculations based on the Status/Current date, such as Earned Value calculations when the Edits to total task % complete will be spread to the status date option is selected, are calculated using the individual Inserted Project's Status/Current date. 

The Current Date gridline in the Gantt Chart and the default date in the Update Project dialog use the Status date from the master project.

Lesson 8.1 - Exercises

1. 
Microsoft Project 98 online Help has a topic titled Consolidated project files. What is the difference in how the term consolidated project is used in Microsoft Project 98 versus how it was used in Microsoft Project 95?

2.
What is an Inserted Project in Microsoft Project 98 and how does it differ from a consolidated project?

The Inserted Project feature in Microsoft Project 98 replaces and improves on what Microsoft 95 features?

3.
How do you insert one project into another project?

4.
When you open a project that contains inserted projects, when do the inserted projects actually get loaded (opened) into memory (i. e. when are they listed in the Window New Window list of open projects)? Is there any way to close an inserted project once it has been opened, other than deleting the inserted project or closing the container project?

5.
Does the Show All Subtasks tool button expand all collapsed inserted projects (in addition to expanding collapsed summary tasks)?

6.
What happens when you open a Microsoft Project 95 consolidated project in Microsoft Project 98?

7.
Can an inserted project be a container for other inserted projects (i. e. can inserted projects be nested)?

8.
Project IP1.mpp in the picture below is an inserted project.
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Is it possible to outdent task IP1-T1?

If you enter a new task or insert another project in the active cell (below IP1-T2), what outline level will it be at?

9.
How can you insert one project below another inserted project without having one indented below the other (i.e. without nesting them)?

Lesson 8.1 - Lab

1. 
Create a project with tasks TA and TB and save it as IP1.mpp Create another project with tasks TC, TD, and TE and save it as IP2.mpp. Close IP1.mpp and IP2.mpp.

2.
Create a new project and insert projects IP1.mpp first and insert IP2.mpp below IP1.mpp so that they are both at outline level 1 (not nested). Collapse both inserted project tasks if they are not already collapsed. Save the container project as Consolidated.mpp and then close it. Close any other open projects you may have been working on too (save changes if desired).

3.
Reopen Consolidated.mpp and on the Window menu click New Window. Only Consolidated.mpp should be listed.

4.
Click the Show All Subtasks tool button (the one with the double plus signs). It should have no effect on the inserted projects.

5.
Click the plus outline symbol in front of the name of IP1.mpp to expand it, and on the Window menu click New Window. IP1.mpp should also be listed now.

6.
Collapse IP1.mpp and check the New Window list again. IP1.mpp should still be listed.

Lesson 8.2:  Cross Project Links

Some Topics to be introduced in this lesson include:

· Different ways to create cross project predecessor/successor links

· Tools "Links Between Projects" command lists external predecessors/successors

· Tools Options View tab "Cross project linking options ..."

· Ghost tasks

· Changes to Predecessor/Successor fields in tables and Task Info

· Task Dependency dialog

· Calculations and Circular Loops involving external predecessor/successor links

Cross Project Linking

Cross project linking allows you to link tasks in one project to tasks in another project.

This could be simulated in Microsoft Project 4.x by using DDE or OLE to link the Start or Finish date of one task to the Start or Finish date of another (Edit menu Paste Special command with the Paste Link option).

Microsoft Project 98 supports true cross project linking. You can include a path and filename in the Predecessor and Successor fields, followed by a slash and the usual relationship syntax.

For example, if you enter C:\MyFiles\P1.mpp\24FS+3d in the Predecessor field, then the predecessor has ID 24 in the file C:\MyFiles\P1.mpp, and the relationship is Finish-to-Start with 3 days of lag.

How an external predecessor of successor is displayed in the active project depends on whether or not its parent project has been inserted into the active project. 

· If the external project is not an inserted project in the active project, then the external task is displayed as a specially formatted (light gray) ghost task. It is inserted into the active project before/after its successor/predecessor in the active project and gets an ID in the active project as if it were part of the active project. Other task ID's are shifted. Exception: If the external task has more than one relationship in the active project, it is inserted only once. 

Note: An external task displayed as a ghost can only be edited in its parent source project. 

· If the external project is an inserted project in the active project, then the external task can be displayed and edited like any other task belonging to the inserted project. It is not displayed as a ghost bar. It is displayed with its original ID from its parent project.

You can link tasks from one project to tasks in another project almost as if you were linking tasks in the same project. The links can be FS, SS, FF and SF with lead and lag. 

Exception: predecessors of summary tasks must be SS or FS, but successors of summary tasks can by any type. 

Example

This example illustrates the difference between external tasks that are ghosted in the active project versus external tasks that are part of an inserted project in the active project. The active project in this discussion is P2.mpp on the left that follows. The pictures on the right of P1.mpp are shown to illustrate what is happening in the background to P1.mpp.

Original P2.mpp
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Original P1.mpp
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External predecessor entered for task P2T3 in P2.mpp
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Resulting change to P1.mpp.
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Next the Insert Project menu command is used to insert P1.mpp into P2.mpp at row 2.
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No additional change to P1.mpp.
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Two important points about the last pictures:

The ghost task P1T2 that had been at row 3 in P2.mpp is no longer displayed. That's because P1T2 is now displayed as part of its inserted parent project.

The subtasks of the inserted project P1.mpp do not include the ghost, P2T3, which was in row 3 in P1.mpp, because P2T3 is already a normal task in P2.mpp. It would be redundant to display it twice (once as a ghost in the inserted project P1.mppand once as a normal task in P2.mpp).

Note: If you delete the inserted project P1.mpp from P2.mpp, the ghost task P1T2 will be inserted again, where it was before P1.mpp was inserted into P2.mpp.

Terminology

The terms Internal or External are used to describe those tasks existing in a project versus those outside of it. Which task is considered internal and which is external is relative to what project you are talking about. 

To avoid confusion, this discussion assumes the active project is the internal project unless stated otherwise.

When an external link is created in the active project, replicated tasks are created in both the external and active projects. 

The term ghost task is used to refer to an external (replicated) task, however, an external task is not displayed with the ghost task formatting in the active project if the parent of the external task has been inserted into the active project.

One project gets an external successor task and the other gets an external predecessor task. When either project is displayed alone (for example, does not contain the other as an inserted project), the external task is displayed with special light gray ghost formatting so it can be easily distinguished from other tasks. 

If an external task is displayed as a ghost task in the active project, it gets its own ID in the active project (not necessarily the same ID it has in its parent project). A predecessor ghost task is inserted just before the corresponding internal successor task, and a successor ghost task is inserted just after the corresponding internal predecessor task. However, if a ghost task representing the external task already exists, then that ghost task is used to represent the external task in all the relationships it may have with tasks in the active project. For example, there is a limit of one ghost task per external task. In other words, if two tasks in the active project both have the same external predecessor, there is only one ghost task representing that external task in the active project.

Example

This example illustrates the relative use of the terms internal and external, regarding cross project linking.

Task Test1T5 is the predecessor in Test1.mpp
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Task Test2T3 is the successor in Test1.mpp
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From the perspective of Test1.mpp, task Test1T5 is the internal predecessor of the external successor task Test2T3.

From the perspective of Test2.mpp, task Test1T5 is the external predecessor or the internal successor task Test2T3.

The task in each individual project that represents an external task is also called a ghost task. 

Creating and Editing Cross Project Links

Consolidated Projects

When using the Insert Project command with the Link to Project option to insert a project into a master (container) project, any changes you make in the master project to tasks in the inserted projects are reflected in the source projects. 

The Gantt Chart in the master can display tasks from many different projects, including tasks from the master project, projects inserted directly into the master project, tasks in nested inserted projects, and ghost tasks from external projects that are not contained in the master.

You can create cross project links by dragging between any two task bars in the Gantt Chart, regardless of what project they belong to. However, link lines are not displayed if the predecessor and successor are both ghost tasks.

The predecessor and successor can be in different projects. If you can see them, you can link them (subject to the normal linking restrictions, such as not being allowed to link a summary task to one of its child tasks). You can also create cross project links in a master project the same way you do in a stand-alone project. This is discussed in a later section.

You can create links between project summary tasks. This allows consolidation in Microsoft Project 98 to replace subproject functionality entirely. 

Note: Only the Inserted Project Summary Task displays in the PERT Chart. You cannot see the individual tasks that it contains so you cannot create cross project links in a PERT Chart except between ordinary tasks and inserted project summary tasks.

Example

This example illustrates cross project links among tasks that are part of a consolidation.

Note that the inserted projects Test1, Test2, and Test3 are displayed as ghost/external summary bars in Main1. Also, Test2 is a nested inserted project under Test1, which is inserted into Main1.

Example of Cross Project linking displayed in a master project.
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Individual Projects

You can create a link between two projects by editing the successor or predecessor field in the sheet or in the Task Information dialog Predecessors tab.

The format of the external link is either:

pathname\filename\task_id

or

pathname\filename\project_name\task_id

or

DSN\project_name\task_id

followed by the usual link type and lag/lead values,

where:

· pathname is the UNC path to the directory containing the project file.

· filename is the name of the project file. This could be a .MPP or .MDB file.

· DSN is the ODBC Data Source Name (like <SQL Server>).

· project_name is a specific project name. This is used in cases where the source file can store multiple projects (such as MPD and ODBC). It indicates to which project within the given file or DSN you refer.

· task_id is the external task ID (the normal ID that would be displayed in the external project).

For example, you might type the following in the Predecessors column:

\\proj1\plans\Project 98\long file name.mpd\long project name\44 SS+1d

When creating a link, you can type in the project name and task name to create an FS cross project link to the external task if the project is in memory (open). Microsoft Project can fill in the path and file name of the open project. If you do not specify a link, Microsoft Project creates an FS link by default. It is a predecessor or successor link depending on whether you are typing in the predecessor or successor field.

If the file is not in memory, you must enter the path (and any other required information if the source is a DSN). Microsoft Project then loads the file for you. If you enter the filename without an extension, it assumes MPP. If it cannot find the file, it displays the normal alert and then displays the file browse dialog.

Example

This example illustrates how external predecessors/successors in a standalone project are inserted as ghost tasks before/after the internal task, causing ID numbers to shift.

Task P3T2 in project P3.mpp will be given an external predecessor from P1.mpp and another from P2.mpp. The pairs of pictures that follow show what each of the projects looked like before and after the link was created. The Project field shows the parent project of each task.

P3.mpp BEFORE the link is created...
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P3.mpp AFTER  the link is create ...
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P1.mpp BEFORE the link is created...
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P1.mpp AFTER the link is created...
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P2.mpp BEFORE the link is created...
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P2.mpp AFTER the link is created...
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Task Information Dialog

You can create cross project links in the Task Information dialog Predecessors tab by specifying the appropriated external predecessor information in the ID column. The path is not required if the predecessor parent file is open. The Type and Lag fields cannot be edited until you click OK and the external file is opened.
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The ID column accepts ID for internal tasks. For external tasks, it accepts the same syntax as the Predecessor column in a task table accepts: path\filename\ID or path\filename\project_name\ID or DSN\project_name\ID.

Since Microsoft Project can’t open the external project while the dialog is displayed, it puts “External Task” as a placeholder name for the task name, Type and Lag. You cannot edit Type and Lag until you OK the dialog, which opens the external project. You can then display this dialog again and edit Type and Lag. 

In a consolidated project, the Task Name column only knows about tasks in the same project as the selected task. So the dropdown only lists other tasks in the same project. Similarly, if you enter a task name from a different project, you get a task name not found alert.

Task Dependency Dialog

Note: The terms ghost and ghosted in this section refer to an external task whose parent project is not inserted in the active project.

You can display the Task Dependency dialog by double-clicking a link line in a consolidated or standalone project. 

There are two versions of the Task Dependency dialog, one version if the link does not involve a ghost task (but may involve inserted external tasks), and a different version for a link between an internal task and a ghost task.

Note: Link lines are not drawn between two external tasks if either of them is displayed as a ghost task. You cannot display the Task Dependency dialog in that case. You can use the mouse to create links between such tasks, but the resulting link line is not displayed.

Double-click a link line between two tasks that are not ghosted to display a Task Dependency dialog similar to the one in Microsoft Project 4.x.

Link between two internal tasks...
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If one or both of the non-ghosted tasks is in an inserted project, then the inserted project names are appended in parentheses after the external task names. In the picture that follows, the project P2.mpp is inserted into the active project, and the task P2T3 in the inserted project P2.mpp is the predecessor of P3T2 in the active project.

Link from a task in an inserted project to an internal task...
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For a link between an internal task and a ghost task, the full path and filename of the ghost task are appended in parentheses after the ghost task name. In the picture that follows, the project P2.mpp is not inserted into the active project. The task P2T3 in project P2.mpp is the ghost predecessor of P3T2 in the active project.

Link from a ghost task to an internal task...
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Editing Ghost Tasks

If you double-click any cell of a ghost task, Microsoft Project opens the external project if it is not already open, and places the cursor at the top of the file.  If the file is already open, double-clicking the ghost task will activate that file and place the cursor at the proper task..

The cross project link can be edited in either project. 

The ghost task can be deleted from the internal task's project. This removes the link and removes the ghost task from the internal project. This action has no affect on the external task in the external project except to remove the cross project link (and the appropriate ghost task) when that project is updated. For example, deleting a ghost task breaks the link, but doesn't delete the task record from the parent project.

Synchronized and editable ghost fields

Some information in a ghost task is synchronized with the information in the external project, and some information is editable in the internal project. In general most fields are synchronized except for custom fields, notes, and baseline fields (so that you can set a baseline in the internal project) and some fields are only used to show assignment fields. 

Cost and work fields are synchronized, but they are not included in rollup calculations since they are not counted against the internal project. Also, fields that are synchronized are not editable since the synchronization would wipe out any edits.

The following split table shows what information is synchronized with the information in the external project. It also shows what information is editable in the internal project. The X at the end of some of the field names in the table is a placeholder for numbered fields. For example, TextX means Text1, Text2, and so on.

Name
Sync
Editable

Name
Sync
Editable

Actual Cost
Yes
No

Marked
No
Yes

Actual Duration
Yes
No

Milestone
Yes
No

Actual Finish
Yes
No

Name
Yes
No

Actual Overtime Cost
Yes
No

Notes
No
Yes

Actual Overtime Work
Yes
No

NumberX
No
Yes

Actual Start
Yes
No

Objects
No
No

Actual Work
Yes
No

Outline Level
No
No

Assignment
No
No

Outline Number
No
No

Baseline Cost
No
Yes

Overallocated
No
No

Baseline Duration
No
Yes

Overtime Cost
Yes
No

Baseline Finish
No
Yes

Overtime Work
Yes
No

Baseline Start
No
Yes

% Complete
Yes
No

Baseline Work
No
Yes

% Work Complete 
Yes
No

BCWP
No
No

Predecessors
No
No

BCWS
No
No

Preleveled Finish
Yes
No

Confirmed
No
No

Preleveled Start
Yes
No

Constraint Date
Yes
No

Priority
Yes
No

Constraint Type
Yes
No

Project
Yes
No

Contact
No
Yes

Recurring
No
No

Cost
Yes
No

Regular Work
Yes
No

Cost Rate Table
No
No

Remaining Cost
Yes
No

Cost Variance
No
No

Remaining Duration
Yes
No

CostX
No
Yes

Remaining Overtime Cost
Yes
No

Created
No
No

Remaining Overtime Work
Yes
No

Critical
Yes
No

Remaining Work
Yes
No

CV
No
No

Resource Group
No
No

DateX
No
Yes

Resource Initials
No
No

Assignment Delay
No
No

Resource Names
No
No

Duration
Yes
No

Resource Phonetics
No
No

Duration Variance
No
No

Response Pending
No
No

DurationX
No
Yes

Resume
Yes
No

Early Finish
Yes
No

Rollup
No
Yes

Early Start
Yes
No

Start
Yes
No

Effort Driven
Yes
No

Start Variance
No
No

External Project Name
No
No

StartX
No
Yes

Finish
Yes
No

Stop
Yes
No

Finish Variance
No
No

Subproject File
No
No

FinishX
No
Yes

Subproject Read-Only
No
No

Fixed Cost
Yes
No

Successors
No
No

Fixed Cost Accrual
Yes
No

Summary
No
No

FlagX
No
Yes

SV
Yes
No

Free Slack
Yes
No

TeamStatus Pending
No
No

Hide Bar
No
Yes

TextX
No
Yes

Hyperlink
No
Yes

Total Slack
Yes
No

Hyperlink Address
No
Yes

Type
Yes
No

Hyperlink Href
No
Yes

Unique ID
No
No

Hyperlink SubAddress
No
Yes

Unique ID Predecessors
No
No

ID
No
No

Unique ID Successors
No
No

Indicators
No
No

Assignment Units
No
No

Late Finish
Yes
No

Update Needed
No
No

Late Start
Yes
No

WBS
Yes
No

Level Assignments
No
No

Work
Yes
No

Leveling Can Split
No
No

Work Contour
No
No

Leveling Delay
Yes
No

Work Variance
No
No

Linked Fields
No
No





Formatting Ghost Tasks

To allow formatting of the ghost tasks, the following items have been added to the following dialogs: 
View
Dialog
Item

Calendar
Text Styles
external task

Calendar
Bar Styles
external task

Gantt
Text Styles
external task

Gantt
Bar Styles
External (Show For)

PERT
Text Styles
external task

PERT
Box Styles
external task

Task Sheet
Text Styles
external task

Task Usage
Text Styles
external task

Task Report
Text
external task

Crosstab Report
Text
external task

Default Formatting for Ghost Tasks

View
Dialog
Formatting

Calendar
Text Styles
Color: Gray

Calendar
Bar Styles
Color: Gray

Bar Type: Bar

Pattern: Hollow

Gantt
Text Styles
Color: Gray

Gantt
Bar Styles
Color: Gray

Bar: Light Dither

PERT
Text Styles
Color: Gray

PERT
Box Styles
Color: Gray

Box: Dotted Box

Task Sheet
Text Styles
Color: Gray

Task Usage
Text Styles
Color: Gray

Task Report
Text
Color: Gray

Crosstab Report
Text 
Color: Gray

GanttChartWizard Changes

The GanttChartWizard preserves ghost task formatting, but provides no options to change it. Formatting for ghost task bars must be done using the Format Bar or Format Bar Styles menu commands.

Baseline Information for Ghost Tasks

Unlike all other information about the ghost task, the baseline information comes from the internal project and not the external project.

An external task has two independent sets of baseline field values. One set is in its parent project, and one set is in the internal project. This allows you to see how much the ghost task has moved or changed from the last time the internal project baseline was set.

Link Updates and Maintenance

Cross Project Linking Options

The Tools Options dialog View tab contains options to control how links are updated when files are opened, as well as whether or not ghost tasks are displayed.

Cross Project Linking Options in Tools Options View Tab
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The first two settings determine if the ghost predecessors or successors are displayed as tasks or hidden in the current project. This setting does not impact the predecessor or successor fields of the linked internal task that show the external links as text. 

If the parent project of an external task is inserted into the active project, then the external task is not displayed as a ghost task, but is instead displayed as any other task in an inserted project.

If the Show Links Between Projects dialog on open option is ON (selected) then the Automatically accept new external data option is disabled and unchecked. If Show Links Between Projects dialog on open is OFF (not selected), then the Automatically accept new external data option is enabled and you can turn this option ON or OFF.

If the Show Links Between Projects dialog on open setting is ON, then Microsoft Project displays the Links between Projects dialog whenever you open the file, but only if there has been a change to an external task or link. If this setting is OFF, then Microsoft Project does not display the dialog on file open even if there have been changes to the external tasks or links. In that case,  choose the Links between Projects command from the Tools to display the dialog.

If Automatically accept new external data is ON, then Microsoft Project automatically accepts any new external link information without prompting you. Since it automatically synchronizes the data, if Microsoft Project can’t find the external link (because the link was removed or the project file was  moved), then the external task is deleted. 

By default, the first three checkboxes are ON.
These options are saved per project, and cannot be saved globally.

Behavior on Open

Suppose there is a link between a task in project A and a task in project B, and you open project B. Various scenarios are discussed as follows.

Project A in Memory

If project A is already open in memory, then the linked task in project B reflects the current information from project A, and B’s ghost in project A reflects the current task data of that task in project B.

Provided calculation is on, any open project reflects the current data of the external tasks and links.

Project A Not in Memory and 'Show ... dialog on open' is ON

If project A is not currently open, then Microsoft Project looks for the external data in the external project (which would cause the project to be loaded in the background). If this external data is different than the current data stored in the first project being opened (for example, project B) then Microsoft Project displays the Cross Project Links dialog (as follows) that shows all external links. You can easily find those links that have changed by looking in the Differences column.

Project A Not in Memory and 'Show ... dialog on open' is OFF

'Automatically accept...' is ON

When opening the project, it looks for the external data in the external project. Any changed data automatically is updated in the current project with no prompting from you.

'Automatically accept...' is OFF

When opening the project, it does not look for the external data. If you display the Links Between Projects dialog, at that point it looks for the external data.

Links Between Projects Dialog

You can use the Tools menu Links Between Projects command to see the cross project links.

Tools Links Between Projects command...
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Links Between Projects dialog
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The Links Between Projects dialog displays all the cross-project predecessors and successors for the current project with information about what changed in the current This dialog also show links whose source project cannot be found, or whose source task cannot be found. 

From this dialog you can repair broken links, and choose to accept or not accept new data concerning a cross project link, and edit or delete a cross project link (and thus the ghost task as well).

When the dialog is displayed, if it hasn't already retrieved the external information, it opens up all the external projects in order to obtain this external information.
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It has one tab that shows the external predecessor tasks and another that shows the external successor tasks.

The internal task’s regular ID number sorts each tab. If an internal task has a predecessor and successor external link, then that task appears on both tabs.

The Task column shows the internal and ghost task pair that constitute a cross project link. The internal tasks are aligned to the left and have an ID number. The ghost task is indented under it. On the same line as the ghost task is Type, Date, % Complete and Difference information. The name, type, date and % Complete fields reflect the old information for example, the information stored in the current project. The differences field is used to inform you what data has changed in the external project and its new value. The current project's internal data on the external task and cross project link changes to this new value when you accept the change.

Type shows the link type and any lag or lead information about the external link.

Date is either the start date or the finish date of the external task. If the link is connected to the start date of the external task, then the date is start date. If the link is connected to the finish date of the external task then the date is the finish date of the external task. It uses the date format selected in the Internal Project.

%Comp. shows the % Complete value for the external task. 

Differences provides information about what has changed in the external task from the external project since it was last updated in the internal project, or it lets you know that the external task or project file could not be found. If more than one piece of information changed, then the changes are listed on separate lines.

Kinds of information displayed in the Differences column:

· Name to <new name>  is displayed when the task name changed.

· Finish to <new finish> is displayed when the finish date changed and the link depends on the finish date.

· Start to <new start> is displayed when the start date changed to a new date X and the link depends on the start date.

· Type to <new type> is displayed when the link type changed.

· Link Deleted is displayed when Microsoft Project detects that the link is deleted from the other project.

· Task Not Found is displayed when Microsoft Project can’t find the external task within the external project.

· Project Not Found is displayed when Microsoft Project can find the project file or DSN but not the project name specified. You can use the Browse dialog to find a renamed or moved project.

· File Not Found is displayed when it can’t find the project file or DSN. You can use the Browse dialog to find a moved or renamed external project file.

· File Located is displayed when you have manually corrected a File Not Found or Project Not Found condition. Note that if there are any changes in the file that it finds, it automatically accepts them.

· None is displayed to indicate that no changes have been made to the external task or link.

The Accept button accepts all the changed information for the selected task. 

The All button accepts the changed information for all links in the dialog.

The Browse button lets you repair the path for an external project file that may have been moved or renamed.

The Delete Link button deletes the selected cross project link and removes the external task from the current project.

Project Calculations

No project is recalculated unless you explicitly open it.

Suppose that project A has links to project B and B has links back into A, and you only open project B. Microsoft Project reads in dates from project A (provided you say it's ok to update links). Microsoft Project does not recalculate tasks in project A, even though their predecessors in project B may have changed. 

You have to open all the appropriate projects before everything can be recalculated.

Circular Loop Detection

If you try to create a circular link loop in a single project, Microsoft Project can detect this condition and not allow you to create the link. This is more difficult to detect and solve when the links are spread among a number of different projects. 

It is possible to create such loops by creating links while not having all the projects open. For example, assume that x, y and z represent single tasks in projects A, B and C. If you link x to y and y to z, and then close B, and link z link to x, you have created a circular link

x -> y -> z -> x

Microsoft Project only detects such loops among currently opened projects.

Lesson 8.2 - Exercises

1. 
What does the term cross project link mean?

2. 
In a non-consolidated project, describe a way to create an external predecessor directly in a task table and a way to create it in the Task Information dialog.

3. 
In what situation can you create a cross project link by using the mouse to connect two bars displayed on the Gantt Chart?

4. 
What is an external predecessor and an external successor, and what dialog gives you a complete list of them along with any information about changes to the external tasks that are out of sync with local (cached) copies of the external task information?

5. 
In what situation is an external predecessor displayed as a ghost task and in what situation is it displayed as a normal task?

6. 
Suppose that task T1 in project P1.mpp is a predecessor of task T2 in project P2.mpp. If you open P1.mpp and enter "hello" in the Text1 field for T1 and then switch to P2.mpp and look at the ghost of T1 in P2.mpp, does the ghost have "hello" in Text1?

Is this behavior the same for all task fields?

7. 
What option settings control the display of ghost tasks and the behavior when a project with external predecessors or successors is opened?

What new Show For ... condition in the Gantt Chart Bar Styles is used to display ghost task bars?

Lesson 8.2 - Lab

1. 
Create folders c:\folder1, c:\folder2, and c:\folder3.

2.
Create a project with tasks TA, TB, and TC (with ID's 1,2, and 3) and save it as P1.mpp in the c:\folder1.  Create a project with tasks TD, TE, and TF (with ID's 1,2, and 3) and save it as P2.mpp in the c:\folder2.  Create a project and insert P1.mpp and P2.mpp both at outline level 1, and then save the container project as Consol.mpp to c:\folder3.

3. 
With Consol.mpp active, use the mouse on the Gantt Chart to make TB be a predecessor of TE. Neither TB nor TE will be displayed as a ghost task.

4. 
Close all projects and reopen P2.mpp. TB should be displayed as a ghost task. Click Links Between Projects on the Tools menu and examine the information.

5. 
In the Gantt Chart in P2.mpp, select TB and TE (at the same time) and click the Unlink Tasks tool button. TB should disappear.

6. 
In the Predecessors field for task TE, enter the following: c:\folder1\P1.mpp\2


This should cause the ghost TB to reappear.

Lesson 8.3:  Resource Pools

Some Topics to be introduced in this lesson include:

· New Resource Pool architecture: Pool contains all assignment information so you can see assignment across all sharers even if they are not all open

· Alerts and choices displayed when opening a pool or sharer when not all the related projects are open

· Opening pool read-only so other users are not locked out

· New Update and Refresh pool commands for writing/reading from a pool (even if the pool is read only)

· Sharing links use UNC notation

Resource Pools

Microsoft Project 98 stores assignment information in the sharer projects and in the pool. If the sharer is available, Microsoft Project uses the information in the sharer. If the sharer is not available, Microsoft Project uses the duplicated information in the pool. 

This allows you to see allocation of resources across all projects in the pool without requiring all sharers to be open. It also allows you to make changes to projects without having the pool open read-write.

Microsoft Project 98 supports the following new features:

· Pool files automatically open read-only.

· You can refresh the pool to see changes other users made.

· You can update the pool to save (replicate) your changes to the pool for other users to see.

How Resource Sharing works in Microsoft Project 4.x

Microsoft Project 4.x only tracks the assignments for tasks in open sharer projects

Assignments are saved in the sharer projects, not in the pool. This allows you to open the sharer projects without having to connect to the pool to get the assignment information.

Drawbacks

The main deficiencies in the Microsoft Project 4.x architecture are:

· You need to open all projects that use the pool in order to know the resource allocation across all the projects.

· Only one user at a time can have the pool open for read/write, and so only one user at a time can save information to the pool.

Information stored in the Pool

In Microsoft Project 98, the resource pool includes all resource information for the resources in the pool. Information such as Name, Standard Rate, and Calendar is stored in the pool. This information is replicated in the sharer so that the sharer can be opened when the pool opens, still allowing the user to see all the resource information.

Information stored in a Sharer

All information about the assignments in a sharer is stored in the sharer, including the name of the task and resource involved in the assignment and the assignment Units, Work, and Work Contour. This information is replicated in the pool so that each sharer can see the assignment information from other sharers (by opening the pool) without having to open the other sharers. If a sharer is open, then the pool uses the information stored in the sharer.

Example

Project files Sharer1.mpp, Sharer2.mpp, and Sharer3.mpp all use resources from Pool.mpp. Sharer1.mpp and Sharer2.mpp are currently open (possibly by different users across a network). 

Sharer1.mpp and Sharer2.mpp use the resource information in the Pool.mpp instead of their own replicated resource information. 

Pool.mpp uses the assignment information in Sharer1.mpp and Sharer2.mpp, but also uses the cached replicated assignment information from the unopened sharer, Share3.mpp.

Viewing task, resources and assignments

In a task view such as the Task Usage view, you can only see the tasks that belong to the current project, even if the pool and all sharers are open. To view task records from multiple projects, you need to use the Insert Project feature to have all the projects of interest in a common container project. This is true whether resource sharing is involved or not.

In the Resource Usage view, if the pool is open, you can see all the resources in the pool and all the cached assignment records from all the sharers. If the pool is not open, then you can only see the resources actually being used by the active project and the assignments for the resources on tasks that belong to the active project.

Opening a Pool or Sharer

In Microsoft Project 4.x, when you open a pool or sharer, Microsoft Project asks if you want to open the pool and other sharers so that you can see all the assignment information across all the sharers.

If you choose to open all these other files, other users are locked out from updating their own files.

Microsoft Project 98 has improvements on how the pool and sharers are opened and shared between multiple users.

Opening the Pool

When opening the pool, the following Alert is displayed:

Alert displayed when you open a pool...
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The three choices that are discussed follow:

Open resource pool read-only…

If this option is chosen, the resource pool is opened read-only.

Open resource pool read-write…

If this option is chosen, the resource pool is opened read-write.

Open resource pool and all other sharer files…

If this option is chosen, the resource pool is opened read-only unless you are the Author of the pool, as specified in the File Properties Summary tab, so you can edit any tasks you may have created in the pool.

In addition, a new project is created, and all of the sharer files are opened (invisibly if they are not already open) and inserted into the new container project (also known as master or consolidated project). All the sharer files are opened read-only, except the ones that you Authored (as in the File Properties Summary tab).

Opening a Sharer

When you open a sharer project, if the pool is not already open, the following Alert is displayed:

Alert displayed if you open a sharer when the pool is not open...

[image: image1126.png]Open Resource Pool Information

This il shares resources from a resource pool, What do you want to
do?

Vou can:
& Open resource pool to sse assignments across al sharer fies,

Open resource pool and all ther sharer fils to see al tasks i ol
projects sharing the same resources

Do not open other fies.

= b





The three choices that are discussed follow:

Open resource pool…

If this option is chosen, the resource pool is opened read-only.

If you want the resource pool to be read-write (resulting in faster operation, but locking out other users), then you need to open the file directly instead of having Microsoft Project open the pool for you through the above Alert.

Open resource pool and all other sharer files…

If this option is chosen, the resource pool is opened read-only.

In addition, a new project is created, and all of the sharer files are opened (invisibly if they are not already open) and inserted into the new container project (also known as master or consolidated project). All the sharer files are opened read-only, except the ones that you are the Authored (as in the File Properties Summary tab).

Do not open other files

If this option is chosen, then no other files are opened.

Updating the Pool

Since in default cases you have the pool open read-only, none of the changes you make in your own file update the information in the pool.

The Update Resource Pool command on the Tools Resources submenu allows you to update the pool with new information from the active sharer project. 

Note: The Update Resource Pool and the Refresh Resource Pool commands are disabled (grayed out) if the Pool is already open read-write, or if the active project does not use resources from a pool. The Refresh Resource Pool command is discussed later.

Tools Resources Update/Refresh Resource Pool commands...
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When you use the Update Resource Pool command, the pool is closed and then re-opened read-write. The pool is then updated with information from the active sharer project and then saved, closed, and re-opened read-only again. During this process, a sequence of messages is displayed on the status bar at the bottom of the window along with a progress meter bar. For example, if the pool is called Pool.mpp, the sequence of messages would be: Closing 'Pool.mpp', Opening 'Pool.mpp', Saving 'Pool.mpp', Closing 'Pool.mpp', and Opening 'Pool.mpp'.

The pool is only updated if something changed in the active sharer project that needs to be saved in the pool.

· Assignment records are always copied from the sharer to the pool. 

· Resource records that exist only in one of the two files, the sharer or pool, are copied from the file containing the record to the file that doesn't have it.

· Resource records that exist in both the sharer and the pool could be copied either way depending on the precedence setting in the Share Resources dialog. If the Pool takes precedence option is selected in the Share Resources dialog, then resource records are copied from the Pool to the Sharer. Otherwise resource records are copied from the sharer to the pool.

Share Resources on the Tools Resources submenu displays this...
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Updating the pool when there are multiple sharers open

If more than one project is open and using the same pool file when you use the Update Resource Pool command, the following Alert is displayed:

Update Resource Pool command displays this if multiple sharers are open...
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Closing a sharer without updating the pool manually

If you save a sharer file and then try to close it, if any changes have been saved in the sharer that have not updated in the pool, the following Alert is displayed:
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Refreshing the Pool

To see changes another user may have made to the pool during your edit session, you can use the Refresh Resource Pool command on the Tools Resources submenu.

This command refreshes (reloads) the pool with the most current information. It closes the current read-only version of the pool you are using, and then reopens the (most recent) version of the pool read-only.

Note: The Update Resource Pool and the Refresh Resource Pool commands are disabled (grayed out) if the Pool is already open read-write, or it the active project does not use resources from a pool.

Local Options

In Microsoft Project 98, as in Microsoft Project 4.x, the local Tools Options settings stored in the current project are used, except for resource specific settings, such as default pay rates, which are taken from the pool.

Lesson 8.3 - Exercises

1. 
Suppose P1.mpp, P2.mpp and P3.mpp all use resources from Pool.mpp. If you want to edit the tasks in P1.mpp but also see assignments involving all tasks from P2.mpp and P3.mpp, which of the following should you do? (Assume all cached information is currently synchronized.)

A. You only need to open P1.mpp because it has cached information on all other sharers.

B. You only need to open P1.mpp and Pool.mpp because Pool.mpp has cached information on all other sharers.

C. You must open P1.mpp, P2.mpp, P3.mpp, and Pool.mpp. 

D. The only way to see assignments from other sharer projects is to insert all the sharer projects into the pool project.

2. 
In Microsoft Project 98, if projects P1.mpp, P2.mpp and P3.mpp all use resources from Pool.mpp, is it possible to see totals on what resources are doing only on tasks from P1.mpp and P2.mpp (but not P3.mpp)?  Could this be done in Microsoft Project 95?

3. 
If you open a sharer project and open the pool project read-only, what kind of information can you edit that will get written back to the pool when you use the Update Resource Pool command?

A. Edits to Standard Rates for existing resources.

B. New assignments involving existing resources and existing tasks.

C. New resources.

D. New tasks.

4. 
What's the difference between the Update Resource Pool and Refresh Resource Pool commands?

Lesson 8.3 - Lab

This lab requires two workstation computers to store sharer projects and another computer or server to store a shared pool project. The steps below refer to these as computer1, computer2, and server1. You can do this lab alone if you have the available computers. In a classroom setting, the lab can be expanded to allow more sharer projects.

1.
Create a project containing several resources, but no tasks, and save it as Pool.mpp to a folder on server1. Close Pool.mpp.

2.
On computer1, open Pool.mpp. Create a project containing several tasks and save it as Sharer1.mpp to a folder on computer1. Use the Tools Resources Share Resources submenu command to specify that Sharer1.mpp uses resources from Pool.mpp. Close all projects.

3.
On computer2, open Pool.mpp. Create a project containing several tasks and save it as Sharer2.mpp to a folder on computer2. Use the Tools Resources Share Resources submenu command to specify that Sharer2.mpp uses resources from Pool.mpp.  Close all projects.

4.
On computer1, open Sharer1.mpp. When prompted, choose to open Pool.mpp read-only.

5.
On computer2, open Sharer2.mpp. When prompted, choose to open Pool.mpp read-only. Assign an existing resource to an existing task. Create a new task and new resource and assign the new resource to the new task. Use the Update Resource Pool command.

6.
On computer1, use the Refresh Resource Pool command and see if the changes made on computer2 show up on computer1.
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Some topics to be introduced in this lesson include:

· Overview of the new Microsoft( Project 98 workgroup features

· Online Help comparison of e-mail versus Web messaging

Workgroup Features Overview

Microsoft Project 98 has the following new or improved workgroup features:

· Web support: Microsoft Project 98 offers you the option to use e-mail, a Web server, or both for workgroup messaging. It includes a special Web server application that can be used to handle workgroup messaging features that were handled only through e-mail systems in Microsoft Project 4.x. 

· TeamStatus messages can include a timesheet grid so resources can report actuals on a day-by-day or week-by-week basis, or report only totals. A date range can be specified instead of a single status date.

· Resources can repeatedly open and save partially filled TeamStatus messages in their inbox and send them to the manager when they complete the report. They can even create unsolicited reports, rather than waiting to receive a TeamStatus message from the manager.

· Microsoft Outlook( integration: The project Set Reminder feature now works with Outlook, and Microsoft Project file names can be logged in the Outlook Journal every time you save or close a project. More Microsoft Project fields can be linked to custom OLE properties. Also, if a resource accepts a TeamAssign, the task gets saved in the Tasks window.

Web Workgroup Features

Microsoft Project 98 has the following new commands and options related to Web workgroup messaging:

· The new WebInbox command on the Tools/Workgroup menu displays all of the Web workgroup messages.

· The new Workgroup tab in the Options dialog box includes settings for where the Web server is and whether users will be using the Web, e-mail, or both for workgroup messaging.

For a manager using Microsoft Project 98, working with users who are on the Internet versus those who use e-mail is nearly transparent. The manager uses an e-mail application to communicate with resources using e-mail and uses the new WebInbox command to communicate with resources using the Web. 

For a resource using the Web workgroup messaging rather than logging on to e-mail to see new workgroup messages from the manager, the resource instead uses a Web browser to run the Microsoft Project 98 Web application from the Web server. The Microsoft Project 98 Web application includes the following:

· A logon screen where the resource enters their name and password.

· An inbox where resources can see all of their messages. Each message will appear as a hyperlink in the inbox that the resource can click to read.

· Web workgroup messages, which are similar to e-mail workgroup messages.

· A task list where resources can see all of the tasks that are assigned to them and can enter period-based actuals, similar to the e-mail-based TeamStatus messages.

Web vs. E-mail

The following Microsoft Project 98 Help topic, Differences between communicating through e-mail and a web, contains a brief overview of the differences between using e-mail versus a Web for workgroup messaging.

Communicating through e-mail

When communicating through a MAPI-compliant, 32-bit e-mail system, the workgroup manager and workgroup members have access to a common e-mail system and each person has an e-mail address. The workgroup manager sets up Microsoft Project to use e-mail as a means of workgroup communication and ensures that Microsoft Project will recognize the correct e-mail address for each person. Workgroup members who do not have Microsoft Project need to run WGsetup.exe on their computers to enable their e-mail program to correctly process the workgroup messages that the workgroup manager sends them. This program is available on the Microsoft Project CD.

When the workgroup manager, using Microsoft Project, sends workgroup messages (such as task assignments) to workgroup members, those workgroup messages appear as new mail items in the workgroup members' e-mail inboxes. When workgroup members reply to these messages, they appear as new mail items in the workgroup manager's e-mail inbox.

Communicating through a Web

When communicating through a Web—whether it's an intranet or the Internet—the workgroup manager and workgroup members have access to a common Web server. When the workgroup manager sets up Microsoft Project to use Web communication, Microsoft Project then installs the TeamInbox on the Web server. The workgroup manager, using Microsoft Project, can then send workgroup messages (such as task assignments) to workgroup members—the workgroup messages are posted in the TeamInbox.

Resources can then use their Web browser to open the TeamInbox, much as they would any other Web site, except that the TeamInbox has a logon screen to make the site secure. Once workgroup members log on, they will see the workgroup messages that the workgroup manager has sent to them arranged in an interface analogous to an e-mail client program. When workgroup members reply to the messages, the TeamInbox alerts Microsoft Project, which in turn alerts the workgroup manager. The workgroup manager can then view these responses from within Microsoft Project, using the WebInbox, and update the schedule accordingly.

By design, the TeamInbox acts as a remote outpost. Workgroup members who use the TeamInbox do not use Microsoft Project to access it. They simply use the TeamInbox as a means of receiving and tracking task assignments across an intranet or the Internet and as a means of sending updates to the workgroup manager.

Lesson 9.1 - Exercises

1. 
What are the four major new or improved workgroup messaging features in Microsoft Project 98?

Lesson 9.2: E-mail-based Workgroup Messaging

Some topics to be introduced in this lesson include:

· Sending workgroup messages from Microsoft Project

· Outlook Integration

· Team Manager Integration

E-mail-based Workgroup Messaging

This lesson assumes that both the manager and resources use the Microsoft Project 98 message handler, except for the last section on compatibility with Microsoft Project 95 and Team Manager.

This lesson discusses the new or improved workgroup features in Microsoft Project 98 compared to Microsoft Project 4.x. Features that do not change from Microsoft Project 4.x are discussed briefly or not at all.

Microsoft Project 98 improvements to e-mail-based workgroup features include the following:

· An updated message handler written in C instead of Microsoft Visual Basic(.

· Daily columns and/or overtime columns in TeamStatus messages. Now resources can enter period-by-period data in a timescaled grid. Microsoft Project 4.x only allowed totals to be reported rather than a timephased report, such as a daily or weekly timesheet.

· Resources can save partially completed TeamStatus messages in their inbox, and finish and send them later.

· Resources can generate TeamStatus messages without having to receive them from the project manager. The unsolicited status messages can then be sent to the project manager.

· Integration with Outlook (Microsoft Project 4.x could store tasks in Schedule+, but not Outlook). 

Supported Mail Servers

· Microsoft Mail 32

· Microsoft Exchange

· Lotus cc:Mail (version 7.0 or later)

· Lotus Notes (version 4.5a or later)

Updated Message Handler

Some of the features of the new Microsoft Project 98 message handler are:

· It is written in C instead of Microsoft Visual Basic.

· It uses the MTM message format that Team Manager uses, instead of the MPM format used by Microsoft Project 4.x. However, Team Manager does not display multicolumn timesheets sent in Microsoft Project 98 TeamStatus messages. It only shows total completed and remaining data. This is discussed in detail later. 

· It does not support VIM (Microsoft Project 4.x does). New MAPI versions of Lotus cc:Mail make continued support of VIM unnecessary.

Sending Workgroup Messages

The Tools/Workgroup submenu contains the three main workgroup e-mail commands used to communicate with resources.

Microsoft Project 98 workgroup e-mail commands.
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· TeamAssign messages notify resources that you want to assign them to tasks.

· TeamUpdate messages notify resources about changes to their tasks (that they are already assigned to and have accepted via a TeamAssign response); for example, if the task dates or durations have changed.

· TeamStatus messages ask resources to send update information to you regarding their progress on their tasks.

Terminology: When a resource opens one of these messages and sends a reply back to you, the reply messages are referred to as RE: TeamAssign, RE: TeamUpdate, and RE: TeamStatus messages, because those are the expressions that are automatically placed in the message subject field.

The TeamAssign and TeamUpdate messages, and replies to those messages, are nearly the same in Microsoft Project 98 and Microsoft Project 95.

The TeamStatus and RE: TeamStatus messages now allow resources to report completed regular and overtime work on a period-by-period basis (for example day-by-day basis) in a timesheet grid.

Workgroup related fields

Workgroup-related field
Description

Confirmed
Yes/No task, resource, and assignment field. Rolls up to task and resource records from assignment records.

Read-only for task and resource records. Editable for assignment records. 

Automatically set to Yes when a resource replies affirmatively to a TeamAssign message and the manager opens the RE: TeamAssign message and clicks Update Project.

Update Needed
Yes/No task, resource, and assignment field. Rolls up to task and resource records from assignment records.

Read-only.

Automatically set to Yes when information about a confirmed assignment changes and the resource working on the assignment needs to know about the change (for example, when the assignment dates change). Set to No again after the resource responds affirmatively and the manager opens the RE: TeamUpdate message and clicks Update Project.

Response Pending
Yes/No task, resource, and assignment field. Rolls up to task and resource records from assignment records.

Read-only for task and resource records. Editable for assignment records. 

Automatically set to Yes when the manager sends a workgroup message regarding the assignment, and automatically set to No when the manager opens all of the reply messages and clicks Update Project. 

Team Status Pending
Yes/No task, resource, and assignment field. Rolls up to task and resource records from assignment records.

Read-only for task and resource records. Editable for assignment records. 

Like the Response Pending field, but specific to TeamStatus messages. 

Workgroup
Enumerated resource field with choices: Default, None, E-mail, Web, and E-mail and Web. Overrides the corresponding Default workgroup messaging for resources setting on the Workgroup tab in the Options dialog box.

Editable.

Improved Confirmed Field

Microsoft Project 4.x has a task field called Confirmed, which is automatically set to Yes when all resources respond affirmatively to the TeamAssign messages sent to them. There is an internal assignment Confirmed field, but because you cannot see it, there is no way to tell which assignments have not been confirmed (except to keep track yourself as you receive the RE: TeamAssign messages).

In Microsoft Project 98, one major improvement of the RE: TeamAssign message is that it updates the assignment Confirmed field. 

In Microsoft Project 98, the Confirmed field is also a resource and assignment field. It is read-only for task and resource records and rolls up from the corresponding assignments (Yes only if all the corresponding assignments are set to Yes). The assignment Confirmed field is also editable, so it can be set manually if desired.

Example

This example illustrates the behavior of the new assignment Confirmed field in Microsoft Project 98. Some of the pictures in this example have altered aspect ratios or have been cropped.

The picture that follows shows the Task Usage view with the Confirmed field before any TeamAssign messages have been sent.

Before sending the TeamAssign messages...
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The manager then selects the TeamAssign command on the Tools/Workgroup menu. 

If any records are selected at that time, the manager is offered a choice to send TeamAssign messages for all tasks or just the selected tasks. If no records are selected, it defaults to sending messages for all tasks.
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The picture that follows shows the TeamAssign form for sending messages to both tasks.

Preparing to send the TeamAssign messages from Microsoft Project 98...
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The next picture shows what the resource Paula Jones sees when she opens the TeamAssign message in her Inbox.

Resource opens the TeamAssign message...
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After the resource clicks Reply and Send, the manager receives the confirmation message as shown.

Manager opens the affirmative reply...
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The manager can click Update Project to set the appropriate Confirmed fields in the project file. 

If the manager chooses to send a reply without updating the project, an alert is displayed.
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The next picture shows the result of updating the project with the confirmation from Paula.

Corresponding assignment Confirmed field is set to Yes...
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New TeamStatus Features

Microsoft Project 98 allows resources to report actuals in an improved TeamStatus message that contains a timesheet grid for entering actuals on a period-by-period basis.

The manager controls the granularity of the timesheet grid by using the Workgroup command on the Tools/Customize menu.
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The choices for the Ask for completed work setting in the Customize Workgroup dialog box are shown with samples of what the messages looks like when opened by a resource from the Inbox.
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From 6/2 to 6/20,

Ask for completed work...
Sample of part of the TeamStatus timesheet grid opened by the resource from the Inbox...

as a total for the entire period
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broken down by day
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broken down by week
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When a manager uses the TeamStatus command, the major difference in the TeamStatus form in Microsoft Project 98 is the replacement of the Update as of control setting with the new Ask for Actual Work from…to... settings. This allows the manager to specify a date range for the reports, rather than just a status date.

Note: The manager doesn't see the grid in Microsoft Project 98 when preparing to send the message. The manager does see the timesheet grid when he or she opens RE: TeamStatus reports sent back from the resource.

When resources open the TeamStatus message in their Inbox, they can enter actuals and send the reply back to the manager, or they can use the new Save and Send Later button to save the message back to their Inbox.

If the resource makes changes and clicks the Close button, an alert asks if the resource wants to save changes to the Inbox.

The resource can continue to open and resave the message as he or she fills in the actuals until the resource is ready to send the report back to the manager (at which time the message is removed from the Inbox).
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Resources can also generate unsolicited status reports without first receiving a TeamStatus message from the manager. This is discussed in a later section.

Example

This example illustrates the new TeamStatus form in Microsoft Project 98 and its appearance when opened by a resource with the Microsoft Project 98 message handler.

The picture that follows shows the Task Usage view before any actuals have been reported.

Before updating project with actuals...
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The next picture shows the manager in Microsoft Project 98 preparing to send TeamStatus messages asking for actuals from 6/2 to 6/6 on a day-by-day basis (as specified in the Customize Workgroup dialog box).

TeamStatus form in Microsoft Project 98...
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The next picture shows what the resource Paula Jones sees when she opens the TeamStatus message in her Inbox (using the Microsoft Project 98 message handler). 

Resource opens the TeamStatus message...
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If the resource clicks the Reply button, or starts entering actuals, the Reply button changes to Send button. After the resource enter actuals, he or she can then click the Send button or click the new Save and Send Later button.

The resource Paula then completes the actual and remaining work fields in the form and sends the form back to the manager. 

The next picture shows the data that she enters and what the manager Joe sees when he opens the RE: TeamStatus message. Paula reports 4 days of actual work on task T1 with 3 days left to do. For example, she needs 2 extra days in addition to the original 5 days scheduled. She reports no actuals on task T2, which doesn't start until 6/9 anyway.

Manager opens the reported actuals message sent from the resource...
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The manager now clicks Update Project. The picture that follows shows the resulting updates to Paula's assignment on task T1 in the project.
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Overtime

Managers can use the Track overtime work setting in the Customize Workgroup dialog box to control whether overtime columns are included in TeamStatus messages.
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The picture to the right shows the Overtime column in the TeamStatus form in Microsoft Project 98 before it is sent.
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When the resource opens the TeamStatus message, there is a separate Overtime column for each period column. The picture at the right illustrates this for a day-by-day timesheet.
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Additional Customizable Workgroup Fields

The Customize Workgroup dialog box in Microsoft Project (displayed with the Workgroup command on the Tools/Customize menu) has Add, Remove, Move Up, and Move Down buttons that can be used to add custom fields to the workgroup messages. The multicolumn table that follows lists the fields you can put in a workgroup message. Note that there is a separate Track overtime work check box for adding overtime work columns to TeamStatus messages.

Cost4
Cost5
Cost6
Cost7
Cost8
Cost9

Cost10
Date1
Date2
Date3
Date4
Date5

Date6
Date7
Date8
Date9
Date10
Duration1

Duration2
Duration3
Duration4
Duration5
Duration6
Duration7

Duration8
Duration9
Duration10
Flag11
Flag12
Flag13

Flag14
Flag15
Flag16
Flag17
Flag18
Flag19

Flag20
Finish6
Finish7
Finish8
Finish9
Finish10

Start6
Start7
Start8
Start9
Start10
Number6

Number7
Number8
Number9
Number10
Number11
Number12

Number13
Number14
Number15
Number16
Number17
Number18

Number19
Number20
Text11
Text12
Text13
Text14

Text15
Text16
Text17
Text18
Text19
Text20

Text21
Text22
Text23
Text24
Text25
Text26

Text27
Text28
Text29
Text30



Outlook Integration 

Microsoft Project 98 integrates with Outlook, not Schedule+ as Microsoft Project 4.x did.

The TeamStatus messages saved in the Inbox correspond to project tasks listed in the Outlook Tasks window.
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Mapping between Microsoft Project 98 and Outlook fields

Here are the mappings between the basic Microsoft Project 98 fields and Outlook fields, not including the work fields, which are discussed later. 

The arrows in the second column indicate which way the data can be updated.

Microsoft Project 98 field

Outlook field

Contact
(
Contacts. Only maps the first contact. Contacts after the first are discarded.

Finish
(
Due date

Priority
(
Importance
Microsoft Project 98



Outlook
Do not level, Highest, Very High, Higher, High
High

Medium





Normal

Low, Lower, Very Low, Lowest


Low

Project
(
Categories

Start
(
Start Date

Task Name
(
Subject

All other Microsoft Project workgroup fields (not including work fields) are ignored.

Work-related calculations between Microsoft Project and Outlook

Outlook uses a hidden field called Reported Work to store the total amount of actual work that is reported in TeamStatus reports.

Whenever a RE: TeamStatus form is opened, it resynchronizes the work with Outlook.

Outlook has the following work-related fields: Total Work, Actual Work, and Percent Complete. The table that follows shows how various fields are recomputed based on what fields changed.

The letters A, T, and P in the cells stand for Actual Work, Total Work, and Percent Complete.

The white cells in the first three columns indicate the fields that are changed or edited. The shaded cells are the fields that changed. The rest of the columns explain what fields are calculated under various conditions. For example, the first row shows the effect of editing Percent Complete and leaves Actual Work and Total Work alone.

Act
Total
PC
Condition
Act
Total
PC

A
T
P
(all)
T ( P
T
P

A
T
P
if T = 0
0
0
P




if T ( 0
A
T
A ( T

A
T
P
if A > T
A
A
100




if A ( T and T ( 0
A
T
A ( T




if A = 0 and T = 0
0
0
P

A
T
P
(all)
T ( (1 / P)
T
P

A
T
P
(all)
A
A ( (1 / P)
P

A
T
P
if A > T 
A
A
100




if A ( T and T ( 0
A
T
A ( T




if A = 0 and T = 0
0
0
P

A
T
P
(all)
A
A ( P
P

When you open a RE: TeamStatus message, the message handler does a calculation pass and fixes the values to make them consistent. This also happens when you reply to a TeamStatus message or save it back to your Inbox.

The calculation makes sure that the current actual work on the task is not decreased below the reported actuals for the task. If it is, it sets the actual work to the reported actual work, using the logic above for a single edit to actual work.

The message fields are set equal to the following:

· Period Actual Work = Actual Work ( Reported Work (evenly distributed for the period in the RE:TeamStatus message)

· Remaining Work = Total Work ( Actual Work

Then, whenever you close the form, or right before you send it, it writes values back to Outlook.

· Actual Work = Reported Work + Period Actual Work (including Overtime)

· Total Work = Reported Work + Period Actual Work (including Overtime) + Remaining Work

Finally, when the message is successfully sent, it sets reported work to actual work.

Changing Actual Work

When you edit the total standard rate actual work in Outlook, the following calculations occur.

If you increase the total actual work...
First, it determines the difference between what is already saved in the RE: TeamStatus message and the actual edited value in Outlook.

· Difference Work = Outlook Actual ( Reported Work ( Value saved in RE:TeamStatus

If there are cells in the period that don’t have values in them, it evenly distributes the difference across the empty standard rate cells. 

For example, suppose the RE: TeamStatus message originally contained the following values.

M
OT
T
OT
W
OT
T
OT
F
OT

8h
2h
8h
2h
8h






If you increase the total actual work by 16h, then the RE: TeamStatus values change to the following.

M
OT
T
OT
W
OT
T
OT
F
OT

8h
2h
8h
2h
8h

8h

8h


If there are no empty cells in the period, it then adds the difference work to the last standard rate cell. For example, suppose the RE: TeamStatus message originally contained the following values.

M
OT
T
OT
W
OT
T
OT
F
OT

8h

8h

8h

8h

8h


If you increase the total actual work by 16h, then the RE: TeamStatus values change to the following.

M
OT
T
OT
W
OT
T
OT
F
OT

8h

8h

8h

8h

24h


If the you decrease the total actual work...
First, it determines the difference between what was already saved in the RE: TeamStatus message and the actual edited value in Outlook (this is a negative number now).

· Difference Work = Outlook Actual ( Reported Work ( Value saved in RE:TeamStatus

Decreased actuals are entered in the RE: TeamStatus message, starting with the latest entered actual, and working toward the earliest entered actuals. Other values are removed.

Overtime work, if any, is removed if the corresponding work is removed.

For example, suppose the RE: TeamStatus message originally contained the following values.

M
OT
T
OT
W
OT
T
OT
F
OT

8h
2h
8h
2h
8h






If you decrease the total actual work by 16h, then the RE: TeamStatus values change to the following.

M
OT
T
OT
W
OT
T
OT
F
OT

8h
2h
2h








If you enter total actual work that is below the reported total work, then the RE:TeamStatus message has no zero actual work. 

Adding/Deleting Tasks

There is no way to add new project tasks from Outlook, and if you delete a task in Outlook, it doesn't send a deletion notice to the project manager.

Unsolicited TeamStatus Reports

Microsoft Project 98 adds the New TeamStatus Report command to the Tasks menu in the Outlook Tasks window.

If you use the command and there are no Microsoft Project tasks in Outlook (from TeamAssign messages sent by project managers), then an alert is displayed.
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If there are Microsoft Project tasks in the Outlook Tasks window, then the above command displays the New Status Report dialog box (shown as follows), which allows the resource to select which project he or she wants to send a report on. The resource can also choose a date From/To date range, the timescale granularity, and whether it should include overtime.

All the controls except the choice of project have equivalent controls in the Customize Workgroup dialog box in Microsoft Project.

When you click OK, the TeamStatus message saves in your Inbox, where you can open it and fill in actual values. You can then send it to the manager or save it in your Inbox to be completed and sent later.
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Setting Reminders in Outlook

Microsoft Project 4.x can set reminders in the manager's Schedule+ file (not the resource's Schedule+ file).

Microsoft Project 98 has a similar feature, but it stores the task and reminder in Outlook.

The table that follows shows what Microsoft Project task fields are stored in the Outlook Tasks window.
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The Microsoft Project 98 Set Reminder command stores the following task fields in Outlook...

Microsoft Project 98 field
Outlook field

Finish
Due Date

Priority
Importance
Microsoft Project 98




Outlook
Do not level, Highest, Very High, Higher, High
High

Medium





Normal

Low, Lower, Very Low, Lowest


Low

Project
Categories

Start
Start Date

Task Name
Subject

Microsoft Project does not set work values in a Set Reminder task in Outlook, because an Outlook task created by Set Reminder serves only as a reminder. Reminders can be set for any task, even tasks with no assignments, and have nothing to do with work or which resource is assigned. Reminders only get stored in the manager's Outlook Tasks window.

Detecting Outlook

Set Reminder can detect if Outlook is installed by checking the Registry.

Outlook with an Exchange Server

The first time Microsoft Project obtains a connection to Outlook, it uses the connection through the current Microsoft Project session. If Outlook is not running when it first tries to obtain the connection, Microsoft Project starts Outlook. If Outlook is running, Microsoft Project creates a connection with an existing instance of Outlook.

If you use the Set Reminders command when Outlook is running offline, Microsoft Project 98 tries to send data through the connection to Outlook, but Outlook won’t accept the data, so the transaction fails. The following alert is then displayed.

Set Reminder gives an alert if it cannot connect to Outlook...
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After you click OK, the Set Reminders command is disabled until you restart Microsoft Project 98. 

Outlook with a Microsoft Post Office

Set Reminder works even when Outlook is running offline.

Recurring Tasks

As in Microsoft Project 4.x, if you set a reminder for a recurring task, it creates a separate Outlook task and reminder for each child task in the series. 

If you select only a subset of the individual recurring tasks in the series, and do not select the parent summary task, it creates tasks and reminders only for the selected tasks.

Outlook Journal Integration

The Outlook Journal provides time-based recording and management of document-related events, such as when documents are saved and closed. This allows you to easily find documents by time. This time-based manner of locating documents has several advantages over the location-based method. First, it fits scenarios where you are not sure where a project is located but know approximately when you interacted with the project. Second, it cuts across storage hierarchies and allows you to access projects by time regardless of where they are stored.

To display the Outlook Journal, click the Journal icon on the Outlook Bar.

Microsoft Project entries in the Outlook journal showing when projects were modified...
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To add Microsoft Project events to the Outlook Journal, click the Journal icon on the Outlook Bar, click the Options command on the Tools menu, and click the Journal tab. In the Also record files from box, select the Microsoft Project check box.

Now whenever you modify a project, an entry will be added to the Outlook Journal.
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For additional information, please refer to article Q176311 in the Microsoft Knowledge Base at HTTP://Support.Microsoft.Com.

Registry

In order for Microsoft Project files to be journaled by Outlook, the following registry entry must exist and be set to 1.

HKEY_CURRENT_USER\Software\Microsoft\SharedTools\Outlook\Journaling\Microsoft Project\Enabled
When this key is set, Microsoft Project is added to the list of applications whose document events are journaled. This list can be seen and manipulated by you from Outlook only, via the Journal tab in the Options dialog box. There is no way in Microsoft Project 98 to control journaling of Microsoft Project events.

Logging Events

Microsoft Office has an API that controls the logging of events to the Journal. When a Microsoft Project event occurs, Microsoft Project passes only a file name to the Office API. Office then handles all the processing. If Outlook is not running, Office saves the journal entry and synchronizes it the next time Outlook is started. Microsoft Project does not communicate with Outlook directly during this process or provide any error handling. 

Events that Microsoft Project 98 Logs for the Journal

Microsoft Project 98 pass a file name to the Journal (Office Journal API) whenever you save or close a project (whether you modify it or not).

Opening an Item from the Journal

If you double-click a Microsoft Project entry in the Outlook Journal, select it and use the Outlook Open command on the File menu. The following Journal Entry dialog box is displayed, which includes a shortcut that you can use to open the project file.
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Custom OLE Properties

You can create custom OLE properties that can be displayed in the object properties when you post a project file to Microsoft Exchange. Custom OLE properties can also be used in a search field when searching for files in the Open dialog box.

Custom properties can be independent of the data in a project file, or they can link to specific Microsoft Project fields. Microsoft Project 95 had this feature, but Microsoft Project 98 expands the number of fields that can be used to define a linked custom property.

To define a custom property, click Properties on the File menu.

Use the File Properties command to display the Properties dialog box...
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Project Fields that can be Linked to Custom Properties

The following Microsoft Project 98 fields can be linked to custom properties.

% Complete
Baseline Finish
Finish Variance

% Work Complete
Baseline Start
Fixed Cost

Actual Cost
BCWP
Notes

Actual Duration
BCWS
Overtime Cost

Actual Finish
Contact
Overtime Work

Actual Overtime Cost
Cost
Remaining Cost

Actual Overtime Work
Cost Variance
Remaining Duration

Actual Start
Created
Remaining Work

Actual Work
CV
Start

ACWP
Duration
Start Variance

Baseline Cost
Duration Variance
Work

Baseline Duration
Finish
Work Variance

Compatibility with Microsoft Project 95 and Team Manager

In cases where Microsoft Project 95 or Team Manager can open Microsoft Project 98 messages, the opened messages appear as they would if they are sent by Microsoft Project 95.

Note: You must have Microsoft Team Manager SR1 in order to pass timephased information between Microsoft Team Manager and Microsoft Project 98.

Opening Microsoft Project 98 messages with the Microsoft Project 95 or Team Manager handlers:

· Microsoft Project 98 TeamAssign and TeamUpdate messages can be opened by the Microsoft Project 95 message handler (Openmail.exe) and the Team Manager message handler (Mtmmail.exe). The Microsoft Project 95 message handler can store the assigned tasks in Schedule+ (but not Outlook), and the Team Manager message handler can store the assigned tasks in the team file (and in Outlook or Schedule+).

· Microsoft Project 98 TeamStatus messages can be opened by the Microsoft Project 95 and by Team Manager message handlers. However, they do not display the Microsoft Project 98 multicolumn timesheet format. Instead, they display only total completed and remaining columns. 

Opening Microsoft Project 95 or Team Manager replies or status reports with the Microsoft Project 98 handler:

· Replies to TeamAssign and TeamUpdate messages sent by the Microsoft Project 95 or Team Manager message handler can be opened by the Microsoft Project 98 message handler in the same way they would be by the Microsoft Project 95 handler. The manager can then click the Update Project command in the opened message to set the appropriate Confirmed fields.

· Replies to TeamStatus messages sent by the Microsoft Project 95 or Team Manager message handler can be opened by the Microsoft Project 98 message handler.

However, an alert is displayed to inform you that the message contains only total completed work (rather than the timephased values Microsoft Project 98 is capable of handling).

This also occurs when the Microsoft Project 98 message handler opens an unsolicited status report from Team Manager (sent by choosing A Microsoft Project status report from the Team Manager Status Updates dialog box). Microsoft Project 95 did not have a feature to send unsolicited status reports.
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Opening Microsoft Project 95 TeamAssign, TeamUpdate, or TeamStatus messages with the Microsoft Project 98 handler

It is possible to use the Microsoft Project 98 handler to open Microsoft Project 95 TeamAssign, TeamUpdate, and TeamStatus messages. However, an alert is displayed when you try to open the message. It informs you that you will not be able to replay to the message.

If the project manager still uses Microsoft Project 95, then the resources will have to use the Microsoft Project 95 message handler if they want to reply to workgroup messages from the manager.
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Conversion between Microsoft Project 98 From/To and Status As Of

In Microsoft Project 98, the form displayed by clicking the TeamStatus command on the Tools/Workgroup menu includes fields for entering a date range for the status report. If the Microsoft Project 98 message handler is used to reply to the Microsoft Project 98 TeamStatus message, it too includes a From/To pair of dates.

From/To fields when creating a Microsoft Project 98 TeamStatus message...
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However, when the Microsoft Project 95 or Team Manager message handler is used to open the Microsoft Project 98 TeamStatus message, the From field is ignored and the To field is used as the Status As Of date.

A Microsoft Project 98 TeamStatus message opened by the Microsoft Project 95 message handler uses the To date as its Status As Of date...
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A Microsoft Project 98 TeamStatus message opened by the Team Manager message handler uses the day before the To date as its Completed Through date...
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If you use the Microsoft Project 98 message handler to open a reply to a TeamStatus message sent by the Team Manager message handler or if you open an unsolicited status message sent by the Team Manager message handler, then the Microsoft Project 98 message handler derives From and To dates as follows:

· It sets the To date equal to the message Status As Of date.

· It sets the From date to the earliest start date of all the tasks in the message.

The reason for this is that in Team Manager (and Microsoft Project 95), completed work is entered for the entire task up to the Status As Of date. 

Even though the original TeamStatus message sent by the Microsoft Project 98 message handler might ask for period actuals and overtime, the Team Manager reply coming back won’t have this information. So when the Microsoft Project 98 message handler opens the reply sent by the Team Manager handler, it only shows the completed work for the entire period, and without Overtime columns. 

Lesson 9.2 - Exercises

1. 
What e-mail systems does Microsoft Project 98 e-mail-based workgroup messaging support?

2. 
Is VIM supported? How about Microsoft Schedule+? 

3. 
In Microsoft Project 98, which task, resource, and assignment fields are specifically related to workgroup messaging? 

4.
How has the functionality of the Confirmed field changed in Microsoft Project 98 versus Microsoft Project 95?

5. 
If you want to include a timescaled grid with a TeamStatus message, how do you control the granularity of the grid (the time represented by each cell) and where can you enter a date range?

6. 
Can a resource create new Microsoft Project tasks in Microsoft Outlook? If yes, then how?

7. 
Can a resource create an unsolicited Microsoft Project TeamStatus report in Microsoft Outlook? If yes, then how?

8. 
What is the purpose of the Microsoft Outlook Journal and how can you have Microsoft Project 98 information automatically logged in the Journal? 

9.
What kind of Microsoft Project 98 information gets logged in the Journal?

Lesson 9.2 - Lab

1.
Create a project with a 2-week duration task and assign yourself to it (using a name that is recognized by your e-mail system). Save the project, and then send yourself a TeamAssign message.

2.
Open the TeamAssign message in Microsoft Outlook and reply to it affirmatively.

3.
Open the reply in Microsoft Outlook and click the Update Project button. Switch to the project and insert the Confirmed field in the task table in the Task Usage view. Examine the Confirmed field. Send yourself a TeamStatus message for reporting actuals during the first week of the task broken down by day.

4.
Open the TeamStatus message in Microsoft Outlook and fill in whatever values you like for the actual work for the first 2 days of the task and then save the message in your Inbox instead of replying. Next, reopen the message and fill in the rest of the actuals for the first week of the task and send the reply.

5.
Open the reply in Microsoft Outlook and click the Update Project button. Switch to the project and view the timephased actual work in the Task Usage view.

6.
Create an unsolicited TeamStatus message in Microsoft Outlook for reporting actuals during the second week of the task broken down by day. Fill in whatever values you like for the actual work for each day of the second week of the task and send the message.

7.
Open the unsolicited TeamStatus report in Microsoft Outlook and click the Update Project button. Switch to the project and view the timephased actual work in the Task Usage view.

Lesson 9.3: Web-based Workgroup Messaging

Some topics to be introduced in this lesson include:

· Supported platforms

· Setting up Web workgroup messaging

· Manager Web messaging interface

· Resource Web workgroup messaging interface

· Web-based workgroup messaging (MSHTML.EXE)

Web Workgroup Messaging

Note: The colors used in some of the pictures in this lesson are changed from the colors actually displayed by Microsoft Project. This is to decrease the size of this document and to increase the contrast in black and white printouts.

Microsoft Project 4.x supports workgroup messaging only through e-mail.

Microsoft Project 98 supports e-mail-based workgroup messaging, but in addition has a new Web workgroup messaging feature that allows resources to use a browser to access a shared workgroup storage site on an intranet or the Internet. The Web workgroup implementation closely mirrors the e-mail workgroup functionality.

A shared workgroup site (folder) is set up on a Web server for storing messages exchanged between the manager and the resources. The manager and the resources access the shared workgroup folder differently.

· The resources use a browser to access the Web site. They do not have to be connected directly to it through a network. For example, if the Microsoft Project site were published on the Internet, the resources could access it through any Internet service provider using a compatible browser, such as Microsoft Internet Explorer. 

· The manager, however, must be able to connect to the shared workgroup folder through a standard network, not through a browser. Microsoft Project uses a UNC path to communicate with the shared workgroup folder, not a URL. In particular, the manager cannot use a browser to send workgroup messages to the resources. Instead, the manager must have the project file open in Microsoft Project and use the workgroup commands on the Tools/Workgroup menu and must be able to access the workgroup folder through a network connection.

Microsoft Project Web workgroup architecture...
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Supported Configurations

Supported Web Servers

Microsoft Project 98 Web workgroup messaging has been tested on, and is supported on, the following Web servers:

· Microsoft IIS3.0 on WinNT4.0

· Microsoft Personal Web Server (PWS) on Win95. PWS ships with Microsoft Project 98

· Netscape Enterprise Server on WinNT4.0

· Netscape FastTrack Server on Win95

· O’Reilly WebSitePro on WinNT4.0

There has been no testing, and will be no support, for non-Windows-based servers.

Supported Browsers

Microsoft Project 98 Web workgroup messaging has been tested with, and is supported with, the following Web browsers:

· Microsoft Internet Explorer(, version 3.0 and 4.0

· Netscape Navigator, version 3.0 and 4.0

· Internet Explorer on the Macintosh( (version 3.x)

· Netscape Navigator on the Macintosh (version 3.x)

Other than the two Macintosh browsers listed above, no other non-Windows-based browsers are supported.

Manager Web Workgroup Setup

The manager installs web workgroup messaging on the Workgroup tab of the Options dialog box. If you fill in the Web Server URL and Web Server root boxes and click OK, Microsoft Project automatically attempts to install the Web workgroup messaging if it is not already installed. The specified site and folder must already exist and have the appropriate access rights. This is discussed in detail later. 

The New Tools Options Workgroup tab

New Tools Options Workgroup tab...
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The settings available on the Workgroup tab are as follows.

Default workgroup messaging for resources 

The starting global default is not E-mail, if a supported e-mail system is not detected during setup. 

The Default workgroup messaging for resources setting on the Workgroup tab sets the default value for the resource Workgroup field. The four options are None, Email, Web, and Email and Web. The starting global default is Email. Specified Web server settings only affect resources that use Web messaging. If you leave the default setting on Email and don't edit the Workgroup field for individual resources, then all resources use e-mail and the Web server settings are irrelevant. 

There is a new resource workgroup field (at right) that overrides the default setting. Also, if the old E-mail Address field contains the word None, then e-mail messages are not sent to the resource regardless of the Workgroup field setting (Web messages can still be sent). The Workgroup field also appears on the General tab of the Resource Information dialog box as follows.
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Workgroup field on the General tab of the Resource Information dialog box...
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Resource Sharing Scenarios

If a resource is in a pool, different projects using the pool may have different selections for the Default workgroup messaging for resources setting. 

When a resource is sent a workgroup message for a specific assignment, the default setting from the sharer project that contains the assignment takes precedence. This allows for scenarios where “project manager A” wants to track the project entirely using e-mail messaging, while “project manager B” wants to use Web messaging. 

However, these scenarios only apply to resources that have Default selected in the resource Workgroup field and that do not have the value None in the resource E-mail Address field. Any other values selected for the resource Workgroup and E-mail Address fields in the resource pool override the Default workgroup messaging for resources settings from sharer projects.

Web Server Settings 

The starting global defaults are blank. 

If you fill in the Web Server URL and Web Server root boxes on the Workgroup tab of the Options dialog box and click OK, Microsoft Project automatically attempts to install the Web workgroup messaging if it is not already installed. Also, if these settings are not blank, then the WebInbox command is enabled; otherwise it is disabled.

Web server settings on the Workgroup tab of the Options dialog box...
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Web Server URL (for resource) points to the Web site that will contain the Web workgroup application, mspjhttp.exe. Resources use this URL to run mspjhttp.exe.

Web Server root (for manager) is the UNC path to the network folder that will contain the Web workgroup application, mspjhttp.exe. 

Note that the commands on the Tools menu connect to the Microsoft Project Web folder through a standard network connection using a UNC path. The manager does not communicate through a browser over the Internet or an intranet.

Notify when new assignments arrive 

The starting global default is not selected. 
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 If the Notify when new web messages arrive setting is selected on the Workgroup tab of the Options dialog box, then the message that follows is displayed in Microsoft Project whenever workgroup messages from resources to the manager arrive in the Microsoft Project Web folder. Microsoft Project checks for new messages every 5 minutes. You cannot control how often Microsoft Project checks for new messages.
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If the WebInbox is already displayed, then the notification is not displayed. Instead, the WebInbox silently refreshes itself.

Send hyperlink in E-mail note 

The starting global default is not selected.
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 The Send hyperlink in E-mail note check box on the Workgroup tab of the Options dialog box indicates whether an e-mail notification message containing the Web URL is sent to resources when a new workgroup message is sent to them on the Web server. If the E-mail Address field for a resource contains the value None, then a notification is not sent to that resource.

The picture that follows shows a sample e-mail notification message that was sent to a resource when a TeamAssign Web message was sent. Click the hyperlink to go to the Microsoft Project Web login page, with Paula Jones selected for user name (she still has to enter her password in the login page and click the Go button). The Web login page is discussed later.

E-mail notification with a hyperlink...
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The Hyperlink appearance settings 

The Hyperlink appearance settings on the Workgroup tab of the Options dialog box are not related to workgroup messaging. They control the formatting of hyperlinks in Microsoft Project (such as in the Hyperlink field in a task or resource table).

Hyperlink appearance settings on the Workgroup tab of the Options dialog box...
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Hyperlink color is the color displayed for unfollowed hyperlinks. The starting global default is blue.

Followed hyperlink color is the color displayed for followed hyperlinks. The starting global default is purple.

Underline hyperlinks is a check box that indicates whether hyperlinks are underlined. The starting global default is for the check box to be selected.

Set as Default

The Set as Default button on the Workgroup tab of the Options dialog box takes all the current settings and makes them the global default settings for all new projects.

Setting up the Microsoft Project Web Workgroup site

No separate Web workgroup setup program is used.

If you fill in the Web Server URL and Web Server root boxes on the Workgroup tab of the Options dialog box and click OK, Microsoft Project automatically attempts to install the Web workgroup messaging if it is not already installed. The specified site and folder must already exist and have the appropriate access rights. You must be able to write to the Microsoft Project Web folder during installation. Which folder needs to have write access depends on the Web server being used, such as Microsoft Personal Web Server or Internet Information Server.

For example, if Microsoft Personal Web Server is being used and if the Microsoft Project Web folder is \\computer1\webshare\wwwroot\projweb (the URL is http://computer1/projweb), then when you click OK on the Workgroup tab of the Options dialog box, the Microsoft Project Web folder must exist and you must have write access to the Webshare folder. Otherwise the following alert is displayed.
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Provided that the Microsoft Project Web folder exists and you have write access to the appropriate Web folder, Microsoft Project displays the following alert if the Web workgroup messaging is not currently installed (properly).
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Note: The above alert occurs anytime you click OK on the Workgroup tab of the Options dialog box and you do not have write access to appropriate Web folder, even if Microsoft Project Web workgroup messaging is already installed properly on the Web server.

Initial folders and files installed

The right pane in the picture that follows shows folder and files installed under the (pre-existing) Microsoft Project Web workgroup folder on the Web server.
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The Bitmaps folder contains GIF format picture files used by the Microsoft Project Web application, mspjhttp.exe. 

The three files installed are described as follows:

mspj_def.txt
A text file containing localization strings.

mspjhttp.exe
Microsoft Project Web Workgroup Messaging server application. Resources run this to access their Web workgroup messages (this is discussed in detail later).

phlp_def.htm
An online Web workgroup help page.

Message folders

After at least one workgroup message is sent from any project, Inbox and Outbox folders are created under the Microsoft Project Web folder. The first time that a Web workgroup message is sent from a specific project file, corresponding folders with the same serial code name are created under the Outbox folder and the Inbox folder. Each project file using the Microsoft Project Web site gets its own pair of folders under the Inbox and Outbox folders. The subfolders of the Outbox folder contain messages sent by managers, and the subfolders of the Inbox folder contain messages sent by resources. 

The picture that follows illustrates the message folder structure.

Web message folder structure...
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The picture to the right lists some sample message files stored in a message folder.
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Password file

The first time a manager sends a Web workgroup message, the password file mspjhttp.pwd is created in the Outbox folder. Manager and resource passwords are stored in this file. All passwords are originally blank. The managers and resources referenced in this file correspond to the names listed in the User name box in the Microsoft Project Web login page (described in detail later). If the PWD file is deleted, then no resource can get to the Web TeamInbox page until they are sent another Web workgroup message from Microsoft Project.
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Overwriting existing files

MSPJHTTP.EXE

During Web workgroup installation, Microsoft Project overwrites an existing mspjhttp.exe file only if it is an older version and digitally signed by Microsoft. No alerts are displayed whether it overwrites the file or not. This approach accounts for the possibility that someone has written and installed a customized version of the file.

Other files not overwritten

No other existing files are overwritten. This includes any existing password file (mspjhttp.pwd), localization file (mspj_def.txt), and message files.

Manager Web Workgroup Interface

Sending Web workgroup messages from Microsoft Project

Whether e-mail messaging or Web messaging is being used, the manager sends TeamAssign, TeamUpdate, and TeamStatus messages in the same way and with the same interface. 

The only difference is that Web messaging communicates directly with a Web messaging folder over a network, while e-mail messaging uses an e-mail system. 
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When Web messaging is used, an e-mail login dialog box is never displayed, unless the Send hyperlink in E-mail note check box on the Workgroup tab of the Options dialog box is selected.

User name setting on the General tab of the Options dialog box

If the User name box is blank on the General tab of the Options dialog box, then an alert is displayed when you click the Send button in the TeamAssign, TeamUpdate, or TeamStatus form.
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E-mail error

If the manager doesn't have write access to appropriate Web folder, then an alert is displayed. The alert refers to e-mail, even if the manager is using Web messaging. This is the same alert that is displayed if a resource is marked as using e-mail, but does not have a valid e-mail address.
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Receiving Web workgroup messages in Microsoft Project

The WebInbox

The manager uses the WebInbox command on the Tools/Workgroup menu to view Web workgroup messages sent to the manager by resources.

There is also be a button for the WebInbox on the Workgroup toolbar.
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When the manager uses the WebInbox command, a password login dialog box is displayed unless the password is blank (which it is originally). The WebInbox also has a Password button you can use to change the password.
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If the manager doesn't have write access to the appropriate Web folder, then an alert is displayed.
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If the manager has the appropriate write access and enters the correct password (if it is not blank), then the WebInbox form is displayed, as shown. It lists messages for the current user, as determined by the name in the User name box on the General tab of the Options dialog box, from the specified Microsoft Project Web folder.

WebInbox form...
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The settings that are available on the WebInbox form are discussed as follows.

Server Root

This is the UNC path to Microsoft Project Web folder on the Web server. It lists all distinct UNC paths for all Web servers from all currently open projects. If you select a different item from this list, the URL and message grid are updated to reflect the messages from the selected Microsoft Project Web folder.

Server URL

This is the URL corresponding to the Web server (the URL is used by resources).

Filter option buttons

The All messages, TeamAssign, and TeamStatus buttons control which type of messages are listed in the message grid.

View button

The View button displays the selected message. Web reply messages and unsolicited TeamStatus messages sent to the manager have the same form as e-mail messages sent to the manager. If the message contains an Update Project button, it behaves like the Update Project button in the WebInbox (as follows).

Update Project button

The Update Project button updates the project with the data from the selected message. 

There can be messages from many project stored in the same Microsoft Project Web folder. If a message is for a project that is not currently open, the project file is opened and updated (and remains open) when you click Update Project.

When a project is updated with the data from a message, a checkmark is placed in the Upd column for that message. The Update button is disabled if you select a message that has already updated the project.

Internally, Microsoft Project keeps track of duplicate messages and only accepts one update from a set of duplicate messages. It doesn’t matter which duplicate message arrives in the Inbox first. The first one from which you update the project disables updating from the remaining duplicate messages in the set.

Delete button

The Delete button deletes the selected message.

Update All button

The Update All button updates projects with the data from all the messages displayed in the WebInbox. If the WebInbox is filtered to show only TeamAssign or TeamStatus messages, then only data from those messages is updated. 

If all messages are displayed, then TeamAssign messages are processed before TeamStatus messages.

The messages are processed from the bottom of the grid to the top, because the bottom messages are the oldest.

See the Update Project button description above for the handling of duplicate messages.

If all the messages currently in the WebInbox are updated, or if there are no messages in the WebInbox, then the Update All button is disabled.

The message grid

The message grid lists messages for the current user (determined by the User name setting on the General tab of the Options dialog box), from the specified Microsoft Project Web folder.

The columns listed in the message grid follow:

· Upd: This field indicates whether the project has been updated from the message. If it has, then this field has a checkmark.

· From: This field displays the name of the sender.

· Project: This field displays the name of the project corresponding to the message.

· Subject: This field displays the subject of the message.

· Assigned: This field displays the number of assigned tasks to which the message refers.

· Received: This field displays the date that the Web server receives the message. 

Password button

The Password button displays the Change Password dialog box.

If the current password is not blank...
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The old password setting is disabled (grayed out) if it is blank.

If you enter a value in the Old password box that does not match the old password, or if you enter two different values in the New password and Confirm new password boxes, then an alert is displayed.

Remove Resource button

The Remove Resource button displays the Remove Resource dialog box, which allows you to remove any single resource from the workgroup. 
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The Resource Name field is blank when the Remove Resource dialog box is displayed, and you must select a resource to delete. If the list box is still blank, and you click the Remove button, an alert is displayed. If a name is selected when you click the Remove button, it displays a confirmation alert. If you confirm the deletion, Microsoft Project deletes the resource from the Web login User Name list and deletes the messages for that resource, but it does not delete the resource or its assignments from any project files.

Note: For more information on this topic, please see Knowledge Base Article Q176300.

Resource Web Workgroup Interface

Running MSPJHTTP.EXE

The manager must give the resources the Web server URL that is specified by the manager on the Workgroup tab of the Options dialog box. 

If the manager selects the Send hyperlink in E-mail note check box on the Workgroup tab, and if the appropriate settings allow a resource to receive e-mail messages, then when the resource is sent a Web workgroup message, the resource is also automatically sent a notification e-mail message containing a hyperlink that executes mspjhttp.exe on the Microsoft Project Web site. The message also selects the resource from the User Name list on the login page.

If a resource manually enters the URL, they must include the executable file name, mspjhttp.exe. Some browsers also require a question mark character at the end of the file name.

Using the URL without the executable

If the resource enters the URL without the executable file name, then the contents of the Microsoft Project Web folder display as follows.

If you don't include the executable file name...
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Right to execute script files

Resources must have the right to execute script files in the Microsoft Project Web folder. 

For example, using Microsoft Personal Web Server on a Windows 95 computer, the Microsoft Project Web folder can be set up to allow execution of scripts by clicking the Web Sharing button in the Folder Properties dialog box (displayed when you right-click the folder and click Properties).
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If a resource does not have the right to execute script files in the Microsoft Project Web folder, then the resulting behavior depends on the browser.

For example, using Microsoft Internet Explorer, if you include the executable file name without a trailing '?' character, and if the Microsoft Project Web folder is not shared correctly, then Microsoft Internet Explorer displays the download file dialog box as follows.
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If the Microsoft Project Web folder is not shared correctly and you attempt to run the executable with the '?' character, then Microsoft Internet Explorer displays the following execution error.
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The Login page

Assuming that the resource has the right to execute script files in the Microsoft Project Web folder, the login page is displayed by including the executable file name, mspjhttp.exe, after the URL. A question mark at the end of the executable file name means that the file should be executed on the server rather than downloaded. Some browsers like Microsoft Internet Explorer do not require the question mark. 
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The User Name list

A resource is included in the User Name list the first time the resource is sent a Web workgroup message from a manager. A manager is listed the first time the manager uses the WebInbox Password button in Microsoft Project or is sent a reply from a resource. Like any other cached Web page, if the user doesn't see his or her name in the list, the user may have to click Refresh after the manager sends a message. 

The Password field

The Password box is blank the first time the resource logs on. The resource should click the Go button without entering a password. The resource can then use the Change Password button in the TeamInbox.

If you enter the wrong password, you are returned to the login page (the line "Incorrect Password for User Name" is displayed in red):
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After selecting the correct user name and entering the correct password, click the Go button to display the TeamInbox page.

The TeamInbox page

The TeamInbox page contains all the message sent to the resource from various project files.

The picture that follows shows the TeamInbox page that contains a single message (the line "Refresh Inbox" is displayed in red).
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The picture that follows shows the three types of workgroup messages that can be in the TeamInbox:
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Refreshing the TeamInbox page

The TeamInbox message list is not automatically updated as it receives new messages. You must explicitly click the Refresh Inbox icon on the navigation bar (at the left side of the page).

Note: The Refresh button does not refresh the TeamInbox page. It takes you to the Login page again. More generally, the Refresh, Back, and Forward buttons in most cases take you back to the Login page, regardless of which Web workgroup page you are in currently.

Opening messages from the TeamInbox

Unlike e-mail messaging, when you open a message from the TeamInbox, the message is already in reply mode when the page opens. This design saves time. 

In e-mail messaging, comments from the manager are displayed in the Comments field when the message is opened, and the Comments field is cleared when the you click the Reply button or edit any of the other fields. You can then enter your own comments in the Comments field and click the Send button.

In Web messaging however, because the message opens in reply mode, there are two comment fields, one labeled Comments and one labeled Mgr Comments. The latter contains the original comments that the manager sent with the message.

Opening a TeamAssign message

Click the Open icon beside a TeamAssign message in the TeamInbox to open the message in the TeamAssign page as shown (the navigation bar is not shown). Click the Send button to send a reply to the manager and add the tasks that were accepted to the Task List page. After you click the Send or Delete button in an open TeamAssign message, the message is automatically deleted from the TeamInbox (to cancel an open message, click the Inbox icon on the navigation bar).
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Opening a TeamUpdate message

Click the Open icon beside a TeamUpdate message in the TeamInbox to open the message in the TeamUpdate page as shown (the navigation bar and legend are not shown). Click the Send button to send a reply to the manager. This does not update the tasks on the Task List page and does not delete the message from the TeamInbox. Click the Update Task List button to update the tasks on the Task List page and to automatically delete the message from the TeamInbox. To cancel an open message, click the Inbox icon on the navigation bar.
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Opening a TeamStatus message

Click the Open icon beside a TeamStatus message in the TeamInbox to open the message in the TeamStatus page as shown (the navigation bar and legend are not shown). The Send button sends a reply to the manager, saves the message in the TeamInbox, and updates the tasks on the Task List page. The Save button functions like the Send button, but without sending a reply to the manager. The Delete button updates the corresponding tasks on the Task List page (it does not delete them) and then deletes the message from the TeamInbox.
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Data Error Checking 

If you submit data that is invalid, you are returned to the originating page. The invalid cells are bordered in red and a message near the top of the page explains that invalid data was entered. 
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Deleting a message

A message cannot be deleted from the TeamInbox when it is open. If you click the Delete button in the TeamAssign, TeamUpdate, or TeamStatus page, an alert similar to this is displayed.
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The Navigation Bar

The table that follows describes each of the command icons that are displayed in the navigation bar at the left side of Microsoft Project Web workgroup pages.

Navigation Bar Icons
Description
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The Refresh Inbox icon actually displays in red. It is displayed when the TeamInbox page is active. Otherwise, the Inbox icon is displayed. 

Click the Inbox icon to display the TeamInbox page. Click the Refresh Inbox icon to update the page with the latest messages.

When a resource displays a specific message and clicks the Send button, that message is deleted from the TeamInbox page and cannot be recovered.

[image: image1212.png]®

Task List




[image: image1213.png]Return to
Task List




It changes to Return to Task List if the Task List Options page is active.

Displays the Task List page for the resource.

A task is added to the Task List if the resource accepts the task from a TeamAssign message and sends a reply to the manager, or if the task is in a TeamStatus message and the resource clicks Send or Reply.

A resource can selectively delete tasks from the Task List.
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Allows the resource to change the Web workgroup login password, and then takes the resource to the TeamInbox page.

Passwords are stored in the encrypted file mspjhttp.pwd in the Outbox folder under the Microsoft Project Web folder.
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Returns the resource to the Web workgroup login page.

[image: image1216.bmp]
Opens the Web workgroup HTML Help file, phlp_def.htm, in a separate browser window. See the picture that follows for a list of Help topics.

Microsoft Project Web Workgroup Help

Click the Help button on the navigation bar to display the Help page. The picture that follows lists the table of contents from the Microsoft Project Web workgroup Help file, phlp_def.htm.

Help topics available in phlp_def.htm.

[image: image1217.png]Table of Contents

Overviews

About the Tearninbox
About the Inbox
About the Task List

Using the Inbox

Accept or decline a TeamAssion request
Reply to a TeamUpdate message
Respond to a TeamnStatus message

Working with messages in the Task List

Update tasks in the Task List

Save changes in the Task List

Delete tasks in the Task List

Send updated status for your tasks to the workgroup manager

Modifying settings
Change your workaroup password
Change the report period and rack overtime

Logging off
Lag off without exiing the browser




Changing the Password
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 A resource can use the Change Password button in navigation bar on the left side of the Web workgroup pages to change the password.
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If the Old Password entry is incorrect, then a new copy of this page is displayed that includes an error message as shown (the third line is displayed in red).
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Similarly, if the New Password and the Confirm Password entries don’t match, then a new copy of the page is displayed that includes an error message as shown (the third line is displayed in red):
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The Task List page
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 The Task List button displays the tasks for the resource, grouped by project.
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The Task List combines two e-mail features

In e-mail messaging, you have the following two Outlook functions:

· Persistent Task List in Outlook. This gives you a place to save, view, and edit the tasks that you are working on.

· Submitting unsolicited TeamStatus messages: Choose the new TeamStatus Report command on the Tasks menu in the Outlook Tasks window to send unsolicited status on the Microsoft Project tasks stored in Outlook. You cannot create Microsoft Project tasks in Outlook; they have to be sent with messages from the manager.

With Web workgroup messaging, the two previously described features are combined in the Task List page. For each task listed, the Task List page always displays a TeamStatus-like form for entering actuals.

Task List fields

The Task List table has the following fields:

Send?: This check box field has an envelope icon for a title. This field determines which projects to include when you send a status message to the manager. This check box is selected by default. If it is selected for a specific project, then status messages include all the tasks from that project (you cannot selectively send status messages for some tasks and not others).

Microsoft Project: Displays the name of the parent project for each task.

Task Name: Lists the task names.

Start: This is the start date of the task from the original TeamAssign message. The messages in the Task List are sorted, in ascending order, by start date.

Work: This is the amount of work assigned in the original TeamAssign message.

Remaining Work: Shows the amount of work left to do on each task.

Period columns: The daily, weekly, and total columns are blank by default. This is where you can enter actuals.

Delete?: This is used by the Delete button to determine which tasks to delete.

Task List buttons

Send button: Click this button to send the manager a TeamStatus report with the actuals that you enter. The browser then jumps back to the TeamInbox page. 

Save button: Click this button to save the data that you enter and to jump to the TeamInbox page. 

Options button: This takes you to the Task List Options page. The available options are discussed in detail later.

Delete button: This deletes the tasks that contain a checkmark in the Delete? field. A confirmation page is displayed before deleting the marked tasks. If you click Yes in the confirmation page, then all marked tasks are deleted. If you click No, then you are returned to the Task List page, and the marked tasks remain marked.
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The Task List Options page

Click the Options button in the Task List page to display the Task List Options page as shown. The Task List button on the navigation bar changes to Return to Task List. Click the Set new period options button to accept changes to the options, or click the Return to Task List button on the navigation bar to cancel changes (when you click any button on the navigation bar, it cancels changes made in the Task List Options page).
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Period From/to sets the status report date range.

Break down by determines the period granularity of the status report. The three choices are total for the entire period, day, and week.

Week starts on determines which week day that weeks start on (Sun, Mon,...). This is used if the granularity is weeks.

Display Overtime Work controls whether overtime work columns display in the task list (one overtime column beside each period column).

The Set new period options button validates and applies the new options settings. If all values are valid, then you are returned to the Task List page. 

Important: If you the change either the Period From or To date, or the Break down by setting, then all actuals that are currently saved in the Task List are cleared.

If either of the period date values are invalid, you are returned to the Task List Options page with an error message near the top of the page, and with a red border around each invalid date.
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Lesson 9.3 - Exercises

1. 
What Web servers and browsers does Microsoft Project 98 Web workgroup messaging support?

2. 
How is Web workgroup messaging installed?

3. 
How do resources access Web workgroup messages regarding their assignments?

4.
How does the manager read the Web workgroup TeamStatus reports sent back from the resources reporting their actual work?

5.
How does the manager add resource names to the User Name list on the Login page? Can resources add their names to the list themselves if they are not already listed?

6. 
What access rights must the manager have to the Web workgroup messaging folder during Web workgroup setup?

7. 
What access rights must a resource have in order to run mspjhttp.exe?

8. 
What is the initial password for a resource the first time the resource logs on to the Web workgroup Login page? Can the manager assign initial passwords for resources?

9. 
How can a resource create an unsolicited TeamStatus report using Web workgroup messaging?

10. 
What must a manager do if a resource has forgotten his or her login password?

Lesson 9.3 - Lab

In this lab, you will play the role of the manager and various resources.

1.
Install Microsoft Personal Web Server on your computer if it is not already installed.

Microsoft Personal Web Server is included with Microsoft Project 98. To install it, run pwssetup.exe. After it finishes installing, it will place the following icon in Windows Control Panel.
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Microsoft Personal Web Server is turned on by default and the icon is displayed in the Windows Task Bar tray. By default, it creates a Websvr folder under the Program Files folder as shown below. You do not need to do anything in the Websvr folder.
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More importantly, it creates a default Webshare folder off the root folder of the C: drive as shown below.
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2.
Prepare the Webgroup folder as follows: 

In the Windows Explorer, create a subfolder named ProjWeb (or any name you like) under the Wwwroot folder.
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Right-click the ProjWeb folder and click Sharing. Assuming you are using share-level access, share the folder for Read-Only:
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Next, click the Web Sharing button at the bottom of the dialog box and select the Share folder for HTTP option and the Read-Only and Execute options. Click OK for both dialog boxes.
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3.
Install the Web workgroup files as follows: 

Start Microsoft Project 98 and enter a couple of tasks in a new project and assign John Smith and some other fictional resources to the tasks. Save the project, click Options on the Tools menu, and then click the Workgroup tab. In the Default workgroup messaging for resources box, click Web.

Enter the appropriate URL and UNC paths as shown below.
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Substitute the name of your computer for computer1 (your computer name is specified by right-clicking the Windows Network Neighborhood icon, clicking Properties, and then clicking the Identification tab). Click OK and you should get a message asking if you want to install the Web workgroup files. Click Yes.

Notes
It doesn't matter what project is active the first time you enter the URL and UNC settings and the Web workgroup files get installed to the Webgroup folder. The URL and UNC settings are project specific, so if you created another project, you still have to enter these settings for that project. However, Microsoft Project does not have to copy the Web workgroup files again once they are installed (unless you specify some other Webgroup folder location that does not yet contain the Web workgroup files).

If the manager tries to install Web workgroup files by running Microsoft Project 98 on a computer other than the one that the Webgroup folder (ProjWeb) is on, then the manager needs write access to the Webgroup folder. That's not an issue in this lab because the manager (you) are on the same computer as the ProjWeb folder. That also means you could have entered c:\webshare\wwwroot\projweb for the UNC path instead of \\computer1\projweb.

In this lab, if you have any problems using your computer name in the UNC setting, just use the local C: drive notation instead.

4.
Send Web workgroup TeamAssign messages as follows: 

On the Tools menu, point to Workgroup, and then click TeamAssign. Click the Send button when the TeamAssign dialog box appears.

5.
Playing the role of the resource John Smith, use Microsoft Internet Explorer to access the Web workgroup TeamAssign message that was sent to you from the manager (also you) as follows. 

Start Internet Explorer, and enter the following in the Address bar (including the question mark):

http://computer1/projweb/mspjhttp.exe?

It's best to include the question mark, which means to run the executable automatically without asking whether you want to save it to disk or open it. The question mark may not be necessary for some browsers, but it does no harm to include it anyway.

The Web workgroup login page should now appear. Select John Smith (you) from the User Name list and click the Go button. This should display your TeamInbox page with the TeamAssign message listed there.

6.
Continuing your role as the resource John Smith, reply to the TeamAssign message as follows.

Click the Envelope icon in the first column to open the TeamAssign message, and then click the Send button to reply to it.

7.
Switching back to the role of the manager, access the resource's reply to your TeamAssign message as follows.

Open the project in Microsoft Project. On the Tools menu, point to Workgroup, and then click WebInbox. This will open the WebInbox form, and you should see the reply to the TeamAssign message from John Smith. 

Double-click the reply message to open it and then click the Update Project button (this will set the Confirmed field to Yes for the assignment). You actually didn't have to open the reply message. You can just select a message and click the Update Project button in the WebInbox itself.

8.
Now that you have an idea on how the manager and resources access their messages, experiment sending some TeamStatus messages to resources and have the resources enter actual work and send the messages back to the manager.

Microsoft Project 98 Support Course

Part #: 098-80553

Microsoft�Project 98�Support�Course





Filter table








PAGE  


_926784912.doc
[image: image1.png]H«- > & ‘-t T—‘







_928030296.doc
[image: image1.png]Name _ W.|Dur |Units (DI |D2 |DG |D4 |D5 |D6 |D7 |D8
‘ EE ol oW oW ow oW ow 1w W Ik
>
DI [ [ [ [ [ b7 ;8 |
100%
N
Peak Units: IS T,








_930890850.doc
[image: image1.png]Fgunat [ Erdtiec
e

Lookinfelds  [nane ER T H

Search; bown 7| [ Matchcase








_930923297.doc
[image: image1.png]X [MalRouts Recpient]
[AddjEdit Routing Sli]
%) Exchange Folder.








_931022395.doc
[image: image1.png]=] =B 02550 75 0| Ee| 2a







_932037990.doc
[image: image1.png]BERY sBBI - CX-L =R
+ = % | = This is the
I Flag10 field

T oo e

Summaryt | 8days Mo m ol








_931021725.doc
[image: image1.png]o 25% 50 75 ot B | e







_930923130.doc
[image: image1.png]D ew ctrkn
2 Open. ko
[ClosejClose and Return]

[SavejUpdate]  Ciks
[save Asfsave Copy As]
Save AsHTML,

Save Workspace.

Page Setup.
[ prit Pregien
S cri+p

send To
Propertiss

[Recently Used Fies]
LProject.mpp
21ppBiofficelsamplet. mpp

[Exit/Exit and Return]








_928368857.doc
[image: image1.png]ame | start | Finisn 288

T esow 7nmt








_928369178.doc
[image: image1.png]62837 [pr3097) 113 Y[ 772098

vame | sar | ian [P )i Y

T esom 7nmt

End of Start of
Fiscal 97 Fiscal 98







_929100568.doc
[image: image1.png]Microsoft Project

Task List Options

Setnew period options

Period From [Mon6/2/97 | to [Sun 67/6/27
PR i doun by [oey
Task List Wesk starts on[Sun ~

™ Display Overtime Work

‘Warning: All the actuals currently saved in the current Task List
will be erased due to the change of timescale!







_928088814.doc
[image: image1.png]7h Ok Th 9h
Th 4k 2k Ih
2 1h Th an
P P O







_928201561.doc
[image: image1.png]= e s (v
et [R pssocandar [sercrs 7] [_ok
= ] For s s =

T B £ Use gt
I ¢ (e (s (7

~ Norworking tine et
S| [ [ [ [ ~ wrkngtine
BRI o o

[eoomn  [1oom |
FAERE R F AR

[roomn  [soom |
ENES — —
—

[

[ Nk ot s

[3t | ecenon

|








_928062908.doc
[image: image1.png]14k 18k 14k 18h
20 sh 4h
4 2 2n e
8h 8h 8h Sk







_927172106.doc
[image: image1.png]Toado--







_927939497.doc
[image: image1.png]010
D-2 [D-1 [D1 [D2 |D3 [D4 |DS [D6 D7 |08 [D9 |

SO ) R
ASAP g W
ASAP mmmm——" R







_928024964.doc
[image: image1.png]Name |W. |Dur|Units [[DI _[D2 [D3 D4 [DE_ |D6 [D7 [D8 |

T 72 (32) 648% 1712 1256k, 954k 984k 750k 6124 SATh
2h Ao ak an e
™ 2 s

[l

o o A T T T
0asn TI2h 256k 384n 384k 256h 1120 04Sh

mzEREZ
g

16








_928030255.doc
[image: image1.png]Name | W.|Dur |Units (DI _|D2 _|D3 _[D4 _[DS |D6 |D7 |D8
‘ w ] on %l 0w on  en an
>
DL o [ [ & [ [w
1005
el
Pesk Uit T T e |








_927939594.doc
[image: image1.png]






_927484813.doc
[image: image1.png]ome _|Dur |Alur |%c |stop | Res |

Details

D1 |02 1D3 (D4 |DS

o2 [ 65 [ 64 [ 65 [ 6%

T

r

BRI

0% HA

A

Work

Aot Work

% Complete

12n 140 12n dn 1oh;

Work

ot Work

% Complete

@ on an 20 on

Work

Act, Work

% Complete

an eh oh 2 on







_927826429.doc
[image: image1.png]| ~Resource Sheet

General
waes [rr _ -
Current date is Resource Information

Costratetables: | earlier than 8/1/97 dialog Costs tab
< o €

B

aetait) |
[
fective Cate Gt
= 1$15.00/h $20.00/h 40.00
Eit 17000 Tz aoh o0
11/3/97 {20 zs.0oh 000

For rates, enter a valus or a percentage increase or decrease from the previous
ate. For nstarce, I a resource's Per Lise Cost i recuced by 20%, type 20%

Cost acerual;  [Prorated







_927828087.doc
[image: image1.png]Cost acorual; [Start







_927606716.doc
[image: image1.png]Tools Project Window Help PastsToPaint

% speliing. =2 CE aa T @S
AutnCorrect. Al Tasks B
Teamassign
Links Between Projects. €9 TeamUpdate.

B Teamstatus,
Change Working Tire. D Tear

Resources >
£ setReminder,

Resourcs Leveling
Send Schedule Note.

o







_927624796.doc
[image: image1.png]Tasks

crosoft Outlook

Eile Edit View Go Tools

ERARS E| & 9 new Task e
| 1) New Task Reguest_CHrIShifts

Chonse Termpit,
Chaoose Farm.

&

Save Task Order







_927558856.doc
[image: image1.png]Send Cancel

Tor Paula Jones, Bob iler

Suject; [ Teamassign
Dot g1t

[Feass reply T e message and e e Fnow T e ek st ed blon 2 2]
ecceptabe

o =

e

[Favis Jonesfob e 5

T [TaskName [Work [start[Finish [ Commen
Pauls Jones pob Miler_|T1 e I3

Paula Jones,ob Filer 12 20 6je 65








_927234097.doc
[image: image1.png]St of child Actual Durations

Summary task total % Complete
St of ckild total Durations








_927059931.doc
[image: image1.png]






_927151185.doc
[image: image1.png]






_926785068.doc
[image: image1.png]






_925031411

_925474019

_925484991

_925497479

_925685566.doc
[image: image1.png]Work [Dur |

Task Name
B frates 3a
Bob_ 16 hes
>
Mo [fu [we [Tn
005
Bob

Peak Units:

S0%

700% | 100% | 75%








_925721880.doc
[image: image1.png]Work contour:
Fiat
B Back Loadsd
Front Loaded
Double Peak
Early Peak
Late ek
Eel
Turte

Erish

-








_925498369

_925498224

_925492535

_925496979

_925492485

_925482383

_925484512

_925478805

_925472384

_925473870

_925042372

_924948201

_924960794

_925027143

_925030680

_924960181

_924889138

_924893951

_924904204

_924893777

_864024609

_879926494

_924887654

_879926529

_864027028

_864024167

